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S5U1C17001C Manual Revision History

Code No. Page Chapter/Section Description of revision

411086605 － Entire manual Version number changed from 1.4.0 to 1.5.0

－ Entire manual Technical term changed 
"implementation-dependent" → "implementation-defined"

2-4 2.2 Installation Method Explanation added 
xgcc_filt.exe: Kanji filter (same as egcc.exe)

3-55 3.5 Tutorial 3  
(Importing an IDE Project)

Section deleted 
• If execution of a build fails after importing a      
project using Windows Vista

4-3 4.2.2 Library Functions and 
Header Files

Explanation modified 
Dummy functions were deleted from the table.

4-3 4.2.2 Library Functions and 
Header Files

Explanation modified 
Table (functions with prototype declarations only) was 
added.

4-3 4.2.2 Library Functions and 
Header Files

Technical term changed 
"ANSI standard library" → "ANSI library"

4-3 4.2.2 Library Functions and 
Header Files

Explanation added 
Certain ANSI library functions ... include the pertinent 
header file rather than declaring a prototype before 
implementing the function.

4-15 4.4 Precautions for Creation of 
Sources

Explanation modified 
-O3 was added.

4-16 4.4 Precautions for Creation of 
Sources

Explanation added 
(10) Due to C language specifications, ... substitution will 
not proceed correctly.

5-47 5.4.5 Importing an Existing 
Project

Section deleted 
• If execution of a build fails after importing a    
project using Windows Vista

5-112 5.7.3 Setting Compiler Options Explanation modified 
[Use Japanese Kanji filter]... (When the checkbox is 
unselected, the -mno-sjis-filt option is specified during 
compilation.)

5-113 5.7.3 Setting Compiler Options Explanation added 
-O3: Optimizes code execution speed.

5-126 to 
5-128

5.7.7 Generated Makefile Explanation modified 
Example of generated makefile

5-155 5.7.9 Executing a Build 
Process

Section deleted 
• If execution of a build fails after importing a    
project using Windows Vista

6-1 6.1 Functions Explanation modified 
Of bugs detected during the evaluation, ... are described in 
...

6-3 to  
6-4

6.3.2 Command-line Options Explanation added 
-O3 was added.

6-6 6.3.2 Command-line Options Explanation added 
-mno-sjis-filt

6-11 6.4.3 Method of Using 
Registers

Explanation added 
• First argument: long; second argument: pointer;      third 
argument: pointer

6-13 6.4.7 Compiler Implementation 
Definition

Section added 
6.4.7 Compiler Implementation Definition

6-14 6.5 Filter Function for Shift JIS 
Code

Section added 
6.5 Filter Function for Shift JIS Code



Code No. Page Chapter/Section Description of revision

411086605 6-16 to 
6-18

6.7 Known Issues Section added 
6.7 Known Issues

7-6 7.2.3 Floating-point Number 
Processing Implementation 
Definition

Section added 
7.2.3 Floating-point Number Processing Implementation 
Definition

7-9 7.3.1 Overview Explanation modified 
Certain ANSI library functions ... See the table in Section 
4.2.2, "Library Functions and Header Files" for a discussion 
of ANSI library functions with prototype declarations only.

7-9 to 
7-12

7.3.2 ANSI Library Function 
List

Explanation modified 
Explanation of dummy functions and descriptions 
pertaining to dummy functions have been deleted.

7-15 7.3.3 Declaring and Initializing 
Global Variables

Explanation modified 
Descriptions pertaining to dummy functions have been 
deleted.

10-26 10.4.5 [Memory] Window Explanation modified 
Memory Preferences dialog box

10-26 10.4.5 [Memory] Window Explanation added 
Default Start Dump Address

10-63 10.7.1 List of Commands "Table 10.7.1.1 List of commands" revised

10-112 10.7.8 Break Setup 
Commands

Section added 
commands (setting a command to execute after a break)

11-3 11.1.4 Makefiles Explanation modified 
Example of generated makefile

11-55 11.11.5.1 Menus Explanation modified 
About LcdUtil message box

11-64 11.11.8 Warning Messages 
and Error Messages

"Table 11.11.8.1 List of warning messages" revised

QR-13 Quick Reference Explanation modified 
-O3 was added.

QR-13 Quick Reference Explanation added 
-mno-sjis-filt

QR-22 Quick Reference Explanation added 
commands

QR-27 Quick Reference Explanation modified 
Explanation of dummy functions and descriptions 
pertaining to dummy functions have been deleted.



Code No. Page Chapter/Section Description of revision

411086606 － Entire manual Version number changed from 1.5.0 to 2.0.0

－ Entire manual Terminology modified following screen and specification 
changes

－ Entire manual Details related to Windows 2000 deleted

－ － Precautions modified 
Modification to "Tool type" in "Development tools"

－ Configuration of product 
number

Description modified 
The sample screens ... vary according to the system or 
fonts used.

－ Manual Notations Description modified 
It also allows use of the S1C17MCU core simulator ... 
"Embedded System Simulator (ES-Sim17)".)

1-1 1.1 Features Description modified 
It also allows use of the S1C17MCU core simulator ... 
"Embedded System Simulator (ES-Sim17)".)

2-1 2.1 Working Environment Description added 
Note: The tools do not support 64-bit operating systems.

2-2 2.2 Installation Method Description modified 
Details related to installer on CD-ROM deleted

2-4 2.2 Installation Method Description added 
File added to \gnu17 (gnu17 tool root DIR)

2-6 2.2 Installation Method Description added 
• The [EPSON MCU] > [GNU17] folder in the Windows 
Start menu may ... deleted manually.

3-1 3.1 Software Development 
flow

Description modified 
Figure 3.1.1 software development flow diagram modified

3-13 3.3.2 Creating a Project Item added 
Specifying the stack pointer address

3-13 3.3.2 Creating a Project Description modified 
The target CPU, memory model, ... stack pointer address 
specification.

3-32 3.3.6 Debugging a Program Description modified 
The contents of the command file displayed by default are 
provided for debugging using an ICD Mini.

3-36 3.3.6 Debugging a Program Description modified 
The source displayed in [Source] editor ... in [Disassembly] 
view.

3-36 3.3.6 Debugging a Program Description modified 
Displaying in [Disassembly] view

3-36 3.3.6 Debugging a Program Item deleted 
SOURCE 
ASSEMBLY

3-36 3.3.6 Debugging a Program Description modified 
"MIXED" → "Disassembly"

3-36 3.3.6 Debugging a Program Item deleted 
SRC+ASM

3-37 to 3-43 3.3.6 Debugging a Program Description modified 
Description modified for steps 60 to 80

3-38 3.3.6 Debugging a Program Description deleted 
Description related to the window displayed at startup of 
the debugger deleted

3-49 to 3-52 3.4.4 Setting and Correcting 
the Makefile

Description modified 
Description modified and added for steps 18 to 28 

3-62 3.6.2 How to launch ES-Sim17 
in the Existing Project

Item deleted 
Simulator mode debugger command file modified



Code No. Page Chapter/Section Description of revision

411086606 3-62 to 3-63 3.6.2 How to launch ES-Sim17 
in the Existing Project

Description modified 
Step numbers modified

3-67 3.8 Sections and linkage Description added 
 /* stack pointer symbols */ 
 __START_stack = 0x000FC0;

4-1 4.1 File format and file Name Description modified 
Default tab setting… tab stops every four characters

4-15 4.4 Precautions for Creation of 
Sources

Description modified 
(9) Note that, because of the specifications of the C/C++ 
language, …in local variables/external variables.

4-16 4.4 Precautions for Creation of 
Sources

Description modified 
In this case, reference or assignment ... may not be 
performed correctly.

4-16 4.4 Precautions for Creation of 
Sources

Description modified 
In that case, variable p1 ... may not be performed correctly.

5-1 5.1.1 Features Description modified 
Table 5.1.2.1 Eclipse plug-in version list modified

5-2 5.1.1 Features Item added 
About the use of Japanese language in the IDE

5-11 5.3.1 Menu Bar Description modified 
[Run] menu

5-12 5.3.1 Menu Bar Description added 
[Debug]

5-13 5.3.1 Menu Bar Description deleted 
Quick Switch Editor (Ctrl+E)

5-14 5.3.2 Window Toolbar Description added 
[Debug] 
[Run]

5-14 5.3.2 Window Toolbar Description deleted 
Open Type 
Select Working Sets

5-15 5.3.3 Editor Area Description deleted 
Description related to canceling and repeating operations 
deleted

5-20 5.3.4 [C/C++ Projects] View Description deleted 
Close Unrelated Project

5-24 5.3.6 [Outline] View Description deleted 
Compare With 
Previous from Local History 
Local Histry 
Object file conversion 
Properties 
Open 
Create Make Target... 
Build Make Target...

5-25 5.3.7 [Console] View Description deleted 
Terminate

5-27 5.3.8 [Problems] View Description added 
Open in External Editor

5-31 5.3.11 [Search] View Description deleted 
Copy to Clipboard

5-33 5.3.12 [Bookmarks] View Description deleted 
Show 
Paste

5-34 5.3.13 [Tasks] View Description deleted 
Paste



Code No. Page Chapter/Section Description of revision

411086606 5-41 5.4.2 Creating a New Project Description modified 
*You can switch target CPUs later. (Refer to Section 5.7.1, 
"Setting the Memory Mode".)

5-41 5.4.2 Creating a New Project Description modified 
Section 5.7.1 headings modified

5-42 5.4.2 Creating a New Project Description modified 
(10) added and subsequent renumbering

5-45 5.4.4 Switching Workspaces Description deleted 
Description related to work space directory modified

5-49 5.4.5 Importing an Existing 
Project

Description deleted 
"(only when that file does not exist)" deleted.

5-77 5.4.11 Project Properties Description modified 
Description related to 9. "GNU17 General" modified

5-77 5.4.11 Project Properties Item added 
Section 12 "GNU17 Flash Protection Settings" added and 
subsequent renumbering

5-81 5.5.3 Editing functions for C 
Source files

Description deleted 
Description related to C editor default settings deleted

5-82 5.5.3 Editing functions for C 
Source files

Item added 
Description related to change cancellation after operations 
deleted

5-87 5.5.3 Editing functions for C 
Source files

Description deleted 
Description related to change cancellation after operations 
deleted

5-87 5.5.3 Editing functions for C 
Source files

Description added 
Note: Refactoring is used ... after editing source files.

5-90 5.5.6 Bookmarks Description modified 
Description of delete (2) in [Bookmarks] view modified

5-95 5.5.7 Tasks Description modified 
Description of case (1) with no source line information 
modified

5-95 5.5.7 Tasks Description modified 
Description of delete (2) in [Task] view modified

5-105 5.5.10 "Launching by 
specifying line number in 
external editor"

Item added 
5.5.10 "Launching by specifying line number in external 
editor" added

5-113 5.7.1 Setting the GNU17 
General Settings

Description modified 
Heading modified

5-113 5.7.1 Setting the GNU17 
General Settings

Description modified 
In most cases, you will not need to select ... and memory 
model as follows:

5-113 5.7.1 Setting the GNU17 
General Settings

Description modified 
Description for (1) and (4) modified

5-114 5.7.1 Setting the GNU17 
General Settings

Description added 
Note: If the target CPU has changed, ... on the GDB 
command screen.

5-123 5.7.3 Setting Compiler Options Description modified 
[Other] default modified

5-132 to 
5-135

5.7.7 Generated Makefile Description modified 
Creation make file example modified

5-136 5.7.7 Generated Makefile Description added 
(11) added and subsequent renumbering

5-139 5.7.8 Editing a linker Script Description added 
If the CPU was changed via the [Properties] ... in the 
.vector section address.



Code No. Page Chapter/Section Description of revision

411086606 5-146 5.7.8 Editing a linker Script Item added 
Stack pointer

5-146
5-149
5-153
5-156

5.7.8 Editing a linker Script Description added 
The following added to linker script and section layout 
 /* stack pointer symbols */ 
 __START_stack = 0x000FC0;

5-163 to 
5-169

5.7.9 Executing a Build 
Process

Item added 
5.7.9 "Setting Flash Protect" added

5-176 5.8.1 Generating a Parameter 
file

Description modified 
Description for default parameter settings modified and 
partially deleted

5-183 5.8.2 Setting the Debugger 
Startup Commands

Description added 
If the CPU has been changed ... set to [Boot vector 
address].

5-184 to 
5-192

5.8.3 Launching the Debugger Description modified 
All description for 5.8.3 "Launching the Debugger" deleted 

5-193 5.9 Customizing the IDE 
(Preferences)

Description deleted 
[Support hyperlink style navigation] 
[Hyperlink style navigation key modifier:] 
[Disable overwrite typing mode]

5-215 5.9 Customizing the IDE 
(Preferences)

Description deleted 
[Select folding used] default deleted

5-226 5.10.1 Properties for Project Description modified 
Section numbering modified for "Using user-created make 
file"

5-236 5.10.1 Properties for Project Description modified 
Select the optimization level (-O0, -O1, -O3).

5-240 5.10.1 Properties for Project Description added 
[Other] default added

5-250 5.10.1 Properties for Project Description added 
If the CPU has been changed ... set to [Boot vector 
address].

5-251 5.10.1 Properties for Project Description added 
GNU17 Flash Protect Settings

5-255 5.10.1 Properties for Project Description added 
[Stack Pointer Address]

5-265 5.11 Files generated in a 
Project by the IDE

Description modified 
Table 5.11.1 IDE created file list modified

6-2 6.3.2 Command-line Options Description deleted 
Description related to -c options deleted

6-2 6.3.2 Command-line Options Description added 
The basic make files generated ... xgcc launch command.

6-7 6.3.2 Command-line Options Description added 
-Werror-implicit-function-declaration

6-14 6.5 Filter function for Shift JIS 
Code

Description modified 
• Header files included from C files

6-14 6.5 Filter function for Shift JIS 
Code

Description added 
Specify the -mno-sjis-filt option to disable this filter option.

6-15 6.6 Functions of xgcc and 
Usage Precautions

Description modified 
Description related to xgcc function and precautions 
modified

6-19 to 6-21 6.7 Known Issues Description added 
No. 5 to No. 8 added

7-2 to 7-3 Precautions to Be Taken When 
Adding a library

Description added 
Make sure the first section of the linker script file (.lds) ... if 
the library is described twice.



Code No. Page Chapter/Section Description of revision

411086606 7-10 to 7-11 7.3.2 ANSI library function list Description modified 
Table 7.3.2.1 input/output function list modified

7-13 7.3.2 ANSI library function list Description modified 
Table 7.3.2.5 numerical function list modified

7-18 7.3.4 Lower-level functions Description added 
Note that the _init_sys, read, and write functions included 
in the libstdio.a library are linked even when only the read 
or write functions are used.

8-3 8.3.2 Command-line Options Description modified 
as -otest.o -adhl test.s　→　as -o test.o -adhl test.s

8-30 8.8 Error/Warning Messages Description modified 
Table 8.8.1 error messages modified

9-3 9.4.1 Default linker Script Description added 
/* stack pointer symbols */ 
 __START_stack = 0x000FC0;

9-4 9.4.1 Default linker Script Description added 
/* stack pointer symbols */ 
 __START_stack = 0x000FC0;

10-1 10.1 Features Description added 
- Debugs using the integrated development environment 
(IDE) debugging function.

10-1 10.1 Features Description deleted 
Description related to symbol saving and re-registration 
deleted

10-1 10.2 Input/output files Description modified 
Figure 10.2.1 flowchart modified

10-2 10.2.1 Input files Item deleted 
ini file

10-2 10.2.1 Input files Description modified 
Description related to ROM data HEX files modified

10-2 10.2.1 Input files Item deleted 
Save breakpoints / watch button command file 
Save breakpoints / watch button command file 
Breakpoint storage file 
Storage file for symbols registered in Watch Window

10-3 10.2.1 Input files Item deleted 
Breakpoint storage file 
Storage file for symbols registered in Watch Window

10-4 10.3.1 Startup format Item added 
operation on iDE

10-4 10.3.1 Startup format Description deleted 
'--c17_euc

10-5 10.3.3 Quitting the Debugger Description modified 
Description related to exit procedures modified

10-6 to 10-79 10.4 Windows Description modified 
Entire section 10.4 "Windows" modified

10-80 10.5.1 Entering Commands 
from the keyboard

Description deleted 
Description related to Console button and command input 
deleted

10-80 10.5.1 Entering Commands 
from the keyboard

Description modified 
Commands are entered using [Console] view. ... [Show 
View] menu.

10-80 10.5.1 Entering Commands 
from the keyboard

Item deleted 
Successive execution by the [Enter] key 
Command history



Code No. Page Chapter/Section Description of revision

411086606 10-82 10.5.3 Using Menus 
and Toolbar To Execute 
Commands

Description modified 
Some commands are registered in the [Debug] view, ... 
lists the registered commands.

10-82 10.5.3 Using Menus and 
Toolbar To Execute 
Commands

Description modified 
Specifiable commands in Table 10.5.3.1 menu, toolbar, 
and view modified

10-83 10.5.3 Using Menus and 
Toolbar To Execute 
Commands

Description modified 
These menus, commands, and buttons... using the source 
command.

10-83 10.5.3 Using Menus and 
Toolbar To Execute 
Commands

Description deleted 
Description related to image files deleted

10-83 10.5.3 Using Menus and 
Toolbar To Execute 
Commands

Description modified 
The commands executed from menus ... of the [Console] 
view.

10-84 10.5.4 Using a Command file 
To Execute Commands

Description deleted 
Description related to executing from [File menu] deleted

10-84 10.5.4 Using a Command file 
To Execute Commands

Item deleted 
Executing a command file repeatedly

10-87 10.6.2 Loading a file Description modified 
The c17 rpf command must be executed before the target 
command.

10-88 10.6.3 Manipulating Memory, 
Variables, and registers

Item deleted 
Section 10.6.3 "Source level debugging function" deleted 
and subsequent renumbering

10-91 10.6.4 Executing the program Description deleted 
Will ignore next 4 crossings of breakpoint 1. Continuing.

10-91 10.6.4 Executing the program Description deleted 
Until command screen deleted

10-92 10.6.4 Executing the program Description modified 
Descriptions related to executing step command modified

10-93 10.6.4 Executing the program Description modified 
Descriptions related to executing stepi, next, nexti, and 
finish commands modified

10-96 10.6.5 Break functions Description deleted 
Description related to lines settable in PC breakpoints 
deleted

10-96 10.6.5 Break functions Description added 
Note: When you set a hardware PC break ... at other than 
the start address.

10-97 10.6.5 Break functions Description deleted 
Will ignore next 2 crossings of breakpoint 2.

ignore next 10 hits

10-97 10.6.5 Break functions Description deleted 
Description related to forcible breaks deleted

10-99 10.6.6 Trace functions Description deleted 
Description related to file saving deleted

10-106 to 10-
107

10.7.1 Lst of Commands Description modified 
Table 10.7.1.1 command list modified

10-107 to 10-
187

10.7 Command reference Item deleted 
GUI items deleted

10-120 10.7.5 Program Execution 
Commands

Description modified 
Example 2 description modified

10-143 10.7.8 Break Setup 
Commands

Description deleted 
Description related to address omission deleted



Code No. Page Chapter/Section Description of revision

411086606 10-143 10.7.8 Break Setup 
Commands

Description deleted 
Example 3 deleted.

10-144 10.7.8 Break Setup 
Commands

Description deleted 
Description related to hexadecimal deleted

10-146 10.7.8 Break Setup 
Commands

Description deleted 
Will ignore next 2 crossings of breakpoint 2.

10-146 10.7.8 Break Setup 
Commands

Description deleted 
ignore next 10 hits

10-147 10.7.8 Break Setup 
Commands

Description modified 
Moreover, the number of times... already hit N times" 
format.

10-149 10.7.8 Break Setup 
Commands

Item deleted 
c17 hbreakmd

10.7.8 Break Setup 
Commands

Item deleted 
c17 savebreak

10.7.8 Break Setup 
Commands

Item deleted 
c17 loadkbreak

10-152 10.7.10 File loading 
Commands

Description modified 
Command execution sequence modified

10-152 10.7.10 File loading 
Commands

Description added 
• An error will occur if an unsupported elf file (with no C17 
flag) is specified.

10-153 10.7.10 File loading 
Commands

Description modified 
Command execution sequence modified

10-155 10.7.11 Map information 
Commands

Description modified 
Command execution sequence modified

10-155 10.7.11 Map information 
Commands

Description modified 
The following memory map information ... in ICD 
connection mode.

10-156 10.7.11 Map information 
Commands

Description modified 
00100000→00008000

10-157 10.7.12 Flash Memory 
Manipulation Commands

Description added 
Description related to [SendSize] added

10-159 10.7.12 Flash Memory 
Manipulation Commands

Item added 
c17 flv

10-160 10.7.12 Flash Memory 
Manipulation Commands

Item added 
c17 flvs

10-164 0.7.14 Simulated I/O 
Commands

Description added 
・BreakAddr and BuffAddr should specify ... is written to 
BreakAddr.

10-165 10.7.14 Simulated I/O 
Commands

Description added 
Outputs to a file and [Console] view.

10-165 0.7.14 Simulated I/O 
Commands

Description added 
・BreakAddr and BuffAddr should specify ... is written to 
BreakAddr.

10-167 10.7.15 Flash Writer 
Commands

Description added 
• If the comment contained the null character (space), ... 
even with the above comment.

10-167 10.7.15 Flash Writer 
Commands

Description added 
6.0 ≤ EraseVoltage ≤ 8.0V 
6.0 ≤ WriteVoltage ≤ 8.0V

10-167 10.7.15 Flash Writer 
Commands

Description added 
(7) Example 2 added



Code No. Page Chapter/Section Description of revision

411086606 10-167 10.7.15 Flash Writer 
Commands

Description added 
• A microprocessor with a flash programming power pin ... 
in the corresponding technical manual.

10-168 10.7.15 Flash Writer 
Commands

Description added 
• If the comment contained the null character (space), it 
encloses with a double quotation.

10-167 10.7.15 Flash Writer 
Commands

Description added 
• If the comment contained the null character (space), it 
encloses with a double quotation.

10-174 10.7.17 Other Commands Description modified 
Selectable formats are hexadecimal, ... when the GDB is 
started next.

10-174 10.7.17 Other Commands Description deleted 
Description related to binary deleted.

10-174 10.7.17 Other Commands Item added 
Note

10-175 10.7.17 Other Commands Description deleted 
Description related to c17 log command deleted

10-176 10.7.17 Other Commands Description deleted 
Description related to repeated execution deleted

10-176 10.7.17 Other Commands Description added 
• Source commands can be nested ... do not support 
control commands for if statements.

10-177 10.7.17 Other Commands Description deleted 
Description related to measurable time deleted

10-178 10.7.17 Other Commands Description added 
• To get accurate measured values, ... of the measurement 
start position is not measured.

10-178 10.7.17 Other Commands Description deleted 
Description related to tolerances in ICDmini mode deleted

10-178 10.7.17 Other Commands Description added 
Restrictions for ICD Mini mode and simulator mode added.

10-179 10.7.17 Other Commands Description modified 
Command execution sequence modified

10-186 10.7.17 Other Commands Item added 
c17 chgclkmd

10-187 10.7.17 Other Commands Item deleted 
c17 savewatch 
c17 loadwatch

10-198 10.9 Parameter files Description added 
• CPU model (ICD mode only)

10-198 10.9 Parameter files Description modified 
Be sure to execute the c17 rpf command before the target 
and load commands.

10-198 10.9 Parameter files Description modified 
Command execution sequence modified

10-198 10.9 Parameter files Description modified 
Example of parameter files modified.

10-199 10.9 Parameter files Description added 
(2) CHIP CPU name

10-199 10.9 Parameter files Description modified 
Description of (3) modified.

10-200 10.9 Parameter files Description modified 
The TTBR address is set to 0x8000.



Code No. Page Chapter/Section Description of revision

411086606 10-201 to 10-
203

10.10.2 Error Messages Description modified 
Table 10.10.2.1 error message modified

10-204 10.11 Embedded System 
Simulator (ES-Sim17)

Description modified 
Chapter No. of "Restrictions" modified.

11-3 to 11-5 11.1.4 make files Description modified 
Created make file example modified

11-66 11.12.2 Procedures for Stand-
Alone flash Writer

Description modified 
0x8000 →8000

11-67 11.12.2 Procedures for Stand-
Alone flash Writer

Description modified 
"readme_j.txt" → "readme"

11-67 11.12.2 Procedures for Stand-
alone flash Writer

Description added 
(7) Example 2 added

11-68 11.13 Old Debugger 
VersionThis

Item added 
Section 11.13 "Old version debugger" added

QR-2 Quick Reference Description modified 
Software development flow diagram modified

QR-4 to QR-6 Quick Reference Description modified 
Menu bar descriptions modified

QR-13 Quick Reference Description modified 
Main command line option table modified

QR-14 Quick Reference Description modified 
"as -otest.o -adhl test.s" → "as -o test.o -adhl test.s"

QR-15 Quick Reference Description added 
"Error : Failed to hash symbols." added.

QR-16 Quick Reference Description modified 
Flowchart diagram modified

QR-17 Quick Reference Description added 
/* stack pointer symbols */ 
 __START_stack = 0x000FC0;

QR-18 Quick Reference Description modified 
Flowchart diagram modified

QR-18 Quick Reference Description modified 
Command line option table modified

QR-19 Quick Reference Description modified 
Description modified following screen changes

QR-20 Quick Reference Description modified 
Menu description modified

QR-21 Quick Reference Description modified 
Menu description modified

QR-21 Quick Reference Description deleted 
gdb main screen shortcut key list deleted

QR-22 Quick Reference Description modified 
Break, map information, flash memory operation tables 
modified

QR-23 Quick Reference Description modified 
Other error messages table modified

QR-24 Quick Reference Description modified 
Error messages table modified

－ International Sales Operation phone and fax numbers changed (EPSON CHINA and 
SHANGHAI BRANCH)



Devices
S1 C 17xxx f 00E1

Packing specifications
00 : Besides tape & reel
0A : TCP BL 2 directions
0B : Tape & reel BACK
0C : TCP BR 2 directions
0D : TCP BT 2 directions
0E : TCP BD 2 directions
0F : Tape & reel FRONT
0G: TCP BT 4 directions
0H : TCP BD 4 directions
0J : TCP SL 2 directions
0K : TCP SR 2 directions
0L : Tape & reel LEFT
0M: TCP ST 2 directions
0N : TCP SD 2 directions
0P : TCP ST 4 directions
0Q: TCP SD 4 directions
0R : Tape & reel RIGHT
99 : Specs not fixed

Specification

Package
D: die form; F: QFP, B: BGA

Model number

Model name
C: microcomputer, digital products

Product classification
S1: semiconductor

Development tools
S5U1 C 17000 H2 1

Packing specifications 
00: standard packing

Version 
1: Version 1

Tool type
Hx : ICE
Dx : Evaluation board
Ex : ROM emulation board
Mx: Emulation memory for external ROM
Tx : A socket for mounting

Cx : Compiler package
Sx : Middleware package
Yx : Writer software

Corresponding model number
17xxx: for S1C17xxx

Tool classification 
C: microcomputer use

Product classification 
S5U1: development tool for semiconductor products 

00

00

Configuration of product number





S
5U

1C
17

00
1C

 M
an

u
al

General

Install

SoftDev

SrcFiles

IDE

Compiler

Library

Assemblr

Linker

Debugger

Tools

 Reference

1  general
2  Installation
3  Software Development Procedures
4  Source files
5  gNU17 IDE
6  C Compiler
7  library
8  Assembler
9  linker
10  Debugger
11  Other Tools
Quick Reference





INTRODUCTION

S5U1C17001C MANUAl Seiko Epson Corporation i
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

Introduction

This document describes the development procedure from compiling C source files to debugging and creating the 
mask data which is finally submitted to Seiko Epson. It also explains how to use each development tool of the 
S1C17 Family C Compiler Package common to all the models of the S1C17 Family.

How To Read the Manual

This manual was edited particularly for those who are engaged in program development. Therefore, it assumes that 
the reader already possesses the following fundamental knowledge:
• Knowledge about C language (based on ANSI C) and C source creation methods
• Knowledge about the gnu C, binutils, gnu make and the linker script for the gnu linker (ld)
• Basic knowledge about assembler language
• Basic knowledge about the general concept of program development by a C compiler and an assembler
• Basic operating methods for Windows XP.

Please refer to manuals or general documents which describe ANSI C, gnu tools and Windows‚ for the above con-
tents.

Before installation
 See Chapter 1. Chapter 1 describes the composition of this package, and provides a general outline of each tool.

Installation
 Install the tools following the installation procedure described in Chapter 2.

To understand the flow of program development and the operating procedure
 See the Tutorial described in Chapter 3. This will give you an overview of program development using the C 

compiler to the debugger and how to make the mask data.

for coding
 See the necessary parts in Chapter 4. Chapter 4 describes notes on creating source files and the grammar for the 

assembler language. Also refer to the following manuals when coding:
 S1C17xxx Technical Manual
  Covers device specifications, and the operation and control method of the peripheral circuits.
 S1C17 Core Manual
  Has the instructions and details the functions and operation of the Core CPU.

for debugging
 Chapter 10 explains details of the debugger. Sections 10.1 to 10.6 give an overview of the functions of the de-

bugger. See Section 10.7 for details of the debug commands. Also refer to the following manuals to understand 
operations of the debugging tools:

 S1C17 Family In-Circuit Debugger Manual
  Explains the functions and handling methods of the ICD Mini (S5U1C17001H).

for details of each tool
 Refer to Chapters 5 to 11 and gnu tool manuals for details.
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Manual Notations

This manual was prepared by following the notation rules detailed below:

Samples
 The sample screens provided in the manual are all examples of displays under Windows XP. These displays 

may vary according to the system or fonts used. 

Names of each part
 The names or designations of the windows, menus and menu commands, buttons, dialog boxes, and keys are 

annotated in brackets [ ]. Examples: [Command] window, [File] menu, [Stop] button, [q] key, etc.

Names of instructions and commands
 The CPU instructions and the debugger commands that can be written in either uppercase or lowercase charac-

ters are annotated in lowercase characters in this manual, except for user-specified symbols. A fixed-width 
font is used to describe these words.

Notation of numeric values
 Numeric values are described as follows:
 Decimal numbers: Not accompanied by any prefix or suffix (e.g., 123, 1000).
 Hexadecimal numbers: Accompanied by the prefix "0x" (e.g., 0x0110, 0xffff).
 Binary numbers: Accompanied by the prefix "0b" (e.g., 0b0001, 0b10).
 However, please note that some sample displays may indicate hexadecimal or binary numbers not accompanied 

by any symbol.

Mouse operations
To click: The operation of pressing the left mouse button once, with the cursor (pointer) placed in the 

intended location, is expressed as "to click". The clicking operation of the right mouse button 
is expressed as "to right-click".

To double-click: Operations of pressing the left mouse button twice in a row, with the cursor (pointer) placed 
in the intended location, are all expressed as "to double-click". 

To drag: The operation of clicking on a file (icon) with the left mouse button and holding it down 
while moving the icon to another location on the screen is expressed as "to drag".

To select: The operation of selecting a menu command by clicking is expressed as "to select".

Key operations
 The operation of pressing a specific key is expressed as "to enter a key" or "to press a key".
 A combination of keys using "+", such as [Ctrl]+[C] keys, denotes the operation of pressing the [C] key while 

the [Ctrl] key is held down. Sample entries through the keyboard are not indicated in [ ].
 In this manual, all the operations that can be executed with the mouse are described only as mouse operations. 

For operating procedures executed through the keyboard, refer to the Windows manual or help screens.

general forms of commands, startup options, and messages
 Items given in [ ] are those to be selected by the user, and they will work without any key entry involved. 
 An annotation enclosed in < > indicates that a specific name should be placed here. For example, <filename> 

needs to be replaced with an actual file name.

Development tool name
ICD: Indicates the ICD Mini (S5U1C17001H) or the ICD board.
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1.1  features
The S1C17 Family C Compiler Package contains software development tools for compiling C source files, 
assembling assembly source files, linking object files, debugging executable files, making mask data and other 
utilities. The tools are common to all the models of the S1C17 Family.
Its principal features are as follows:

Powerful optimizing function
 The C Compiler is designed to suit to the S1C17 architecture, it makes it possible to deliver minimized codes. 

The high-optimize ability does not lose most of the debugging information, and it enables C source level 
debugging.

Useful extended instructions are provided
 The extended instructions allow the programmer to describe assembly source simply without the need of 

knowing the data size. The immediate data extension using the "ext" instruction and some useful functions 
that need multiple basic instructions are described with an extended instruction. 

C and assembly source level debugger with a simulator function
 The debugger supports C source level debugging and assembly source level debugging. By using an ICD, the 

program can be debugged even when the target board is operating. It also allows use of the S1C17MCU core 
simulator or ES-Sim17 to simulate typical S1C17 device peripheral circuits. (For specific information on the 
compatibility of various devices with ES-Sim17, refer to Section 10.11, "Embedded System Simulator (ES-
Sim17)".)

Integrated development environment for Windows
 Designed to run under Microsoft Windows XP and Windows Vista, the GNU17 IDE is a seamless integrated 

development environment suitable for a wide range of development tasks, from source creation to debugging.
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1.2  Outline of Software Tools
The following shows the outlines of the principle tools included in the package.

(1) C Compiler (xgcc.exe)
 This tool is made based on GNU C Compiler and is compatible with ANSI C. This tool invokes cpp.exe and 

cc1.exe sequentially to compile C source files to the assembly source files for the S1C17 Family. It has a 
powerful optimizing ability that can generate minimized assembly codes. The xgcc.exe can also invoke the 
as.exe assembler to generate object files.

(2) Assembler (as.exe)
 This tool assembles assembly source files output by the C compiler and converts the mnemonics of the 

source files into object codes (machine language) of the S1C17 Core. The as.exe allows the user to invoke the 
assembler through xgcc.exe, this makes it possible to include preprocessor directives into assembly source files. 
The results are output in an object file that can be linked or added to a library. 

(3) linker (ld.exe)
 The linker defines the memory locations of object codes created by the C compiler and assembler, and creates 

executable object codes. This tool puts together multiple objects and library files into one file.

(4) Debugger (gdb.exe)
 This debugger serves to perform source-level debugging by controlling an ICD. It also comes with a simulator 

function that allows debugging on a personal computer. 
 The gdb.exe supports Windows GUI. Commands that are used frequently, such as break and step, are registered 

on the tool bar, minimizing the necessary keyboard operations. Moreover, various data can be displayed in 
multi windows, with a resultant increased efficiency in the debugging tasks. 

(5) librarian (ar.exe)
 This tool is used to edit libraries. The ar.exe can register object modules created by the C compiler and 

assembler to libraries, delete object modules in libraries and restore library modules to the original object files.

(6) Make (make.exe)
 This tool automatically executes from compile to link according to the command lines described in the make 

file. The basic make file can be created by the IDE.

(7) gNU17 IDE (eclipse.exe)
 The development workbench provides an integrated development environment for a wide range of development 

tasks, from source creation to debugging.

This package contains other gnu tools, sample programs and several utility programs. For details on those 
programs, please refer to "readmeVxx.txt" (xx indicates version) on the disk.

Note: Only the command options for each tool described in the respective section are guaranteed to 
work. If other options are required, they should only be used at the user's own risk.
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 This chapter describes the required working environments for the tools supplied in the S1C17 Family C 
Compiler Package and their installation methods. 

2.1  Working Environment
To use the S1C17 Family C Compiler Package, the following conditions are necessary:

Personal computer
 An IBM PC/AT or a compatible machine which is equipped with a CPU equal to or better than a Pentium4 1.50 

GHz, and 512MB or more of memory is recommended. 
 To use an optional ICD, a USB port is required.

Display
 A display unit capable of displaying 1,024 × 768 dots or more is recommended.

Note: Selecting an ultra-large font and high contrast in the Windows "Display Properties" may prevent 
proper display of the IDE screen. Furthermore, "Color quality" should be set to 16 bits or higher.

Hard drive
 The hard drive must have at least 500MB of empty space to install the S1C17 Family C Compiler Package.

Mouse
 A mouse is necessary to operate the tools. 

Debugging tool
 To debug the program and the target system, an optional ICD is needed in addition to this software package.

System software
 The tools support Microsoft Windows XP or Windows Vista (English or Japanese version).

Note: The tools do not support 64-bit operating systems.

User account
 Run the S1C17 Family C Complier Package with Administrator privileges.

Other
• Please go through the precautions and restrictions given in "readmeVxx.txt" (English, Japanese) (xx indicates 

version) on the disk. 

• Running the tools in this package presumes the presence of cygwin1.dll. Although cygwin1.dll is stored in 
the \gnu17 directory, if cygwin1.dll is already installed on your system, the duplication may cause problems. 
If so, remove the copy of cygwin1.dll installed in your system or exclude it from the environment variable 
PATH settings to ensure that the file referenced is always the copy of cygwin1.dll located in the \gnu17 
directory. 
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2.2  Installation Method

Installing the tools

(1) Start Windows XP/Vista.
If Windows is already running, close all other programs that are currently open.

(2) Download the compressed S5U1C17001C file from the EPSON user site and expand it in the desired 
folder..

(3) Double-click Setup.exe to launch the installer.

You will see the install wizard start screen.
 (4) Click the [Next >] button to go to the next step.

Read the end user software license agreement displayed 
on the following screen.

(5) If you agree to the terms of the license, select "I 
accept the terms of the license agreement" and click 
the [Next >] button. If you do not agree, click the 
[Cancel] button to close the installer.

The screen displayed allows you to select the directory 
into which the gnu17 tools are to be installed.

(6) Check the destination directory in which the tool 
will be installed. 

 To switch to a different directory, use the [Browse...] 
button to bring up a directory selection dialog box. 
From the list in this dialog box, select the directory 
in which you want to install the tools, or enter a path 
to the desired directory in the [Path] text box. Click 
the [OK] button.

(7) Click the [Next >] button.
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This is the install start screen.

(8) Click the [Install] button to begin installing.

When installation is completed, a complete screen is 
displayed.

(9) Click the [Finish] button to quit the installer.

This completes installation of the tools.

 Assuming installation finished successfully, an [EPSON MCU] > [GNU17vx.x] menu will be added to the 
Windows startup menu.
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Installed files
 The following lists the configuration of directories and files after copying.

 \EPSON (default)
   \gnu17 (root DIR of gnu17 tool)
  readmeVxx.txt :  Description of the tool (English and Japanese)
  Copying.GNU :  GNU general public license

  xgcc.exe  :  Gnu C compiler (cpp.exe and cc1.exe are used)
  xgcc_filt.exe :  Kanji filter (same as xgcc.exe)
  cpp.exe  :  Preprocessor
  cc1.exe  :  Compiler

  as.exe  :  Assembler
  ld.exe  :  Linker
  objdump.exe :  Object file dump tool
  objcopy.exe :  Converts obj files to the specified format (e.g., S-record format).

  gdb.exe  :  Debugger
  gdbtk.ini :  gdb initialization file
  gnuProf.exe :  Profiler executable file
  gnuCvrg.exe :  Coverage executable file
  cygitcl30.dll :  dll for gdb
  cygitk30.dll :  dll for gdb
  cygtcl80.dll :  dll for gdb
  cygtk80.dll :  dll for gdb
  tix4180.dll :  dll for gdb
  cygwin1.dll :  dll for compiler, binutils, etc.
  cygiconv-2.dll :  dll for cygwin1.dll
  cygintl-3.dll :  dll for cygwin1.dll
  cygintl-8.dll :  dll for cygwin1.dll
  gnustdin.dll :  dll for simulated input
  reset.gdb :  Command file executable by Reset button
  userdefine.gdb :  Command file executable by User button
  savebreak.gdb :  Command file for commands related to saving breakpoints
  loadbreak.gdb :  Command file for commands related to resetting breakpoints
  kill.exe  :  Forced break
  c17_cmd_ref_eng.chm :  Old GDB command reference (English version)
  c17_cmd_ref_jpn.chm :  Old GDB command reference (Japanese version)

  make.exe :  Make execution
  ar.exe  :  Library file creation/update
  cp.exe  :  File copying
  rm.exe  :  File deletion
  sed.exe  :  Stream editor
  sh.exe  :  Bourne shell
  ccap.exe  :  Console capture
  moto2ff.exe :  Tool for filling gaps in Motorola-format file with FFs
  sconv32.exe :  Tool for converting Motorola-format file to S2 record file
  DIFF.EXE :  File comparison utility
  vecChecker.exe :  Vector checker for coprocessor

  \include  :  Header file to ANSI C library
  \lib
  \16bit  :  Library for 16-bit address space
   libc.a :  ANSI C library
   libgcc.a :  Emulation library
   libgccM.a :  Emulation library (coprocessor multiplication instructions supported)

  libgccMD.a : Emulation library (coprocessor multiplication/division/remainder 
instructions supported)

   libstdio.a :  Library for simulation IO
  \24bit  :   Library for 24-bit address space (file structure is the same as that of \16bit)
 \eclipse
  eclipse.exe :  GNU17 IDE executable file
  eclipse.ini :  Eclipse settings file
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  .eclipseproduct :  Eclipse version information
  epl-v10.html :  EPL license
  notice.html :  Software agreement
  gnu17_32_trans.ico :  gnu17 icon file
  artifacts.xml :  Eclipse update manager file
  \configuration :  Startup configuration file and other files
  \dropins  :  plug-in folder (empty folder)
  \features  :  Features
  \jre   :  Java virtual machine
  \p2   :  Eclipse update manager folder
  \plugins  :  Plug-in
  \readme  :  Release note
 \essim17   :  Embedded system simulator
 \utility    :  Utility
 \tool    :  Middleware and other tools
 \dev    :  ROM data production tool
 \sample    :  Sample file
 \mcu_model   :  Model-specific information tool
 \doc    :  Manual and other documents

 Refer to the "readmeVxx.txt" for the contents of the "sample" and "utility" directories.

Precaution when installing over existing version
 If the gnu17 tools have been installed over the old version, changes in the GNU17 IDE may not be reflected in 

the new version just installed. If this happens, temporarily close GNU17 IDE, then start from the command line 
prompt, as described below.

 C:\EPSON\gnu17\eclipse>eclipse.exe -clean

Precautions on setting the OS
   • Select to "regular" font size in "Display Properties".

   • When using a drive on the network as the tool and/or work drive, be sure to assign a drive name to it. The 
network name cannot be used.

   • Do not use the USB port for the ICD in other drivers and applications. Furthermore, make sure that the port has 
been enabled when using a note PC as some can disable USB port.

   • If the gdb debugger or GNU17 IDE have a problem on the GUI that causes an abnormal display, decrease 
the function level of the graphics or use a low-level standard display driver which has been supplied in the 
Windows package.

Uninstalling the tools
 To uninstall the tools, select [UnInstall] from [EPSON MCU] > [GNU17] in Windows startup menu, then click 

the [OK] button in the subsequent dialog box.

   

→

   

 You also can use Add/Remove Programs in the Control Panel to uninstall the tools.
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Note: • If  you set the \EPSON\gnu17\eclipse\workspace directory in the workspace, make a backup 
of the workspace directory before removing the tools. (Projects are saved to this directory.) 

 • The [EPSON MCU] > [GNU17] folder in the Windows Start menu may sometimes not be 
deleted even after uninstalling. If this occurs, it should be deleted manually.

About the license 

 gNU
 The C compiler tools in this package is made based on the GNU C Compiler designed by Free Software 

Foundation, Inc. Please read the "Copying.GNU" text file for the license before using.

 EPl
 GNU17 IDE complies with the Open Source Initiative EPL (Eclipse Public License) 1.0. For more information 

on the EPL, refer to epl-v10.html in the \gnu17\eclipse directory.
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3  Software Development Procedures

3.1  Software Development flow
Figure 3.1.1 shows typical software development flow.
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Figure 3.1.1  Software development flow
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As shown above, the tools included with this package handle all software processing required after creating a 
source program. All basic operations except debugging are performed in the GNU17 IDE (hereafter the IDE).
The development flow is outlined below.

(1) Creating a project
 Use the IDE to create a new project. The system will set up the project file needed to collectively manage the 

software resources of the application to be developed and a workspace directory in which those resources are 
stored.

(2) Creating a source program
 Use the IDE editor or a general-purpose editor to create a source file and add it to the project.

(3) Building a program
 Start by using the IDE to set startup options for the tools from the C compiler to the linker and linker scripts.
 Then execute a build process from the IDE. The system will execute make.exe using the makefile (generated 

according to the set content), generating object files in debuggable ‘elf’ format and ROM data files (psa files), 
which are created by converting object files into S-record format.

 The necessary processing is automatically executed sequentially in the following operations according to the 
makefile.

• Compile (for C sources)
 The source files are compiled by the xgcc C compiler, generating the object files (.o) are to be input to the ld 

linker.

• Assemble (assembler sources)
 The assembler source files are assembled by the as assembler to generate the object files (.o) to be input to 

the ld linker.
 If the source files include preprocessor instructions, use xgcc to perform preprocessing and assembly. When 

the necessary options are specified, xgcc will execute the cpp preprocessor and the as assembler.

• Link
 The compilation and assembly operations described above will prepare one or multiple object files required 

for subsequent processing. The ld linker then generates an executable object file capable of being loaded and 
executed in the target ROM, namely ‘elf’ format object files that include information required for debugging, 
etc.

• S-record conversion
 Launches objcopy/moto2ff/sconv32 and outputs S-record-format ROM data files (psa files) from ‘elf’ format 

object files.
 Use the objcopy object file format conversion utility to create HEX files for writing programs to external 

ROM or internal ROM from ‘elf’ format object files generated by the ld linker.
 Then convert the HEX file for the internal ROM into a Motorola S2 file in which the unused area is filled 

with 0xff by moto2ff and sconv32.
 Using the ROM data file created above, perform final verification of program operation on the actual target 

board.

(4) Debugging
 Use ‘elf’ format object files generated by the ld linker and S-record format ROM data file (psa file) to perform 

verification and debugging with the gdb debugger. Although an ICD can be used to debug hardware as well as 
software operation, the gdb has simulator mode that allows the PC to emulate device operations as the S1C17 
Core and memory models.

 Debugger setting and startup can be performed from the IDE.
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(5) Creating ROM data and mask data
 Use the object file format conversion utility objcopy to create HEX files for writing the program into external and in-

ternal ROMs from the ‘elf’ format object files generated by the ld linker. Then, convert the HEX file for the internal 
ROM into a Motorola S2 file in which the unused area is filled with 0xff using moto2ff and sconv32. After creating 
the ROM data file according to the above procedure, be sure to perform the final verification of program operation on 
the actual target board using that file. Finally, pack the verified ROM data file (psa file) and the mask option data file 
generated by winfog17 into a mask data file using winmdc17 and present it to Seiko Epson.

 Note that winfog17 and winmdc17 can be started by the IDE.

In addition to the tools described above, the C compiler package comes with the ar librarian. This tool organizes 
modules for general-purpose processing (e.g., object files output by the as assembler) as a library, facilitating future 
applications development involving the S1C17 Family.
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3.2  Software Development Using the IDE
This section describes software development procedures using the IDE separately in several different cases. The 
actual operations are detailed in other tutorial sections in this manual.

First, before starting software development with the IDE, create a folder labeled "project" for each application. Use 
this folder to manage necessary resources.
If no projects are created in the IDE, software development with the IDE will start with project creation. The same 
applies when creating an entirely new application or when using one of programs created with an earlier version of 
the S1C17 tools.
If a project has already been created in the IDE, it is possible to migrate projects from another environment or to 
upgrade program versions by importing that project folder.

Creating a 
new project

When generating makefiles, etc. automatically by the IDE

•Ordinary program development
•Building and debugging requires the creation of source files

When using the makefiles, etc. prepared by the user

•Reuse/revision, etc. of programs not created with the IDE
•Increased user freedom of build and debugger startup
• makefile and IDE configurations requires modification

Reference

(1) Creating a new project 1

3.3 Tutorial 1 (Basic Operations, from Project Creation 
 to ROM mask Data)

Importing an 
existing 
project

•Project migration from another environment
•Program revision, etc.

Reference

(3) Importing an existing IDE project

3.5 Tutorial 3 (Importing an IDE Project)

Reference

(2) Creating a new project 2

3.4 Tutorial 2 (Using the User Makefiles)

Figure 3.2.1  Software development with the IDE
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(1) Creating a new project 1
 This is the conventional procedure for developing software with the IDE. The user creates source files, after 

which the IDE automatically generates all other files required for build processing and debugger startup.
 The basic procedural flow is given below.

Create a new project

Edit source files

Specify build options

Set a linker script (link map)

Build (compile  link)

Set debugger startup

Start the debugger

Close the debugger

Debug

Error?

OK?

Create and edit source files using the IDE.
You can also import source files created in other editors.

IDE

Debugger

Select C compiler, assembler, and linker options.
From

second
time

yes

yes

no

no
From

second
time

Set section information and location.
Linker script files are generated automatically by the IDE.

Run make.exe to execute the makefile generated 
automatically by the IDE.

You can jump from an error message to the editor line 
containing the error.

Set parameter file map information and connect
mode, etc.

Completed

Start the gdb debugger. The gdb debugger executes 
the command file generated automatically by the IDE.

Start the IDE

Figure 3.2.2  Procedural flow (makefiles, etc. generated automatically by the IDE)

 For detailed information on basic operations, from starting the IDE to debugging the program, refer to Section 
3.3, "Tutorial 1 (Basic Operations, from Project Creation to ROM mask Data)".
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(2) Creating a new project 2
 When developing new software, a user makefile or a debug command file may be used instead of generating 

files automatically with the IDE. 
 The basic procedural flow is given below.

Create a new project

Import files

Edit source files

Edit user's build/debug files

 Alter IDE settings

Specify build options

Set a linker script (link map)

Build (compile  link)

Set debugger startup

Start the debugger

 Close the debugger

Debug

Error?

OK?

Create and edit source files in the IDE.

IDE

Debugger

Not required when using the user's makefiles.

Correct the makefiles, linker script files, parameter 
files, and debugger command files.

In addition to source files, existing or user-created 
makefiles, linker script files, parameter files, and 
debugger command files may be imported for use 
in this operation.

From
second

time

yes

yes

no

no
From

second
time

Not required when using the user's linker script files.

This setting is required to use the user's build/debug 
files.

Run make.exe to execute a build process.

You can jump from an error message to the editor line 
containing the error.

Not required when using the user's parameter and 
debug command files.

Completed

Start the gdb debugger.
The user's debug command file can be specified.

Start the IDE

Figure 3.2.3  Procedural flow (using the user's makefiles, etc.)

 For detailed information on building a program with the IDE, refer to Section 3.4, "Tutorial 2 (Using the User 
Makefiles)", which describes the procedure for building a sample program using a user makefile.

 To use user makefiles, you must correct the makefile itself and alter the settings made in the IDE. Unless doing 
so would result in problems, we recommend using the files automatically generated by the IDE.
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(3) Importing an existing IDE project
 If you have an existing project, you can simply import the project to continue working on your development or 

revisions. The project properties are inherited, so that re-configuration or other such operations are not required 
unless you intend to change them. However, project management files must remain intact in the project folder 
to be able to import projects.

 The basic procedural flow is given below.

Import a project

Edit source files

Specify build options

Set a linker script (link map)

Build (compile  link)

Set debugger startup

Start the debugger

Close the debugger

Debug

Error?

OK?

Create and edit source files in the IDE.

IDE

Debugger

Only when changes are needed.

Only when changes are needed.

Only when changes are needed.

Select and import a project file.

From
second

time

yes

yes

no

no
From

second
time

Run make.exe to execute a build process.

You can jump from an error message to the 
editor line containing the error.

Completed

Start the gdb debugger.

Start the IDE

Figure 3.2.4  Procedural flow (importing an IDE project)

 For detailed information on how to import a project, refer to Section 3.5, "Tutorial 3 (Importing an IDE Proj-
ect)", which describes the procedure for importing a sample program created with the IDE.
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3.3  Tutorial 1 (Basic Operations, from Project Creation to ROM 
mask Data)

This section provides a tutorial based on a sequence of basic operations from IDE startup to debugging to creation 
of the ROM data file. For detailed information on each tool, refer to the sections in which the respective tools are 
described.

Files used
 This discussion assumes that the sample source files listed below are present in the c:\EPSON\gnu17\ 

sample\S1C17common\simulator\tst directory.
 boot.s Assembler source file
 main.c C source file

Described below is range of operations for creating a project, building a program, and verifying program operation 
using the above two source files. Note that this discussion assumes that you are using the IDE for the first time af-
ter installing the tools. If you have taken any actions in the IDE, the example screens may not match the ones you 
see on your PC.

3.3.1  Starting the IDE

Step 1: Double-click the eclipse.exe icon in the c:\EPSON\gnu17\eclipse directory to start the 
IDE. You also can start the IDE by selecting [EPSON MCU] > [GNU17] > [GNU17 IDE] from 
the Windows Start menu.

After an Eclipse splash screen, the [Workspace Launcher] dialog box shown below will appear. Specify the work-
space (directory) in which you want to save the project resources and output files.

 

This tutorial uses the default workspace directory. You can select any directory or create a new directory and set it 
as the workspace.

* Do not specify the project directory (directory containing .project file) as a workspace directory. Doing so may 
result in failures with project imports (when [Copy projects into workspace] is selected).

Step 2: Click the [OK] button.

The IDE window shown below will be displayed.
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View

To quit before completing the tutorial, select [Exit] from the [File] menu of the IDE. Or use the window's  
(close) button. When the following dialog box appears, click the [OK] button to quit or the [Cancel] button to 
cancel quitting.

Editor area
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3.3.2  Creating a Project

In applications development, a single executable program file is created from multiple source files. To manage 
these files in one location, you must create a project. The IDE generates programs on a per-project basis. In a 
sense, the project is the application program you want to develop, but the project actually created is a directory 
with a specified project name, wherein files containing project information (.cproject, .gnu17project, and 
.project) are generated.

To create a new project
Step 3: Select [New GNU17 Project] from the [New] pulldown menu in the toolbar.

You can also select [New GNU17 Project] from the [File] menu or from [New] on the 
context menu (displayed by right-clicking) in the [C/C++ Projects/Navigator] view.

 The [New GNU17 Project] wizard will start.
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Specifying a project name

Step 4: Enter the project name "sample" in the [Project name:] text box.

 Leave the [Use default location] check box selected. A project folder named "sample" will be generated in the 
workspace directory you specified when the IDE started.

 The executable object file (.elf) generated when building a project is assigned the name you specify here.

Step 5: Click the [Next>] button.

 The system will go to the next screen, where you select a target CPU, memory model and vector table file.
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Specifying a target CPU
Step 6: From the [Target CPU Device] combo box, select the target processor. Here, se-

lect "S1C17".

Selecting a memory model
Step 7: Select the memory model supported by the processor from the [Memory Model] 

combo box. Here, select "REGULAR".
 REGULAR: 24-bit address space (16MB)
 MIDDLE: 20-bit address space (1MB)
 SMALL: 16-bit address space (64KB)

Selecting a coprocessor library
 Depending on the selected target CPU, you can specify whether to link a coprocessor library and its type.

Step 8: Select or unselect the [Use Co-processor Library] checkbox.
 ON: Adds the setting to link the coprocessor library libgccMD.a (for multiplication and division) 

or libgccM.a (for multiplication) when creating a project. If you select this option, select the 
library type from the [Select the Co-processor library type] combo box. (Certain models offer 
just one selection option.)

 OFF: Adds the setting to link the ordinary emulation library libgcc.a when creating a project.

Specifying a vector table file
 The IDE requires the definition of a vector table section labeled .vector in a linker script to ensure that the 

trap vectors located in memory always begin with the trap table base address. In the [Use '.vector' section as a 
vector table container] field of this screen, specify whether to locate a specific object in the .vector section 
by selecting or unselecting the check box and set an object file name in the combo box. Here, we'll proceed as-
suming that boot.o is located in the .vector section.

Step 9: Select boot.o from the pulldown list.

 For detailed information on the .vector section, refer to Section 5.7.8, "Editing a Linker Script".

Specifying a boot vector address
 In the [Specify boot vector address] field, specify a boot vector address. The default boot vector address is 

"008000". The value set here will be used as the parameter for the TTBR setting command that will be written 
in the debugger startup command file created by the IDE as well as it will be used as the VMA of the .vector 
section that will be written in the linker script file. It is not necessary to alter the default value.



S5U1C17001C MANUAl Seiko Epson Corporation 3-13
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

3  SOfTWARE DEVElOPMENT PROCEDURES

3
SoftDev

Specifying the stack pointer address
 The stack pointer address is specified in the [Set stack pointer address] field.
 The default stack pointer address setting is "000FC0".
 The value set here forms the value for the linker script file __START_stack symbol created automatically by 

the IDE, allowing the symbol to be used as the start address of the stack area.
 Example: This can be defined in the boot routine as shown below.
 boot:

  xld.a   %sp, __START_stack

Step 10: Click the [Finish] button.

 The [New GNU17 Project] wizard will be closed, creating a project with the specified name.

 The target CPU, memory model, and co-processor library selections can be changed later, as can the vector 
table file and stack pointer address specification.
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3.3.3  Creating, Adding, and Editing a Source file

The IDE supports C and assembler to allow generation of an object from source files created in those languages.
All source files required to generate an object must be added to the project created earlier.

Creating a source file
 Use the IDE editor or a general-purpose editor to create a source file. You can also use an existing source file in 

the application you created for the S1C17 Family.
 In this tutorial, we will use the source files prepared as examples.
 For detailed information on creating a new source file with the IDE, refer to Section 5.5, "The Editor and Edit-

ing Source Files".

Adding a source file
 Load the source files prepared as samples into the project.

Step 11: Select [Import...] from the [File] menu.

 The [Import] wizard will start.

Step 12: From the list displayed, select [General] > [File System] and click the [Next>] button.
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Step 13: Click the [Browse...] button for [From directory:]. The [Import from directory] dialog box will be dis-
played, so select the \EPSON\gnu17\sample\S1C17common\simulator\tst directory from 
the drive (C) in which you installed the IDE and click [OK].
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 The directory you selected is displayed in the left-side list box, while the files contained in the directory are 
listed in the right-side list box.

Step 14: Select "boot.s" and "main.c" from the file list. Click to select the check box shown before the 
file name (flagged by a check mark when selected).

Step 15: Click the [Browse...] button for the [Into folder:]. This displays the [Import into Folder] dialog box. 
Select the "sample" folder and click [OK].
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Step 16: After confirming that the dialog box is filled out as shown above, click the [Finish] button.

 This procedure adds "boot.s" and "main.c" to the project.

Step 17: Double-click "sample" in the [C/C++ Projects] view, or click [+] shown before "sample".

 The added source files are displayed in the "sample" folder in the [C/C++ Projects] view.

Step 18: Click [+] for "main.c" in the [C/C++ Projects] view.

 The global variables and functions defined in the file are displayed for C sources.
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Displaying and editing source files
 Use the IDE editor to display and edit source files added to the project.

Step 19: Double-click "main.c" in the [C/C++ Projects] view.

 The contents of main.c are displayed in the editor. Here, you can correct the source as with a general-purpose 
editor. Furthermore, you can set up the editor so that selected files will be opened in a general-purpose editor 
you normally use.

 For detailed information, refer to Section 5.5, "The Editor and Editing Source Files".

 If C sources are displayed, reserved words, comments, and C strings are highlighted in color.
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Step 20: Click "main" in the [Outline] view.

 The editor will jump to the line where main() exists and highlight it. Furthermore, a bar indicating the range 
of the main() function will be displayed in the marker bar on the left side of the editor window. This way the 
editor allows you to inspect functions, etc. easily.

Step 21: Double-click "boot.s" in the [C/C++ Projects] view.

 Multiple sources can be opened at the same time. Click the tab at the top of the editor window (where a file 
name is displayed) and select the source you want to display or edit.

 When assembler sources are displayed, the labels, directives, and registers are highlighted.

Step 22: Click the  (close) button on the editor tab of each open source to close the editor.

Marker bar
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3.3.4  Editing the Build Options and the linker Script

To build a project (to generate an executable object file), make.exe is used to start the compiler, assembler, and 
linker. Although the makefiles required for make are generated automatically by the IDE, the build options to be 
written in those files (i.e., compiler, assembler, and linker startup options) must first be set before they can be used. 
Furthermore, the contents of the linker script files required for link operation must also be set before a project can 
be built.
The method for making these settings is outlined below.

Setting build options
Step 23: Select [Properties] from the [Project] menu. You also can select [Properties] from the context menu that 

pops up when you right-click on the project name "sample" in the [C/C++ Projects] view.

 The [Properties] dialog box will be displayed.

Step 24: From the properties list on the left side of the dialog box, select [GNU17 Build Options] by clicking 
on it to display the [Build Options] tab page.

 

 You can set command line options here for the compiler, assembler, linker, and vector checker.
 Click to select one of the tool names shown in tree form (Compiler, Assembler, Linker, or Vector Checker for 

Copro) and display the currently selected options in the [All Options] column. Select the kind of option from 
those shown in tree form by clicking on it, and the options of the selected kind will be enabled, allowing you to 
set.

 Currently displayed here are the options that have been set by default when you created a new project.
 For the contents of options, refer to the respective chapters in this manual in which each tool is described. For 

detailed information on option select screen, refer to Section 5.7, "Building a Program".
 In this tutorial, although no particular changes are needed here, we'll take a look at the method on how to add a 

user include path and a library file.
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Adding an include path
 Steps 25 to 28 below are shown for reference only. No operation is required.

Step 25: Select [Compiler] > [Directories] from the [Build Options] tree.

 The page in which you set the C compiler's -I option (to specify an include path) will be displayed.

 

 If user header files are prepared in another directory, they should be added to this list following the procedure 
described below.

Step 26: Click the [Add] button. A directory select dialog box will be displayed, so enter a path or se-
lect one from the folder select dialog box that appears when you click the [File System...] but-
ton.

 When the directory select dialog box is closed, the path entered or selected is added to the list as shown below.
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 The features of other buttons are summarized below.
 [Delete] Deletes the path selected in the list.
 [Edit] Edits the path selected in the list. A dialog box is displayed in which you can modify the 

path.
 [Move Up] Moves the path selected in the list one place up in the list. Include files are searched sequen-

tially, beginning with the path uppermost in the list.
 [Move Down] Moves the selected path down in the list.

Step 27: Press the [Apply] button to confirm the changes made here.
 If you click the [Apply] or [OK] button after settings in a [GNU17 Build Options] page have been 

changed, a dialog box appears for selecting whether the files created with the previous settings will 
be deleted (and rebuild) or not. Click the [Cancel] button.

 The directory setting specified here provides the includes file paths for the C compiler to search from.

 Macro and environment variable to specify a path
 The [Include Paths (-I)] column lists "$(TOOL_DIR)/include" that is set by default.
 $(environment variable) is a macro defined in the makefile that is generated when you build a project. TOOL_

DIR is the environment variable in which the path to the gnu17 tool directory is defined. The defined contents 

can be verified in the [Environments] tab page.
 Example: If the gnu17 tools have been installed in the c:\EPSON\gnu17 directory
  TOOL_DIR = c:/EPSON/gnu17

 Since the macro is replaced with the contents of the environment variable described in () during execution of 
make.exe, -I$(TOOL_DIR)/include will be resolved to -Ic:/EPSON/gnu17/include.

 The [Environments] tab page allows the user to define environment variables similar to TOOL_DIR. 
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 The definition procedure is described below.

Step 28: Click the [New] button to display the [New Environment Setting] dialog box.
 Enter an environment variable name in the [Name:] text box.
 Type in using the keyboard or select using the [Browse...] button to enter a path in the [Path:] text 

box.
 Then click the [OK] button to close the dialog box.

 The environment variables defined here may be used for specifying include file and library file paths in the 
build options. The environment variable should be used as a $(environment variable) macro format when 
specifying a path option.

Adding a library file
 Steps 29 to 31 below are shown for reference only. No operation is required.

Step 29: Select [Linker] > [Libraries] from the [Build Options] tree.

 Displays the page in which a library file can be set.

 

 The [Libraries] column lists the ANSI library and emulation library included in this package.
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 If user library files are available, add them to this list following the procedure described below.

Step 30: Click the [Add] button. In the file select dialog box displayed, enter a file name or select one from 
the [Browse for Folder] dialog box displayed by clicking the [File System...] button.

 Paths can be specified using the environment variables that have been defined in the [Environments] tab page.
Close the file select dialog box to add the file entered or selected to the list as shown below.

 

 The features of other buttons are the same as for the include path described before.

Step 31: Press the [Apply] button to confirm the changes made here.
 If you click the [Apply] or [OK] button after settings in a [GNU17 Build Options] page have been 

changed, a dialog box appears for selecting whether the files created with the previous settings will 
be deleted (and rebuild) or not. Click the [Cancel] button.

 The library settings specified here will be used in the linking operation.

Setting a linker script
 A build process requires a linker script file. This file also can be created with the IDE.
 A linker script file is used to indicate the section location and configuration to the linker. For example, one 

object file generated by the assembler consists of sets of codes classified by data attributes, such as a program 
code part, static data part, and a variable part. A set of codes like these comprises a single section. To the linker, 
these represent an input section. The linker combines multiple input sections of the same kind into one (by re-
configuring them into an output section) to generate an executable object file. Furthermore, these sets of codes, 
even of the same attributes, must be separated by location address and device so that the program code part 
for the object generated from sources 1 and 2 is located at address A of the external ROM, and the program 
code part for the object generated from source 3 is located at address B of the internal ROM before they can be 
linked.

 Therefore, a linker script file specifies which input sections should be combined to configure one output sec-
tion, from which address a section should be stored in memory, and at which address a section should be ex-
ecuted. For more information, refer to Section 3.8, "Sections and Linkage".

Step 32: If you closed the [Properties] dialog box, select [Properties] from the [Project] menu to reopen it.

Step 33: Click to select [GNU17 Linker Script Settings] from the properties list.
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 You'll see that the five basic sections (output sections)—i.e., .bss, .data, .vector, .text, and .roda-
ta—are preset in [Section name] column.
.bss Section in which variables without initial values are placed. (Normally located in 

RAM.)
.data Section in which variables with initial values are placed. (The initial values are lo-

cated in ROM. They are copied into RAM when needed.)
.vector Section in which vector tables are placed. (The actual data is located in ROM.)
.text Section in which program codes are placed. (The actual data is located in ROM and 

executed there or from high-speed RAM after copying.)
.rodata Constant variables. (The actual data is located in ROM.)

 The VMA (Virtual Memory Address) is the position (start address) at which a section is placed during runtime. 
If a section does not have its start address indicated in the VMA column, it means that the section is to be lo-
cated following the immediately preceding section.

 The LMA (Load Memory Address) is the position (start address) in ROM at which the actual data is placed. 
If this column is marked with "-", it means that this address is the same as the VMA (i.e., the section will be 
executed or accessed at the position at which the actual data is placed). If this column is marked with "after 
(.rodata)", it means that the actual data is to be located following the section indicated in parentheses (in 

this case, the .rodata section).

 The Labels column shows the labels indicating the start and end addresses of an area in which the section will 
be located. If the LMA is not specified, two labels <beginning of VMA> and <end of VMA> are shown here. If 
the LMA is specified, four labels are shown in order of <beginning of VMA>, <end of VMA>, <beginning of 
LMA>, and <end of LMA>. These labels may be used to specify addresses in a source file when, for example, 
copying sections from ROM to RAM.

 During actual program development, user defined sections can be added using the [Add] button.
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 The section information is displayed in blue except for the .vector section displayed in black. Blue is used to 
display the standard sections defined by default and black is used to display other user defined sections. To edit 
the section name, standard section attribute, address to locate, and objects to be located, a user section should 
be created. The standard section allows the user to specify the location address only, and objects are automati-
cally located except those are located in the user sections with the same attribute.

 Each of the above sections is predefined to contain object files that exist within a project.
 Let's take a look at an example of the .vector section.

Step 34: Select ".vector" from the section list and click the [Edit] button.

 The [Edit Section] dialog box will be displayed.

 The upper part of the dialog box is used to set the sections listed in the preceding screen.
 The list box on the lower right side shows the objects to be located in the .vector section. You can see 

"boot.o" is set in the .vector section as you have previously specified in the New Project Wizard.
 The list box on the left side lists the remaining other object files and library files within the project.
 If any object in the left-side list needs to be located in this section, select that file from the list and click the [>] 

button. The selected file will be moved to the right-side list box and added to the list of files that comprise this 
section.

 If there are multiple files displayed in the right-side list, they will be located in order as shown. The placement 
order can be changed with the [Up] or [Down] button.

 Although there are no object files generated at this point of time yet, the files in this dialog box are displayed 
on the assumption that object files (boot.o, main.o) will be generated from the source files added to a proj-
ect in the same name as those of the source files.
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 To take a look at [File Attributes] here, we see that the indicated attribute is ".rodata". This means that only 
the .rodata sections in boot.o will be located in the .vector section. Since the other sections in boot.
o will be located in respective sections with the same attribute, looking at the other section information we find 

that all sections except the .rodata section with the same attribute will have boot.o located in each.
 In its initial settings, the IDE assumes that a vector table is written in the .rodata section (in the C sources, 

the constants declared by const, in the assembler sources, the constants in the scope of the .rodata sec-
tion).

 If the vector table is written in another section with a different attribute (e.g. .text section), select the attribute 
from [File Attributes] so that the section will be located in the .vector section.

 Furthermore, [Virtual map address] contains the boot vector address specified when the project is newly created. 
If the processor has a different boot vector address, rewrite [Virtual map address] with the correct value.

Step 35: Click the [OK] button to close the dialog box.

Step 36: Click the [OK] button in the [Properties] dialog box to finish editing a linker script.

 Editing objects to be located and section attribute of a user section (displayed in black) automatically updates 
the object configuration of the standard section with the same attribute.

 By the above, you are finished with preparations for building a program.
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3.3.5  Building a Program

When you are finished with the work described in the preceding sections, you are ready to build (compile, assem-
ble, and link) a program.

To execute a build process
Step 37: Select the project name "sample" from the [C/C++ Projects] view.

Step 38: Select [Build Project] from the [Project] menu. You also can select [Build Project] from the context 
menu that appears when you right-click on the project name "sample" in the [C/C++ Projects] view.

 When the build command is selected this way, makefiles are generated with the current settings and then make.
exe is executed to generate an executable format object file sample.elf.

The commands executed during a build process and tool messages are displayed in the [Console] view.
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3.3.6  Debugging a Program

Before debugging a program, create a parameter file for the debugger. This is a file in which the memory map in-
formation of the target system is written, which is loaded into the debugger to set a memory map. A parameter file 
should be created to be suitable for the memory configuration of the target system and must always be loaded into 
the debugger.
Furthermore, the debugger's startup options must also be set before debugging a program.

Setting parameters
Step 39: Select the "sample" project in the [Navigator] or the [C/C++ Projects] view and then [Properties] 

from the [Project] menu.

Step 40: Select [GNU17 Parameter Settings] from the properties list by clicking on it.

 Two items of area information that have been set by default will be displayed.
 The information for RAM defines that 0x0 to 0xffffff (16M bytes) be used as a RAM area. Note that "00 

word" here means this device is accessed in 32-bit size for read with no wait states (0 cycles) and for write 

with no wait states (0 cycles). (The access conditions set here are effective in only simulator mode.)
 Other area information for the stack area in RAM is also defined.
 Shown here is the basic configuration of the S1C17 microcomputer that incorporates the S1C17 Core.
 If other memory or external devices must be used, click the [Add] button and set the area to be added.
 Since the sample program does not specifically require a memory configuration other than the default, a param-

eter file may be created directly as shown here without incurring any problem. Steps 41 to 47 below are shown 
for reference only. No operation is required.

 As for an example, we'll add a ROM area (0x8000–0x17fff). Note, however, that areas cannot overlap with an-
other area except for the STACK setting. Therefore, first the RAM area must be changed to 0x0–0x7fff.

Step 41: Click on the RAM line in the list box to get it displayed in inverse video and click the [Edit] button.

 The [Edit Parameter] dialog box will be displayed.



3-30 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

3  SOfTWARE DEVElOPMENT PROCEDURES

Step 42: Change the address in [End Address:] to 7fff.

Step 43: Click the [OK] button.

 The displayed address range of the RAM area has been changed to "000000-007FFF".

Step 44: Click the [Add] button.

 The [Add Parameter] dialog box will be displayed.

Step 45: Enter 8000 in the [Start Address:] text box and 17fff in the 
[End Address:] text box. 

 Select "halfword" (16 bits) from [Access Size:].

Step 46: Click the [OK] button.
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 The ROM area have been added.

Step 47: Click the [Apply] button.

 When above settings are made, a file named "sample_gnu17IDE.par" is generated and passed to the de-
bugger via a command file when the debugger starts.

Setting the debugger's startup options
Step 48: Select [GNU17 GDB Commands] from the properties list by clicking on it.

 This page displays the contents of the debugger startup command file that will be generated by the IDE.
 The debugger must be set to the appropriate mode that suits the ICD used, etc. before it can be operated. For 

detailed information, refer to Section 3.7, "Debugging Environment". 
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 Here, we'll set the debugger to simulator mode that does not require external equipment before we start debug-
ging.

 The contents of the command file displayed by default are provided for debugging using an ICD Mini.
 It may be changed for simulator mode by the following procedure.

Step 49: Click the [Create commands from template] button to display the [Create a simple startup command] 
dialog box. 

Step 50: Select "Simulator" from the [Debugger:] combo box.

Step 51: Click the [Overwrite] button, then click the [OK] button in the [Overwrite commands] dialog box 
displayed next.

 The displayed contents are altered for simulator mode. The commands may be added and edited directly in this 
page as necessary.

Step 52: Click the [OK] button.

 When above settings are made, a command file named "sample_gnu17IDE.cmd" is generated and it will 
be passed to the debugger.
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Starting the debugger
Step 53: Select [Debug Configurations...] from the [Run] menu.

 The [Debug Configurations] dialog box will be displayed.

Step 54: Select [GDS17 Debugger for sample] from the list in the dialog box.

 This dialog box may be used to edit the command line of the gdb debugger. No particular changes are required 
for executing the sample, so start the debugger directly with this setting.

Step 55: Click the [Run] button.

 The gdb debugger will start.
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 When the debugger has started, the window shown below appears, executing the command file that was set in 
the [GNU17 GDB Commands] dialog box.

 The object file is loaded into the debugger by the command file and the debugger is reset. The PC (program counter) 
is set to the program execution start position, letting the debugger ready to start debugging.

To run a program

Step 56: Click the [Resume] button in the toolbar.

 The sample program here endlessly increments the int variable counter 'i' (addresses 0x0–0x3).

 Use a forcible break to stop such an endless loop.

To forcibly break a program

Step 57: Click the [Suspend] button in the toolbar.
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 Notice that the for statement in the [Source] editor is highlighted in green. This is because the current address 
of the PC (program counter) exists there, at which the program has stopped. Furthermore, notice that the 'pc' 
column of the [Registers] view indicates the address 0x8094. It means that the program has stopped immedi-
ately before executing the instruction at this address.

 Although boot.s was displayed in the [Source] editor when the program has started, the source of main.c is 
displayed in it because the program has stopped and remains idle in main.c now.

 The source displayed in [Source] editor can display a program in disassembled form in [Disassembly] view.

Displaying in [Disassembly] view
Step 58: Select [Show View] > [Disassembly] in the toolbar [Window] menu.
 The [Disassembly] view is displayed.
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 Disassembly
 In Disassembly mode, the displayed source lines have the corresponding assembler display inserted in each. 

This Disassembly mode, therefore, allows you to know not only the source line at which the program has 
stopped, but also the address and the instruction code at that address, all in the [Disassembly] view. In this case 
too, the C sources are displayed in function units.

Step 59: Select [Source] editor to reverse the view.

 Let's take a look at other views of the debugger here.

About the debugger windows

 This is the [Console] view. Enter a debug command at the "(gdb)" prompt to execute it.
 Although we used a button to run a program in Step 56, the same effect can be achieved by entering cont here 

and pressing the [Enter] key.
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 This is the [Registers] view. It shows the contents of the S1C17 Core registers. The register data can be rewrit-
ten here.

 This is the [Memory] view. It shows the contents of the target memory. The memory data here can be rewritten.
 When run in the above step, the sample program increments the int variable 'i' (addresses 0x0–0x3). Examine 

value of the variable 'i' in the [Memory] view.

Step 60: Select [Show View] > [Memory] in the toolbar [Window] menu.
 The [Memory] view is displayed.

Step 61: Clicking the [Add Memory Monitor] button displays the [Monitor Memory] dialog box.
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Step 62: Enter ‘&i’ or ‘0’ in the text box of the [Monitor Memory] dialog box and click [OK].

 

 The memory contents are displayed, beginning with the variable 'i' (address 0x0). As shown here, 'i' has been 
counted up to 0x6eeb (= 28395).

Step 63: Select [Show View] > [Breakpoints] in the toolbar [Window] menu.
 The [Breakpoints] view is displayed.

 This is the [Breakpoints] view. This window is used to manage software PC breakpoints that halt the program 
at specified positions.

Step 64: Select [Show View] > [Expressions] in the toolbar [Window] menu.
 The [Expressions] view is displayed.

 This is the [Expressions] view. This window is used to monitor the values of global variables. This window 
may be used to monitor the variable 'i' (i = global variable) earlier verified in the [Memory] view. The proce-
dure is described below.

Step 65: Click the [Add New Watchpoint] button in [Expressions] view. The [Add Watch Expression...] dialog 
box is displayed.



S5U1C17001C MANUAl Seiko Epson Corporation 3-39
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

3  SOfTWARE DEVElOPMENT PROCEDURES

3
SoftDev

Step 66: Enter ‘i’ in the text box of the [Add Watch Expression...] dialog box and click [OK].

 

 The letter 'i' will appear in the list box of the window, the contents of which are displayed as decimal values 
(default display mode).

Step 67: Select [Show View] > [Variables] in the toolbar [Window] menu.

 The [Variables] view is displayed.

 This is the [Variables] view. It shows the local variables defined in the current function. Since the current PC 
address exists in the main() function, the symbol and the value of the variable 'j' defined in this function are 
displayed.

 We have thus far seen the windows for the gdb debugger. Each view has other facilities, not just the ones that 
display information. These are detailed in Section 10.4, "Windows".

 We'll now return to program execution.
 In the preceding steps, we ran a program, stopping it using forced breaks.
 This time we'll run a program after specifying in advance a position at which to stop it.

To specify a breakpoint
Step 68: The source line numbers are displayed in the [Source] editor. Move the mouse cursor to a position 

preceding numeral 16, and double-click.

 You will see that source line 16 is marked with  at the beginning of it. This means that this line has been set 
to be a software PC breakpoint. If a  mark is attached anywhere other than source line 16, double-click there 
to reverse, then repeat

 Step 69: Click the [Resume] button.

 In contrast to Step 56, the program this time should have stopped at the line set to be a breakpoint. Try pressing 
the [Resume] button a number of times. You will see that the program stops at the same place each time.
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 If the [Variables] view is still open, you can verify that the variable 'j' increments each time the program 
breaks. Similarly, you can verify that the variable 'i' displayed in the [Expressions] view increments every 
other time the program is run, indicating that the program operates exactly as expected.

Step 70: Select [Show View] > [Breakpoints] in the toolbar [Window] menu.
 The [Breakpoints] view is displayed.

 Examine the [Breakpoints] view. The information on the breakpoint we set above is displayed in it, although no 
information was displayed there earlier. The check mark shown at the beginning of the information means that 
the breakpoint is currently active. When the check box is unselected, the breakpoint is temporarily disabled: 
The next time the program is run, it will no longer halt at the position at which it halted earlier. Selecting the 
check box reenables the breakpoint.

Step 71: Double-click the " " displayed in the [Source] editor to remove it.

 This clears the breakpoint.

 In addition, other break facilities are available, including a temporary break effective only once the program is 
run. Discussions of these break facilities are omitted here. For detailed information on break facilities, refer to 
Section 10.6.5, "Break Functions".

 If any problem in program behavior is detected, the program operation should be verified with greater care.
 As the last step of the tutorial, we will proceed through the program by executing one source line at a time.

To proceed through the program step-by-step

 Step 72: Click the [Step Into] button in [Debug] view.

 The source line highlighted in green in the [Source] editor (the line at which the current PC address exists) is 
executed, and the highlighting moves to the next source line to be executed.

 By repeating Step 72, we can execute the program one step or one source line at a time. If the program has no 
problems, you will see that the displayed register values, etc. change correctly at each step.

 The [Step Into] button executes the program one source line at a time. To execute the program one instruction 
(mnemonic) at a time, click the [Instruction Stepping Mode] button, then click the [Step Into] button while de-
pressing the [Instruction Stepping Mode] button.

 [Instruction Stepping Mode] button

Step 73: Click the [Step Over] button in [Debug] view.

 Repeat Step 73 to verify differences between this and the [Step Into] button in the [Source] editor.
 When the program is run with the [Next] button, you will see that although the function sub() was skipped, 

the value of the variable 'i' is updated, indicating that the instructions in the function have all been executed.

 The [Next] button operates in basically the same way as the [Step] button, except that the [Next] button skips 
functions and subroutines (i.e., executes a function or subroutine as one step, without stopping at every instruc-
tion). If you do not need to debug the subroutines instruction by instruction, use the [Next] button instead.
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 We have thus far seen the basic use of the debugger. More advanced debugging can be performed by entering a 
command in the [Console] view from the keyboard. For detailed information, refer to Chapter 10, "Debugger".

 Follow the procedure described below to quit the debugger.

To quit the debugger
Step 74: Select [Terminate] in the [Run] menu.
 The debugger ends. To return to the IDE window, click the ["GNU17" Perspective] button at the top 

right of the window.

 In addition to the simulator mode described above, a program can be debugged in another mode after connect-
ing an ICD to the target board. For detailed information on how to debug in this mode, refer to Section 3.7, 
"Debugging Environment".

 Finally, we'll quit the IDE.

To quit the IDE
Step 75: Select [Exit] in the [File] menu.
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3.3.7  Creating ROM Data

The ROM data HEX file for incorporation into the target board is generated, based on the executable file used in 
debugging. 
(This HEX file is generated based on the ‘elf’ format object file at the build time (a .psa file).) 
When [Build Mask file (.psa)] is selected in [Build goal switch] in the [Properties] dialog box from the [Project] 
menu

The mask data to be presented is generated based on this ROM data HEX file. 
After a program for a model with built-in ROM is completed, you will be requested to present the masked data for 
the internal ROM to Seiko Epson.

Creating a ROM data HEX file
 When a build process is executed, a Motorola-S2-format ROM data HEX file with the same name as the ‘elf’ 

format object file and the ".psa" extension will be created as follows:

1. Motorola-S3-format HEX file is created by objcopy.exe.
 objcopy -I elf32-little -O srec --srec-forceS3 InputFile(.elf)  
OutputFile(.sa)

2. Empty addresses in the HEX file are filled with 0xff data by moto2ff.exe.
 moto2ff StartAddress BlockSize InputFile(.sa)
 (output file name: <input file name + .saf>)

3. File is converted to the Motorola S2 format by sconv32.exe.
 sconv32 S2 InputFile(.saf) OutputFile(.psa)

 Use the ROM data HEX file created by the above procedure to perform final verification of program operations 
on the actual target board.

Creating mask data for presentation
 If the model is set with a mask option, select the option using winfog17.exe.
 Information on the selected option is output to a function option document file by winfog17.

Step 76: Select a project in the IDE and click the toolbar [Start Winfog17] button.

 If the model lacks mask options, the [INI file does not include FOG information] dialog box will appear when 
you click the [Start Winfog17] button.

 In this case, there is no need to create a function options file. Close the dialog box and exit Winfog17.
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Step 77: Select a mask option on the Winfog17 window.

Step 78: Select [Generate] from the [Tools] menu to create a function option document file (sample.FDC file) 
in the project directory.

Step 79: The Winfog17 window will close.

 For detailed information on winfog17.exe, refer to the section describing other tools.

 Lastly, pack the verified Motorola-S2 ROM data HEX file and the function option document file created by 
winfog17 into a single mask data file (packed file) using winmdc17.exe.

Step 80: Select a project and click the toolbar [Pack with WinMdc17] button. 
 The [Pack successfully completed!!] dialog box appears, and a packed file (sample.pa file) is 

created in the project directory.

 For detailed information on winmdc17.exe, refer to the section describing other tools.

 Present the mask data file generated by the above operations to Seiko Epson.
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3.4  Tutorial 2 (Using the User Makefiles)
In this section, as an example for using a user makefile, a user linker script file and a user command file, we'll take 
a look at a series of procedures, from building a project in the IDE to starting the debugger. For basic information 
on using the IDE, etc., refer to Tutorial 1.

Files used
 Tutorial 2 uses the sample files listed below that exist in the c:\EPSON\gnu17\sample\S1C17common\

simulator\simulatedIO directory.
 vector.c Vector table file
 main.c C source file
 mymakefile.mak Makefile
 myldsfile.lds Linker script file
 mycmdfile.cmd Debugger command file (for simulator mode)
 myparfile.par Parameter file

3.4.1  Creating a Project

First, create a new project with the IDE.

Step 1: Launch the IDE.

Step 2: Select [New] > [New GNU17 Project] from the [File] menu to start the [New GNU17 Project] wizard.

Step 3: Enter the project name "mymake_sample" in the [Project name:] field.

In this tutorial, we create a project folder in the workspace (default). Leave the [Use default location] check box 
selected.
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Step 4: Click the [Next>] button.

This tutorial does not use the makefiles and linker script files generated by the IDE, so there is no need to select the 
target CPU, memory model and .vector section.

Step 5: Deselect the check box [Allocate a specific file to '.vector' section].

Step 6: Click the [Finish] button to create a project.
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3.4.2  Importing Source files

Import the source files after creating a project. Here, for the sake of convenience, we'll also import the makefiles 
stored in the same directory.

Step 7: Select "mymake_sample" in [Navigator] view, and [Import...] from the [File] menu.

This launches the [Import] wizard.

Step 8: Select [General] > [File System] from the list displayed and click the [Next>] button.

Step 9: Using the [Browse...] button in [From directory:], select the C:\EPSON\gnu17\sample\
S1C17common\simulator\simulatedIO directory that contains the files to be imported.
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The selected directory and the files in it will be displayed in the list boxes on the left and the right sides of the win-
dow, respectively.

Step 10: Select the check boxes for the following files shown in the right-side list box.

 vector.c Vector table file
 main.c C source file
 mymakefile.mak Makefile
 myldsfile.lds Linker script file
 mycmdfile.cmd Debugger command file
 myparfile.par Parameter file

Step 11: Click the [Finish] button.

You can inspect the files that have been added to the project from the [Navigator] view.
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3.4.3  Disabling the gNU17 file Builder

The IDE is initialized to automatically generate makefiles, linker script files, parameter files, and debugger com-
mand files and to use these files when building a project or starting the debugger. In this tutorial, since we use sepa-
rately prepared files, we need to change the default IDE settings to keep from using these files.
The following describes how to disable the file builder to prevent automatic generation of these files.

Step 12: After selecting the "mymake_sample" project from the [Navigator] or the [C/C++ Projects] view, se-
lect [Properties] from the [Project] menu or context menu to display the [Properties] dialog box.

Step 13: Select [Builders] from the properties list and deselect the [GNU17 File Builder] check box. A dialog box 
below appears for confirmation. Click [OK].

Step 14: Click the [OK] button.

You can use your own makefiles, linker script files, parameter files, and debugger command files even without tak-
ing this step, but unnecessary files will be generated each time you build a project. Additionally, the automatically 
generated files will overwrite any current files with the same names.
Do not disable the file builder if any of the above files must be automatically generated by the IDE.
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3.4.4  Setting and Correcting the Makefile

To specify a user makefile
 Now we'll set up the IDE to build the project using the separately prepared makefile. Here, we use mymake-

file.mak, which we imported into the project.

Step 15: After selecting the "mymake_sample" project from the [Navigator] or [C/C++ Projects] view, se-
lect [Properties] from the [Project] menu or context menu to display the [Properties] dialog box.

Step 16: Select [C/C++ Make Project] from the properties list to display the page for the [Make Builder] tab.

Step 17: Change the makefile name "mymake_sample_gnu17IDE.mak" set in [Build command:] to 
"mymakefile.mak".

 No change is required if the makefile is mymakefile.mak. However, unless the target name in the user-
created makefile is all (build) or clean (clean), the following settings must also be changed.

[Build (Incremental Build)]
 Specify the target in the makefile to be called when executing a build process.
[Clean]
 Specify the target in the makefile to be called when executing a clean process (to clear the generated files).

 [Build on resource save (Auto Build)] is not used in the IDE.

Step 18: Display the page for the [Discovery Options] tab.
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Step 19: Deselect the [Automate discovery of paths and symbols] check box.

Step 20: Click the [OK] button.

Correcting the makefile contents
 To use a makefile not created with the IDE, you may need to change the path written in it. If it contains a rela-

tive path, change it to a cygwin format path to allow file referencing from the project directory as well. You can 
use the IDE editor to make changes in the file.
Example: Before change: SRCDIR=    .. 
 After change: SRCDIR=/cygdrive/c/EPSON/gnu17/sample/S1C17common/simulator

3.4.5  Building a Project

After setting the makefile, you can execute a build process as you would normally do. There is no need to set build 
options or to edit the linker script file.

Step 21: Select the project "mymake_sample" name from the [Navigator] or the [C/C++ Projects] view.

Step 22: Select [Build Project] from the [Project] menu.

When the build command is selected this way, make.exe is executed with a specified makefile to generate the ex-
ecutable format object file "stdio.elf". (Since we are using a makefile that is not automatically generated, the 
object file is not named after the project name.)

3.4.6  Starting the Debugger

As the last step in Tutorial 2, described below is the method for making the necessary settings to execute the pre-
pared command file at debugger startup.

Step 23: Select [Debug Configurations...] from the [Run] menu to display the [Debug Configurations] dialog box.

Step 24: Select [GDB17 Debugger for mymake_sample] from the list in the dialog box and display the page for 
the [Main] tab.
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Step 25: Change the elf file in [C/C++ Application:] to "simulatedIO.elf".

Step 26: Display the [Debugger] tab, and change the command file in [GDB command file:] to [mycmdfile.cmd].

Step 27: Click the [Apply] button to confirm what you've altered here.

Starting the debugger will now execute mycmdfile.cmd.
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Step 28: Click the [Close] button if you want to finish here.
 To actually start the debugger, click the [Debug] button.

See Tutorial 1 for basic debugger operations.
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3.5  Tutorial 3 (Importing an IDE Project)
If you've already developed an application for the S1C17 Family with the IDE, you can continue with development 
or make revisions by importing that project into the IDE on another PC. Or you can develop another application, 
based on that project. The procedure for importing a project is explained here. For other procedures, refer to Tutori-
als 1 and 2.

Sample project directory used
 C:\EPSON\gnu17\sample\S1C17common\simulator\simulatedIO

To import a project
 We'll assume that the project to be imported is copied to the HDD of your PC.

Step 1: Launch the IDE.

Step 2: Select [Import...] from the [File] menu.

 This launches the [Import] wizard.

Step 3: Select [Existing Projects into Workspace] from the displayed list and click the [Next>] button.
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Step 4: Using the [Browse...] button in [Select root directory:], select the project directory C:\EPSON\ 
gnu17\sample\S1C17common\simulator\simulatedIO to be imported.

Step 5: Select the [Copy projects into workspace] check box.
 This will make a copy of the project into the workspace directory and the original project files will 

not be modified.

* Do not specify the project directory (directory containing .project file) as a workspace directory. 
Doing so may result in failures with project imports (when [Copy projects into workspace] is  
selected).

 The current workspace directory can be checked by selecting [File] > [Switch workspace...] > 
[Other...] and opening the [Workspace Launcher] dialog box.
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Step 6: Click the [Finish] button.

 This imports the selected directory into the IDE as a project.

Automatic updates of the project file
 When you import a project created in an older version of the IDE, the project file (.project/.cproject/.gnu17project/) 

is automatically updated to one compatible with the current version.
 Note that .cdtproject files used by projects of an older version will be replaced by .cproject files. A .cproject file 

is generated during project import, and the contents of the .cdtproject file will be transferred automatically to 

the newly generated .cproject file.

About the directory structure and resource position
 If all resources are stored together in a project directory, the project can be copied to any location without caus-

ing problems. The project can then be built at the copied destination with no further revisions.
 Even if your project references certain external files or folders outside the project, you will not need to correct 

them as long as those files and folders are managed in the same directory structure. However, if makefiles, etc. 
are prepared externally and not the ones automatically generated by the IDE, as explained in Tutorial 2, the 
paths specified in these files may need to be corrected.

 You will neither have a problem with the standard libraries and include directories as long as the tools are in-
stalled in the same directory where the original project was created in (e.g. C:\EPSON\gnu17). Otherwise, 
corrections are required for the user library and include directory. Make these corrections in the [GNU17 Build 
Options] of the [Properties] dialog box for the project.
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3.6  Tutorial 4 (How to Use ES-Sim17) 
The S5U1C17001C Package contains the Embedded System Simulator (ES-Sim17) for simulating the hardware 
functions of the target model, such as I/O ports and LCD display, during debugging on the PC. The debugger will 
launch ES-Sim17 by setting some conditions with the IDE. This section describes operations on the IDE to use 
ES-Sim17. For other operations, see Tutorials 1 to 3. For details on ES-Sim17, see Section 10.11, "Embedded Sys-
tem Simulator (ES-Sim17)".

3.6.1  Settings Required for launching ES-Sim17

To launch ES-Sim17 at the start of the debugger, the following two settings are required.

1. Specifying the target CPU (parameter file)
2. Starting the debugger in simulator mode (debugger command file)

This section explains the operations on the IDE to set the above conditions when a new project begins.

Specifying the target model
 To simulate model specific hardware functions, the target CPU to be used must be specified in advance.
 When a new project is created, specify the target CPU as in the procedure below.

Step 1: Select [New GNU17 Project] from the [New] pull-down menu on the tool bar to launch the [New 
GNU17 Project] wizard. Then enter the project name in the [Project name:] box on the first wizard 
page and click the [Next>] button.
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Step 2: Select "S1C17701" from the [Target CPU Device] combo box.

 

 "S1C17" is provided for simulating the S1C17 Core only and selecting it will not launch ES-Sim17 at the start 
of debugging.

 Select "S1C17" when debugging the program in simulator mode without ES-Sim17. When debugging the pro-
gram using an ICD (in ICD Mini mode), ES-Sim17 will not start up regardless of how the target CPU has been 
selected.

 The models displayed in the list may be added/deleted by the configuration file that will be modified when a 
new model is released or an existing model is discontinued.

Step 3: Configure the memory model and vector section as necessary, then terminate the wizard by clicking 
the [Finish] button.

 After that, edit source files and build them as usual.
 The target CPU can also be specified on the [GNU17 General] page of the [Properties] dialog box similar to 

above.

Creating a debugger command file for simulator mode
 The ES-Sim17 will be able to run only when the debugger is running in simulator mode. The following shows 

the operations on the IDE to launch the debugger in simulator mode.

Step 4: Display the [Properties] dialog box by selecting [Properties] from the [Project] menu and open the 
[GNU17 GDB Commands] page.
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Step 5: Display the [Create a simple startup command] dialog box by clicking the [Create commands from 
template] button and select "Simulator" from the [Debugger:] combo box.

Step 6: Click the [Overwrite] button.

Step 7: Click the [OK] button.

 Following the above steps the settings for launching ES-Sim17 at the same time the debugger starts up are fin-
ished. Other operations are not necessary in the source edit and build stages to launch ES-Sim17.
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3.6.2  How to launch ES-Sim17 in the Existing Project

This section explains the procedure from importing the project, which has been made for the S1C17 Core as the 
target, to launching the debugger and ES-Sim17 after changing the target model.

Sample project directory used
 C:\EPSON\gnu17\sample\S1C17701\simulator\application

Importing the project
 This tutorial assumes that the project to be imported is copied to the HDD of your PC.

Step 1: Launch the IDE.

Step 2: Select [Import...] from the [File] menu.

 This launches the [Import] wizard.

Step 3: Select [Existing Projects into Workspace] from the displayed list and click the [Next>] button.
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Step 4: Using the [Browse...] button in [Select root directory:], select the project directory C:\EPSON\
gnu17\sample\S1C17701\simulator\application to be imported.

Step 5: Select the [Copy projects into workspace] check box.
 This will make a copy of the project into the workspace directory and the original project files will 

not be modified.

* Do not specify the project directory (directory containing .project file) as a workspace directory. 
Doing so may result in failures with project imports (when [Copy projects into workspace] is  
selected).

 The current workspace directory can be checked by selecting [File] > [Switch workspace...] > 
[Other...] and opening the [Workspace Launcher] dialog box.
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Step 6: Click the [Finish] button.

 This imports the selected directory into the IDE as a project.

Checking the target CPU (parameter file)
 Make sure "S1C17701" is selected as the target processor of the sample project to be simulated by ES-Sim17.

Step 7: Display the [Properties] dialog box by selecting [Properties] from the [Project] menu and open the 
[GNU17 General] page.

Step 8: Make sure "S1C17701" is selected in the [Target CPU Device] combo box.

Step 9: Click the [OK] button.

 The name of the target model used by the debugger to start ES-Sim17 is described below in the parameter file 
to be passed on to the debugger:

 ESSIM  S1C17701 ("S1C17701" is the name of the target processor.) 

* When the user provides the original parameter file, add the above description to the file.
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launching the debugger

Step 10: Select [Debug Configurations...] > [GDB17 Debugger for application] from the [Run] menu.

 The debugger starts up and enters simulator mode. At the same time the [ES-Sim] window opens.
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loading files for lCD simulation
 You can simulate an LCD panel display with ES-Sim17 using LCD files created in LCDUtil17. Load an LCD 

file (.lcd) compatible with the model selected in the project. 
 For instructions on creating LCD files, see Section 11.11, "LCDUtil17 (LCD Panel Customizing Tool)."

Step 11: Select [Load lcd file] from the [File] menu.

 After the file selection dialog box is displayed, open the LCD file for the S1C17701 (as created in LCDUtil17) 
at C:\EPSON\gnu17\tool\LcdUtil17\sample\SVT17701.lcd.

 For the functions and how to operate ES-Sim17, see Section 10.11, "Embedded System Simulator (ES-Sim17)".
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3.7  Debugging Environment
The debugger supports two connect modes, of which the mode used is set by the target command. 

ICD Mini mode
 In this mode, the ICD Mini (S5U1C17001H) or ICD board is used to perform debugging. The program is ex-

ecuted on the target board. 

USB cable
(included with the ICD package)

4-pin to 4-pin
target system
connecting cable
(included with the ICD package)

USB

Target board

ICD

Figure 3.7.1  Example of debugging system using an ICD 

 Specification method
 Command: (gdb) 
   target icd usb

 Specification in IDE:
 Select "ICD Mini" from the [Debugger:] combo box in the [Create a simple startup command] dia-

log box to generate a startup command file.

 To start in ICD Mini mode, make sure an ICD and target board are connected correctly, and that the power for 
these units is turned on. For details on how to use the ICD, refer to the manual for the ICD used.

 Note that the trace function is not available in ICD Mini mode.

Simulator (SIM) mode
 In simulator mode, target program execution is simulated in internal memory of a personal computer, with no 

other tools required. However, the ICD-dependent functions cannot be used in this mode.

 Specification method
 Command: (gdb) 
   target sim

 Specification in IDE:
 Select "Simulator" from the [Debugger:] combo box in the [Create a simple startup command] dia-

log box to generate a startup command file.

 The trace function is available in simulator mode. The flash writer function cannot be used.
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3.8  Sections and linkage
Here, the concept of section management that is required when you create and link source files is explained.
The source file contains data with various attributes, such as program code, constants, and variables. In an embed-
ded system, data management must assume that data will be mapped to different memory devices such as ROM and 
RAM. For this reason, logical areas called "sections" are provided to enable management of data with their attri-
butes.
For example, if a program is created on the assumption that program code present in multiple source files will be 
located in one section, program code can easily be combined from these source files when linked, and will con-
sequently be located in the same ROM. And since addresses can be specified separately for each file, they can be 
located on separate devices, such as internal ROM and external ROM.
Four broad categories (attributes) of sections are set in the xgcc C compiler, and data is located in the appropriate 
sections according to the contents of the source files.

(1).text section
 Program code is located here. All code is eventually written to ROM.

(2).data section
 Read/writable data with initial values are located here. The data is written to ROM, from which it is transferred 

to RAM before use.

(3).rodata section
 Variables defined with const are located here. They are eventually written to ROM.

(4).bss section
 Variables without initial values are located here. Memory is allocated without a specific value.

(5).vector section
 The IDE has another section with .rodata attribute, the .vector section, available for use for vector tables.
 For C sources, create a vector table with a const declaration and locate its object in the .vector section.
 For the assembler sources, a vector table may be written in .rodata or the .text section. However, if a vec-

tor table is located in the .text section, you must change the .vector section attribute to .text.
 For more information, refer to Section 5.7.8, "Editing a Linker Script".
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Discussed below is the relationship between sections and actual memory locations.

Example source files
(file1.s)
.section .rodata  ; .rodata section

.global BOOT

.align 2

.long BOOT         ; 0x00 reset     

.long UNALIGN      ; 0x01 unalign 

.long EXCEPTION     ; 0x02 nmi
      :
      :
.text   ; .text section
BOOT:
 xld.a  %sp, 0x3f00 ; set SP
      :
      :

(file2.s)
      :
 .data  ;.data section
      :
      :
 .rodata  ;.rodata section
      :
      :

(file3.c)
      :
#include <string.h>
  
int i_bss;    /* .bss section */
int i_data = 1;    /* .data section */
const int   i_rodata = 0x12345678;  /* .rodata section */
const char  sz_rodata[] = "ABCDEFGH"; /* .rodata section */
      :
int main()    /* .text section */
{
 char sz_buf[10];
 int  i;

 for( i = 0; i < 5; ++i ){
  sz_buf[i] = sz_rodata[i];
 }

      :
      :
 return 0;
}
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Example linker script file
(sample.lds)
/* Linker Script file */

SECTIONS
{
 /* stack pointer symbols */
 __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;         ...(1)

 /* section information */
 .bss 0x000000 :        ...(2)
   {
    __START_bss = . ;       ...(3)
    file1.o(.bss)        ...(4)
    file2.o(.bss)
    file3.o(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
   }
   __END_bss = . ;        ...(5)

 .data __END_bss : AT( __END_rodata )    ...(6)
   {
    __START_data = . ;
    file1.o(.data)
    file2.o(.data)
    file3.o(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
   }
   __END_data = . ;

 .vector 0x008000 :        ...(7)
   {
    __START_vector = . ;
    file1.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector :        ...(8)
   {
    __START_text = . ;
    file1.o(.text)
    file2.o(.text)
    file3.o(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
   }
   __END_text = . ;

 .rodata __END_text :         ...(9)
   {
    __START_rodata = . ;
    file2.o(.rodata)
    file3.o(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
   }
   __END_rodata = . ;

 /* load address symbols */
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 __START_data_lma = LOADADDR( .data );   ...(10)
__END_data_lma = __START_data_lma + SIZEOF( .data );
}

The example source files shown above include the following sections.
 file1 .rodata and .text sections
 file2 .data and .rodata sections
 file3 .text, .bss, .data, and .rodata sections

These sections are relocated according to the SECTIONS command specified in a linker script file. The contents of 
the example linker script file are described below.

(1) Set the location counter to 0x0. This location is assumed to be address 0x0. The location counter will be incre-
mented by specifying an address or locating sections. '.' is used to reference the current location counter value 
in a linker script.

(2) Define the .bss output section to be output to an executable format object file. The .bss section begins 
with address 0x000000 as the definition specifies the address.

(3) The linker script created by the IDE contains symbols defined to indicate a section start address. In this ex-
ample, the .bss output section start address is defined as the symbol name __START_bss. '.' represents the 
location counter value, so the symbol is defined with the value 0x000000. Other sections have a start address 
definition similar to this. These symbols can be referenced from program source files as global symbols.

(4) Specify the object files with their basic section attribute to be located in this section. In this example, the 
.bss sections in the specified files will be located in order of file1.o, file2.o, and file3.o in the 
.bss output section. The file2.o does not contain a .bss section, so no memory area will be allocated 

but no error will occur even if it is specified like this.
 Furthermore, library files must be written if the application uses library functions. In this example, libgcc.

a cannot reference symbols in the preceding libc.a, therefore libc.a is specified twice to resolve refer-

ences to unknown symbols (some functions in libgcc.a call a function in libc.a). This specification 
does not locate the actual code twice.

(5) The symbol __END_bss is defined to indicate the .bss output section end address similar to (3) above. The 
location counter value specified by '.' is __START_bss + (total size of all .bss sections located).

(6) Define the .data output section. With __END_bss specified as the start address, this section (VMA) is 
located immediately after the .bss section. All .data sections in the input files are placed into this output 
section. 

 The defined section is located at the VMA (memory address accessed when actually executing code or when 
reading/writing data). The VMA is normally the same as the LMA (load memory address in which data is 
stored). However, the .data section requires that initial values be written to ROM and that the initial values 
be copied to RAM before use. For this reason, the LMA (ROM address) must be specified separately. The AT 
statement specifies that the actual code in the .data section must be located from __END_rodata (imme-
diately following the .rodata section). 

(7) Define the .vector output section beginning with address 0x008000. In this example, the vector table is 
written in the .rodata section defined in file1.o, so only file1.o(.rodata) is specified as the file 
(section attribute) to be located in this section.

(8) Define the .text output section immediately following the .vector section. All .text sections in the 
input files are placed into this output section.

(9) Define the .rodata output section immediately following the .text section. All .rodata sections in the 
input files are placed into this output section. The file1.o is not specified here, as its .rodata section has 
been located in the .vector section.

(10) The __START_data_lma and __END_data_lma are defined for the start (LOADADDR(.data)) and 
the end addresses (LMA) of the .data section in which the actual data is stored. These symbols are used to 
copy data from the LMA to the VMA in the program source.
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Figure 3.8.1 shows the memory map configured by this example script.

Stack, etc.

.data (3)

.data (4)

.data (5)

.bss (4)

.bss (5)
.data (2)

.text (1)
.rodata (1)

file1.o

.data (2)
.rodata (2)

file2.o

.data (3)
.rodata (3)

.text (3)

file3.o

.bss (3)

.bss (3)

(RAM)

Copy
before
using.
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(VMA)

0x000000
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.text (4)

libc.a (library)

.bss (4)
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.text (5)

.data (5)

libgcc.a (library)
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__START_data

__END_bss
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__END_rodata
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Figure 3.8.1  Memory map configured by sample.lds
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4  Source Files
 This chapter explains the rules and grammar involved with the creation of source files. 

4.1  file format and file Name
Use the GNU17 IDE editor or a general-purpose editor to create source files.

File format
 Save data in a standard text file.

File name
 C source file <filename>.c
 Assembly source file <filename>.s
 Specify the <filename> with not more than 32 alphanumeric characters shown as follows:
 a–z, A–Z, 0–9 and _
 This rule applies to file names for all the S1C17 tools.

Directory name
 Only alphanumeric characters can be used for directory names just as for file names. Do not use spaces or other 

symbols. Up to 64 characters can be used for a path name including directory and file names.

Global variables/static variables
 Up to 200 characters can be used to name global and static variables.
 A total of 32,000 global and static variables can be accepted.

File size
 The following shows the guide about the upper limit of the C source file size:

• In the case of a source file that contains only variables, constants and arrays, up to 100,000 lines can be 
accepted.

• In the case of a source file that contains only executable codes (not including arrays and variables), up to 
20,000 lines can be accepted. However, the number of acceptable lines varies depending on the source 
density.

• Consider these two conditions above as reference for sources in which variables, constants, arrays and 
executable codes are mixed.

• The number of lines shown above varies depending on compile environment conditions. Moreover, the 
compiler may be forcibly terminated due to insufficient resources. In this case, build the program under a 
resource-rich environment or divide the source file into multiple files before compiling. (Resources described 
here depend on the OS used rather than the RAM capacity of the PC.)

• Up to 512 characters can be used per line in C source files.

 In the case of assembly source files, up to 30,000 lines can be accepted.

Tab setting
 The recommended tab stop is every 4 characters. This is the default tab setting when the IDE displays sources. 

EOF
 Make sure that each statement starts on a new line and that EOF is entered after line feed (so that EOF will 

stand independent at the file end).
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4.2  grammar of C Source
The xgcc C compiler included in this package is the GNU C Compiler (ver. 3.3.2) under ANSI C standards. Make 
sure C sources are created according to ANSI C standards. If you want information about the syntax, please refer to 
ANSI C textbooks generally available on the market.

4.2.1  Data Type

The xgcc C compiler supports all data types under ANSI C. The size of each data type (in bytes) and the effective 
range of values that can be expressed are listed in Table 4.2.1.1. 

Table 4.2.1.1  Data type and size
Data type Size Effective range of a number

char 1 -128 to 127
unsigned char 1 0 to 255
short 2 -32768 to 32767
unsigned short 2 0 to 65535
int 2 -32768 to 32767
unsigned int 2 0 to 65535
long 4 -2147483648 to 2147483647
unsigned long 4 0 to 4294967295
pointer 4 0 to 16777215
float 4 1.175e-38 to 3.403e+38 (normalized number)
double 8 2.225e-308 to 1.798e+308 (normalized number)
long long 8 -9223372036854775808 to 9223372036854775807
unsigned long long 8 0 to 18446744073709551615
wchar_t 2 0 to 65535

The float and double types conform to the IEEE standard format.

Handling of long long-type constants requires the suffix LL or ll (long long type) or ULL or ull (un-
signed long long type). If this suffix is not present, a warning is generated, since the compiler may not be 

able to recognize long long-type constants as such.
Example: long long  ll_val;
  ll_val = 0x1234567812345678;

   → warning: integer constant is too large for "long" type
  ll_val = 0x1234567812345678LL;

   → OK

Type wchar_t is the data type needed to handle wide characters. This data type is defined in stdlib.h/std-
def.h as the type unsigned short. 
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4.2.2  library functions and Header files

This package contains an ANSI library and an emulation library for calculating floating-point numbers and the 
remainders of divided integral numbers. 
The header files in the "include" directory contain library function declarations and macro definitions. When using 
a library function, include the header file that contains its declaration by using the #include instruction. 
Certain ANSI library functions not supported by this package are not included in the ANSI library.
The client assumes responsibility for function implementation and prototype declarations when using ANSI library 
functions not supported by this package.
For some ANSI library functions not supported by this package, the header files include only prototype 
declarations. In these cases, include the pertinent header file rather than declaring a prototype before implementing 
the function.
The following table shows the relationship between the types of library files and header files.

Table 4.2.2.1  List of library files and functions

 ANSI library
file name functions/macros Corresponding header file

libc.a perror, getchar, fgetc, getc, gets, fgets, fscanf, scanf, sscanf, fread, putchar, 
fputc, putc, puts, fputs, ungetc, fprintf, printf, sprintf, vfprintf, vprintf, vsprintf, 
fwrite

stdio.h

abort, exit, malloc, calloc, realloc, free, atoi, atol, atof, strtol, strtoul, strtod, 
abs, labs, div, ldiv, rand, srand, bsearch, qsort

stdlib.h

setjmp, longjmp setjmp.h
time, mktime, gmtime time.h
acos, asin, atan, atan2, ceil, cos, cosh, exp, fabs, floor, fmod, frexp, ldexp, 
log, log10, modf, pow, sin, sinh, sqrt, tan, tanh

math.h, errno.h, float.h, 
limits.h

memchr, memmove, strchr, strcspn, strncat, strpbrk, strstr, memcmp, 
memset, strcmp, strerror, strncmp, strrchr, strtok, memcpy, strcat, strcpy, 
strlen, strncpy, strspn

string.h

isalnum, iscntrl, isgraph, isprint, isspace, isxdigit, toupper, isalpha, isdigit, 
islower, ispunct, isupper, tolower

ctype.h

va_start, va_arg, va_end stdarg.h

 Emulation library
file name functions

libgcc.a 
(libgccM.a / 
libgccMD.a)

___subdf3, __adddf3, __addsf3, __ashldi3, __ashlhi3, __ashlsi3, __ashrdi3, __ashrhi3, __ashrsi3, 
__cmpdi2, __divdf3, __divdi3, __divhi3, __divsf3, __divsi3, __eqdf2, __eqsf2, __extendsfdf2, 
__fixdfdi, __fixdfsi, __fixsfdi, __fixsfsi, __fixunsdfdi, __fixunsdfsi, __fixunssfdi, __fixunssfsi, 
__floatdidf, __floatdisf, __floatsidf, __floatsisf, __gedf2, __gesf2, __gtdf2, __gtsf2, __ledf2, __lesf2, 
__lshrdi3, __lshrhi3, __lshrsi3, __ltdf2, __ltsf2, __moddi3, __modhi3, __modsi3, __muldf3, __muldi3, 
__mulhi3, __mulsf3, __mulsi3, __nedf2, __negdf2, __negdi2, __negsf2, __nesf2, __subsf3, 
__truncdfsf2, __ucmpdi2, __udivdi3, __udivhi3, __udivsi3, __umoddi3, __umodhi3, __umodsi3, 
__cmpsi2, __ucmpsi2

 functions with prototype declarations only
functions Corresponding header file

freopen, tmpfile, tmpnam, remove, rename, fopen, fclose, setbuf, 
setvbuf, fflush, clearerr, feof, ferror, fseek,fgetpos, fsetpos, ftell, rewind

stdio.h

atexit, getenv, system stdlib.h

difftime, clock, localtime, asctime, ctime time.h

For details about the functions included in the libraries, refer to Chapter 7, "Library". 
When using a library function, be sure to specify the library file that contains the function used when linking. The 
linker extracts only the necessary object modules from the specified library file as it links them. 
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4.2.3  In-line Assemble

The xgcc C compiler supports in-line assembly, so the asm statement can be used. As a result, the word "asm" is 
reserved for system use. 

Format: asm("<character string>");

Example 1: /* HALT mode */
  asm("halt");

Example 2: /* Trap Table*/
  asm(".long  BOOT\n\
   .long  ADDR_ERR\n\
   .long  NMI\n\
   .space 4\n\
   .long  EINT0\n\
   .long  EINT1");

Example 3: BOOT(){
   asm("xld.a  %sp,0x3f00"); /* set SP */

    :

  }

For details on how to write an assembly source, refer to Section 4.3, "Grammar of Assembly Source". 

4.2.4  Prototype Declarations

Declaring interrupt handler functions
 Interrupt handler functions should be declared in the following format:

 <type> <function name> __attribute__ ((interrupt_handler));

 Example: void foo(void) __attribute__ ((interrupt_handler));

  int int_num;
  void foo()
  {
   int_num = 5;
  }

  Assembler code
  foo:
   ld.a  -[%sp],%r2
   ld    %r2,5
   xld   [int_num],%r2
   ld.a  %r2,[%sp]+
   reti
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4.3  grammar of Assembly Source

4.3.1  Statements

Each individual instruction or definition of an assembly source is called a statement. The basic composition of a 
statement is as follows:

Syntax pattern
1 <Mnemonic>   (<Operands>)  (;<Comment>)
2 <Assembler directive>  (<Parameters>) (;<Comment>)
3 <Label>:      (;<Comment>)
4 ;<Comment>
5 <Extended instruction> <Operands>  (;<Comment>)
6 <Preprocessor directive> (<Parameters>) (;<Comment>)

 Example:
 ————————————————–————— Statement ———————————–————————— — Syntax pattern —

; boot.s   4
; boot program  4

#define SP_INI,0x3f00       ; Stack pointer value 6

        .text  2
        .long BOOT          ; BOOT VECTOR 2
BOOT:   3
        xld.a %sp,SP_INI    ; set SP 5
        xcall main          ; goto main 5
        jpr   BOOT          ; infinity loop 1
  :          :                        :

 The example given above is an ordinary source description method. For increased visibility, the elements 
composing each statement are aligned with tabs and spaces. 

 Restrictions
• Only one statement can be described in one line. A description containing more than two instructions in one 

line will result in an error. However, comments may be described in the same line with an instruction or label.
 Example: ;OK
  BOOT: ld  %r1,%r2

    ld  %r0,%r1

  ;Error

  BOOT: ld  %r1,%r2  ld  %r0,%r1

• One statement cannot be described in more than one line. A statement not complete in one line will result in 
an error.

 Example: ;OK
    ld  %r1,%r2

  ;Error

    ld  %r1,

        %r2

• The usable characters are limited to ASCII characters (alphanumeric symbols), except for use in comments. 
Also, the usable symbols have certain limitations (details below). 

 Comments can be described using other characters than ASCII characters. When using non-ASCII characters 
(such as Chinese characters) for comments, use /* · · · */ as the comment symbol.
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(1) Instructions (Mnemonics and Operands) 
 An instruction to the S1C17 Core is generally composed of <Mnemonic> + <Operand>. Some instructions do 

not contain an operand.

 general notation forms of instructions

 General forms: <Mnemonic>
  <Mnemonic> tab or space <Operand>
  <Mnemonic> tab or space <Operand 1>,<Operand 2>
 Examples: nop
  call  SUB1

  ld    %r0,0x4

 There is no restriction as to where the description of a mnemonic may begin in a line. A tab or space 
preceding a mnemonic is ignored. Generally, mnemonics are justified left by tab setting.

 An instruction containing an operand needs to be broken with one or more tabs or spaces between the 
mnemonic and the operand. If there are plural operands, the operands are separated from each other with 
one comma (,). Space between operands is ignored.

 The elements of operands will be described further below.

 Types of mnemonics
 The following S1C17 Core instructions can be used in the S1C17 Family:

 ld.b ld.ub ld ld.a
 add add/c add/nc add.a add.a/c add.a/nc

 adc adc/c adc/nc sub sub/c sub/nc

 sub.a sub.a/c sub.a/nc sbc sbc/c sbc/nc

 cmp cmp/c cmp/nc cmp.a cmp.a/c cmp.a/nc

 cmc cmc/c cmc/nc

 and and/c and/nc or or/c or/nc

 xor xor/c xor/nc not not/c not/nc

 sr sa sl swap

 cv.ab cv.as cv.al cv.la cv.ls

 jpr jpr.d jpa ipa.d jrgt jrgt.d

 jrge jrge.d jrlt jrlt.d jrle jrle.d

 jrugt jrugt.d jruge jruge.d jrult jrult.d

 jrule jrule.d jreq jreq.d jrne jrne.d

 call call.d calla calla.d ret ret.d

 int intl reti reti.d brk retd

 ext nop halt slp ei di

 ld.cw ld.ca ld.cf

 Refer to the "S1C17 Core Manual" for details of each instruction.

 Restrictions on characters
 Mnemonics can be written in uppercase (A–Z) characters, lowercase (a–z) characters, or both. For example, 

"ld", "LD", and "Ld" are all accepted as "ld" instructions. 
 For purposes of discrimination from symbols, this manual uses lowercase characters. 
 More will be said about operands later.
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(2) Assembler Directives
 The as assembler supports the standard directives provided in the gnu assembler. Refer to the gnu assembler 

manual for the standard directives. Each directive begins with a period (.). The following lists often-utilized 
directives.

 .text     Declares a .text section.
 .section .data   Declares a .data section.
 .section .rodata   Declares a .rodata section.
 .section .bss    Declares a .bss section.

 .long    <data>   Defines a 4-byte data.
 .short   <data>   Defines a 2-byte data.
 .byte    <data>   Defines a byte data.
 .ascii   <string>   Defines an ASCII character strings.

 .space   <length>   Defines a blank (0x0) space.
 .zero    <length>   Defines a blank (0x0) space.
 .align   <value>   Alignment to a specified boundary address.
 .global  <symbol>   Defines a global symbol.

 .set     <symbol>,<address> Defines a symbol with an absolute address.

(3) labels
 A label is an identifier designed to refer to an arbitrary address in the program. You can refer to a branch 

destination of a program or an address in the .text/.data section by using a symbol defined as a label. 

 Definition of a label
 A symbol described in the following format is regarded as a label.

 <Symbol>:

 Preceding spaces and tabs are ignored. It is a general practice to describe from the top of a line.
 A defined symbol denotes the address of a described location.
 An actual address value will be determined in the linking process.

 Restrictions
 Only the following characters can be used:

 A–Z  a–z  _  0–9
 A label cannot begin with a numeral. Uppercase and lowercase are discriminated.
 Examples: ;OK  ;Error
  FOO:  1label:

  _Abcd:  0_ABC:

  L1:
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(4) Comments
 Comments are used to describe the meaning of a series of routines or each statement. Comments cannot 

comprise part of coding.

 Definition of comment
 A character string beginning with a semicolon (;) and ending with a line feed is interpreted as a comment.
 Strings from "/*" through the next "*/" are also regarded as a comment.
 Not only ASCII characters, but also other non-ASCII characters can be used to describe a comment.
 It can be described with a label or instruction in one line.
 Examples: ; This line is a comment line.
   LABEL:   ;Comment for LABEL.

    ld %a,%b  ;Comment for the instruction on the left.

   /*

    This type of comment can include 

    newline characters.

   */

 Restrictions
 When a comment extends to several lines, each line must begin with a semicolon or use "/*" and "*/".
 Examples:
  ;These are
      comment lines. The second line will not be regarded as a comment. An error will result.

  ;These are

  ;   comment lines. Both lines will be regarded as comments.

  /*

    These are

    comment lines. Both lines will be regarded as a comment.
  */

(5) Blank lines
 This assembler also allows a blank line containing only a return/line feed code. It need not be made into a 

comment line, for example, when used as a break in a series of routines.
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4.3.2  Notations of Operands

This section explains the notations for the register names, symbols, and constants that are used in the operands of 
instructions.

(1) Register Names
 The names of the internal registers of the S1C17 Core all contain a percentage symbol (%). Register names 

may be written in either uppercase or lowercase letters.

 general-purpose register (%rd, %rs, %rb) Notation                                   
 General-purpose register R0–R7 %r0–%r7 or %R0–%R7

 Special register                      Notation                                   
 Stack pointer SP %sp or %SP
 Program counter PC %pc or %PC

 Register names placed in brackets ([]) for indirect addressing must include the % symbol.
 Examples:  [%r7]  [%r1]+  [%sp+imm7]

Note: A register name not containing % will be regarded as a symbol.
 Conversely, all notations beginning with % will be regarded as registers, and will give rise to an 

error if it is not a register name.

(2) Numerical Notations
 The as assembler supports three kinds of numerical notations: decimal, hexadecimal and binary.

 Decimal notations of values
 Notations represented with 0–9 only will be regarded as decimal numbers. To specify a negative value, put 

a minus sign (-) before the value. 
 Examples:  1  255  -3

 Characters other than 0–9 and the sign (-) cannot be used.

 Hexadecimal notations of values
 To specify a hexadecimal number, place "0x" before the value.
 Examples:  0x1a  0xff00

 "0x" cannot be followed by characters other than 0–9, a–f, and A–F.

 Binary notations of values
 To specify a binary number, place "0b" before the value.
 Examples:  0b1001  0b01001100

 "0b" cannot be followed by characters other than 0 or 1.

 Specified ranges of values
 The size (specified range) of immediate data varies with each instruction.
 The specifiable ranges of different immediate data are given below.

Table 4.3.2.1  Types of immediate data and their specifiable ranges
Symbol Type Decimal Hexadecimal Binary
imm3 3-bit immediate data 0 to 7 0x0 to 0x7 0b0 to 0b111
imm5 5-bit immediate data 0 to 31 0x0 to 0x1f 0b0 to 0b1 1111
imm7 7-bit immediate data 0 to 127 0x0 to 0x7f 0b0 to 0b111 1111
sign7 Signed 7-bit immediate data -64 to 63 0x0 to 0x7f 0b0 to 0b111 1111
sign8 Signed 8-bit immediate data -128 to 127 0x0 to 0xff 0b0 to 0b1111 1111
sign10 Signed 10-bit immediate data -512 to 511 0x0 to 0x3ff 0b0 to 0b11 1111 1111
imm13 13-bit immediate data 0 to 8,191 0x0 to 0x1fff 0b0 to 0b1 1111 1111 1111
imm16 16-bit immediate data 0 to 65,535 0x0 to 0xffff 0b0 to 0b1111 1111 1111 1111
sign16 Signed 16-bit immediate data -32,768 to 32,767 0x0 to 0xffff 0b0 to 0b1111 1111 1111 1111
imm20 20-bit immediate data 0 to 1,048,575 0x0 to 0xfffff 0b0 to 0b1111 1111 1111 1111 1111
sign21 Signed 21-bit immediate data -1,048,576 to 1,048,575 0x0 to 0x1fffff 0b0 to 0b1 1111 1111 1111 1111 1111
sign23 Signed 23-bit immediate data -4194304 to 4194303 0x0 to 0x7fffff 0b0 to 0b111 1111 1111 1111 1111 1111
imm24 24-bit immediate data 0 to 16,777,215 0x0 to 0xffffff 0b0 to 0b1111 1111 1111 1111 1111 1111
sign24 Signed 24-bit immediate data -8,388,608 to 8,388,607 0x0 to 0xffffff 0b0 to 0b1111 1111 1111 1111 1111 1111
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(3) Symbols
 In specifying an address with immediate data, you can use a symbol defined in the source files.

 Definition of symbols
 Usable symbols are defined as 24-bit values by any of the following methods:

1.  It is described as a label (in text, data or bss section)
 Example: LABEL1: 
 LABEL1 is a symbol that indicates the address of a described location in the .text, .data, or .bss 

section.
2. It is defined with the .set directive
 Example: .set  ADDR1,0xff00 

 ADDR1 is a symbol that represents absolute address 0x00ff00.

 Restrictions on characters
 The characters that can be used are limited to the following:
 A–Z  a–z  _  0–9 
 Note that a symbol cannot begin with a numeral. Uppercase and lowercase characters are discriminated.

 local and global symbols
 Defined symbols are normally local symbols that can only be referenced in the file where they are defined. 

Therefore, you can define symbols with the same name in multiple files. To reference a symbol defined 
in some other file, you must declare it to be global in the file where the symbol is defined by using the 
.global directive. 

 Extended notation of symbols
 When referencing an address with a symbol, you normally write the name of that symbol in the operand 

where an address is specified.
  Examples: call LABEL  ← LABEL = sign10
  ld.a %rd,LABEL ← LABEL = sign7

 The as assembler also accepts the referencing of an address with a specified displacement as shown below. 
 LABEL + imm24   LABEL + sign24
 Example: xcall LABEL+0x10
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4.3.3  Extended Instructions

The extended instructions are such that the contents which normally are written in multiple instructions including 
the ext instruction can be written in one instruction. Extended instructions are expanded into the smallest possible 
basic instructions by the as assembler. 

Types of extended instructions
 xadd xadd.a xadc xsub xsub.a xsbc x c m p 

xcmp.a xcmc

 sadd sadd.a sadc ssub ssub.a ssbc s c m p 

scmp.a scmc

 xand xoor xxor 

 sand soor sxor 

 xld xld.a xld.b xld.ub 

 sld sld.a sld.b sld.ub 

 xjpr xjpr.d xjpa xjpa.d xjreq xjreq.d xjrne 

xjrne.d xjrgt xjrgt.d xjrge xjrge.d xjrlt xjrlt.d 

xjrle xjrle.d xjrugt xjrugt.d xjruge xjruge.d xjrult 

xjrult.d xjrule xjrule.d xcall xcall.d xcalla xcalla.d

 sjpr sjpr.d sjpa sjpa.d sjreq sjreq.d sjrne 

sjrne.d sjrgt sjrgt.d sjrge sjrge.d sjrlt sjrlt.d 

sjrle sjrle.d sjrugt sjrugt.d sjruge sjruge.d sjrult 

sjrult.d sjrule sjrule.d scall scall.d scalla scalla.d

 xld.cw xld.ca xld.cf

 sld.cw sld.ca sld.cf

Method for using extended instructions
 The value or symbol for the expanded immediate size can be written directly in the operand. 
 Examples: xcall  LABEL  ; ext   LABEL[23:10]
       ; call  LABEL[9:0]

   sld.a  %r1,imm16 ; ext   imm16[15:7]

       ; ld.a  %r1,imm16[6:0]

   xld.a  %r1,imm24 ; ext   imm24[23:20]

       ; ext   imm24[19:7]

       ; ld.a  %r1,imm24[6:0]

 In addition to the immediate expansion function of the basic instructions, a special operand specification like 
the one shown below is accepted for some instructions. 

 Examples: xld.a  %r0,symbol + 0x10  ; R0 ← symbol + 0x10

   xjpa   LABEL + 5   ; Jumps to address LABEL + 5.

For details about the extended instructions that include operands, refer to Section 8.6, "Extended Instructions". 
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4.3.4  Preprocessor Directives

The cpp C preprocessor directives can be used in assembly source files.
The principal directives are as follows:

#include Insertion of file 
#define Definition of character strings and numbers
#if–#else–#endif Conditional assembly

Examples: #include "define.h"
 #define NULL 0

 #ifdef TYPE1

  ld %r0,0

 #else

  ld %r0,-1

 #endif

Refer to the gnu C preprocessor manual for details of the preprocessor directives.

Note: The sources that contain preprocessor directives need to be processed by the preprocessor (use 
the xgcc options -c and -xassembler-with-cpp), and cannot be entered directly into the as 
assembler. (Direct entry into the assembler will result an error.)
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4.4  Precautions for Creation of Sources
(1) Place a tab stop every 4 characters wherever possible. Source display/mixed display with the gdb debugger of a 

source set at a tab interval other than 4 characters may result in displaced output of the source part. 

(2) When compiling/assembling a C source or assembly source that includes debugging information, do not 
include other source files (by using #include). It may cause a debugger operation error. This does not apply 
to ordinary header files that do not contain sources.

(3) When using C and assembler modules in a program, pay attention to the interface between the C functions and 
assembler routines, such as arguments, size of return values and the parameter passing conventions.

(4) The C compiler assumes that the address size is 24 bits by default or 20 bits when the -mshort-offset option 
only is specified. Therefore, be aware that the expected results may not be obtained from an operation using an 
unsigned int/unsigned short type variable and a pointer, as int type variables are 16-bit size, as 

shown below.
  int* ip_Pt;
  unsigned int i = 1;

  ip_Pt += (-1)*i;

 The code above is written to expect "ip_Pt += (-1);", however it will be processed as "ip_Pt += 
0xffff;".

 Although it will be processed normally when the address space is 16-bit size, an invalid address will result if 
the address space is 24- or 20-bit size.

 To perform a pointer operation correctly when the C compiler is under the default condition or when the -ms-
hort-offset option only is specified, avoid using unsigned int/unsigned short type variables, or 

add the suffix 'L' to the constant as shown below so that it will be handled as a long type constant.
  ip_Pt += (-1L)*i;

(5) In C sources, function names can be used as the pointer to the function, note, however, that the pointer values 
cannot be assigned to real type (float/double) variables and arrays using the function names.

 They can be assigned to integer type variables and arrays.
 However, if assigning a value to a global variable/array using a function name at the same time the variable/

array is declared, the types of variables/arrays are limited depending on the address space size.

In 24-bit address space (default condition) or 20-bit address space (when -mshort-offset only is specified) 
 The long/unsigned long type variables/arrays only allow substitution with a function name.

In 16-bit address space (when -mpointer16 is specified) 
 The short/unsigned short/int/unsigned int type variables/arrays only allow substitution with 

a function name.

 If it is not at declaration, global variables/arrays in any integer type can be substituted with a function name.

 Integer type local variables/arrays always allow substitution with a function name regardless of whether it is at 
declaration or not.

 Examples: In 16-bit address space (when -mpointer16 is specified)
  1) short s_Global_Val = (short)boot;  

→ A function name can be used to assign the pointer to the short type global variable 
s_Global_Val when it is declared.

  2) long l_Global_Val = (long)boot;  
→ An error occurs if a function name is assigned to the long type global variable l_Global_Val 

when it is declared.
 error: initializer element is not constant

  3) short s_local_val = (short)boot;  
→ A function name can be used to assign the pointer to the short type local variable 

s_local_val.
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  4) long l_local_val = (long)boot;  
→ A function name can be used to assign the pointer to the long type local variable l_local_val.

  5) char c_Global_Val;

    void sub()

    {

   c_Global_Val = (char)boot;

    }

→ A function name can be used to assign the pointer to the char type global variable 
c_Global_Val except when it is declared.

(6) Function pointers can be used in C sources, note, however, that function pointers cannot be assigned to real type 
(float/double) variables and arrays similar to (5) above.

 They can be assigned to integer type variables and arrays.
 However, when a global variable/array is declared, a function pointer cannot be assigned at the same time.

 If it is not at declaration, a function pointer can be assigned to integer type global variables/arrays.
 Integer type local variables/arrays always allow substitution with a function pointer regardless of whether it is 

at declaration or not. However, a warning occurs depending on a combination of the address space size and the 
type of global/local variable or global/local array.

In 24-bit address space (default condition) or 20-bit address space (when -mshort-offset only is specified) 
 A warning occurs if a function pointer is assigned to a variable/array other than long/unsigned long 

data types.

In 16-bit address space (when -mpointer16 is specified)
 A warning occurs if a function pointer is assigned to a variable/array other than short/unsigned 

short/int/unsigned int data types.

 Examples: In 16-bit address space (when -mpointer16 is specified)
  void (* fp_Pt)(void); // Declaration of a function pointer with
       // void type return value and argument

  1) short s_Global_Val = (short)fp_Pt;  
→ An error occurs if a function pointer is assigned to the global variable s_Global_Val when it is 

declared.
 error: initializer element is not constant

  2) short s_local_val = (short)fp_Pt;  
→ A function pointer can be assigned to the short type local variable s_local_val.

  3) long l_local_val = (long)fp_Pt;  
→ Although a function pointer can be assigned to the long type local variable l_local_val, a 

warning will occur.
 warning: cast from pointer to integer of different size

  4) short s_Global_Val;

    void sub()
    {

   s_Global_Val = (short)fp_Pt;

    }

→ A function pointer can be assigned to the short type global variable s_Global_Val except 
when it is declared.
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(7) Be sure to include the prototype declaration or the extern declaration of the functions. 
 If there is no prototype or extern declaration and if a function without its definition part in an earlier part of the 

same file is called, the type assumed in the file calling the function may differ from the function type actually 
called, resulting in a potential malfunction. Even so, the function will compile without errors. 

 However, a warning is generated if the definition part of the called function is present in the same file. If the 
definition part of the called function is located in another file, no warning is generated unless the -Wall option 
is attached. 

 Since the return value is implicitly assumed to be of the int type, the correct value will not be returned if the 
return value has a data type larger than int.

 Example:
long l_Val=0x12345678,l_Val_2;

int main()

 {

  l_Val_2 = sub(); // l_Val_2 is substituted with 0x5678. 
  return 0;

 }

long sub()

 {

  long l_wk;

  l_wk = l_Val;

  return l_wk;

 }

(8) Do not use a pointer other than "char" to perform a read/write operations to an odd-number memory.
 Failure to observe this warning will result in an address error exception.

Example:
int *ip_Pt;

int sub()

{

 ip_Pt = (int *)0x3;

 (*ip_Pt) = 0x2;

 return 0;    // Address error exception occurs here.
}

(9) Due to the specifications of the C language, note that processing an undefined action can result in different 
calculation results due to differences in optimization options (-O0/-O/-O3) and local/external variables.

 Undefined processing includes the following cases:

・ When overflow is occurring during conversion from floating decimal to integer
・ When shift calculation is performed with a negative value or a value equal to or greater than the bit length of 

the calculation target after a type promotion.
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(10)Due to C language specifications, an attempt to access a variable using an incompatible pointer may result in 
the following warning message if the -Wall option is specified. 
In this case, reference or assignment of variables via pointers may not be performed correctly.

Example: When the -O3 option is specified.
int sub()

{

  int p1 = 0 ;

  short *p2 = (short *)&p1 ;

Because p2 and &p1 are incompatible pointers, a warning message will appear.
 In that case, variable p1 may not be referenced by means of pointer p2 or assignment may not be performed 

correctly.
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5  GNU17 IDE
 This chapter describes the facilities available with the GNU17 IDE and describes how to use the GNU17 IDE.

5.1  Overview

5.1.1  features

The GNU17 IDE (hereafter simply the IDE) provides an integrated development environment that makes it user to 
develop software using the S1C17 Family C Compiler Package (S5U1C17001C).
The main features of the IDE are outlined below.

• Project management
 Allows collective management of all source files needed to create an application as a single project.

• Supports GNU-compliant C and assembler
 The IDE lets users create and edit sources in GNU-compliant C or assembly language. User can also load source 

code written in other editors into the IDE.

• Creates and executes a makefile
 The IDE automatically generates a makefile featuring a compiler to linker execution sequence based on user-

selected build options. A build process to generate an executable object file based on this file can be executed 
simply by clicking a button.

• Creates various definition files
 The IDE lets the user easily edit/create various files in addition to the above makefile, including the linker script 

file needed to build a project and the parameter and command files needed to launch the debugger.

• Launcher for calling the gdb debugger
 After a build process, the user can call the gdb debugger to debug a built application.

5.1.2  Some Notes on Use of the IDE

About the guaranteed operation of the IDE
 The IDE is designed to run on the Eclipse development platform and uses Eclipse facilities during development 

work. Note that the facilities not described in this manual lie beyond the scope of guarantee for the IDE.

Eclipse plug-in versions
 Listed below are the Eclipse plug-ins and versions required by the IDE:

Table 5.1.2.1  Eclipse plug-in versions
Plug-in Version

Eclipse Platform 3.4.0
Eclipse CDT 5.0.0
Eclipse DSDP Memory View 1.1.0

 IDE operations cannot be guaranteed if any modification, deletions, or updates of these plug-ins are made. 
Since the IDE is a Java application, Java Virtual Machine will be installed as well. IDE operations cannot be 
guaranteed for use on a platform other than this virtual Java machine.
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About the use of Japanese language in the IDE
 Although the IDE permits Japanese (using Shift-JIS/MS-932 character code) file and directory names and 

strings, the GNU17 tools used to build projects do not support the Japanese language. Do not use the Japanese 
language for file and directory names or in executable source code. (Comments in the source code may be writ-
ten in Japanese.)

 Displaying the IDE user interface in Japanese
 The IDE comes packaged with the Eclipse "blanco" translator plug-in.
 This enables the IDE user interface (menus, dialog boxes, and error messages) to be displayed in Japanese (with 

some exceptions).
 The user interface display is normally selected automatically in accordance with the regional language option 

setting for the operating system when the IDE is launched. (Japanese display when running on Japanese OS, 
and English for all other operating systems.)

 Launching the IDE as follows enables the language display to be switched manually between English and Japa-
nese.
eclipse.exe -nl en_US: English
eclipse.exe -nl ja_JP: Japanese
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5.2  Starting and Quitting the IDE

5.2.1  Starting the IDE

The method for starting the IDE is described below.

(1) Double-click the eclipse.exe icon in the c:\EPSON\gnu17\eclipse directory to start the IDE.
 You can also start the IDE by selecting [EPSON MCU] > [GNU17] > [GNU17 IDE] from the Win-

dows Start menu, or from the command line without parameters.

(2) After the Eclipse splash screen, the [Workspace Launcher] dialog box shown below is displayed. Here, specify 
the working directory (workspace) in which you want to store projects and associated files.

  
Although c:\EPSON\gnu17\eclipse\workspace is displayed 
as the default directory, you can select any other directory or 
create a new directory and set it as the workspace. Enter a 
directory name in the [Workspace:] combo box or select one 
from the directory select dialog box displayed by clicking 
the [Browse...] button.

 The [Workspace Launcher] dialog box is displayed each time you start the IDE. If you plan to perform your 
work in the same workspace from this point, you can choose not to display the [Workspace Launcher] dialog 
box by selecting the [Use this as the default and do not ask again] check box (indicated by a check mark when 
selected). (Select [Switch Workspace...] from the [File] menu to change to a different workspace.)

* Do not specify the project directory (directory containing .project file) as a workspace directory. Doing so 
may result in failures with project imports (when [Copy projects into workspace] is selected).

 The current workspace directory can be checked by selecting [File] > [Switch workspace...] > [Other...] and 
opening the [Workspace Launcher] dialog box.
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(3) Click the [OK] button.

 The IDE window shown below will be displayed.

5.2.2  Quitting the IDE

Select [Exit] from the [File] menu to close the IDE.
If any open files in the editor have not been saved, you will be prompted to save or discard your changes. Select [Yes] 
or [No] before quitting the IDE.

You also can use the  (close) button to quit the IDE. Click the [OK] button at the following dialog prompt to quit 
or [Cancel] to continue working.

Select the [Always exit without prompt] check box to skip this prompt.
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5.3  IDE Window
The IDE window consists of an editor surrounded by several views and a menu bar and a toolbar.

       Menu bar  Window toolbar   Editor   Perspective bar 

      Status bar              Views        View toolbar
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5.3.1  Menu Bar

[file] menu
New (Alt+Shift+N)

New GNU17 Project
 Launches a GNU17 wizard to create a new 

project.
Project...
 Selects a wizard to create a new project. 
 Select [GNU17 Project] > [New GNU17 

Project] from the various wizards shown in 
the displayed dialog box.

Source File
 Creates a new source file.
Header File
 Creates a new header file.
Source Folder
 Creates a new source folder.
File from Template
 Creates a new text file. 
Other... 
 Works the same way as [Project...].

Open file...
 Choose a file to be opened with the editor.

Close (Ctrl+W)
 Closes the current active file. You will be prompted to save or discard any changes made since you created 

or last saved the file.

Close All (Ctrl+Shift+W)
 Closes all files open in the editor. You will be prompted to save or discard any changes made since you cre-

ated or last saved the files.

Save (Ctrl+S)
 Saves changes made in the current file. If the content you last edited has already been saved, selecting menu 

command has no effect.

Save As...
 Saves the current active file under another name or at a different location.

Save All (Ctrl+Shift+S)
 Saves all open files.

Revert
 Discards any changes made in the current active file, reverting to the previously saved version.

Move...
 Moves the file or directory selected in the [C/C++ Projects] or [Navigator] view to a different location.

Rename... (f2)
 Places the file or directory selected in the [C/C++ Projects] or [Navigator] view in editing mode (allowing 

renaming of the file or directory).

Refresh (f5)
 Updates the displayed content of the [C/C++ Projects] or [Navigator] view.
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Convert line Delimiters To
 Selects a line delimiting character.

Print... (Ctrl+P)
 Prints the current active file.

Switch Workspace...
 Selects another workspace. All information for the current workspace is saved before the new workspace 

opens. The [Save All] processing is executed for the file currently opened by the editor.

* Do not specify the project directory (directory containing .project file) as a workspace directory.

Restart
 Restarts the IDE.

Import...
 Launches a wizard that lets the user add an existing project or source file to the current workspace or proj-

ect.

Export...
 Writes the file in the current project out to another directory.

Properties (Alt+Enter)
 Opens a dialog box in which the user can display or edit properties of the project, file, or directory currently 

selected in the [C/C++ Projects] or [Navigator] view.

Exit
 Closes the IDE.

[Edit] menu
Undo Typing (Ctrl+Z)
 Undoes the most recent operation performed in the editor.

Redo Typing (Ctrl+y)
 Repeats the last operation canceled by [Undo Typing].

Cut (Ctrl+X)
 Cuts the selected string or file/directory and copies it to the clipboard.

Copy (Ctrl+C)
 Copies a selected string or file/directory to the clipboard.

Paste (Ctrl+V)
 Pastes the copied content from the clipboard to the position indicated 

by the cursor or into the current view.

Delete (Delete)
 Deletes the selected string or file/directory.

Select All (Ctrl+A)
 Selects all contents in the currently active editor.

find/Replace... (Ctrl+f)
 Finds and replaces a string in the editor.

find word
 Searches for the next occurrence that matches the search string.

find Next (Ctrl+K)
 Jumps to the next instance of a search string.

find Previous (Ctrl+Shift+K)
 Jumps back to the previous instance of a search string.
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Incremental find Next (Ctrl+J)
 Select this command and type a string to search for the string in the currently active document (searched 

backward from the current cursor position). This command performs another search each time you type one 
character and jumps to the next instance of the current search string when you press the arrow keys [↑] or [↓]. 
You can cancel this search mode by pressing the arrow keys [←] or [→] or the [Enter] or [Esc] key.

Incremental find Previous
 Select this command and type a string to search for the string in the currently active document (searched 

forward from the current cursor position). This command performs another search each time you type one 
character and jumps to the next instance of the current search string when you press the arrow keys [↑] or [↓]. 
You can cancel this search mode by pressing the arrow keys [←] or [→] or the [Enter] or [Esc] key.

Add Bookmark...
 Registers a line in an active document in the editor at the current cursor position as a bookmark. For more 

information on the bookmarks, refer to Section 5.5.6, "Bookmarks".

Add Task...
 Registers the line at the current cursor position in an active document in the editor as a task (memorandum). 

The registered task can be managed in the [Tasks] view.

Smart Insert Mode (Ctrl+Shift+Insert)
 Changes the editor Smart Insert Mode.

Show Tooltip Description (f2)
 Pressing the [F2] key while a tooltip is displayed focuses on the tooltip.

Word Completion (Alt+/)
 Inserts a word beginning with the character being entered in the editor into the current position. The most 

recently entered word is selected.

Quick fix (Ctrl+1)
 Displays proposals for error/warning corrections.

Content Assist (Ctrl+Space)
 Displays a dialog box and inserts the C source keyword or template selected in the dialog box into the cur-

rent cursor position in the editor. This is possible only during the editing of a C source.

Parameter Hints (Ctrl+Shift+Space)
 Displays a tip for function arguments.

Shift Right
 Moves the beginning of a line by one tab to the right.

Shift left (Shift+Tab)
 Moves the beginning of a line by one tab to the left.

format (Ctrl+Shift+f)
 Formats a text according to formatter settings.

Set Encoding...
 Selects the text-encoding format.

[Refactor] menu
Rename... (Alt+Shift+R)
 Changes the name of a selected function or variable.

Extract Constant (Alt+C)
 Cuts out a constant from a source file for use in a variable.

Extract function (Alt+Shift+M)
 Cuts out a part of a code from a source file for use in a function.
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[Navigate] menu
go Into
 Changes display of the [C/C++ Projects] or [Navigator] view to display 

the content of just the currently selected directory.

go To
Back
 Returns the [C/C++ Projects] or 

[Navigator] view to the one dis-
played immediately before.

Forward
 Returns the display traced back by 

[Go To] > [Back] above to the next 
most recent state.

Up One Level
 Switches the display of the [C/C++ Projects] or [Navigator] view to 

display content one level above the current hierarchical level.
Next Member (Ctrl+Shift+Up)
 Jumps to the next function or variable defining location. (C editor 

only)
Previous Member (Ctrl+Shift+Down)
 Jumps to the previous function or variable defining location. (C editor only)
Matching Bracket (Ctrl+Shift+P)
 Jumps to a matching bracket. (C editor only)
Next Bookmark
 Jumps to the next bookmark. (C editor only)

Open Declaration (f3)
 Opens the declaration or definition of a selected object. (Effective when the indexer is ON)

Open Type Hierarchy (f4)
 Opens the type hierarchy of a selected variable. (Effective when the indexer is ON)

Open Call Hierarchy (Ctrl+Alt+H)
 Opens the call hierarchy of a selected function. (Effective when the indexer is ON)

Open Include Browser (Ctrl+Alt+I)
 Opens the include hierarchy of a selected source file. (Effective when the indexer is ON)

Toggle Source/Header (Ctrl+Tab)
 Switches to the corresponding source file and header file with the editor.

Show In
 Selects a view other than the editor (if available) to highlight the resource that includes the selected element 

(function name, variable name, or type).

Next Annotation (Ctrl+.)
 Selects the next item the list displayed in the [Problems] or the [Search] view.

Previous Annotation (Ctrl+,)
 Selects the previous item the list displayed in the [Problems] or the [Search] view.

last Edit location (Ctrl+Q)
 Jumps to the last edited position in the editor.

go to line... (Ctrl+l)
 Jumps to the position in the active document indicated by the specified line number.
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Back (Alt+left)
 Returns to any position in the document just referenced or edited.

forward (Alt+Right)
 Reverts the display traced back by [Back] above to the next recent state.

[Search] menu
Search... (Ctrl+H)
 Displays a [Search] dialog box that lets the user search for a file or C.

file...
 Searches for a file containing the specified string. (Displays the [Search] dialog box 

file search page.)

C/C++...
 Searches for C source containing the specified string. (Displays the C search page of the [Search] dialog 

box.)

Text
 Searches the string at which the cursor is currently placed within the range (work 

space, current project, current file, or specified working set) selected from the sub-
menu.

[Project] menu
Open Project
 Opens the closed project currently selected in the [C/C++ Projects] or [Navi-

gator] view.

Close Project
 Closes the project currently selected in the [C/C++ Projects] or [Navigator] 

view.

Build All (Ctrl+B)
 Executes a build process on all projects open in the [C/C++ Projects] or 

[Navigator] view.
Build Project
 Executes a build process on the project currently selected in the [C/C++ Projects] or [Navigator] view.

Build Working Set
 Executes a build process on the resources included in a specified working set.
Clean...
 Deletes all files that were generated during the previous build process to repeat a build process from all re-

sources.

Build Automatically
 Turns the auto-build feature on or off. This feature allows the user to automatically execute a build after 

saving source files edited in the editor, but cannot be used within the IDE.

Properties
 Displays a [Properties] dialog box that lets the user display or edit properties of the project selected in the 

[C/C++ Projects] or [Navigator] view.
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   [gNU17 Actions] menu
Start Winfog17
 Launches winfog17.exe to create function option document files for mask 

ROM. Refer to Section 11.9, "winfog17.exe," for detailed information on 
winfog17. 

 If the model lacks mask options, the [INI file does not include FOG information] dialog box will appear 
when you click the [Start Winfog17] button. 

 In this case, there is no need to create a function options file. Close the dialog box and exit Winfog17.

Pack with WinMdc17
 Launches winmdc17.exe and creates a pack file (<project name>.pa). Refer to Section 11.10, "winmdc17.

exe," for detailed information on packing and unpacking.

Unpack with WinMdc17
 Launches winmdc17.exe and unpacks a pack file (<project name>.pa). Refer to Section 11.10, "winmdc17.

exe," for detailed information on packing and unpacking.

Start lcdUtility
 Launches the LCD utility application (LcdUtil17.exe).

[Run] menu
Run last launched
 Not supported.
Debug last launched
 Starts debugging using the configuration previously launched.
Run History
 Not supported.
Run As
 Not supported.
Run Configurations...
 Not supported.
Debug History
 Displays a shortcut in the submenu to the debug configuration last 

launched.
Debug As
 Not supported.
Debug Configurations...
 Opens the debugger gdb launch configuration dialog box.
External Tools
 Not supported.
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[Window] menu
New Window
 Opens a new window in the initially set view layout of the currently se-

lected perspective. The currently open project is moved unchanged to the 
new window view.

New Editor
 Opens the currently edited file with the new editor tab.

Open Perspective
GNU17
 Opens the GNU17 perspective.
Debug
 Opens the debugger perspective.
Other...
 Opens another perspective.

Show View
 Opens the view selected in a submenu. If the view is already open, the 

view is activated.

Customize Perspective...
 Allows the user to make changes to toolbar shortcuts or settings for menu commands defined in the current 

perspective.

Save Perspective As...
 Saves settings for the current perspective under another name.

Reset Perspective
 Restores the perspective (view layout, etc.) to the default state.

Close Perspective
 Closes the currently active perspective.

Close All Perspectives
 Closes all loaded perspectives.

Navigation
Show System Menu (Alt+-)
 Displays the currently active view or system menus usable in 

the editor (e.g., fast view, resize, or close).
Show View Menu (Ctrl+F10)
 Displays view menus for the currently active view.
Maximize Active View or Editor (Ctrl+M)
 Maximizes the view or editor of the currently active view. If al-

ready maximized, the view or editor reverts to the original size.
Minimize Active View or Editor
 Minimizes the view or editor of the currently active view.

Activate Editor (F12)
 Activates the document displayed in front of all other documents currently open in the editor.
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Next Editor (Ctrl+F6)
 Selects the document to be activated in the editor (by default, the one opened just after the currently ac-

tive document in usage history).
Previous Editor (Ctrl+Shift+F6)
 Selects the document to be activated in the editor (by default, the one opened just before the currently 

active document in usage history).
Switch to Editor... (Ctrl+Shift+E)
 Selects the document to be activated in the editor from the dialog box that appears.
Next View (Ctrl+F7)
 Selects the view to be activated (by default, the one opened just after the current view in usage history).
Previous View (Ctrl+Shift+F7)
 Selects the view to be activated (by default, the one opened just before the current view in usage his-

tory).
Next Perspective (Ctrl+F8)
 Selects the perspective to be activated (by default, the one opened just after the currently active perspec-

tive in usage history).
Previous Perspective (Ctrl+Shift+F8)
 Selects the perspective to be activated (by default, the one opened just before the currently active per-

spective in usage history).

Preferences...
 Displays a [Preferences] dialog box that lets users customize the IDE environment.

[Help] menu
Help Contents
 Displays help contents in a browser.

Search
 Displays a search view for help topics.

Dynamic Help
 Displays the help topic related to the view currently activated.

Key Assist... (Ctrl+Shift+l)
 Displays the list of currently available menu commands.

Software Updates
 Installs an updater, updates, plug-ins, etc. for software management.
 Use this command only when required.

About Eclipse for gNU17 Vx.x
 Shows IDE version information and detailed information on plug-ins, etc.



5-14 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5.3.2  Window Toolbar

This toolbar contains shortcuts to frequently used commands from the window menu. For information on each but-
ton, refer to the description of the menu bar in the preceding section.

 New = [File] > [New] 

 Save = [File] > [Save] 

 Print = [File] > [Print...] 

 Build All = [Project] > [Build All] 

 Start WinFog17 = [GNU17 Actions] > [Start WinFog17]

 Pack with WinMdc17 = [GNU17 Actions] > [Pack with WinMdc17]

 Unpack with WinMdc17 = [GNU17 Actions] > [Unpack with WinMdc17]

 Start LcdUtility = [GNU17 Actions] > [Start LcdUtility] 

 New C/C++ Project = [File] > [New] > [New GNU17 Project] 

 New C/C++ Source Folder = [File] > [New] > [Source Folder] 

 New C/C++ Source File = [File] > [New] > [Source File] 

 New C++ Class Unused 

 Debug = [Run] > [Debug History] > [Configuration Last Launched]

 Run Not supported

 External Tools = [Run] > [External Tools] 

 Search = [Search] > [Search...] 

 Next Annotation = [Navigate] > [Next Annotation] 

 Previous Annotation = [Navigate] > [Previous Annotation] 

 Last Edit Location = [Navigate] > [Last Edit Location] 

 Back = [Navigate] > [Back] 

 Forward = [Navigate] > [Forward] 
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5.3.3  Editor Area

This is the area of the editor where you edit source code. The IDE has an editor for C sources and an editor for as-
sembler sources. These editors have the same features as a general-purpose editor, and error messages or variable 
or function names displayed in other views can be linked to the editor. Multiple documents can be opened at a time, 
any of which can be selected with a tab at the top of the area in which its document name is displayed.

The marker bar on the left edge of the editor area shows the line in error and the markers indicating a bookmark, a 
line in which a task is set, etc. Hover the mouse pointer over a marker to display the contents of an error, the name 
of a bookmark, or a task explanation.

As for the marker bar, the overview ruler on the right edge of the area shows the position in error and the position at 
which a bookmark or task is set by a square symbol. The positions displayed on this side do not correspond to the 
current display position; they are relative positions seen from the entire file. Hover the mouse pointer over a symbol 
to display explanations as for the marker. Click a symbol to go to that position.

In addition to the built-in editors, you can start an external editor from the IDE and edit the sources in it. For more 
information on editing features, refer to Section 5.5, "The Editor and Editing of Source Files".

Overview ruler

Marker bar

Editing area

Error marker

Bookmark 

marker

Task marker
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Context menu
 Right-click in the editing area to display the context menu shown below (for information on menu commands 

that are not described below, refer to the section that discusses the menu bar).

Undo Typing  = [Edit]>[Undo Typing]

Revert file
 Returns the document currently being edited to the content saved im-

mediately before in that file.

Save  = [File]>[Save]

Open Declaration  = [Navigate]>[Open Declaration]

Open Type Hierarchy  = [Navigate]>[Open Type Hierarchy]

Open Call Hierarchy  = [Navigate]>[Open Call Hierarchy]

Quick Outline  = [Navigate]>[Quick Outline]

Toggle Source/Header  = [Navigate]>[Toggle Source/Header]

Show in
 Activates the view ([C/C++ Projects], [Navigator], [Project Explorer], 

or [Outline]) selected in the submenu and displays the file currently 
being edited. (C editor only)

Cut  = [Edit]>[Cut]

Copy  = [Edit]>[Copy]

Paste = [Edit]>[Paste]

Quick fix  = [Edit]>[Quick Fix]

Source
 Displays the submenu for editing the line at which the cursor is cur-

rently positioned.

Comment/Uncomment
 Changes the line at which the cursor is currently positioned to 

a comment line or ordinary source line ("//" added to or deleted 
from the beginning of the line). (C editor only)

Add Block Comment
 Changes the currently selected string or line to a comment by enclosing with a set of "/*" and "*/." (C 

editor only)
Remove Block Comment
 Delete a set of "/*" and "*/" from the currently selected string or line to change it to an ordinary source 

line. (C editor only)
 Shift Right  = [Edit]>[Shift Right]
 Shift Left  = [Edit]>[Shift Left]

Correct Indentation
 Aligns the indent of the line being edited.

 Format  = [Edit]>[Format]
 Add Include  = [Edit]>[Add Include]
 Content assist  = [Edit]>[Content Assist] (C editor only)

Refactor
 Rename...

 Changes the name of the selected type, function, or member in all locations, including other locations 
in the source. 
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Declarations
 Searches for the location of the declaration of the string (e.g., function name or variable name) selected in 

the editing area within the range selected in the submenu (workspace, current project, specified working 
set). (C editor only)

References
 Searches for the location that references the string (e.g., function name or variable name) selected in the 

editing area within the range selected in the submenu (workspace, current project, specified working set). (C 
editor only)

Search Text
 Searches for the string selected in the editing area within the range selected in the submenu (workspace, 

current project, current file, specified working set). (C editor only)

Preferences...
 Displays the [Preferences] dialog box for the editor.

Build Configuration...
 Defines the target to be selected by [Make Target...].

Make Target...
 Selects a target and performs a build using make.exe.
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5.3.4  [C/C++ Projects] View

Lists the projects present in the workspace along with the C and assembler 
sources, include files, and generated execution format object files included 
in these projects. (Select the type of file to be displayed using [Filters...] 
from the view menu.) The function names and global variable names, etc. 
in the C source can also be displayed. Before editing a project or source or 
performing other operations, be sure to select the desired project or source 
here.

The file list displayed in tree structure can be navigated in the same way as 
with Windows Explorer.
Display the contents of a directory/file or fold them up into the parent direc-
tory by clicking the  or  icon. To display the content of only a specific 
directory, select the desired directory and then [Go Into] from the menu. To 
redo, click the [Up] button in the toolbar shown below.

Navigation operations are saved to a history file, and the operations can be 
restored to a previous state or advanced forward using the [Back] or [For-
ward] menu command or toolbar button.

Note: The tree view display of the [C/C++ Projects] view does not support the display of symbols and 
labels in assembler sources.

Tree list icons
 Indicated below are the meanings of the main icons displayed in the tree list.

Project Include

Binary container Variable

Executable format file Function

Include container Structure (struct)

Include folder Member variable

Header file Union (union)

Source folder Enumeration type (enum)

C source file Enumerator

Assembler source file Function definition 
(prototype declaration)

Text file, etc. Macro-definition

Object file Type definition (typedef)

Toolbar
Back
 Restores the display in the view to the immediately preceding state based on history.

forward
 Advances the display in the view to the immediately following state based on history.

Up
 Expands the display in the view to the immediately higher hierarchy.
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Collapse All
 Folds all of the hierarchy-expanded display ( ) up into the uppermost hierarchy ( ).

link with Editor
 While this button is toggled, the editor view changes to reflect the selected content in the view. For 

example, when you select (click) a file in the view, the selected document is displayed in front of 
all other documents in the editor (providing the editor is already open). When you select a C source 
function name or variable name displayed in the view, the editor view jumps to the beginning of the 
function or the position at which the variable is defined.

View Menu
Select Working Set...
 Selects, creates, or deletes a working set. A working set is used to limit the 

resources to be displayed to a specific view.
Deselect Working Set
 Restores a selected working set to an unselected state.
Edit Active Working Set...
 Edits the content of the currently selected working set.

Filters...
 Specifies the type of file to be displayed.
Link With Editor
 Updates the editor view to reflect the selection in the view.

Context menu
 Right-click in the view to display the context menu shown below (for information on menu commands not de-

scribed below, refer to the section that discusses the menu bar).

New = [File]>[New]

Open
 Opens a selected file with an editor. (Effective when a file is selected)

Open With
 Opens a selected file using the editor chosen from the following submenu. (Ef-

fective when a file is selected)

go Into  = [Navigate]>[Go Into] 
   (Effective when a project is selected)

Open in new Window  = [Window]>[New Window] 
   (Effective when a project is selected)

Copy  = [Edit]>[Copy]

Paste  = [Edit]>[Paste]

Delete  = [Edit]>[Delete]

Move...  = [File]>[Move...]

Rename  = [File]>[Rename...]

Import...  = [File]>[Import...]

Export...  = [File]>[Export...]

Build Project  = [Project]>[Build Project] 
   (Effective when a project is selected)

Refresh  = [File]>[Refresh]

Add Bookmark  = [Edit]>[Add Bookmark] 
   (Effective when a project is selected)
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Close Project  = [Project]>[Close Project] 
   (Effective when a project is selected)

Compare With
 Compares the contents of two or three selected files.

Restore from local History...
 Restores files (e.g., those that have been deleted) to a project. (Effective when a project is selected)

Replace With (Effective when a file is selected)
Local History...
 Replaces a selected file with the content previously saved (selected from history).
Previous from Local History
 Replaces a selected file with the content saved immediately before.

Object file conversion (Effective when a file is selected)
Generate an S record file (Effective when an elf file is selected)
 Converts a selected elf format object file to Motorola S3 format and generates a HEX file. This calls a 

command that executes "objcopy -I elf32-little -O srec --srec-forceS3 <file-
name>.elf <filename>.sa." 

Generate a raw binary file (Effective when an elf file is selected)
 Removes debugging and other information from a selected elf format object file and generates a binary 

file. This calls a command that executes "objcopy -I elf32-little -O binary <file-
name>.elf <filename>.bin." 

Properties
 Displays a [Properties] dialog box that shows and allows changes in the properties of the current project.

Build Configuration...
 Defines the target to be selected by [Make Target...]. 

Make Target...
 Selects a target and performs a build using make.exe.
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5.3.5  [Navigator] View

Lists the directories and files present in the workspace. (The type of file to 
be displayed can be selected using [Filters...] from the view menu.) Before 
editing a project or source or performing other operations, select the desired 
project or source here.
The file list displayed in tree structure can be navigated in the same way as 
with Windows Explorer.
Display the contents of a directory/file or fold them up into only the par-
ent directory by clicking the  or  icon. To display the content of only a 
specific directory, select the desired directory and then [Go Into] from the 
menu. To redo, click the [Up] button in the toolbar shown below.
Navigation operations are saved to a history file, and the operations can be 
restored to a previous state or advanced forward using the [Back] or [For-
ward] menu command or toolbar button.

Toolbar
Back
 Restores the display in the view to the immediately preceding state based on history.

forward
 Advances display in the view to the immediately following state based on history.

Up
 Expands the display in the view to the hierarchy one level up.

Collapse All
 Folds all of the hierarchy-expanded display ( ) up into the uppermost hierarchy ( ).

link with Editor
 While this button is toggled, the editor view changes to reflect the selected content in the view. For 

example, when you select (click) a file in the view, the selected document is displayed in front of all 
other documents in the editor (providing the editor is already open). 

View Menu
Select Working Set...
 Selects, creates, or deletes a working set. A working set is used to limit the 

resources to be displayed to a specific view.
Deselect Working Set
 Restores a selected working set to an unselected state.
Edit Active Working Set...
 Edits the content of the currently selected working set.

Sort
by Name
 Sorts display in the view in alphabetical order irrespective of file types.
by Type
 Sorts display in the view in alphabetical order by file type.

Filters...
 Specifies the type of file to be displayed.
Link with Editor
 Updates the editor view to reflect the selection in the view.
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Context menu
 Right-click in the view to display the context menu shown below (for information on menu commands not de-

scribed below, refer to the section that discusses the menu bar).

New  = [File]>[New]

Open
 Opens a selected file with an editor. (Effective when a file is selected)

Open With
 Opens a selected file using the editor chosen from the following submenu. (Ef-

fective when a file is selected)

go Into  = [Navigate]>[Go Into] 
   (Effective when a project is selected)

Open in new Window = [Window]>[New Window]
   (Effective when a project is selected)

Copy  = [Edit]>[Copy]

Paste  = [Edit]>[Paste]

Delete  = [Edit]>[Delete]

Move...  = [File]>[Move...]

Rename  = [File]>[Rename...]

Import...  = [File]>[Import...]

Export...  = [File]>[Export...]

Build Project  = [Project]>[Build Project]
   (Effective when a project is selected)

Refresh  = [File]>[Refresh]

Close Project  = [Project]>[Close Project]
   (Effective when a project is selected)

Close Unrelated Project
 Closes projects unrelated to the one currently selected. (Effective when a project is selected)

Compare With
 Compares the contents of two or three selected files.

Restore from local History...
 Restores files (e.g., those that have been deleted) to a project. (Effective when a project is selected)

Replace With (Effective when a file is selected)
Local History...
 Replaces a selected file with the content previously saved (selected from history).
Previous from Local History
 Replaces a selected file with the content saved immediately before.

Object file conversion (Effective when a file is selected)
Generate an S record file (Effective when an elf file is selected)
 Converts a selected elf format object file to Motorola S3 format and generates a HEX file. This calls a 

command that executes "objcopy -I elf32-little -O srec --srec-forceS3 <file-
name>.elf <filename>.sa." 

* An S record file is generated with a name "<project name>.psa" when a project is built. In normal 
use, it is not necessary to generate an S record file by the method described above.
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Generate a raw binary file (Effective when an elf file is selected)
 Removes debugging and other information from a selected elf format object file and generates a binary 

file. This calls a command that executes "objcopy -I elf32-little -O binary <file-
name>.elf <filename>.bin." 

Properties
Displays a [Properties] dialog box that shows and allows changes in the properties of the current project.

Build Configuration...
Defines the target to be selected by [Make Target...]. 

Make Target...
Selects a target and performs a build using make.exe.
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5.3.6  [Outline] View

Shows the functions and global variables that are written in the C source being dis-
played in the editor. Clicking on one of these items allows you to jump to the position 
in the editor at which the function or variable is written. While an assembler source is 
being displayed, no information is shown in this view.
The icons in the tree list are the same as in the [C/C++ Projects] view.

Toolbar
Sort
 While this button is toggled, the displayed contents are sorted in alphabetical order. Normally, con-

tents are displayed in the order in which they appear in the editor.

Hide field
 While this button is toggled, fields are not displayed.

Hide Static Members
 While this button is toggled, static members are not displayed.

Hide Non-Public Members
 While this button is toggled, members other than public are not displayed.

View Menu
Filters...
 Specifies the items to be displayed in the view.
Group includes
 Selects whether the included files are displayed in grouped structure or individually.

Context menu
 Right-click in the view to display the context menu shown below.

Refactor
Rename...
 Changes the selected type, function, or member name, all instances includ-

ing these in other locations of the source. 

Declarations
 Searches the location where the function name or variable name selected in the view is declared within the 

range selected in the submenu (workspace, current project, specified working set).

References
 Searches the location where the function name or variable name selected in the view is referenced within 

the range selected in the submenu (workspace, current project, specified working set).
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5.3.7  [Console] View

Displays the executed command line or the messages output by the GNU17 tools.

Toolbar
Scroll lock
 While this button is toggled, automatic scroll is disabled.

Clear Console
 Clears the contents displayed.

Pin Console
 While this button is toggled, you can activate another view in the same pane even when a 

message is being output in the [Console] view. This button will prove useful when building 
a project takes time.

Display Selected Console
 When multiple consoles such as a build console and a debugger startup console are open, 

this button allows you to select the console to be displayed in the [Console] view.

Open Console
 Opens a new console.

Terminate
 This button is displayed in a debugger startup console, etc. If you click this button, the tool 

corresponding to the console (e.g., the debugger) aborts the process underway and is closed. 
The console is not closed. Nor is the console closed when processing is terminated by an 
operation on the tool side.

Remove launch
 This button is displayed in a debugger startup console, etc. It closes the active console.

Remove All Terminated launches
 This button is displayed in a debugger startup console, etc. It closes all consoles of the ter-

minated tools.

Context menu
 Right-click in the view to display the context menu shown below.

Copy = [Edit] > [Copy]

Select All = [Edit] > [Select All]

find/Replace... = [Edit] > [Find/Replace...]

go to line...
 Jumps to a specified line in the view.

Clear
 Clears the contents displayed.

 (For the menu commands not specifically discussed here, refer to the description of the menu bar.)
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5.3.8  [Problems] View

Shows the errors that occurred during a build operation. For errors in the source file, you can jump to the corre-
sponding spot in the editor that is in error by clicking on an error message here.

View menu
Show
 Selects a filter to be applied.

group By
 Selects a target for grouping of errors.

Sort By
 Select the items in the list you wish to prioritize over others when sorting the list. 

Selecting [Ascending] sorts and arranges items in ascending order. Deselecting 
[Ascending] sorts and arranges items in descending order.

New Problems View
 Creates a new problems view.

Configure Contents...
 Creates and edits filter settings.
 The conditions set here restrict the errors to be displayed and the maximum allowable number. For filter 

settings, refer to Section 5.10.5, "Filters."

Columns...
 Sets the sequence of items (rows) to be displayed.

Preferences...
 Sets the maximum number of errors to be displayed and the display/hide setting for items (rows).

Context menu
 Right-click in the view to display the context menu shown below.

go To
 Jumps to the line in the editor that is in error.

Show In
 Selects a view other than the editor (if available) to highlight the resource in 

which the selected error has occurred.

Copy = [Edit] > [Copy]

Select All = [Edit] > [Select All]

Delete
 Deletes the error markers in the editor that correspond to the selected error.

Properties
 Displays information on the error currently selected.
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Open in External Editor
 If an external editor has been set according to the procedure described in Section 5.5.10, "Launching Ex-

ternal Editor by Specifying Line Number", you can jump to the error-generating line by using the context 
menu.

 For details, refer to Section 5.5.10, "Launching External Editor by Specifying Line Number".

 (For the menu commands not specifically discussed here, refer to the description of the menu bar.)
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5.3.9  [Properties] View

Displays information on the resource or member currently selected in the [C/C++ Projects], the [Navigator], or the 
[Outline] view.
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5.3.10  [Make Targets] View

When using a makefile you created, define the target here before executing it.

Toolbar
Home
 Returns to the uppermost hierarchy in the tree list.

Back
 Returns to the hierarchy one level up in the tree list.

go Into
 Advances to the hierarchy one level down in the tree list.

Build Make Target
 Executes a make process on a selected target.

Hide Empty folders
 Hides the folders and displays registered targets only.

Context menu
 Right-click in the view to display the context menu shown below.

Build Make Target
 Executes a make process on a selected target.

Add Make Target
 Defines a make target.

Delete Make Target
 Deletes the selected target.

Edit Make Target
 Edits a selected target.

go Home
 Returns to the uppermost hierarchy in the tree list.

go Back
 Returns to the hierarchy one level up in the tree list.

go Into
 Advances to the hierarchy one level down in the tree list.
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5.3.11  [Search] View

Shows the result of a search that was performed using the [Search] dialog box. This view in the initial IDE configu-
ration is not displayed. It appears when a search is executed.

Toolbar
Show Next Match
 Jumps to the next instance of search string immediately following the found occurrence.

Show Previous Match
 Jumps to the previous instance of search string immediately preceding the found occurrence.

Remove Selected Matches
 Deletes the found occurrence that you selected.

Remove All Matches
 Deletes all of the found occurrences.

Expand All
 Expands all of the hierarchical display in the view.

Collapse All
 Folds all of the expanded hierarchical display up into the uppermost hierarchy.

Run the Current Search Again
 Repeats the search previously performed.

Cancel Current Search
 Cancels the search operation currently in progress.

Show Previous Searches
 Shows the result of the previously performed search that you selected.

Pin the Search View
 While this button is toggled, you can activate another view in the same pane even when the 

search results are being output in the [Search] view. This button will prove useful when a search 
takes time.

View Menu
Show as List
 Shows the search results in a non-hierarchical flat layout.
Show as Tree
 Shows the search results in hierarchically structured mode.
Preferences...
 Displays the preference dialog box to set search conditions.
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Context menu
 Right-click in the view to display the context menu shown below.

Open
 Opens a selected file in the editor. (Effective when searching a file)

Open With
 Opens a selected file in the editor currently selected in the submenu 

shown below. (Effective when searching a file)

C/C++ Editor (Assembly Editor)
 C editor (when C source is selected) or assembly editor (when as-

sembler source is selected)
Text Editor
 Text editor
System Editor
 Windows program (e.g., Notepad)
In-Place Editor
 C editor (when C source is selected) or assembly editor (when as-

sembler source is selected)
Default Editor
 C editor (when C source is selected) or assembly editor (when as-

sembler source is selected)

Show in
 Highlights a selected occurrence of search string in the view selected from the submenu.

Next Match
 Jumps to the next instance of search string immediately following the found occurrence.

Previous Match
 Jumps to the previous instance of search string immediately preceding the found occurrence.

Remove Selected Matches
 Deletes the found occurrences of search string from the view that you selected.

Remove All Matches
 Deletes all of the found occurrences of search string from the view.

Replace Selected...
 Replaces only the currently selected occurrence of search string with another string. (Effective when 

searching a file)

Replace All...
 Replaces all of the currently selected occurrences of search string with another string. (Effective when 

searching a file)

Search Again
 Repeats the search previously performed.

Compare With
Each Other
 Compares the contents of two or three selected files with each other.
Local History...
 Compares the content of a selected file with its previously saved content. (Effective when a file is se-

lected)
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Restore from local History...
 Restores files (such as these that have been deleted) back in the project. (Effective when a project is select-

ed)

Replace With (Effective when a file is selected)
Previous from Local History
 Replaces a selected file with the content that was saved immediately before.
Local History... 
 Replaces a selected file with its previously saved content (selected from history).

Object file conversion (Effective when a file is selected)
Generate an S record file (Effective when an elf file is selected)
 Converts the selected elf format object file into Motorola S3 format to generates a HEX file.
 This command executes "objcopy -I elf32-little -O srec --srec-forceS3 <file-

name>.elf <filename>.sa".
 Note: S record files, named <project name>.psa, are created when a project is built. 
 Normally, there is no need to create S record files using this operation.

Generate a raw binary file (Effective when an elf file is selected)
 Removes debugging and other information from the selected elf format object file to generates a binary 

file.
 This command executes "objcopy -I elf32-little -O binary <filename>.elf <file-

name>.bin".

Properties
 Displays information on the currently selected occurrence of search string.

Build Configurations...
 Defines the target to be selected by [Build Make Target...].

Build Make Target...
 Selects a target and executes make.exe.
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5.3.12  [Bookmarks] View

Shows the bookmarks registered in the editor, letting you jump to a bookmark or delete a bookmark. This view is not 
displayed in the initial IDE configuration. (You must select it by selecting [Show View] from the [Window] menu.)

View menu
Sort By
 Select the items in the list you wish to prioritize over other items when sorting the 

list. Selecting [Ascending] sorts and arranges items in ascending order. Deselect-
ing [Ascending] sorts and arranges items in descending order.

New Bookmarks View
 Creates a new bookmarks view. 

Configure Contents...
 Creates and edits filter settings.
 The conditions set here restrict the bookmarks to be displayed and the maximum 

allowable number. For filter settings, refer to Section 5.10.5, "Filters."

Columns...
 Sets the sequence of items (rows) to be displayed.

Preferences...
 Sets the maximum number of bookmarks to be displayed and the display/ hide set-

ting for items (rows).

Context menu
 Right-click  in the view to display the context menu shown below.

go To
 Jumps to a bookmark position in the editor.

Show In
 Highlights the resource in which the selected bookmark is defined in the view se-

lected from the submenu.

Copy  = [Edit] > [Copy]

Delete = [Edit] > [Delete]

Select All = [Edit] > [Select All]

Properties
 Displays information on the selected bookmarks.

 (For the menu commands not specifically discussed here, refer to the description of the menu bar.)
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5.3.13  [Tasks] View

Shows the tasks registered in the editor, letting you jump to or delete a task. A task is a "To-Do" item. The square n 
at the beginning of each line is the icon checked up on the completion of a task. The icon indicating priority (High 
= , Normal = blank, or Low = ) is displayed in the column next to the square. This view in the initial IDE con-
figuration is not displayed. To open it, you must select it from [Show View] on the [Window] menu.

View menu
Show
 Selects a filter to be applied.

group By
 Selects a target for grouping of tasks.

Sort By
 Select the items in the list you wish to prioritize over other items when sorting the 

list. Selecting [Ascending] sorts and arranges items in ascending order. Deselect-
ing [Ascending] sorts and arranges items in descending order.

New Tasks View
 Creates a new tasks view.

Configure Contents...
 Creates and edits filter settings.
 The conditions set here restrict the tasks to be displayed and the maximum allowable number. For filter set-

tings, refer to Section 5.10.5, "Filters."

Columns...
 Sets the sequence of items (rows) to be displayed.

Preferences...
 Sets the maximum number of tasks to be displayed and the display/hide setting for items (rows).

Context menu
 Right-click in the view to display the context menu shown below.

Add Task... = [Edit] > [Add Task...]

go To
 Jumps to the position in the editor at which a task is set.

Show In
 Highlights the resource in which a selected task is defined in the view selected 

from the submenu.

Copy = [Edit] > [Copy]

Delete = [Edit] > [Delete]

Select All = [Edit] > [Select All]

Mark Completed
 Adds a completion mark to a selected task.

Delete Completed Tasks
 Deletes all of the completed tasks.
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Properties
 Displays information on the tasks selected.

 (For the menu commands not specifically discussed here, refer to the description of the menu bar.)
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5.3.14  View Manipulation

This section describes how to open or close any view of the IDE and how to change the layout of a view.

Opening/closing a view
 The displayed view is closed by clicking the  button on the tab. When all views in one pane are closed, the 

pane itself goes out.
 To open a closed view, select it from [Show View] on the [Window] menu. The pane in which a selected view 

is displayed depends on how the perspective (described later) is set.
 If multiple views overlap one on top of another in one pane, use the tab at the top of each view to select the 

view you want to display.

Changing the view layout
 You can change the position at which a view is displayed by dragging its tab. When you drag the tab of a view 

to a relocatable position, a rectangular frame is displayed indicating the destination to which the view will be 
moved. For example, when you drag the tab of a view to a position in another pane and a frame in size of that 
pane and directory icons are displayed, the view is moved to that pane. Even when a frame in size of the tab 
is displayed at the tab position, the view is moved to that pane, in which case you can select a position in the 
stack of tabs at which you want to insert. If an arrow icon and a different size frame appears when you dragged 
a view's tab, the pane will be separated and the view will be displayed in a new pane.

↓

 The size of any pane can also be changed by dragging the boundary border of the pane.

Maximizing a view
 When you double-click the tab of a view, a pane including the selected view is expanded to the size of the IDE 

window, with other views hidden behind it. When you double-click the tab of a maximized view, the view re-
verts to its original size. Each pane has a maximize button at the upper right corner. Click this button to maxi-
mize a view. A minimize button restores the view to its original size. If you click the minimize button of a view 
in ordinary display, only the tab is displayed.

  Maximize button

  Minimize button

Dragging
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fast view
 You may want to expand the editor area under certain circumstances — for example, when editing a source file. 

You can choose to maximize the editor area or use fast view mode instead. In this mode, views not currently 
required are temporarily iconized and the icon placed in a fast view area at the lower left corner of the window. 
You can click the icon to enlarge the view. Other views will not be hidden.

  
To turn a view into a fast view, right-click on the corresponding tab and select [Fast 
View] from the subsequent context menu. Or drag-and-drop the tab corresponding to 
a view into a fast view area to turn it into a fast view.
For example, select [Fast View] from the context menus of the [C/C++ Projects] and 
the [Navigator] tabs. The corresponding views will be turned into fast views, and 
icons will appear in the fast view area at the lower left corner of the window. The edi-
tor and lower view areas are enlarged as the views in the left pain are closed.

  Fast view area
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 To open a fast view, click the corresponding icon in the fast view area. To close a fast view, click on any other 
view, or click the corresponding icon in the fast view area or the minimize button of the fast view.

  Click the icon to open or close a fast view

  
By default, a fast view will be displayed vertically at the left edge of 
the window. For a different orientation, select [Orientation] > [Hori-
zontal] from the context menu for the fast-view icon. The fast view 
will open horizontally at the bottom of the window.

  To restore a fast view to normal view, select [Fast View] from the context menu for 
the fast-view icon.

 Select [Close] from this context menu to close the view and remove the icon.

Fast view
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 In addition to the above, any view can be selected from the menu displayed by clicking the [Show View as a 
fast view] button to open as a fast view. The same function can be performed from [New Fast View] in the con-
text menu.

 [Show View as a fast view] button

  

To restore view layout to default settings
 Select [Reset Perspective] from the [Window] menu. When a dialog box for confirmation is displayed, click [OK]. 

The view layout will revert to default settings of the IDE (the initial state when the IDE is started for the first 
time).

 The view layout is saved when you quit the IDE. When you next start the IDE, it will start with the layout last 
saved. The IDE will not revert to the default settings when you restart it.

5.3.15  perspectives

Perspectives represent the definitions of the configuration of displayed views, the view layout including the editor 
area, and the configuration of menus and toolbars. The version of Eclipse adopted for the IDE permits switching of 
perspectives to the these suiting particular development environments. In the IDE, the perspective named "GNU17" 
is defined with the view configuration and layout described in the preceding sections.

 
The word "GNU17" shown to the right of the perspective shortcut icon indicates that the GNU17 
perspective is currently selected. Although the IDE allows you to switch perspectives, use only the 
default "GNU17" perspective.
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5.4  Projects

5.4.1  What Is a Project?

The IDE manages individual applications being developed under a project name, creating a directory with the name 
you specified before beginning to develop an application, managing resources such as source files and files gener-
ated by the compiler and other tools in it.
In addition, project management files (.cproject, .gnu17project, and .project) are generated in a proj-
ect directory and are updated from time to time by the IDE.

Note: These project management files which reside in the project directory must not be edited, moved, 
or deleted except when you manipulate them in the IDE. Attempting to do so will prevent you from 
restarting the project.

5.4.2  Creating a New Project

Application development by the IDE starts with creating a new project:

(1) Launch the [New GNU17 Project] wizard by one of the following methods.
• Select [New] > [New GNU17 Project] from the [File] menu.
• Select [New GNU17 Project] from the [New] shortcut in the toolbar.
• Select [New] > [New GNU17 Project] from the context menu for the [C/C++ Projects] or [Navigator] view.

 The wizard will start, displaying the dialog box shown below.

(2) Enter a project name in the [Project name:] text box.

Notes: • Make sure the project name you enter is 100 characters or less.

 • Only single-byte alphanumeric characters and underscores may be used for project names.
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(3) Specify the location at which you want to create a project directory. (This is necessary if you want to specify a 
specific location.)

 With default settings, the [Use default location] check box is selected, and a project directory is generated in the 
workspace directory specified when you started the IDE. Normally, go to the next step directly.

 If you want to create a project directory outside the workspace, deselect the [Use default location] check box 
and enter a path in [Location:], or select an existing directory from the list displayed by clicking the [Browse...] 
button.

Note: The path is limited to a maximum of 200 characters.

(4) Click the [Next>] button.
 The IDE goes to the target CPU select screen shown below.

(5) From the [Target CPU Device] combo box, select the target processor:

  
The models displayed in the list may be added/deleted by the configuration file that will be 
modified when a new model is released or an existing model is discontinued.

* You can switch target CPUs later. (Refer to Section 5.7.1, "Setting the GNU17 General 
Settings".)

* When "S1C17" is selected, only files up to an executable elf file will be generated when 
the project is built.
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(6) From the [Memory Model] combo box, select the memory model of the target:

  
REGULAR: 24 bits (Up to 16M-byte space can be used.)
MIDDLE: 20 bits (Up to 1M-byte space can be used.)
SMALL: 16 bits (Up to 64K-byte space can be used.)

 You can modify settings for the memory model later. (Refer to Section 5.7.1, "Setting the GNU17 General Set-
tings".)

(7) Select whether to link libraries for coprocessors (only for models permitting this selection).
 Coprocessor commands can be used to perform multiplication or division within a program. To use a coproces-

sor, you must specify the emu_copro_process( ) function in interrupt vector 3 in the vector table.
 (Refer to Section 7.2.6,"Compatibility with Coprocessor Instructions.")
 Select or unselect the [Use Co-processor Library] checkbox.
 ON: Adds the setting to link the coprocessor library libgccMD.a (for multiplication and division) or libgccM.

a (for multiplication) when creating a project. If you select this option, select the library type from the 
[Select the Co-processor library type] combo box. (Certain models offer just one selection option.)

 OFF: Adds the setting to link the ordinary emulation library libgcc.a when creating a project.
 For models for which this checkbox cannot be selected, the setting to link the ordinary emulation library libgcc.

a will be added when creating a project.

(8) Select an object you want to locate in the .vector section (section for a vector table) by selecting from the 
combo box (vector.o or boot.o selectable) or entering one in the box.

 If no objects are to be located in the .vector section, deselect the check box entitled [Allocate a specific file 
to '.vector' section].

 You can modify settings for the .vector section later. (Refer to Section 5.7.8, "Editing a Linker Script".)

(9) Specify a boot vector address. The setting address (ex. 00800, 020000, etc.) varies depending on the model se-
lected in the [Target CPU Device] combo box. The value set here will be used as the parameter for the TTBR 
setting command that will be written in the debugger startup command file created by the IDE as well as it will 
be used as the VMA of the .vector section that will be written in the linker script file.

(10) Specify the stack pointer address.
 The default setting depends on the target CPU selected. For more information on the default setting, refer to the 

corresponding technical manual for the device.
 The value set here forms the value for the linker script file __START_stack symbol created automatically by 

the IDE, allowing the symbol to be used as the start address of the stack area.

 Example: This can be defined in the boot routine as shown below.
 boot:
 xld.a   %sp, __START_stack

(11) Click the [Finish] button.

 The [New GNU17 Project] wizard is closed, and a project is created under the name specified.

Creating a new project creates a directory with the same name as the project in the current workspace or the direc-
tory specified in (3). If a directory with this project name already exists, the IDE uses it as the project directory.

In the [C/C++ Projects] or [Navigator] view, the project will be displayed along with a directory icon similar to the 
one shown below.
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Example: Project created with the name "sample"

 If multiple projects are created in the workspace, all will appear in the 
[C/C++ Projects] or [Navigator] view.
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5.4.3  Opening and Closing a Project

When you create a project, the project stays in an open state. An open project remains open until you explicitly 
close it. Even when you restart the IDE, you can continue to work on that open project unless you have closed it.
Example: Icons of open and closed projects

 ← Open project

← Closed project

In order to edit source files or to perform a build and other operations, the project must be open, and the project di-
rectory or contained files must be selected in the [C/C++ Projects] or [Navigator] view.

Closing a project
 If you have more than one project in the workspace, you can close all of them except the one you are currently 

working on.

(1) Select the project you want to close by clicking it in the [C/C++ Projects] or [Navigator] view.

(2) Close the project by one of the following methods.
• Select [Close Project] from the [Project] menu.
• Select [Close Project] from the context menu for the [C/C++ Projects] or [Navigator] view.

 This closes the project. At this time, any source files open in the editor are closed. If the contents edited in 
the editor have not been saved, the [Save Resources] dialog box (see Section 5.10.2) is displayed, letting you 
choose to save or not save the files file-by-file.

Opening a project
 A project present within the workspace and closed in the [C/C++ Projects] or [Navigator] view can be opened 

by one of the following methods.

(1) Select a project by clicking on it in the [C/C++ Projects] or [Navigator] view.

(2) Open the selected project by one of the following methods.
• Select [Open Project] form the [Project] menu.
• Select [Open Project] form the context menu for the [C/C++ Projects] or [Navigator] view.

 This works only for currently closed projects displayed in the [C/C++ Projects] or [Navigator] view. To open a 
project present in a directory outside the current workspace, switch the workspace to the directory in which the 
project is saved (see Section 5.4.4). Or import an existing project you want to open into the current workspace (see 
Section 5.4.5).
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5.4.4  Switching Workspaces

The projects displayed in the [C/C++ Projects] or [Navigator] view are only those present in the current workspace. 
To perform any operation on a project in another directory, you must switch workspaces to that directory, or create 
a new directory and make it the workspace:

(1) Save any documents currently being edited.

(2) Select [Switch Workspace...] from the [File] menu.
 The [Workspace Launcher] dialog box is displayed.

(3) Enter a path in the [Workspace:] combo box or select an existing directory from the directory select dialog box 
displayed by clicking the [Browse...] button.

 If the desired directory is a workspace previously used, select it from the list displayed by clicking the  button 
in the [Workspace:] combo box.

(4) Click the [OK] button.

The IDE window is temporarily closed. After the specified directory is set to the workspace, a new window ap-
pears. If the directory contains any open source files, these files are closed simultaneously with the IDE window. 
If the contents edited in the editor have not been saved, the [Save Resources] dialog box (see Section 5.10.2) is dis-
played.

If the workspace to which you've switched contains any existing projects, the window is opened in the status at the 
time you finished work on that project.

Specifying a nonexistent directory in (3) will create a new instance of your specified directory.



5-46 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5.4.5  Importing an Existing Project

This section describes how to import an existing project into the current workspace.
Follow the import procedure given below to continue developing a project created in the IDE of an older version 
(V1.2.1 or later).
The import procedure is described below.

(1) Perform one of the operations described below.
• Select [Import...] from the [File] menu.
• Select [Import...] from the context menu for the [C/C++ Projects] or [Navigator] view.

 The [Import] wizard will start.

(2) Select [Existing Projects into Workspace] from the list and click [Next>].
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(3) When the project is not archived, select the [Select root directory:] radio button. Then select the project direc-
tory you want to import in the directory select dialog box displayed by clicking the [Browse...] button. 
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 When the project is an archived file, select the [Select archive file:] radio button. Then select the project ar-
chived file in the file select dialog box displayed by clicking the [Browse...] button.

 When the root directory or the archived file has been selected, the projects that exist in it are displayed in the 
[Projects:] list box. Select the check box for the project to be imported (one or more projects can be selected).

 The [Select All] button is used to select all the projects in the list and the [Deselect All] button is used to dese-
lect all the project in the list.

 The [Refresh] button brings the list up to date.

 The [Copy projects into workspace] check box is used to select whether the project is copied into the work-
space directory or not. 

When not copying the project
 Deselect the [Copy projects into workspace] check box. The project will not be copied into the workspace 

and editing operations will be applied to the files located in the original project directory. Be aware that the 
original project folder is deleted by the operation to delete the project.

When copying the project
 Select the [Copy projects into workspace] check box. The specified project directory will be copied into the 

workspace and editing operations will be applied to the files located in the workspace. The files located in 
the original project directory are left unmodified.

 Be sure to select the [Copy projects into workspace] check box if you do not want to change the original files.
 When an archived file is selected, the projects in it are always copied into the workspace.

* Do not specify the project directory (directory containing .project file) as a workspace directory. Doing so 
may result in failures with project imports (when [Copy projects into workspace] is selected).

(4) Click the [Finish] button.

The imported project will be displayed in the [C/C++ Projects] or [Navigator] view.
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You also can import and execute a build process on a project created in another environment (PC) into the current 
PC by copying it in its entirety, including the project directory. However, if the project is configured with exclusive 
include search paths and library paths in the build options, you may have to modify these paths after importing the 
project.

If the target CPU set in a project is supported by EsSimulator, an essim17_user.ini file will be created in the project 
folder.

Automatic updates of the project file
 When you import a project created in an older version of the IDE, the project file (.project/.cproject/.gnu17pro-

ject/) is automatically updated to one compatible with the current version.
 Note that .cdtproject files used by projects from an older version will be replaced by .cproject files.
 A .cproject file is generated during a project import, and the contents of the .cdtproject file will be transferred 

automatically to the newly generated .cproject file.

Directory structure and resource location
 If all resources are stored together in a project folder, the project can be copied to any location. The project can 

then be built at the copied destination with no further revisions.
 Even if external files are referenced from inside the original project folder, there is no need for modification as 

long as the directory structure is the same. However, if makefiles and other files are prepared externally and are 
not automatically generated by the IDE, as explained in Tutorial 2, the paths specified in these files may need to 
be corrected.

 No problems will arise with the standard libraries and include directories as long as the tools are installed in the 
same directory (e.g., C:\EPSON\gnu17). If you use an IDE with a different tool directory, the user library and 
include directory must be changed as necessary using [GNU17 Build Options] in the [Properties] dialog box of 
the project.
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5.4.6  Deleting a Project

Unnecessary projects can be deleted as described below.

(1) Select a project you want to delete by clicking on it in the [C/C++ Projects] or [Navigator] view.

(2) Perform one of the operations described below.
• Select [Delete] from the [Edit] menu.
• Select [Delete] from the context menu for the [C/C++ Projects] or [Navigator] view.
• Press the [Delete] key.

 The [Delete Resources] dialog box is displayed.

* To leave the directories and files in the file system intact
（3） Deselect the [Delete project contents on disk] checkbox.
 In this case, the project displayed in the [C/C++ Projects] and [Navigator] views disappears, but the files re-

main. If you import the same project (refer to Section 5.4.5), you can continue working on it as a project.

* To delete all directories and files in the file system along with the project
（3'）Select the [Delete project contents on disk] checkbox.

Note: Keep in mind that if you select this option, all files associated with the project are deleted from the 
disk, and the project can no longer be recovered.

（4） Click the [OK] button to delete. To cancel, click the [Cancel] button.

Note: If you created a project with a project name exceeding the permissible maximum number of char-
acters, the project directory may not be deleted. In such cases, quit the IDE and rename the di-
rectory name of the project from the shell (i.e., the command prompt) before deleting the project.

If a project cannot be deleted on Windows Vista
 When an attempt to delete a project is made on Windows Vista by selecting [Delete project contents on disk] 

in the [Delete Resources] dialog box, an error message, "An exception has been caught while processing the 
refactoring ‘Delete Resource’" may appear and disallow the deletion of a project folder in some cases.

 This error occurs when conime.exe (enabling Japanese input in command prompt) launches using the projector 
folder as the current directory during a project build and continues running after the project is built, disallowing 
the deletion of the project folder.

 When this happens, use the Task Manager to end the conime.exe process or reboot the PC, and then delete the 
project folder.
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5.4.7  Changing the Project Name

To change a project name in the [C/C++ Projects] or [Navigator] view, follow the procedure described below.

(1) Select a project whose name you want to change by clicking on it in the [C/C++ Projects] or [Navigator] view.

(2) Perform one of the following operations.
• Select [Rename...] from the [File] menu.
• Select [Rename] from the context menu for the [C/C++ Projects] or [Navigator] view.

(3) The project name in the view will be placed in editing mode. Enter a new name and press the [Enter] key.

This operation is reflected in the file system.

Changing a project name also changes the project directory name as well as the following:

• Command file name (<project name>_gnu17IDE.cmd)
 The previous file <old project name>_gnu17IDE.cmd file is not deleted.

• The names of the files in the project listed below (changed the next time you build)
 - Executable format object file (<project name>.elf)
 - Makefile (<project name>_gnu17IDE.mak)*
 - Linker script file (<project name>_gnu17IDE.lds)*
 - Parameter file (<project name>_gnu17IDE.par)*

* These files are deleted when you change a project name, and are newly generated the next time you build. 
The elf file already generated is not deleted and remains intact with its previous name.

• Debugger startup settings
 The contents set in the [Debugger Configurations] dialog box are changed according to a new project name.

Notes: • Only single-byte alphanumeric characters and underscores can be used in a project name. 
Keep in mind that including any other characters or symbols in a project name will result in an 
error when you perform a build or other operation.

 • When the project name is changed, the IDE generates a new command file using the template 
without copying the contents of the previous command file. Therefore, copy the contents of the 
<old project name>_gnu17IDE.cmd and paste them in to the [Properties] > [GNU17 GDB 
Commands] page as necessary.

 • To place a copy of the original project in the same workspace, please paste the project first 
and then rename it.

  Example: To place Project and Project2 in the same workspace
    1. Copy project "Project".
    2. Paste the project with the name "projectTemp."
    3. Rename "projectTemp" to "Project2."

  This procedure lets you place an original project "Project" and a new project "Project2" in the 
same workspace.

 • Note that the automatic change of project settings described above will not occur if a project is 
copied and pasted using the [C/C++ Projects] or [Navigator] view menu.
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5.4.8  Resource Manipulation in a Project

This section describes the operations to create resources, as well as importing, copying, moving, or deleting re-
sources that are possible in the [C/C++ Projects] or [Navigator] view.

Creating a new source directory
 You can create a source file folder inside a project folder.
 Source files used by a project must be stored inside the source folder. When source files are stored in the source 

folder, the project can automatically add source files to make files and update linker script files for the make 
process.

 The project folder is treated as a source folder at the time of project creation.

(1) Perform one of the following operations.
• Select [New] > [Source Folder] from the [File] menu.
• Select [New] > [Source Folder] from the context menu for the [C/C++ Projects] or [Navigator] view.
• Select [Source Folder] from the [New] shortcut in the toolbar.
• Click the [New C/C++ Source Folder] button in the toolbar.

 The [New Source Folder] dialog box is displayed.

 

(2) The current project name is entered in [Project name:]. When creating a source directory in another project, 
select the project directory using the [Browse...] button.

(3) Enter the name of the directory you want to create in the [Folder name:] text box.

 

 If a source file has already been imported to the project folder, select [Update exclusion filters in other 
source folders to solve nesting.].

 If a source folder is created without selecting this checkbox, you must re-import a source file into the proj-
ect folder.

 If a source file is placed in the project folder, be sure to select this checkbox (it is selected by default).
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(4) Click the [Finish] button. To cancel, click the [Cancel] button.

The directory you created is displayed.

  
Although a general directory is created on the file system, it is assumed as 
a source directory. The source files located in the source directory will be 
included to the make process.

Creating a new directory for general-purpose use
 You can create a new directory in a project or in the internal directory of a project:

(1) Perform one of the following operations.
• Select [New] > [Other...] from the [File] menu.
• Select [New] > [Other...] from the context menu for the [C/C++ Projects] or [Navigator] view.
• Select [Other...] from the [New] shortcut in the toolbar.

 The [New] dialog box is displayed.

 

(2) Select [Folder] from the [General] tree list.

 

(3) Click [Next >].
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(4) Select the project or the parent directory in which you want to create a new directory (subdirectory) by 
clicking on it in the directory list in tree form.

(5) Enter the name of the directory you want to create in the [Folder name:] text box.

 

(6) Click the [Finish] button. To cancel, click the [Cancel] button.

The directory you created is displayed.

 

Note: The source files located in this folder will not be included in a make process. Place the source 
files into a source folder to include them in a make process.
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Creating a new source file/header file
 You can create a new source or header file in a project:

(1) Perform one of the following operations.
• Select [New] > [Source File] (to create a source file) or [Header File] (to create a header file) from the [File] 

menu.
• Select [New] > [Source File] or [Header File] from the context menu for the [C/C++ Projects] or [Nav-

igator] view.
• Select [Source File] or [Header File] from the [New] shortcut in the toolbar.
• Select [Source File] or [Header File] from the [New C/C++ Source File] shortcut in the toolbar.
• Click the [New C/C++ Source File] button in the toolbar (to create a source file).

 The [New Source File] (or [New Header File]) dialog box is displayed.

 

(2) Enter the name of the file you want to create in the [Source File:] (or [Header File:]) text box.

 

 Enter the file extension as ".c" to create a C source file or ".s" to create an assembler source file.
 The message shown below appears if an appropriate file extension for the source file is not entered. How-

ever, the file can be created with the entered name even if another file extension is specified.

 

 The current project name is entered in [Source Folder:]. When creating the file in another directory, enter 
the path or select the directory using the [Browse...] button.
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(3) Click the [Finish] button. To cancel, click the [Cancel] button.

The file you created is displayed in the view and open with the editor.

 When a header file is created by selecting [Header File] from a menu, the created file contains a macro defini-
tion (<filename>_H_) described automatically.

Creating a new general-purpose text file
 You can create a new text file in a project or in the internal directory of a project:

(1) Perform one of the following operations.
• Select [New] > [File from Template] from the [File] menu.
• Select [New] > [File from Template] from the context menu for the [C/C++ Projects] or [Navigator] 

view.
• Select [File from Template] from the [New] shortcut in the toolbar.
• Select [File from Template] from the [New C/C++ Source File] shortcut in the toolbar.
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 The [New File] dialog box is displayed.

 

(2) Select the project or the parent directory in which you want to create a new file by clicking on it in the direc-
tory list in tree form.

(3) Enter the name of the file you want to create in the [File name:] text box.

 

(4) Click the [Finish] button. To cancel, click the [Cancel] button.

The file you created is displayed in the view* and open with the editor.

* The file is not displayed in the [C/C++ Projects]/[Navigator] view when the file type (extension) is disabled 
to display by the filter setting.
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Importing an existing file or directory
 Described below is the procedure for importing an existing file or directory into a project. In the import pro-

cedure described here, files/directories are also copied to a project directory in the file system. This approach 
allows you to retain the original unchanged files when (for example) creating a new source by correcting an 
existing source. The import procedure is given below.

(1) From within the [C/C++ Projects] or [Navigator] view, click on the project or directory into which you want 
to import a file/directory.

(2) Do one of the following:
• Select [Import...] from the [File] menu.
• Select [Import...] from the context menu in the [C/C++ Projects] or [Navigator] view.

 This launches the [Import] wizard.

 

(3) Select [File System] from the list and click [Next>].
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(4) In the directory select dialog box displayed when you click the [Browse...] button to the right of the [From 
directory:] combo box, select the directory containing the file/directory you want to import. This populates 
the [From directory:] combo box with the path to the selected directory. If you imported from this project 
previously, you can select the project from the history displayed by clicking the  button in the [From di-
rectory:] combo box.

 

Note: Always be sure to select the parent directory of the file/directory you want to import. The files/di-
rectories to be imported are located in the directory displayed as the root directory in the directory 
list to the left of the dialog box.

(5) To import a file, select the file you want to import from the list box to the right (indicated by a check mark 
when selected).

 Example: Importing a file

 

 To import a directory, expand the tree list in the list box to the left and select the directory you want to im-
port from the list of sub-directories. You can also select and import a sub-sub-directory, in which case the 
directory structure from the sub-directory is also imported (for files, only those in the selected directory are 
imported).
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 Example: Importing a directory

 

(6) Click the [Finish] button.

The imported file/directory is displayed in the [C/C++ Projects] or [Navigator] view.

 Refer to Section 5.10.3 for information on the [Import > File system] dialog box and other controls.

Specifying a source folder
 The IDE writes the source files located directly below the project directory and the source files located in the 

source folder of the project to a makefile, thereby specifying those files as targets to be assembled/compiled. In 
their initial default status, source files located in the internal directory of a project other than the source folder 
are not written in a makefile. However, you can register that directory as a source folder in project properties so 
that the source files in the directory are recognized as targets for the make command.

 This procedure is described below. Note that the directory to be registered is assumed to have been already cre-
ated in or imported into the project.

(1) In the [C/C++ Projects] or [Navigator] view, select the project containing the source folder you want to se-
lect.

(2) Do one of the following:
• Select [Properties] from the [Project] menu.
• Select [Properties] from the context menu in the [C/C++ Projects] or [Navigator] view.

 This will display the [Properties] dialog box.

(3) Select [C/C++ Project Paths] from the properties list, then click the [Source] tab.
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 By default, project directories are already registered.

(4) Click the [Add Folder...] button.
 This displays the [Source Folder Selection] dialog box.

 

(5) Select the directory you want to register (indicated by a check mark when selected) and click the [OK] but-
ton.

 
 The selected directory will be registered in the list of source directories. To remove a registered source fold-

er, select it from the list and click the [Remove] button. Use the [Edit...] button (select "Exclusion filter" 
from the list before use) to select any files in the source folder you want to exclude from a makefile.
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(6) Click the [OK] button to close the [Properties] dialog box.

 A source folder in the [C/C++ Projects] or [Navigator] view is indicated by the 
letter 'C' superimposed on its icon, as shown below.

Copying/pasting a file or directory
 You can copy and paste resources from within the [C/C++ Projects] or [Navi-

gator] view.

 Copying
(1) Select the file or directory you want to copy in the [C/C++ Projects] or 

[Navigator] view.

(2) Do one of the following:
• Select [Copy] from the [Edit] menu.
• Select [Copy] from the context menu in the [C/C++ Projects] or [Navi-

gator] view.

This copies the selected resource to the clipboard.

 Pasting
(1) In the [C/C++ Projects] or [Navigator] view, select the project or directory 

into which you want to paste the copied file or directory.

(2) Do one of the following:
• Select [Paste] from the [Edit] menu.
• Select [Paste] from the context menu in the [C/C++ Projects] or [Navi-

gator] view.

(3) The dialog box shown below is displayed if you attempt to paste the file 
or directory to the location from which you copied it. Rename the file or 
directory, if necessary.

 

 The copy-and-paste operations performed in the [C/C++ Projects] or [Naviga-
tor] view are also reflected in the file system.

 You can paste resources copied in the [C/C++ Projects] or [Navigator] view 
into Windows Explorer or paste resources copied in Windows Explorer into 
the [C/C++ Projects] or [Navigator] view.

Moving a file or directory
 Do the following to move files or directories in the [C/C++ Projects] or [Navi-

gator] view:

(1) In the [C/C++ Projects] or [Navigator] view, select the file or directory you 
want to move.
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(2) Do one of the following:
• Select [Move...] from the [File] menu.
• Select [Move...] from the context menu in the [C/C++ Projects] or [Navigator] view.

(3) A directory select dialog box is displayed. Select the directory into which you want to move the file or 
directory and click [OK].
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 Move operations performed in the [C/C++ Projects] or [Navigator] view are reflected in the file system. This 
method is restricted to movements within the current workspace. To move a file or directory to a location out-
side the workspace, you must copy the resource by copying and pasting or exporting, then delete the resource 
from within the view.

Exporting a file or directory
 As described below, files/directories in the [C/C++ Projects] or [Navigator] view can be written out (exported) 

to outside the workspace.

(1) In the [C/C++ Projects] or [Navigator] view, select the file or directory you want to export to the outside 
location.

(2) Do one of the following:
• Select [Export...] from the [File] menu.
• Select [Export...] from the context menu in the [C/C++ Projects] or [Navigator] view.

 This launches the [Export] wizard.

 

(3) Expand [General].
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(4) Select [File System] from the wizard list and click [Next>].

 

(5) In the directory select dialog box displayed when you click the [Browse...] button to the right of the [To 
directory:] combo box, select the directory to which you want to export the file or directory. The [To direc-
tory:] combo box is populated by the path corresponding to the selected directory. If the directory is one to 
which you previously exported, you can select it from the history displayed when you click the  button in 
the [To directory:] combo box.

(6) Select or deselect the check boxes in the directory list and file list to edit the directories or files you want to 
export.

(7) Click the [Finish] button.

 The selected directory/files are written out to the specified directory.

 Refer to Section 5.10.4 for information on the [Export > File system] dialog box and other controls.

Renaming a file or directory
 Do the following to rename a file or directory in the [C/C++ Projects] or [Navigator] view:

(1) In the [C/C++ Projects] or [Navigator] view, select the file or directory you want to rename.

(2) Do one of the following:
• Select [Rename...] from the [File] menu.
• Select [Rename] from the context menu in the [C/C++ Projects] or [Navigator] view.

(3) The file/directory name in the view will be placed in edit mode. Enter a new name and press the [Enter] 
key.

 This operation is reflected in the file system.

Deleting a file or directory
 Do the following to delete a file/directory in the [C/C++ Projects] or [Navigator] view:

Note: • Be careful when deleting a file/directory from the [C/C++ Projects] or [Navigator] view, since 
doing so will also delete the actual file/directory from the file system.
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(1) In the [C/C++ Projects] or [Navigator] view, select the file or directory you want to delete.

(2) Do one of the following:
• Press the [Delete] key.
• Select [Delete] from the [Edit] menu.
• Select [Delete] from the context menu in the [C/C++ Projects] or [Navigator] view.

(3) A confirmation dialog box is displayed. Click [OK] to delete or [Cancel] to cancel.

 • Deleting a link to an external file or folder deletes only the link. The actual file or folder will not 
be deleted.

linking to a file located outside the project folder
 In team development, it is sometimes useful to reference source files located outside the project folder and in-

clude them in the build process.

 A link to a file located outside the project folder can be established as follows:

 Linked files can be edited just like those in the project folder.

(1) Do one of the following:
• Select [New] > [File from Template] from the [File] menu. 
• Select [New] > [File from Template] from the context menu for the [C/C++ Projects] or [Navigator] 

view.
• Select [File from Template] from the [New] shortcut in the toolbar.
• Select [File from Template] from the [New C/C++ Source File] shortcut in the toolbar.

 The [New File] dialog box is displayed.

 

(2) In the tree view of folders, select the project or parent folder in which a new file is to be created.

(3) In [File name:], enter a name for the file to be created.
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(4) Click the [Advanced>>] button.

(5) Select the [Link to file in the file system] checkbox.

(6) Click the [Browse] button and select a file to reference.

 

(7) Click the [Finish] button. Click the [Cancel] button to abort the process.

 The newly-created file, appearing in tree view, can be opened by the editor.

 

Note: • Make sure the link source file name (File name) is the same as the link destination file name 
(Link to file in the file system).

 • Be sure to select a source folder as the destination folder. (The project folder is a source folder 
by default.) If the file is not created in a source folder, it cannot be used in a build process.

 • Use of the [Variables] button for path designation is not supported. Do not use the [Variables] 
button.

About object files generated from a link source
 The object files for linked source files located outside the project folder will be generated directly under the 

project folder. 
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linking to a folder located outside the project folder
 In team development, it is sometimes useful to reference a group of source files in a folder located outside the 

project folder and include them in the build process.

 A link to a file located outside the project folder can be established as follows:

(1) Do one of the following:
• Select [New] > [Other...] from the [File] menu.
• Select [New] > [Other...] from the context menu for the [C/C++ Projects] or [Navigator] view.
• Select [Other...] from the [New] shortcut in the toolbar.

 The [New] dialog box is displayed.

 

(2) Select [Folder] from [General] in the list.
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(3) Click [Next >].

 

(4) In the tree view of folders, select the project or parent folder in which a new file is to be created.

(5) In [Folder name:], enter a name for the folder to be created. 

(6) Click the [Advanced>>] button.

(7) Select the [Link to folder in the file system] checkbox.

(8) Click the [Browse] button and select a folder to reference.

 

(9) Click the [Finish] button. Click the [Cancel] button to abort the process.
 The newly-created folder will appear in tree view.
(10) Register the folder as a source folder. After registration as a source folder, a "C" mark will appear on the 

icon.
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Note: • Make sure the link source folder name (Folder name) is the same as the link destination folder 
name (Link to folder in the file system).

 • Use of the [Variables] button for path designation is not supported. Do not use the [Variables] 
button.

 • In order to build the source files that are in the linked folder, please specify the folder as a 
"source folder." For detailed information, refer to "Specifying a source folder."

About object files generated from a link source
 The object files for linked source files located outside the project folder will be generated directly under the 

project folder. 
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5.4.9  file filter

File management and navigation in the IDE are performed in the [C/C++ Projects] or [Navigator] view. These 
views have a file filter function for screening out certain file types.
The file filter affects only the display in this view. Even if you choose not to display some of the source files needed 
to build a project, these files will be included in the build process, and the project build will proceed correctly.

file filter in the [C/C++ Projects] view
 Select [Filters...] from the toolbar menu (t) in the [C/C++ Projects] view to display the dialog box shown be-

low.

 
Select the type of file you want filtered out of the display.
Use [Select All] to select all file types or [Deselect All] 
to deselect all file types.
Select the [Name filter patterns:] check box and enter a 
character string in the text box. That allows you to filter 
out files whose names match the character string. You 
can use * (string) and ? (one character) wildcards.
The files listed below are not displayed in the initial set-
tings for the [C/C++ Projects] view:
• Files other than below corresponding to ".*"
• Executable files (.elf files)
• Object files (.o files)
• Text files not associated with C

file filter in the [Navigator] view
 Select [Filters...] from the toolbar menu (t) in the [Navigator] view to display the dialog box shown below.

 
Select the type of file to filter from the display.
Use [Select All] to select all file types or [Deselect All] to 
deselect all file types.
By default, the files listed below are not displayed in the 
[Navigator] view:
• Files corresponding to "*.o" (object files)
• Files corresponding to "*.elf" (executable files)
• Files corresponding to "*.d" (build dependency files)
• Files corresponding to "*_gnu17IDE.*" (IDE files)
• Files corresponding to "*ext0" (assembler source files 
 output from the compiler)
• Files corresponding to "*.dump " (symbol files for 2pass 

build)
• Files corresponding to "*.sa" (S3 format files of elf execut-

able files)
• Files corresponding to "*.saf" (S3 format files output by 

moto2ff)
• Files corresponding to "*.out" (vector check files)
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5.4.10  Working Set

It is possible to group only the necessary resources as a working set and to limit the contents displayed in the [C/
C++ Projects] or [Navigator] view to a specified working set. This section describes how to manipulate a working 
set in the [C/C++ Projects] view. The procedure described below is the same as for [Navigator] view.
The working set created as described below can also be used to specify a search domain or a project to build during 
a build process.

Selecting a working set

Note: Working sets must be created in advance.

(1) Select [Select Working Set...] from the toolbar menu (t) in the [C/C++ Projects] view. This displays the 
[Select Working Set] dialog box, which shows a list of the working sets created.

 

(2) Select a working set from the list and click [OK].

 Only the resources defined in the selected working set will be displayed in the [C/C++ Projects] view.

 To revert the display in the [C/C++ Projects] view, select [Deselect Working Set] from the toolbar menu (t) in 
the [C/C++ Projects] view.

Creating a working set

(1) Select [Select Working Set...] from the toolbar menu (t) in the [C/C++ Projects] view to display the [Select 
Working Set] dialog box (shown above).

(2) Click the [New...] button.
 This launches the [New Working Set] wizard.
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(3) Select [C/C++] from the [Working set type:] list and click [Next>].

 

(4) Enter the name of a working set in the [Working set name:] text box.

(5) To select all resources in a project, select the check box corresponding to the project directory.
 To select for display one or more specific resources in the project directory, click the [+] icon of the project 

to list the resources contained in the directory and select the desired resource.

(6) Click the [Finish] button.
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(7) Click [OK]. Your settings will be applied to the view. Clicking [Cancel] here will discard the settings.

Editing a working set
 You can modify the resource configuration of a created working set as described below.

(1) Select [Select Working Set...] from the toolbar menu (t) in the [C/C++ Projects] view to display the [Select 
Working Set] dialog box (shown above). 

(2) Select the working set you want to edit from the list and click [Edit...].
 This will display the [Edit Working Set] dialog box.

 

(3) Change the selected resources for the working set just as you did when creating a new working set. Click 
[Finish].

(4) Click [OK] to apply the settings to the view. Clicking [Cancel] here will discard these settings.

 To edit the working set currently selected in the view, select [Edit Active Working Set...] from the toolbar menu 
(t) in the [C/C++ Projects] view to display the [Edit Working Set] dialog box. When you close the [Edit Work-
ing Set] dialog box, any changes made will be directly reflected in the view.
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Deleting a working set
 Delete any unnecessary working sets as described below.

(1) Select [Select Working Set...] from the toolbar menu (t) in the [C/C++ Projects] view to display the [Select 
Working Set] dialog box, showing a list of the working sets created.

 

(2) Select a working set to delete from the list and click [Remove].
 No working sets are selected in the display in this view.

(3) Click the [OK] button.
 To use another working set, select one from the list before clicking [OK].
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5.4.11  Project Properties

Each project has various properties that can be referenced and configured in the [Properties] dialog box.
Do the following to open the [Properties] dialog box:

(1) Select a project in the [C/C++ Projects] or [Navigator] view.

(2) Do one of the following:
• Select [Properties] from the [Project] menu.
• Select [Properties] from the context menu in the [C/C++ Projects] or [Navigator] view.

Click the desired item in the properties list to the left of the dialog box to display the content set for the selected 
item. Make changes, if necessary.
The following properties are listed:

1. Resource
 Shows the location of the project directory. You can also set the encoding format for text files such as source 

files and the line delimiter.

2. Builders
 Register or select the builder to build projects.

3. C/C++general
 General settings for C/C++.
 Since the following items are not used by IDE, they can generally be disregarded in normal use.
 For detailed information, select [C/C++ Development User Guide] > [Reference] > [C/C++ Properties] > [C/

C++ Project Properties] > [C/C++ General] from the Help menu.

Code Style
 Formatter settings.
Documentation
 Selects the Help document to be used for a project.
 Disregard in normal use.
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File Types
 Defines the names and extensions of files used as C resources.
 Disregard in normal use.
Indexer
 Makes settings for the indexer used in the C search and content assist.
 Disregard in normal use.
Language Mappings
 Changes the language and file mapping.
 Disregard in normal use.

4. C/C++ Include Paths and Symbols
 Define the path by which to search for an include file or the symbol for a preprocessor. 
 In most cases, this setting should be left unchanged.

5. C/C++ Make Project
 Set make conditions.

6. C/C++ Project Paths
 Set the destination, etc. to which the source directory and generated files are to be output.

7. gNU17 Build Options
 Set the command line options for the compiler, assembler, and linker.

8. gNU17 gDB Commands
 Edit a debugger startup command file.

9. gNU17 general
 Select whether to link the libraries for the target processors, memory model, and coprocessors.

10. gNU17 linker Script Settings
 Edit the linker script.

11. gNU17 Parameter Settings
 Edit the parameter file used in the debugger.

12. gNU17 flash Protect Setting
 Set the flash memory flash protect bit.

13. Project References
 Select other projects to be referenced by the current project.

14. Refactoring History
 Displays the refactoring history.

15. Run/Debug Settings
 A launch configuration can be specified for the file being selected.
 Disregard in normal use.

For more information, refer to Section 5.10.1 or the various sections that discuss the corresponding specific topic.
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5.5  The Editor and Editing Source files
The IDE incorporates editors to allow users to create and edit source files. The IDE can also be set to launch an ex-
ternal editor for source file editing.

5.5.1  Starting the Editor

Types of editors
 The IDE provides three kinds of editors. Use the editor appropriate for the file type (file name extension).

 1. C editor
 Used to create and edit C sources (*.c) and header files (*.h). This editor highlights C reserved words, com-

ments, and strings. The editor provides a "content assist" feature that allows you to enter C reserved words 
or code templates by selecting from a list.

 The documents opened in this editor are represented in the [C/C++ Projects] or [Navigator] view by the 
icons shown below.

 , 

 2. Assembler editor
 Used to create and edit assembler sources (*.s). This editor highlights labels, directives, and register names.
 Documents opened in this editor are represented in the [C/C++ Projects] or [Navigator] view by the icons 

shown below.
 The tree view display of the [C/C++ Projects] view does not support the display of symbols and labels in 

assembler sources.

 

 3. Text editor
 Used to create and edit text files in formats (file name extensions) other than the above.
 The documents opened in this editor are represented in the [C/C++ Projects] or [Navigator] view by the 

icons shown below.

 

 The file types associated with the C editor or assembler editor (i.e., launch the C or assembler editor by default 
when opened) are registered as C project resource files. For information on registered file types, check [C/C++ 
File Types] in the [Properties] dialog box (displayed by selecting [Properties] from the [Project] menu) or [C/
C++] > [File Types] in the [Preferences] dialog box (displayed by selecting [Preferences...] from the [Window] 
menu).

 * Word/Excel files and batch files
 Eclipse, the platform on which the IDE is designed to run, supports OLE documents. This means that open-

ing a "*.doc" or "*.xls" file will launch the specific application associated with that file type in Windows 
(Word or Excel), allowing the file to be edited in the IDE's editor area.

 Note that opening an OLE document puts it in editing mode. You will be prompted to save your changes 
when you close the document, even if no changes were made.

 Double clicking on a "*.cmd" or "*.bat" file launches Command Prompt. To edit a file of one of these types, 
drag and drop it on the editor area.
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Creating a new source
 Do the following to create a new source (text) file:

(1) Do one of the following:
• Select [New] > [Source File] from the [File] menu.
• Select [New] > [Source File] from the context menu in the [C/C++ Projects] or [Navigator] view.
• Select [Source File] from the [New] shortcut in the toolbar.
• Select [Source File] from the [New C/C++ Source File] shortcut in the toolbar.
• Click the [New C/C++ Source File] button in the toolbar.

 This displays the [New Source File] dialog box.

 

(2) Enter the name of the file you want to create in the [Source File:] text box. To create a C source or assem-
bler source, be sure to add the file name extension appropriate for the source to be created.

(3) Click the [Finish] button.

 A blank document is opened in the editor area.

Opening a file
 To open a file in the editor, double-click on the file name (or icon) in the [C/C++ Projects] or [Navigator] view.
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5.5.2  Basic Editing facilities

The editor is used in the same way as a general editor and offers the same general functions.
Listed below are typical editing functions and menu commands.

Table 5.5.2.1  Basic editing commands

Editing facilities
Menu bar 

(key shortcut)
Context menu 

(view that shows the menu)
Button/other operation

Create a new file [File]>[New]>[Source 
File],[Header File], 
[File from Template]

[New]>[Source File],[Header 
File],[File from Template]
(C/C++ Projects, Navigator)

, 

Open a file [File]>[Open File...] [Open], [Open With]
(C/C++ Projects, Navigator)

Double-click on a file name in 
[C/C++ Projects]/[Navigator] view

Close a file [File]>[Close]
(Ctrl+W)

– Click on the  button in the editor 
tab

Close all files [File]>[Close All]
(Ctrl+Shift+W)

– –

Save a file [File]>[Save]
(Ctrl+S)

[Save] 
(Editor)

Save under another 
name

[File]>[Save As...] – –

Save all [File]>[Save All]
(Ctrl+Shift+S)

– –

Revert to previously 
saved version

[File]>[Revert] [Revert File] 
(Editor)

–

Print [File]>[Print...]
(Ctrl+P)

–

Undo [Edit]>[Undo Typing]
(Ctrl+Z)

[Undo Typing] 
(Editor)

–

Redo [Edit]>[Redo Typing]
(Ctrl+Y)

– –

Cut [Edit]>[Cut]
(Ctrl+X)

[Cut] 
(Editor)

–

Copy [Edit]>[Copy]
(Ctrl+C)

[Copy] 
(Editor)

–

Paste [Edit]>[Paste]
(Ctrl+V)

[Paste] 
(Editor)

–

Delete [Edit]>[Delete]
(Delete)

– –

Select all [Edit]>[Select All]
(Ctrl+A)

– –

Find [Edit]>[Find/
Replace...]
(Ctrl+F)

– –

Replace [Edit]>[Find/
Replace...]
(Ctrl+F)

– –

Find next [Edit]>[Find Next]
(Ctrl+K)

– –

Find previous [Edit]>[Find Previous]
(Ctrl+Shift+K)

– –



S5U1C17001C MANUAl Seiko Epson Corporation 5-81
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

5.5.3  Editing functions for C Source files

In addition to the basic editing functions shown above, the C editor provides features specific to C source code.

Jump to a specified line
 This function allows you to specify a line number and jump to that line. The procedure is described below.

(1) Select [Go to Line...] from the [Navigate] menu.
 Displays the [Go to Line] dialog box.

 

(2) Enter a line number in the text box and click [OK].
 Control will jump to the specified line.

Jump to a line with an error
 When an error occurs during a build process, a list of errors and their locations are displayed in the [Problems] 

view.

 If an error occurs in the source file currently open in the editor, the line with the error is marked with a symbol ( ). 
Hover the mouse cursor over this marker to see the nature of the error.
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 The [Problems] view links to the editor. Double-clicking on the compile error displayed in the [Problems] view 
will control jumps to the relevant line in the editor. (If closed, the file is opened.) This applies only when the er-
ror information in [Problems] view indicates the source file and the lines in error.

 Although assembler sources also support jumps from the [Problems] view, C source files allow navigation 
through the lines with the errors from within the editor.

 Jump back to a line with an error
 If you do either of the following, control jumps back to the line containing the error closest to the current 

cursor position:
• Select [Next Annotation] from the [Navigate] menu.
• Click the [Next Annotation] button in the toolbar.

 Jump forward to line containing the error
 If you do either of the following, control jumps forward to the line containing the error closest to the cur-

rent cursor position:
• Select [Previous Annotation] from the [Navigate] menu.
• Click the [Previous Annotation] button in the toolbar.

 The editor's overview ruler (to the right of the vertical scroll bar) displays a marker to indicate the position of 
the error within the overall file. Click on the marker to jump to the line containing the error.

launching external editor by specifying line number
 If an external editor has been set according to the procedure described in Section 5.5.10, "Launching External 

Editor by Specifying Line Number", you can jump to the error-generating line by using the context menu.
 For details, refer to Section 5.5.10, "Launching External Editor by Specifying Line Number".

Jump from the [Problems] view

Jump from the overview ruler 

error marker
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Incremental search
 You can use the incremental search function in the C editor to locate a string. Each time you enter a search string, 

the search results reflect the entry of each character in real time. Procedures for use are described below.

(1) Activate the file you want to search (bring it before all other files) in the editor.

(2) Select [Incremental Find Next] or [Incremental Find Previous] from the [Edit] menu.
 You will see "Incremental Find" displayed in the status bar (at the bottom) of the window, with the editor 

placed in incremental search mode.

(3) Enter a search string.
 Although no search strings are entered at the cursor position, note that the string searches proceed backward 

from the current position for [Incremental Find Next] or searched forward from the current position for [In-
cremental Find Previous].

 Among the strings matching the search string, the one closest to the current position will be displayed in 
inverse video. The search result changes each time you enter one character. If you enter a character inadver-
tently, simply use the [Backspace] key to delete it. The search string you entered appears in the status bar.

 Example: Entered as main
/* main.c         */
/* C main program */
          :
            [m] key entered
          :
/* main.c         */
/* C main program */
          :
         [a] [i] [n] key entered
          :
/* main.c         */
/* C main program */
          :

Note: The arrow keys [←] and [→] and the [Enter] and [Esc] keys terminate incremental search mode. 
Be careful to avoid pressing these keys inadvertently before the end of the search.

(4) The closest occurrence of the search string is displayed after you enter the target search string.
 You can use the arrow keys [↑] or [↓] to move to the next or previous occurrence. Selecting [Incremental 

Find Next] or [Incremental Find Previous] from the [Edit] menu has the same action.
/* main.c         */
/* C main program */
          :
            [ ] key entered
          :
/* main.c         */
/* C main program */

Note: If no matching strings are found in the chosen search direction when you select [Incremental Find 
Next] or [Incremental Find Previous], the message "<string> not found" is displayed in the status 
bar. Even in this case, since it is possible that matching strings will exist in the document, use the 
arrow keys [↑] or [↓] to search the document forward or backward.

(5) To quit incremental search mode, press the [Enter] or the [Esc] key.



5-84 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

Indentation
 In C source files, you can shift multiple lines of code to the left or right by one tab stop. Use this function to 

adjust indents (for example, to align nesting in a loop statement after copying and pasting). The procedure is 
described below.

(1) Select the line whose indent you want to change by placing the cursor within the line. To select multiple 
lines, drag across the lines in question.

(2) Select [Shift Right] or [Shift Left] from the [Edit] menu or the editor's context menu.

Example:
 main()

     {  ← [Shift Left] executed

 int j; ← [Shift Right] executed
       ↓
 main()
 {

     int j;    

 All selected lines are moved to the left or right by one tab stop.
 When shifted to the right, a tab stop is inserted at the beginning of the line(s).
 If the line is shifted to the left, one tab stop is removed from the beginning of the line(s). If indented by a space, 

a space equal to the currently set tab size (with initial settings, four characters) is removed. For example, if a 
line is indented by a blank space equal to six characters when the tab stop is set to four characters, the line will 
have a space equal to two characters left at the beginning when shifted left. If indented by a blank of space less 
than four characters, shifting the line(s) to the left will have no effect.

 Select [Window] > [Preferences...] to modify tab sizes in the [Preferences] dialog box ([Text Editors] settings 
of [General] > [Editors]).

Commenting out specified lines
 In C sources, you can comment out multiple lines, then later undo the action.
 The comment-out' procedure is described below.

(1) Select the line you want to comment out by placing the cursor at that position in the editor. To select mul-
tiple lines, drag and select the lines in question.

(2) Select [Source]>[Comment/Uncomment] from the editor's context menu.

 Example:
      for (j=0 ; ; j++)
          {

              disp_j(); ← [Source]>[Comment/Uncomment] executed
              sub(j);

          {

    ↓
      for (j=0 ; ; j++)
          {

  //            disp_j();

              sub(j);

          {

 All selected lines will be preceded by "//". Even if the selected line has already been turned into a comment, "//" 
is inserted unconditionally (whether marked with // or /*).
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 Described below is the procedure for uncommenting a line previously commented out.

(1) Select the line you want to uncomment by placing the cursor at that position in the editor. To select multiple 
lines, drag and select the lines in question.

(2) Select [Source]>[Comment/Uncomment] from the editor's context menu.

 Example:
      for (j=0 ; ; j++)
          {

  //            disp_j(); ← [Source]>[Comment/Uncomment] executed
              sub(j);

          {

    ↓
      for (j=0 ; ; j++)
          {

              disp_j();

              sub(j);

          {

 The "//" inserted at the beginning of the line is removed. Even when "//" is preceded by a space or tab stop, only 
"//" is removed. The space or tab stop left intact.

 This operation does not affect comment lines beginning with "/*".

Content assist
 The C editor has a content assist facility that allows the user to select a C reserved word or template for inser-

tion at the text cursor position from a list as the user begins typing it. This feature is described below.

(1) Place the text cursor at the position where you want to insert a new statement.

(2) If you know the code you want to enter, enter the first one or two characters. This narrows the list of sug-
gestions.

 Example: To write a for statement, enter the letter 'f'.

(3) Select [Content Assist] from the [Edit] menu or the editor's context menu.

 

(4) Choose a reserved word or template from the list and double-click.
 The selection is inserted at the cursor location.
 Consisting of a loop statement or condition statement in fixed format, templates are listed with document 

icons in the left-side column. Template contents are displayed in the right-side column when you click to 
select it from the list. While general-purpose templates are predefined, you can also define custom tem-
plates. (Refer to [C/C++] > [Editor] > [Templates] in Section 5.9, "Customizing the IDE (Preferences)".)
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Refactoring
 You can change the names of variables, types, or functions by including their declared locations and all refer-

enced locations. The procedure is described below.

(1) Select an element whose name you want to change from the editor or from the [C/C++ Projects] or [Outline] 
view.

(2) Select [Rename...] from the [Refactor] menu. Or display the context menu of the selected element and se-
lect [Refactor] > [Rename...] from it.

 This displays the [Rename] dialog box.

 

(3) Enter a new name in the [Rename to:] text box.

(4) Select the scope of renaming using a radio button in the [Scope of refactoring:] field.
[all projects] All the opened projects will be in the scope of renaming.
[related projects] All the projects related to the project being currently edited will be in the scope of re-

naming. 
[project] The project being currently edited only will be in the scope of renaming.
[working set:] Projects or files in a working set will be in the scope of renaming. Use the [Choose...] 

button to select the working set.

(5) Select the effective range using the check boxes in the [Update within:] field.
[source code] The elements in source code will be renamed. 
[comments] The string in comments will be replaced.
[macro definitions] The elements in macro definitions will be renamed.
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(6) Click the [Preview>] button to display a list of the corresponding resources. If you do not want to change 
any resource, deselect it by removing a check mark.

 

 Use the arrow buttons to check the locations of the elements that will be renamed.

(7) Click the [OK] button to change, or click the [Cancel] button to cancel.

Note: Refactoring is used in the development of Eclipse CDT.
  Thoroughly check all operations using this function after editing source files.
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5.5.4  [Outline] View

The [Outline] view shows the variables and functions defined in the C source currently in front of all other files in 
the editor area.
Click on a variable or function name to jump to its defined position in the source.
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5.5.5  Navigation History

The IDE editor retains a history of the files opened previously, making it possible to trace the history backward or 
forward, as with a Web browser. You only navigate through a history, and cannot change the edited content.

Tracing a history backward
 Do one of the following:

• Select [Back] from the [Navigate] menu.
• Click the [Back] button in the toolbar.

 These operations will return you to the immediately preceding point in a history.

 Click [t] to the right of the [Back] button in the toolbar to display a list of files in a history. If you wish, you 
can select a file from this list.

Tracing a history forward
 Do one of the following:

• Select [Forward] from the [Navigate] menu.
• Click the [Forward] button in the toolbar.

 These operations will move you forward to the point immediately following in a history.

 Click [t] to the right of the [Forward] button in the toolbar to display a list of files in a history. If you wish, 
you can select a file from this list.

Jumping to a location just edited
 This feature allows you to return to the source line you last edited. Do one of the following:

• Select [Last Edit Location] from the [Navigate] menu.
• Click the [Last Edit Location] button in the toolbar.

 These operations will always move you to the point just edited until you choose to edit another location. Any 
entry made in the document is judged as editing. Deleting the characters entered or undoing an operation does 
not reverse the history. If the last edit made was a line deletion, the history will go to the point preceding the 
deletion.
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5.5.6  Bookmarks

Frequently examined points (lines) can be marked by bookmarks. Lines marked with a bookmark are listed in 
[Bookmarks] view to allow users to move rapidly to those locations.

Attaching a bookmark
 Do the following to attach a bookmark:

(1) Place the cursor at the source line where you want to attach a bookmark.

(2) Do one of the following:
• Select [Add Bookmark...] from the [Edit] menu.
• Right-click on the editor's marker bar (the left edge of the editor area) to display the context menu, then 

select [Add Bookmark...].

 This displays the [Add Bookmark] dialog box.

 

(3) Set a bookmark name. Use the name displayed in the [Enter Bookmark name:] text box unchanged, or enter 
another name and click [OK].

 A bookmark marker appears in the editor's marker bar.

   

 Open the [Bookmarks] view. The bookmark just set has been added to the list.

 You can rename a bookmark simply by clicking in the [Description] column.

Bookmark marker
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Jumping to a bookmark
 You can jump from the [Bookmarks] view to a source line marked by a bookmark.

(1) Activate the [Bookmarks] view. If not open, select [Show View] > [Bookmarks] from the [Window] menu.

(2) Do one of the following:
• Double click in the line of the desired bookmark.
• Right-click anywhere in the line of the desired bookmark to display the context menu, then select [Go 

To].

 The editor will jump to the bookmark position.

Removing a bookmark
 If a bookmark becomes unnecessary, you can remove it in the editor or from the [Bookmarks] view.

 Performing deletions in the editor
 Right-click on a bookmark marker you want to remove to display the context menu, then select [Remove 

Bookmark].

 Removing in the [Bookmarks] view

(1) Click a bookmark marker to select it for removal.

(2) Display the context menu and select [Delete] from it.

Showing bookmark information
 Right-click anywhere in the line of the desired bookmark to display the context menu, then select [Properties]. 

This displays the [Properties] dialog box, showing the date and time of creation, in addition to the information 
shown in the view.

 You also rename the bookmark.
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filtering and sorting the bookmark list
 If the number of bookmarks makes the list in the [Bookmarks] view unwieldy, you can choose to hide certain 

bookmarks or sort the bookmarks by item.

 filters
 Use filters to display only the desired bookmarks and to hide other bookmarks.
 Furthermore, two or more filters can be configured and used as necessary.
 A new filter can be configured as in the procedure below.

(1) Activate [Bookmarks] view.

（2） Select [Configure Contents...] from the View menu (▽).

 This displays the [Configure Contents] dialog box.

(3) Click the [New] button.

 Enter the name of the filter to be configured and click [OK].

(4) If other filters are shown in [Configurations:], deselect the checkboxes for those filters and select the 
checkbox for the newly-created filter.
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(5) Select conditions to display bookmarks.
[On any element] The bookmarks attached in all the opened projects will be dis-

played.
[On any element in same project] The bookmarks attached in the project being currently selected 

will be displayed.
[On selected element only] The bookmarks attached in the file that has been selected in the 

[C/C++ Projects]/[Navigator] view or activated in the editor will 
be displayed.

[On selected element and its children] The bookmarks attached in the files located in the project or 
folder that has been selected in the [C/C++ Projects]/[Navigator] 
view or in the selected file will be displayed.

[On working set:] The bookmarks attached in a working set will be displayed. Use 
the [Select...] button to select the working set.

[Description] - [contains] In addition to the condition above, this option limits the book-
marks to be displayed to those whose [Description] contain the 
string entered in the text box. Leave the text box empty when 
this condition is not used.

[Description] - [doesn't contain] In addition to the condition above, this option limits the book-
marks to be displayed to those whose [Description] does not 
contain the string entered in the text box. Leave the text box 
empty when this condition is not used.

(6) Click [OK].

The [Bookmarks] view now displays just the bookmarks meeting the specified conditions.

 To change the conditions for the currently selected filter, omit Steps (3) and (4) and just select the condi-
tions.

 When two or more filters are created, display the dialog box above and select the filters to be used from the 
[Configurations:] list. Or select them from the submenu of the [Show] view menu.

 Refer to Section 5.10.5 for information on settings made in the [Configure Contents] dialog box.
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 Sorting
 You can prioritize items and sort the displayed bookmarks in order of prioritized items.

(1) Activate the [Bookmarks] view.

(2) Select [Sort by] from the View menu (▽) and select the items in the list you wish to prioritize over oth-
ers when sorting the list. Selecting [Ascending] sorts and arranges items in ascending order. Deselecting 
[Ascending] sorts and arranges items in descending order.
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5.5.7  Tasks

While creating a source, if you want to jump ahead while leaving part of the source pending, you can retain infor-
mation on that position or the content of work recorded as tasks. Although a task in the editor is a marker for the 
jump destination similar to a bookmark, you can specify task the priorities and use a list of tasks displayed in the 
[Tasks] view as a To Do list.

Creating a task
 Do the following to create a task:

 When including source line information

(1) Place the cursor at the source line in which you want to set a task.

(2) Do one of the following:
• Select [Add Task...] from the [Edit] menu.
• Right-click on the editor's marker bar (the left edge of the editor area) to display the context menu, then 

select [Add Task...].

 This displays the [Properties] dialog box.

(3) Enter a task description in the [Description:] text box.

(4) Select priority (High, Normal, or Low) from the [Priority:] combo box.

(5) If you want the task to be created as a completed task, select the [Completed] check box.

(6) Click the [OK] button.

 A task marker is displayed in the editor's marker bar.

 

 Open the [Tasks] view. The task created should appear in the list.

 

 The check box on the left edge of the list indicates whether a task is "Completed" or "Not Completed". For 
a completed task, click and check this box.

 The column next to it indicates the task priority with an icon.
  = High, blank = Normal,  = Low

 Click in this column to display a pull-down list box. Use the pull-down list box to revise the task priority.
 Click in the [Description] column to change a task description.

Task marker
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 When not including source line information
 You can create a To Do item not associated with a specific source file.

(1) Select [Add Task...] from the context menu of the [Tasks] view.

 This displays the [Add Task] dialog box.

(2) Enter a description of a task in the [Description:] text box.

(3) Select priority (High, Normal, or Low) from the [Priority] combo box.

(4) If you want to create the task as a completed task, select the [Completed] check box.

(5) Click the [OK] button.

 In this case, no resources or line numbers are set.

Jumping to a set task position
 You can jump from the [Tasks] view to the source line in which you set a task.

(1) Activate the [Tasks] view. If not open, select [Show View] > [Tasks] from the [Window] menu.

(2) Do one of the following:
• Double click in the line of the desired task.
• Right-click in the line of the desired task to display the context menu, then select [Go To].

 The editor will jump to the position at which the task is set.

Removing a task
 If a task does no longer need to be displayed, you can remove it in the editor or from the [Tasks] view.

 Deleting in the editor
 Right-click on the task marker you want to remove to display the context menu, then select [Remove Task].

 Removing from the [Tasks] view

(1) Click to select the task marker you want to remove.

(2) Display the context menu and select [Delete] from it.

 Removing completed tasks
 You can remove completed tasks only one at a time.

(1) Select [Delete Completed Tasks] from the context menu of the [Tasks] view.

(2) This displays a confirmation dialog box. Click [OK] to remove or [Cancel] to cancel.

 You can also use filters to hide completed tasks without deleting them (described later).
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Showing task information
 Right-click in the line of the desired task to display the context menu, then select [Properties]. This displays the 

[Properties] dialog box, showing the date and time of creation, in addition to the information shown in the view.

 You also can alter the task description here.

filtering and sorting the task list
 If the number of tasks makes the list in [Tasks] view unwieldy, you can choose to hide certain tasks or sort tasks 

by item.

 filters
 Use filters to display only the necessary tasks and to hide others.
 Furthermore, two or more filters can be configured and used as necessary.
 A new filter can be configured as in the procedure below.

(1) Activate [Tasks] view.
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(2) Select [Configure Contents...] from the View menu (▽).

 This displays the [Configure Contents] dialog box.

 

(3) Click the [New] button.

 Enter the name of the filter to be configured and click [OK]. 

(4) If other filters are shown in [Configurations:], deselect the checkboxes for those filters and select the 
checkbox for the newly-created filter.

(5) Select conditions to display tasks.
[On any element] The tasks set in all the opened projects will be dis-

played.
[On any element in same project] The tasks attached in the project being currently se-

lected will be displayed.
[On selected element only] The tasks set in the file that has been selected in the 

[C/C++ Projects]/[Navigator] view or activated in the 
editor will be displayed.
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[On selected element and its children] The tasks set in the files located in the project or 
folder that has been selected in the [C/C++ Projects]/
[Navigator] view or in the selected file will be dis-
played.

[On working set:] The tasks set in a working set will be displayed. Use 
the [Select...] button to select the working set.

[Completed] - [Completed] / [Not Completed] Select to display "Completed" or "Not completed."
[Priority] - [High] / [Normal] / [Low] Select to display tasks with a specific priority setting 

(High, Normal, Low).
[Description] - [contains] In addition to the condition above, this option limits 

the tasks to be displayed to those whose [Description] 
contain the string entered in the text box. Leave the 
text box empty when this condition is not used.

[Description] - [doesn't contain] In addition to the condition above, this option limits 
the tasks to be displayed to those whose [Description] 
does not contain the string entered in the text box. 
Leave the text box empty when this condition is not 
used.

(6) Click [OK].

 The [Tasks] view now displays only the tasks meeting the specified condition.

 To change the conditions for the currently selected filter, omit Steps (3) and (4) and just select the condi-
tions.



5-100 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

 When two or more filters are created, display the dialog box above and select the filters to be used from the 
[Configurations:] list. Or select them from the submenu of the [Shows] view menu.

 Refer to Section 5.10.5 for information on settings made in the [Configure Contents] dialog box.

 Sorting
 You can prioritize items and sort the displayed tasks in order of prioritized items.

(1) Activate the [Tasks] view.

(2) Select [Sort by] from the View menu (▽) and select the items in the list you wish to prioritize over 
other times when sorting the list. Selecting [Ascending] sorts and arranges items in ascending order. 
Deselecting [Ascending] sorts and arranges items in descending order.
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5.5.8  Customizing the Editor

You can change the font and tab size used in the editor in the [Preferences] dialog box. The [Preferences] dialog 
box is displayed when you select [Preferences...] from the [Window] menu.
Listed below are the main pages and customization items in the [Preferences] dialog box associated with the editor. 
Refer to Section 5.9, "Customizing the IDE (Preferences)" for more information on the [Preferences] dialog box.

Text fonts and colors ([general] > [Appearance] > [Colors and fonts])

 Here, you can change the default text fonts used by the C editor and assembler editor.

(1) To change fonts for the C editor, select [C/C++] > [Editor] > [C/C++ Editor Text Font] from tree view.
 Select [Basic] > [Text Font] from tree view to change assembler editor text fonts.

 C editor fonts      Assembler editor fonts

  

(2) Click [Change...] to display the font select dialog box. Select a font, font style, and display color in the dia-
log box.

 Or use the [Use System Font] button to select the 
standard Windows font.

(3) Click [Apply] or [OK] to complete the settings.
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Changing the editor tab size and displaying line numbers  

([general]>[Editors]>[Text Editors])

 To change the tab size, set the number of characters for the tab width in the [Displayed tab width:] text box.
 Select the [Show line numbers] check box to enable display of line numbers.

 You can also set highlighting and other options on this page.
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5.5.9  Using an External Editor

You can register a preferred editor to launch from the IDE for resource editing.
The procedure for registering an external editor is described below.

(1) Select [Preferences...] from the [Window] menu.
 This displays the [Preferences] dialog box.

(2) Select [General] > [Editors] > [File Associations] from the setup items listed in tree view on the left side of the 
dialog box.

(3) From [File types:], select the file type (file name extension) you want to edit with the editor being registered.
 If the file type does not appear in the list, display the dialog box below by clicking the [Add...] button for [File 

types:] and enter the file name extension (*.c, *.h, *.s) to add it to the list.
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(4) Click the [Add...] button for [Associated editors:].
 This displays the [Editor Selection] dialog box.

(5) Select the [External Programs] radio button.

(6) Select the editor you want to register from the list. If the editor does not appear in the list, click the [Browse...] 
button and use the select dialog box.

(7) Click the [OK] button to close the [Editor Selection] dialog box.

(8) Click the [OK] button to close the [Preferences] dialog box.

The file name extension you selected and the external editor have been correlated to each other by the above opera-
tion. Do this setting for all file types you want to edit.

The following describes how to open a file with the registered editor.

(1) Select a file in the [C/C++ Projects] or [Navigator] view.

(2) Right-click on the file to display the context menu. Select the registered editor from [Open With].

This opens the selected file in the external editor.

Note: You must first close files already open in the IDE editor before reopening them in an external editor.
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5.5.10  launching External Editor by Specifying line Number

External editor setting screen
 If there are compiler errors in a project built with the IDE, the [Problems] view of the IDE displays a list of the 

files and line numbers that contain errors.
 An external editor can be launched by selecting a line number in this error list.
 The following describes the procedure for registering which external editor to launch.

(1) Select [Preferences...] from the [Window] menu.
  The [Preferences] dialog box opens.

(2) Select [External Editor Path] in the tree list of setting items displayed on the left.

(3) Click the [Browse...] button and select the editor to launch.
  Both path name and file name are limited to 255 characters. By default, "notepad.exe" (text editor) is set.

(4) Specify the editor startup parameters in [Parameters].
  One of the following parameters can be set.
  %F: Replaced by the file name during startup (cannot be omitted).
  %L: Replaced by the line number during startup (can be omitted).

(5) Click the [OK] button to close the [Preferences] dialog box.

This establishes a correlation between the selected error and the external editor.
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Starting up the external editor
 If there are compiler errors in a project built with the IDE, the [Problems] view of the IDE displays a list of 

files and line numbers that contain errors.
 The external editor can be launched by selecting a line number in this error list.
 In the [Problems] view, right-click an error and select [Open in External Editor] in the context menu to launch 

the external editor set in [External Editor Path] in the [Preferences] dialog box.

If the external editor does not launch due to incorrect settings or other reason, the error message "Error opening ex-
ternal editor" is displayed.
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5.6  Search
In addition to a function that can be used to search a document opened in the editor, the IDE incorporates search 
features that allow you to search text in the entire workspace or project and to set search conditions for resources or 
C elements. Search results are displayed in the [Search] view. This section describes how to use these search fea-
tures.

5.6.1  Text Search

You can search for the string being selected in the editor not only in the file but also outside the file. The operation 
procedure is as follows:

(1) In the editor, drag and select the string to be searched.

(2) Select [Text] from the [Search] menu and select a search domain (workspace, current project, current file or a 
specified working set) from its submenu.

Search results are displayed in the [Search] view.

5.6.2  file Search

You can search for a resource in the workspace, current project, or the specified working set. You can also search 
for text data included in the file being currently edited. To perform a File Search, do one of the following to display 
the [File Search] page of the [Search] dialog box:
• Select [File...] from the [Search] menu.
• Select [Search...] from the [Search] menu, then the [File Search] tab in the ensuing [Search] dialog box.
• Click the [Search] button in the window toolbar, then select the [File Search] tab in the ensuing [Search] dialog 

box.

Set the search parameters as described below and click the [Search] button. When the search ends, the search re-
sults are displayed in the [Search] view.

[Containing text:]
 Enter the text string being searched for. To search for files only, leave this combo box blank.
 If the same search was previously performed from this page, you can select it from the pull-down list. (Click  

to display the pull-down list). The following are valid wildcards in the search string:
 *: Any string
 ?: Any character
 \: Place in front of *, ?, or \ to specify them as the search character (\*, \?, or \\).

[Case sensitive]
 Select this check box to make searches case-sensitive.
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[Regular expression]
 If this check box is selected, the search will be conducted matching regular expression patterns. This search 

mode allows you to use a regular expression input assist facility. This is described below.
(1) Select the [Regular expression] check box.
(2) Place the cursor in the [Containing text:] text field. A " " will be displayed in front of the text field, indicat-

ing that the input assist facility is enabled.
(3) Press the [Ctrl] + [Space] keys.
(4) Select the syntax you want to enter from the pull-down list.

[File name patterns:]
 Enter the file type or name pattern to search for. Separate multiple patterns with commas (,). Searches for 

multiple patterns assume an OR condition. Select the file types from the dialog box displayed by clicking the 
[Choose...] button. If the pattern you're looking for was previously entered in this page, you can select from the 
pull-down list. (Click  to display the pull-down list).

 The following are valid wildcards in the search string:
 *: Any string
 ?: Any character

[Scope]
 Use the radio buttons listed below to narrow the search domain:

[Workspace] Entire workspace
[Selected Resources] Resource selected in the [C/C++ Projects] or [Navigator] view
[Enclosing Projects] Project including the resource selected in the [C/C++ Projects] or [Navigator] view
[Working Set:] Resource in a selected working set. Use the dialog box displayed by clicking the 

[Choose...] button to select a working set.

[Customize...]
 Selects the search page ([File Search] or [C/C++ Search]) to display in the [Search] dialog box.

[Replace...]
 Performs a search using the parameters specified above, 

stopping at the first match. The matching search string 
is automatically selected. Use the [Replace] dialog box 
displayed to replace this string.
[With:]
 Enter the replacement string.

[Preview]
 Click to open the [Replace Text Matches] dialog box, 

which displays a list of matches. Check the replacement 
position.

[OK]
 Replaces the currently selected occurrence of the search string with the new string entered and begins 

searching for the next occurrence.
[Cancel]
 Stops the search.

[Search]
 Performs a search using the parameters specified above.

[Cancel]
 Cancels a search.
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5.6.3  C Search

Use C Search to search for strings, function names, and other elements within workspace resources. To perform a C 
Search, do one of the following to display the [C/C++ Search] page of the [Search] dialog box:
• Select [C/C++...] from the [Search] menu.
• Select [Search...] from the [Search] menu.
• Click the [Search] button in the window toolbar.

Set the search parameters as described below and click the [Search] button. When the search ends, the search re-
sults are displayed in the [Search] view.

[Search string:]
 Enter a search string or select a string in the editor before opening the [Search] dialog box.
 If a previous search was made for same string, you can reselect it from the pull-down list. (Click  to display 

the pull-down list).
 The following are valid wildcards in the search string:
 *: Any string
 ?: Any character

[Case sensitive]
 Select this check box to make searches case-sensitive.

[Search For]
 Selecting one of the check boxes in this section to specify the target element to look for:

[Class/Struct] Structure
[Function] Global function (not including structure, and union member functions)
[Variable] Variable (not including structure, and union members)
[Union] Union
[Method] Method (structure, or union members)
[Field] Field (structure, or union members)
[Enumeration] Enumeration
[Enumerator] Enumerator
[Namespace] Name space (ineffective)
[Typedef] Type definition
[Macro] Macro definition
[Any Element] All elements are searched for. Selecting this check box disables the check boxes for all other 

elements.
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[Limit To]
 Restrict the search target by making the selections shown below.

[Declarations] Declared location
[Definitions] Defined place (function, method, variable, field)
[References] Referenced location
[All Occurrences] All occurrences, including the above

[Scope]
 Use the radio buttons listed below to narrow the search domain:

[Workspace] Entire workspace
[Selected Resources] Resource selected in the [C/C++ Projects] or [Navigator] view
[Enclosing projects] Project that contains the resource selected in the [C/C++ Projects] or [Navigator] 

view
[Working Set:] Resources in a selected working set. Use the dialog box displayed by clicking the 

[Choose...] button to select a working set.

[Customize...]
 Selects the search page ([File Search] or [C/C++ Search]) to display in the [Search] dialog box.

[Search]
 Performs a search using the parameters specified above.

[Cancel]
 Cancels a search.

5.6.4  C Search from Context Menu

You can also search for places where the selected element is declared or referenced from the context menu on the 
editor or [Outline] view.

(1) Select an element such as a variable or function from the source in the editor or from the [Outline] view and 
right-click to display the context menu.

(2) To search for declared locations, select the search range (workspace, current project, or working set) in the 
[Declarations] submenu.

(3) To search for referenced locations, select the search range (workspace, current project, or working set) in the 
[References] submenu.

The search results are displayed in the [Search] view.

5.6.5  Canceling a Search

The [Search] view is displayed at the start of the search. The [Cancel Current Search] button in the [Search] view 
toolbar remains enabled while a search is underway. Click this button to cancel the search.
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5.6.6  Search Results

The results of File and C Searches are displayed in list form in [Search] view.

Inspecting the search position
 Click one of the search results in the [Search] view to jump to the corresponding location in the editor.
 If the target file is not open, double-click in the search results to open it.
 You can also use the [Search] view toolbar buttons to navigate the search results.

 [Show Next Match] Jumps to the search position immediately following the current search position 
in the list (equivalent to [Next Annotation] in the [Navigate] menu)

 [Show Previous Match] Jumps to the search position immediately preceding the current search position 
in the list (equivalent to [Previous Annotation] in the [Navigate] menu)

 Each occurrence of the search string is shown highlighted in the editor and indicated by an arrow marker in the 
marker bar for that line.

 If you left the file name blank for the search, the search begins from the beginning of the file. To find and re-
view a file in the [Navigator] view by file name, select the file name in the [Search] view, then select [Show In] 
> [Navigator] from the context menu or from the [Navigate] menu. The corresponding file in the [Navigator] 
view will be highlighted (assuming it is displayed in the list).

Changing [Search] view display modes
 The [Search] view is initially set to display the search results in tree form. To display the search results in non-

hierarchical mode, select [Flat Layout] from the [Show as List] view menu ( ).

Show as Tree    Show as List

  

Search history
 The [Show Previous Searches] shortcut in the [Search] view toolbar displays a list of the file, C, and text 

searches previously performed.
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 You can review or repeat a previous search result by selecting the corresponding search from the list.

 Select [Clear History] in the [Show Previous Searches] shortcut to delete all previous searches from the history.

 When [History...] is selected from the [Show Previous Searches] shortcut, the dialog box below appears to al-
low you to select the previous searches to be displayed. You can also delete previous searches individually from 
the history.

[Remove]
 Deletes the previous searches selected from the list.

[Open]
 Displays the results of the previous search selected from the list in the active [Search] view.

[Open in New]
 Opens a new [Search] view and displays the results of the previous search selected from the list.

[Cancel]
 Closes the dialog box.

Deleting the search results
 Use [Search] view toolbar buttons to delete search results.
  [Remove Selected Matches] Deletes the search results currently selected in the view.
  [Remove All Matches] Deletes all search results listed in the view.

 The search results deleted here will no longer be displayed when you select [Show Previous Searches].
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5.7  Building a Program
Building a program means compiling/assembling the necessary sources and linking the compiled/assembled sourc-
es, including libraries, to generate an executable object file. In practice, this means running make.exe to execute the 
makefile containing the compiler and linker execution procedures.
This section describes how to set the tool options and linker scripts needed for a build operation and how to execute 
a build process.

5.7.1  Setting the gNU17 general Settings

The startup command options for tools and libraries to be linked depend on the processor and its memory space 
size for which you are developing the application. You must select the correct processor type and memory model 
before attempting a build process. In most cases, you will not need to select a target CPU type and memory model, 
since this would presumably have been done when you created the project. If necessary, you can reset the target 
CPU type and memory model as follows:

(1) In the [C/C++ Projects] or [Navigator] view, select a project for which you want to change the target CPU type 
and memory model.

(2) Select [Properties] from the [Project] menu or from the context menu in the above view.
 This displays the [Properties] dialog box.

(3) Select [GNU17 General] from the properties list.

 The [Target CPU Device] and [Memory Model] combo boxes show the currently selected C17 Core/processor 
type and memory model, respectively. (The default CPU type and memory model are S1C17 and REGULAR.)

(4) Select the target CPU type from the [Target CPU Devices] list.

 

(5) From the [Memory Model] combo box, select the memory model of the target:
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REGULAR
 Address size:
  24 bits (16M-byte space can be used)
 Compiler and assembler options (described in makefile):
  -mpointer16 Not specified
  -mshort-offset Not specified
 Library files (described in makefile and linker script file):
  24-bit libraries

MIDDLE
 Address size:
  20 bits (1M-byte space can be used)
 Compiler and assembler options (described in makefile):
  -mpointer16 Not specified
  -mshort-offset Specified
 Library files (described in makefile and linker script file):
  24-bit libraries

SMALL

 Address size:
  16 bits (64K-byte space can be used)
 Compiler and assembler options (described in makefile):
  -mpointer16 Specified
  -mshort-offset Specified
 Library files (described in makefile and linker script file):
  16-bit libraries

(6) Select whether to link libraries for coprocessors (only for models permitting this selection).

 Coprocessor commands can be used to perform multiplication or division within a program. To use a coproces-
sor, you must specify the emu_copro_process( ) function in interrupt vector 3 in the vector table.

 (Refer to Section 7.2.6,"Compatibility with Coprocessor Instructions.")

 Select or unselect the [Use Co-processor Library] checkbox.
 ON: Adds the setting to link the coprocessor library libgccMD.a (for multiplication and division) or libgccM.a  

(for multiplication) when creating a project. If you select this option, select the library type from the 
[Select the Co-processor library type] combo box. (Certain models offer just one selection option.)

 OFF: Adds the setting to link the ordinary emulation library libgcc.a when creating a project.

 For models for which this checkbox cannot be selected, the setting to link the ordinary emulation library libgcc.
a will be added when creating a project.

(7) Click the [OK] button to confirm the changes made or the [Cancel] button to cancel.

 The buttons have the functions described below:
[OK] Confirms the changes made. If above settings have been changed, a dialog box appears for 

selecting "clean" build (see Section 5.7.8) to delete the files created with the previous set-
tings (and rebuild).

 Then the [Properties] dialog box is closed.
[Cancel] Discards the changes made and closes the dialog box.
[Apply] Confirms the changes made, but will not close the dialog box. To change other properties, 

click the [Apply] button before proceeding to the desired page.
 If above settings have been changed, a dialog box appears for selecting "clean" build (see 

Section 5.7.8) to delete the files created with the previous settings (and rebuild).
[Revert Settings] Undoes the changes made, restoring the state in which this page was opened (or, if you 

clicked the [Apply] button, the content confirmed at that point).

Note: If the target CPU has changed, a confirmation dialog box will prompt you to manually correct the 
section layout on the linker script setting screen and command file contents on the GDB com-
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mand screen.
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5.7.2  Setting the Build goal

In a GNU17 project, a build goal (end product of build) can be selected.

• Build Mask file (psa)
 A mask file is output as an end product after debugging is completed.
 All program data must be placed in ROM.
 The blank areas of ROM will be filled with 0xFF.
 Selecting this option will also generate an elf file.

• Build Executable file (elf)
 An elf file, which can be used in debugging during the development process, is output.
 Some program data can be placed in RAM for debugging.
 If this option is selected, a psa file will not be generated.

"Build Mask file (psa)" is selected by default. However, if "S1C17" is selected as the CPU, "Build Executable file 
(elf)" becomes the fixed setting and cannot be changed.

A build goal can be set as follows:

(1) Select the project to build from the [C/C++ Projects] or [Navigator] view.
(2) Select [Properties] from the context menu for the [Project] menu or the above view.
 The [Properties] dialog box opens.
(3) Select [GNU17 Build Options] in the property list.

(4) Select either [Build Mask File (psa)] or [Build Executable file (elf)] from [Build goal switch].

(5) To modify another property, click the [Apply] button. To end property setting, click the [OK] button.
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5.7.3  Setting Compiler Options

Do the following to set C compiler command options.

(1) Select a project to build in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu, or select the context menu from the above view.
 This displays the [Properties] dialog box.

(3) Select [GNU17 Build Options] from the properties list.

(4) Select [Compiler] from the [Build Options] tree.

 

 The [Command:] field shows the name of the C compiler. The [All Options] field lists currently set compiler 
options.

(5) Select a category from the [Compiler] tree list and set the necessary options.

(6) Click the [Apply] button to change other properties or the [OK] button to complete property settings.
 If settings in a [GNU17 Build Options] page have been changed, a dialog box appears for selecting "clean" 

build (see Section 5.7.8) to delete the files created with the previous settings (and rebuild).

 If you haven't clicked [Apply] yet, you can use the [Revert Settings] button to discard the changes and restore 
the state in which this page was opened.

Shown below are the pages in which compiler options are set for each category. For detailed information on the op-
tions, refer to the section that discusses the C compiler.
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[general]

 

 Select basic compiler option from this page.

 [Use Japanese Kanji filter] (Setting Kanji filter)
 If this option is enabled, Shift JIS codes in the source will be read appropriately during compilation. Dis-

abling the option is equivalent to specifying the -mno-sjis-filt option when calling a compiler, in which case 
the above processing is not performed.

 The default status of the checkbox depends on the language of the OS used to run the IDE. The checkbox 
is selected by default if the IDE is launched in a Japanese-language OS environment; in other language ver-
sions, the checkbox is unselected by default. (When the checkbox is unselected, the -mno-sjis-filt option is 
specified during compilation.)
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[Optimization]

 

 Select compiler optimization options from this page.

 [Optimization Level] (default: -O1)
Select the optimization level.
-O0: No optimization performed.
-O1: Optimizes code by prioritizing speed and size.
-O3: Optimizes code execution speed.

Refer to Section 6.3.2, "Command-line Options," for detailed information on optimization.
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[Directories]

 

 Set compiler search path options from this page.

 [Include Paths (-I)] (default: -I$(TOOL_DIR)/include)
 Set the include file search path. The buttons have the functions described below.

 [Add] Adds a directory. A dialog box for entering a path or selecting one using the [File  
System...] button is displayed.

 [Delete] Deletes the path selected in the list.
 [Edit] Edits the path selected in the list. A dialog box is displayed to allow you to edit the path.
 [Move Up] Moves the path selected in the list one position up in the list. The include files are 

searched in order in which the paths are listed, beginning with the uppermost path.
 [Move Down] Moves the path selected in the list one position down.

* About $(TOOL_DIR)
 The [Include Paths (-I)] column lists "$(TOOL_DIR)/include" that is set by default.

 $(environment variable) is a macro defined in the makefile that is generated when you build a project. 
TOOL_DIR is the environment variable in which the path to the gnu17 tool directory is defined. The de-

fined contents can be verified in the [Environments] tab page.
 Example: If the gnu17 tools have been installed in the c:\EPSON\gnu17 directory
  TOOL_DIR = c:/EPSON/gnu17

 Since the macro is replaced with the contents of the environment variable described in () during execution 
of make.exe, -I$(TOOL_DIR)/include will be resolved to -Ic:/EPSON/gnu17/include.

 The [Environments] tab page allows the user to define environment variables similar to TOOL_DIR. The 
environment variables defined here may be used for specifying include file and library file paths in the build 
options. Refer to Section 5.10.1 for details of the [Environments] page.
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[Symbols]

 

 Set compiler macro-definition options from this page.

 [Defined Symbols (-D)] (default: none)
 Specify a macro-name and replacement character. The buttons have the functions described below.

 [Add] Adds a macro-definition. A dialog box for entering a macro-definition is displayed. 
Make the entry in the form shown below.

  <macro-name>
    or
  <macro-name>=<replacement string>

 [Delete] Deletes the selected macro-definition from the list.
 [Edit] Edits the macro-definition selected in the list. A dialog box is displayed to allow you to 

edit the macro-definition.
 [Move Up] Moves the macro-definition selected in the list one position up in the list.
 [Move Down] Moves the macro-definition selected in the list one position down.
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[Code generation]

 

 Select compiler code generation option from this page.

[Do not expand built-in functions inline (-fno-builtin)] (default: ON)
 If this option is specified, built-in functions are ignored and the functions are always called.
 For the functions in question, refer to Section 6.3.2, "Command-line Options".
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[Miscellaneous]

 

 Set other compiler options from this page.

[Other flags] (default: -Wall -Werror-implicit-function-declaration)
 Enter other options directly into this text field. Separate each option with one or more spaces.
 Refer to Section 6.3.2, "Command-line Options," for detailed information on each option.

Note: When the -S option is specified, the IDE compiles the C source and outputs an assembly file 
(extension: .ext0), then assembles this file using an assembler. It is not necessary to specify 
the -S option or -c option for Other Flags.

   The C source assembly image can be confirmed by viewing the <C source file name.ext0> 
file.
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5.7.4  Setting Assembler Options

Do the following to set assembler command options.

(1) Select a project to build in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu, or select the context menu from the above view.
 This displays the [Properties] dialog box.

(3) Select [GNU17 Build Options] from the properties list.

(4) Select [Assembler] from the [Build Options] tree.

 

 The [Command:] field shows the program name of the compiler*, and the [All Options] field lists the currently set 
options.

Note: When the -c -xassembler-with-cpp option is specified, the IDE assembles the assembler 
source using the specified C compiler. It is not necessary to specify the compiler -c option or 
-xassembler-with-cpp option to All Options.

(5) Select [General] from the [Assembler] tree list and set the necessary options.

(6) Click the [Apply] button to change other properties or the [OK] button to complete property settings.
 If settings in a [GNU17 Build Options] page have been changed, a dialog box appears for selecting "clean" 

build (see Section 5.7.8) to delete the files created with the previous settings (and rebuild).

 If you haven't clicked [Apply], you can use the [Revert Settings] button to discard the changes made and restore 
the state in which this page was opened.

Shown below are the pages in which assembler options are set. For detailed information on the options, refer to the 
section that discusses the assembler.



S5U1C17001C MANUAl Seiko Epson Corporation 5-125
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

[general]

 

 The -c, -xassembler-with-cpp, and -Wa,--gstabs options (and -mpointer16 option depending 
on the memory model selected) are always added. Set other assembler options from this page. 

[Other flags] (default: none)
 Enter the options to be passed to the assembler. Insert one or more spaces between each option.
 The options entered are passed to the assembler as "-Wa,<option>, ...".
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5.7.5  Setting linker Options

Do the following to set the linker command options:

(1) Select a project to build in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu, or select the context menu from the above view.
 This displays the [Properties] dialog box.

(3) Select [GNU17 Build Options] from the properties list.

(4) Select [Linker] from the [Build Options] tree.

 

 The [Command:] field shows the program name of the linker. The [All Options] field lists the currently set options.

(5) Select a category from the [Linker] tree list and set the necessary options.

(6) Click the [Apply] button to change other properties or the [OK] button to complete property settings.
 If settings in a [GNU17 Build Options] page have been changed, a dialog box appears for selecting "clean" 

build (see Section 5.7.8) to delete the files created with the previous settings (and rebuild).

 If you haven't clicked [Apply], you can use the [Revert Settings] button to discard the changes made and to re-
turn to the state in which this page was opened.

Shown below are the pages in which the linker options are set. For detailed information on the options, refer to the 
section that discusses the linker.
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[general]

 

 The -Map and -N options are always added. Set other linker options from this page.

[Linker flags] (default: -T<project name>_gnu17IDE.lds)
 Enter other linker options in this text field. Insert one or more spaces between each option.
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[libraries]

 

 Set the libraries to be linked from this page.

[Libraries]
 If you chose not to use a coprocessor-compatible library when creating the project, the default [Libraries] 

are libstdio.a, libc.a, libgcc.a, and libc.a. 
 If you specified a coprocessor-compatible library when creating the project, the default [Libraries] are 

libstdio.a, libc.a, libgccM.a or libgccMD.a, and libc.a.

 Set the libraries to be linked. The buttons have the functions described below.
 [Add] Adds a library. A dialog box is displayed to allow you to enter a path or select one using 

the [File System...] button.
 [Delete] Deletes the library selected in the list.
 [Edit] Edits the library selected in the list. A dialog box is displayed to allow you to edit the 

path.
 [Move Up] Moves the library selected in the list one position up in the list. Libraries are linked in 

order of listed paths, beginning with the uppermost path.
 [Move Down] Moves the library selected in the list one position down.

 The libraries set here are written in a makefile to link to the objects generated from the sources. However, they 
must be mapped to sections in a linker script file.

* Either the 24-bit libraries or 16-bit libraries are specified by default according to the selected memory model. 
Furthermore, libc.a is specified twice to resolve cross-references between libc.a and libgcc.a.
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* About $(TOOL_DIR)
 The [Libraries] column lists "$(TOOL_DIR)/lib/24bit(16bit)/libxxx.a" that is set by default.

 $(environment variable) is a macro defined in the makefile that is generated when you build a project. 
TOOL_DIR is the environment variable in which the path to the gnu17 tool directory is defined. The de-

fined contents can be verified in the [Environments] tab page.
 Example: If the gnu17 tools have been installed in the c:\EPSON\gnu17 directory
  TOOL_DIR = c:/EPSON/gnu17

 Since the macro is replaced with the contents of the environment variable described in () during execution 
of make.exe, -I$(TOOL_DIR)/lib/24bit/libxxx.a will be resolved to -Ic:/EPSON/gnu17/
lib/24bit/libxxx.a.

 The [Environments] tab page allows the user to define environment variables similar to TOOL_DIR. The 
environment variables defined here may be used for specifying include file and library file paths in the build 
options. Refer to Section 5.10.1 for details of the [Environments] page.
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5.7.6  Setting the Vector Checker

Set the options for the vector checker. When you use the coprocessor library, select or unselect the checker that 
verifies whether the emu_copro_process interrupt function is allocated to the vector table. 

(1) Select the project to be built in the [C/C++ Projects] or [Navigator] view.

(2) Select the [Properties] command from the [Project] menu or from the context menu of the above view. This dis-
plays the [Properties] dialog box.

(3) Select [GNU17 Build Options] in the property list.

(4) Select [Vector Checker for Copro] from the tree list of [Build Options].
 [Command:] indicates the program name of the vector checker, while [All Options] indicates the options cur-

rently set.

(5) Select the category from the tree list of [Vector Checker for Copro] and set the required options.

(6) Click the [Apply] button to change other properties or the [OK] button to end property settings.
 After you change the settings, a dialog box appears inquiring whether to execute the "clean" build (refer to Sec-

tion 5.7.8). You can remove (and rebuild) the file generated under the old settings.
 If you haven't clicked [Apply], you can use the [Revert Settings] button to discard the changes made and restore 

the status in which this page was opened.

Shown below is the page for setting vector checker options.

[general]

 

 [Check if 'emu_copro_process()' is allocated to vector No. 3]
 (default: ON if the coprocessor library is used)
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 Select or unselect the checker that verifies whether the emu_copro_process interrupt function is allocated to the 
vector table. 

 If you select ON, the vector checker starts during the build and checks whether the emu_copro_process() inter-
rupt function is allocated to Vector No. 3.

 (The Vector No. 3 data is searched as the start address for the .vector section in the elf executable file. If the elf 
file lacks a .vector section, this check is not performed.)

 The -t and -s options of the vector checker are always specified.
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5.7.7  generated Makefile

Building a project generates a makefile named "<project name>_gnu17IDE.mak" according to the CPU type 
and the tool options set above, which is then executed by make.exe.

An example of a generated makefile is shown below.
Example:

# Make file generated by Gnu17 Plug-in for Eclipse
# This file should be placed directly under the project folder

# macro definitions for target file        (1)
TARGET= sample
GOAL= $(TARGET).psa

# macro definitions for tools         (2)
TOOL_DIR= C:/EPSON/GNU17
CC= $(TOOL_DIR)/xgcc
AS= $(TOOL_DIR)/xgcc
AS_CC= $(TOOL_DIR)/as
LD= $(TOOL_DIR)/ld
RM= $(TOOL_DIR)/rm
SED= $(TOOL_DIR)/sed
CP= $(TOOL_DIR)/cp
CC_KFILT= $(TOOL_DIR)/xgcc_filt
OBJDUMP= $(TOOL_DIR)/objdump
OBJCOPY= $(TOOL_DIR)/objcopy
MOTO2FF= $(TOOL_DIR)/moto2ff
SCONV= $(TOOL_DIR)/sconv32
VECCHECKER= $(TOOL_DIR)/vecChecker

# macro definitions for tool flags        (3)
CFLAGS= -B$(TOOL_DIR)/ -gstabs -S  -O1 -I$(TOOL_DIR)/include -fno-builtin -Wall 
-Werror-implicit-function-declaration
ASFLAGS= -B$(TOOL_DIR)/ -c -xassembler-with-cpp -Wa,--gstabs
ASFLAGS_CC=
LDFLAGS=  -Map sample.map -N -T sample_gnu17IDE.lds
EXTFLAGS= -Wa,-mc17_ext -Wa,$(TARGET).dump -Wa,$(TARGET).map
EXTFLAGS_CC= -mc17_ext $(TARGET).dump $(TARGET).map
OBJDUMPFLAGS= -t
OBJCOPYFLAGS= -I elf32-little -O srec --srec-forceS3
MOTOSTART= 8000
MOTOSIZE= 10000
SCONVFLAGS= S2
VECCHECKERFLAGS= -t symtable.out -r raw.out
VECCHECKER_ON= false

# macro for switching 2pass or 1pass build       (4)
PASS= 2pass

# macro definitions for tool flags
 PROTECT_ON= true

# search paths for source files
vpath %.c
vpath %.s

# macro definitions for object files        (5)
OBJS= boot.o \
      lib.o \
      main.o \
      sys.o \
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# macro definitions for library files
OBJLDS= $(TOOL_DIR)/lib/24bit/libstdio.a \
        $(TOOL_DIR)/lib/24bit/libc.a \
        $(TOOL_DIR)/lib/24bit/libgcc.a \
        $(TOOL_DIR)/lib/24bit/libc.a \

# macro definitions for assembly files generated from c source files  (6)
CEXTTEMPS= lib.ext0 \
      main.ext0 \
      sys.ext0 \

# macro definitions for dependency files       (7)
DEPS= $(OBJS:%.o=%.d)
SED_PTN= 's/[[:space:]]\([a-zA-Z]\)\:/ \/cygdrive\/\1/g'
SED_PTN2= 's/^\($(subst .,\.,$(@F))\)\:/$(subst /,\/,$(@))\:/g'

# macro definitions for creating dependency files      (8)
DEPCMD_CC= @$(CC) -M -MG $(CFLAGS) $< | $(SED) -e $(SED_PTN) | $(SED) -e $(SED_PTN2) 
>$(@:%.o=%.d)
DEPCMD_AS= @$(AS) -M -MG $(ASFLAGS) $< | $(SED) -e $(SED_PTN) | $(SED) -e $(SED_
PTN2) >$(@:%.o=%.d)

# targets and dependencies          (9)
.PHONY : all clean

all : $(GOAL)            (10)

$(TARGET).psa : $(TARGET).elf
# clean psa files
 $(RM) -f $(TARGET).sa $(TARGET).saf $(TARGET).psa
# create psa file from elf
 $(OBJCOPY) $(OBJCOPYFLAGS) $< $(TARGET).sa
 $(MOTO2FF) $(MOTOSTART) $(MOTOSIZE) $(TARGET).sa
 $(SCONV) $(SCONVFLAGS) $(TARGET).saf $(TARGET).psa

# create protected psa file         (11)
ifeq ($(PROTECT_ON), true)
 $(TOOL_DIR)/gdb.exe --nw --command=protect.cmd
 $(SCONV) $(SCONVFLAGS) temp $(TARGET)_ptd.psa
 $(RM) -f temp
endif

 @cmd /c "echo ---------------- Finished building target : $@ ----------------"

$(TARGET).elf : $(OBJS) sample_gnu17IDE.mak sample_gnu17IDE.lds
ifeq ($(PASS), 1pass)
# 1pass linking
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS)
else
# 1pass linking
 -$(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS) 2>lderr
 @if [ -s lderr ]; then \
  cmd /c "type lderr" \
  && $(RM) -f $(TARGET).elf \
  && exit 1; \
 else $(RM) -f lderr ; \
 fi
 $(OBJDUMP) $(OBJDUMPFLAGS) $@ > $(TARGET).dump
 $(RM) -f $(TARGET).elf
# save 1pass object files
 @if [ -e obj1pass ]; then \
  cmd /c "rd /s /q obj1pass" ; \
 fi
 cmd /c "md obj1pass"
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 for NAME in $(subst /,\\,$(OBJS)) ; do \
  cmd /c "copy /y $$NAME obj1pass\\$$NAME" >nul ; done \
 && $(RM) -f $(OBJS)
# 2pass for assembly files
 $(AS) $(ASFLAGS) $(EXTFLAGS) -o boot.o boot.s
# 2pass for c files
 for NAME in $(basename $(CEXTTEMPS))  ; do \
  $(AS_CC) $(ASFLAGS_CC) $(EXTFLAGS_CC) -o $$NAME.o $$NAME.ext0 ; done
 $(RM) -f $(TARGET).map
# 2pass linking
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS)
# restore 1pass object files
 $(RM) -f $(OBJS) \
 && \
 for NAME in $(subst /,\\,$(OBJS)) ; do \
  cmd /c "copy /y obj1pass\\$$NAME $$NAME" >nul ; done \
 && cmd /c "rd /s /q obj1pass"
endif

# check copro function in vector         (12)
ifeq ($(VECCHECKER_ON), true)
 $(RM) -f symtable.out raw.out
 $(OBJDUMP) -t $@ > symtable.out
 $(OBJDUMP) -s $@ > raw.out
 $(VECCHECKER) -t symtable.out -r raw.out
endif

 @cmd /c "echo ---------------- Finished building target : $@ ----------------"

## boot.s            (13)
boot.o : boot.s
 $(AS) $(ASFLAGS) -o $@ $<
 $(DEPCMD_AS)

## lib.c
lib.o : lib.c lib.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

## main.c
main.o : main.c main.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

## sys.c
sys.o : sys.c sys.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

# dependecies for assembled c source files
lib.ext0 : lib.c
main.ext0 : main.c
sys.ext0 : sys.c

# include dependency files
-include $(DEPS)

# clean files            (14)
clean :
 $(RM) -f $(OBJS) $(TARGET).elf $(TARGET).map $(DEPS) $(CEXTTEMPS) $(TARGET).dump 
lderr $(TARGET).sa $(TARGET).saf $(TARGET).psa $(TARGET)_ptd.psa
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 @if [ -e obj1pass ]; then \
  cmd /c "rd /s /q obj1pass" ; \
 fi
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Each field indicated by a number is described below.

(1) Defines the project name as TARGET. This name is used in the elf object file and map file.
 The end product (.psa or .elf) is defined in GOAL.

(2) Defines the tool directory and the compiler, assembler, and linker commands. The directory in which the tools are 
stored is set in TOOL_DIR. The space characters in the path are converted to "\ " (\ + space). The link process 
cannot proceed if the path includes spaces. Confirm that one set of S5U1C17001C tools is installed in a directory 
that does not include spaces.

(3) Defines the compiler, assembler, and linker options. These options reflect the selected contents of project 
properties ([GNU17 Build Options]).

(4) The object file names corresponding to the source files in the project are written here following "OBJS=".
 The contents written in this field change when source files are added or deleted.

(5) The library file names set in [GNU17 Build Options] > [Build Options] > [Linker] > [Libraries] are written 
here following  "OBJLDS=" in the same way as for "OBJS=".

(6) The assembler source files are written here for a two-pass make that optimizes extended instructions.
 Note that the assembler source files created from C source files have a file extension ".ext0".

(7) Defines the macros needed to create dependency files. Dependency files are generated for each source. The 
sources and include files needed to generate object files are defined here.

 Example:
  Dependency file (main.d)
    main.o: main.c

  Dependency file (boot.d)
     boot.o: boot.s

 These files are used to create the tool commands written to a dependency list.

(8) Defines the execution commands to be stored in a dependency list.

(9) Defines the target.

(10) This is the dependency list for the target to be built and executable format object files.
 The two-pass make process generates the executable format object file after optimizing the extended instruc-

tions.
 GOAL determines whether an executable object file (elf) or an S-record format ROM data file (psa) is gener-

ated.

(11) The protected (.psa) file is created if flash protect is enabled.

(12) Defines the execution command of the vector checker.

(13) This is the dependency list for object files generated from each source.
 Adding or deleting source files will change the information in this field.

(14) The commands written here delete the generated files executed in the target "clean".

For detailed information on makefiles, refer to Section 11.1, "make.exe".
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5.7.8  Editing a linker Script

A linker script file is used to pass location information on object files comprising the executable file (.elf) to the 
linker. The IDE generates a linker script file "<project name>_gnu17IDE.lds" according to the settings dis-
cussed in this section.
The procedure for setting a linker script is described below. For detailed information on sections and linker scripts, 
refer to Section 3.8, "Sections and Linkage", and Chapter 9, "Linker".

linker script setup page
 Use the [GNU17 Linker Script Settings] page of project properties to set a linker script.
 Do the following to display the setup page:

(1) Select a project to build in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu or from the context menu in the above view. This displays the 
[Properties] dialog box.

(3) Select [GNU17 Linker Script Settings] from the properties list.

 

 The list shows the configuration and location of sections in an executable file (.elf). This memory map is shown 
in Figure 5.7.6.1.
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Figure 5.7.6.1  Selection location in default settings

 As shown in the [Section name] column, the following five basic sections are set in advance:
.bss: A section in which variables without initial values are placed. (This is normally lo-

cated in RAM.)
.data: A section in which variables with initial values are placed. (The initial values are 

located in ROM. When needed, they are copied into RAM.)
.vector: A section in which vector tables are placed. (The actual data is located in ROM.)
.text: A section in which program code is placed. (The actual data is located in ROM and 

executed from there or from high-speed RAM after copying.)
.rodata: Constants. (The actual data is located in ROM.)

 The section information is displayed in blue except for the .vector section displayed in black. Blue is used to 
display the standard sections defined by default and black is used to display other user defined sections. To edit 
the section name, standard section attribute, address to locate, and objects to be located, a user section should 
be created. The standard section allows the user to specify the location address only, and objects are automati-
cally located except those are located in the user sections with the same attribute.

 The "VMA" (Virtual Memory Address) is the position (start address) at which a section is placed when ex-
ecuted. A section whose address is not written in the VMA will be located at an address following the section 
immediately preceding.

 The "LMA" (Load Memory Address) is the position in a ROM (start address) at which the actual data is locat-
ed. "-" means the same as the VMA (i.e., a section will be executed or accessed from the position at which its 
actual data is placed). "after(.rodata)" means that a section will have its actual data located at an address 
following another section (in this case, the .rodata section).

 "Labels" are the labels indicating the start and the end addresses of the area in which a section will be located. 
When a VMA is specified, two labels are displayed, whereas when a LMA is specified, four labels for the start/
end VMA addresses and the start/end LMA addresses are displayed, in that order. These labels can be used to 
specify the address in a source file when (for example) a section is copied from ROM to RAM. The names of 
these labels are automatically generated from section names.

 Example:
  __START_bss:__END_bss
   Labels indicating the start and end addresses of a .bss section

  __START_data:__END_data:__START_data_lma:__END_data_lma
   Labels indicating the start VMA address, end VMA address, start LMA address, and end LMA ad-

dress of a .data section
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About the .vector section
 The .vector section is an exclusive section provided by the IDE to ensure that vector tables will always be 

located beginning with the trap table vector address. 

 With the initial IDE settings, the .text section is located immediately after the .vector section.

 By specifying a file that includes a vector table as the object to be located in this section, it is possible to en-
sure, without concern for the order in which this and other objects are located, that the vector table will always 
be located from the above address.

 The object to be located in this section can be selected in the wizard for creating a new project. For more infor-
mation on this wizard, refer to Section 5.4.2, "Creating a New Project".

 Select the object you want to locate in the .vector section from the combo box list (vector.o and boot.
o selectable) or by entering it in the combo box text field.

 Use the [Set boot vector address] text box to specify the address to locate the .vector section. The setting 
address depends on the model of the [Target CPU Device] (e.g., 008000, 020000, etc.). The value set here will 
be used as the parameter for the TTBR setting command that will be written in the debugger startup command 
file created by the IDE as well as it will be used as the VMA of the .vector section that will be written in the 
linker script file.

 If the CPU was changed via the [Properties] > [GNU17 General] page when located in the .vector section, the 
vector address for the CPU will be placed in the .vector section address.

 If you do not locate objects in the .vector section, deselect the [Allocate a specific file to '.vector' section] 
check box. Even so, the .vector section is defined as a section, but without an object.

 The contents set in the wizard can be changed in the [Edit Section] dialog box (refer to "Editing section infor-
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mation").

 The .vector section is defined with the .rodata attribute. Make sure the vector table is written in the 
source files, as shown below.

 For C sources (vector.c)
 Declare a vector table with const to specify that it be located in the .rodata section.
 Example:
  const unsigned long vector[] = {
      (unsigned long)boot,            // 0x0    0

      (unsigned long)addr_err,        // 0x4    1

      (unsigned long)nmi,             // 0x8    2

      :

      (unsigned long)dummy,           // 0x48   18

      (unsigned long)dummy            // 0x4c   19

  };

For assembler sources (boot.s)
 Declare a .rodata section and write a vector table following it.

Example:
 .section .rodata, "a"
 .long   BOOT    ; 0x0    0

  .long   ADDR_ERR   ; 0x4    1

  .long   NMI    ; 0x8    2

    :

  .long DUMMY    ; 0x48   18

  .long DUMMY    ; 0x4c   19

 If you are using an assembler source in which a vector table is written in the .text section and you want 
the table to be located in the .vector section, select the desired method from the following options:

 Method 1: Editing the source file
(1) Insert a .rodata directive similar to the one shown above before the vector table in the source 

file. If a program is written after the vector table, insert a .text directive in front of it and declare 
a .text section.

(2) In the new project wizard, select the [Allocate a specific file to '.vector' section] check box, then 
boot.o in the combo box. (If the source is other than boot.s, enter the file name of the source.)

 Method 2: Editing section information in the IDE (using the source file as is)
(1) In the new project wizard, select the [Allocate a specific file to '.vector' section] check box, then 

boot.o in the combo box. (If the source is other than boot.s, enter the file name of the source.)

(2) In the [Edit Section] dialog box, change the attribute of the .vector section to .text. (Refer to 
the discussion in the next and the following pages.)

 If you are not using the .vector section, deselect the [Allocate a specific file to '.vector' section] check 
box and edit the .text section in the [Edit Section] dialog box to locate boot.o at the top.
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Editing section information
 The location information on each section described above and the objects or libraries to be located in the re-

spective sections can be changed as suitable for the system. The procedure is described below.

(1) Click the section you want to edit in the section list for the [GNU17 Linker Script Settings] page.

(2) Click the [Edit] button.
 This displays the [Edit Section] dialog box.

(3) Make the necessary changes according to the explanation given below. Click [OK].

(4) Click the [Apply] button if you want to change other sections or properties or the [OK] button to end prop-
erty settings. If you haven't clicked [Apply], you can use the [Revert Settings] button to discard the changes 
made and to return to the state in which this page was opened.

 [Edit Section] dialog box
 Standard section     User section

  

 Use the upper part of the dialog box to set the location information on a section in an executable file.

[Section name]
 Set a user section name (output section).

Note: Keep in mind the following conditions when entering a section name:
•	 A	section	name	must	begin	with	".".
•	 Only	 single-byte	 alphanumeric	 characters	 and	 symbols,	 the	 "_"	 character,	 and	 "."	 are	

valid for section names.

[Virtual map address]
 Set a location (start address) in which the section should be located when executed. To locate the sec-

tion following another section, select the section immediately preceding name from the pull-down list. 
To locate the section at the beginning of a device or apart from the preceding section, enter the address 
of that location (in hexadecimal notation).

Note: When entering an address, use only 0–9 and A–F. Make sure that the address entered is 
six characters or less. Otherwise, your entry will be interpreted as a section name, not an 
address.

[LMA ≠ VMA]
 Select this check box when the execution address (VMA) and stored address (LMA) of the section are 

different as for variables with initial values (e.g., .data section) and programs executed in RAM. 
Leave unselected if the section is to be executed directly in its stored location, as in ROM.
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[Load map address]
 If you selected [LMA ≠ VMA], set the address at which you want to store the section. If you want to lo-

cate the section following another section, select the section immediately preceding from the pull-down 
list. To locate the section at the beginning of a device or apart from the preceding section, enter the ad-
dress of that location (in hexadecimal notation).

Note: When entering an address, use only 0–9 and A–F. Make sure that the address entered is 
six characters or less. Otherwise, your entry will be interpreted as a section name, not an 
address.

 Use the lower part of the dialog box to set the location information on objects in the section.
 The contents shown below may be changed only in user sections. The standard sections are predefined so 

that all object files for the project and the libraries already set in build options will be located. When a user 
section is defined, the settings of the standard section with the same attribute will be automatically updated 
to avoid overlaps.

[File Attributes]
 Select an attribute from the pull-down list. Selectable attributes are the same as those of the standard 

sections.
 The standard sections do not allow changing of the attribute.

[Unallocated files] (left)
 Lists the object files of the project and the libraries already set in build options not located in this user 

section. Even before a build process, a list of object files is created from the source file names in the 
project. Select objects to be located in this section from the list.

 In a standard section, this list may be blank or the objects that have been located in user sections with 
the same attribute are listed in unselectable status.

[Allocated files] (right)
 Lists the object files and libraries located in this section. 

 In a standard section, all object files of the project and the libraries already set in build options locatable in 
this section (except those are located in user sections with the same attribute) are listed here. When linked, 
sections with the same attribute as that of an output section are extracted from within these files and listed in 
the output section in given order, beginning with the top of the list. The object files are listed in alphabetical 
order, after which the libraries are listed in the order in which the build options are set.

 The list in standard sections is automatically updated according to the user section settings. It cannot be ed-
ited manually in contrast to user sections.

 In user sections, the file configuration can be changed with the [<], [>], [Up], and [Down] buttons.

[>]
 Selects a file to be located in this section from [Unallocated files]. This button is ineffective for stan-

dard sections.

[<]
 Moves a file not to be located in this section from [Allocated files] to [Unallocated files]. This button is 

ineffective for standard sections.

[Up]
 Changes the location of objects within the section. When you select an object in [Allocated files] and click 

this button, it swaps positions with the object immediately above it. This button is ineffective for standard 
sections.

[Down]
 Changes the location of objects within the section. When you select an object in [Allocated files] and 

click this button, it swaps positions with the object immediately below it. This button is ineffective for 
standard sections.

[Select All]
 Selects all entries in the respective lists. This button is ineffective for standard sections.
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 Example of editing the section information (.vector section)
 As an example of editing the section information, the .vector section information created with the de-

fault settings of the new project wizard is changed.
 Section attribute: .rodata → .text
 Object: vector.o → boot.o

(1) In the [GNU17 Linker Script Settings] page for project properties, select the .vector section and 
click the [Edit] button.

 This displays the [Edit Section] dialog box.

(2) Select .text from the [File Attributes] pull-down list.

(3) Select vector.o from [Allocated files] and click the [<] button.

 Since no source files are available for vector.o, it is removed without being moved to [Unallocated 
files]. This operation alone also removes vector.o from other section information.
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(4) Select boot.o from [Unallocated files] and click the [>] button.

 The selected boot.o is moved to [Allocated files].

(5) Click the [OK] button to end editing work.

 Since the .text section of boot.o has been located in the .vector section, boot.o in the .text 
section information is moved to [Unallocated files]. (You cannot locate one file in multiple sections 
with the same attribute.)

(6) Simply closing the [Edit Section] dialog box with the [OK] button will not automatically reflect the 
edits made here in the linker script. You must click the [Apply] or the [OK] button in the [Properties] 
dialog box to confirm your edits.
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Automatic updating of object files (for standard sections)
 The standard section enables an automatic updating feature for the object files to be located in the sections. 

Since the linker script will automatically update itself whenever source files are added/removed, there is no 
need to manually reconfigure these sections.

 The following describes the handling of object files in automatic updating.

 If no other sections have the same attribute
 The object files for the project and the libraries already set in build options are all selected and located in 

that section.

 If there are multiple sections with the same attribute
 The object files and libraries not located in other user sections with the same attribute are selected and lo-

cated in that standard section. Files already located in user sections with the same attribute are not handled 
in automatic updating.

 In user sections, the files included in other sections with the same attribute can also be added by selecting 
from [Unallocated files]. When a file is relocated from one section to another, it is removed from the section in 
which it was located up to that point.

 The following limitations apply to standard sections in which automatic updating is enabled:
1. The section attribute ([File Attributes]) cannot be changed.
2. The file list can only be referenced; it cannot be manipulated.
3. Object files are added in ascending alphabetical order. 

 If these changes need to be made, create a user section.

Adding a section
 Follow the procedure described below to add a new section.

(1) Click the [Add] button. This displays the [Add Section] dialog box.

(2) Make the necessary settings based on the 
above discussion. Click [OK].

(3) Click the [Apply] button to change other 
sections or properties or the [OK] button to 
end property settings.

If you haven't clicked [Apply], you can use the 
[Revert Settings] button to discard the changes 
made and restore the status in which this page 
was opened.

The section is inserted into the list according to 
the VMA you set.
To ensure that the new section location or 
objects will not overlap with another section, 
review the other section information, making 
alterations, if necessary.
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Removing a section
 Do the following to remove unnecessary sections:
 However, only user defined sections may be removed and standard sections cannot be removed.

(1) In the [GNU17 Linker Script Settings] page, click to select the section you want to remove from the section 
list.

(2) Click the [Delete] button.

(3) A dialog box for confirmation will be displayed. Click [OK] to delete or [Cancel] to cancel.

(4) Click the [Apply] button if you want to change other sections or properties or the [OK] button to end prop-
erty settings.

 If you haven't clicked [Apply], you can use the [Revert Settings] button to discard the changes made and 
restore the status in which this page was opened.

* About changes in referenced sections pursuant to deletion
 Section1 ([Virtual map address] = 000000)
 Section2 ([Virtual map address] = Section1)
 Section3 ([Virtual map address] = Section2)
 Section4 ([Virtual map address] = Section3)

 Removing Section2 in a section configuration like the one shown will automatically change Section3 so 
that Section1 is referenced instead.

 Section1 ([Virtual map address] = 000000)
 Section3 ([Virtual map address] = Section1)
 Section4 ([Virtual map address] = Section3)

 If Section1 is removed, the location address of Section2 changes to (0x)000000. If this results in problems, 
reedit the section information.

 Section2 ([Virtual map address] = 000000)
 Section3 ([Virtual map address] = Section2)
 Section4 ([Virtual map address] = Section3)

Stack pointer
 The [Set stack pointer address] text box on the [GNU17 Linker Script Settings] page will form the __START_

stack symbol value in the linker script file created automatically by the IDE, and the symbol can be used as the 
start address in the stack area.

 The default value will be set by the New Project wizard.
 For more information on the default setting, refer to the corresponding technical manual for the device.

Example:  The __START_stack symbol will be output to the linker script file as shown below at the time of 
building.

/* stack pointer symbols */

 __START_stack = 0x000FC0;

Example:  It can be written as shown below within the boot routine.

boot:

 xld.a   %sp, __START_stack

Precautions
• No more than 255 characters may be entered for each of [Section name], [Virtual map address], and [Load 

map address] in the [Edit Section] dialog box.

• A section name must begin with ".". Only single-byte alphanumeric characters, "_", and "." are valid for sec-
tion names.
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• When entering an address in [Virtual map address] or [Load map address], use only 0–9 and A–F. Make sure 
that the address entered is six characters or less. Otherwise, your entry will be interpreted as a section name, 
not an address.

• Although the IDE checks backward and cyclic references from one section to another, this check is not nec-
essarily complete, and an error may result at linking.

• The object file (vector.o) to be mapped to the .vector section, which was specified in the [New 
GNU17 Project] wizard, must be located in the project directory. The .vector section settings in the linker 
script must be edited when the object file is located in another directory.
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Example linker script settings
 Shown below are example linker script settings for several section configurations using sample screens. For 

more information on making these settings, refer to the discussion on the preceding pages.
 Example 1: Minimum section configuration
 Example 2: Changing the basic layout
 Example 3: Sharing the RAM area with multiple variables
 Example 4: Executing a program in RAM

 It is assumed that the vector table in the assembler source (boot.o) is written in the .rodata section and 
that the table is set in the new project wizard to be located in the .vector section.

Example 1: Minimum section configuration
 Described here is a system with the simplest possible configuration using RAM and ROM.
 The program and data will be located in the ROM beginning with address 0x8000 as shown in Figure 5.7.6.2. 

The program is assumed to run directly from its stored ROM address (LMA), and static data is also assumed 
to be read out for use directly from the ROM. The variable without initial values will be located from address 
0x0 in the RAM. Subsequent areas are used for variables with initial values. The initial values of variables are 
stored in the ROM and copied from the ROM into the RAM by the application program.

Program

Vector table

Constants 
and other static data

Variables 
with initial values

Unused area

Stack area

0x008000

ROM

.data section (LMA)

.rodata section (LMA=VMA)

.text section (LMA=VMA)

.vector section (LMA=VMA)

Variables without initial 
values and work area

Variables 
with initial values

0x000fbf

0x000000

RAM

.data section (VMA)

.bss section (VMA)

Data
copied

Figure 5.7.6.2  Example of a memory configuration 1

 Using default linker script files is the simplest method for using memory in this way.
 This section location can be realized without adding to or correcting settings in the [GNU17 Linker Script Set-

tings] dialog box.

 Example of a source file configuration
 boot.s (vector table and stack initialization, etc.)
 main.c (main and other functions)

 The program is assumed to be comprised of these two sources.
 Except when the location addresses of the respective sections are specified individually, the sections when 

linked are located in alphabetical order of file names. In the example here, the sections are located in order of 
boot.s and main.c. The vector table at the beginning of boot.s (i.e., the .rodata section) is placed at 

the beginning of the ROM (0x8000 and beyond).
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 Section configuration (contents set in the [GNU17 Linker Script Settings] dialog box)

 These are the contents set by default.
 The VMAs (execution addresses) are set so that the .bss section is located from address 0x0 (RAM) and the 

.vector section (.rodata section of boot.o) is located from address 0x8000 (start of ROM). Other sec-

tions are located at addresses following these two sections. Since sections other than .data are used from their 
stored addresses, no LMAs (load addresses) are set. Since .data is copied from ROM to RAM before use, a 
LMA is set following the .rodata section. The memory map configuration in Figure 5.7.6.2 can be realized 
directly, without modifying this section configuration.

 Linker script and section location
 The linker script is generated as shown below.

/* Linker Script file generated by Gnu17 Plug-in for Eclipse */
OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
  __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ;
    boot.o(.bss)
    main.o(.bss)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
   }
   __END_bss = . ;
 .data __END_bss : AT( __END_rodata )
   {
    __START_data = . ;
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    boot.o(.data)
    main.o(.data)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
   }
   __END_data = . ;

 .vector 0x008000 : 
   {
    __START_vector = . ;
    boot.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector : 
   {
    __START_text = . ;
    boot.o(.text)
    main.o(.text)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
   }
   __END_text = . ;

 .rodata __END_text : 
   {
    __START_rodata = . ;
    boot.o(.rodata)
    main.o(.rodata)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
   }
   __END_rodata = . ;

 /* load address symbols */
 __START_data_lma = LOADADDR( .data );
 __END_data_lma = __START_data_lma + SIZEOF( .data );
}

 The section location including a file configuration is shown below.

boot.o – .text

main.o – .text

library – .text

library – .rodata

library – .bss

boot.o – .rodata

main.o – .rodata

boot.o – .data

main.o – .data

(__START_data_lma)

(__START_rodata)

(__START_text)

0x008000

0x000000

LMA

.data
section

.rodata
section

.text
section

.vector
section
No sections/files 
located here

boot.o – .bss

main.o – .bss

boot.o – .data

main.o – .data

(__START_data)

0x000000

VMA

.data
section

.bss
section

Figure 5.7.6.3  Example of a section location 1
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Example 2: Changing the basic layout
 Here, a ROM for storing constants is added to the system in Example 1. Shown below is an example of how to 

locate the .rodata section.

Program

Variables 
with initial values

Unused area

Vector table

Stack area

ROM 1

.data section (LMA)

.text section (LMA=VMA)

.vector section (LMA=VMA)

Variables without initial 
values and work area

Variables 
with initial values

RAM

.data section (VMA)

.bss section (VMA)

Data
copied

Constants 
and other static data

Unused area
ROM 2

.rodata section (LMA=VMA)

0x008000

0x000fbf

0x000000

0x080000

Figure 5.7.6.4  Example of a memory configuration 2

 Example of a source file configuration
 boot.s (vector table and stack initialization, etc.)
 main.c (main and other functions)

 Editing of sections (contents set in the [Edit Section] dialog box)
 Correct the .rodata and .data section information as shown below. Use all other sections with default set-

tings directly and unaltered.

1. Correcting the .rodata section
 Correct [Virtual map address] to 0x080000.
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2. Correcting the .data section
 Correct [Load map address] to ".text".

 

 Section configuration (contents set in the [GNU17 Linker Script Settings] dialog box)
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 Linker script and section location
 The linker script is generated as shown below.

/* Linker Script file generated by Gnu17 Plug-in for Eclipse */
OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
  __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ;
    boot.o(.bss)
    main.o(.bss)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
   }
   __END_bss = . ;

 .data __END_bss : AT( __END_text )
   {
    __START_data = . ;
    boot.o(.data)
    main.o(.data)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
   }
   __END_data = . ;

 .vector 0x008000 : 
   {
    __START_vector = . ;
    boot.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector : 
   {
    __START_text = . ;
    boot.o(.text)
    main.o(.text)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
   }
   __END_text = . ;

 .rodata 0x080000 : 
   {
    __START_rodata = . ;
    main.o(.rodata)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
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   }
   __END_rodata = . ;

 /* load address symbols */
 __START_data_lma = LOADADDR( .data );
 __END_data_lma = __START_data_lma + SIZEOF( .data );
}

 Shown below are section locations and file configurations.

boot.o – .text

main.o – .text

library – .text

library – .bss

boot.o – .data

main.o – .data

(__START_data_lma)

(__START_text)

0x008000

0x000000

.data
section

.text
section

.vector
section
No sections/files 
located here

library – .rodata

boot.o – .rodata

main.o – .rodata
0x080000

LMA

.rodata
section

No sections/files 
located here

boot.o – .bss

main.o – .bss

boot.o – .data

main.o – .data

(__START_data)

0x000000

VMA

.data
section

.bss
section

Figure 5.7.6.5  Example of section location 2

Example 3. Sharing the RAM area with multiple variables
 Shown below is an example of how to assign the same RAM area to multiple variables in a system with the 

memory configuration shown in Example 1.
 Multiple sections are allocated to the same address as in Figure 5.7.6.6, where the same data is shared by mul-

tiple variables and the data for one section is exchanged for another when used. This permits efficient use of 
memory. However, only sections having the .bss attribute can share data areas. The area set aside for variables 
with initial values (.data section) cannot be shared.

Program

Constants 
and other static data

Variables 
with initial values

Unused area

Vector table

Stack area

0x008000

ROM

.data section (LMA)

.rodata section (LMA=VMA)

.text section (LMA=VMA)

.vector section (LMA=VMA)

Fixed area for variables 
without initial values

Shared area for variables 
without initial values

Variables 
with initial values

0x000fbf

0x000000

RAM

.bss1 and.bss2 sections (VMA)
located in the same area

.data section (VMA)

.bss section (VMA)

Figure 5.7.6.6  Example for shared data area

 Example of a source file configuration
 boot.s (vector table and stack initialization, etc.)
 main.c (main and other functions)
 bss1.c (global variable definition file 1)
 bss2.c (global variable definition file 2)

 bss1.c and bss2.c are assumed to consist only of a definition of global variables without initial values that 
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share an area. If these files contain functions, variables with initial values, or constants, the files in the example 
here will be located in the .text, .data, or .rodata sections.

 Editing sections (content set in the [Add/Edit Section] dialog box)
 Create new sections .bssS1 and .bssS2 that share an area of RAM. Both sections assume the .bss at-

tribute and are located immediately after the .data section (VMA). As files for the respective sections, select 
only bss1.o for the .bssS1 section and only bss2.o for the .bssS2 section.

 

 Note that automatic updating is enabled for .bss section information and that bss1.o and bss2.o are not 
included in the list of files to be located. This is because they have been specified for the respective sections 
above.
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 Section configuration (content set in the [GNU17 Linker Script Settings] dialog box)

 Linker script and section location
 The linker script is generated as shown below.

/* Linker Script file generated by Gnu17 Plug-in for Eclipse */
OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
  __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ;
    boot.o(.bss)
    main.o(.bss)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
   }
   __END_bss = . ;

 .data __END_bss : AT( __END_rodata )
   {
    __START_data = . ;
    boot.o(.data)
    bss1.o(.data)
    bss2.o(.data)
    main.o(.data)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
   }
   __END_data = . ;
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 .bssS1 __END_data : 
   {
    __START_bssS1 = . ;
    bss1.o(.bss)
   }
   __END_bssS1 = . ;

 .bssS2 __END_data : 
   {
    __START_bssS2 = . ;
    bss2.o(.bss)
   }
   __END_bssS2 = . ;

 .vector 0x008000 : 
   {
    __START_vector = . ;
    boot.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector : 
   {
    __START_text = . ;
    boot.o(.text)
    bss1.o(.text)
    bss2.o(.text)
    main.o(.text)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
   }
   __END_text = . ;

 .rodata __END_text : 
   {
    __START_rodata = . ;
    bss1.o(.rodata)
    bss2.o(.rodata)
    main.o(.rodata)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
   }
   __END_rodata = . ;

 /* load address symbols */
 __START_data_lma = LOADADDR( .data );
 __END_data_lma = __START_data_lma + SIZEOF( .data );
}
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 Shown below are section locations and file configurations.

VMA
.bssS1 section .bssS2 section

bss1.o – .bss bss2.o – .bss

library – .bss
boot.o – .text

main.o – .text

library – .text

library – .rodata

boot.o – .rodata

main.o – .rodata

boot.o – .data

main.o – .data

(__START_data_lma)

(__START_rodata)

(__START_text)

0x008000

0x000000

LMA

.data
section

.rodata
section

.text
section

.vector
section
No sections/files 
located here

boot.o – .bss

main.o – .bss

boot.o – .data

main.o – .data

(__START_data)

0x000000

(__START_bssS1)

.data
section

.bss
section

Figure 5.7.6.7  Example of a section location 3

 The .bssS1 and .bssS2 sections are located in parallel. The application determines which section is man-
aged and what data is used.

Example 4: Executing a program in RAM
 A routine that requires high-speed processing can be executed in RAM that can be accessed without wait states 

to meet specific requirements. In the examples seen so far, only the VMA of the .text section is specified, 
and the program is executed in ROM. However, the program can be executed in RAM by first specifying the 
VMA and LMA, as for the .data section, then copying the program to RAM before execution. Additionally, 
multiple sections may be allocated to the same area, as in Example 3, and the program may be executed by ex-
changing sections as necessary.

Program storage/
execution area

Constants 
and other static data

Program storage area

Unused area

Vector table

Stack area

0x008000

ROM

.textu2 section (LMA)

.textu1 section (LMA)

.data section (LMA)

.rodata section (LMA=VMA)

.text section (LMA=VMA)

.vector section (LMA=VMA)

Variables 
without initial values

Program cache

Variables 
with initial values

0x000fbf

0x000000

RAM

.textu1 and .textu2 sections (VMA)
located in the same area

.data section (VMA)

.bss section (VMA)

Program storage area

Variables 
with initial values

Program
copied

Figure 5.7.6.8  Allocating a storage area for the program in RAM

 Example of a source file configuration
 boot.s (vector table and stack initialization, etc.)
 main.c (main and other functions)
 func1.c (program 1 to be executed in RAM)
 func2.c (program 2 to be executed in RAM)
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 Editing sections (content set in the [Add Section] dialog box)
 Create new sections .textu1 and .textu2, as shown below.

 

 Section configuration (content set in the [GNU17 Linker Script Settings] dialog box)
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 Linker script and section location
 The linker script is generated, as shown below.

/* Linker Script file generated by Gnu17 Plug-in for Eclipse */
OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
  __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ;
    boot.o(.bss)
    func1.o(.bss)
    func2.o(.bss)
    main.o(.bss)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.bss)
    C:/EPSON/gnu17/lib/24bit/libc.a(.bss)
   }
   __END_bss = . ;

 .data __END_bss : AT( __END_rodata )
   {
    __START_data = . ;
    boot.o(.data)
    func1.o(.data)
    func2.o(.data)
    main.o(.data)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.data)
    C:/EPSON/gnu17/lib/24bit/libc.a(.data)
   }
   __END_data = . ;

 .textu1 __END_data : AT( __START_data_lma + SIZEOF( .data ) )
   {
    __START_textu1 = . ;
    func1.o(.text)
   }
   __END_textu1 = . ;

 .textu2 __END_data : AT( __START_textu1_lma + SIZEOF( .textu1 ) )
   {
    __START_textu2 = . ;
    func2.o(.text)
   }
   __END_textu2 = . ;

 .vector 0x008000 : 
   {
    __START_vector = . ;
    boot.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector : 
   {
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    __START_text = . ;
    boot.o(.text)
    main.o(.text)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.text)
    C:/EPSON/gnu17/lib/24bit/libc.a(.text)
   }
   __END_text = . ;

 .rodata __END_text : 
   {
    __START_rodata = . ;
    func1.o(.rodata)
    func2.o(.rodata)
    main.o(.rodata)
    C:/EPSON/gnu17/lib/24bit/libstdio.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libgcc.a(.rodata)
    C:/EPSON/gnu17/lib/24bit/libc.a(.rodata)
   }
   __END_rodata = . ;

 /* load address symbols */
 __START_data_lma = LOADADDR( .data );
 __END_data_lma = __START_data_lma + SIZEOF( .data );
 __START_textu1_lma = LOADADDR( .textu1 );
 __END_textu1_lma = __START_textu1_lma + SIZEOF( .textu1 );
 __START_textu2_lma = LOADADDR( .textu2 );
 __END_textu2_lma = __START_textu2_lma + SIZEOF( .textu2 );
}

 Shown below are the section locations and file configurations.

boot.o – .text

main.o – .text

boot.o – .rodata

main.o – .rodata

func1.o – .rodata

func2.o – .rodata

boot.o – .data

main.o – .data

func1.o – .data

func2.o – .data

(__START_textu2_lma)

(__START_textu1_lma)

(__START_data_lma)

(__START_rodata)

(__START_text)

0x008000

0x000000

LMA

.textu2
section
.textu1
section

.data
section

.rodata
section

.text
section

.vector
section
No sections/files 
located here

func1.o – .text

func2.o – .text

boot.o – .bss

main.o – .bss

boot.o – .data

func1.o – .data

func2.o – .data

main.o – .datamain.o – 
.datamain.o – .data

(__START_textu1)

(__START_data)

0x000000

VMA

.data
section

.bss
section

.textu1 section .textu2 section

func1.o – .bss

func2.o – .bss

func1.o – .text func2.o – .text

library – .text library – .bss

library – .rodata

Figure 5.7.6.9  Example of s section location 4

 The routine for transferring the program from ROM to RAM should be created within main.c.
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Note: Locating the .textu1 and .textu2 sections preceding a .rodata section with (for example) 
no LMA specified will result in positioning the .rodata section behind the end VMA address of 
the .textu2 section. Do not locate any VMA-only sections behind LMA ≠ VMA sections.



S5U1C17001C MANUAl Seiko Epson Corporation 5-163
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

5.7.9  flash Protect Settings

Write Protect and Read Protect can be set to protect the contents of internal flash memory. (Flash protect settings 
may not be available with all devices.) The IDE creates the psa file "<project name>_ptd.psa" for which flash-
protect is set by the settings described in this section.
The procedure for setting flash protect is described below.

Note: [Build Mask file(psa)] must be selected on the [GNU17 Build Options] page to create the psa file. 
For more information on how to select this, refer to section 5.7.2 "Setting the Build Goal".

flash protect setting page
 Flash protect is set using the [GNU17 Flash Protect Settings] page in Project Properties. Flash protect is set as 

follows:

(1) Select the project for the flash protect settings in [C/C++ Projects] view or [Navigator] view.
(2) Select [Properties] from the [Project] menu or context menu for the view above to display the [Properties] 

dialog box.
(3) Select [GNU17 Flash Protect Settings] from the Properties list.

 

 The S1C17 core/processor types currently set for the [Protect bits setting for] will be displayed.

(4) Select whether to set flash protect. (Only for devices for which flash protect setting is available)
 Check or uncheck the [Use FLASH Protection] checkbox.

On: Creates the "<project name>_ptd.psa" file for which flash protect was written at the build time. When 
enabled, advanced settings are available in the table at the bottom of the screen.

 Off: Flash protect is not set.
Note: The flash protection setting may be unavailable with certain models. For more information, refer 

to the technical manual for the device.
(5) Set the flash protect advanced settings.
 Flash protect advanced settings
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 Address:
 Displays the start and end addresses for flash protection.
Read protect:
 Sets read protection for the address specified using the checkbox.
 Read protection keeps data from being read from the address specified.
 On: Protected
 Off: Not protected
Write protect:
 Sets write protection for the address specified using the checkbox.
 Write protection prevents data from being written to the address specified.
 On: Protected
 Off: Not protected

(6) Click [OK] or [Apply] to confirm the settings.
 This confirms the details changed. If the settings above are changed, a dialog box will prompt you to con-

firm whether to run a "clean" build (see section 5.7.8), and files created by previous settings will be de-
leted (or rebuilt). The protect.cmd file will be created here if [Use FLASH Protection] is enabled. An 
already existing file will be overwritten.

 [OK] button: Closes the [Properties] dialog box.
 [Apply] button: Lets you continue editing without closing the [Properties] dialog box.
 To cancel the details changed and close the [Properties] dialog box, click the [Cancel] button. If you do not 

click the [Apply] button, you can use the [Revert Settings] button to revert to the original settings in place 
when the page was opened.

Note:  If you change the device type on the [GNU17 General] page, the flash protection settings 
changed will be discarded and set to the default for the device type after changing.

flash-protected programs
 You must do the following to load, debug, or erase flash-protected programs. The example here uses the 

S1C17702 "sample" project.
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loading flash-protected psa files
 The command file described in section 5.8.2 "Setting the Debugger Startup Commands" must be changed to 

load flash-protected psa files.
 (1) Changing a command file

 

 Change "load sample.psa" to "load sample_ptd.psa" as enclosed in red above.
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(2) Loading psa file
 Launch the debugger to load the psa file to flash.
 Right-click the [C/C++ Projects] view or [Navigator] view. Select [Debug As] > [Debug Configurations] 

from the context menu to display the [Debug Configurations] dialog box.

Select the debug configuration for the project. Click the [Debug] button to launch the debugger. Protection is up-
dated once you exit the debugger and the target has been reset.

Debugging a protected psa file
You must do the following to debug a protected psa file.
(1) Creating a command file

 (Example)
 Create the ptd_debug.cmd file described below in an editor, referring to the command file (debugger: ICD 

Mini) created by [Create commands from template].

# load debugging information in program

file sample.elf

# set the memory configuration map file to the debugger

c17 rpf sample_gnu17IDE.par

# connect to the debugger with specified mode and port

# target [icd usb | sim]

target icd usb

# reset

c17 rst
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(2) Creating a debug configuration
Next create a debug configuration.
Display the [Debug Configurations] dialog box.

 

 Right-click the debug configuration for the specific project and select [Duplicate].
 Changes are applied to the duplicated debug configuration. Select the Debugger tab from the tabs on the right-

hand side of the screen.
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 Ent er the GDB command file or click the [Browse] button to change "sample_gnu17IDE.cmd" to "ptd_debug.

cmd" as enclosed in red above.

(3) Executing debugging
Select the duplicated debug configuration to debug.

Unprotecting
 (1) Creating a command file
 (Example)
 Create the unprotect.cmd file described below using an editor referring to the command file (debugger: 

ICD Mini) created by [Create commands from template].

# flash program load

file /cygdrive/C/EPSON/GNU17/mcu_model/17702/fls/fls17702.elf

# connect to the debugger with specified mode and port

target icd usb

# load flash program

load /cygdrive/C/EPSON/GNU17/mcu_model/17702/fls/fls17702.elf

# flash set

c17 fls 0x8000 0x27fff FLASH_ERASE FLASH_LOAD 

# flash erase

c17 fle 0x8000 0 0

c17 rstt

(2) Creating a debug configuration
Next, create a debug configuration.
Display the [Debug Configurations] dialog box.

 

 Right-click the debug configuration for the specific project and select [Duplicate].
 Changes are applied to the duplicated debug configuration. Select the Debugger tab from the tabs on the right-

hand side of the screen.
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 Enter the GDB command file or click the [Browse] button to change "sample_gnu17IDE.cmd" to "unprotect.
cmd" as enclosed in red above.

(3) Unprotecting
Select the duplicated debug configuration to debug.
Protection is removed once you exit the debugger and the target is reset.
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5.7.10  Executing a Build Process

After creating source files, setting build options, and editing a linker script file, you can execute a build process.
Shown below is the procedure for executing a build process.

Building all projects in the workspace
 Do one of the following to build all projects present in the workspace:

• Select [Build All] from the [Project] menu.
• Click the [Build All] button in the window toolbar.

Building a selected project
 Do the following to build a project individually:

(1) Select the project you want to build in the [C/C++ Projects] or [Navigator] view.

(2) Do the following to execute a build process:
• Select [Build Project] from the [Project] menu.
• Select [Build Project] from the context menu in the [C/C++ Projects] or [Navigator] view.

 You also can select a working set from [Build Working Set] on the [Project] menu and build only projects in-
cluded in the selected working set.

Build process
 When you begin building a project, the IDE executes the processing described below.

1. Save any unsaved files in the editor.

2. Generate the following files according to the settings for project properties:
• Makefile (<project name>_gnu17IDE.mak) and dependency file (<source name>.d)
• Linker script file (<project name>_gnu17IDE.lds)
• Parameter file (<project name>_gnu17IDE.par)*
• Command file (<project name>_gnu17IDE.cmd)*

* These files are needed for debugging and do not affect the build process. Normally, no command file is 
generated in a build process. A build process generates a command file that includes a minimum com-
mand set required for starting up the debugger only when <project name>_gnu17IDE.cmd does not 
exist.

3. Execute make.exe. The following files will be generated:
• Object file for each source (<source name>.o)
• Assembly file (<C source name>.ext0) for each C source
• Executable format object file (<project name>.elf)
• S-record-format psa file (<project name>.psa)
• Link map file (<project name>.map)
• Dump file (<project name>.dump)

 While a build process is underway, the command line in [Console] view shows each tool being executed.
 Any errors occurring during a build process can be reviewed in [Problems] view. From there, you can jump the 

corresponding spot in the editor in error. For more information on this feature, refer to "Jump to a line with an 
error" in Section 5.5.3.

 Note that make.exe is designed to generate and link only the object files (*.o) that have yet to be generated or 
that require updating by checking the dependency list of the source files and object files (*.o) written in the 
makefile.

 Therefore, in the first build process, make.exe compiles/assembles all sources to generate object files (*.o) and 
to link the generated files. Thereafter, it compiles/assembles only the altered sources (including alteration of 
include files) and links the generated files.
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 The files listed in 2 above require caution. Even if you correct their contents directly in the editor before a build 
process, they will be overwritten when a build process starts. To ensure that these files are not regenerated dur-
ing a build process, deselect the [GNU17 File Builder] currently selected check box in the [Builders] page of 
the [Properties] dialog box.

About object files generated from a link source
 The object files for linked source files located outside the project folder will be generated directly under the 

project folder. 
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5.7.11  Clean and Rebuild

As described above, no object files (*.o) are regenerated unless the source or include files have been altered. If all 
of the generated object files (*.o) are erased, a build (or rebuild) from all sources can be re-executed. Therefore, 
the makefile generated by the IDE has a command for erasing all generated files written in it with the target name 
"clean".
The following describes the procedure for rebuilding a project using this command:

(1) Select the project you want to rebuild in the [C/C++ Projects] or [Navigator] view.

(2) Select [Clean...] from the [Project] menu.
 This displays the [Clean] dialog box.

(3) Select the [Clean projects selected below] radio button and select the project to execute "clean" (rebuild) from 
the list.

 Select [Clean all projects] to rebuild all projects in the workspace.

 Leave the [Start a build immediately] check box selected. This allows you to proceed to a build process directly, 
without doing anything, else after executing the clean command.

 Select [Build the entire workspace] to build all projects in the workspace.
 Select [Build only the selected projects] to build only the projects selected in the above step.

(4) Click the [OK] button.

This deletes all generated object files in the selected project, then executes a build process.
If the [Start a build immediately] check box is unselected, the command will only perform the file deletions. You 
must execute the build process as described in the preceding section.

You also can also execute "clean" as described below:

(1) Select the project you want to execute "clean" in the [C/C++ Projects] view.

(2) Select [Clean Project] from the context menu in the [C/C++ Projects] view.

In this case, no dialog boxes are displayed, and the "clean" process only is executed.

Except when you intend to rebuild a project, you will need to execute a build process after altering certain source 
files or header files. You must perform a rebuild in the following cases:

• When certain header files have been deleted from the project
 The dependency file is regenerated by rebuilding the project.
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• When the dependency file is deleted
 Do not delete the dependency file.

• When the included header file does not exist in the project
 You must rebuild if you've altered a header file not existing in the project file (i.e., external to the project).

• When a build fails due to file privileges when a build is executed immediately after importing a project



5-174 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5.7.12  Using an Original Makefile

To perform a build, the original makefiles created by a user may be used instead of those automatically generated 
by the IDE. This procedure is described below.

(1) In the [C/C++ Projects] or [Navigator] view, select the project you want to build using the makefile you created.

(2) Create a new makefile in the IDE or import the makefile you already created. (Refer to Section 5.4.8, "Re-
source Manipulation in a Project.")

 If you've already performed a build in the IDE, you can use the makefile generated by the IDE after correcting 
it.

(3) Select [Properties] from the [Project] menu or the context menu of the selected project.
 This displays the [Properties] dialog box.

If you created a makefile with the name "<project name>_gnu17IDE.mak" or use a corrected version of the 
IDE-generated makefile, steps (4) and (5) described below are required. If you are using a makefile with a different 
name and use the IDE-generated files for the linker script file (.lds), parameter file (.par), and command file (.cmd), 
skip steps (4) and (5) and go to (6).

(4) Select [Builders] from the properties list.

(5) Deselect the [GNU17 File Builder] check box.
 The following files will no longer be generated during a build process:

• Makefile (<project name>_gnu17IDE.mak)
• Linker script file (<project name>_gnu17IDE.lds)
• Parameter file (<project name>_gnu17IDE.par)
• Command file (<project name>_gnu17IDE.cmd)

  Selecting the [GNU17 File Builder] check box will cause the IDE to overwrite these files each time you exe-
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cute a build process. If you want to use the files generated by the IDE except for the makefile, create a makefile 
with other than the name shown above and leave the [GNU17 File Builder] check box selected. Or select the 
[GNU17 File Builder] check box before executing a build process and deselect it after the above files have been 
generated.

(6) Select [C/C++ Make Project] from the properties list to display the page for the [Make Builder] tab.

(7) Deselect the [Use default] check box and correct the [Build command:] command line.
 Example: Change to the makefile named "user.mak".
  ${gnu17_loc}/make.exe -f user.mak

(8) Change the following target names to the ones you created. Leave the check boxes selected.
[Build (Incremental Build)]
 Specify the target in the makefile called when you execute a build process. By default, "all" is called.
[Clean]
 Specify the target in the makefile called when you execute a clean process. By default, "clean" is called.

 There is no need to change if the same target names are used in the user makefile.

 Leave the [Build on resource save (Auto Build)] check box at the default setting. (The default settings for the 
IDE disable this option.)

(9) Click the [OK] button to close the [Properties] dialog box.
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5.8  Starting the Debugger
Although the gdb debugger is provided as an application distinct from the IDE, it can be started from within the 
IDE after setting the appropriate command options.

5.8.1  generating a Parameter file

A parameter file is used to set memory map information for the target system in the debugger. The debugger per-
forms the following processing, based on debugger settings.
• Check to see if the software PC break addresses are within the valid map area.
• Stops program at write access to the ROM area. (simulator mode only)
• Access to undefined area (simulator mode only)
• Stack overflow (simulator mode only)

Loading a parameter file reserves sufficient storage in PC memory for all memory areas written in the file.
For more information on the parameter file, refer to Section 10.9, "Parameter Files."

The IDE generates a parameter file with the name "<project name>_gnu17IDE.par" during a build process, 
based on the project properties set. If the project properties are changed thereafter, the parameter file will be up-
dated and passed just before you start the debugger.

The following explains how a parameter file is generated.

Parameter setup page
 Use the [GNU17 Parameter Settings] page of the project properties to set the content of a parameter file. Dis-

play the setup page following the procedure described below.

(1) Select a project in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu or the context menu of the selected project.
 This displays the [Properties] dialog box.

(3) Select [GNU17 Parameter Settings] from the properties list.

 

 This displays the currently set content in this page.
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[Comment:]
 You can enter any comments here. Up to 255 characters can be entered. The comments entered here are 

written in the parameter file.

Area list
 Shows one area information in each line. Information is listed in alphabetical order, except that stack area 

information is displayed collectively at the bottom of the list.
[Type]
 Shows the type of area (ROM, RAM, IO, or STACK).
[Start-End Address]
 Shows the start and end addresses of the area in hexadecimal notation.
[Wait R/W]
 The first two single-digit values indicates the number of wait states during a read cycle (first digit) and 

the number of wait states during a write cycle (second digit), respectively. The words "byte" (8 bits), 
"halfword" (16 bits), and "word" (32 bits) indicate the access size in which the area is accessed. If the 
rest is blank, the area is accessed in little endian mode. The areas set for big endian are marked by 
"Big".

[Comments]
 Shows the comment entered in each area information. You do not need to enter the symbol "#" to set off 

comments.

 Shown below are the contents initially set when you create a project.

 When S1C17 is selected for the target CPU device
Area Start-end address Wait states (R/W) Access size Area comment

RAM 0x000000–0xFFFFFF 0/0 word All Area
STACK 0x000000-0x000FBF – – Stack area

 If a CPU device other than S1C17 is selected, the default parameter settings will change, in accordance with 
the setup file provided for that particular device. For more information on target CPU devices other than the 
S1C17702, refer to "parameter.txt" found in the C:\EPSON\gnu17\mcu_model model compatibility folder.

 When S1C17702 is selected for the target CPU device
Area Start-end address Wait states (R/W) Access size Area comment

RAM 0x000000-0x002FBF 0/0 Word Internal RAM
IO 0x004000-0x0043FF 0/0 Byte Peripheral Area1
IO 0x005000-0x005FFF 0/0 Byte Peripheral Area2

ROM 0x008000-0x027FFF 1/0 Halfword ROM(Flash)
RAM 0x080000-0x08055F 1/1 Byte SRAM(LCD Display)

IO 0xFFFC00-0xFFFFFF 0/0 Byte Reserved for Core I/O
STACK 0x000000-0x002FBF – – Stack area
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 Content of a parameter file

  When S1C17 is selected for the target CPU device
# Parameter file generated by Gnu17 Plug-in for Eclipse

RAM     000000 FFFFFF 00W     # All Area 
STACK   000000 000FBF         # Stack area 

  When S1C17702 is selected as the target CPU device
# Parameter file generated by Gnu17 Plug-in for Eclipse
ESSIM S1C17702

RAM     000000 001FBF 00W     # Internal RAM
IO     004000 0043FF 00B     # Peripheral Area1
IO     005000 005FFF 00B     # Peripheral Area2
ROM     008000 027FFF 10H     # ROM (Flash)
RAM     080000 08055F 11B     # SRAM (LCD Display)
IO      FFFC00 FFFFFF 00B     # Reserved for Core I/O
STACK   000000 001FBF         # Stack area

Editing an area
 All of the above area information can be modified to suit the system. This is described below:

(1) From the area list of the [GNU17 Parameter Settings] page, click to select the area you want to edit.

(2) Click the [Edit] button.
 This displays the [Edit Parameter] dialog box.

(3) Make the required settings based on the explanation given below. Click [OK].

 If any address of the area you've edited overlaps that of an already set area, an error message similar to the 
one shown below is displayed at the top of the dialog box.

 "Address range overlaps with other areas"

 In such cases, correct the address of the area you're editing, or after temporarily quitting by selecting [Cancel], 
correct the overlapping area information before editing the information of this area once again.

(4) Click the [Apply] button if you want to change other areas or properties or the [OK] button to end property 
settings.

 If you haven't clicked [Apply], you can use the [Revert Settings] button to restore modified content to the 
state in which this page was opened.
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 [Edit Parameter] dialog box

[Area Type:]
 Select the type of area from the following four options:

ROM Select to set internal or external ROM areas.
RAM Select to set internal or external RAM areas.
IO Select to map an internal I/O area or external device to 

memory.
STACK Select to set a stack area.

 ROM, RAM, and IO settings are used in the debugger to de-
termine whether software PC breakpoints are valid addresses. 
During simulator mode debugging, all simulated memory areas 
will be allocated in the PC memory. These areas cannot have 
overlapping addresses.

 STACK settings are used specifically to cause program execu-
tion to break upon detecting a stack overflow during simulator 
mode and do not affect operations in any other mode or the stack 
pointer. Since STACK is not an area of physical memory, its ad-
dresses may overlap those of other areas. If STACK is selected, 
[Access Wait Cycle], [Access Size:], and [Use Big Endian] have 
no effect.

[Start Address:]
 Enter the start address of the area in hexadecimal notation (omit 0x). An error will result if this address ex-

tends beyond the end address or overlaps the address of an already set area.

[End Address:]
 Enter the end address of the area in hexadecimal notation (omit 0x). An error results if this address precedes 

the start address or overlaps the address of an already set area.

[Access Wait Cycle]
 Enter the number of wait states inserted when the area is accessed. Specify in clock cycles ranging from 0 

to F (hexadecimal), or 0 to 15 cycles. This is disabled for STACK areas.
 [Read:] Enter the number of wait states inserted during a read cycle.
 [Write:]  Enter the number of wait states inserted during a write cycle.

[Access Size:]
 Select the access size of the area from the following three options. This is disabled for STACK areas.
 byte 8 bits
 halfword 16 bits
 word 32 bits

[Use Big Endian]
 Select this for the area to be accessed in big endian. Unless this is selected, areas are accessed in little en-

dian. This option is disabled for STACK areas.

[Area Comment:]
 Enter the content of the area or other notes as a comment. You do not need to enter the symbol "#" to set off 

the comments.

[OK]
 Closes the dialog box. The area list in the [GNU17 Parameter Settings] page is updated with the contents 

you set. If any content that needs to be set remains blank, this button is disabled. Also note that after you 
click [OK], the set contents are checked. If any discrepancy is detected (e.g., the set address overlaps an-
other area), an error message is displayed at the top of the dialog box, in which case the dialog box is not 
closed. You must correct the erratic content of the area being edited or correct another area after temporarily 
quitting by selecting [Cancel].
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[Cancel]
 Discards all modifications and closes the dialog box. The area list in the [GNU17 Parameter Settings] page 

is not updated.

Adding an area
 Do the following to add a new area:

(1) Click the [Add] button.
 This displays the [Add Parameter] dialog box.

(2) Make the necessary settings, based on the explanations given in 
"Editing an area" above. Click [OK].

(3) Click the [Apply] button to change other areas or properties or the 
[OK] button to end property settings.

 If you haven't clicked [Apply], you can use the [Revert Settings] 
button to restore modified content to the state in which this page 
was opened.

 The area added is inserted into the list in order of set address.

Deleting an area
 Do the following to delete an unnecessary area:

(1) From the area list of the [GNU17 Parameter Settings] page, click to select the area you want to delete.

(2) Click the [Delete] button.

(3) A dialog box for confirmation is displayed. Click [OK] to delete or [Cancel] to cancel.

(4) Click the [Apply] button to change other sections or properties or the [OK] button to end property settings.
 If you haven't clicked [Apply], you can use the [Revert Settings] button to restore modified content to the 

state in which this page was opened.
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5.8.2  Setting the Debugger Startup Commands

The debugger startup commands can be set in advance as project properties in the manner described below:

(1) Select a project in the [C/C++ Projects] or [Navigator] view.

(2) Select [Properties] from the [Project] menu or the context menu of the selected project. This displays the [Prop-
erties] dialog box.

(3) Select [GNU17 GDB Commands] from the properties list.

 This page allows the user to directly edit a debugger startup command file. The edit area shows the contents of 
<project name>_gnu17IDE.cmd. If the file does not exist, the edit area shows the default commands as be-
low according to the settings in the project file.

(4) Click the [Apply] button to change other sections or properties or the [OK] button to end property settings.
 If you haven't clicked [Apply], you can use the [Revert Settings] button to restore modified content to the state 

in which this page was opened.

The command file (<project name>_gnu17IDE.cmd) is generated with the contents set here when the [OK] or 
[Apply] button is clicked, and it will be passed to the debugger at launching.

Command file for ICD Mini mode (default)
# Command file generated by Gnu17 Plug-in for Eclipse

# flash program load
file /cygdrive/C/EPSON/GNU17/mcu_model/17701/fls/fls17701.elf
# connect to the debugger with specified mode and port
target icd usb
# load flash program
load /cygdrive/C/EPSON/GNU17/mcu_model/17701/fls/fls17701.elf
# flash set
c17 fls 0x8000 0x17fff FLASH_ERASE FLASH_LOAD 
# flash erase
c17 fle 0x8000 0 0
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# load debugging information in program
file sample.elf     ... Loads debug information.
# set the memory configuration map file to the debugger
c17 rpf sample_gnu17IDE.par   ... Loads a parameter file.
# connect to the debugger with specified mode and port
# target [icd usb | sim]
target icd usb     ... Sets connection mode.
# load program to memory
load sample.psa     ... Loads an S record file.
# reset
c17 rst       ... Resets.

The default setting shows the command to set the debugger in ICD Mini mode. If simulator mode is used, rewrite 
the command directly in this page or replace the command using the [Create a simple startup command] dialog box 
shown below that appears by clicking the [Create commands from template] button.

Command file for simulator mode
# Command file generated by Gnu17 Plug-in for Eclipse
# load debugging information in program
file sample.elf    ... Loads debug information.
# set the memory configuration map file to the debugger
c17 rpf sample_gnu17IDE.par  ... Loads a parameter file.
# set ttbr for simulator
c17 ttbr 0x008000    ... Sets TTBR.
# connect to the debugger with specified mode and port
# target [icd usb | sim]
target sim     ... Sets connect mode.
# load program to memory
load sample.psa    ... Loads an S record file.
# reset
c17 rst      ... Reset

This command file is executed when the debugger starts up making the following initial settings:
1. Import debug information and parameter map information.
2. Set connect mode.
3. Set TTBR. (only in simulator mode)
4. Load the program to be debugged.
5. Set the PC (program counter) to the boot address.

These initial settings enable the debugger to execute a program from the boot address immediately after launching.

If other commands must be executed, enter them from the keyboard to add to the command list.
For detailed information on debugger commands, refer to Chapter 10, "Debugger".

The debugger startup commands in the command file may be edited using an editor.
Note, however, that the contents of the command file may not be displayed on the [GNU17 GDB Commands] page 
if the command file is being opened in an external editor when the [Properties] dialog box is opened. In this case, 
open the [Properties] dialog box after closing the command file in the external editor.
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[Create a simple startup command]

[Debugger:]
 Select the debugger (connect mode) to connect to.
 ICD Mini When using an ICD to debug.
   When [ICD Mini] is selected and [Overwrite] is pressed, the flash load command will also be ex-

ecuted in accordance with the target CPU selected in the [Properties] > [GNU17 General] page.
 Simulator To debug with a PC only.

[Boot vector address] (effective only in simulator mode)
 Enter the boot vector address in hexadecimal notation (omit 0x) in the text box when creating a command file 

for simulator mode. The address may be specified in 256-byte increments. The IDE generates a command file 
for simulator mode that includes a command for setting this value to the boot vector address. The value ap-
peared here by default is the address that was specified when the project was created.

[Ports]
 Selecting ICD Mini or Simulator in [Debugger:] sets the port to USB or NONE, respectively. So no settings are 

required.

[Overwrite]
 Applies the above settings to the command file shown in the [GNU17 GDB Commands] page and closes the 

dialog box. A dialog box appears prompting overwrite, so execution may be canceled even after the button is 
clicked. 

[Close]
 Close the dialog box. The command file shown in the [GNU17 GDB Commands] page does not reflect the con-

tents changed in the dialog box.

If the memory model is changed in the [Properties] > [GNU17 General] page, this dialog box also reverts to the de-
fault setting (ICD Mini). If the CPU has been changed via the [Properties] > [GNU17 General] page, the CPU boot 
vector address will be set to [Boot vector address].
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5.8.3  launching the Debugger

The debugger can be started once an execution file (.elf) has been generated using a build operation and the prepa-
rations described in the preceding section have been completed.
The debugger is started via the launch configuration window.
The launch configuration window is used for the various settings to start debugging and for launching the debugger 
(GDB).

Starting debugging
(1)  Select [Debug Configurations...] on the [Run] menu to display the launch configuration dialog box. It can 

also be opened from the [Debug] button menu on the toolbar.
(2) Select [GDB17 Debugger for <Project Name >] from the tree list.

 

(3) Modify [GDB other options:] (debugger command line argument) in the [Debugger] tab as necessary.
 There is no need to change this if the debugger is launched using a command file created by the IDE.
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(4) Click the [Debug] button.
 The debugger gdb launches and executes the specified command file.
 For subsequent debugger operations, refer to Section 10, "Debugger".

Quitting the debugger
 The debugger can be quit using any of the following methods.
 After the debugger terminates, the [Debug] view display changes to the terminated state.

• Select [Terminate] in the [Run] menu.
• Click the [Terminate] button in [Debug] view.
• Click the [Terminate] button in [Console] view.
• Select [Terminate] in the [Debug] view Context menu.

Relaunching the debugger
 Relaunching the debugger means relaunching the debugger (GDB) while it is suspended.
 Debugging can be started using the same launching method after debugging has already been performed with-

out having to open the launch configuration dialog box.
 The debugger can be relaunched using any of the following methods.

• Select [Debug Last Launched (F11)] in the [Run] menu.
• Select the previous [GDB17 Debugger for <Project Name> ] from the [Debug History] list in the [Run] menu.
• Click the [Debug] button on the toolbar.
• Select [Relaunch] in the [Debug] view Context menu.

launch configuration dialog box
 [Create New Launch Configuration]

• When creating a new launch configuration
 Double-click [GNU17 Debugging] in the tree to create a new launch configuration. The newly created con-

figuration is named [New creation].
 The settings required for launching (project name, execution file, command file used) should be input in the 

order described below.

Note:  The project folder must be specified using the [Common File] in the [Common] tab in order 
to save the launch configuration settings in the project folder.

• When creating a new launch configuration from an existing project
 Open the launch configuration dialog box with the project selected in [C/C++ Projects] view and double-

click [GNU17 Debugging]. This sets the project name, execution file, and command file to be used in ad-
vance from the project selected.
Note: Select the project in [C/C++ Projects] view and open the launch configuration dialog box in 

the GNU17 perspective. 
   If the launch configuration dialog box is opened in the debug perspective, the launch con-

figuration will be created in [New creation], as the project selected in [C/C++ Projects] view 
cannot be acquired.
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 [Launch Configuration Settings]
 Selecting the launch configuration displays the various tab windows in the right-hand pane.
 Enter the corresponding debugger settings in these tab windows.

 

Table 5.8.3.1  List of Launch Configurations window tabs
Tab Setting

Main Project and target program to be debugged
Debugger Debugger path and argument
Source Source search path
Common Common settings related to launch configuration
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[Main] tab
Enter and display the information for the project and target program to be debugged.

Table 5.8.3.2  [Main] tab
Input item Details

Project Enter the project name to be debugged.
The [Browse] button can be used to select a project within the 
workspace.
Enter the execution file (elf) to be debugged.

C/C++ Application The elf file within the project can be selected using the [Search Project] 
button (if a project has been entered).
The [Browse] button can be used to open the [Files] dialog box and 
select the desired elf file (if a project has been entered).
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[Debugger] tab
 Sets the debugger (GDB) path and arguments.

 

Table 5.8.3.3  [Debugger] tab
Input item Details

Debugger Selects the debugger type to be launched. 
Fixed at GNU17 Debugger.

GDB debugger Displays and enters the path of the debugger to be launched.
This can be selected via the [Browse] button file dialog box.

GDB command file Specifies the command file used when launching.
(The default is "(project name)_gnuXXIDE.cmd".)
-nx when blank.
This can be selected via the [Browse] button file dialog box.

GDB other options Allows additional arguments to be specified for launching gdb.exe.
Typical parameters that can be specified:
 --c17_cmw=n
 --double_starting

The following options must not be specified, as they will cause 
malfunctioning.
(-x、--command、--cd、--directory)

Verbose console mode Displays the MI command communication between the IDE and GDB.
Default: OFF
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[Source] tab
Specifies the source search path for source level debugging.

Table 5.8.3.4  [Source] tab
Input item Details

Source lookup path Displays the source search path.
The default is the project folder.

Add Adds a new path.
Edit Edits the source search path.
Remove Deletes the source search path.
Up/Down Changes the path search sequence. ("Up" takes priority.)
Restore default Returns the source search path to the default settings.
Search for duplicate source 
files on the path

Searches for duplicate files on the source search path.
Not supported.
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[Common] tab
Used for the common settings related to launch configuration. 

table 5.8.3.5  [Common] tab
Input item Details

Local file The IDE saves the launch configuration internally.
Shared file Saves the launch configuration as a launch file within the project. The path 

for saving the file should be specified. By default, the launch configuration 
will be saved as "GDB17 Debugger for <project name.launch> " 
immediately inside the project folder.

Display in Favorites menu Registers the shortcut for this launch configuration in the toolbar [Debug] 
button menu.

Console Encoding Specifies the console output encoding.
This setting is not normally required.

Allocate Console 
(necessary for input)

Enables command input to the GDB in [Console] view.
This must always be set to "ON".

File Redirects the GDB command output in [Console] view. (It is also output in 
[Console] view.)
The file name should be specified.
The file and path can be specified from [Workspace...]/[File System...].

Append Outputs in Append mode when [Files] is specified.
Launch in background Launches in the background.

This should normally be set to "ON".

Note: The project folder should be set using the settings in [Common File] in order to save the launch 
configuration settings in the project folder.
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[Confirm Launch Configuration Settings]
The following buttons confirm the launch configuration settings.

[Apply] Confirms the tab window settings currently displayed.
[Revert] Returns the tab window settings currently displayed to the previ-

ously saved state.
[Close] Closes the launch configuration dialog box.
 A confirmation dialog box will be displayed if setting changes 

have not been saved.
[Debug] Confirms the tab window settings and launches the debugger.
 When launching other than for the first time, the debugger can be 

launched using the toolbar or the [Run] menu shortcut rather than 
this button.

 Sets further breakpoints for the debugger if breakpoints exist on 
the [Breakpoints] view list.

Note: If an error occurs within a command file, the error message will be output to [Console] view, 
and the debugger will be launched without executing subsequent commands.
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Precautions
• Once you start the debugger, you cannot execute a build process in the IDE. Quit the debugger to perform a 

build.

• If you quit the IDE with the debugger open, the debugger will also be terminated.
 • Launching the debugger from the [Debug] menu may perform a build process before the debugger starts up 

(when a source or other file in the project has been modified). Note that the debugger starts up if an error oc-
curs during the build.

 If you do not want to execute a build before the debugger starts up, disable it  by the procedure below.

(1) Open the [Run/Debug] > [Launching] page after displaying the [Preferences] dialog box by selecting 
[Preferences...] from the [Window] menu.

(2) Deselect the [Build (if required) before launching] check box.
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5.9  Customizing the IDE (Preferences)
You can customize settings for IDE operations and display in various ways to suit your own needs and preferences.
To perform this customization, use the [Preferences] dialog box displayed when you select [Preferences...] from the 
[Window] menu.

The customizable items are displayed in tree form in the left-side column of the dialog box. Select the item you 
want to change to display its setup page. The [type filter text] field is used to filter the items in the list so that only 
the items that begin with the letters to be entered will be displayed.
The buttons common to each page are described below.

 [Back]
 Returns to the preference pages previously referenced or edited. 

 [Forward]

 Reverts the display traced back by [Back] above to the next recent page.

[Restore Defaults]
 Restores the set content of each page to the state in which the dialog box was opened or the state at which the 

[Apply] button was clicked to confirm dialog box settings.

[Apply]
 Applies the settings made on the page. Before changing another item, be sure to click [Apply] before proceed-

ing to a new page.

[OK]
 Applies the set content of the current page and closes the dialog box.

[Cancel]
 Cancels settings and closes the dialog box. Settings already confirmed with the [Apply] button prior to [Cancel] 

will not be canceled.

The relevant page and the set content of each customization item are described below. Please do not attempt to 
change any settings not discussed here.
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general

 Make settings for IDE operations.

[Always run in background]  (default: OFF)
 If this check box is selected, a build or other process runs in the background (no dialogs displayed during a 

build), allowing you to perform other tasks.

[Keep next/previous editor, view and perspectives dialog open]  (default: OFF)
 By pressing [Ctrl] + [F6] (for editor) or [Ctrl] + [F7] (for views), the IDE switches the editor/view between 

one currently edited/referenced and another one previously edited/referenced. Normally, pressing the keys 
switches the editor/view immediately. If this check box is selected, pressing the keys displays a pull-down 
menu including the browsing history and you can select the editor/view to be activated from the list.

[Show heap status]  (default: OFF)
 If this check box is selected, the usage status of the Java heap will be displayed at the bottom right of the 

workbench window.

[Open mode]
 Select the action by which resources are opened in the editor from the [C/C++ Projects] or [Navigator] 

view.
[Double click]  (default: ON)
 Single-clicking a resource selects it; double-clicking a resource opens it.
[Single click]  (default: OFF)
 Single-clicking a resource opens it.
[Select on hover]  (default: OFF)
 If this check box is selected, a resource in the view can be selected simply by hovering the mouse cur-

sor over it. (Effective only when [Single click] is selected)
[Open when using arrow keys]  (default: OFF)
 If this check box is selected, a resource can also be opened in the editor by selecting it with arrow keys. 

(Effective only when [Single click] is selected)
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general > Appearance

 Specify the IDE appearance and the tab positions displayed in the editor and views.

[Current Presentation:] 
 The appearance of the IDE can be changed to the Eclipse 2.1 style. To switch the appearance, restart the 

IDE after selecting it from the pull-down list.

[Override presentation settings]  (default: OFF)
 Select this check box when changing the tab position displayed in the editor.

[Editor tab positions] 
 Specify the tab position displayed in the editor.

[Top]  (default: ON)
 Tabs are displayed at the top of the view.
[Bottom]  (default: OFF)
 Tabs are displayed at the bottom of the view.

[View tab positions]
 Specify the tab position displayed in the view.
 [Top]  (default: ON)

 Tabs are displayed at the top of the view.
 [Bottom]  (default: OFF)

 Tabs are displayed at the bottom of the view.

[Perspective switcher positions]
 Specify the displayed position of the perspective bar.

[Left]  (default: OFF)
 The perspective bar is displayed on the left edge of the window.
[Top Left]  (default: OFF)
 The perspective bar is displayed at the upper left part of the window (below the toolbar).
[Top Right]  (default: ON)
 The perspective bar is displayed at the upper right part of the window (on the right of the toolbar).

[Show text on the perspective bar]  (default: ON)
 If this check box is selected, a perspective name is also displayed on the perspective bar. If this check box is 

unselected, only the icon is displayed.
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[Show traditional style tabs]  (default: OFF)
 Selecting this check box displays the tabs in the editor and views in an angular style.

[Enable animations]  (default: ON)
 Selecting this check box enables the function to animate fast views to their location when they are closed or 

opened.
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general > Appearance > Colors and fonts

 Set the fonts and colors used in the editor and other windows.

[Colors and Fonts:]
 Specify the items to be displayed in the list. Use the symbols "?" and "*" as wildcards to specify any char-

acter or any string, respectively.

List box
 Color and font settings are listed by category here. Select the color or font you want to change from this 

list.

[Description:]
 Displays a description of the location, etc. in or for which the color or font you selected from the list will be 

used.

[Preview:]
 If available, a display sample of the color or font selected from the list is displayed here.

The buttons described below are displayed when you select a font from the list.

[Use System Font]
 Changes the font you selected from the list to the system font.

[Change...]
 Changes the font selected from the list to a font or font size selected in the [Font] dialog box.

[Reset]
 Restore the changed font to the default font. This button is enabled once a font is changed.

The buttons described below are displayed when you select a color from the list.

Color select button
 Select a new color in the [Color] dialog box.

[Reset]
 Resets the changed color to the default color. This button is enabled once a color is changed.
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general > Editors

Set the items associated with all editing windows.

[Size of recently opened files list:]  (default: four)
 Set the number of recently opened files displayed on the [File] menu.

[Show multiple editor tabs]  (default: ON)
 Choose whether to display multiple tabs at the same time in the editor view.
 If you deselect this check box, only the tab for the foremost document is displayed. In this case, use the 

shortcut menu (>>) located above the tab to select other documents.

[Close editors automatically]  (default: OFF)
 If more than a specified number of editors is open (by default, 8 editors), selecting this check box automati-

cally closes the editors, starting with the oldest.
 If this feature is selected, the [Pin Editor] button appears in the toolbar. Selecting this button (leaving it de-

pressed) will leave the resource open when others are closed automatically. (You can do the same by select-
ing [Pin Editor] from the context menu of the tab.)

 If any file to be closed remains unsaved, a dialog box prompts you to save or discard changes or to choose 
to open an editor that would exceed the limited number of editors.

[Number of opened editors before closing:]  (default: eight)
 Specify the number of resources opened in the editor at which you want the above auto-close feature to be 

enabled. This field is settable when [Close editors automatically] is selected.

[When all editors are dirty or pinned]
 When the auto-close feature is on, specify the processing to be performed when a limited number of editors 

is already open and not all are saved or the "Pin Editor" is selected. This field is settable when [Close edi-
tors automatically] is selected.
[Prompt to save and reuse]  (default: ON)
 Shows a dialog box that allows you to choose to save or not save the file to be closed, or choose to 

newly an editor surpassing the limited number of editors.
[Open new editor]  (default: OFF)
 Opens an editor surpassing the limited number of editors without asking for your confirmation.
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general > Editors > file Associations

Set a file type (file name extension) and the editor used to edit it.

[File types:]
  Lists the file types to be edited in the IDE.

[Associated editors:]
 Lists the editors used to edit the files selected in [File types:]. The editor indicated as the default in paren-

theses is used if you open a file by double-clicking in the [C/C++ Projects] or [Navigator] view. You can 
use another editor on the list by selecting the [Open With] command from the context menu.

[Add...]
 Adds a file type or editor to the list. You can enter or select one in the dialog box that appears when you 

click this button.

[Remove]
 Removes a selected file type or editor from the list box.

[Default]
 Sets the editor selected in [Associated editors:] to the default editor.
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general > Editors > Text Editors

Make settings for the IDE's text editor.

[Displayed tab width:]  (default: four)
 Specify the tab width in number of characters.

[Undo history size:]  (default: 200)
 Specify the number of times to undo the recent operations performed.

[Highlight current line]  (default: ON)
 If this check box is selected, the current line is highlighted while at the same time tinted with a color.

[Show print margin]  (default: OFF)
 If this check box is selected, a vertical line is displayed to indicate a print margin (per-line printable range 

set by [Print margin column:]).

[Print margin column:]  (default: 80)
 Specify the number of characters printed per line.

[Show line numbers]  (default: ON)
 If this check box is selected, a line number is displayed at the beginning of each line.

[Show range indicator]  (default: ON)
 If this check box is selected, the marker bar at the left edge of the editor area will display the range indica-

tor that shows the location of the function or other element being selected in the [Outline] view.
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[Appearance color options:]
 Set the following display colors. Select the item whose display color you want to change from the list, then 

select a color from the dialog box displayed when you click the [Color:] button.
 Line number foreground Line number character color
 Current line highlight Current line highlight color
 Print margin Vertical line color showing a print margin
 Find scope Range of search area
 Selection foreground color Character color* of a selection
 Selection background color Background color* of a selection
 Background color Background color*
 Foreground color Character color*
 Hyperlink Hyper link character color
  * If the [System Default] check box is selected, default settings of the system are applied.
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general > Keys
Set keyboard shortcuts.

Shows the list of shortcut keys.

[Binding]
 A key sequence can be assigned by pressing a key combination.

[When:]
 Selects a location/state in which the command is enabled when assigning the key sequence set with [Binding] 

to the command.

[Export...]
 Saves the contents of the list to a CSV format file.
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general > Search

Make settings related to searches performed with the [Search] menu/button.

[Reuse editors to show matches]  (default: ON)
 If this check box is selected, the same editor is used to show search results. The current file is closed if you 

move to a search position in another file that can be displayed in the same editor.

[Bring Search view to front after search]  (default: ON)
 If this check box is selected, the [Search] view is displayed in front of other views after a search.

[Ignore potential matches]  (default: OFF)
 If this check box is selected, only complete matches for the search text are displayed.
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general > Startup and Shutdown

Make settings related to IDE startup/shutdown.

[Prompt for workspace on startup]  (default: ON)
 If this check box is selected, a dialog box for specifying a workspace directory is displayed on IDE startup.

[Refresh workspace on startup]  (default: OFF)
 If this check box is selected, workspace information is updated to the latest file system status on IDE start-

up.

[Confirm exit when closing last window]  (default: ON)
 If this check box is selected, a dialog box prompting for confirmation is displayed if you click the  (Close) 

button to close the last open IDE window.

[Plug-ins activated on startup:]
 Select plug-ins you want to activate on IDE startup.
 Do not modify this setting.
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general > Workspace

 Make settings for IDE operations.

[Build automatically]  (default: OFF)
 Although this check box is provided to enable or disable the auto-build feature (automatically build a proj-

ect when you save sources you've been editing in the editor), this feature cannot be used in the IDE.

[Refresh automatically]  (default: ON)
 If this check box is selected, resources in the file system are automatically reflected in the [C/C++ Projects] 

and [Navigator] views when added or removed. When this check box is deselected, select [Refresh] from 
the [File] menu or the context menu of the view to update the display of the view.

[Save automatically before build]  (default: ON)
 If this check box is selected, the resources being edited in the editor but not yet saved will be automatically 

saved before a build process is executed.

[Workspace save interval (in minutes):]  (default: five minutes)
 Set the intervals in minutes at which intervals you want the workspace information to be automatically 

saved.

[Open referenced projects when a project is opened]
 Select whether opening a project will also open other projects it references or not. 

[Always]  (default: OFF)
 Referenced projects will always be opened.
[Never]  (default: OFF)
 No other projects will be opened.
[Prompt]  (default: ON)
 A dialog appears to prompt for selection.
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[Text file encoding]
 Set text encoding format.

[Default (*1)] (*1: Cp1252, MS932, etc.; varies with Windows language support)
 This is the standard Windows character set. (default)
[Other:] 
 Select another character encoding.

[New text file line delimiter]
 Select a line delimiter. The selection will take effect for subsequent only. It does not affect the existing files.

[Default]
 The standard Windows line delimiter is used. (default)
[Other:] 
 Select another line delimiter.



S5U1C17001C MANUAl Seiko Epson Corporation 5-207
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

general > Workspace > Build Order

 Define the order in which projects are built.

[Use default build order]  (default: ON)
 If [Build All] (building all the opened projects) is executed when this option is selected, the projects are 

built in the order in which they appear in the [C/C++ Projects] view (in alphabetical order). If this check 
box is deselected, the projects will be built in the order of the list on this page.

[Project build order:] 
 Set the build order in this field when the [Use default build order] check box is deselected.
 The projects will be built from the top of the list. If projects not listed here are opened, they will be built in 

alphabetical order after all projects in this list are built.

[Up] 
 Moves the project selected one position up in the list.

[Down] 
 Moves the project selected one position down in the list.

[Add Project...] 
 Adds a project in the list.

[Max iterations when building with cycles:]  (default: 10)
 Set the maximum number of times to build the projects in the order specified in the list.
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general > Workspace > linked Resources

 

Switch the ON/OFF of the link resource.

 For detailed information, refer to "Linking to a file located outside the project folder" and "Linking to a folder 
located outside the project folder" in Section 5.4.8, "Resource Manipulation in a Project."

[Enable linked resources] (default: ON)
 Disables use of the resource linking function when set to OFF.
 Do not change this setting in normal use.
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general > Workspace > local History

Make settings related to the history of modified resources.

[Days to keep files:]  (default: seven days)
 Set the number of days you want the revision history to be retained.

[Maximum entries per file:]  (default: 50)
 Set the number of entries of revision history retained per file.

[Maximum file size (MB):]  (default: 1MB)
 Set the maximum file size for the file containing revision history entries.
 No history entry will be saved for a file whose size exceed the value set here.

History entries exceeding these limits will be erased. 
Restart the IDE to apply these settings.
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C/C++

Disregard this screen. 
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C/C++ > Build Console

Make settings related to the [Console] view.

[Always clear console before building]  (default: ON)
 Selecting this check box clears [Console] view when you begin building a project.

[Open console when building]  (default: ON)
 Selecting this check box opens the [Console] view when you build a project.

[Bring console to top when building (if present)]  (default: OFF)
 Selecting this check box displays the [Console] view in front of other views (if already open) when you 

build a project.

[Limit console output (# lines):]  (default: 500 lines)
 Specify the maximum number of lines displayed in the [Console] view.

[Display tab width:]  (default: four characters)
 Specify a number of characters for the tab width displayed in the [Console] view.

[Console text color settings]
[Output text color]
 This is the display color for executed command lines.
[Information message text color]
 This is the display color for status messages output by tools.
[Error message text color]
 This is the display color for error messages output by tools.
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●C/C++ > Editor
 Makes settings for the C editor bundled with the IDE.

[General behavior]
 [Smart caret positioning in identifiers] (default: ON)
 Select this checkbox to display a border between words in identifiers.

[Highlight matching brackets] (default: ON)
 If the cursor is placed on a line with parentheses ( ) (or braces { }) with this checkbox selected, the cor-

responding parentheses will be surrounded with a border.
[Highlight inactive code] (default: ON)
 If the cursor is placed on a line with inactive code with this checkbox selected, the inactive code is 

highlighted.
[Appearance color options:]
 Sets the color for characters in comments or keywords. Select the statement type from the list and select 

the desired color using the [Color] button.

[Save Actions]
[Remove trailing whitespace]
 Deletes blank space from the end of line when saving data to a file.
[Ensure newline at end of file]
 Enters a line break at the end of the last line when saving data to a file.

[Documentation tool comments]
 Select the type of documentation tool that determines the editor display and operation. Set editor functions 

such as content assist, color coding, and comment generation based on the tool selected here.

 The settings selected here will be applied to files unrelated to the project or files without project level settings.
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C/C++ > Editor > Content assist

Makes settings for content assist.
Disregard in normal use.

[Insertion]
 Makes settings for the display and insertion of candidates.

[Insert single proposals automatically] (default: ON)
 Select this checkbox to enter the candidate automatically when there is only one candidate.
[Insert common prefixes automatically] (default: ON)
 Select this checkbox to enter common prefixes automatically.

[Sorting and Filtering]
 Makes settings for sorting and filtering.

[Present proposals in alphabetical order] (default: OFF)
 Select this checkbox to list candidates in the content assist list in alphabetical order. Deselect the check-

box to list candidates in order of suitability determined by factors such as relative position, scope, and 
prefix.

[Auto-Activation:]
 Automatically starts up content assist when a symbol (".," "->," "::") is entered.
 To disable this function, deselect the checkbox.

[Enable "." as trigger] (default: ON)
[Enable "->" as trigger] (default: ON)
[Enable "::" as trigger] (default: ON)
[delay (ms)] (default: 500 ms)

 Specify the length of time (in milliseconds ) from the entry of a symbol described above to automatic display of 
the content assist.
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C/C++ > Editor > Content assist > Advanced

Makes advanced settings for the content assist.

[Select the proposal kinds contained in the 'default' content assist list:]
 Select the functions to be included in the content assist as standard functions.

 [Content assist cycling: Select the proposal kinds that are cycled through when repeatedly invoking 
content assist:]
 Select the functions to be added when the content assist is called repeatedly. Select an item and click the [Up] 

or [Down] button to set the priority order of that item.
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C/C++ > Editor > folding

Makes settings for the folding function.

[Enable folding when opening a new editor] (default: OFF)
 Select this checkbox to apply the folding function to the newly opened editor.

[Select folding to use:]
 Select the type of folding function.

[Enable folding of preprocessor branches (#if/#endif)] (default: OFF)
 Select this checkbox to fold preprocessor branches.

[Enable folding of control flow statements (if/else, do/while, for, switch)] (default: OFF)
 Select this checkbox to fold flow control declaration statements.

[Initially fold these region types:]
 Select initially fold types when opening an editor.
 [Macros] (default: ON) Macros
 [Functions] (default: OFF) Functions
 [Methods] (default: OFF) Methods
 [Structures] (default: ON) Structures
 [Comments] (default: OFF) Comments
 [Header Comments] (default: ON) Headers
 [Inactive Preprocessor Branches] (default: ON) Inactive preprocessor branches
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C/C++ > Editor > Hovers

Makes settings for a dialog balloon.

[Enable editor problem annotation] (default: ON)
 Select this checkbox to highlight discovered problems.

[Text Hover key modifier preferences:]
 Select a hot key to activate text hover. For example, positioning the mouse cursor while pressing the [Ctrl] 

key links the target to the original declaration.



S5U1C17001C MANUAl Seiko Epson Corporation 5-217
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

C/C++ > Editor > Mark Occurrences

[Mark occurrences of the selected element in the current file:] (default: ON)
 Select this checkbox to display variables, functions, methods, types, macros, or other component marks.

[Keep marks when the selection changes] (default: ON)
 Select this checkbox to retain marks even if the selection is changed.
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C/C++ > Editor > Scalability

Adjusts the performance of an editor.
 This function restricts editor display functions to prevent degradation of editor performance including highlight 

function when the editor opens a file containing many lines.
This can generally be disregarded in normal use.

[Scalability mode detection]

 [Alert me when scalability mode should be turned on]
 By default, a dialog box opens to issue a warning about editor performance when a file source with 5,000 

lines or more is opened with an editor.

[Scalability mode settings]

[Enable all scalability mode options]
 Enables option for restricting editor functions when a large file is opened.

[Disable editor live parsing]
 Disables the editor live syntax analysis function (also disables outline, highlight, and fold display 

functions).
[Disable semantic highlighting in editor]
 Disables the editor highlighting feature.
[Disable syntax coloring in editor]
 Disables the editor syntax coloring function.
[Disable parsing-based content assist proposal]
 Disables the syntax-analysis-based content assist function.
 [Disable content assist auto-activation]
  Disables the content assist automatic launch function.
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C/C++ > Editor > Syntax Coloring

Makes a highlight setting for syntax.

[Enable semantic highlighting:] (default: ON)
 Select this checkbox to enable color settings.

[Element:]
 Sets colors for characters in comments or keywords. Select the statement type from the list and select the 

desired color using the [Color] button. The following checkboxes will modify character style attributes.
 [Bold] Bold
 [Italic] Italic
 [Strikethough] Strikethrough
 [Underline] Underline

[Preview:]
 Displays a sample to confirm the settings above.
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C/C++ > Editor > Templates

Manages templates entered with the content assist function.

[Create, edit or remove templates:]
 Lists the defined templates in alphabetical order.

[Name]
 This is the template name. The corresponding checkbox indicates whether the template is enabled or 

disabled. The checked templates are enabled and displayed in the content assist list.
[Context]
 Shows a location at which the template can be written. "C" means that the template can be written in a 

C source.
[Description]
 Gives an overview of the template.
[Auto Insert]
 "On" means that the template will be automatically inserted if there is only one candidate.

[Preview:]
 Displays the contents of the template selected in the list.

[New...]
 Displays the [New Template] dialog box, allowing you to create a new template.
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[Edit...]
 Displays the [Edit Template] dialog box, allowing you to edit the template selected in the list.

[New/Edit Template] dialog box

 Use this dialog box to create or edit a template.
[Name:]
 Enter a template name.
[Context:]
 Select context.
[Automatically insert]
 Select whether or not the template will be automatically inserted.
[Description:]
 Enter a template description.
[Pattern:]
 Write a template here.
[Insert Variable...]
 Shows a list of variables, allowing you to insert variables indicating filename, date/time, etc. into the 

template.
[OK]/[Cancel]
 Click [OK] to confirm the entered or edited content. Click [Cancel] to cancel the production or editing 

of the template.

[Remove]
 Removes the template selected in the list.

[Restore Removed]
 Restores the removed template.

[Revert to Default]
 Reverts the templates to default conditions.

[Import...]
 Loads a template definition from a file.

[Export...]
 Writes the contents of the template definition selected in the list to a file. This file can be loaded using the 

[Import...] button.
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C/C++ > Editor > Typing

Makes settings for typing (entering data).

[Automatically close]
 Closes the following items automatically.

["Strings"] (default: ON)
 Select this checkbox to close strings automatically.
[(Parentheses) and [square] brackets] (default: ON)
 Select this checkbox to close parentheses ( ) and brackets [ ] automatically.
[<Angle> brackets] (default: ON)
 Select this checkbox to close angle brackets < > automatically.
[{Braces}] (default: ON)
 Select this checkbox to close braces { } automatically.

[Tabulators]
 Sets the operation of the [Tab] key.

[Tab key indents the current line] (default: ON)
 Select this checkbox to indent lines on which the [Tab] key is pressed.

[When pasting]
 Sets the process to be performed by pasting.

 [Adjust indentation] (default: ON)
 Select this checkbox to adjust indents in the pasted text to the current indent style.

[In string literals]
 Sets processing for strings.

 [Wrap automatically] (default: ON)
 Select this checkbox to wrap strings automatically if they exceed the maximum number of characters per 

line.
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 [Escape text when pasting into a string literal] (default: OFF)
Select this checkbox to enclose special characters in pasted strings with escape characters automati-
cally.

[Automatically indent]
 Sets automatic indentation.

[New lines and braces] (default: ON)
 Select this checkbox to indent new lines and braces { } automatically.

Other setting items
In normal use, disregard the following items. (These items are not discussed in this manual.)

 Environment
 File Types
 Indexer
 Language Mappings
 Make
 New CDT Project Wizard
 Property Pages Settings
 Task Tags
 Template Default Values
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5.10  Additional Description on Dialog Boxes
This section discuss dialog boxes that may require additional description. Not discussed are dialog boxes described 
in the body text, standard Windows dialog boxes and equivalents, and simple confirmation dialog boxes involving 
simply [OK] and [Cancel] buttons.

5.10.1  Properties for Project

This dialog box is used to display properties and change settings for the currently selected project. This dialog box 
appears when you select [Properties] from the [Project] menu or from the context menu for the [C/C++ Projects] 
or [Navigator] view. The 15 categories prepared in the properties list to the left allow you to display the page for a 
category by clicking from a list. The dialog boxes corresponding to each category page are described below.
Also described below are buttons appearing on every page.

[Restore Defaults]
 Restores the content of each page to the state in which the dialog box was opened or the state in which the dia-

log box settings were confirmed with the [Apply] button.

[Apply] *
 Applies the changes and content set on the page. Click [Apply] before proceeding to another page if you want 

to change other properties.

[OK] *
 Applies the changes and content set on the current page and closes the dialog box.

[Cancel]
 Cancels the settings and closes the dialog box. Contents not already confirmed with the [Apply] button before 

canceling do not revert to their former state.

* If you click the [Apply] or [OK] button after settings in a [GNU17 Build Options] or [GNU17 General] page 
have been changed, a dialog box appears for selecting "clean" build (see Section 5.7.8) to delete the files cre-
ated with the previous settings (and rebuild).
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Resource

 Shows the project directory location. You also can set the encoding format and line delimiter for text files such 
as source files.

[Text file encoding]
 Set text encoding format.

[Inherited from container (*1)] (*1: Cp1252, MS932, etc.; varies with Windows language support)
 This is the standard Windows character set. (default)
[Other:]
 Select another character encoding.

[New text file line delimiter]
 Select a line delimiter. The selection will take effect for files to be created subsequently. It does not affect 

the existing files.
[Inherited from container]
 The standard Windows line delimiter is used. (default)
[Other:] 
 Select another line delimiter.
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Builders

 Select the builder for a project.

[GNU17 File Builder]
 Deselect this check box if you do not wish to automatically generate the makefiles and other files needed 

for a build when executing a build process. (Refer to Section 5.7.12, "Using an Original Makefile".) Other-
wise, avoid making any other changes on this page.
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C/C++ Documentation

 Used to select the help documents for the project. No document is used in the IDE.
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C/C++ file Types

 Define the name or extension of the file you want to be handled as a C resource. There is no need to make 
changes if you use only files created in the IDE.

[Use workspace settings]
 Uses settings for file formats shown on the [C/C++] > [File Types] page of the [Preferences] dialog box.

[Use project settings]
 Select this radio button to use a set of file formats specific to a project. Click the [New...] button to add new 

file extensions. You can remove unnecessary extensions and file names by selecting from the list and click-
ing the [Remove] button.
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C/C++ Indexer

 Make settings for the indexer used by C search and content assist. Do not change any of the settings on this 
page.
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C/C++ Include Paths and Symbols

 Define the path by which to search for an include file or the symbol for a preprocessor.
 Once a build is executed, the include directory searched during that process and the macro-definitions passed to 

the preprocessor are added to [Discovered Paths] in the tree list.

Note: For normal use, leave this setting unchanged.
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C/C++ Make Project

 Make settings for the make.exe executable that performs the build process. If you are using original makefiles 
that you created, enter your changes on the page for the [Make Builder] tab. Do not change the pages on other 
tabs.

[Build command]
[Use default]
 Leave this check box unselected if you wish to edit the make.exe command line.
[Build command:]
 Edit the make.exe command line. (Change the makefile to the one you created.)

[Build Setting]
[Stop on first build error.]
 If this is selected, the IDE stops building upon the occurrence of an error. This check box is enabled 

when [Use default] is selected.

[Workbench Build Behavior]
[Build on resource save (Auto Build)]
 Specify the target in the makefile to be called during an auto build. By default, "all" is called. (This 

option is not used with the default IDE settings.)
[Build (Incremental Build)]
 Specify the target in the makefile to be called during a build process. By default, "all" is called.
[Clean]
 Specify the target in the makefile to be called during a clean process. By default, "clean" is called.

[Build Location]
 Although this field is used to specify the working directory during a build, no entry is required here.

 If you are using your own makefiles, you must also edit or make changes on other pages. For more information, 
refer to Section 5.7.12, "Using an Original Makefile".
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C/C++ Project Paths
 Set the source folder. It is not necessary to set parameters in the pages other than [Source] tab.

[Source] tab

 Set the source folder. The source files in the directory set here are written in the makefile used for a build.

[Source folders on build path:]
 This is a list of current source folders. The project directory is listed here by default.

[Add Folder...]
 Adds a source folder to the list.

 The [Source Folder Selection] dialog box is displayed.
 Select a source folder from the tree list, or click the 

[Create New Folder...] button to create a new source 
folder or link an existing source folder present outside 
the project directory.
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[Edit...]
 Enter a file name pattern to exclude certain C resources from a source folder to be rendered as source files 

(files you do not want to include in the makefile).
 Select [Exclusion filter:] for the source directory you want to edit from the source directory tree list and 

click this button. This displays the [Source Folder Exclusion Patterns] dialog box.

 

[Exclusion patterns for <source directory>:]
 Lists the file name patterns by which to exclude certain C resources to be rendered as source files (files 

you do not want to include in the makefile).
[Add...]
 Adds a file name pattern. You can use "?" as a single-character wildcard and "*" as a string wildcard.
 Example: src?.c The "?" can represent any character. (e.g., src1.c or src2.c)
  test.* The extension can be any string. (e.g., test.c or test.s)
[Add Multiple...]
 From the list of files in the source directory displayed here, select the files you want to exclude from the 

source. (Use the [Ctrl] key to make multiple selections.)
[Edit...]
 Edit the file pattern selected from the list.
[Remove]
 Removes the file pattern selected from the list.

[Remove]
 Removes the source directory selected from the list. (The directory is not removed from the file system.)
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gNU17 Build Options
 Set command line options for the compiler, assembler, and linker.

 In a GNU17 project, a build goal (end product of a build) can be selected.

• Build Mask file (psa)
 A mask file is output as an end product after debugging is completed.
 All program data must be placed in ROM.
 The blank areas of ROM will be filled with 0xFF
 Selecting this option will also generate an elf file.

• Build Executable file (elf)
 An elf file, which can be used in debugging during the development process, is output.
 Some program data can be placed in RAM for debugging.
 If this option is selected, a psa file will not be generated.

 "Build Mask file (psa)" is selected by default. However, if "S1C17" is selected as the CPU, "Build Executable 
file (elf)" becomes the fixed setting and cannot be changed.

* If you click the [Apply] or [OK] button after settings in a [GNU17 Build Options] page have been changed, a 
dialog box appears for selecting "clean" build (see Section 5.7.8) to delete the files created with the previous 
settings (and rebuild).

[Build Options] tab > [Compiler] 

 

 Shows the current settings for the compiler options.

[Command:]
 Shows the program name of the C compiler.

[All Options]
 Shows the currently set compiler options.
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[Build Options] tab > [Compiler] > [general]

 

 Use this page to select the basic compiler option.

 [Use Japanese Kanji filter]
 When this option is specified, the IDE converts Shift JIS codes in the source into ASCII escape characters 

before calling the compiler. 
 The default check box status depends on the OS under which the IDE starts up; the check box is set to on 

under an OS with Japanese environment or is set to off under other language versions.
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[Build Options] tab > [Compiler] > [Optimization]

 

 Use this page to select compiler optimization option.

[Optimization Level]
  Select the optimization level (-O0, -O1, -O3).
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[Build Options] tab > [Compiler] > [Directories]

 

 Use this page to set compiler search path options.

[Include Paths (-I)]
 Set the include file search path. The buttons are described below.

 [Add] Adds a directory. Displays a dialog box for entering a path or selecting a path with the 
[File System...] button.

 [Delete] Deletes the path selected in the list.
 [Edit] Edits the path selected in the list. Displays a dialog box for editing the path.
 [Move Up] Moves the path selected one position up in the list. The include files are searched by or-

der of paths in the list, beginning with the uppermost path.
 [Move Down] Moves the path selected one position down in the list.
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[Build Options] tab > [Compiler] > [Symbols]

 

 Use this page to set compiler macro-definition options.

[Defined Symbols (-D)]
 Specify a macro-name and replacement string. The buttons are described below.

 [Add] Adds a macro-definition. In the dialog box displayed for macro-definition entry, enter a 
macro-definition in the following format:

  <macro-name>
  or
  <macro-name>=<replacement string>

 [Delete] Deletes the macro-definition selected in the list.
 [Edit] Edits the macro-definition selected in the list. Displays a dialog box for editing the 

macro-definition.
 [Move Up] Moves the macro-definition selected one position up in the list.
 [Move Down] Moves the macro-definition selected one position down in the list.
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[Build Options] tab > [Compiler] > [Code generation]

 

 Use this page to select compiler code-generation option.

[Do not expand built-in functions inline (-fno-builtin)]
 When this option is specified, built-in functions are ignored for inline expansion and are always called. For 

the functions to which this option applies, refer to Section 6.3.2, "Command-line Options".
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[Build Options] tab > [Compiler] > [Miscellaneous]

 

 Use this page to set other compiler options.

Other flags] (default: -Wall -Werror-implicit-function-declaration)
 Enter other options directly into this text field. Insert one or more spaces between each option. 
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[Build Options] tab > [Assembler] 

 

 Shows the current settings for the assembler options.

[Command:]
 Shows the program name of the compiler*.

[All Options]
 Shows the currently set options.

* In the IDE, the assembler sources are assembled by the C compiler for which -xassembler-with-
cpp option is specified.
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[Build Options] tab > [Assembler] > [general]

 

 The -c, -xassembler-with-cpp, and -Wa,--gstabs options (and -mpointer16 option depending 
on the memory model selected) are always added. Set other assembler options from this page. 

[Other flags]
 Enter the options to be passed to the assembler. Insert one or more spaces between each option.
 The options entered are passed to the assembler as "-Wa,<option>, ...".
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[Build Options] tab > [linker] 

 

 Shows the current settings for the linker options.

[Command:]
 Shows the program name of the linker.

[All Options]
 Shows the currently set options.
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[Build Options] tab > [linker] > [general]

 

 The -Map and -N options are always added. Set other linker options from this page.

[Linker flags]
 Enter other linker options in this text field. Insert one or more spaces between each option.
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[Build Options] tab > [linker] > [libraries]

 

 Use this page to set the libraries to be linked.

[Libraries] (default: libstdio.a, libc.a, libgcc.a, libc.a*)
 Set the libraries to be linked. The buttons are described below.

 [Add] Adds a library. Displays a dialog box for entering a path or selecting one with the [File 
System...] button.

 [Delete] Deletes the selected library in the list.
 [Edit] Edits the selected library in the list. Displays a dialog box for editing the path.
 [Move Up] Moves the selected library one position up in the list. Libraries are linked in order of the 

paths in the list, beginning with the uppermost path.
 [Move Down] Moves the selected library one position down in the list.

 The libraries set here are written in a makefile to link to the objects generated from the sources. However, they 
must be mapped to sections in a linker script file.

* Either the 24-bit libraries or 16-bit libraries are specified by default according to the selected memory model. 
Furthermore, libc.a is specified twice to resolve cross-references between libc.a and libgcc.a.
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[Build Options] tab > [Vector Checker for Copro]

 Displays settings for vector checker options.

 [Command:]
 Displays the name of the vector checker program.

 [All Options]
 Displays the currently set options.
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[Build Options] tab > [Vector Checker for Copro] > [general]

 [Confirm if 'emu_copro_process()' is allocated to vector No.3]
 When using the coprocessor library, select or unselect the checker that verifies whether the 

emu_copro_process interrupt function is allocated to the vector table. 
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[Environments] tab

 Use this page to manage environment variables used for specifying paths in the [Compiler] > [Directories] and 
[Linker] > [Libraries] pages in the [Build Options] tab.

Environment variable list
 Lists the available environment variables and the paths defined. TOOL_DIR is the reserved variable in 

which the gnu17 tool directory is defined, and cannot be edited and removed. 

[New]
 Displays a dialog box to define a new environment variable. 
 Enter a variable name in the [Name:] text box, and the path to be defined in the [Path:] text box on the [New 

Environment Setting] dialog box that appears by clicking this button, then click [OK]. The path may be se-
lected in the dialog box that appears by clicking the [Browse...] button.

 [Edit]
 Displays a dialog box similar to that appeared 

by the [New] button to edit the name and path 
definition of the environment variable that has 
been selected in the list.

[Remove]
 Removes the environment variable selected in 

the list.

Notes: • A path to be entered in the [New Environment Setting] dialog box cannot include characters 
other than single-byte alphanumeric characters, '_', ':', '/' and '\ or \'. Japanese and other two-
byte characters cannot be used.

 • Use the defined environment variables as $(environment variable) format. If an environment 
variable is described in another format, it will not be replaced and an error will occur during a 
build process.
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gNU17 gDB Commands

 This page is used to edit the debugger start up command file for this project. The contents displayed here are 
exactly written to the command file.

[Create commands from template]
 Displays the [Create a simple startup command] dialog box shown below to set the connect mode. The 

command file contents shown in this page reflects the settings in the [Create a simple startup command] 
dialog box.

 Create a simple startup command

[Debugger:]
 Select the debugger (connect mode) to connect to.
 ICD Mini When using an ICD to debug.
 Simulator To debug with a PC only.
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[Boot vector address] (effective only in simulator mode)
 Enter the boot vector address in hexadecimal notation (omit 0x) in the text box when creating a command 

file for simulator mode. The address may be specified in 256-byte increments. The IDE generates a com-
mand file for simulator mode that includes a command for setting this value to the boot vector address. The 
value appeared here by default is the address that was specified when the project was created.

[Ports]
 Selecting ICD Mini or Simulator in [Debugger:] sets the port to USB or NONE, respectively. So no settings 

are required.

[Overwrite]
 Applies the above settings to the command file shown in the [GNU17 GDB Commands] page and closes 

the dialog box. A dialog box appears prompting overwrite, so execution may be canceled even after the but-
ton is clicked. 

[Close]
 Close the dialog box. The command file shown in the [GNU17 GDB Commands] page does not reflect the 

contents changed in the dialog box.

 When you change the target CPU or memory model in the [Properties] > [GNU17 General] page, this dialog 
box is restored to default settings (for ICD Mini). If the CPU has been changed via the [Properties] > [GNU17 
General] page, the CPU boot vector address will be set to [Boot vector address].
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gnU17 flash protect Settings

 Set flash protection.

[Use FLASH Protection]
Selects whether to set the protect bit. (Only with models for which this feature is available.)
 ON: Creates the file "<project name>_ptd.psa" in which flash protection information was written at the  

 build  time. This enables detailed settings to be made from the protection setting address list.
 OFF: Does not use flash protection.

note: The flash protection setting may not be available with certain models. For more information, refer 
to the technical manual for the device.

[Protect bits setting for:]
 Displays the currently selected S1C17 core processor type.

Protection setting address list
 Lists the addresses for which flash protection can be set, together with protection on/off settings.

[Address]
 Displays start and finish addresses for flash protection.

[Read Protect]
 Sets read protection for the applicable addresses using the checkbox.
 Read protection prevents data from being read from the address set.
 On: Protected
 Off: Not protected

[Write Protect]
 Sets write protection for the applicable addresses using the checkbox.
 Write protection prevents data from being written to the address set.
 On: Protected
 Off: Not protected

 For more information on setting flash protection, refer to section 5.7.9 "Flash Protection Settings."
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gNU17 general

 Select the target processor and memory model.

[Target CPU Device]
 Shows processor types.

 

[Memory Model]
 Select a memory model.

 REGULAR: 24 bits (Up to 16M-byte space can be used.)
MIDDLE: 20 bits (Up to 1M-byte space can be used.)
SMALL: 16 bits (Up to 64K-byte space can be used.)

[Co-processor Library]
 Select whether to link libraries for coprocessors (only for models permitting this selection).

 

ON： Adds the setting to link the coprocessor library libgccMD.a (for multiplication and division) or lib-
gccM.a (for multiplication) when creating a project. 

 If you select this option, select the library type from the [Select the Co-processor library type] com-
bo box. (Certain models offer just one selection option.)

OFF： Adds the setting to link the ordinary emulation library libgcc.a when creating a project.

 For models for which this checkbox cannot be selected, the setting to link the ordinary emulation library 
libgcc.a will be added when creating a project.
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* If you click the [Apply] or [OK] button after settings in this page have been changed, a dialog box appears for 
selecting "clean" build (see Section 5.7.8) to delete the files created with the previous settings (and rebuild).
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gNU17 linker Script Settings

 Edit a linker script.

 Section list
 Shows the configuration and location of sections in an executable file (.elf). Information displayed in blue 

is standard sections defined by default and others displayed in black is user defined sections. To edit the 
section name, standard section attribute, address to locate, and objects to be located, a user section should 
be created. The standard section allows the user to specify the location address only, and objects are auto-
matically located except those are located in the user sections with the same attribute.

[VMA]
 Shows the position (start address) at which a section is placed when it is executed. A section whose ad-

dress is not written in the VMA will be located at an address following the immediately preceding sec-
tion.

[LMA]
 Shows the position in a ROM (start address) at which the actual data is placed. "-" means the same 

as the VMA (i.e., a section will be executed or accessed from the position at which its actual data is 
placed). A description "after (<section name>)" means that the actual data for a section will be located 
following another section indicated in (  ).

[Section name]
 Indicates the section name.
[Labels]
 Shows labels indicating the start and the end addresses of the area in which a section will be located. 

When a LMA is not specified, two labels are displayed. When a LMA is specified, four labels for the 
start/end VMA addresses and the start/end LMA addresses are displayed, in that order. These labels can 
be used to specify the address in a source file — for example, when a section is copied from ROM to 
RAM. The label names are generated automatically from section names.
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[Add]
 Adds section information.

[Edit]
 Edits the section information selected in the list.

[Delete]
 Deletes the section information selected in the list.

[Set stack pointer address]
 This forms the value for the linker script file _START_stack symbol and sets the symbol as the stack area 

start address.

 For more information on how to edit a linker script, refer to Section 5.7.8, "Editing a Linker Script".
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gNU17 Parameter Settings

 Edit the parameter file used in the debugger.

[Comment:]
 You can enter any comments (up to 255 characters) here. The comments entered here are written to the pa-

rameter file.

Area list
 Shows information for one area per line. Information is listed in alphabetical order, except that all stack 

area information is displayed at the bottom of the list.

[Type]
 Shows the area type (ROM, RAM, IO, or STACK).
[Start-End Address]
 Shows the start and the end addresses of the area in hexadecimal notation.
[Wait R/W]
 The first two-digit value shows the number of wait states during a read cycle (first digit) and the number 

of wait states during a write cycle (second digit), respectively. The words "byte" (8 bits), "halfword" (16 
bits), and "word" (32 bits) indicate the access size by which the area is accessed. If the rest is blank, the 
area is accessed in little endian mode. The areas set for big endian are marked by "Big".

[Comments]
 Shows the comment entered in each area information. You do not need to enter the symbol "#" to indi-

cate the start of a comment.

[Add]
 Adds area information.

[Edit]
 Edits the area information selected in the list.

[Delete]
 Deletes the area information selected in the list.

 For more information on how to edit a parameter file, refer to Section 5.8.1, "Generating a Parameter File".
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Project References

 Select the project to be referenced.

[Project references for sample:]
 Select the other projects to be referenced by the current project.
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5.10.2  Save Resources

This dialog box is displayed if you attempted to close multiple documents before saving the document being edited 
in the editor.

File check boxes
 Select the check box corresponding to the file you want to save.

[Select All]
 Selects check boxes for all files.

[Deselect All]
 Deselects check boxes for all files.

[OK]
 Closes the documents in the editor after saving the selected files.

[Cancel]
 Cancels the action invoking the dialog box. The documents are neither saved nor closed.
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5.10.3  Import > file system

This dialog box is displayed if you select [File system] in the [Import] dialog box and click the [Next>] button to 
import a file or directory.

[From directory:]
 Enter a path to the parent directory for the file or directory to be imported, or select one from the list displayed by 

clicking the [Browse...] button.

Directory list (box to the left)
 Lists the subdirectories hierarchically subordinate to the directory selected in [From directory:].
 To import a directory, select one from this list.
 To import a file, select the parent directory containing it.

File list (box to the right)
 Lists the files present in the directory selected in the directory list. Use this list to select the file you want to im-

port.

[Filter Types...]
 Allows you to restrict the import to a subset of the files selected in the file list by specifying a file format (file 

name extension).
 Select a file name extension from the dialog box by clicking this button. Files other than the selected file for-

mats will be deselected.

[Select All]
 Selects all files displayed in the list box.

[Deselect All]
 Deselects all files displayed in the list box.
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[Into folder:]
 Shows the project or directory selected in the [C/C++ Projects] or [Navigator] view. To import the selected file 

or directory into another project or directory, click the [Browse...] button and select from the ensuing dialog 
box.

[Overwrite existing resources without warning]
 If this check box is selected, any files or directories at the import destination having the same name are over-

written without warning. If this check box is unselected (default), you will be prompted to confirm that you 
want to overwrite the files in question.

[Create complete folder structure]
 Selecting this radio button imports the entire directory, including the directory structure of the file system (a 

tree structure from the root of the selected directory).

[Create selected folders only]
 If this radio button is selected, only the directory you selected is imported. No directory structures are imported.
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5.10.4  Export > file system

This dialog box appears if you select [File system] in the [Export] dialog box and click the [Next>] button to export 
a file or directory.

Directory list (left-side box)
 Lists the subdirectories hierarchically subordinate to the project directory.
 To export a directory, select one from this list.
 To export a file, select the parent directory that contains it.

File list (right-side box)
 Lists the files currently in the directory selected from the directory list. Use this list to select the file you want 

to export.

[File Types...]
 Allows you to export a subset of the files selected in the file list by specifying a file format (file name exten-

sion).
 Select a file name extension from the dialog box by clicking this button. All files of a different file format are 

deselected.

[Select All]
 Selects all directories and files displayed in the list box.

[Deselect All]
 Deselects all directories and files displayed in the list box.

[Overwrite existing files without warning]
 If this check box is selected, any files or directories at the export destination having the same name are over-

written without warning. If this check box is unselected (default), you will be prompted to confirm that you 
want to overwrite the files in question.
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[Create directory structure for files]
 Selecting this radio button exports the entire file or directory, including the directory structure of the file system 

(a tree structure from the project directory).

[Create only selected directories]
 If this radio button is selected, only the directory you selected is exported. The directory structure of the project 

is not exported.



S5U1C17001C MANUAl Seiko Epson Corporation 5-263
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

5  gNU17 IDE

5
IDE

5.10.5  filters

To display this dialog box, select [Configure Contents] on the View menu (▽) of the [Problems], [Bookmarks], or 
[Tasks] view. If there are too many items in list view, you can limit the target or number of resources displayed in 
the list by setting filter parameters here.

[Configurations:]
 Displays a list of filters that have been set. Use each checkbox to select whether to apply the filter.
 To modify filter conditions, select a filter name from this list and select the corresponding conditions.
 If two or more filters are selected, all filter conditions will be ORed.

[New]
 Creates a new filter. Enter the filter name in the [Add New Filter] dialog box displayed to add it to the [Configu-

ration:] list. Select the filter in the list and set conditions.

[Remove]
 Removes the filters selected in the [User filters:] list.

[On any element]
 All resources in the opened projects are displayed.

[On any element in same project]
 Only resources in the same project as the resources currently active in the editor or the resources selected in the 

[C/C++ Projects] or [Navigator] view are displayed.

[On selected element only]
 Only resources currently active in the editor or resources selected in the [C/C++ Projects] or [Navigator] view 

are displayed.
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[On selected element and its children]
 Only resources in the directory selected in the [C/C++ Projects] or [Navigator] view are displayed.

[On working set:]
 Only resources in a specified working set are displayed.

[Select...]
 Selects the working set displayed if you selected [On working set:].

[[Completed] ([Tasks] view only)
 [Completed] Displays only completed tasks.
 [Not Completed] Displays only incomplete tasks.

[Priority] ([Tasks] view only)
 Select to restrict the display based on task priority level. Specify the priority of items to be displayed by select-

ing the desired checkbox (High, Normal, or Low).

[Description]
contains  Only items containing the string entered in the text box will be displayed in [Description].
doesn't contain Only items that do not contain the string entered in the text box will be displayed in [De-

scription].
    To disable this restriction, leave this text box blank.
[Where severity is:] ([Problems] view only)
 Select to restrict the display based on error criticality. Specify the display content (Error, Warning, or Info) by 

selecting the desired checkbox.

[Types] ([Problems] view and [Tasks] view only)
 Select the type of list to be displayed to a specific view.

[Select All] Selects all items displayed in [Types].
[Deselect All] Deselects all items displayed in [Types].

[OK]
 Begins filtering with the set conditions.

[Cancel]
 Cancels filter settings.
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5.11  files generated in a Project by the IDE

Table 5.11.1  List of files generated by the IDE

Filename File type Editing
File 

management 
required

.project IDE project file × ○

.cproject IDE project file (CDT) × ○

.cdtproject IDE project file (CDT)
Project created in GNU17 v1.3.0 or before

× ○

.gnu17project IDE project file (GNU17) × ○
GDB17 Debugger for <project name>.
launch

GDB launch setting file × ○

<project name>_gnu17IDE.cmd GDB command file ○ *1 ○
\.settings Project settings directory × ○
\.externalToolBuilders Project settings directory (builder) × ○
<project name>_gnu17IDE.mak Makefile × ×
<project name>_gnu17IDE.lds Linker script file × ×
<project name>_gnu17IDE.par Parameter file × ×
<project name> .elf Executable file × ×
<project name> .map Map file × ×
<project name> .dump Symbol file for two-pass make × ×
<source filename> .d Dependency file for makefile × ×
<source filename> .o Object file × ×
<source filename> .ext0 Assembler source file for two-pass make × ×
<project name> .sa S3 file generated based on the executable file × ×
<project name> .saf File generated by filling open areas in the S3 

file with 0xFF
× ×

<project name> .psa ROM data HEX file × ×
symtable.out Symbol table file for vector checker × ×
raw.out Data file for vector checker × ×
protect.cmd Flash protection setting command file × ×
<project name>_ptd.psa Protected ROM data HEX file × ×
*1: Can be edited using an editor only when the [Properties] dialog box for the project is closed.

The files in the "File management required" column must be managed using a source management application.
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 This chapter explains how to use the xgcc C compiler, and provides details on interfacing with the assembly 
source. For information about the standard functions of the C compiler and the syntax of the C source programs, 
refer to the ANSI C literature generally available on the market.

6.1  functions
The xgcc C compiler compiles C source files to generate an assembly source file that includes S1C17 Core 
instruction set mnemonics, extended instructions, and assembler directives. The xgcc is a gnu C compiler in 
conformity with an ANSI standard. Since special syntax is not supported, the programs developed for other types of 
microcomputers can be transplanted easily to the S1C17 Family. 
Furthermore, since this C compiler has a powerful optimizing capability that allows it to generate a very compact 
code, it is best suited to developing embedded applications.
This C compiler consists of three files: xgcc.exe, cpp.exe and cc1.exe.
The xgcc is based on the C compiler of Free Software Foundation, Inc. Details about the license of this compiler 
are written in the text file "Copying GNU", therefore, be sure to read this file before using the compiler.

This C compiler has passed the compiler evaluation provided as a service by Japan Novel Corporation.
Of bugs detected during the evaluation, those violating C compiler restrictions are described in "\gnu17\doc\
release_history_j.pdf" and Section 6.7, "Known Issues." Refer to these documents for detailed information.

6.2  Input/Output files

C compiler
xgcc -S

file.sAssembly
source files

as assembler

C compiler
xgcc -c

file.c

file.o

C source files

file.c

C source files

Object files

ld linker
Figure 6.2.1  Flowchart

6.2.1  Input file
C source file

File format: Text file
File name: <filename>.c
Description: File in which the C source program is described.

6.2.2  Output files
Assembly source file

File format: Text file
File name: <filename>.s
Description: An assembly source file to be input to the as assembler. This file is generated when the -S option 

is specified.
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Object file
File format: Binary file
File name: <filename>.o
Description: A relocatable object file to be input to the ld linker. This file is generated when the -c option is 

specified. 

Note: The xgcc C compiler generates an elf format executable object file or preprocessed source file 
according to the option specified.

6.3  Starting Method

6.3.1  Startup format

To invoke the xgcc C compiler, use the command shown below. 

xgcc <options> <filename>

 <options> See Section 6.3.2.
 <filename> Specify C source file name(s) including the extension (.c).

6.3.2  Command-line Options

The compiler provided in this package formally supports the command line options described below.
All other command line options lie beyond the scope of the performance guarantee, and use thereof is solely the 
user's responsibility. 

-c

Function: Output relocatable object file
Description: This option is used to output a relocatable object file (<input file name>.o). When this option is 

specified, the xgcc C compiler stops processing after the stage of assembly has finished and does 
not link. Do not specify the -S or -E option simultaneously when this option is used.

Default: The xgcc C compiler generates the elf executable object file.

-S

Function: Output assembly code
Description: This option is used to output an assembly source file (<input file name>.s). When this option is 

specified, the xgcc C/C++ compiler stops processing after the stage of compilation has finished 
and does not assemble the compiled code. The basic make files generated by the IDE use this 
option for the C/C++ compiler xgcc launch command. Do not specify the -c or -E option 
simultaneously when this option is used.

Default: The xgcc C compiler generates the elf executable object file.

-E

Function: Execute C preprocessor only
Description: When this option is specified, the xgcc C compiler stops processing after the stage of 

preprocessing has finished and does not compile or assemble the preprocessed code. The results 
are output to the standard output device. Do not specify the -S or -c option simultaneously when 
this option is used.

Default: The xgcc C compiler generates the elf executable object file.

-B<directory>

Function: Specify compiler search path
Description: This option is used to add the <directory> to the search paths of the xgcc C compiler.
 Input <directory> immediately after -B. Multiple directories can be specified. In this case, input 

as many instances of -B<directory> as necessary. The sub-programs (cpp, cc1, etc.) and other 
data files of the compiler itself are searched in the order they appear in the command line.

 File search is performed in order of priorities, i.e., current directory, -B option, and PATH in that 
order.
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Default: The xgcc C compiler searches sub-programs in the current directory and the PATH directory.

-I<directory>

Function: Specify include file directory
Description: This option is used to specify the directory that contains the files included in the C source.
 Input <directory> immediately after -I. Multiple directories can be specified. In this case, input 

as many instances of -I<directory> as necessary. The include files are searched in the order they 
appear in the command line.

 If the directory is registered in environment variable C_INCLUDE_PATH, the -I option is 
unnecessary.

 File search is performed in order of priorities, i.e., current directory, -I option, and 
C_INCLUDE_PATH in that order.

Default: The xgcc C compiler searches include files in the current directory and the C_INCLUDE_PATH 
directory.

-D<macro name>[=<replacement character>]

Function: Define macro name
Description: This option functions in the same way as #define. If there is =<replacement character> 

specified, define its value in the macro. If not specified, the value of the macro is set to 1.
 Input <macro name>[=<replacement character>] immediately after -D. Multiple macro names 

can be specified. In this case, input as many instances of  -D<macro name>[=<replacement char-
acter>] as necessary. 

 * About automatic generation of macro names 
 The macro names listed below are automatically defined during compilation. These macro 

names can be referenced from any source file. Note, however, that the same macro names 
cannot be used for macro definitions in the user program.

Macro name Contents
__c17 Indicates that the source was compiled for S1C17 processors. 
__INT__ Indicates the data size of int type variables (16). 
__POINTER24 Indicates that the source was compiled without the -mpointer16 

compile option specified.
__POINTER16 Indicates that the source was compiled with the -mpointer16 com-

pile option specified.
__LONG_OFFSET Indicates that the source was compiled without the -mshort-offset 

compile option specified.
__SHORT_OFFSET Indicates that the source was compiled with the -mshort-offset 

compile option specified.

-O0,-O,-O3

Function: Optimization
Description: Specify one of the switches, then optimize.
 The code generated is optimized by prioritizing speed and size. When the -O3 option is specified, 

optimization prioritizes speed only.
 The larger the number following "-O", the stronger the optimization applied. However, keep 

in mind that large values may generate issues, such as failure to output parts of the debug 
information.

 Reduce this value if the optimization cannot be executed properly. Register interlocks are ignored 
during optimization. Since the -O3 option is designed to optimize speed, size in certain cases can 
grow larger than that resulting from the use of the -O option. In ordinary cases, we recommend 
using -O when compiling.

 Basic makefiles created by the IDE use the -O option as the startup command for xgcc C compiler.
 The characteristics of each option are described below.
 -O0

 No optimization performed.
 An area is secured in the stack even if an unused local variable is declared.
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 Code is compiled unchanged, generating unnecessary code as well, including code that assigns 
values to local variables that are never referenced. While the values of the variables loaded in 
registers will not be reused, local variables that are declared as registered will be optimized 
and deleted, as needed.

 -O/-O1

 Code size and execution speed optimized
 The optimization performed here includes the following processes:
 Unnecessary code is deleted (e.g., code that assigns a value to a never-referenced local 

variable). 
 Variable processing is assigned with a register, and the value of this register is reused to reduce 

memory read/write counts. However, since this removes guaranteed memory access, variables 
that require fail-proof read/writes to memory must be declared as volatile.

 Loop process optimization is performed. Optimization based on predicting branch conditions 
prevents repetition of duplicate compare instructions.

 -O3

 This setting optimizes code execution speed more effectively than the -O option, resulting in 
the following differences with respect to the -O option:

 Common computation processes in the global region are replaced by single computation 
(common equations in the global region are deleted). Loop process optimization is performed 
twice.

 Register allocation is optimized for operands for simple commands (e.g., Id).
 Branch condition blocks without attainable destinations are ignored; no code is generated.
 Functions lacking inline declarations are expanded inline. The subroutine of a simple code 

copies the code of the function itself rather than calling a function, eliminating the overhead 
associated with a function call.

 Depending on the source code, the -O3 option may not result in the fastest execution speed in 
certain cases.

 Avoid using the -O2 or -Os options, which are not supported.
Default: Code optimization is performed.

-gstabs

Function: Add debugging information with relative path to source files
Description: This option is used to creates an output file containing debugging information.
 The source file location information is output as a relative path. The basic make file generated by 

the IDE specifies this option when invoking the xgcc C compiler.
Default: No debugging information is output.

-fno-builtin

Function: Disable built-in functions 
Description: The functions listed below are always called, not compiled as built-in functions. If this option is 

not specified, the compiler will expand the following functions inline or replace them with other 
functions make code generation more efficient, depending on circumstances.

 abort, abs, cos, exit, exp, fabs, fprintf, fputs, labs, log, memcmp, memcpy, 
memset, printf, putchar, puts, scanf, sin, sprintf, sqrt, sscanf, strcat, 
strchr, strcmp, strcpy, strcspn, strlen, strncat, strncmp, strncpy, 
strpbrk, strrchr, strspn, strstr, vprintf, vsprintf

Default: The built-in functions are enabled.

-mpointer16

Function: Generate code for 16-bit (64KB) data space
Description: This option is used to generate codes that use 16-bit data pointers (the data space is limited up to 

64KB).
 This option allows the user program to reduce the RAM size for storing static variable pointers. 

However, the stack size cannot be reduced by this option.
Default: The C compiler generates the object that allows data to be located in the 24-bit (16MB) space.

-mshort-offset
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Function: Generate code for 20-bit (1MB) space
Description: This option is used to generate codes in which the data space and branch address range are limited to 

20-bit (1MB space).
 When this option is specified, the C compiler uses only one ext instruction for extending the 

immediate data in the data access/branch instructions to reduce code size. This limits the range of 
data accessing and conditional branching to a 1MB space. However, the call and jpr branch 
instructions are not limited to 1MB, as one ext instruction extends them to branch within a 24-bit 
range. This option is useful to reduce code size for applications of which the program and data can be 
located in a 1MB space. The C compiler always output ‘s’ extended instructions (sld, sjreq, etc.), 
not ‘x’ extended instructions (xld, xjreq, etc.).

Default: The C compiler generates objects that allow data/program to be located in the 24-bit (16MB) 
space.

Table 6.3.2.1  -mpointer16 and -mshort-offset option settings

Option

Data/Program space

24 bits (16MB) *1

Code is generated with a 24-
bit data pointer

20 bits (1MB) *1

Code is generated with a 24-
bit data pointer

16 bits (64KB) *2

Code is generated with a 16-
bit data pointer

Use entire space Reduce code size Reduce code and RAM size

-mpointer16 Do not specify (default) Do not specify (default) Specify *3

-mshort-offset Do not specify (default) Specify Specify *3

*1 Use the ANSI C and emulation libraries for 24-bit memory model (located in \lib\24bit).
*2 Use the ANSI C and emulation libraries for 16-bit memory model (located in \lib\16bit).
*3 Use the -mpointer16 option in conjunction with the -mshort-offset option.

-Wall

Function: Enables warning option
Description: This function enables all of the following warning options.
  These warning options can be individually disabled by adding "-Wno-." For example, to disable 

just the "-Wcomment" warning, add "-Wno-comment" after "-Wall."

 -Wchar-subscripts 

 Outputs a warning when the subscript of an array is of the type "char."

 -Wcomment

 Outputs a warning when "/*" the starting character string for a comment line occurs inside a 
comment beginning with "/*." Also outputs a warning when a comment starting with "//" ends 
with a backslash.

 -Wformat

 Checks whether the argument is appropriate for a converted character string when the printf or 
scanf function is invoked. Also checks whether the conversion specified by the converted character 
string is appropriate.

 -Wimplicit-int

 Outputs a warning if a format is not specified when a variable or function is declared.

 -Wimplicit-function-declaration

 Outputs a warning when a function is used before declaration.

 -Wimplicit

 Same as "-Wimplicit-int" and "-Wimplicit-function-declaration" in enabled 
state.

 -Wmain 

 Outputs a warning when the format of the main function is incorrect. The main function has an 
external linkage and the return value is in int format. It should have 0, 2, or 3 arguments of the 
appropriate format.

 -Wmissing-braces 

 Outputs a warning when parentheses are used incorrectly during initialization of arrays. For 
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example, when a multidimensional array is initialized, a warning is output if parentheses are not 
used correctly for each dimension.

 Example: long l_Array_1[3][3] = { 0, 1, 2, 3, 4, 5, 6, 7, 8 }; 
  (Warning is output.)

  long l _ Array _ 2[3][3] = { { 0, 1, 2 }, { 3, 4, 5 }, { 6, 7, 8 } };

  (No warning is output.)

 -Wparentheses

 Outputs a warning when omission of parentheses results in ambiguities in the description. For 
example, a warning is output if "{ }" are omitted from a nested if statement.

 -Wsequence-point

 Outputs a warning in the case of the standard C language specification if a code described might 
result in undefined behavior due to the absence of an accurate execution sequence indication.

 Example: i_Array[i_Val++] = i_Val;

 -Wreturn-type

 Outputs a warning when the return value format is defined as the default "int" format since it is 
not specified when the function was defined. Also outputs a warning when no value is returned 
when the return value is a function other than the void type.

 -Wswitch

 Outputs a warning when case statements do not exist for all enum values when the switch 
statement uses a variable of the enum type for the index. (If a default label exists, this warning is 
not output.) Also outputs a warning when a case statement specifies a value outside the range of 
enum type.

 -Wunused-function

 Outputs a warning when a static function is declared but not defined. Also outputs a warning when 
a static function that is not inline is defined but not used.

 -Wunused-label

 Outputs a warning when a label is declared but not used.

 -Wunused-variable 

 Outputs a warning when a static variable other than local variable or const is declared but not 
used.

 -Wunused-value 

 Outputs a warning when a calculation is performed even though the calculation result clearly will 
not be used.

 -Wunused 

 Same as all "-Wunused-xxxx" above in the enabled state.

 -Wuninitialized 

 Outputs a warning when a local variable is used without initialization. This warning is not output 
when -O0 is selected.

Default: The above warning options are disabled.

-Werror-implicit-function-declaration

Function: Error output for undeclared functions
Description: This outputs an error if an undeclared function is used in a C source file.
Default: An error is not output even if an undeclared function is used in a C source file.
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-mno-sjis-filt

Function:  Disable the filter function for the Shift JIS code
Description:  This option disables the filter function for the Shift JIS code.
 For detailed information on this filter function, refer to Section 6.5, "Filter Function for Shift JIS 

Code."
Default:  The preprocessor performs filtering for Shift JIS code.

-xassembler-with-cpp

Function: Invoking C preprocessor 
Description: When this option is specified, the cpp C preprocessor will be executed before the source is 

assembled. This allows assembly sources to include preprocessor instructions (#define, #in-
clude, etc.).

Default: The C preprocessor is not invoked.

-Wa,<option>

Function: Specify an assembler option
Description: The specified option will be passed to the assembler. To specify two or more options, input as 

many instances of -Wa,<option> as necessary.
Default: No option will be passed to the assembler.

When entering options in the command line, you need to place one or more spaces before and after the option. 
Example:  xgcc -c -gstabs test.c

Notes: • Be aware that the compile processing will be unsteady if the same compiler option is specified 
twice or more with different settings.

 • Be sure to specify one of the -S, -E or -c options when invoking xgcc. If none are specified, 
xgcc continues processing until the linkage stage. Note, however, that necessary linker 
options cannot be specified in this case.

 • Generate all the objects to be linked using the same -mpointer16 and -mshort-offset 
option combination in compiling and assembling. Objects that were generated with different 
option specifications may not be linked normally.

    Example of compiling:
         xgcc -B$(TOOL_DIR)/ -c -O -gstabs -fno-builtin -I$(TOOL_DIR)/in-

clude -mpointer16 -mshort-offset main.c

 When the -c option is specified, the -mpointer16 option will also be passed to the 
assembler.

    Example of assembling:
 xgcc -B$(TOOL_DIR)/ -c -xassembler-with-cpp -Wa,--gstabs 
 -Wa,-mpointer16  boot.s

 After boot.s is processed in the preprocessor, it will be assembled with the -mpointer16 
option specified.
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6.4  Compiler Output
This section explains the assembly sources output by the xgcc C compiler and the registers used by the xgcc.

6.4.1  Output Contents 

After compiling C sources, the xgcc C compiler outputs the following contents:
• S1C17 Core instruction set mnemonics
• Extended instruction mnemonics
• Assembler directives

All but the basic instructions are output using extended instructions.

Since the system control instructions cannot be expressed in the C source, use in-line assemble by asm or an 
assembly source file to process them. 
Example:  asm("halt");

Assembler directives are output for section and data definitions. 
The following describes the sections where instructions and data are set.

Instructions
 All instructions are located in the .text section.

Constants
 Constants are located in the .rodata section.
 Example: const int i=1;  .global i
       .section .rodata

       .align 2

       .type  i,@object

       .size  i,4

           i:

       .long  1

global and static variables with initial values 
 These variables are located in the .data section.
 Example: int i=1;   .global i
       .section .data

       .align 2

       .type  i,@object

       .size  i,4

           i:

       .long  1

global and static variables without initial values
 These variables are located in the .bss section.
 Example: int  i;   .global i
       .section .bss

       .align 2

       .type  i,@object

       .size  i,4

           i:

       .zero  4

For all symbols including function names and labels, symbol information by the .stab assembler directive is 
inserted (when the -gstabs option is specified).
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6.4.2  Data Representation

The xgcc C compiler supports all data types under ANSI C. Table 6.4.2.1 below lists the size of each type (in bytes) 
and the effective range of numeric values that can be expressed in each type.

Table 6.4.2.1  Data type and size
Data type Size Effective range of a number

char 1 -128 to 127
unsigned char 1 0 to 255
short 2 -32768 to 32767
unsigned short 2 0 to 65535
int 2 -32768 to 32767
unsigned int 2 0 to 65535
long 4 -2147483648 to 2147483647
unsigned long 4 0 to 4294967295
pointer 4 0 to 16777215
float 4 1.175e-38 to 3.403e+38 (normalized number)
double 8 2.225e-308 to 1.798e+308 (normalized number)
long long 8 -9223372036854775808 to 9223372036854775807
unsigned long long 8 0 to 18446744073709551615
wchar_t 2 0 to 65535

The float and double types conform to the IEEE standard format.

Handling of long long-type constants requires the suffix LL or ll (long long type) or ULL or ull (un-
signed long long type). If this suffix is not present, a warning is generated, since the compiler may not be 
able to recognize long long-type constants as such.
Example: long long  ll_val;
  ll_val = 0x1234567812345678;
   → warning: integer constant is too large for "long" type
  ll_val = 0x1234567812345678LL;
   → OK

Type wchar_t is the data type needed to handle wide characters. This data type is defined in stdlib.h/std-
def.h as the type unsigned short. 

Store positions in memory
 The positions in the memory where data is stored depend on the data type. The short and int type variables 

are aligned at 2-byte boundary addresses, and the long and double type variables are aligned at 4-byte 
boundary addresses. 

Structure data 
 Structure data is located in the memory beginning with a 4-byte boundary address. Members are located in the 

memory according to the size of each data type in the order they are defined.
 The following shows an example of how structure is defined, and where it is located.
 Example: struct Sample {
    char  cData;
    short  sData;
    char  cArray[3];
    long  lData;
   };

Low memory +0 +1 +2 +3
cDataStart address Unused

cArray[3]
lData+8

+4
+0

Unused
sData

Figure 6.4.2.1  Sample locations of structure data in the memory 

 As shown in the diagram above, some unused areas may remain in the memory depending on the data type of a 
member.

 C language specifications permit implementation-defined adjustment of the method of configuring member 
variables of a structure or union.
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 The C compiler in this package is adjusted to yield even-number bytes for the size of a structure or union as an 
implementation defined feature.

Accessing bit fields
 Bit fields with an 8-bit or less bit width will be accessed in byte size as shown below due to the compiler 

optimization processing even if the bit field is defined as an unsigned short type. Take this into 
consideration when accessing a device or I/O memory that needs to be accessed in 16-bit size.

 Program
  struct IFtag {

   volatile union {

    volatile struct {

     unsigned short  DATA    : 1;        /* 1bit */

     unsigned short  Dummy   : 15;

    } bCTL;

    unsigned short  usCTL;

   } rOUT;

  };

  struct g_GAtag {

   volatile struct IFtag       g_IF;

  };

  volatile struct g_GAtag *pg_GAtag;

  main()

  {

   pg_GAtag = (struct g_GAtag *)0x8300;

   pg_GAtag->g_IF.rOUT.bCTL.DATA = 1; (*)
   return;

  }

 Code compiled from the source line (*) 
  pg_GAtag->g_IF.rOUT.bCTL.DATA = 1;

  ld.b    %r3,[%r2]     ; Byte access
  or      %r3,0x1       

  ld.b    [%r2],%r3     ; Byte access
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6.4.3  Method of Using Registers

The following shows how the xgcc C compiler uses general-purpose registers.

Table 6.4.3.1  Method of using general-purpose registers by xgcc
Register Method of use

%r0 Register for passing argument (1st word)
Register for storing returned values (8/16-bit data, pointer, 16 low-order bits of 32-bit data)

%r1 Register for passing argument (2nd word)
Register for storing returned values (16 high-order bits of 32-bit data)

%r2 Register for passing argument (3rd word)
%r3 Register for passing argument (4th word)
%r4 Registers that need have to their values saved when calling a function
%r5
%r6
%r7

Registers for passing arguments (%r0 to %r3)
 These registers are used to store arguments when calling a function. Arguments exceeding four words are stored 

in the stack before being passed. They are used as scratch registers before storing arguments.

 %r0 ← First argument
 %r1 ← Second argument
 %r2 ← Third argument
 %r3 ← Fourth argument

 A pair of the registers is used to store a 32-bit (long) argument.
 %r1 (high-order 16 bits) and %r0 (low-order 16 bits) 
 %r3 (high-order 16 bits) and %r2 (low-order 16 bits)

 Examples:
• First argument: long, second argument: long 
 foo( long lData1, long lData2 );

 %r0 ← lData1 (low-order 16 bits)
 %r1 ← lData1 (high-order 16 bits)
 %r2 ← lData2 (low-order 16 bits)
 %r3 ← lData2 (high-order 16 bits)

• First argument: short, second argument: long 
 foo( short sData, long lData );

 %r0 ← sData (16 bits) 
 %r1 Unused
 %r2 ← lData (low-order 16 bits)
 %r3 ← lData (high-order 16 bits)

 • First argument: long, second argument: short, third argument: short 
 foo( long lData, short sData1, short sData2 );

 %r0 ← lData (low-order 16 bits)
 %r1 ← lData (high-order 16 bits)
 %r2 ← sData1 (16 bits)
 %r3 ← sData2 (16 bits)

• First argument: long; second argument: pointer; third argument: pointer
 foo( long lData, int *ip_Pt, char *cp_Pt );

 %r0 ← lData (lower-order 16 bits)
 %r1 ← lData (lower-order 16 bits)
 %r2 ← ip_Pt (24 bits (for REGULAR/MIDDLE MODEL), 16 bits (for SMALL MODEL))
 %r3 ← cp_Pt (24 bits (for REGULAR/MIDDLE MODEL), 16 bits (for SMALL MODEL))
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 64-bit (long long, double) arguments are stored in the stack before delivery.

 If the return value is 64-bit (long long, double) data, a return value area is secured during invocation, and 
its leading address is placed in %r0 before being passed on to the function.

Registers for storing returned values (%r0, %r1)
 These registers are used to store returned values. They are used as scratch registers before storing a returned 

value.

• When the returned value is an 8-bit/16-bit data or a pointer (24 bits)
 %r0 ← Returned value
 %r1 Unused

• When the returned value is a 32-bit data
 %r0 ← Returned value (low-order 16 bits)
 %r1 ← Returned value (high-order 16 bits)

Registers for saving values when calling a function (%r4 to %r7)
 These registers are used to store the calculation results of expressions and local variables. These register values 

after returning from a function must be the same as those when the function was called. Therefore, the called 
function has to save and restore the register values if it modifies the register contents.

6.4.4  function Call

The way arguments are passed
 When calling a function, up to four arguments are stored in registers for passing argument (%r0 to %r3) while 

larger arguments are stored in the stack frame of the calling function (explained in the next section) before they 
are passed. 

Handling of structure arguments
 When an argument is a 64-bit or smaller structure, the values of the structure members are stored in the registers 

(%r0 to %r3) to pass through the function if the registers can be used. If the registers for passing argument (%r0 
to %r3) cannot be used, the values of the structure members are passed through the stack. 

 When an argument is a structure larger than 64 bits, the values of the structure members are passed through the 
stack. 

6.4.5  Stack frame

When calling a function, the xgcc C compiler creates the stack frame shown in Figure 6.4.5.1. The start address of 
the stack frame is always a 32-bit boundary address. 

Low memory SP

Argument area

Return address

Register save area

Local variable area

Last argument
 :
First argument stored in the stack

%r7 (4 registers at maximum)
 :
%r4 
Last variable defined
 :
First variable defined 

Allocated by caller function
Cleared by caller function

Allocated by call instruction, 
cleared by ret instruction

Allocated by function prologue 
processing
Cleared by function epilogue 
processing

Figure 6.4.5.1  Stack frame

Argument area
 If there are any arguments for function call that cannot be stored in the registers for passing argument, an area 

is allocated in the stack frame. All arguments are located at 4-byte boundaries. 
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Return address
 This is the return address to the caller function.

Register save area
 If any registers from %r4 to %r7 are used by the caller function, they are saved to this area. 
 If none of the registers from %r4 to %r7 is used by the caller function, this area is not allocated.

local variable area
 If there are any local variables defined in the called function that cannot be stored in registers, an area is 

allocated in the stack frame. Then they are saved sequentially beginning with the last-declared variable at 
boundary addresses according to the data types. 

 Example: {
    char   cData;

    short  sData;

    long   lData;

             :

   }

Low memory +0 +1 +2 +3
cDataLocal start Unused

lData+4
+0 sData

Figure 6.4.5.2  Example of local variables saved to stack

 Depending on the source codes, the variables may not be located in the order of declarations due to 
optimization.

 This area is not allocated if there is no local variable that needs to be saved in the stack.

6.4.6  grammar of C Source

Refer to Section 4.2, "Grammar of C Source", for data type, library functions and header files, in-line assemble, and 
prototype declarations (declaring interrupt handler functions).

6.4.7  Compiler Implementation Definition

C language specifications permit implementation-defined adjustment of the method of configuring member variables 
of a structure or union.
The C compiler in this package is adjusted to yield even-number bytes for the size of a structure or union as an 
implementation definition feature.
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6.5  filter function for Shift JIS Code

Description of function
 The original GNU preprocessor/compiler is not fully compatible with the Shift JIS code (hereafter written as the 

"SJIS code"). This means that for an SJIS character code like " " (0x945c), the "0x5c" part of the code will be 
incorrectly judged as a line connector (\);the character code will not be processed correctly.

 Example:
  i_Val = 0;  // 
  i_Val = 1;  ← This line is joined to the above line and processed as a comment.

 To prevent such errors, the preprocessor/compiler in package versions 1.5.0 and later incorporates a function to 
filter SJIS codes.

 When the code "0x5c" is encountered, this filter function checks one byte immediately before that code and 
determines whether "0x5c" is a line connector (‘\’) or the second byte of an SJIS code.

 If the function determines the code constitutes the second byte of an SJIS code, it performs a process to prevent 
"0x5c" from being processed as a line connector (‘\’).

 This function is compatible with the following files:
 • C source files
 • Header files included from C source files
 • Assembly source files
 • Header files included from assembly source files

 Specify the -mno-sjis-filt option to disable this filter option.
 -mno-sjis-filt can be set via the IDE as described below.
 Select [Properties] > [GNU17 Build Options] > [Compiler] > [General] from the Context menu for the project to 

be set.
 Here, [Use Kanji Filter] is unchecked.

Notes
 • The -traditional-cpp option is not supported but is available in the preprocessor. The filter function will not  

 operate properly if this option is specified while building a project.
  The -traditional-cpp option is designed to execute a preprocess in accordance with a rule in place before ISO  

 specifications were established.
 • If the filter process is enabled, the output of code for a wide character (2-byte) enclosed in single quotation  

 marks (‘) will differ from that output by versions before 1.5.0.
  The prefix "L" must be added to ensure correct output.

 Example:

 Inserting a wide character (2-byte) " " (SJIS code: 0x8bf3)

 • When a version before 1.5.0 is used or when the -mno-sjis-filt option is specified in versions 1.5.0 or later

  int i_Val = ‘ ’;  →  i_Val is replaced by 0x8bf3

 • When the -mno-sjis-filt option is not specified in versions 1.5.0 or later

  int i_Val = L’ ’;  →  i_Val is replaced by 0x8bf3 if the prefix "L" is specified. If the prefix  
        "L" is not specified, i_Val is replaced by 0xfff3.
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6.6  functions of xgcc and Usage Precautions 
• For details about the xgcc C compiler, refer to the documents for the gnu compiler. 
 The documents can be acquired from the GNU mirror sites located in various places around the world through 

Internet, etc.
• Of __attribute__ specifications, this package supports only __attribute__ ((interrupt_handler)). 

No guarantees are made regarding compatibility with any other __attribute__ specifications. Use these 
others solely at your own risk.

 Similarly, xgcc includes functions for assigning functions and variables to unique sections using  
__attribute__ ((section ("section name"))), but no guarantee is made regarding compatibility with 

these functions.
 Sections will be assigned normally when using these functions, but the following restrictions apply:

○ Debugging information cannot be acquired for a function assigned to a unique section.
 Thus, it is not possible to display source code in a source editor if a program counter is included within the 

function for steps or breaks.
 However, Assembler view is possible in Disassembly view.

○ .bss attribute variables (variables with no default value) cannot be assigned to a unique section.
 The following error will occur if you create a ROM data file (psa file).
 Error: xxx.sa contains data outside of the specified range

○ If .data attribute variables (variable with default values) are assigned to a unique section, the user must 
create the process required to transfer the default value from ROM to RAM.

Note that specific functions and variables can also be placed at desired addresses by creating object files 
containing only the functions and variables and by assigning them to unique sections rather than specifying 
__attribute__ ((section ("section name"))) as described above.

• The #pragma preprocessor directive is not guaranteed to work properly. Use it at your own risk.

• gcc expansion functions that are not described in this manual or that fail to comply with ANSI C are not 
guaranteed to function correctly. Use at your own risk.

• For detailed information on bugs in the gcc core, refer to: "\gnu17\doc\release_history.pdf" and Section 6.7, 
"Known Issues".

• For information on the C99 standard supported in gcc3.3, refer to the site below.
 http://gcc.gnu.org/gcc-3.3/c99status.html
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6.7  Known Issues
The following shows the case of bugs recognized in GNU17 C Compiler.

No.1

content of bug

The following compile error occurs, when declaring a huge array( several hundred thousand bytes ).

cc1.exe: out of memory allocating mmmmmmmm bytes after a total of nnnnnnnn bytes

workaround

Be small the memory domain which a compiler secures at once by dividing the array and the source code.

reappearance code

unsigned char uc_array[] = { 0x00,0x01, ........ };

int main()
{

※ The size of array is more than several hundred thousand bytes.

cause

This is the error that the memory domain which the compiler has secured becomes insufficient at the time of 
compile.
Because the size of the array without dimension is too large.
The same error may occur when compiling the source file with many lines.

No.2

content of bug

The result does not become the right value. Because sign extension of char type variable and addition / 
subtraction are carried out at once by optimization.

This bug occurs when all the following conditions are filled.
・ First the value which is more than 128( =0x80 ) is set to the variable which is bigger than char type.
  Second substitute the result which addition / subtraction are carried out to this variable for char 

type variable.
  Last substitute the result which addition / subtraction are carried out to this char type variable 
  for the variable which is bigger than char type.
  Then the error occurs.
・ It is necessary that the result of one of substitution is within 0 - 127.

workaround

Declare volatile to char type variable in order not to sign extension and addition / subtraction are carried out 
at once by optimization.

reappearance code

signed int big_type_val ;

int main( void )
{
 signed char char_val ;

 big_type_val = 128 ;
 char_val = big_type_val - 1 ; ・・・(1)
 big_type_val = char_val - 1 ; ・・・(2)    // big_type_val should be 126, but is -130.

cause

It is an error by optimization.
The process of (1) & (2) is collected into one and compiled by optimization.
For this reason, sign extension and operation are carried out at once.
Then the result does not become the right value.
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No.3

content of bug

The result of strcmp() between a Kanji string sequence which is defined by the macro of 
stringification operator and a Kanji string sequence which is enclosed by double quotation mark 
does not become equal.
Kanji are Japanese characters.
The error occurs when Kanji filter is effective.

workaround

Invalidate Kanji filter.
When compiling from a command line, change "CC=xgcc_filt" into "CC=xgcc" in makefile(*.mak).
When compiling from IDE, invalidate the item of Kanji filter use in project property.
※ This bug has been resolved in Ver 1.5.0 or after. 

reappearance code

#include <string.h>

#define str(a) #a    // macro of stringification operator

int main( void )
{
 if( strcmp( str( " " ), "\" \"" ) ) {   // The result of compare should be equal, but is not equal.

cause

Kanji filter which changes a Kanji string sequence into ASCII sequence at the time of compile is effective by 
the default.
When using macro of stringification operator, the compare of a Kanji string sequence does not become 
equal. Because a Kanji string sequence is changed in the order of the following at the time of compile.

source code                              str(" ")                "\" \""
                                                                    ↓
Conversion by Kanji filter          str("\x8e\x9a")      "\"\x8e\x9a\""
                                                                    ↓
Conversion by preprocessor     "\"\\x8e\\x9a\""     "\"\x8e\x9a\""
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No.4

content of bug

The following compile error occurs.

error: unable to find a register to spill in class

This bug may occur when all the following conditions are filled.
・ Compiled with REGULAR Model or MIDDLE Model.
・ The pointer argument is passed by %r3 register to a function.
・ Referencing the pointer argument passed by %r3 register in a function.

See the compiler package manual "registers for passing arguments" at "6.4.3 Method of Using Registers" 
about the allocation of registers for passing arguments.

workaround

Don’t pass the pointer argument which is cause of the error by %r3 register.
So change the order of parameters, or add the dummy argument.

reappearance code

void sub( int arg1, int arg2, int arg3, long *arg4 )
{
 static long long int num ;

 num = *arg4 ;
}

※ In this case the pointer argument ‘arg4’ is passed by %r3. 
So for example, add the dummy argument as follows,

void sub( int arg1, int arg2, int arg3, int dummy, long *arg4 )
{
 static long long int num ;

 num = *arg4 ;
}

cause

This is compiler internal error when failing to secure registers needed to process.
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No.5

content of bug

Values for global variables in subroutine are not set correctly by inline expansion.

This bug occurs when all of the following conditions apply:

・ The address of a global variable is passed as a parameter to a subroutine.
・ A value is set to the global variable via the pointer, which is a subroutine parameter.
・ The subroutine is expanded inline.
 A number of conditions must be met for inline expansion, as shown below.

 - An inline statement is added and compiled and optimized to at least -O1 or -O3.
 - The subroutine definition section precedes the main function.
 - The subroutine is small.

Inline expansion can be checked in Disassembly view by checking whether the subroutine is called.

workaround

Corrective action (1): Declare the global variable (g2 in the example below) with volatile added.
Corrective action (2): Disable inline expansion by placing the subroutine after the main function.

reappearance code

int g1, g2;
int i_Val;

void write_at ( int *addr, int off )  
{
  addr[off] = 1000;　　　　　　 // specifies g2.
}

int main( void )
{
  g2 = 12;
  write_at ( &g1, &g2 - &g1 ); // This function is expanded inline.
  i_Val = g2; // i_Val should be 1000 but is actually 12.

cause

Error due to optimization.
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No.6

content of bug

The following internal compiler error occurs if a function call is made after casting the immediate value as a 
function pointer.

internal compiler error: Segmentation fault

workaround

First substitute the immediate value for the function pointer global value before function calling is made for 
the global variable.

reappearance code

typedef void  *(*T)( void );

void f( void )
{
  ((T) 10000000)() // Internal compiler error occurs.
}
* This can be avoided in this case by function calling the function pointer global variable as shown below.
typedef void  *(*T)(void);
T  p_Pt; // Function pointer global variable

void f( void )
{
  p_Pt = (void *(*)(void))10000000;
  p_Pt();
}

cause

Caused by a bug in processing when an immediate value is directly assigned for function calling.

No.7

content of bug

An illegal assembler instruction is issued if a function call is made after casting the parameter address as a 
function pointer.

workaround

First substitute the parameter for the global variable before assigning the global variable address for making 
the function call.

reappearance code

void f( int x )
{
    ( *(void (*)())&x )(); // Illegal assembler instruction is generated.
}
* This can be avoided in this case by assigning the global variable address to make the function calling as 

shown below.

int  ip_Pt;  // Global variable

void f( int x )
{
    ip_Pt = x;
    ( *(void (*)())&ip_Pt )();
}

cause

Caused by a bug in processing for direct function calling from a parameter address.
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No.8

content of bug

Calculations between subroutines nested in a while() statement conditional expression and local variables 
are not performed correctly by inline expansion.

This bug occurs when all of the following conditions apply:

・ Compiled using optimization exceeding -O1 (gnu17 supports -O3).
・ Subroutine in a while() statement conditional expression is expanded inline.
・ It is nested within at least nine functions.
・ The local variable calculated in the while() statement conditional expression is calculated in the same way 

in the while() statement block.

workaround

Declare by adding volatile to the local variable calculated in the while() statement conditional expression.

reappearance code

int f( int x )
{
  return ( x + 1 );
}

  int main( void )
{
  int a = 1; 

  // Calculations performed with local variable a and with 9 f() functions nested in while() statement
  // conditional expression.
  while ( (f(f(f(f(f(f(f(f(f(1)))))))))) - a < 10 ){
      a--;  // Same calculation processing as in conditional expression.
      exit ( 0 ); // The required exit(0) is not actually executed.
  }
  abort(); // abort() is executed without entering the while() block.

cause

Error due to optimization.
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7  Library
 This chapter explains the emulation library and the ANSI library included in the S1C17 Family C Compiler 
Package.

7.1  library Overview
Briefly described below are general aspects of the libraries supplied with this package.

7.1.1  library files

The libraries comprise the following components:

libc.a ANSI library
  Provides ANSI standard functions.

libgcc.a Emulation library
  Provides single-precision (32-bit) and double-precision (64-bit) floating-point functions 

including arithmetic operations, comparison and type conversion, integer multiplication/
division/sift functions, and long long-type addition/subtraction functions.

libgccM.a   Emulation library (supports coprocessor multiplication instruction)
 This provides the same functions as libgcc.a, but uses multiplication coprocessor 

instructions internally. In a model supporting coprocessor multiplication instructions, this 
library can be linked in place of libgcc.a.

libgccMD.a   Emulation library (supports coprocessor multiplication, division, and remainder 
instructions)

  This provides the same functions as libgcc.a, but uses multiplication, division, and 
remainder coprocessor instructions internally. In a model supporting coprocessor 
multiplication/division/remainder instructions, this library can be linked in place of libgcc.a.

libstdio.a   Simulated I/O library
  Provides the ANSI C library initialization function (see Section 7.3.3) and lower-level 

functions for inputs/outputs.

The libraries are installed in the following separate directories for each memory model.
\EPSON

 \gnu17

  \lib

   \24bit 24-bit (16MB) memory model libraries
            libc.a

            libgcc.a

            libgccM.a

            libgccMD.a

            libstdio.a

   \16bit 16-bit (64KB) memory model libraries
            libc.a

            libgcc.a

            libgccM.a

            libgccMD.a

            libstdio.a

Link the 16-bit libraries with the application program when the -mpointer16 option is specified in the C 
compiler and assembler.
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7.1.2  precautions to Be Taken When adding a library

There is a dependency relationship between the libraries.
When writing to a *.mak or *.lds file, specify the libraries in the sequence below.
1. Additional libraries
2. libc.a
3. libgcc.a ( libgccM.a / libgccMD.a )
4. libc.a  (Duplication with 2 does not cause an error. Both files can be referenced normally.)

The object file (or library) can reference only the files present after it, in the order in which they are passed to the 
linker. If the added library is specified last, none of the external libraries can be used in the added library. Because 
the basic functions such as float and double arithmetic and the ANSI library cannot be used, always make sure 
the added library is located before the emulation and ANSI libraries.
Example:
 1. NG

ld.exe -T withmylib.lds -o withmylib.elf boot.o libc.a libgcc.a libc.a mylib.a

 If mylib.a is using the emulation and ANSI libraries, an error should always occur during linking.

 2. OK
ld.exe -T withmylib.lds -o withmylib.elf boot.o mylib.a libc.a libgcc.a libc.a

 No errors should occur during linking, allowing mylib.a to use the emulation and ANSI libraries normally.

If the added libraries have a dependent relationship, make sure the basic library is located last. 
Example:
 lib1.a calls only the emulation and ANSI libraries
 lib2.a calls lib1.a in addition to the emulation and ANSI libraries
 lib3.a calls lib1.a and lib2.a in addition to the emulation and ANSI libraries

ld.exe -T withmylib.lds -o withmylib.elf boot.o lib3.a lib2.a lib1.a libc.a libgcc.a 
libc.a

Make sure the first section of the linker script file (.lds) includes the object file. A link error will occur if the first 
section includes only the library. This error can be avoided by describing the library twice, once inside each of the 
*.mak and *.lds files.

Note that describing the library twice will not increase program size.

Example:
 1. NG
 *.lds file
 /* section information */

 .bss 0x0000 : 

 {

 __START_bss = . ;

 c:/epson/gnu17/lib/24bit/libstdio.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 c:/epson/gnu17/lib/24bit/libgcc.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 }

 __END_bss = . ;

 .usr_bss __END_bss : 

 {

  __START_usr_bss = . ;

 test.o(.bss)

 }

  __END_usr_bss = . ;
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A link error occurs if test.o attempts to use a library function when the first section of the *.lds file describes 
only the library file.

 2.OK(1)

 *.lds file
 /* section information */

 .bss 0x0000 : 

 {

 __START_bss = . ;

 test.o(.bss)

 c:/epson/gnu17/lib/24bit/libstdio.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 c:/epson/gnu17/lib/24bit/libgcc.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 }

 __END_bss = . ;

test.o can use each library function if the object file (test.o) is described in the first section of the *.lds 

file.

 3.OK(2)
 *.lds file
  /* section information */

 .bss 0x0000 : 

 {

 __START_bss = . ;

 c:/epson/gnu17/lib/24bit/libstdio.a(.bss)

 c:/epson/gnu17/lib/24bit/libstdio.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 c:/epson/gnu17/lib/24bit/libgcc.a(.bss)

 c:/epson/gnu17/lib/24bit/libgcc.a(.bss)

 c:/epson/gnu17/lib/24bit/libc.a(.bss)

 }

 __END_bss = . ;

 .usr_bss __END_bss : 

 {

 __START_usr_bss = . ;

 test.o(.bss)

 }

 __END_usr_bss = . ;

 *.mak file
 OBJLDS= $(TOOL_DIR)/lib/24bit/libstdio.a \

  $(TOOL_DIR)/lib/24bit/libstdio.a \

  $(TOOL_DIR)/lib/24bit/libc.a \

  $(TOOL_DIR)/lib/24bit/libgcc.a \

  $(TOOL_DIR)/lib/24bit/libgcc.a \

  $(TOOL_DIR)/lib/24bit/libc.a \

test.o can use each library function even if the first section of the *.lds file describes only the library if the 

library is described twice.

Refer to Section 5.7.5, "Setting Linker Options", for how to add libraries using the IDE.
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7.2  Emulation library

7.2.1  Overview

The S1C17 Family C Compiler Package includes the emulation library (libgcc.a, libgccM.a, libgccMD.a) 
that supports the arithmetic operation, comparison, and type conversion of single-precision (32-bit) and double-
precision (64-bit) floating-point numbers that conform to IEEE format, integer multiplication/division/sift 
operations, and long long-type addition/subtraction. The libgcc.a library does not use coprocessor instructions; 
the libgccM.a library uses multiplication coprocessor instructions; the libgccMD.a library uses multiplication, 
division, and remainder coprocessor instructions. These libraries provide the same functions. The xgcc C compiler 
calls up functions from this library when a floating-point number,  long long data or integer calculation is 
performed. Since library functions exchange data via a designated general-purpose register/stack, they can be called 
from an assembly source. To use emulation library functions, specify libgcc.a (libgccM.a, libgccMD.a) and 
libc.a when linking.

Registers used in the libraries
• The registers %r0 to %r7 are used.
• The registers %r4 to %r7 are protected by saving to the stack before execution of a function and by restoring 

from the stack after completion of the function.
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7.2.2  floating-point Calculation functions

function list
 Table 7.2.2.1 below lists the floating-point calculation functions.

Table 7.2.2.1  Floating-point calculation functions
Classification function name functionality

Double-precision
floating-point 
calculation

__adddf3 Addition x ← a + b
__subdf3 Subtraction x ← a - b
__muldf3 Multiplication x ← a * b
__divdf3 Division x ← a / b
__negdf2 Sign inversion x ← -a

Single-precision
floating-point 
calculation

__addsf3 Addition x ← a + b
__subsf3 Subtraction x ← a - b
__mulsf3 Multiplication x ← a * b
__divsf3 Division x ← a / b
__negsf2 Sign inversion x ← -a

Type conversion __fixunsdfsi double → unsigned long x ← a
__fixdfsi double → long x ← a
__floatsidf long → double x ← a
__fixunssfsi float → unsigned long x ← a
__fixsfsi float → long x ← a
__floatsisf long → float x ← a
__truncdfsf2 double → float x ← a
__extendsfdf2 float → double x ← a

Double-precision 
floating-point
comparison

__fcmpd Comparison of double type PSR change ← a - b
__eqdf2 Comparison of double type (a = b) PSR change ← a - b, x ← 0 | 1 *
__nedf2 Comparison of double type (a ≠ b) PSR change ← a - b, x ← 1 | 0 *
__gtdf2 Comparison of double type (a > b) PSR change ← a - b, x ← 1 | 0  *
__gedf2 Comparison of double type (a ≥ b) PSR change ← a - b, x ← 0 | -1 *
__ltdf2 Comparison of double type (a < b) PSR change ← a - b, x ← -1 | 0 *
__ledf2 Comparison of double type (a ≤ b) PSR change ← a - b, x ← 0 | 1 *

Single-precision 
floating-point
comparison

__fcmps Comparison of float type PSR change ← a - b
__eqsf2 Comparison of float type (a = b) PSR change ← a - b, x ← 0 | 1 *
__nesf2 Comparison of float type (a ≠ b) PSR change ← a - b, x ← 1 | 0 *
__gtsf2 Comparison of float type (a > b) PSR change ← a - b, x ← 1 | 0  *
__gesf2 Comparison of float type (a ≥ b) PSR change ← a - b, x ← 0 | -1 *
__ltsf2 Comparison of float type (a < b) PSR change ← a - b, x ← -1 | 0 *
__lesf2 Comparison of float type (a ≤ b) PSR change ← a - b, x ← 0 | 1 *

* x = the value at left if true, x = the value at right if false

• If the operation resulted in an overflow or underflow, infinity or negative infinity (see next section) is 
returned.

• The comparison function changes the C, V, Z or N flag of the PSR depending on the result of op1 - op2, as 
shown below. Other flags are not changed.

Comparison result C V Z N

op1 > op2 0 0 0 0
op1 = op2 0 0 1 0
op1 < op2 1 0 0 1
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floating-point format
 The xgcc C compiler supports the float type (32-bit single-precision) and the double type (64-bit double-

precision) floating-point numbers conforming to IEEE standards. 
 The following shows the internal format of floating-point numbers.

 format of double-precision floating-point number
 The real number of the double type consists of 64 bits, as shown below.

63 62 52 51 0
S Exponent part Fixed-point part

 Bit 63: Sign bit (1 bit)
 Bits 62–52: Exponent part (11 bits)
 Bits 51–0: Fixed-point part (52 bits)

 The result of a floating-point calculation is stored in the 64-bit area beginning with the address loaded in 
the %r0 register.

 The following shows the relationship of the effective range, floating-point representation, and internal data 
of the double type.

 +0: 0.0e+0 0x00000000 00000000

 -0: -0.0e+0 0x80000000 00000000

 Maximum normalized number: 1.79769e+308 0x7fefffff ffffffff

 Minimum normalized number: 2.22507e-308 0x00100000 00000000

 Maximum unnormalized number: 2.22507e-308 0x000fffff ffffffff

 Minimum unnormalized number: 4.94065e-324 0x00000000 00000001

 Infinity:  0x7ff00000 00000000

 Negative infinity:  0xfff00000 00000000

 Values 0x7ff00000 00000001 to 0x7fffffff ffffffff and 0xfff00000 00000001 to 
0xffffffff ffffffff are not recognized as numeric values.

 format of single-precision floating-point number
 The real number of the float type consists of 32 bits, as shown below.

31 30 23 22 0
S Exponent part Fixed-point part

 Bit 31:  Sign bit (1 bit)
 Bits 30–23: Exponent part (8 bits)
 Bits 22–0: Fixed-point part (23 bits)

 This type of value occupies two registers. For example, the result of a floating-point calculation is stored in 
the %r1 and %r0 registers.

  %r1 register: Sign bit, exponent part, and 7 high-order bits of fixed-point part (22:16)
  %r0 register: 16 low-order bits of fixed-point part (15:0)

 The following shows the relationship of the effective range, floating-point representation, and internal data 
of the float type.

 +0: 0.0e+0f 0x00000000

 -0: -0.0e+0f 0x80000000

 Maximum normalized number: 3.40282e+38f 0x7f7fffff

 Minimum normalized number: 1.17549e-38f 0x00800000

 Maximum unnormalized number: 1.17549e-38f 0x007fffff

 Minimum unnormalized number: 1.40129e-45f 0x00000001

 Infinity:  0x7f800000

 Negative infinity:  0xff800000

 Values 0x7f800001 to 0x7fffffff and 0xff800001 to 0xffffffff are not recognized as 
numeric values.

 Note
 The floating-point numbers in the xgcc C compiler differ from the IEEE-based FPU in precision and 

functionality, including the manner in which infinity is handled.
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7.2.3  floating-point Number Processing Implementation Definition
 The following processes are implementation-defined due to C language specifications. The package emulation 

library handles them as described below.

 floating-point value rounding method
 In type conversion from integer type to floating-point type or from one floating-point type to another floating-

point type or in floating-point calculations, if the target value is halfway between two adjacent values 
expressible by the intended format, whether the result is rounded to the larger value or smaller value is 
implementation-defined.

 This package is designed to round values to yield even numbers.
 In other words, if the LSB of the value before rounding is 0, no rounding is performed. If the LSB is 1, the 

value is rounded up by 1.

 Conversion from floating-point type to integer type
 In converting a floating-point number to an integral number, the fractional part will be truncated.
 Following truncation, the action taken if the original value cannot be expressed in the intended format is 

implementation-defined.

・ Conversion from single-/double-precision floating-point type to signed/unsigned long
 If the original value is +NaN → 0x0 if the intended format is signed or 0x80000000 if unsigned

 If the original value is –NaN → 0x0
 If the original value is too large → Maximum value that can be expressed in the intended format
 If the original value is too small → 0x80000000

・ Conversion from single-/double-precision floating-point type to signed/unsigned long long
 If the original value is +NaN → 0x80000000 80000000
 If the original value is –NaN → 0x7fffffff 80000000 if the intended format is signed or 0x0 if 

unsigned
 If the original value is too large → 0xffffffff ffffffff

 If the original value is too small → 0x1 if the intended format is signed or 0x0 if unsigned

 Conversion from one floating-point type to another floating-point type
 If the original value cannot be expressed in the intended format in the conversion from one floating-point type 

to another floating-point type, the action taken is implementation-defined.

・ Conversion from double-precision floating-point type to single-precision floating-point type
 If the original value is +NaN → The significand of the double-precision floating-point number is shifted 

two bits to the left and the higher-order 32 bits obtained. If the lower-
order 32 bits of the truncated significand are not 0x0, the LSB of the 
32-bit significand is set to 1, and the logical sum of that value and 
0x7f900000 is used (+NaN).

 If the original value is –NaN → The significand of the double-precision floating-point number is shifted 
two bits to the left and the higher-order 32 bits obtained. If the lower-
order 32 bits of the truncated significand are not 0x0, the LSB of the 
32-bit significand is set to 1, and the logical sum of that value and 
0xff900000 is used (−NaN).

 If the original value is too large → 0x7f800000 (+∞)
 If the original value is too small → 0xff800000 (−∞)
 If the original value is too close to 0 (larger than 0) → 0x00000000 (+0)
 If the original value is too close to 0 (less than 0) → 0x80000000 (−0)

・ Conversion from single-precision floating-point type to double-precision floating-point type
 If the original value is +NaN → The significand of the single-precision floating-point number is 

shifted two bits to the right, and the logical sum of that value and 
0x7ff80000 00000000 is used.

 If the original value is －NaN → The significand of the single-precision floating-point number is 
shifted two bits to the right, and the logical sum of that value and 
0xfff80000 00000000 is used.
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7.2.4  Integral Calculation functions

Table 7.2.4.1 below lists the integral calculation functions.

Table 7.2.4.1  Integral calculation functions
Classification function name functionality

Integral calculation __divsi3 Signed 32-bit integral division x ← a / b
__modsi3 Signed 32-bit remainder calculation x ← a % b
__udivsi3 Unsigned 32-bit integral division x ← a / b
__umodsi3 Unsigned 32-bit remainder calculation x ← a % b
__mulsi3 32-bit multiplication x ← a * b
__divhi3 Signed 16-bit integral division x ← a / b
__modhi3 Signed 16-bit remainder calculation x ← a % b
__udivhi3 Unsigned 16-bit integral division  x ← a / b
__umodhi3 Unsigned 16-bit remainder calculation x ← a % b
__mulhi3 16-bit multiplication x ← a * b

Integral shift __ashlsi3 32-bit arithmetical shift to left x ← a << b bits
__ashrsi3 32-bit arithmetical shift to right x ← a >> b bits
__lshrsi3 32-bit logical shift to right x ← a >> b bits
__ashlhi3 16-bit arithmetical shift to left x ← a << b bits
__ashrhi3 16-bit arithmetical shift to right x ← a >> b bits
__lshrhi3 16-bit logical shift to right x ← a >> b bits

Integer comparison __cmpsi2 comparison (long) x ← 2 | 1 | 0  *1
__ucmpsi2 Comparison (unsigned long) x ← 2 | 1 | 0  *1

7.2.5  long long Type Calculation functions

Table 7.2.5.1 below lists the long long type calculation functions.

Table 7.2.5.1  long long type calculation functions
Classification function name functionality

long long type 

calculation

__muldi3 Signed 64-bit multiplication x ← a * b
__divdi3 Signed 64-bit division x ← a / b
__udivdi3 Unsigned 64-bit division x ← a / b
__moddi3 Signed 64-bit remainder calculation x ← a % b
__umoddi3 Unsigned 64-bit remainder calculation x ← a % b
__negdi2 Sign inversion x ← -a

long long type shift __lshrdi3 64-bit logical shift to right x ← a >> b bits
__ashldi3 64-bit arithmetical shift to left x ← a << b bits
__ashrdi3 64-bit arithmetical shift to right x ← a >> b bits

Type conversion __fixunsdfdi double → unsigned long long x ← a
__fixdfdi double → long long x ← a  
__floatdidf long long → double x ← a
__fixunssfdi float → unsigned long long x ← a
__fixsfdi float → long long x ← a
__floatdisf long long → float x ← a

long long type 

comparison

__cmpdi2 Comparison (long long) x ← 2 | 1 | 0 *1
__ucmpdi2 Comparison (unsigned long long) x ← 2 | 1 | 0 *1

*1 The integer comparison function and the long long comparison function return the following values based 
on the result of op1 – op2.

 op1 > op2  → 2
 op1 = op2  → 1
 op1 < op2  → 0

*2 Bits are scanned for logic 1 beginning with the LSB, and the position of the first bit found with the value 1 is 
returned.

 If the first bit with the value 1 is the LSB: 1
 If the first bit with the value 1 is the MSB: 64
 If no bits are found with the value 1: 0
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7.2.6  Compatibility with Coprocessor Instructions

The S1C17 core supports coprocessor instructions.
When using a library compatible with coprocessor instructions, add the "emu_copro_process" function in Vector 
Table No. 3 as shown below.

Example: Specifying vector tables (vector.c)
 extern void emu_copro_process(void);
 func *const vector[] = {
  VECTOR(boot),   //  0
  VECTOR(unalign),   //  1
  VECTOR(dummy),   //  2
  VECTOR(emu_copro_process)  //  3
 };

Note that some models do not support coprocessor instructions.
When you create projects from the IDE, libraries compatible with coprocessor instructions can be specified only if 
you selected a model that supports coprocessor instructions.
The libgccM.a library is compatible with multiplication coprocessor instructions.
The libgccMD.a library is compatible with multiplication, division, and remainder coprocessor instructions.

Table 7.2.5.1 lists functions using coprocessor instructions in libgccM.a.

Table 7.2.6.1 Functions using coprocessor instructions in libgccM.a.

function functionality Interrupt disable segment

__mulhi3 16-bit multiplication 10 cycles

__mulsi3 32-bit multiplication 14 cycles

Table 7.2.5.2 lists functions using coprocessor instructions in libgccMD.a.

Table 7.2.6.2 Functions using coprocessor instructions in libgccMD.a.

function functionality Interrupt disable segment

__mulhi3 16-bit multiplication 14 cycles

__mulsi3 32-bit multiplication 17 cycles

__divhi3 Signed 16-bit division 14 cycles

__modhi3 Signed 16-bit remainder calculation 14 cycles

__udivhi3 Unsigned 16-bit division 14 cycles

__umodhi3 Unsigned 16-bit remainder calculation 14 cycles
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7.3  ANSI library

7.3.1  Overview

The S1C17 Family C Compiler Package contains an ANSI library.
Each function in this library has ANSI-standard functionality. Certain ANSI library functions not supported by this 
package are not included in the ANSI library.
The client assumes responsibility for function implementation and prototype declarations when using ANSI library 
functions not listed in Section 7.3.2, "ANSI Library Function List."
For some ANSI library functions not supported by this package, the header files include only prototype 
declarations. In these cases, include the pertinent header file rather than declaring a prototype before implementing 
the function.
See the table in Section 4.2.2, "Library Functions and Header Files" for a discussion of ANSI library functions with 
prototype declarations only. 
The libc.a ANSI library file is installed in separate directories (\gnu17\lib\24bit and \gnu17\lib\
16bit) for each memory model. A long long-type ANSI library is included in libgcc.a (libgccM.a/
libgccMD.a).

The following header files which contain definitions of each function are installed in the include directory.
stdio.h  stdlib.h  time.h  math.h  errno.h  float.h  limits.h  ctype.h  

string.h  stdarg.h  setjmp.h  smcvals.h  stddef.h

Registers used in the library
• The registers %r0 to %r7 are used.
• The registers %r4 to %r7 are protected by saving to the stack before execution of a function and by restoring 

from the stack after completion of the function. 

7.3.2  ANSI library function list

The contents of the Reentrant column in the tables are as follows:
Reentrant: Reentrant function
Nonreentrant: Non-reentrant function
Conditional: Non-reentrant function (This function refers to a global variable. It can be used as a reentrant function 

if there is no change in the global variable, and your created read() and write() are reentrant functions.)

Input/output functions
 The table below lists the input/output functions included in libc.a.

Table 7.3.2.1  Input/output functions

Header file: stdio.h
function functionality Reentrant Notes

size_t fread(void *ptr, size_t size, 

size_t count, FILE *stream);

Input array element from 
stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.

size_t fwrite(void *ptr, size_t size, 

size_t count, FILE *stream);

Output array element to 
stdout.

Conditional Refer to global variables stdout, stderr 
and _iob, and call write function.

int fgetc(FILE *stream); Input one character from 
stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.

int getc(FILE *stream); Input one character from 
stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.

int getchar( ); Input one character from 
stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.

int ungetc(int c, FILE *stream); Push one character back 
to input buffer.

Nonreentrant Refer to global variables stdin, std-
out, stderr, and _iob, returned value 

overwrite.
char *fgets(char *s, int n, FILE 

*stream);

Input character string 
from stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.

char *gets(char *s); Input character string 
from stdin.

Conditional Refer to global variables stdin and 
_iob, and call read function.
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function functionality Reentrant Notes
int fputc(int c, FILE *stream); Output one character to 

stdout.
Conditional Refer to global variables stdout, stderr 

and _iob, and call write function.
int putc(int c, FILE *stream); Output one character to 

stdout.
Conditional Refer to global variables stdout, stderr 

and _iob, and call write function.
int putchar(int c); Output one character to 

stdout.
Conditional Refer to global variables stdout, stderr 

and _iob, and call write function.
int fputs(char *s, FILE *stream); Output character string 

to stdout.
Conditional Refer to global variables stdout, stderr 

and _iob, and call write function.
int puts(char *s); Output character string 

to stdout.
Conditional Refer to global variables stdout, stderr 

and _iob, and call write function.
void perror(char *s); Output error information 

to stdout.
Nonreentrant Refer to global variables stdout and 

_iob, change errno, and call read 

function.
int fscanf(FILE *stream, char 

*format, ...);

Input from stdin with 
format specified.

Nonreentrant Refer to global variables stdout and 
_iob, change errno, and call read 

function.
int scanf(char *format, ...); Input from stdin with 

format specified.
Nonreentrant Refer to global variables stdout and 

_iob, change errno, and call read 

function.
int sscanf(const char *s, const char 

*format, ...);

Input from character 
string with format 
specified.

Nonreentrant Change global variable errno.

int fprintf(FILE *stream, char 

*format, ...);

Output to stdout with 
format specified.

Conditional Refer to global variables stdout, stderr 
and _iob, and call write function.

int printf(char *format, ...); Output to stdout with 
format specified.

Conditional Refer to global variables stdout, stderr 
and _iob, and call write function.

int sprintf(char *s, char *format, 

...);

Output to array with 
format specified.

Reentrant Call write function.

int vfprintf(FILE *stream, char 

*format, va_list arg);

Output conversion result 
to stdout.

Conditional Refer to global variables stdout, stderr 
and _iob, and call write function.

int vprintf(char *s, va_list arg); Output conversion result 
to stdout.

Conditional Refer to global variables stdout, stderr 
and _iob, and call write function.

int vsprintf(char *s, char *format, 

va_list arg);

Output conversion result 
to array.

Reentrant Call write function.

Note: The file system is disabled; stdin and stdout are enabled. When using stdin and stdout, the 
read() and write() functions are needed, respectively. Refer to Section 7.3.4 for more 
information.
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Utility functions
 The table below lists the utility functions included in libc.a.

Table 7.3.2.2  Utility functions
Header file: stdlib.h

function functionality Reentrant Notes
void *malloc(size_t size); Allocate area. Nonreentrant Change global variables errno, 

ansi_ucStartAlloc, 
ansi_ucEndAlloc, 
ansi_ucNxtAlcP, 
ansi_ucTblPtr, and ansi_ulRow.

void *calloc(size_t elt_count, size_t 

elt_size);

Allocate array area. Nonreentrant Invalid for call from memory allocate.

void free(void *ptr); Clear area. Nonreentrant Invalid for call from memory allocate.
void *realloc(void *ptr, size_t size); Change area size. Nonreentrant Invalid for call from memory allocate.
void exit(int status); Terminate program 

normally.
Reentrant Refer to exit, terminates on the side 

of called later.
void abort( ); Terminate program 

abnormally.
Reentrant Refer to exit, terminates on the side 

of called later.
void *bsearch(void *key, void *base, 

size_t count, size_t size, int (*compare) 

(void *, void *));

Binary search. Reentrant

void qsort(void *base, size_t count, 

size_t size, int (*compare)(void *, void 

*));

Quick sort. Reentrant

int abs(int x); Return absolute value 
(int type).

Reentrant

long int labs(long int x); Return absolute value 
(long type).

Reentrant

div_t div(int n, int d); Divide int type. Nonreentrant Change global variable errno.
ldiv_t ldiv(int n, int d); Divide long type. Nonreentrant Change global variable errno.
int rand( ); Return pseudo-random 

number.
Nonreentrant Change global variable errno.

void srand(unsigned int seed); Set seed of pseudo-
random number.

Nonreentrant Change global variable errno.

long int atol(char *str); Convert character 
string into long type.

Nonreentrant Change global variable errno.

int atoi(char *str); Convert character 
string into int type.

Nonreentrant Change global variable errno.

double atof(char *str); Convert character string 
into double type.

Nonreentrant Change global variable errno.

double strtod(char *str, char **ptr); Convert character string 
into double type.

Nonreentrant Change global variable errno.

long int strtol(char *str, char **ptr, 

int base);

Convert character 
string into long type.

Nonreentrant Change global variable errno.

unsigned long int strtoul(char *str, char 

**ptr, int base);

Convert character 
string into unsigned 
long type.

Nonreentrant Change global variable errno.

Non-local branch functions
 The table below lists the non-local branch functions included in libc.a.

Table 7.3.2.3  Non-local branch functions
Header file: setjmp.h

function functionality Reentrant Notes
int setjmp(jmp_buf env); Non-local branch Reentrant
void longjmp(jmp_buf env, int status); Non-local branch Reentrant
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Date and time functions
 The table below lists the date and time functions included in libc.a.

Table 7.3.2.4  Date and time functions
Header file: time.h

function functionality Reentrant Notes
struct tm *gmtime(time_t *t); Convert calendar time to standard time. Nonreentrant Change static variable.
time_t mktime(struct tm *tmptr); Convert standard time to calendar time. Nonreentrant Locale information and daylight 

savings time settings are not 
applied.

time_t time(time_t *tptr); Return current calendar time. Conditional Refer to global variable gm_sec.

Mathematical functions
 The table below lists the mathematical functions included in libc.a.

Table 7.3.2.5  Mathematical functions
Header files: math.h, errno.h, float.h, limits.h

function functionality Reentrant Notes
double fabs(double x); Return absolute value (double type). Reentrant
double ceil(double x); Round up double-type decimal part. Nonreentrant Change global variable errno.
double floor(double x); Round down double-type decimal 

part.
Nonreentrant Change global variable errno.

double fmod(double x, double y); Calculate double-type remainder. Nonreentrant Change global variable errno.

double exp(double x); Exponentiate (ex). Nonreentrant Change global variable errno.
double log(double x); Calculate natural logarithm. Nonreentrant Change global variable errno.
double log10(double x); Calculate common logarithm. Nonreentrant Change global variable errno.
double frexp(double x, int *nptr); Return mantissa and exponent of 

floating-point number.
Nonreentrant Change global variable errno.

double ldexp(double x, int n); Return floating-point number from 
mantissa and exponent.

Nonreentrant Change global variable errno.

double modf(double x, double 
*nptr);

Return integer and decimal parts of 
floating-point number.

Nonreentrant Change global variable errno.

double pow(double x, double y); Calculate xy. Nonreentrant Change global variable errno.
double sqrt(double x); Calculate square root. Nonreentrant Change global variable errno.
double sin(double x); Calculate sine. Nonreentrant Change global variable errno.
double cos(double x); Calculate cosine. Nonreentrant Change global variable errno.
double tan(double x); Calculate tangent. Nonreentrant Change global variable errno.
double asin(double x); Calculate arcsine. Nonreentrant Change global variable errno.
double acos(double x); Calculate arccosine. Nonreentrant Change global variable errno.
double atan(double x); Calculate arctangent. Nonreentrant
double atan2(double y, double x); Calculate arctangent of y/x. Nonreentrant Change global variable errno.
double sinh(double x); Calculate hyperbolic sine. Nonreentrant Change global variable errno.
double cosh(double x); Calculate hyperbolic cosine. Nonreentrant Change global variable errno.
double tanh(double x); Calculate hyperbolic tangent. Nonreentrant
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Character functions
 The table below lists the character functions included in libc.a.

Table 7.3.2.6  Character functions
Header file: string.h

function functionality Reentrant Notes
void *memchr(const void *s, int c, size_t 

n);

Return specified character position in the 
storage area.

Reentrant

int memcmp(char *s1, char *s2, int n); Compare storage areas. Reentrant
void *memcpy(char *s1, char *s2, int n); Copy storage area. Reentrant
void *memmove(char *s1, char *s2, int n); Copy the storage area (overlapping allowed). Reentrant
void *memset(char *s, int c, int n); Set character in the storage area. Reentrant
char *strcat(char *s1, char *s2); Concatenate character strings. Reentrant
char *strchr(char *s, int c); Return specified character position found first 

in the character string.
Reentrant

int strcmp(char *s1, char *s2); Compare character strings. Reentrant
char *strcpy(char *s1, char *s2); Copy character string. Reentrant
size_t *strcspn(char *s1, char *s2); Return number of characters from the 

beginning of the character string until the 
specified character appears (multiple choices).

Reentrant

char *strerror(int code); Return error message character string. Reentrant
size_t strlen(char *s); Return length of character string. Reentrant
size_t strncat(char *s1, char *s2, int n); Concatenate character strings (number of 

characters specified).
Reentrant

int strncmp(char *s1, char *s2, int n); Compare character strings (number of 
characters specified).

Reentrant

char *strncpy(char *s1, char *s2, int n); Copy character string (number of characters 
specified).

Reentrant

char *strpbrk(char *s1, char *s2); Return specified character position (multiple 
choices) found first in the character string.

Reentrant

char *strrchr(char *s, int c); Return specified character position found last 
in the character string.

Reentrant

size_t strspn(char *s1, char *s2); Return number of characters from the 
beginning of the character string until the non-
specified character appears (multiple choices).

Reentrant

char *strstr(char *s1, char *s2); Return position where the specified character 
string appeared first.

Reentrant

char *strtok(char *s1, char *s2); Divide the character string into tokens. Nonreentrant Change static 
variable.

Character type determination/conversion functions
 The table below lists the character type determination/conversion functions included in libc.a.

Table 7.3.2.7  Character type determination/conversion functions 
Header file: ctype.h

function functionality Reentrant
int isalnum(int c); Determine character type (decimal or alphabet). Reentrant
int isalpha(int c); Determine character type (alphabet). Reentrant
int iscntrl(int c); Determine character type (control character). Reentrant
int isdigit(int c); Determine character type (decimal). Reentrant
int isgraph(int c); Determine character type (graphic character). Reentrant
int islower(int c); Determine character type (lowercase alphabet). Reentrant
int isprint(int c); Determine character type (printable character). Reentrant
int ispunct(int c); Determine character type (delimiter). Reentrant
int isspace(int c); Determine character type (null character). Reentrant
int isupper(int c); Determine character type (uppercase alphabet). Reentrant
int isxdigit(int c); Determine character type (hexadecimal). Reentrant
int tolower(int c); Convert character type (uppercase alphabet → lowercase). Reentrant
int toupper(int c); Convert character type (lowercase alphabet → uppercase). Reentrant
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Variable argument macros
 The table below lists the variable argument macros defined in stdarg.h.

Table 7.3.2.8  Variable argument macros
Header file: stdarg.h

Macro functionality
void va_start(va_list ap, type lastarg); Initialize the variable argument group.
type va_arg(va_list ap, type); Return the actual argument.
void va_end(va_list ap); Return normally from the variable argument function.
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7.3.3  Declaring and Initializing global Variables 

The ANSI library functions reference the global variables listed in Table 7.3.3.1. These variables have been 
defined in the libstdio.a library. Include "\include\libstdio.h" in the C source program and call the 
_init_lib() function to initialize the variables before calling a library function.

For how to initialize the ANSI library using libstdio.a, refer to the sample file "\gnu17\sample\
S1C17common\simulator\simulatedIO".

Table 7.3.3.1  Global variables required of declaration
global variable Initial setting Related header file/function

FILE _iob[FOPEN_MAX +1]; 
  FOPEN_MAX=3, defined in stdio.h
File structure data for standard 
input/output streams

_iob[N]._flg = _UGETN;
_iob[N]._buf = 0;
_iob[N]._fd  = N;
 (N=0–2)
 _iob[0]: Input data for stdin
 _iob[1]: Output data for stdout
 _iob[2]: Output data for stderr

stdio.h, smcvals.h
fgets, fread, fscanf, getc, getchar, gets, scanf, 
ungetc, perror, fprintf, fputs, fwrite, printf, 
putc, putchar, puts, vfprintf, vprintf

FILE *stdin;

Pointer to standard input/output file 
structure data _iob[0]

stdin = &_iob[0]; stdio.h
fgets, fread, fscanf, getc, getchar, gets, scanf, 
ungetc

FILE *stdout;

Pointer to standard input/output file 
structure data _iob[1]

stdout = &_iob[1]; stdio.h
fprintf, fputs, fwrite, printf, putc, putchar, 
puts, vfprintf, vprintf

FILE *stderr;

Pointer to standard input/output file 
structure data _iob[2]

stderr = &_iob[2]; stdio.h
fprintf, fputs, fwrite, printf, perror, putc, 
putchar, puts, vfprintf, vprintf

int errno;

Variable to store error number
errno = 0; errno.h

perror, fprintf, printf, sprintf, vprintf, 
vfprintf, fscanf, scanf, sscanf
atof, atoi, calloc, div, ldiv, malloc, realloc, str-
tod, strtol, strtoul
acos, asin, atan2, ceil, cos, cosh, exp, fabs, floor, 
fmod, frexp, ldexp, log, log10, modf, pow, sin, sinh, 
sqrt, tan

unsigned int seed;

Variable to store seed of random 
number

seed = 1; stdlib.h
rand, srand

time_t gm_sec;

Elapsed time of timer function in 
seconds from 0:00:00 on January 1, 
1970

gm_sec = -1; time.h
time

Among the global variables referenced by the ANSI library functions, those that are used by each function (mal-
loc, calloc, realloc, and free) are initialized using the initialization function shown below. This function is 

defined in stdlib.h.

int ansi_InitMalloc(unsigned long START_ADDRESS, unsigned long END_ADDRESS);

For the START_ADDRESS and END_ADDRESS, set the start and end addresses of the memory used, respectively. 
These addresses are adjusted to the 4-byte boundaries within the function.

The following global variables are initialized. These variables are defined in stdlib.h.
unsigned char *ansi_ucStartAlloc; Pointer to indicate the start address of the heap area

unsigned char *ansi_ucEndAlloc; Pointer to indicate the end address of the heap area

unsigned char *ansi_ucNxtAlcP; Address pointer to indicate the beginning of the next new area mapped

unsigned char *ansi_ucTblPtr; Address pointer to indicate the beginning of the next management area 

mapped
unsigned long ansi_ulRow; Line pointer to indicate the next management area mapped

Each time storage is reserved for a heap area, eight-byte heap area management data is written from the ending 
address (ansi_ucEndAlloc) toward the beginning address. Be careful to avoid rewriting areas specified as heap 
areas by the ansi_InitMalloc() function by a stack pointer, etc.
* The libstdio.a library does not contain the ansi_InitMalloc() function. Be aware that it must be 

called from the user routine before calling malloc() or a similar function. (A heap area cannot be allocated if 
the ansi_InitMalloc() function is not called.)
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7.3.4  lower-level functions

The following three functions (read, write, and _exit) are the lower-level functions called by library 
functions. A read and a write function have been defined in the libstdio.a library. Before these functions 
can be used, include "\include\libstdio.h" in the C source program and call the _init_sys() function.
The _exit function must be defined in the user program.
For how to use the libstdio.a, refer to the sample file "\gnu17\sample\S1C17common\simulator\
simulatedIO".

read function

 Contents of read function
Format: int read(int fd, char *buf, int nbytes);

Argument: int fd; File descriptor denoting input
  When called from a library function, 0 (stdin) is passed.
 char *buf; Pointer to the buffer that stores input data
 int nbytes; Number of bytes transferred

Functionality: This function reads up to nbytes of data from the user-defined input buffer, and stores it 
in the buffer indicated by buf.

Returned value: Number of bytes actually read from the input buffer
 If the input buffer is empty (EOF) or nbytes = 0, 0 is returned.
 If an error occurs, -1 is returned.

Library functions that call the read function: 
 Direct call: fread, getc, _doscan (_doscan is a scanf-series internal function)
 Indirect call: fgetc, fgets, getchar, gets (calls getc)
  scanf, fscanf, sscanf (calls _doscan)

 Definition of input buffer
Format: unsigned char READ_BUF[65]; (Variable name is arbitrary; size is fixed to 65 bytes)
 unsigned char READ_EOF;

Buffer contents: The size of the input data (1 to max. 64) is stored at the beginning of the buffer 
(READ_BUF[0]). 0 denotes EOF.

 The input data is stored in READ_BUF[1], and the following locations. 
 READ_EOF stores the status that indicates whether EOF is reached.

 Precautions on using a simulated I/O
 When using the debugger's simulated I/O, define in the read function the global label READ_FLASH that 

is required for the debugger to update the input buffer, then create the function so that new data will be 
read into the input buffer at that position. (For details about the simulated I/O function, refer to the chapter 
where the debugger is discussed.)

 A read function has been defined in the libstdio.a library. To use the read function, link 
libstdio.a and call the _init_sys() function from the boot routine in the user program.
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write function

 Contents of write function
Format: int write(int fd, char *buf, int nbytes);

Argument: int fd; File descriptor denoting output
  When called from a library function, 1 (stdout) or 2 (stderr) is passed.
 char *buf; Pointer to the buffer that stores output data
 int nbytes; Number of transferred bytes

Functionality: The data stored in the buffer indicated by buf is written as much as indicated by nbytes 
to the user-defined output buffer.

Returned value: Number of bytes actually written to the output buffer
 If data is written normally, nbytes is returned.
 If a write error occurs, a value other than nbytes is returned.

Library function that calls the write function:
 Direct call: fwrite, putc, _doprint (_doprint is printf-series internal function)
 Indirect call: fputc, fputs, putchar, puts (calls putcc)
  printf, fprintf, sprintf, vprintf, vfprintf (calls _doprint)
  perror (calls fprintf)

 Definition of output buffer
Format: unsigned char WRITE_BUF[65];

 (Variable name is arbitrary; size is fixed to 65 bytes)

Buffer content: The size of the output data (1 to max. 64) is stored at the beginning of the buffer 
(WRITE_BUF[0]). 0 denotes EOF.

 The output data is stored in WRITE_BUF[1], and the following locations.

 Precautions on using simulated I/O
 When using the debugger's simulated I/O, define in the write function the global label WRITE_FLASH 

that is required for the debugger to update the output buffer, and create a function so that data will be output 
from the output buffer at that position. (For details about the simulated I/O function, refer to the chapter 
where the debugger is discussed.)

 A write function has been defined in the libstdio.a library. To use the read function, link 
libstdio.a and call the _init_sys() function from the boot routine in the user program.

 Note that the _init_sys, read, and write functions included in the libstdio.a library are linked even when 
only the read or write functions are used.

_exit function

 Contents of _exit function
Format: void _exit(void);

Functionality: Performs program terminating processing.

Argument: None

Returned value: None

Library function that calls the _exit function:
 Direct call:  abort, exit
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 This chapter describes the functions of the as assembler. For the syntax of the assembly sources, refer to 
Section 4.3, "Grammar of Assembly Source".

8.1  functions
The as assembler assembles (translates) assembly source files that are delivered by the C compiler and creates 
object files in the machine language. It can also deliver debugging information for purposes of symbolic debugging.
This assembler is based on the gnu assembler (as). For details about the as assembler, refer to the documents for 
the gnu assembler. The documents can be acquired from the GNU mirror sites located in various places around the 
world through Internet, etc.

8.2  Input/Output files

Assembler
as

file.s

file.o

Specify the -c and 
-xassembler-with-cpp 
options

-mc17_ext 
C compiler

xgcc

Preprocessor
cpp

Assembler
as

file.s

file.o

Assembly sources 
including preprocessor instructions

Object files

ld linker

Object files

ld linker

Link map and
dump files

Assembly 
sources

file.dump
file.map

Figure 8.2.1  Flowchart

8.2.1  Input files

Assembly source file 
File format: Text file 
File name: <filename>.s (Other extenders than ".s" can be used. A path can also be specified.)
 <file name.ext0>
Description: File in which a source program is described. Usually, a file delivered by the xgcc C compiler is 

input there. 
 If source files were created that only describe basic instructions and assembler directives, they can 

be input into the as assembler directly.
 When built in the IDE, the <file name.ext0> file is the input file.

link map file 
File format: Text file 
File name: <filename>.map
Description: File in which object mapping information is described. This file is delivered by the ld linker and 

is used to optimize the code for referencing global symbols when the -mc17_ext option is 
specified.



8-2 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

8  ASSEMBlER

Dump file 
File format: Text file 
File name: <filename>.dump
Description: File in which global and local symbol information is described. Use objdump to create this file.
 objdump -t <filename>.elf > <filename>.dump

 Specify the file name extension as ".dump". This file is used to optimize the code for referencing 

local symbols when the -mc17_ext option is specified.

8.2.2  Output file

Object file 
File format: Binary file in elf format
File name: <filename>.o (The <filename> is the same as that of the input file.) 
Description: File in which symbol information and debugging information are added to the program code 

(machine language). 
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8.3  Starting Method

8.3.1  Startup format

To invoke the as assembler, use the command shown below. 

as <options> <filename>

 <options> See Section 8.3.2.
 <filename> Specify assembly source file name(s) including the extension (.s).

8.3.2  Command-line Options

The as assembler accepts the gnu assembler standard options. The following lists the principal options only. Refer 
to the gnu assembler manual for more information.

-o<filename>

Function: Specify output file name
Description: This option is used to specify the name of the object file output by the as assembler. 
 The <filename> must be the same as the input file and input immediately after -o.
Default: The default output file name is a.out.

-a[<sub-option>] 

Function: Output assembly list file 
Description: Outputs an assembly list file. The <sub-option> controls the output contents.
 Example: -adhl Requests high-level assembly listing without debugging directives.
Default: No assembly list file is output.

--gstabs

Function: Add debugging information with relative path to source files
Description: This option is used to creates an output file containing debugging information. 
 The source file location information is output as a relative path.
Default: No debugging information is output.

In addition to the standard options, the following S1C17 option is available:

-mpointer16

Function: Specify 16-bit pointer mode
Description: This option is used to generate object files for the 16-bit pointer mode (64KB memory model).
 This option just sets a flag to indicate that the 16-bit pointer mode is specified and it does not af-This option just sets a flag to indicate that the 16-bit pointer mode is specified and it does not af-

fect the object code that will be generated.
Default: The assembler generates object files for the 24-bit pointer mode (16MB or 1MB memory model).

-mc17_ext <dump file name> <link map file name>

Function: Optimize extended instructions
Description: This option is used to remove unnecessary ext instructions, which were inserted when s*/x* 

extended instructions were expanded by the assembler in the first pass, according to the actual 
distance to each symbol that has been determined during linkage process. Perform until linkage 
process in the first pass and specify this assembler option in the second pass. For more information 
on the extended instruction and optimization, refer to Sections 8.6 and 8.7.

Default: The assembler does not optimizes extended instructions.

When entering options in the command line, you need to place one or more spaces before and after the option. 
Example: as -o test.o -adhl test.s
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8.4  Scope
Symbols defined in each source file can freely be referred to within that file. Such reference range of symbols is 
termed scope. 
Usually, reference can be made only within a defined file. If a symbol that does not exist in that file is referenced, 
the as assembler creates the object file assuming that the symbol is an undefined symbol, leaving the problem to be 
solved by the ld linker. 
If your development project requires the use of multiple source files, it is necessary for the scope to be extended to 
cover other source files. The as assembler has the pseudo-instructions that can be used for this purpose.  
Symbols that can be referenced in only the file where they are defined are called "local symbols". Symbols that 
are declared to be global are called "global symbols". Local symbols – even when symbols of the same name 
are specified in two or more different files – are handled as different symbols. Global symbols – if defined as 
overlapping in multiple files – cause a warning to be generated in the ld linker. 

Example:
 file1: file in which global symbol is defined
   .global  SYMBOL  ...Global declaration of symbols that are to be defined in this file.
   .global  VAR1

 SYMBOL:
    :

    :

 LABEL:     ...Local symbol

    :      (Can be referred to only in this file)
   .section .bss

   .align   2

 VAR1:

   .zero    4

 file2: file in which a global symbol is referred
   xcall  SYMBOL  ...Symbol externally referred 
    :
   xld.a  %r1,VAR1  ...Symbol externally referred 

 LABEL:     ...Local symbol
    :       (Treated as a different symbol from LABEL of file1)

The as assembler regards the symbols SYMBOL and VAR1 in the file2 as those of undefined addresses in the 
assembling, and includes that information in the object file it delivers. Those addresses are finally determined by 
the processing of the ld linker.
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8.5  Assembler Directives
The assembler directives are not converted to execution codes, but they are designed to control the assembler or to 
set data. For discrimination from other instructions, all the assembler directives begin with a period (.). Describe the 
directives in lowercase unless otherwise specified. Parameters are discriminated between uppercase and lowercase.
The as assembler supports all the gnu assembler directives. Refer to the gnu assembler manual for details of the 
assembler directives. The following explains the often-utilized directives.

8.5.1  Text Section Defining Directive (.text)

Instruction format

 .text

Description
 Declares the start of a .text section. Statements following this instruction are assembled as those to be 

mapped in the .text section, until another section is declared. 
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8.5.2  Data Section Defining Directives (.rodata, .data)

list of data section defining directives
 .rodata Declares a .rodata section in which constants are located.
 .data Declares a .data section in which data with initial values are located.

Instruction format

 .section .rodata

 .section .data

Description

 (1) .section .rodata
 Declares the start of a constant data section. Statements following this instruction are assembled as those to 

be mapped in the .rodata section, until another section is declared. Usually, this section will be mapped 
into a read-only memory at the stage of linkage.

 Example: .section .rodata Defines a .rodata section.

 (2) .section .data
 Declares the start of a data section with an initial value. Statements following this instruction are assembled 

as those to be mapped in the .data section, until another section is declared. Usually, this section will be 
mapped into a read-only memory at the stage of linkage and data in this section must be copied to a read/
write memory such as a RAM by the software before using. 

 Example: .section .data  Defines a .data section.

Note
 The data space allocated by the data-define directive is as follows:
 1 byte: .byte
 2 bytes: .short, .hword, .word, .int
 4 bytes: .long
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8.5.3  Bss Section Defining Directive (.bss)

list of bss section defining directives
 .bss Declares a .bss section for data without an initial value.

Instruction format

 .section .bss

Description
 Declares the start of a uninitialized data section. Statements following this instruction are assembled as those to 

be mapped in the .bss section, until another section is declared.
 Example: .section .bss   Defines a .bss section.

Note
• The labels described in the .bss section will be defined as local symbols by default. To define a global 

symbol, use the .global directive.
 Example: .section .bss
     .align   2

    VAR1:

     .skip    4   Defines the 4-byte local variable VAR1.

     .section .bss
     .global  VAR2

     .align   2

    VAR2:

     .skip    4   Defines the 4-byte global variable VAR2.

• Areas in .bss sections can be secured using the .skip directive. The .space directive cannot be used 
because it has an initial data.
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8.5.4  Data Defining Directives (.long, .short, .byte, .ascii, .space)

The following assembler directives are used to define data in .data or .text sections:

list of data defining directives
 .long Define 4-byte data.
 .short Define 2-byte data.
 .byte Define 1-byte data.
 .ascii Define ASCII character strings.
 .space Fills an area with a byte data.

Instruction format

 .long <4-byte data>[,<4-byte data> ... ,<4-byte data>]
 .short <2-byte data>[,<2-byte data> ... ,<2-byte data>]
 .byte <1-byte data>[,<1-byte data> ... ,<1-byte data>]
 .ascii "<character string>"[,"<character string>" ... ,"<character string>"]
 .space <length>[,<1-byte data>]

 <4-byte data> 0x0–0xffffffff
 <2-byte data> 0x0–0xffff
 <1-byte data> 0x0–0xff
 <character string> ASCII character string
 <length> Area size to be filled

Description

 (1) .long, .short, .byte
 Defines one or more 4-byte data, 2-byte data, or 1-byte data. When specifying two or more data, separate 

them with a comma. 
 The defined data is located beginning with a boundary address matched to the data size by the data defining 

directive unless it is immediately preceded by the .align directive. If the current position is not a 
boundary address, 0x00 is set in the interval from that position to the nearest boundary address.

 Example: .long  0x0,0x1,0x2 
  .byte  0xff

 In addition to these directives, the directives listed below can also be used.
 .hword same as .short
 .word  same as .short
 .int  same as .short

 (2) .ascii
 Defines one or more string literals. Enclose a character string in double quotes. ASCII characters and an 

escape sequence that begins with a symbol "\" can be written in a character string. For example, if you 
want to set double quote in a character string, write \"; to set a \, write \\.

 When specifying two or more strings, separate them with a comma. 
 The defined data is located beginning with the current address first, unless it is immediately preceded by the 

.align directive.

 Example: .ascii "abc","xyz"
  .ascii "abc\"D\"efg" (= abc"D"efg)

 (3) .space
 An area of the specified <length> bytes long is set to <1-byte data>. The area begins from the current 

address unless it is immediately preceded by the .align directive.
 If <1-byte data> is omitted, the area is filled with 0x0. To fill the area with 0x0, the .zero directive (see 

the next page) can also be used.
 Example: .space 4,0xff  Sets 0xff to the 4-byte area beginning from the current address.
  .zero  4   (= .space 4,0x0)
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8.5.5  Area Securing Directive (.zero)

Instruction format

 .zero  <length>

 <length>     Area size in bytes

Description
 This directive secures a <length> bytes of blank area in the current .bss section.
 The area begins from the current address unless it is immediately preceded by the .align directive.
 Example:  .section .bss
    .global  VAR1

    .align   2

   VAR1:

    .zero    4  Secures an space for the 4-byte global variable VAR1.
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8.5.6  Alignment Directive (.align)

Instruction format

 .align  <alignment>

 <alignment>     Value to specify a boundary

Description
 The data that appears immediately after this directive is aligned to a 2n byte boundary (n = <alignment>).
 Example: .align 2  Aligns the following data to a 4-byte boundary.

Note
 The .align directive is valid for only the immediately following data definition or area securing directive. 

Therefore, when defining data that requires alignment, you need to use the .align directive for each data 
definition directive. 
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8.5.7  global Declaring Directive (.global)

Instruction format 

 .global  <symbol>

 <symbol>     Symbol to be defined in the current file

Description
 Makes global declaration of a symbol. The declaration made in a file with a symbol defined converts that 

symbol to a global symbol which can be referred to from other modules.
 Example: .global SUB1

Note
 The symbols are always defined as a local symbol unless it is declared using this directive.
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8.5.8  Symbol Defining Directive (.set)

Instruction format

 .set  <symbol>,<address>

 <symbol>     Symbol for memory access (address reference)
 <address> Absolute address

Description
 Defines a symbol with an absolute address (24-bit).
 Example: .set  DATA1,0x80000 Defines the symbol DATA1 that represents absolute address 0x80000.

Note
 The symbol is defined as a local symbol. To use it as a global symbol, global declaration using the .global 

directive is necessary.
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8.6  Extended Instructions
The as assembler supports the extended instructions explained below. Extended instructions allow an operation that 
normally requires using multiple instructions including the ext instruction to be written in one instruction. They 
are expanded into the absolutely necessary minimum basic instructions according to instruction functionality and 
the operand's immediate size before assembling. 

Symbols used in explanation
 immX Unsigned X-bit immediate
 signX Signed X-bit immediate
 symbol Symbol to indicate memory address
 label Jump address label
 (X:Y) Bit field from bit X to bit Y

8.6.1  Arithmetic Operation Instructions

Types and functions of extended instructions
Extended instruction function Expansion

sadd    %rd,imm16 %rd ← %rd+imm16 (1)
sadc    %rd,imm16 %rd ← %rd+imm16+C (1)
sadd.a  %rd,imm20 %rd ← %rd+imm20 (2)
sadd.a  %sp,imm20 %sp ← %sp+imm20 (2)
ssub    %rd,imm16 %rd ← %rd-imm16 (1)
ssbc    %rd,imm16 %rd ← %rd-imm16-C (1)
ssub.a  %rd,imm20 %rd ← %rd-imm20 (2)
ssub.a  %sp,imm20 %sp ← %sp-imm20 (2)
xadd    %rd,imm16 %rd ← %rd+imm16 (1)
xadc    %rd,imm16 %rd ← %rd+imm16+C (1)
xadd.a  %rd,imm24 %rd ← %rd+imm24 (3)
xadd.a  %sp,imm24 %sp ← %sp+imm24 (3)
xsub    %rd,imm16 %rd ← %rd-imm16 (1)
xsbc    %rd,imm16 %rd ← %rd-imm16-C (1)
xsub.a  %rd,imm24 %rd ← %rd-imm24 (3)
xsub.a  %sp,imm24 %sp ← %sp-imm24 (3)

 These extended instructions allow a 16-bit/20-bit/24-bit immediate to be specified directly in an add or subtract 
operation.

 A conditional operation option (/c, /nc) cannot be specified in the extended instructions.

Basic instructions after expansion
 sadd, xadd Expanded into the add instruction
 sadc, xadc Expanded into the adc instruction
 sadd.a, xadd.a Expanded into the add.a instruction
 ssub, xsub Expanded into the sub instruction
 ssbc, xsbc Expanded into the sbc instruction
 ssub.a, xsub.a Expanded into the sub.a instruction
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Expansion formats

(1) sOP  %rd,imm16 / xOP  %rd,imm16   (OP = add, adc, sub, sbc)
 Example: xadd  %rd,imm16

imm16 ≤ 0x7f 0x7f < imm16
add  %rd,imm16(6:0) ext  imm16(15:7)

add  %rd,imm16(6:0)

(2) sOP.a  %rd,imm20 / sOP.a  %sp,imm20  (OP = add, sub)
 Example: sadd.a  %rd,imm20

imm20 ≤ 0x7f 0x7f < imm20
add.a  %rd,imm20(6:0) ext    imm20(19:7)

add.a  %rd,imm20(6:0)

(3) xOP.a  %rd,imm24 / xOP.a  %sp,imm24  (OP = add, sub)
 Example: xadd.a  %rd,imm24

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
add.a  %rd,imm24(6:0) ext    imm24(19:7)

add.a  %rd,imm24(6:0)
ext    imm24(23:20)
ext    imm24(19:7)
add.a  %rd,imm24(6:0)
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8.6.2  Comparison Instructions

Types and functions of extended instructions
Extended instruction function Expansion

scmp    %rd,imm16 %rd-imm16 (Sets/resets C, V, Z and N flags in PSR) (1)
scmc    %rd,imm16 %rd-imm16-C (Sets/resets C, V, Z and N flags in PSR) (1)
scmp.a  %rd,imm20 %rd-imm20 (Sets/resets C, V, Z and N flags in PSR) (2)
xcmp    %rd,imm16 %rd-imm16 (Sets/resets C, V, Z and N flags in PSR) (1)
xcmc    %rd,imm16 %rd-imm16-C (Sets/resets C, V, Z and N flags in PSR) (1)
xcmp.a  %rd,imm24 %rd-imm24 (Sets/resets C, V, Z and N flags in PSR) (3)

 These extended instructions allow you to compare a general-purpose register and a 16-bit/20-bit/24-bit 
immediate.

 A conditional operation option (/c, /nc) cannot be specified in the extended instructions.

Basic instructions after expansion
 scmp, xcmp Expanded into the cmp instruction
 scmc, xcmc Expanded into the cmc instruction
 scmp.a, xcmp.a Expanded into the cmp.a instruction

Expansion formats

(1) sOP  %rd,imm16 / xOP  %rd,imm16  (OP = cmp, cmc)
 Example: xcmp  %rd,imm16

imm16 ≤ 0x7f 0x7f < imm16
cmp  %rd,imm16(6:0) ext  imm16(15:7)

cmp  %rd,imm16(6:0)

(2) scmp.a  %rd,imm20
imm20 ≤ 0x7f 0x7f < imm20

cmp.a  %rd,imm20(6:0) ext    imm20(19:7)
cmp.a  %rd,imm20(6:0)

(3) xcmp.a  %rd,imm24
imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24

cmp.a  %rd,imm24(6:0) ext    imm24(19:7)
cmp.a  %rd,imm24(6:0)

ext    imm24(23:20)
ext    imm24(19:7)
cmp.a  %rd,imm24(6:0)
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8.6.3  logic Operation Instructions

Types and functions of extended instructions
Extended instruction function Expansion

sand  %rd,imm16 %rd ← %rd&imm16 (1)
soor  %rd,imm16 %rd ← %rd|imm16 (1)
sxor  %rd,imm16 %rd ← %rd^imm16 (1)
snot  %rd,imm16 %rd ← !imm16 (1)
xand  %rd,imm16 %rd ← %rd&imm16 (1)
xoor  %rd,imm16 %rd ← %rd|imm16 (1)
xxor  %rd,imm16 %rd ← %rd^imm16 (1)
xnot  %rd,imm16 %rd ← !imm16 (1)

 These extended instructions allow a 16-bit immediate to be specified directly in a logical operation. 
 A conditional operation option (/c, /nc) cannot be specified in the extended instructions.

Basic instructions after expansion
 sand, xand Expanded into the and instruction
 soor, xoor Expanded into the or instruction
 sxor, xxor Expanded into the xor instruction
 snot, xnot Expanded into the not instruction

Expansion format

(1) sOP  %rd,imm16 / xOP  %rd,imm16  (OP = and, oor, xor, not)
 Example: xand  %rd,imm16

imm16 ≤ 0x7f 0x7f < imm16
and  %rd,imm16(6:0) ext  imm16(15:7)

and  %rd,imm16(6:0)
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8.6.4  Data Transfer Instructions (between Stack and Register)

Types and functions of extended instructions
Extended instruction function Expansion

sld.b   %rd,[%sp+imm20] %rd ← B[%sp+imm20]  (with sign extension) (1)
sld.ub  %rd,[%sp+imm20] %rd ← B[%sp+imm20]  (with zero extension) (1)
sld     %rd,[%sp+imm20] %rd ← W[%sp+imm20] (1)
sld.a   %rd,[%sp+imm20] %rd ← A[%sp+imm20](23:0), ignored ← A[%sp+imm20](31:24) (1)
sld.b   [%sp+imm20],%rs B[%sp+imm20] ← %rs(7:0) (1)
sld     [%sp+imm20],%rs W[%sp+imm20] ← %rs(15:0) (1)
sld.a   [%sp+imm20],%rs A[%sp+imm20](23:0) ← %rs(23:0), A[%sp+imm20](31:24)← 0 (1)
xld.b   %rd,[%sp+imm24] %rd ← B[%sp+imm24]  (with sign extension) (2)
xld.ub  %rd,[%sp+imm24] %rd ← B[%sp+imm24]  (with zero extension) (2)
xld     %rd,[%sp+imm24] %rd ← W[%sp+imm24] (2)
xld.a   %rd,[%sp+imm24] %rd ← A[%sp+imm24](23:0), ignored ← A[%sp+imm24](31:24) (2)
xld.b   [%sp+imm24],%rs B[%sp+imm24] ← %rs(7:0) (2)
xld     [%sp+imm24],%rs W[%sp+imm24] ← %rs(15:0) (2)
xld.a   [%sp+imm24],%rs A[%sp+imm24](23:0) ← %rs(23:0), A[%sp+imm20](31:24)← 0 (2)

 These extended instructions allow you to directly specify a displacement of up to 20 bits/24 bits. Specification 
of imm20/imm24 can be omitted.

Basic instructions after expansion
 sld.b, xld.b Expanded into the ld.b instruction
 sld.ub, xld.ub Expanded into the ld.ub instruction
 sld, xld Expanded into the ld instruction
 sld.a, xld.a Expanded into the ld.a instruction

Expansion formats
 If imm20/imm24 is omitted, the as assembler assumes that [%sp+0x0] is specified as it expands the 

instruction. 

(1) sOP  %rd,[%sp+imm20]  (OP = ld.b, ld.ub, ld, ld.a)
 sOP  [%sp+imm20],%rs  (OP = ld.b, ld, ld.a)
 Example: sld.a  %rd,[%sp+imm20]

imm20 ≤ 0x7f 0x7f < imm20
ld.a  %rd,[%sp+imm20(6:0)] ext   imm20(19:7)

ld.a  %rd,[%sp+imm20(6:0)]

(2) xOP  %rd,[%sp+imm24]  (OP = ld.b, ld.ub, ld, ld.a)
 xOP  [%sp+imm24],%rs  (OP = ld.b, ld, ld.a)
 Example: xld.a  %rd,[%sp+imm24]

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
ld.a  %rd,[%sp+imm24(6:0)] ext   imm24(19:7)

ld.a  %rd,[%sp+imm24(6:0)]
ext   imm24(23:20)
ext   imm24(19:7)
ld.a  %rd,[%sp+imm24(6:0)]
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8.6.5  Data Transfer Instructions (between Memory and Register)

Types and functions of extended instructions
Extended instruction function Expansion

sld.b   %rd,[imm20] %rd ← B[imm20]  (with sign extension) (1)
sld.ub  %rd,[imm20] %rd ← B[imm20]  (with zero extension) (1)
sld     %rd,[imm20] %rd ← W[imm20] (1)
sld.a   %rd,[imm20] %rd ← A[imm20](23:0), ignored ← A[imm20](31:24) (1)
sld.b   [imm20],%rs B[imm20] ← %rs(7:0) (1)
sld     [imm20],%rs W[imm20] ← %rs(15:0) (1)
sld.a   [imm20],%rs A[imm20](23:0) ← %rs(23:0), A[imm20](31:24)← 0 (1)
xld.b   %rd,[imm24] %rd ← B[imm24]  (with sign extension) (2)
xld.ub  %rd,[imm24] %rd ← B[imm24]  (with zero extension) (2)
xld     %rd,[imm24] %rd ← W[imm24] (2)
xld.a   %rd,[imm24] %rd ← A[imm24](23:0), ignored ← A[imm24](31:24) (2)
xld.b   [imm24],%rs B[imm24] ← %rs(7:0) (2)
xld     [imm24],%rs W[imm24] ← %rs(15:0) (2)
xld.a   [imm24],%rs A[imm24](23:0) ← %rs(23:0), A[imm24](31:24)← 0 (2)

 These extended instructions allow memory locations to be accessed by specifying the address with a 20-bit/24-
bit immediate. However, the postincrement function ([]+) cannot be used. 

Basic instructions after expansion
 sld.b, xld.b Expanded into the ld.b instruction
 sld.ub, xld.ub Expanded into the ld.ub instruction
 sld, xld Expanded into the ld instruction
 sld.a, xld.a Expanded into the ld.a instruction

Expansion formats

(1) sOP  %rd,[imm20]  (OP = ld.b, ld.ub, ld, ld.a)
 sOP  [imm20],%rs  (OP = ld.b, ld, ld.a)
 Example: sld.a  %rd,[imm20]

imm20 ≤ 0x7f 0x7f < imm20
ld.a  %rd,[imm20(6:0)] ext   imm20(19:7)

ld.a  %rd,[imm20(6:0)]

(2) xOP  %rd,[imm24]  (OP = ld.b, ld.ub, ld, ld.a)
 xOP  [imm24],%rs  (OP = ld.b, ld, ld.a)
 Example: xld.a  %rd,[imm24]

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
ld.a  %rd,[imm24(6:0)] ext   imm24(19:7)

ld.a  %rd,[imm24(6:0)]
ext   imm24(23:20)
ext   imm24(19:7)
ld.a  %rd,[imm24(6:0)]
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8.6.6  Immediate Data load Instructions

Types and functions of extended instructions
Extended instruction function Expansion

sld    %rd,imm16 %rd ← imm16 (1)
sld.a  %rd,imm20 %rd ← imm20 (2)
sld.a  %sp,imm20 %sp ← imm20 (2)
sld    %rd,symbol±imm16 %rd ← symbol±imm16(15:0) (4)
sld.a  %rd,symbol±imm20 %rd ← symbol±imm20(19:0) (5)
sld.a  %sp,symbol±imm20 %sp ← symbol±imm20(19:0) (5)
xld    %rd,imm16 %rd ← imm16 (1)
xld.a  %rd,imm24 %rd ← imm24 (3)
xld.a  %sp,imm24 %sp ← imm24 (3)
xld    %rd,symbol±imm16 %rd ← symbol±imm16(15:0) (4)
xld.a  %rd,symbol±imm24 %rd ← symbol±imm24(23:0) (6)
xld.a  %sp,symbol±imm24 %sp ← symbol±imm24(23:0) (6)

 These extended instructions allow a 16-bit/20-bit/24-bit immediate to be loaded directly into a general-purpose 
register. A symbol also can be used for immediate specification. 

Basic instructions after expansion
 sld, xld Expanded into the ld instruction
 sld.a, xld.a Expanded into the ld.a instruction

Expansion formats

(1) sld  %rd,imm16 / xld  %rd,imm16
 Example: xld  %rd,imm16

imm16 ≤ 0x7f 0x7f < imm16
ld  %rd,imm16(6:0) ext  imm16(15:7)

ld   %rd,imm16(6:0)

(2) sld.a  %rd,imm20 / sld.a  %sp,imm20
 Example: sld.a  %rd,imm20

imm20 ≤ 0x7f 0x7f < imm20
ld.a  %rd,imm20(6:0) ext   imm20(19:7)

ld.a  %rd,imm20(6:0)

(3) xld.a  %rd,imm24 / xld.a  %sp,imm24
 Example: xld.a  %rd,imm24

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
ld.a  %rd,imm24(6:0) ext   imm24(19:7)

ld.a  %rd,imm24(6:0)
ext   imm24(23:20)
ext   imm24(19:7)
ld.a  %rd,imm24(6:0)

(4) sld  %rd,symbol±imm16 / xld  %rd,symbol±imm16
 Example: sld  %rd,symbol±imm16

Unconditional
ext  (symbol±imm16)(15:7)
ld   %rd,(symbol±imm16)(6:0)

(5) sld.a  %rd,symbol±imm20 / sld.a  %sp,symbol±imm20
 Example: sld.a  %rd,symbol±imm20

Unconditional
ext   (symbol±imm20)(19:7)
ld.a  %rd,(symbol±imm20)(6:0)
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(6) xld.a  %rd,symbol±imm24 / xld.a  %sp,symbol±imm24
 Example: xld.a  %rd,symbol±imm24

Unconditional
ext   (symbol±imm24)(23:20)
ext   (symbol±imm24)(19:7)
ld.a  %rd,(symbol±imm24)(6:0)
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8.6.7  Branch Instructions

Types and functions of extended instructions
Extended instruction function Expansion

scall   label±imm20 PC relative subroutine call (1)
sjpr    label±imm20 PC relative unconditional jump (1)
sjreq   label±imm20 PC relative conditional jump (2)
sjrne   label±imm20 PC relative conditional jump (2)
sjrgt   label±imm20 PC relative conditional jump (2)
sjrge   label±imm20 PC relative conditional jump (2)
sjrlt   label±imm20 PC relative conditional jump (2)
sjrle   label±imm20 PC relative conditional jump (2)
sjrugt  label±imm20 PC relative conditional jump (2)
sjruge  label±imm20 PC relative conditional jump (2)
sjrult  label±imm20 PC relative conditional jump (2)
sjrule  label±imm20 PC relative conditional jump (2)
scalla  label±imm20 PC absolute subroutine call (3)
sjpa    label±imm20 PC absolute unconditional jump (3)
scall   sign20 PC relative subroutine call (4)
sjpr    sign20 PC relative unconditional jump (4)
sjreq   sign20 PC relative conditional jump (5)
sjrne   sign20 PC relative conditional jump (5)
sjrgt   sign20 PC relative conditional jump (5)
sjrge   sign20 PC relative conditional jump (5)
sjrlt   sign20 PC relative conditional jump (5)
sjrle   sign20 PC relative conditional jump (5)
sjrugt  sign20 PC relative conditional jump (5)
sjruge  sign20 PC relative conditional jump (5)
sjrult  sign20 PC relative conditional jump (5)
sjrule  sign20 PC relative conditional jump (5)
scalla  imm20 PC absolute subroutine call (6)
sjpa    imm20 PC absolute unconditional jump (6)
xcall   label±imm24 PC relative subroutine call (7)
xjpr    label±imm24 PC relative unconditional jump (7)
xjreq   label±imm24 PC relative conditional jump (8)
xjrne   label±imm24 PC relative conditional jump (8)
xjrgt   label±imm24 PC relative conditional jump (8)
xjrge   label±imm24 PC relative conditional jump (8)
xjrlt   label±imm24 PC relative conditional jump (8)
xjrle   label±imm24 PC relative conditional jump (8)
xjrugt  label±imm24 PC relative conditional jump (8)
xjruge  label±imm24 PC relative conditional jump (8)
xjrult  label±imm24 PC relative conditional jump (8)
xjrule  label±imm24 PC relative conditional jump (8)
xcalla  label±imm24 PC absolute subroutine call (9)
xjpa    label±imm24 PC absolute unconditional jump (9)
xcall   sign24 PC relative subroutine call (10)
xjpr    sign24 PC relative unconditional jump (10)
xjreq   sign24 PC relative conditional jump (11)
xjrne   sign24 PC relative conditional jump (11)
xjrgt   sign24 PC relative conditional jump (11)
xjrge   sign24 PC relative conditional jump (11)
xjrlt   sign24 PC relative conditional jump (11)
xjrle   sign24 PC relative conditional jump (11)
xjrugt  sign24 PC relative conditional jump (11)
xjruge  sign24 PC relative conditional jump (11)
xjrult  sign24 PC relative conditional jump (11)
xjrule  sign24 PC relative conditional jump (11)
xcalla  imm24 PC absolute subroutine call (12)
xjpa    imm24 PC absolute unconditional jump (12)
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 These extended instructions allow a branch destination to be specified using a 20-bit/24-bit immediate or 
a label. The branch conditions of these conditional jump instructions are the same as those of the basic 
instructions. 

 The extended instructions can be used as delayed branch instructions by adding ".d".
 Example: xcall.d  sign24

Basic instructions after expansion
 scall, scall.d, xcall, xcall.d Expanded into the call/call.d instruction
 scalla, scalla.d, xcalla, xcalla.d Expanded into the calla/calla.d instruction
 sjpa, sjpa.d, xjpa, xjpa.d Expanded into the jpa/jpa.d instruction
 sjpr, sjpr.d, xjpr, xjpr.d Expanded into the jpr/jpr.d instruction
 sjreq, sjreq.d, xjreq, xjreq.d Expanded into the jreq/jreq.d instruction
 sjrne, sjrne.d, xjrne, xjrne.d Expanded into the jrne/jrne.d instruction
 sjrgt, sjrgt.d, xjrgt, xjrgt.d Expanded into the jrgt/jrgt.d instruction
 sjrge, sjrge.d, xjrge, xjrge.d Expanded into the jrge/jrge.d instruction
 sjrlt, sjrlt.d, xjrlt, xjrlt.d Expanded into the jrlt/jrlt.d instruction
 sjrle, sjrle.d, xjrle, xjrle.d Expanded into the jrle/jrle.d instruction
 sjrugt, sjrugt.d, xjrugt, xjrugt.d Expanded into the jrugt/jrugt.d instruction
 sjruge, sjruge.d, xjruge, xjruge.d Expanded into the jruge/jruge.d instruction
 sjrult, sjrult.d, xjrult, xjrult.d Expanded into the jrult/jrult.d instruction
 sjrule, sjrule.d, xjrule, xjrule.d Expanded into the jrule/jrule.d instruction

Expansion formats

(1) sOP  label±imm20 (OP = call, call.d, jpr, jpr.d)
 Example: scall  label±imm20

Unconditional
ext   (label±imm20)(19:12)
call  (label±imm20)(11:1)

(2) sOP  label±imm20 (OP = jr*, jr*.d)
 Example: sjreq  label±imm20

Unconditional
ext   (label±imm20)(19:8)
jreq  (label±imm20)(7:1)

(3) sOP  label±imm20 (OP = calla, calla.d, jpa, jpa.d)
 Example: scalla  label±imm20

Unconditional
ext    (label±imm20)(19:7)
calla  (label±imm20)(6:0)

(4) sOP  sign20   (OP = call, call.d, jpr, jpr.d)
 Example: scall  sign20

-1024 ≤ sign20 ≤ 1023 sign20 < -1024
or 1023 < sign20

call  sign20(11:1) ext   sign20(19:12)
call  sign20(11:1)

(5) sOP  sign20   (OP = jr*, jr*.d)
 Example: sjreq  sign20

-128 ≤ sign20 ≤ 127 sign20 < -128
or 127 < sign20

jreq  sign20(7:1) ext   sign20(19:8)
jreq  sign20(7:1)
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(6) sOP  imm20    (OP = calla, calla.d, jpa, jpa.d)
 Example: scalla  imm20

imm20 ≤ 0x7f 0x7f < imm20
calla  imm20(6:0) ext    imm20(19:7)

calla  imm20(6:0)

(7) xOP  label±imm24 (OP = call, call.d, jpr, jpr.d)
 Example: xcall  label±imm24

Unconditional
ext   (label±imm24)(23:12)
call  (label±imm24)(11:1)

(8) xOP  label±imm24 (OP = jr*, jr*.d)
 Example: xjreq  label±imm24

Unconditional
ext   (label±imm24)(23:21)
ext   (label±imm24)(20:8)
jreq  (label±imm24)(7:1)

(9) xOP  label±imm24 (OP = calla, calla.d, jpa, jpa.d)
 Example: xcalla  label±imm24

Unconditional
ext    (label±imm24)(23:20)
ext    (label±imm24)(19:7)
calla  (label±imm24)(6:0)

(10) xOP  sign24   (OP = call, call.d, jpr, jpr.d)
 Example: xcall  sign24

-1024 ≤ sign24 ≤ 1023 sign24 < -1024
or 1023 < sign24

call  sign24(11:1) ext   sign24(23:12)
call  sign24(11:1)

(11) xOP  sign24   (OP = jr*, jr*.d)
 Example: xjreq  sign24

-128 ≤ sign24 ≤ 127 -1048576 ≤ sign24 < -128
or 127 < sign24 ≤ 1048575

sign24 < -1048576
or 1048575 < sign24

jreq  sign24(7:1) ext   sign24(20:8)
jreq  sign24(7:1)

ext   sign24(23:21)
ext   sign24(20:8)
jreq  sign24(7:1)

(12) xOP  imm24   (OP = calla, calla.d, jpa, jpa.d)
 Example: xcalla  imm24

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
calla  imm24(6:0) ext    imm24(19:7)

calla  imm24(6:0)
ext    imm24(23:20)
ext    imm24(19:7)
calla  imm24(6:0)
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8.6.8  Coprocessor Instructions

Types and functions of extended instructions
Extended instruction function Expansion

sld.cw  %rd,imm20 Coprocessor ← %rd & imm20 (1)
sld.ca  %rd,imm20 Coprocessor ← %rd & imm20, get results and flag statuses (1)
sld.cf  %rd,imm20 Coprocessor ← %rd & imm20, get flag statuses (1)
sld.cw  %rd,symbol±imm20 Coprocessor ← %rd & symbol±imm20 (2)
sld.ca  %rd,symbol±imm20 Coprocessor ← %rd & symbol±imm20, get results and flag statuses (2)
sld.cf  %sp,symbol±imm20 Coprocessor ← %rd & symbol±imm20, get flag statuses (2)
xld.cw  %rd,imm24 Coprocessor ← %rd & imm24 (3)
xld.ca  %rd,imm24 Coprocessor ← %rd & imm24, get results and flag statuses (3)
xld.cf  %rd,imm24 Coprocessor ← %rd & imm24, get flag statuses (3)
xld.cw  %rd,symbol±imm24 Coprocessor ← %rd & symbol±imm24 (4)
xld.ca  %rd,symbol±imm24 Coprocessor ← %rd & symbol±imm24, get results and flag statuses (4)
xld.cf  %rd,symbol±imm24 Coprocessor ← %rd & symbol±imm24, get flag statuses (4)

 These extended instructions allow a 20-bit/24-bit immediate to be transferred to the coprocessor. A symbol also 
can be used for immediate specification. 

Basic instructions after expansion
 sld.cw, xld.cw Expanded into the ld.cw instruction
 sld.ca, xld.ca Expanded into the ld.ca instruction
 sld.cf, xld.cf Expanded into the ld.cf instruction

Expansion formats

(1) sOP  %rd,imm20    (OP = ld.cw, ld.ca, ld.cf)
 Example: sld.ca  %rd,imm20

imm20 ≤ 0x7f 0x7f < imm20
ld.ca  %rd,imm20(6:0) ext    imm20(19:7)

ld.ca  %rd,imm20(6:0)

(2) sOP  %rd,symbol±imm20  (OP = ld.cw, ld.ca, ld.cf)
 Example: sld.ca  %rd,symbol±imm20

Unconditional
ext    (symbol±imm20)(19:7)
ld.ca  %rd,(symbol±imm20)(6:0)

(3) xOP  %rd,imm24    (OP = ld.cw, ld.ca, ld.cf)
 Example: xld.ca  %rd,imm24

imm24 ≤ 0x7f 0x7f < imm24 ≤ 0xfffff 0xfffff < imm24
ld.ca  %rd,imm24(6:0) ext    imm24(19:7)

ld.ca  %rd,imm24(6:0)
ext    imm24(23:20)
ext    imm24(19:7)
ld.ca  %rd,imm24(6:0)

(4) xOP  %rd,symbol±imm24  (OP = ld.cw, ld.ca, ld.cf)
 Example: xld.ca  %rd,symbol±imm24

Unconditional
ext    (symbol±imm24)(23:20)
ext    (symbol±imm24)(19:7)
ld.ca  %rd,(symbol±imm24)(6:0)
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8.6.9  Xext Instructions

Types and functions of extended instruction
Extended instruction function Expansion

Xext  imm24 Expanded into the ext instruction （1）

 Combined with the instructions below, this instruction functions as the offset.

 Xext  imm24

 OP    [%rd], %rs ==> [%rd+imm24] ← Functions as %rs 

 Xext  imm24

 OP    %rd, [%rs] ==> %rd ← Functions as [%rs+imm24]

 （OP = ld.b, ld.ub, ld, ld.a）

Basic instructions after expansion
 Xext Expanded into the ext instruction

Expansion formats

（1） Xext  imm24
imm24 ≤ 0x1fff 0x1fff < imm24 ≤ 0xffffff

ext  imm20(12:0) ext    imm24(23:13)
ext    imm24(12:0)
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8.7  Optimization of Extended Instructions
The C compiler compiles all codes that reference a global symbol address and some codes that reference a local 
symbol address into s* or x* extended instructions. As shown in the preceding section, these extended instructions 
are expanded into a basic instruction with the ext instructions.
If the operand of an extended instruction is an immediate data, the assembler adds zero to two ext instructions to 
the basic instruction according to the immediate data size. So the optimization is completed at this point.
If the operand of an extended instruction is a symbol, the assembler adds the required number of ext instructions 
for referencing to the entire memory space, as the symbol value is not determined until linkage has completed. 
Therefore, unnecessary ext instructions may be output and it increases the code size. The -mc17_ext option is 
used for the optimization to remove unnecessary ext instructions.

-mc17_ext option

 -mc17_ext filename.dump filename.map

filename.dump File in which global and local symbol information is described. Use objdump to create this 
file. The file name extension must be ".dump".

 objdump -t filename.elf > filename.dump

filename.map File in which object mapping information is described. This file is delivered by the ld linker. 
The file name extension must be ".map".

 Example: objdump -t test.elf > test.dump
  as -mc17_ext test.dump test.map -otest.o test.s

Optimize procedure
 The assembler needs the symbol address information determined in the linkage process for the optimization and 

gets it from the link map and dump files specified with the -mc17_ext option. Therefore, the optimization 
needs a two-pass make process. The procedure shown below should be written in the makefile to perform a 
two-pass make process.

 1. Compile
 2. Assemble (without the -mc17_ext option)
 3. Link (with a map file output) 
 4. Create a dump file from the elf file using objdump.
 5. Reassemble (with the -mc17_ext option) * Specify the same input/output files as Step 2.

 The makefile created by the IDE contains the procedure above.



S5U1C17001C MANUAl Seiko Epson Corporation 8-27
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

8  ASSEMBlER

8
Assemblr

Optimize patterns
 The optimization process is classified under five patterns. 

 Optimization 1: for data transfer instructions
 Example:

  sub:
   ret

  main:
   xsub.a  %sp,0x4
          :
   xld.b   %r0,[sub]
   add.a   %sp,0x4
   ret

 The assembler obtains the address of the symbol (sub) from the dump and map files to determine the 
number of ext instructions to be used.

 Symbol address = 0 to 0x7f: The extended instruction (xld.b) is expanded with no ext used. 
 Symbol address = 0x80 to 0xfffff: The extended instruction (xld.b) is expanded with one ext used.
 Symbol address = 0xfffff to 0xffffff: The extended instruction (xld.b) is expanded with two ext used.

 Optimization 2: for arithmetic operation instructions
 Example:

  sub:
   ret

  main:
   xsub.a  %sp,0x4
          :
   xadd    %r1,sub
   add.a   %sp,0x4
   ret

 The assembler obtains the address of the symbol (sub) from the dump and map files to determine the 
number of ext instructions to be used.

 Symbol address = 0 to 0x7f: The extended instruction (xadd) is expanded with no ext used. 
 Symbol address = 0x80 to 0xfffff: The extended instruction (xadd) is expanded with one ext used.

 Optimization 3: for relative branch instructions  
 (scall/xcall/sjpr/xjpr/sjrxx/xjrxx instructions)
 Example:

  sub:
   ret

  main:
   xsub.a  %sp,0x4
          :
   xcall   sub  ← ADDR1
   add.a   %sp,0x4
   ret

 The assembler obtains the destination address (sub) directly from the dump and map files. The branch 
address (ADDR1) is not included in the dump and map files. Therefore, the assembler counts the 
instructions from the beginning address of the main routine that can be obtained from the dump and map 
files to calculate the distance from main to ADDR1. The number of ext instructions is determined from 
the branch distance calculated by subtracting the branch address from the destination address.

 scall/xcall/sjpr/xjpr instructions
Branch distance = -1024 to 1022:
 The extended instruction is expanded with no ext used. 
Branch distance = -16,777,216 to -1026 or 1024 to 16,777,214:
 The extended instruction is expanded with one ext used.
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 sjrxx/xjrxx instructions
Branch distance = -128 to 126:
 The extended instruction is expanded with no ext used.
Branch distance = -1,048,576 to -130 or 128 to 1,048,574:
 The extended instruction is expanded with one ext used.
Branch distance = -16,777,216 to -1,048,578 or 1,048,576 to 16,777,214:
 The extended instruction is expanded with two ext used.

 Note that ext instructions may be removed even in a case other than "ext 0". In the example below, no 
ext instruction is required since operand 3 will be automatically sign extended if all the bits of operands 1 

and 2 and the MSB of operand 3 are 1. In this case, the added ext instructions are removed.
 Example:
  L1:
         nop

        xjrgt  L1 ; (L1 - branch address - 2) >> 1 → -2

        Before optimization                              After optimization
         nop        nop
        ext   0x7  ← operand 1 (imm3)         jrgt  0x7e

         ext   0x1fff ← operand 2 (imm13)
         jrgt  0x7c  ← operand 3 (sign7)

 Optimization 4: for absolute branch instructions (scalla/xcalla/sjpa/xjpa instructions)
 Example:

  sub:
   ret

  main:
   xsub.a  %sp,0x4
          :
   xcalla  sub
   add.a   %sp,0x4
   ret

 The assembler obtains the destination address (sub) from the dump and map files and determines the 
number of ext instructions to be used directly from the destination address.

 Destination address = 0 to 0x7f: The extended instruction is expanded with no ext used.
 Destination address = 0x80 to 0xfffff: The extended instruction is expanded with one ext used.
 Destination address = 0xfffff to 0xffffff: The extended instruction is expanded with two ext used.

 Optimization 5: when the operand is an expression using a symbol
 Example:

  sub:
   ret

  main:
   xsub.a  %sp,0x4
          :
   xldb    %r0,[sub+0x2]
   add.a   %sp,0x4
   ret

 The assembler evaluates the expression in the operand and determines the number of ext instructions to be 
used.

 Evaluation result = 0 to 0x7f: The extended instruction is expanded with no ext used.
 Evaluation result = 0x80 to 0xfffff: The extended instruction is expanded with one ext used.
 Evaluation result = 0xfffff to 0xffffff: The extended instruction is expanded with two ext used.
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Notes
• When the ext instructions are written directly to an assembler source to extend basic instructions, they are 

not optimized. When creating an assembler source, use s* or x* extended instructions for data transfer, 
arithmetic operation, and branch if a symbol is used as the operand.

• If the branch destination symbol for a relative branch instruction is located in another section, the branch 
instruction will not be optimized.

 Example: .text_A 0x00000000 :
  {
      __START_ text_A = . ;
      sub_1.o(.text)
   sub_2.o(.text)
          sub_3.o(.text)
          sub_4.o(.text)
      __END_ text_A = . ;
    }

  .text_B 0x00C00000 : 
    {
      __START_text_B = . ;
      main.o(.text)
      __END_ text_B = . ;
    }

   In this example, the extended instructions for referencing or branching to a symbol between "main.o" and 
"sub_X.o" will not be optimized. Therefore, new sections should not be added in the linker script file (.lds) 
if they are not necessary.

   • When a file name is described twice or more in a dump file (source files with the same name (except 
extension and path) exist), optimization for local symbols using the dump file will not be performed. This 
is not applied when the uppercase and lowercase letter configuration is different even if the file name is the 
same. Furthermore, this condition does not affect optimization for global symbols using a map file.
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8.8  Error/Warning Messages
The following shows the principal error and warning messages output by the assembler as:

Table 8.8.1  Error messages
Error message Description

Error: Unrecognized opcode: 'XXXXX' The operation code XXXXX is undefined. 
Error: junk at end of line: 'XXXXX' A format error of the operand.
Error: XXXXXX: invalid register name The specified register cannot be used.
Error: operand out of range 
(XXXXXX: XXX not between AAA and BBB)

The value specified in the operand is out of the 
effective range.

Error: There are too many characters of one line in assembler 
source file. *

The number of characters (except for a new line 
character) in an assembler source line has exceeded 
2,047 characters.

Error: Cannot allocate memory. * Memory allocation by malloc() has failed.
Error: Cannot specify plurality source files. * More than one source file name is specified in the 

command line.
Error: Cannot find the dump file. * A dump file name is not specified even though the 

-mc17_ext option is specified. Or the specified 
dump file does not exist.

Error: Cannot find the map file. * A map file name is not specified even though the 
-mc17_ext option is specified. Or the specified map 
file does not exist.

Error: The format of the dump file is invalid. * The contents in the dump file specified with the 
-mc17_ext option are invalid.

Error: The format of the map file is invalid. * The contents of the map file specified with the 
-mc17_ext option are invalid.

Error: Cannot close the map file. * The map file specified with the -mc17_ext option 
cannot be closed after it has been read.

Error: There are too many characters of one line in dump file. * The number of characters (except for a new line 
character) in a line of the dump file specified with the 
-mc17_ext option has exceeded 2,047 characters.

Error: There are too many characters of one line in map file. * The number of characters (except for a new line 
character) in a line of the map file specified with the 
-mc17_ext option has exceeded 2,047 characters.

Error: Value of XXXX too large for field of AAA bytes at BBB The address of the label located XXXX bytes from the 
beginning of the .text session is too large. This label 
is referenced by the AAA-byte symbol table located 
BBB bytes from the beginning of the .rodata session.  

Error: Failed to hash symbols. -mc17_ext is specified but symbol name registration 
failed.

* When the source file is assembled through xgcc, assembling terminates after displaying the following error 
message instead of the above message:

 xgcc: cannot specify -o with -c or -S and multiple compilations

Table 8.8.2  Warning messages
Warning message Description

Warning: Unrecognized .section attribute: want a, w, x The section attribute is not a, w or x.
Warning: Bignum truncated to AAA bytes The constant declared (e.g. .long, .int) exceeds 

the maximum size. It has been corrected to AAA-byte 
size. 
(e.g. 0x100000012 → 0x12)

Warning: Value XXXX truncated to AAA The constant declared exceeds the maximum value 
AAA. It has been corrected to AAA. 
(e.g. .byte 0x100000012 → .byte 0xff)
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8.9  Precautions
• To perform assembly source level debugging with the debugger gdb, specify the --gstabs assembler option to 

add the source information to the output object file when assembling the source file.

• Always be sure to use the xgcc compiler and/or as assembler to add debugging information (.stab directive) 
in the source file and do not use any other method. Also be sure not to correct the debugging information that is 
output. Corrections could cause the as, ld or gdb to malfunction.

• To prevent errors during linkage, be sure to write the .section directive with the .align directive to clearly 
define the section boundary.

 Example:
            .section .rodata
           .align 2           ; ← Essential

   .long   data1
   .long   data2

• Up to 512 characters can be used for a global symbol name and up to 32,000 global symbols can be defined.

• The assembler source, map and dump files have an upper limit of 2,047 characters per line (except for a new line 
character). An error will occur if there is a line that exceeds the limit.

• More than one source file cannot be specified as the input file of the as assembler. An error will occur if 
specified.

 • The output file name specified with the -o option must be the same as that of the input source file name (except 
for the file name extension).

• When the ext instructions are written directly to an assembler source to extend basic instructions, they will 
not be optimized even if the -mc17_ext option is specified. When creating an assembler source, use s* or x* 
extended instructions for data transfer, arithmetic operation, and branch if a symbol is used as the operand.

• If the branch destination symbol for a relative branch instruction is located in another section, the branch 
instruction will not be optimized even if the -mc17_ext option is specified.

 Example: .text_A 0x00000000 :
  {
      __START_ text_A = . ;
      sub_1.o(.text)
   sub_2.o(.text)
          sub_3.o(.text)
          sub_4.o(.text)
      __END_ text_A = . ;
    }

  .text_B 0x00C00000 : 
    {
      __START_text_B = . ;
      main.o(.text)
      __END_ text_B = . ;
    }

  In this example, the extended instructions for referencing or branching to a symbol between "main.o" and 
"sub_X.o" will not be optimized. Therefore, new sections should not be added in the linker script file (.lds) if 
they are not necessary.

• When a file name is described twice or more in a dump file (source files with the same name (except extension 
and path) exist), optimization for local symbols using the dump file will not be performed. This is not applied 
when the uppercase and lowercase letter configuration is different even if the file name is the same. Furthermore, 
this condition does not affect optimization for global symbols using a map file.
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 This chapter describes the functions of the ld linker.

9.1  functions
The ld linker is a software that generates executable object files. It provides the following functions: 
• Links together multiple object modules including libraries to create one executable object file.
• Resolves external reference from one module to another. 
• Relocates relative addresses to absolute addresses.
• Delivers debugging information, such as line numbers and symbol information, in the object file created after 

linking. 
• Capable of outputting link map files.

This linker is based on the gnu linker (ld). For details about the ld linker, refer to the documents for the gnu linker. 
The documents can be acquired from the GNU mirror sites located in various places around the world through 
Internet, etc.

9.2  Input/Output files

file.ldsLinker script file

Link map file

gdb debugger

as assembler

Linker
ld

file.o

file.elf

file.a

file.map

User
Library

Library files

Object files

Executable
object file

libstdio.a

libc.a

ANSI library
Emulation library

Simulated I/O library

libgcc.a (libgccM.a/libgccMD.a)

Figure 9.2.1  Flowchart

9.2.1  Input files

Object file 
File format: Binary file in elf format
File name: <filename>.o 
Description: Object file of individual modules created by the as assembler. 

library file
File format: Binary file in library format 
File name: <filename>.a
Description: ANSI library files, emulation library files and user library files.

linker script file 
File format: Text file 
File name: <filename>.lds
Description: File to specify the start address of each section and other information for linkage. 
 The IDE may be used to create a linker script file.
 It is input to the ld linker when the -T option is specified. 
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9.2.2  Output files

Executable object file 
File format: Binary file in elf format 
File name: <filename>.elf
Description: Object file in executable format that can be input in the gdb debugger. All the modules comprising 

one program are linked together in the file, and the absolute addresses that all the codes will be 
mapped are determined. It also contains the necessary debugging information in elf format. 

 The default file name is a.out when no output file name is specified using the -o option.

link map file 
File format: Text file
File name: <filename>.map 
Description: Mapping information file showing from which address of a section each input file was mapped. 

The file is delivered when the -M or -Map option is specified. 

9.3  Starting Method

9.3.1  Startup format

To invoke the ld linker, use the command shown below. 

ld <options> <file names>

 <options> See Section 9.3.2.
 <file names> Specify one or more object file names and/or one ore more library file names.

 Example: ld -o sample.elf boot.o sample.o ..\lib\24bit\libc.a ..\lib\24bit\libgcc.a

9.3.2  Command-line Options

The ld linker accepts the gnu linker standard options. The following lists the principal options only. Refer to the 
gnu linker manual for more information.

-o <filename>

Function: Specify output file name
Explanation: This option is used to specify the name of the object file output by the ld linker.
Default: The default output file name is a.out.

-T <linker script file name> 

Function: Read linker script file 
Explanation: Specify this option when loading relocate-information into the ld linker using a linker script file. 
Default: The default linker script (see Section 9.4.1) is used.

-M

-Map <filename> 

Function: Output link map file 
Explanation: The -M option outputs the link map information to stdio. 
 The -Map option outputs the link map information to a file.
Default: No link map information is output.

-N

Function: Disable data segment alignment check
Explanation: When the -N option is specified, the linker does not check the alignment of data segments. This 

option should be used normally. (see Section 9.6, "Precautions".)
Default: The linker checks the alignment of data segments.

When inputting options in the command line, one or more spaces are necessary before and after the option. 
Example: ld -o sample.elf -T sample.lds -N boot.o sample.o ..\lib\24bit\libc.a
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9.4  linkage

9.4.1  Default linker Script

Default linker script when the -T option is not specified
 When the -T option is not specified, the ld linker uses the default script shown below for linkage.

OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);
SECTIONS
{
    /* stack pointer symbols */
    __START_stack = 0x000FC0;

    /* section information */
    .bss 0x0 : 
      {
       __START_bss = . ;
       *(.bss)
       __END_bss = . ;
      }
    .data __END_bss : AT( __END_rodata )
      {
       __START_data = . ;
       *(.data)
       __END_data = . ;
      }
    .text 0x8000 : 
      {
       __START_vector = . ;
       *(.vector)
       __END_vector = . ;
       . = 0x80 ;
       __START_text = . ;
       *(.text)
       __END_text = . ;
      }
    .rodata __END_text : 
      {
       __START_rodata = . ;
       *(.rodata)
       __END_rodata = . ;
      }
    /* load address symbols */
    __START_data_lma = LOADADDR( .data );
}

 In this script, data will be located from address 0 in order of .bss and .data sections, the vector table, 
program codes and constant data will be located from address 0x8000.

 Figure 9.4.1.1 shows the memory map after linkage.

.text

Unused

.data
.bss

.rodata VMA=LMA
.data (initial values) LMA

.vector VMA=LMA

VMA=LMA
VMA

VMA=LMA

0x0

0x8080
0x8000

Figure 9.4.1.1  Memory map configured by default script

9
Linker
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9.4.2  Examples of linkage

When virtual and shared sections are used
 The following is a sample linker script when virtual and shared sections are used:

OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
 __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ; 
    *(.bss) ;
    __END_bss = . ; 
   }

 .data __END_bss : AT( __END_text )
   {
    __START_data = . ; 
    *(.data) ;
    __END_data = . ; 
   }
 __START_data_lma = LOADADDR( .data );

 .text_foo1 __END_data : AT( __START_data_lma+SIZEOF( .data )
   {
    __START_text_foo1 = . ; 
    foo1.o(.text) ;
    __END_text_foo1 = . ; 
   }
 __START_text_foo1_lma = LOADADDR( .text_foo1 );

 .text_foo2 __END_data : AT( __START_text_foo1_lma+SIZEOF( .text_foo1 )
   {
    __START_text_foo2 = . ; 
    foo2.o(.text) ;
    __END_text_foo2 = . ; 
   }
 __START_text_foo2_lma = LOADADDR( .text_foo2 );

 .text_foo3 __END_data : AT( __START_text_foo2_lma+SIZEOF( .text_foo2 )
   {
    __START_text_foo3 = . ; 
    foo3.o(.text) ;
    __END_text_foo3 = . ; 
   }
 __START_text_foo3_lma = LOADADDR( .text_foo3 );

 .rodata 0x008000 : 
   {
    __START_rodata = . ; 
    *(.rodata) ;
    __END_rodata = . ; 
   }

 .text __END_rodata : 
   {
    __START_text = . ; 
    *(.text) ;
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    __END_text = . ; 
   }

}
 The section map is shown in Figure 9.4.2.1.

Copy before
using.

Shared section

Virtual section

∗ – .bss VMA

∗ – .data VMA

__START_bss=0x0

RAM

ROM

__END_bss=__START_data

__END_data=__START_text_foo1/foo2/foo3

∗ – .rodata LMA=VMA

∗ – .text LMA=VMA

∗ – .data LMA

LMA

__START_rodata=0x8000

__END_rodata=__START_text

__END_text=__START_data_lma

__START_data_lma+SIZEOF(.data)=__START_text_foo1_lma

__START_text_foo1_lma+SIZEOF(.text_foo1)=__START_text_foo2_lma

__START_text_foo2_lma+SIZEOF(.text_foo2)=__START_text_foo3_lma

foo1/foo2/foo3 – 
.text_foo1/foo2/foo3

foo1 – .text_foo1

LMAfoo2 – .text_foo2

LMAfoo3 – .text_foo3

VMA
__END_text_foo1/foo2/foo3

Figure 9.4.2.1  Memory map

 The substance of the .data section is placed on the LMA in the ROM, and it must be copied to the VMA in 
the RAM (immediately following the .bss section) before it can be used. The .data section (VMA) in the 
RAM is a virtual section that does not exist when the program starts executing. This method should be used for 
handling variables that have an initial value. In this example, the .data sections in all the files are combined 
into one section.

 .text_foo1 is the .text section in the foo1.o file. Its actual code is located at the LMA in the ROM and 
is executed at the VMA in the RAM. Also the .text_foo2 and .text_foo3 sections are used similarly 
and the same VMA is set for these three sections. The RAM area for .text_foo1/2/3 is a shared section 
used for executing multiple .text sections by replacing the codes. A program cache for high-speed program 
execution is realized in this method. The .text sections in other files than these three files are located in 
the .text section that follows the .rodata section (0x8000–) and are executed at the stored address in the 
ROM.

9
Linker
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9.5  Error Messages
Error messages are displayed/output through the Standard Output (stdout). 
In the ld linker, the following error messages are added to the standard error messages of the gnu linker:

Table 9.5.1  Error messages
Error message Description

Error: The offset value of a symbol is over 16bit. The address of the symbol exceeds the 16-bit address 
space.

Error: The offset value of a symbol is over 24bit. The address of the symbol exceeds the 24-bit address 
space.

Error: section XXX is not within 16bit address. The address of the XXX section exceeds the 16-bit 
address space.

Error: section XXX is not within 24bit address. The address of the XXX section exceeds the 24-bit 
address space.

Error: Input bject file <objectfile> [included from 
<archivefile>] is not for C17.

The object file is not compatible with the C17.

Error: Input object file <objectfile> is not 16bit nor 24bit 
address mode.

The object file is neither in 16-bit or 24-bit mode.

Error: Cannot link 16bit object <objectfile16> [included 
from <archivefile16> ] with 24bit object <objectfile24> 
[included from <archivefile24> ] 

Object files created in 16-bit pointer mode and object files 
created in 24-bit pointer mode cannot be linked.
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9.6  Precautions
• When the linker is executed, an error message as shown below may appear.

 ld: test.elf: Not enough room for program header, try linking with -N

 This error occurs in the alignment check for the data segment. The linker's alignment check can be disabled with 
the -N option, so normally specify the -N option when invoking the linker. (The make file generated by the IDE 
contains the linker command line with the -N option.)

• The object file names are case-sensitive. It is necessary to specify the exact same file name in the ld command 
line and the linker script file. If the upper/lower case is different, ld considers them as two different files.

 Example:
 Command line
  ld -T sample.lds -o sample.elf prg1.o prg2.o

 Linker script file (sample.lds)
   :
  .text 0xc00000:

  {

  PRG1.o (.text) ← PRG1.o must be changed to prg1.o.
  prg2.o (.text)

  }

   :

• Linking files of different sizes with the same function name displays the following message. 

 Warning: size of symbol 'AAA' changed from BBB to CCC in DDD.o

 AAA: Duplicate function name
 BBB, CCC: Size of function
 DDD: File name to be linked

 If file sizes match, this message is not displayed. When linking files, be careful to avoid specifying the same 
function name. Take particular care to avoid assigning a function name already included in the library file (*.a).

• If "*" and individual object file specification coexist in a linker script file as in the example below, the files 
may not link correctly. If object files do not need to be specified individually, use only "*". With this exception, 
specify object files individually.

 Example:
 .text 0x00600000 :

 {

 *(.text) ;

 }

 .text2 :

 {

 main.o(.text) ;

 }

• Linking two or more library files (*.a) that contain the same function does not cause an error (no double linkage 
performed).

 Note that an error occurs when two or more object files (*.o) that contain the same function are linked.

• If the located address, which is specified by a variable or the result of a calculation with a variable, is higher than 
the 24-bit limit (0xffffff) or lower than 0x0, the address bits that exceed 24 bits are masked with 0 and no error 
occurs. 

 Example: xadd.a %r0,symbol-5
 If the symbol is located at address 0, the specified absolute address is 0 - 5 = 0xfffffb (-5). Therefore, this 

code will be assembled as "xadd.a %r0,0xfffffb".

9
Linker
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 This chapter describes how to use the debugger gdb.

10.1  features
The debugger gdb is software used to debug a program after loading an elf-format object file created by the linker.
This debugger has the following features and functions:
• Debugs using the integrated development environment (IDE) debugging function.
• Can reference various types of data at one time, thanks to a multi-window facility.
• In addition to debugging programs using the ICD Mini (S5U1C17001H) or ICD board, the debugger incorporates 

a software simulator function for debugging programs on a personal computer. 
• Capable of C source and assembly source level debugging.
• Supports C source and assembler level single-stepping functions, in addition to continuous program execution.
• Supports hardware and software PC break functions.
• Can measure program execution time by duration of time or number of cycles.
• Supports a trace function that allows saving of the traced data (in simulator mode).
• Can automatically execute commands using a command file.
• Supports a simulated I/O function that allows Stdin/Stdout evaluation in the debugger.
• Supports the embedded system simulator that allows evaluation of port input/output, SVD and LCD display in 

the debugger.
• Supports the flash writer function of the ICD Mini (S5U1C17001H).

10.2  Input/Output files

Debugger

gdb

Embedded system simulator

ES-Sim17

file.cmd

Command
file

file.log

Command 
log file

file.log

Trace
log file

file.log

Stdout file

from Linker

ICD

file.par

Parameter file

file.xxx

Motorola
HEX fileStdin file

Profile/coverage
data file

c17_profile_path.gdb

Profile/coverage
data path file

c17_profile_path.gdb

Storage location file for
profile/coverage data files

c17_profile.prf

Profile/coverage data file

User definition button

command file

userdefine.gdb

Reset definition

command file

reset.gdb

file.elf

elf object file

file.c
file.s

Source file(s)

file.xxx

c17_profile.prf

Figure 10.2.1  Flowchart

10.2.1  Input files

Parameter file
File format: Text file
File name: <filename>.par
Description: This file has recorded in it the contents needed to set the memory map information for the debugger. 
 The [Project > Properties > GNU17 Parameter Settings] dialog box of the IDE displayed by 

selecting Project and then Properties may be used to create parameter files. For details about 
parameter files, see Section 10.9, "Parameter Files".
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Object file
File format: elf format binary file
File name: <filename>.elf
Description: This is the elf format absolute object file created by the linker ld. This file is loaded in the 

debugger by using the file and load commands. Source display and symbolic debugging are 
made possible by loading an object file that contains debug information.

Source files
File format: Text file
File name: <filename>.c (C source), <filename>.s (assembly source)
Description: These are source files for the object file above, loaded in the debugger to generate source display.

Command file
File format: Text file
File name: <filename>.cmd
Description: This file contains a description of debugging commands to be executed successively. By writing a 

series of frequently used commands in a file, you can save the time and labor required for entering 
commands from the keyboard each time. This file is loaded in the debugger and executed by the 
startup option -x or the source command.

ROM data HEX file
File format: Motorola (S1 to S3) format HEX file
File name: Desired filename (e.g., .psa, .sa, or .saf)
Description: This object file does not contain debug information created from an object file (.elf). Source 

level debugging is not performed for ROM data HEX files, since debugging information is not 
included. It is used with the load command to load programs and data to target memory and with 
the flash writer function c17 fwlp and c17 fwld commands.

Input simulation data file
File format: Text file
File name: Any file name
Description: This file is loaded in the debugger by the simulated input function. The c17 stdin command is 

used to specify the file name and other information.

Reset definition command file
File format: Text file
File name: reset.gdb
Description: Same as the command file.

User-defined button command file
File format: Text file
File name: userdefine.gdb
Description: Same as the command file.

Profile/coverage data file
File format: Binary file
Filename: c17_profile.prf
Description: This is a measurement result data file created by the execution of the c17 profile or c17 

coverage command.

Profile/coverage data path file
File format: Text file
Filename: c17_profile_path.gdb
Description: This is the path in which profile/coverage data files (c17_profile.prf) are stored. It is referenced by 

the profile window and coverage window.
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10.2.2  Output files

Trace information file
File format: Text file
File name: Any file name
Description: This file contains trace results output by the debugger. The c17 tm command is used to specify a 

file name and other information for trace results to be output.

log file
File format: Text file
File name: Any file name
Description: The commands executed and execution results are output to this file. The c17 log command is 

used to specify a file name and other information for logs to be output.

Output simulation data file
File format: Text file
File name: Any file name
Description: This file is created by the simulated output function. The c17 stdout command is used to 

specify a file name and other information.

Profile/coverage data file
File format: Binary file
Filename: c17_profile.prf
Description: This is a measurement result data file created by the execution of the c17 profile or c17 coverage 

command.

Profile/coverage data path file
File format: Text file
Filename: c17_profile_path.gdb
Description: This is the path in which the profile/coverage data files (c17_profile.prf) are stored. It is referenced 

by the profile window and coverage window.
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10.3  Starting the Debugger

10.3.1  Startup format 

general command line format
 gdb [<startup option>]

 The brackets [ ] denote that the specification can be omitted. 

Operation on IDE
 After setting the necessary startup commands in the [Project] > [Properties] > [GNU17 GDB Commands] 

dialog box displayed, select [Run] > [Debug Configurations...], select [GNU17 Debugging] > [GDB Debugger 
for <Project Name>] in the debug start/launch configuration dialog box displayed, and then click the [Debug] 
button.

 The debug start/launch configuration dialog box can be opened via the [Debug] button menu on the toolbar.
 For more information about the debug start/launch configuration dialog box, refer to "Launch configuration 

dialog box" in Section 5.8.3, "Starting Up the Debugger".

Precautions
• Except when a second S5UIC17001H is connected using the "target icd usb2" command, avoid 

launching a second instance of the debugger. If invoked twice, the debugger may not operate normally.

10.3.2  Startup Options

The debugger has six available startup options. For more information on how to select in the IDE, refer to Section 
5.8.3, "Starting Up the Debugger."

--command=<command filename>
-x <command filename>

Function: Specifies a command file
Explanation: When this option is specified, the debugger loads the specified command file at startup and 

executes the commands written in the file. 

--c17_cmw=<wait in seconds>
Function: Specifies a time interval at which to execute commands in a command file
Explanation: When the debugger executes a command file as specified by the -x or --command option or 

source command, this option inserts a wait time between each command by a specified duration 
in seconds. The wait time can be specified from 1 to 256 seconds. If any other value is specified, a 
1-second wait time is assumed.

--cd=<directory path string>
Function: Changes the current directory
Explanation: When this option is specified, the debugger sets the specified path for the current directory at 

startup. If this option is omitted, the directory written in the gdbtk.ini file (or directory 
containing gdb.exe, if gdbtk.ini not found) is assumed.

--directory=<directory path string>
Function: Changes the source file directory
Explanation: This option can be used to specify the directory containing the source files. Multiple instances of 

this option can be specified.

--c17_double_starting

Function: Enables double starting 
Explanation: This option enables launching a second instance of the debugger in one PC that is disabled by 

default. 

When entering options on the command line, insert one or more spaces to delimit each option. 
Example: c:\EPSON\gnu17\gdb -x sample.cmd --cd=/cygdrive/d/test/sample
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Notes: • An error message as shown below will be displayed if an unknown option is specified.
  Error message:  · · · gdb : unrecognized option 'XXXXXX'

 • A second instance of the debugger cannot be run in one PC by default.

10.3.3  Quitting the Debugger

Console view operation
 Debugging is terminated using the quit (q) command input.
 (gdb)

 q

IDE operation
 Debugging can be terminated using any of the methods below.
 The [Debug] view display will change to the terminated state after debugging has ended.

• Select [Terminate] on the [Run] menu.
• Click the [Terminate] button in [Debug] view.
• Click the [Terminate] button in [Console] view.
• Select [Terminate] from the Context menu in [Debug] view.

 For details of [Console] and [Debug] views, refer to the respective view sections.

Note: When using an ICD to debug a program (in ICD Mini mode), always be sure to close the 
debugger before turning off power to the ICD. Should you turn off power to the ICD while running 
the debugger, you will be unable to reconnect it. In such case, you need to restart your computer.
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10.4  Windows
This section describes the types of windows used in the debugger.

10.4.1  Debug Perspective

10.4.1.1  Toggling Debug 
The following dialog box appears when the debugger is launched.

[Yes]: Automatically toggles to debug perspective.
[No]: Perspective is not toggled.
[Remember my decision]: Always opens the debug perspective using the current settings.
 Automatically toggles to debug perspective without displaying this dialog box in 

future.
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10.4.1.2  Debug Perspective Configuration
The debug perspective opens the various views used for debugging on the screen.
The following views are opened when using the default settings.

Table 10.4.1.2.1  Debug perspective views
View function

Debug Operation window for debugging.
Used for running, stopping, and restarting program steps during 
debugging.
Displays the program status and stack frame during debugging.

Source Highlights the line to be run.
Sets and cancels breakpoints.

Console Console for displaying the command execution and execution 
results sent to the debugger.

Variables Displays the local variables.
Outline Displays the configuration (variables/functions) of the source 

displayed by the [Source] editor
Breakpoints Lists the breakpoints.
Registers Displays the register values.
Memory Displays the memory area.

Note: The views shown below close automatically when debugging ends. They open again 
automatically the next time debugging starts. (They will not open automatically if they were closed 
during debugging.)
• [Memory] view
• [Registers] view
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10.4.1.3  Opening/Closing View
Views other than those described above can be opened by clicking [Window] > [Show View]. The same applies 
when opening views that have been closed by the user.

The views that can be used with debugging are listed below.
Views other than those listed here are not supported.

Table 10.4.1.3.1  [Window] > [Show View] menu
View available with debugging function

Breakpoints Breakpoints list
Console Command input and Simulated I/O output to GDB
Debug Start/end/run/stop debugging
Disassembly Disassembly display
Expressions Watch expressions
Memory Memory
Registers Registers
Variables Local variables
Trace PC trace

Views can be closed by clicking the X button on the tab.
All of these views can be dragged, enlarged/reduced, minimized, or maximized.
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10.4.1.4  Customizing Perspective
Views can be rearranged for ease of use.

Views can be rearranged by dragging the tab section to the desired location.

Views can be closed if not required.

The view arrangement is remembered when the IDE is closed, and retained the next time it is launched.

To return the perspective settings to their original factory defaults, click [Window] > [Reset Perspective...].

10.4.1.5  Menu/Toolbar
This section describes the menu and toolbar using debug perspectives.

●[Run] menu
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Table 10.4.1.5.1  Toolbar [Run] menu
Menu function

Toggle Breakpoint Sets a line breakpoint at the cursor position.
(Only when the cursor is in [Source] editor)

Toggle Line Breakpoint Sets a line breakpoint at the cursor position.
(Only when the cursor is in [Source] editor)

Toggle Method Breakpoint Sets a function breakpoint at the function start position.
(Only when the cursor is in [Source] editor)

Toggle Watchpoint Not supported.
Skip All Breakpoints Temporarily skips all breakpoints.
Remove All Breakpoints Removes all the breakpoints
Reset Resets.
User Command Executes a user-defined command.
Restart Not supported.
Resume Without Signal Not supported.
Resume At Line Not supported.
Resume Resumes the program. (When the debugging program is suspended)
Suspend Suspends the program. (When the debugging program is running)
Terminate Stops the debugger (GDB) and ends debugging. (When the debugging 

program is running or suspended)
Step Into Step into. (When stack frame is selected in [Debug] view)
Step Over Step over. (When stack frame is selected in [Debug] view)
Step Return Step return. (When stack frame is selected in [Debug] view)
Run to Line Runs as far as the line specified by the cursor in [Source] editor or 

[Disassembly] view.
(When the cursor is in [Source] editor while the debugging program is 
suspended)

Use Step Filters Not supported.
Run Last Launched Not supported.
Debug Last Launched Starts debugging using the previously launched configuration.
Run History Not supported.
Run As Not supported.
Run Configurations... Not supported.
Debug History Displays the shortcuts to the debugging configurations recently 

launched in the submenu.
Debug As Not supported.
Debug Configurations... Opens the Launch Configurations dialog box.
External Tools Opens the external launch setting dialog box.

This is used for launching when debugging using older GUI versions.
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●[Window] menu

 

Table 10.4.1.5.2  Toolbar [Window] menu
Menu function

New Window Allows a new IDE window to be opened.
New Editor Opens a new currently active editor.
Open Perspective Toggles the debug or GNU17 perspective.
Show View Opens the view used for debugging.
Customize Perspective... Customizes/saves/resets the perspective.
Save Perspective As...
Reset Perspective...
Close Perspective Closes the perspective.
Close All Perspectives
Navigation See "[Window] menu" in Section 5.3.1, "Menu Bar".
Preferences Opens the IDE setting dialog box.
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10.4.1.6  Changing Settings
The IDE settings for debugging can be changed by clicking [Window] > [Preferences].
This section describes only the main settings used for debugging.

●[C/C++] > [Debug]
 These are the general settings for C debugging.

 

Table 10.4.1.6.1  [C/C++] > [Debug]
Setting Details

Opened view default settings Default view settings.
Show full paths Not supported.
Default variable format Display format for [Variables] view. Default: Natural.
Default expression format Display format for [Expressions] view. Default: Natural.
Default register format Display format for [Registers] view. Default: Hexadecimal.
Character encoding Sets the character encoding. Default: UTF-16
Disassembly options [Disassembly] view settings.
Maximum number of displayed 
instructions

Sets the maximum number of lines displayed in disassembly. Default: 100
This value is the number of lines displayed from the start of the functions in 
which the current PC is included. Going beyond the line number set by this 
value will display until the current function ends and will not simultaneously 
display the source. When this occurs, a larger value should be set.

Color of source lines Sets the color used for source lines. Default: Dark blue
Show source files in binaries Not supported.

The following setting windows in this tree should not be used.
●[C/C++] > [Debug] > [GDB MI]
●[C/C++] > [Debug] > [Debugger Types]
●[C/C++] > [Debug] > [Breakpoint Actions]
●[C/C++] > [Debug] > [Common Source Lookup]
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●[Run/Debug]
 These are the general settings used for debugging.

Table 10.4.1.6.2  [Run/Debug]
Setting Details

Reuse editor when displaying source 
code

Reuses the editor in source display. Default: ON
Do not change this.

Activate the workbench when a 
breakpoint is hit

Activates the workbench when stopped at a breakpoint. Default: ON

Activate the debug view when a 
breakpoint is hit

Activates [Debug] view when stopped at a breakpoint. Default: ON

Skip breakpoints during a ‘RUN to Line’ 
operation.

Temporarily skips breakpoints when using [Run to Line]. Default: OFF

Prompt for confirmation when deleting 
all breakpoints.

Displays a prompt for configuration when deleting all breakpoints. 
Default: ON

Prompt for confirmation when deleting 
breakpoint containers.

Displays a prompt for configuration when deleting breakpoint groups. 
Default: ON

Changed value color Value color changed in [Variables]/[Registers] view.
Default: Red (for list format only)

Changed value background color Value background color changed in [Variables]/[Registers] view.
Default: Yellow (for table format only)

Memory unbuffered color Not supported.
Memory buffered color Not supported.
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●[Run/Debug] > [launching]
 These are the settings determining behavior when the debugger is launched.

 

Table 10.4.1.6.3  [Run/Debug] > [Launching]
Setting Details

Save required dirty editors before 
launching

Saves editors not saved during editing before launching.
Always: Saved
Never: Not saved
Prompt: Prompts for confirmation (default)

Wait for ongoing build to complete 
before launching

Waits for build to complete if currently in progress.
Always: Waits (default)
Never: Does not wait
Prompt: Prompts for confirmation

Launch in debug mode when 
workspace contains breakpoints

Not supported.

Continue launch if project contains 
errors

Launch even if the project contains errors.
Always: Always launches
Prompt: Prompts for confirmation (default)

General Options
Build (if required) before launching Builds before launching if required. (When the run file is older than the 

source file)
Default: ON

Remove terminated launches when a 
new launch is created

Removes completed launches from [Debug] view when a new launch is 
created.
Default: ON

Prompt for confirmation when removing 
a configuration from the launch history

Not supported.

Size of recently launched applications 
list

Number of launch histories for [Run], [Debug], and [External Tools].
Default: 10

Launch Operation
Always launch the previously launched 
application

Launches using the previous debugging configuration when F11 or the 
Debug button is depressed. Default: ON
Do not change this setting.

Launch the selected resource or active 
editor. If not launchable

Launches using the configuration corresponding to the editor currently 
selected when F11 or the Debug button is depressed.
Either of the following methods can be used to launch if not launchable.
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Setting Details

Launch the associated project Launches using the configuration corresponding to the project currently 
selected.

Launch the previously launched 
application

Launches using the previous debugging configuration.

●[Run/Debug] > [Traditional Memory Reading]
These are settings for [Memory] view.
For details, see Section 10.4.9, "[Memory] View".

●[Run/Debug] > [Console]
These are settings for [Console] view.
For details, see Section 10.4.10, "[Console] View".

The following setting windows in this tree should not be used.
●[Run/Debug] > [String Substitution]
●[Run/Debug] > [Perspectives]
●[Run/Debug] > [View Management]
●[Run/Debug] > [External Tools]
●[Run/Debug] > [Launching] > [Default Launchers]
●[Run/Debug] > [Launching] > [Launch Configurations]
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10.4.2  [Debug] View

[Debug] view is the main window used in debugging, and contains the menus and toolbars used for debugging. 
This window is used for step running and stopping and resuming the program.
[Debug] view should always be kept open.

10.4.2.1  Window layout

10.4.2.2  Menu/Toolbar

●Toolbar
Table 10.4.2.2.1  Toolbar

Button function

Remove All Terminated 
Launches

Removes all of the terminated debug icons.

Restart Not supported.
Reset Resets.

Resume Resumes the program. (When the debugging program is suspended)
Suspend Suspends the program. (When the debugging program is running)

Terminate Stops the debugger (GDB) and ends debugging. (When the debugging 
program is running or suspended)

Terminate and Relaunch Terminates and restarts the debugger (GDB) currently running.
Disconnect Not supported.
Step Into Step into. (When stack frame is selected in [Debug] view)
Step Over Step over. (When stack frame is selected in [Debug] view)
Step Return Step return. (When stack frame is selected in [Debug] view)
Drop To Frame Not supported.
Instruction Stepping Mode [Step Into]/[Step Over] are step-run for individual assembler commands 

when depressed.
Use Step Filters Not supported.
User Command Runs a user-defined command.
Profile Launches the profiler window.
Coverage Launches the coverage window.
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●Context menu

 

Table 10.4.2.2.2  Context menu
Menu function

Copy Stack Copies the stack configuration below the icon selected in [Debug] view 
as a text string.

Find... Searches for icons within [Debug] view.

Drop To Frame Not supported.
Restart Not supported.
Reset Resets.
Step Into Step into. (When stack frame is selected in [Debug] view)
Step Over Step over. (When stack frame is selected in [Debug] view)
Step Return Step return. (When stack frame is selected in [Debug] view)
Instruction Stepping Mode [Step Into]/[Step Over] are step-run for individual mnemonic commands 

when depressed.
Use Step Filters Not supported.
Resume Without Signal Not supported.
Resume Resumes the program. (When the debugging program is suspended)
Suspend Suspends the program. (When the debugging program is running)
Terminate Stops the debugger (GDB) and ends debugging. (When the debugging 

program is running or suspended)
Terminate and Relaunch Relaunches after terminating the program.
Disconnect Not supported.
Remove All Terminated Removes all of the terminated icons in [Debug] view.
Relaunch Relaunches the debugger after termination.
Edit GDB17 Debugger for **** ... Opens the launch configuration dialog box for editing.

Edit Source Lookup... Not supported.
Lookup Source Not supported.
Terminate and Remove Terminates the debugger selected in [Debug] view and removes the 

icon.
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Menu function

Terminate/Disconnect All Terminates all of the debuggers currently launched.
Properties Not supported.
User Command Runs a user-defined command.
Profile Launches the profiler window.
Coverage Launches the coverage window.

●View menu

 

Table 10.4.2.2.3  View menu
Menu functions

Show Full Paths Toggles the path display for source files in the stack frame.
View Management... Not supported.

10.4.2.3  Display Details
The following items are displayed in tree form in [Debug] view.

Table 10.4.2.3.1  Display items
Item Description

Launch configuration Name of launch configuration used when launching debugger.

Debug target Debugger launched / launch time / status

Thread Thread being run (Normally only one)

Stack frame Stop position for target program
Information on stop position is displayed when this is selected.

Debugger process GDB process launched:
[Console] view is activated when selected, enabling GDB commands to 
be input.
(See Section 10.4.10, "[Console] View".)

Target program Program being debugged:
[Console] view is activated when selected, and simulated I/O is displayed.
(See Section 10.4.11, "[Simulated I/O] View".)
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10.4.2.4  Operation

●Opening/Closing views
 The [Debug] view opens automatically when the debugger is launched.
 [Debug] view should always be kept open during debugging.

 To open a view again, click [Window] > [Show View].
 Views can be closed by pressing the X button for the view. (Do not close during debugging.)

●Running debugging program
 The target program can be debugged (including step running, running, and stopping) using the menus or buttons 

in [Debug] view.

Note: [Debug] view must always be kept open for running the debugging program.

Resetting CPU
 [Reset] button:

 Runs the user-editable command file (\gnu17\reset.gdb).
 The default command file contains the instruction c17 rst.

 
The default settings when the CPU is reset are as listed below.

Table 10.4.2.4.1  Initial values when CPU is reset
C17 register Default setting

R0-R7 0x0
PC Boot address
PSR 0x0
SP 0xfffffc

Note: The operation of the c17 rstc command will differ depending on the connect mode.
• ICD Mini mode
 Determines the boot address using the S1C17 chip TTBR address.
• Simulator mode
 Select [Project]> [Properties] > [C17 GDB command], and open the [Create a simple startup 

command] dialog using the [Create commands from template] button to determine the boot 
address using the address specified for [Boot Vector Address].

 The c17 ttbr boot vector address is created in the command file.

Continuous execution
 [Resume] button:

 Continuously executes the suspended target program from the current PC.
 Programs executed using continuous execution will not be suspended until they are broken due to one of 

the following factors.
• The breakpoint is reached. (Including temporary breaks in Run To Line/until command)
• The [Suspend] button is clicked. (Except in Debug monitor mode)
• Any other break factor occurs.

 [Suspend] button:
 Forcibly suspends the target program while it is being executed.
 It can be used to break the target program execution if the CPU is in standby mode (HALT or SLEEP) or if the 

program is in an endless loop.
 The following view displays are updated when the program is suspended.

• [Console] view The (gdb) prompt is displayed enabling commands to be input. 
• [Source] editor The PC location line is highlighted.
• [Variables] view The local variables on the frame are displayed and updated.
• [Registers] view The registers are displayed and updated.
• [Memory] view The memory is displayed if the memory monitor is registered.
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Step execution
 [Step Into] button:

 Executes the target program for one line of source from the current PC.
 If [Instruction Stepping Mode] is selected, the target program is executed for one mnemonic instruction 

from the current PC.
 [Step Over] button:

 Executes the target program for one line of source from the current PC.
 Function calls and subroutine calls are executed as a single step, including all functions and subroutines 

called up.
 If [Instruction Stepping Mode] is selected, the target program is executed for one mnemonic instruction 

from the current PC.
 [Step Return] button:

 Executes the target program from the current PC. Execution is stopped after returning from the current 
function to the upper level.

 It cannot be clicked if the bottommost stack frame is selected.
 [Instruction Stepping Mode] button:

 Selecting this determines the processing for when the [Step Into] or [Step Over] button is clicked.

Table 10.4.2.4.2  [Instruction Stepping Mode] button status
Status Processing

Selected (ON) Executed for one mnemonic instruction when the [Step Into] 
or [Step Over] button is clicked.

Not selected (OFF) Executed for one C source line when the [Step Into] or [Step 
Over] button is clicked.

Note:  The GDB cannot determine the length of the function prolog in the case of programs that refer 
to variables without initializing the local variables. This may prevent [Step Into] from executing 
correctly within a function.

 Care must be taken to ensure that programs do not refer to undetermined variables.

Terminating debugging
 [Terminate] button:

 Terminates the debugger (GDB) being executed.

●Stack frame
 The stack frame is displayed when the target program is suspended.
 Selecting the stack frame enables the following debugging operations to be performed.
 [Stack frame] selection:

 The stack frame displays the suspend position and call-up layer when the program is suspended.
 Selecting the stack frame updates the following view displays.

• [Debug] view Button enabled/disabled status
• [Source] editor Highlights the current line.
• [Disassembly] view Displays the current function disassembly.
• [Breakpoints] view Highlights breakpoint at which the program was suspended.
• [Variables] view Displays the local variables on the frame selected.
• [Registers] view Displays the registers.
• [Memory] view Displays the memory.

Note: The stack frame must always be selected to refer to individual view statuses. The stack 
frame displays the current PC address, current function, and source line number. (Up to 
99)

 [Console]
 Selecting the debugger process (gdb.exe) activates the [Console] view and enables GDB commands to 

be input.
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Note:  Closing [Console] view prevents commands from being input.
 If [Console] view is closed, it should be reopened using the procedure described below.

1. Select [Window] > [Show View] > [Console].
2. Click the [Debug] view debugger process (gdb.exe).
3. Select [Pin Console] in [Console] view, to pin the console.

If the gdb console does not appear immediately after the debugger has been launched, 
temporarily disable pinning using [Pin Console] in [Console] view, click the debugger 
process (gdb.exe) icon in [Debug] view, and then click the [Pin Console] button before 
pinning the console.

For details, see Section 10.4.10, "[Console] View".

 Simulated I/O:
 Selecting the target program (elf during debugging) activates [Console] view and displays the simulated  

I/O output. See Section 10.4.11, "[Simulated I/O] View". 

Note:  Closing [Console] view prevents the simulated I/O output from being displayed.
 [Console] view must be left open when using simulated I/O.
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10.4.2.5  Restrictions
• A maximum of 99 stack frames can be displayed.

• Stack frames cannot be displayed correctly in the following cases.
- If the contents of this area are overwritten after the program has been loaded to RAM
- If there are no ret/ret.d/reti instructions until instruction 4096 toward the upstream address from 

the current PC on the assembler
-  Immediately after a PC reset

• Execution commands (e.g., next/nexti/finish/until/continue) and quit command are included in the command 
file and "User defined command file (\gnu17\userdefine.gdb)" executed using the user command button. 
Debugging cannot start if the breakpoint is not hit or if the program enters an endless loop.

 If these execution files are included in the command file, it will be necessary to stop using the boot routine or 
ensure that the program stops by setting so that breakpoints are hit.

 If a program like this is executed, the GDB will have to be suspended via the Task Manager.
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10.4.3  [Source] Editor

Editors used for editing source on the IDE are also used for displaying the current line during debugging. [Source] 
editor is also used for setting breakpoints.
Disassembly is displayed in [Disassembly] view. See Section 10.4.4, "[Disassembly] View".

10.4.3.1  Window layout
[Source] editor enables multiple source files to be opened from [C/C++ Projects] view or other views in the GNU17 
perspective even during debugging.

 Line number ruler Overview ruler

[Source] editor consists of a central editing area with the line number ruler on the left-hand side and Overview ruler 
on the right-hand side. Breakpoints can be placed on the line number ruler.
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10.4.3.2  Menu/Toolbar
Operation is the same as for the "[Run] menu" in "10.4.1.5 Menu/Toolbar".
There is no dedicated menu/toolbar for [Source] editor.

●Context menu

 

 This section describes only those menus that can be used during debugging.
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Table 10.4.3.2.1  Context menu
Menu function

Run to Line Runs as far as the line specified by the cursor in [Source] editor or 
[Disassembly] view. (When the cursor is in [Source] editor while the 
debugging program is suspended)

Resume At Line Not supported.
Add Watch Expression... Opens the dialog box for registering watch expressions in [Expressions] view.
Run As Not supported.
Debug As Displays the menu for opening the launch configuration window.

10.4.3.3  Display Details

●Current line display
 When the target program is run, the current PC address line (the next line to be executed) is highlighted in 

green. The display details are not updated while the program is being run.
 The source file for the current line is opened automatically, but can also be opened manually by double-clicking 

the [Debug] view stack frame.

 <Conditions for displaying current line>
• In order to display the current line, debugging must be in progress, and the stack frame must be selected in 

[Debug] view.
• The source line number and source code can be displayed when an execution file (elf file) containing 

debugging information for displaying source code has been loaded.
• In order to display C source code, it must have been compiled by specifying the C compiler –gstabs 

option.
• In order to display assembler source code, it must have been compiled by specifying the assembler –gstabs 

option.
• Source code will not be displayed if no debugging information is included, or if no supported source file is 

found.
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  ●Breakpoint display

Breakpoints can be placed on the line number ruler.
The line number ruler indicates the breakpoint status and type.

Table 10.4.3.3.1  List of breakpoints
Item Description

Icon Icons are used to indicate the breakpoint type.
 The presence of an icon indicates that a breakpoint has been placed in the 

source.
The enabled/disabled status is displayed.
 The enabled/disabled status indicates whether the program will be 

suspended at that breakpoint.
The resolved/unresolved status is also displayed.
 The resolved/unresolved status indicates whether a breakpoint has 

actually been placed in the debugger.
Status Enabled / unresolved 

status
Enabled:

The breakpoint has been placed in the source file.
Unresolved:

When the debugger is launched:
• Actually placed in the debugger.
• Can be placed in enabled status.
• The breakpoint is placed in the source file when the debugger is 

running. Breakpoints that become unresolved are indicated by the 
icon in the line ruler.

Enabled / resolved 
status

Enabled:
The breakpoint has been placed in the source file.

Resolved:
When the debugger is running:
• The breakpoint has been placed.
• The program stops at this position when hit.

* The program will not stop unless the breakpoint is in this status.
Disabled / unresolved 
status

Disabled:
 The breakpoint has been placed in the source file, but is set not to stop the 

program.
Unresolved:

When the debugger is launched:
• Actually placed in the debugger.
• But placed in disabled status.
• The breakpoint is placed in the source file when the debugger is 

running. Breakpoints that become unresolved are indicated by the  
icon in the line ruler.

Disabled / resolved 
status

Disabled:
 The breakpoint has been placed in the source file, but is set not to stop the 

program.
Unresolved:

When the debugger is running:
• The breakpoint has been placed.
• The program will not stop when hit.

Type Soft break Software PC breakpoint
When set in [Source] editor

When set in [Disassembly] view

When function breakpoints are set

When temporary software PC breakpoints are set

Hard breaks Hardware PC breakpoints
When set in [Source] editor

When set in [Disassembly] view

When temporary hardware PC breakpoints are set
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●Symbol value display

 Hovering the mouse pointer over the symbol name (or within comments if the entire word matches) displays 
the symbol value in a balloon.

 

 When local variables are pointed to, only the symbol associated with the current stack frame (function) is 
displayed, and symbol values inside other functions are not displayed.

 Similarly, symbol values are not displayed for optimized local variables.

 This function can be disabled by clicking [Window] > [Preferences] > [C/C++] > [Editor] > [Hovers].

10.4.3.4  Operation

●Opening editor
 The [Source] editor automatically opens the source corresponding to the stack frame selected in [Debug] view 

when the program has been suspended. To reopen the editor, double-click the source file in [C/C++ Projects] 
view.

 Multiple editors can also be opened. Editors can be opened by clicking [Window] > [New Editor] when 
activated.

 Editors can be closed by clicking the X button.

Note: While normal editing operations are available in the editor, avoid performing edits while debugging 
is underway. The program stop position and source file line position will not match, since the 
execution file is not reloaded during debugging, even if it is edited.

●Setting/clearing breakpoints
 The editor is used to set and clear software or hardware PC breakpoints to the source file currently displayed.
 Breakpoints can be set or cleared using any of the methods described below.

・ Double-clicking line ruler
 Double-click the line ruler at the position at which a breakpoint is to be added. This sets a software PC 

breakpoint . Double-clicking the same position again clears the breakpoint.

 Only software PC breakpoints can be set by double-clicking. Double-clicking to clear breakpoints can however be used 

for temporary software PC breakpoints, hardware PC breakpoints, and temporary hardware PC breakpoints.

・ Line ruler Context menu > [Toggle Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Software Breakpoint]

 

 Software PC breakpoints  or temporary software PC breakpoints can be set at the desired position using the line 

ruler Context menu.

 Temporary software PC breakpoints are breakpoints valid only for one hit.

 Breakpoints can be cleared by selecting the same menu again at the position at which the breakpoint is set.

・ Line ruler Context menu > [Toggle Hardware Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Hardware Breakpoint]

 

 Hardware PC breakpoints  or temporary hardware PC breakpoints can be set at the desired position using the line 

ruler Context menu.

 Temporary hardware PC breakpoints are breakpoints valid only for one hit.

 Breakpoints can be cleared by selecting the same menu again at the position at which the breakpoint is set.
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・ [Run] > [Toggle Breakpoint]
・ [Run] > [Toggle Line Breakpoint]
 Software PC breakpoints  can be set by placing the cursor at the desired line and using the [Run] menu.

 Software PC breakpoints are placed in the same way for either of the menus above.

 The breakpoints can be cleared by selecting the same menu again at the position set.

・ [Run] > [Toggle Method Breakpoint]
 Function breakpoints  can be set by placing the cursor within the function (between "{" and "}") and selecting  

[Run] > [Toggle Method Breakpoint]. Function breakpoints are software PC breakpoints.

 The stop position for function breakpoints is the next source line to be executed in the function prolog.

 

Note: ・ Positions at which breakpoints can be set
 Breakpoints can be set for any line in [Source] editor. However, if breakpoints are set for 

comment or blank lines, the stop position will be at the next instruction.
・ Positions at which breakpoints cannot be set
 Breakpoints cannot be set in sections with no instructions (with no debugging information), such 

as blanks after the end of the source file.
 Similarly, software PC breakpoints cannot be set for programs in the ROM area.
 Hardware PC breakpoints should be used when setting breakpoints for programs in the ROM 

area.
・ Timing for setting breakpoints
 Breakpoints can be set even when launching the debugger or when the debugger is running.
 Breakpoints will be displayed in [Breakpoints] view as soon as they are added to the source file.
 Breakpoints can be set at any line. However, if they are placed in comment or empty lines, the 

actual stop position will be at the next subsequent command position.
 They cannot be set in the area at the end of source files with no commands (debugging 

information).
 1．Placing breakpoints when debugger is already running

Setting operation:
If a breakpoint is added to a source file while the debugger is running, a command is issued 
to the debugger, and the breakpoint is enabled for use.
A check overlay is therefore added to the breakpoint.  (resolved)
Debugging will not stop unless the breakpoint is in this state.
Error operation:
No check overlay is added if an error occurs that prevents use.

 (unresolved)
If breakpoints cannot be set due to an error, this is indicated by a dialog box.
The enabled/disabled status changes as follows.
Breakpoints set in [Source] editor Enabled/disabled status does not change
Breakpoints set in [Disassembly] view Changes to disabled status
Breakpoints cannot be changed from unresolved status  to resolved status  while the 
debugger is running. If an error occurs when the debugger is launched, breakpoints must be 
deleted before they can be readded.

 2．Placing breakpoints when debugger is not yet running
Setting operation:
Breakpoints can be placed in a source file even when the debugger is not running.
They will be displayed in the list in [Breakpoints] view.
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These breakpoints are enabled for use by a command issued when the debugger is 
launched, as described in "1. Placing breakpoints when debugger is already running.

• Number of breakpoints set
There is a limit on the number of breakpoints that can be set.
‐Software PC breakpoints: Up to 200 (including temporary software PC breakpoints)
‐Hardware PC breakpoints: Up to four locations, depending on the model.
 (Only one location in SIM mode)
An error occurs if these are exceeded in conjunction with those set using command input.
An error is displayed if these are exceeded while the debugger is running.
These can be set in the source file provided the debugger has not yet been launched.
Software PC breakpoints cannot be set at addresses in external ROM.

●Enabling/disabling breakpoints
• Enable/disable breakpoint
 Breakpoints can be enabled and disabled.
 Enable: Stops at the breakpoint position. The breakpoints set will be enabled.
 Disable: Used when a breakpoint is set but you do not wish to stop at that breakpoint.
• Skip all breakpoints
 Selecting [Run] > [Skip All Breakpoints] temporarily disables all breakpoints and prevents debugging from 

stopping at them.
 They can be reenabled by selecting [Skip All Breakpoints] once more.

●Removing breakpoints
• Removing all the breakpoints
 Selecting [Run] > [Remove All Breakpoints] removes all of the breakpoints currently set.

●Running program to specified position
 [Run To Line]:

 Selecting [Run To Line] in the Context menu starts running the target program from the current PC address 
and stops it at the line at which the cursor is currently displayed. (Disabled if the program does not pass this 
line.)

Note: The program is stopped by setting a temporary software PC breakpoint.
Note that this function is available even if 200 (the maximum number) software PC 
breakpoints have already been set.

●Registering watch expression
[Add Watch Expression...]:
 Open the Context menu in [Source] editor and select [Add Watch Expression...] to display the following 

popup menu.

  

 Enter the watch expression and click [OK] to register in [Expressions] view. An error will be displayed in 
[Expressions] view after registering an invalid expression that cannot be evaluated.

●Changing settings

 The settings listed below can be changed in [Source] editor using [Window] > [Preferences].
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Table 10.4.3.4.1  Modifiable items
Modifiable setting Path

Font [General] > [Appearance] > [Colors and Fonts] > [Basic] > [Text 
Font]

Current line (current PC) color [General] > [Editors] > [Text Editors] > [Annotations] > [Debug 
Current Instruction Pointer]

Toggle variable value balloons ON/OFF [C/C++] > [Editor] > [Hovers] > [Combined Hover]

10.4.3.5  Restrictions
There is no memory dump function for symbol specification. Symbols should be registered using [Memory] view.
The following operations cannot be used for breakpoints set via commands.

Table 10.4.3.5.1  List of restrictions
Operation Details

Show [Breakpoints] view Breakpoints set via commands may not be displayed in 
[Breakpoints] view.

[Toggle Breakpoint] Clears software PC breakpoint.
[Toggle Temporary Software Breakpoint] Clears temporary software PC breakpoint.
[Toggle Hardware Breakpoint] Clears hardware PC breakpoint.
[Toggle Temporary Hardware Breakpoint] Clears temporary hardware PC breakpoint.
[Toggle Line Breakpoint] Clears software PC breakpoint.
[Toggle Method Breakpoint] Clears function breakpoint.
[Toggle Watchpoint] Clears data breakpoint.
[Enable/Disable Breakpoint] Enables or disables breakpoint.
[Skip All Breakpoints] Enables or disables all breakpoints.
[Breakpoint Properties] See detailed information for breakpoints.
[Export Breakpoints] Exports breakpoints.
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10.4.4  [Disassembly] View

[Disassembly] view displays the program disassembly for the stack frame selected in [Debug] view.

10.4.4.1  Window layout
[Disassembly] view can be opened by clicking [Window] > [Show View] > [Disassembly].

10.4.4.2  Menu/Toolbar

●Toolbar/View menu
 There is no Toolbar or View menu.

●Context menu

 

Table 10.4.4.2.1  Context menu
Menu function

Run to Line Runs as far as the line in which the cursor is located in [Source] 
editor or [Disassembly] view. (When the cursor is displayed in 
[Source] editor while the debugging program is suspended)

Resume At Line Not supported.
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10.4.4.3  Display Details
The disassembly for the current line is displayed while debugging is in progress.

●Disassembly display
 This disassembles and displays the execution file (elf file).
 The respective address, label, assembler basic instructions, and assembler expansion instructions are displayed 

for each line of source code for C source files or assembler source files.
 In order to display disassembly, debugging must be in progress, and the stack frame must be selected in [Debug] 

view.

Conditions for displaying original source code
• The source code for disassembly can be displayed when an execution file (elf file) containing 

debugging information for displaying source code has been loaded.
• In order to display C source code, it must be compiled by specifying the C compiler -gstabs option.
• In order to display assembler source code, it must be assembled by specifying the assembler --gstabs 

option.
• Only disassembly will be forcibly displayed if no debugging information is included, or if no supported 

source file is found.

Note: ・ The disassembly details displayed may not necessarily match the assembler source file due to 
optimization of the assembler expansion instructions.

・ Up to 100 disassembly lines are displayed.
 The source lines of the original source code are displayed in dark blue.
 These settings can be altered using [Disassembly options] under "[C/C++] > [Debug]" in Section 

10.4.1.6, "Changing Settings". Going beyond the line number set by this value will display until 
the current function ends and will not simultaneously display the source. When this occurs, a 
larger value should be set.

・ Disassembly is not displayed unless debugging is progress.

10.4.4.4  Operation 

●Opening/closing view
 Open the [Variables] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

●Setting/clearing breakpoints
 Software or hardware PC breakpoints can be set or cleared in the source file currently displayed in [Disassembly] 

view.
 Breakpoints can be set or cleared using any of the methods described below.

・ Double-click line ruler
 Double-click the line ruler at the position at which a breakpoint is to be added. This sets a software PC 

breakpoint  . Double-clicking the same position again clears the breakpoint.
 Only software PC breakpoints can be set by double-clicking. Double-clicking to clear breakpoints can 

however be used for temporary software PC breakpoints, hardware PC breakpoints, and temporary 
hardware PC breakpoints.

 ・ Line ruler Context menu > [Toggle Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Software Breakpoint]

 

 Software PC breakpoints  or temporary software PC breakpoints can be set at the desired position using 
the line ruler Context menu.

 Temporary software PC breakpoints are breakpoints valid only for one hit.
 Breakpoints can be cleared by selecting the same menu again at the position at which the breakpoint is set.
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・ Line ruler Context menu > [Toggle Hardware Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Hardware Breakpoint]

 

 Hardware PC breakpoints  or temporary hardware PC breakpoints can be set at the desired position using 
the line ruler Context menu.

 Temporary hardware PC breakpoints are breakpoints valid only for one hit.
 Breakpoints can be cleared by selecting the same menu again at the position at which the breakpoint is set.

Note: ・ Timing for setting breakpoints
 Breakpoints can be set only when the debugger is running, and are displayed in [Breakpoints] 

view as soon as they are placed in disassembly.
 Breakpoints can be set only in disassembly instruction lines that have an address. They cannot 

be set in C source lines.

 

 Similarly, breakpoints cannot be set in the following locations.
• Expansion instruction lines excluding the initial ext instruction
 Example:
 ext xxx ○ Can be set
 ext xxx × Cannot be set
 ld xxx × Cannot be set

• Delayed instruction lines (lines after delayed branch instructions)
 Example:
 jpr.d xxx ○ Can be set
 cmp × Cannot be set

 If a breakpoint is added, a command is issued to the debugger, enabling the breakpoint. A 
check overlay  is therefore added to the breakpoint. Debugging will not stop unless the 
breakpoint is in this state.

 If an error occurs and breakpoints cannot be used, no check overlay is added, and the 
breakpoint is disabled .

 If a breakpoint cannot be set due to an error, this is indicated in a dialog box.
• Number of breakpoints set
 There is a limit on the number of breakpoints that can be set.
‐ Software PC break: Up to 200 locations (including temporary locations)
‐ Hardware PC break: Up to four locations, depending on the model (Only one location in 

SIM mode)
• Software PC breakpoints cannot be set for programs in the ROM area.
• Hardware PC breakpoints should be used when setting breakpoints for programs in the ROM 

area. 

●Enabling/disabling breakpoints
• Enable/disable breakpoint
 Breakpoints can be enabled and disabled.
 Enable: Stops at the breakpoint position. The breakpoints set will be enabled.
 Disable: Used when a breakpoint is set but you do not wish to stop at that breakpoint.
・ Skip all breakpoints
 Selecting [Run] > [Skip All Breakpoints] temporarily disables all breakpoints and prevents debugging from 

stopping at them.
 They can be reenabled by selecting [Skip All Breakpoints] once more.
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●Removing breakpoints
・Remove all breakpoints
 Selecting [Run] > [Remove All Breakpoints] removes all of the breakpoints currently set.

●Breakpoint properties
・Breakpoint properties
 Detailed information about breakpoints can be viewed using [Breakpoint Properties] in the Context menu for 

the line ruler on which the breakpoint is set.
 See "Breakpoint list" in Section 10.4.5.4.

●Running program to specified position
[Run To Line]:
 Selecting [Run To Line] in the Context menu starts running the target program from the current PC address 

and stops it at the line at which the cursor is currently displayed. (The program does not stop if this line is not 
passed.)

Note: The program is stopped by setting a temporary software PC breakpoint. Note that this 
function is available even if 200 (the maximum number) software PC breakpoints have 
already been set.

10.4.4.5  Restrictions
This only applies when disassembly and source code is displayed together. It is not supported when only assembly 
is displayed.
The following operations cannot be used for breakpoints set via commands.

Table 10.4.4.5.1  List of restrictions
Operation Details

Show [Breakpoints] view Breakpoints set via commands may not be displayed in 
[Breakpoints] view.

[Toggle Breakpoint] Clears software PC breakpoint.
[Toggle Temporary Software 
Breakpoint]

Clears temporary software PC breakpoint.

[Toggle Hardware Breakpoint] Clears hardware PC breakpoint.
[Toggle Temporary Hardware 
Breakpoint]

Clears temporary hardware PC breakpoint.

[Toggle Line Breakpoint] Clears software PC breakpoint.
[Toggle Method Breakpoint] Clears function breakpoint.
[Toggle Watchpoint] Clears data breakpoint.
[Enable/Disable Breakpoint] Enables or disables breakpoint.
[Skip All Breakpoints] Enables or disables all breakpoints.
[Breakpoint Properties] See detailed information for breakpoints.
[Export Breakpoints] Exports breakpoints.
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10.4.5  [Breakpoints] View

[Breakpoints] view is used for displaying and managing breakpoints. Breakpoints are set via [Source] editor and 
[Disassembly] view.
All project breakpoints within the workspace are displayed.

10.4.5.1  Window layout

10.4.5.2  Menu/Toolbar

●Toolbar
Table 10.4.5.2.1  Toolbar 

Button function

Remove Selected 
Breakpoints

Removes the selected breakpoints.

Remove All Breakpoints Removes all breakpoints.

Show Breakpoints Supported 
by Selected Target

Not supported.

Go to File for Breakpoint Opens the selected breakpoint in the editor.
Skip All Breakpoints Temporarily skips all breakpoints.
Expand All Expands the collapsed breakpoint list.
Collapse All Collapses the breakpoint list displayed.
Link with Debug View Highlights the breakpoint hit within [Breakpoints] view when debugging 

stops at a breakpoint.

●View menu

 

Table 10.4.5.2.2  View menu
Menu function

Add Event Breakpoint Not supported.
Show Full Paths Switches to the full path display for the file for which the 

breakpoint is set.
Group By Displays breakpoints in groups.
Select Default Working Set... Not supported.
Deselect Default Working Set Not supported.
Working Sets... Not supported.
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●Context menu

 

Table 10.4.5.2.3  Context menu
Menu function

Go to File Opens the selected breakpoint in the editor.
Enable Enables the breakpoint. (Breaks)
Disable Disables the breakpoint. (Does not break)
Remove Removes the selected breakpoints from the display.
Remove All Removes all breakpoints from the display.
Select All Selects the entire breakpoint list.
Copy/Paste Copies or pastes the breakpoint list.
Export Breakpoints... Saves the breakpoints.
Import Breakpoints... Restores the breakpoints.
Add Watchpoint... Not supported.
Properties... Opens the dialog box displaying the breakpoint properties.
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10.4.5.3  general Breakpoint Specifications

●Breakpoint status (enabled/disabled and resolved/unresolved)）
Table 10.4.5.3.1  Breakpoint status list

Breakpoint status Status details

Icon / no icon Indicates whether a breakpoint has been placed in the source file. 
Display of the icon can be enabled or disabled.
These are set in the GDB when the debugger is running 
regardless of whether enabled or disabled.

Enabled/disabled The breakpoint has been placed in the source file.
Enabled: Stops the program at the breakpoint.
Disabled: Does not stop the program at the breakpoint.

Resolved/unresolved The breakpoint has been placed in the source file.
The resolved/unresolved status will change when the debugger is 
launched.
Resolved: Indicates that the breakpoint setting has succeeded 

for the target.
Unresolved: Indicates that the breakpoint setting has failed for 

the target.
(those returning info break command results)

Table 10.4.5.3.2  Icons and status correlations

Icon Enabled Resolved
IDE status

Breaks
gDB status

○ ×
Set in IDE source file.

×
Not set in GDB.

× ×
Set in IDE source file.

×
Not set in GDB.

○ ○
Set in IDE source file.

○Set in GDB.
(Program stops only for this status)

× ○
Breakpoint set in IDE source file.

×
Set in GDB, but skipped when run.

None × ×
Breakpoint not set in source file.

×
Breakpoint not set in GDB.

Note: ・ Resolved breakpoints can be enabled or disabled on the GDB.
 ・ The breakpoints will actually be set in the target program when the target program is executed 

by the GDB.
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●Breakpoint status transitions
 The enabled/disabled and resolved/unresolved status changes as shown in the diagram below.

Place breakpoint in source

Disable

Enable

Disable (running)

Enable (running)

Remove breakpoint from source
Possible in any status

Enabled Disabled

Enabled Disabled

Breakpoint setting failed with debugger 
running
• Breakpoints placed in C source 

are unchanged.
• Breakpoints placed in disassembly 

are disabled.

Breakpoint 
setting 
successful 
with debug-
ger running

Breakpoint 
setting 
successful 
with debug-
ger running

Debugger 
terminates

Debugger 
terminates

Figure 10.4.5.3.1  Breakpoint status transitions
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●Timing for setting breakpoints
・Setting breakpoints in [Source] editor
 Breakpoints can be placed even when the debugger is not running. Breakpoints are displayed in [Breakpoints] 

view as soon as they are placed in the source file.

 Breakpoints can be set on any line. However, if they are placed in comment or blank lines, the actual stop 
position will be at the next instruction position. The position is not adjusted automatically.

Note: Breakpoints cannot be set in the following locations.
・  Sections with no instructions (with no debugging information) such as blanks after the end 

of the source file
・  Software/temporary breakpoints cannot be set outside the parameter file RAM area.
・  Software/temporary breakpoints cannot be set at addresses in the target ROM.

・Setting breakpoints in [Disassembly] view
 Breakpoints can be placed only when the debugger is running. Breakpoints are displayed in [Breakpoints] 

view as soon as they are placed in disassembly.
 Breakpoints can be set only in disassembly instruction lines that have an address. They cannot be set in C 

source lines.

 

Note: Breakpoints cannot be set in the following locations.
・ Software/temporary breakpoints cannot be set outside the parameter file RAM area.
・ Software/temporary breakpoints cannot be set at addresses in the target ROM.
・ Expansion instruction lines excluding the initial ext instruction
Example:
ext xxx ○ Can be set
ext xxx × Cannot be set
ld xxx × Cannot be set

• Delayed instruction lines (lines after delayed branch instructions)
Example:
jpr.d xxx ○ Can be set
cmp × Cannot be set

・Setting breakpoints when debugger is running
 Setting operation
 Placing a breakpoint in a source file when the debugger is running sets the breakpoint for the debugger. A 

check overlay  (resolved) is therefore added to the breakpoint. 

 Debugging will not stop unless the breakpoint is in this state.
 Error operation
 No check overlay  (unresolved) is added if an error occurs and the breakpoint cannot be used. If the breakpoint 

cannot be set due to an error, this is indicated in a dialog box. The  icon is displayed on the ruler.
 The enabled/disabled status changes as follows.

Set in [Source] editor Enabled/disabled status does not change
Set in [Disassembly] view Changes to disabled status

Note: ・ Breakpoints cannot be changed from unresolved status  to resolved status  while 
the debugger is running.

・ In order to reset breakpoints for which an error occurred while the debugger is running, 
they must first be removed and then set once again.
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・ Setting breakpoints when debugger is not yet running
  Setting operation
 Breakpoints can be placed in a source file even when the debugger is not running. The breakpoints set will 

be displayed in the list in [Breakpoints] view.
 These breakpoints will be enabled by a command sent when the debugger is launched, as described in 

"Setting breakpoints when debugger is running".

●Restrictions when executing breakpoint instructions via commands
 [Breakpoints] view displays breakpoints set by commands via the screen or console.
 However, the following restrictions apply to breakpoints set via commands.

Table 10.4.5.3.3  List of restrictions when breakpoints are set via commands
Command issued Behavior and restrictions

break main
(tbreak/hbreak/thbreak also 
identical)

A line breakpoint is set.
Not set for function breakpoints. Function breakpoints can be set using 
[Toggle Method Breakpoint]. They are set at an address after the prolog 
(as a function breakpoint).
Note that they are not listed for locations with no debugging information 
(address position source line) such as libraries.

break file:lineno
(tbreak/hbreak/thbreak also 
identical)

A line breakpoint is set.
These can be placed anywhere in the source file, but the actual stop 
position will be at the next command position.

break *0xXXXX
(tbreak/hbreak/thbreak also 
identical)

A line breakpoint is set at the source line corresponding to the address 
specified.
Note that icons will not be displayed in [Source] editor or [Disassembly] 
view if there is no debugging information in the address at which the 
breakpoint is set, as the source line cannot be acquired.
The breakpoint will be displayed as an address breakpoint in 
[Breakpoints] view.

delete Removes all breakpoints.
The breakpoints on the list will become unresolved  , and cannot be 
reverted to resolved status unless the GDB is relaunched.
[Remove] in [Breakpoints] view must be used to remove them from the 
list.

●Temporary breakpoints
 Temporary breakpoints are also displayed on the breakpoint list.

 When temporary breakpoints are set

Table 10.4.5.3.4  Temporary breakpoints
gDB status Display

GDB stopped Indicated as unresolved  in the [Breakpoints] view list.
GDB running Indicated as resolved  in the [Breakpoints] view list.

Changes to unresolved  after breaking.
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10.4.5.4  Display Details
All project breakpoints within the workspace are displayed.
Breakpoints are set via [Source] editor and [Disassembly] view.

●Breakpoint list
 The following breakpoint information is displayed for each line.

Table 10.4.5.4.1  List of breakpoints
Item Description

Checkbox Indicates whether the breakpoint is enabled or disabled.
Checked: Enabled
Unchecked:  Disabled

Icon Indicates the breakpoint type.
The presence of an icon indicates that a breakpoint has been placed in 
the source.

The enabled/disabled status is displayed.
The enabled/disabled status indicates whether the program will be 
suspended at that breakpoint.

The resolved/unresolved status is also displayed.
The resolved/unresolved status indicates whether a breakpoint has 
actually been placed in the debugger.

Status Enabled / 
unresolved 
status

Enabled:
 The breakpoint has been placed in the source file.

Unresolved:
 When the debugger is launched:
 ・Actually placed in the debugger.
 ・Can be placed in enabled status.
 ・The breakpoints is placed in the source file when the debugger is 

running. Breakpoints that become unresolved are indicated by the  
icon in the line ruler.

Enabled / 
resolved status

Enabled:
 The breakpoint has been placed in the source file.

Resolved:
 When the debugger is launched:
 ・The breakpoint has been placed.
 ・The program stops at this position when hit.
* The program will not stop unless the breakpoint is in this status.

Disabled/
unresolved 
status

Disabled:
The breakpoint has been placed in the source file, but is set not to stop 
the program.

Unresolved:
 When the debugger is launched:
 ・Actually placed in the debugger.
 ・But, can be placed in disabled status.
・The breakpoint is placed in the source file when the debugger is 

running. Breakpoints that become unresolved are indicated by the 
icon in the line ruler.

Disabled / 
resolved status

Disabled:

 The breakpoint has been placed in the source file, but is set not to stop 
the program.

Resolved:

 When the debugger is running:
 ・The breakpoint has been placed.
 ・The program will not stop at this position when hit.
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Item Description

Type Soft break Software PC breakpoint
When set in [Source] editor

When set in [Disassembly] view

When function breakpoints are set

When temporary software PC breakpoints are set

Hard break Hardware PC breakpoints
When set in [Source] editor
When set in [Disassembly] view

When temporary hardware PC breakpoints are set

File name Displays the name of the source file in which the breakpoint is set. The full 
path is shown when [Show Full Paths] is selected.
Double-clicking on the breakpoint highlights the corresponding line in 
[Source] editor.

Setting position Displays the setting position information depending on the breakpoint type.
The program breaks immediately before executing the next instruction on 
reaching these positions when running.

Address Displays the address at which the software/hardware PC breakpoint is set. 
Displayed when placed in [Disassembly] view.

Line Displays the line number at which the software/hardware PC breakpoint is 
set. Displayed when placed in a source line in [Source] editor.

Function Displays the function name for which the software/hardware PC breakpoint 
is set. Displayed when a function breakpoint is placed using [Toggle 
Method Breakpoint].
The function breakpoint is placed at the first instruction after prolog 
processing.

●group display
 Selecting a group in [Group By] displays the breakpoints by group.

 

Table 10.4.5.4.2 Group display items
group Display format

Breakpoints Displays all breakpoints. (Default)
Files Displays by source file.
Breakpoint Working Sets Not supported.

Breakpoint Types Displays by breakpoint type.
Projects Displays by project.
Resource Working Sets Not supported.

Advanced... Not supported.

The display can be shown or hidden for group display using [Expand All] or [Collapse All].
Note: ・ The order in which breakpoints are displayed differs from the order in which they were added.

10.4.5.5  Operation

●Opening/closing view
 Open [Breakpoints] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.
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●Setting software PC breakpoints
 These can be set using the windows below. For details of how to set breakpoints, see "[Source] editor" and 

"[Disassembly] view".
 [Source] editor

・ Double-click line ruler
・ Line ruler Context menu > [Toggle Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Software Breakpoint]
・ [Run] > [Toggle Breakpoint]
・ [Run] > [Toggle Line Breakpoint]
・ [Run] > [Toggle Method Breakpoint]

[Disassembly] view
・ Double-click line ruler
・ Line ruler Context menu > [Toggle Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Software Breakpoint]

Example: Line ruler Context menu

 The breakpoint set is shown by the  icon in [Breakpoints] view.
 An error dialog box is displayed if an error occurs when the breakpoint cannot be placed while the debugger is 

running. The  icon is displayed on the ruler.

Note:  There is a limit on the number of software PC breakpoints that can be set. Up to 200 breakpoints 
(including temporary breakpoints) can be set. An error will be displayed if this is exceeded while 
the debugger is running.

 The number of breakpoints set in the source file can exceed this if the debugger is stopped.
 Software PC breakpoints cannot be set for programs in the ROM area.
 Hardware PC breakpoints should be used for setting breakpoints for programs in the ROM area.

●Setting hardware PC breakpoints
 These can be set using the windows below. For details of how to set breakpoints, see "[Source] editor" and 

"[Disassembly] view".
 [Source] editor

・ Line ruler Context menu > [Toggle Hardware Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Hardware Breakpoint]

 [Disassembly] view
・ Line ruler Context menu > [Toggle Hardware Breakpoint]
・ Line ruler Context menu > [Toggle Temporary Hardware Breakpoint]

 The breakpoint set is shown by the  icon in [Breakpoints] view.

 An error dialog box is displayed if an error occurs when the breakpoint cannot be placed while the debugger is running. The 

 icon is displayed on the ruler.
Note: There is a limit on the number of hardware PC breakpoints that can be set. Up to 1 to 4 

breakpoints can be set. (Only one in SIM mode)
An error will be displayed if this is exceeded while the debugger is running.
The number of breakpoints set in the source file can exceed this if the debugger is stopped.
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●Enabling/disabling breakpoints
 Enabling allows breaking of the program at that point when it is running, while disabled breakpoints are 

ignored and the program is not broken.
・Checkbox:
 Click the checkbox at the beginning of the line in the breakpoint list to enable or disable.
 A check indicates enabled, and no check indicates disabled.
・[Enable]/[Disable]
 To select and enable a breakpoint via the Context menu, select [Enable]. To disable a breakpoint, select 

[Disable].
 To enable or disable multiple or all breakpoints, select all breakpoints using [Select All], and then select 

[Enable] or [Disable] in the menu.
・[Skip All Breakpoints]
 Selecting [Skip All Breakpoints] in the [Breakpoints] view temporarily disables all breakpoints and 

prevents the program from stopping at them. They can be reenabled by selecting [Skip All Breakpoints] 
once more.

●Jumping to breakpoint location
 Double-clicking the [Breakpoints] view list or selecting [Go To File] in the Context menu displays the 

corresponding location in [Source] editor.

●Removing breakpoints
[Remove]/[Remove All]
 Select the line with the breakpoint to be removed, and select [Remove] in the Context menu. To remove all 

PC breakpoints, select [Remove All].

●Saving/restoring breakpoints
 Registered breakpoints are automatically saved when the IDE is terminated, and are restored the next time the 

IDE is launched. The registered breakpoints will be set for the GDB debugger when the debugger is relaunched.

 Breakpoints can be saved as external files (Eclipse XML file format) and restored from external files.
Save:
 Context menu > [Export Breakpoints...]
 Select the breakpoint(s) to be saved in the breakpoint list, specify the file name, and save.
Restore:
 Context menu > [Import Breakpoints...]
 Specify the external file and restore the breakpoint(s) to the breakpoint list.
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●Breakpoint details
A dialog box can be opened using any of the methods below to check the breakpoint details.
・ Context menu > [Properties]
・ [Source] editor line ruler > [Breakpoint Properties]
・ [Disassembly] view line ruler > [Breakpoint Properties]
Selecting [Common] in the tree displays the following information.

 

Table 10.4.5.5.1  Breakpoint properties
Item Description

Class Breakpoint internal type
C/C++ line breakpoint ([Source] editor setting)

C/C++ function breakpoint (when setting function breakpoint via 

[Source] editor)

Disabled (when set in disassembly)
Type Breakpoint type

Standard (software PC breakpoint)

Hardware (hardware PC breakpoint)

Temporary (temporary software PC breakpoint)

Hardware temporary (temporary hardware PC breakpoint)
Class display File/Line 

number
File name (when set in [Source] editor

Function Function name (when function breakpoint is set via [Source] editor)
Address Address (when set in Disassembly)

Enabled Enabled/disabled status
Condition Break conditions
Ignore count Skip count until breakpoint is hit

[Actions] and [Filtering] are not supported.
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10.4.5.6  Restrictions
• The breakpoint list will not be updated correctly if a breakpoint instruction is executed via a command. 

Breakpoints should be set via the screen.
• Breakpoint information for the project will remain in [Breakpoints] view even after the debugger has 

terminated. If the debugger is launched for a different project in this state, the breakpoints from the previous 
project will be set.

 Note, however, that breakpoints are not displayed in [Source] editor in this case. In order to prevent the 
breakpoints from the previous project being set, the previous breakpoint settings must first be deleted, for 
example using the [Remove All Breakpoints] button on the toolbar.

• If debugging two projects simultaneously using --double-starting, two IDEs must be launched in 
separate workspaces. The projects must be imported to separate workspaces before launching the debugger.
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10.4.6  [Variables] View

[Variables] view is used for monitoring the values of local variables.
Local variables are displayed automatically corresponding to the stack frames in [Debug] view. Global variable 
values can also be viewed if they are registered.

10.4.6.1  Window layout
The window displays the function arguments defined by the stack frame selected in [Debug] view together with the 
local variable names and their values.

10.4.6.2  Menu/Toolbar

●Toolbar
Table 10.4.6.2.1  Toolbar

Button function

Show Type Names Lists the expression types.

Show Logical Structure Not supported.

Collapse All Collapses the variable list shown.

Add Global Variables Selects and adds global variables from the list.

Remove Selected Global 
Variables

Deletes the selected global variables from the display.

Remove All Global Variables Deletes all global variables from the display.

●View menu

 

Table 10.4.6.2.2  View menu
Menu function

Layout Alters the View display layout.
Vertical View Orientation
Horizontal View Orientation
Variables View Only

Displays the detail panes vertically.
Displays the detail panes horizontally.
Hides the detail panes.

Show Columns Toggles the table display.
Select Columns... Not supported.
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●Context menu

 

Table 10.4.6.2.3  Context menu
Menu function

Select All Selects the entire view display.
Copy Variables Copies the details selected.
Enable Allows the variables to be updated.
Disable Prevents the variables from being updated.
Display As Array... Not supported.
Cast To Type... Not supported.
Restore Original Type Not supported.
View Memory Displays variable value addresses in [Memory] view.
Find... Searches for a variable.
Change Value... Opens a dialog box for changing variable values.
Add Watchpoint... Not supported.
Add Global Variables... Selects and adds global variables from the list.
Remove Global Variables Deletes the selected global variables from the display.
Remove All Global Variables Deletes all global variables from the display.
Create Watch Expression Registers variables in [Expressions] view.
Format Alters the display format.

Binary
Natural
Decimal
Hexadecimal

Binary
Integers as signed decimals, floating point numerals as exponentials
Signed decimals
Hexadecimal

Note: Operations via the detail pane Context menu are not supported.
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10.4.6.3  Display Details

●local variable list
  The window displays the function arguments defined by the stack frame selected in [Debug] view together with 

the local variable names and their values.
 Variables are updated after the program has been run.
 The local variables displayed will also be updated automatically when moving to another function.
 If a variable is an array or pointer, a [+] or [ ]symbol will be displayed in front of the variable name. Clicking 

on the symbol changes it [-] or [ ]and the information inside the array or the address details indicated by the 
pointer will be displayed.

 When [Format] is set to [Binary], the number of digits corresponding to the symbol size is displayed.
  Example:  int iSymbol = 0x1a55;
 iSymbol is displayed as 0001101001010101 as the int type is 16 bits.

 The display format in the detail pane (octal/decimal/hexadecimal) will change according to the set output-
radix command setting.

Note: Values will not display correctly if binary is set.

●Table/list format
 [Variables] view can be displayed in one of two ways as shown below.

Table 10.4.6.3.1  Display methods
Display 
method

Toggle method features

Table format Select [Show 
Columns] in View 
menu.

Display Displays as [Name] and [Value] columns.
Highlighting Locations changed are highlighted in yellow.
Value changes Can be edited directly in [Value] column.

List format Deselect [Show 
Columns] in View 
menu.

Display Displays in Variable = Value format.
Highlighting Highlighted in red.
Value changes Can be edited via Context menu > [Change Value...].

 The colors used for highlighting can be changed using [Changed value color] or [Changed value background 
color] in Section 10.4.1.6, "Changing Settings".

Note: ・ Sections outside the [Variables] view scroll area and not displayed will not be highlighted when 
the program stops, for example, at a breakpoint.

・ [Format] should be set to [Natural] when referencing floating point values such as for float 
and double. (They will be displayed in the form exponent + significand if [Format] is set to 
[Hexadecimal] or other setting.)

10.4.6.4  Operation

●Opening/closing view
 Open the [Variables] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

●Changing variable
 [Change Value...]:

 Variable values can be changed. Select the variable to be altered and select [Change Value...]. Edit the value 
in the dialog box displayed, and click [OK].

 Values should be entered as decimal or hexadecimal (with "0x") values.

 [Value] column:
 Values can be edited directly via the [Value] column if [Variables] view is displayed in table format.

Note: [Format] should be set to [Natural] before changing floating point values such as for float 
and double. (They must be entered in the form exponent + significand if [Format] is set to 
[Hexadecimal] or other setting.)
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●Registering/deleting global variables
 [Variables] view displays local variables automatically, but it can also be used for referencing and editing global 

variables.
 Global variable values cannot be changed in [Expressions] view, but they can be edited if registered in [Variables] 

view.
[Add Global Variables...]:
 Selecting Context menu > [Add Global Variables...] displays the list of global variables in a dialog box.
 Selecting the variables to be displayed from this list displays the values in [Variables] view.
 The variables registered are retained even when the debugger is terminated, and the same variables can be 

monitored the next time it is launched.

[Remove Global Variables]:
 Registered global variables can be deleted using [Remove Global Variables].
 All global variables registered in [Variables] view can be deleted using [Remove All Global Variables].

●Changing display format
 Context menu > [Format]

 The display format can be selected from the following.

Table 10.4.6.4.1  List of display formats
Selection Display format Default

Binary Binary
Natural Signed decimal ○
Decimal Signed decimal
Hexadecimal Hexadecimal

 Display format changes are applied to all selected items.

●View memory
 [View Memory]:

 Allows a specific variable value to be registered and displayed in [Memory] view.
 Selecting Context menu > [View Memory] for the variable to be registered registers and displays the 

variable in [Memory] view when it opens.

●Registering watched expression
 [Create Watch Expression]:

 Allows a specific variable value to be registered and displayed in [Expressions] view.
 Select Context menu > [Create Watch Expression] for the variable to be registered, and register and display 

the variable in [Expressions] view.

10.4.6.5  Restrictions
・ Multiple local variables may be displayed when stack frame is selected in [Debug] view.
 This depends on any of the following.
 - When built with optimization options (other than -O0)
 - When local variables are assigned to registers
 Similarly, local variables that have not been used may be optimized when building. If this occurs, the local 

variables will not be displayed in [Variables] view.
・ The display will not be updated even if the local variable details are modified using commands.
・ The value may not always be updated when the program is suspended. If this occurs, the value should be checked 

via the Details pane.
・ The values for the local variables assigned to the register may not display correctly due to C compiler 

optimization. If so, substitute local variables for global variables, then check the values of the global variable in 
[Expressions] view.
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10.4.7  [Expressions] View

[Expressions] view is used for registering required watch expressions (global symbols and registers) and monitoring 
the values. All project watch expressions within the workspace are displayed.

10.4.7.1  Window layout

10.4.7.2  Menu/Toolbar

●Toolbar
Table 10.4.7.2.1 Toolbar

Button function

Show Type Names Lists the types.
Show Logical Structure Not supported.
Collapse All Collapses the watch expression list displayed.
Create a new watch expression Adds a watch expression.
Remove Selected Expressions Deletes the selected expression from the display.
Remove All Expressions Deletes all expressions from the display.

●View menu

 

Table 10.4.7.2.2  View menu
Menu function

Layout Alters the View display layout.
Vertical View Orientation
Horizontal View Orientation
Expressions View Only

Displays the detail panes vertically.
Displays the detail panes horizontally.
Hides the detail panes.
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●Context menu
・ When watch expression is selected (root node  icon)

・ Selecting expression values (sub node  variable icon  pointer icon)

Table 10.4.7.2.3  Context menu
Menu function

Select All Selects the entire view display.
Copy Expressions Copies the selected details.
Remove Deletes the selected expressions from the display.
Remove All Deletes all the expressions from the display.
Find... Searches for an expression.
Change Value... Opens the dialog box for changing the expression value.

Not displayed if the watch expression added is selected.
Add Watch Expression... Adds a watch expression.
Edit Watch Expression... Edits the watch expression.

Displayed only when the watch expression added is selected.
Reevaluate Watch 
Expression

Reevaluates (recalculates) the watch expression.
Displayed only when the watch expression added is selected.

Create Watch Expression Registers the selected value as a watch expression in [Expressions] 
view.
Not displayed when the watch expression added is selected.

Enable Allows the watch expression to be updated.
Disable Prevents the watch expression from being updated.
Format Changes the display format.

Not displayed when the watch expression added is selected.
Binary
Natural
Decimal
Hexadecimal

Binary
Integers as signed decimals, floating point numerals as exponentials
Signed decimals
Hexadecimal

Display As Array... Not supported.
Cast To Type... Not supported.



S5U1C17001C MANUAl Seiko Epson Corporation 10-53
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

10
Debugger

Menu function

Restore Original Type Not supported.
View Memory Displays the expression value address in [Memory] view.

Not displayed when the watch expression added is selected.

Note: Operations via the detail pane Context menu are not supported.

10.4.7.3  Display Details

●Watch expression list
 The window displays the expressions (symbol names) registered in the watch list together with their evaluation 

results. The expression evaluation results displayed will be updated when the values change as the program is 
run. They are not updated when changed due to commands.

 If a symbol is an array or pointer, a [+] or [ ] symbol will be displayed in front of the symbol name. Clicking 
on the symbol changes it to [-] or [ ] and the information inside the array or the address details indicated by 
the pointer will be displayed.

 When [Format] is set to [Binary], the number of digits corresponding to the symbol size is displayed.
   Example:  int iSymbol = 0x1a55;
 iSymbol is displayed as 0001101001010101 as the int type is 16 bits.

 In the detail pane, the "set output-radix" command setting changes the display format (octal/decimal/
hexadecimal).

Note: Values will not display correctly if binary is set.

●list format
 [Expressions] view is displayed as shown below.

Table 10.4.7.3.1  Display methods
Display 
method

Toggle method features

List format Deselect [Show 
Columns] in View 
menu.

Display Displays in Variable = Value format.
Highlighting Not highlighted.
Value changes Can be edited via Context menu > [Change Value...].

 There is no table format display.

Note:  [Format] should be set to [Natural] when referencing floating point values such as for  floatand 
double . (They will be displayed in the form exponent + significand if [Format] is set to 
[Hexadecimal] or other setting.)



10-54 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

10.4.7.4  Operation

●Opening/closing view
 Open the [Expressions] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". 

The view can be closed by clicking the X button.

●Registering watch expression (symbol)
 Expressions must be registered in order for them to be displayed in [Expressions] view.
 Expressions can be registered using any of the following methods.

・[Expressions] view Context menu buttons
 [Add Watch Expression...]:

 A dialog box is displayed.
 Enter the watch expression and symbol name in the dialog box. (No line break required here)
 Leave the [Enable] checkbox checked.
 Click the [OK] button to register the expression in [Expressions] view.
 Clicking the [Cancel] button closes the dialog box without registering the expression.

 ・[Source] editor Context menu
 [Add Watch Expression...]:

 See "Registering watch expression" in Section 10.4.3, "[Source] Editor".

 ・[Variables] view Context menu
 [Create Watch Expression]:

 See "Registering watch expression" in Section 10.4.6, "[Variables] View".

 ・[Registers] view Context menu
 [Create Watch Expression]:

 See "Registering watch expression" in Section 10.4.8, "[Registers] View".

 If an invalid expression is registered
 If an invalid watch expression is entered, this will not be able to be evaluated by the debugger.
 This will still be registered incorrectly in [Expressions] view.
 The watch expression should be edited to correct the details.

 If a local variable is registered
 If a local variable is registered, its value can be referenced, provided the variable exists within the function.
 It will be treated as an invalid watch expression if it is moved outside the function

If an array is selected and registered
 If an array variable is selected in [Expressions] view and a watch expression is registered using [Create 

Watch Expression], an expression will be registered in the following form.
 Example: (*((symbol)+0)@10)[2]
 The expression can be interpreted as indicating 
 the second element 
 of the @10 array 
 in the symbol+0 address.

●Editing watch expression (symbol)
 [Edit Watch Expression...]:

 Select [Edit Watch Expression...].
 A dialog box opens with the watch expression to be edited already entered.
 Enter the watch expression and symbol name in the dialog box. (No line break required here)
 Leave the [Enable] checkbox checked. (Values are updated)
 Click the [OK] button to update the expression in [Expressions] view.
 Clicking the [Cancel] button closes the dialog box without registering the expression.
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●Reevaluating watch expression (symbol)
 [Reevaluate Watch Expression]

 A watch expression should be evaluated immediately when it is updated from [Disable] to [Enable]. Select 
the expression to be evaluated, and select [Reevaluate Watch Expression].

●Deleting watch expression (symbol)
 Expressions that are no longer required as watch expressions can be deleted from the window as described 

below.
 Click the expression to be deleted, and then select Context menu > [Remove] or click the Tool bar > [Remove 

Selected Expressions] button.
 All the expressions can be deleted by selecting [Remove All].

●Saving/restoring watch expression
 Registered watch expressions are automatically saved when the IDE is terminated, and are restored the next 

time the IDE is launched. The registered watch expressions will be evaluated when the debugger is relaunched.

●Changing expression value
 Values cannot be changed for watch expressions that have been registered (  icon). Values can be changed only 

for sub-elements with an expression value (variable  icon or pointer  icon).

 Click and select the expression value to be changed (variable  icon or pointer  icon).
 Select Context menu > [Change Value...].
 Edit the value in the dialog box displayed, and click [OK].
 Values should be entered as decimal or hexadecimal (with "0x") values.

Note: Values cannot be changed in [Expressions] view for expressions that have been added. 
[Variables] view should be used to change values.

●Changing display format
 ・Context menu > [Format]

 The display format can be selected from the following.

Table 10.4.7.3.1  Display methods
Selection Display format Default

Binary Binary
Natural Signed decimal ○
Decimal Signed decimal
Hexadecimal Hexadecimal

 Display format changes are applied to all selected items.

●View memory
 [View Memory]:

 Allows a specific variable value to be registered and displayed in [Memory] view.
 Select Context menu > [View Memory] for the variable to be registered, and register and display the variable 

in [Memory] view.
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10.4.7.5  Restrictions
・ Values cannot be changed in [Expressions] view for expressions added. [Variables] view should be used to 

change values.
・ Do not register local variables in [Expressions] view. Values of local variables can be checked using [Variables] 

view.
・ The display will not be updated even if variable details are corrected using commands.
・ The value may not always be updated when the program is suspended. If this occurs, the value should be checked 

via the Details pane.
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10.4.8  [Registers] View

[Registers] view is used for displaying and correcting CPU register values.

10.4.8.1  Window layout

10.4.8.2  Menu/Toolbar

●Toolbar
Table 10.4.8.2.1  Toolbar

Button function

Show Type Names Not supported.
Show Logical Structure Not supported.
Collapse All Collapses the registers displayed.

●View menu
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Table 10.4.8.2.2  View menu
Menu function

Layout Alters the View display layout.
Vertical View Orientation
Horizontal View Orientation
Registers View Only

Displays the detail panes vertically.
Displays the detail panes horizontally.
Hides the detail panes.

Show Columns Toggles the table display.
Select Columns... Not supported.

●Context menu

 

Table 10.4.8.2.3  Context menu
Menu function　

Select All Selects the entire view display.
Copy Registers Copies the details selected.
Enable Allows registers to be updated.
Disable Prevents registers from being updated.
Display As Array... Not supported.
Cast To Type... Not supported.
Restore Original Type Not supported.
View Memory Displays register value addresses in [Memory] view.

Not displayed if register group name is selected.
Find... Searches for registers.
Change Value... Opens the dialog box for changing register values.

Not displayed if register group name is selected.
Add Register Group Creates a register group to display only specific registers.
Restore Default Register Groups Restores the default register group display.

Register groups created will also be deleted.
Edit Register Group Edits the register group.

Displayed only when register group is selected.
Remove Register Group Deletes the register group.

Displayed only when register group is selected.
Create Watch Expression Registers a register in [Expressions] view.

Not displayed when register group name is selected.
Format Changes the display format.

Not displayed when register group name is selected.
Binary
Natural
Decimal
Hexadecimal

Binary
Signed decimal
Signed decimal
Hexadecimal

Note: Operations via the detail pane Context menu are not supported.
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10.4.8.3  Display Details
[Register] view lists the following CPU register details in accordance with the C17 core being debugged.

●Register list
 In order to display the registers, the stack frame must be selected in [Debug] view. The register values will be 

updated when the target program terminates. The updated registers will be highlighted. (Tabular form = Yellow, 
Non-tabular form = Red)

Table 10.4.8.3.1  List of CPU registers
Core Register type

C17 r0–r7, psr, sp, pc

 The registers above will be displayed in tree form as the Main register group.

●Table/list format
 [Registers] view can be displayed in one of two ways as shown below.

Table 10.4.8.3.2  Display methods
Display method Toggle method features

Table format Select [Show 
Columns] in View 
menu.

Display Displays as [Name] and [Value] columns.
Highlighting Locations changed are highlighted.
Value changes Can be edited directly in [Value] column.

List format Deselect [Show 
Columns] in View 
menu.

Display Displays in Register = Value format.
Highlighting Highlighted in red.
Value changes Can be edited via Context menu > [Change Value...].

 The colors used for highlighting can be changed using [Changed value color] or [Changed value background 
color] in Section 10.4.1.6, "Changing Settings.

Note: Sections not displayed in [Registers] view will not be highlighted even if the values are changed.

●Detail pane display
 Views are normally divided into two with the detail panes displayed. Detail panes are displayed only for the 

register values selected.
 The "set output-radix" command setting changes the display format (octal/decimal/hexadecimal).
 The detail pane layout can be changed as shown below using View menu > [Layout].

Table 10.4.8.3.3  Detail pane display methods
Path layout

Vertical View Orientation Displays the detail panes vertically.
Horizontal View Orientation Displays the detail panes horizontally.
Registers View Only Hides the detail panes.

Note: Values will not display correctly if binary is set.

●PSR register detail display
 Selecting the PSR register displays the various register flag values in the detail pane.
 The PSR register details will vary depending on the core being debugged.
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Table 10.4.8.3.4  List of PSR register details
Core PSR flag

C17 STD IL: Interrupt level
IE: Interrupt permission
Z: Zero flag
N: Negative flag
C: Carry flag
V: Overflow flag

flag display methods
Table 10.4.8.3.5 Flag display methods

flag Display method
IL Integer starting from 0

Example: IL:7
All other flags 1 if raised, 0 if lowered

Example: Z:0  N:0  C:1  V:1

10.4.8.4  Operation

●Opening/closing view
 Open the [Registers] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

●Changing display format
 ・Context menu > [Format]
 The display format can be selected from the following.

Table 10.4.8.4.1  List of display formats
Selection Display format Default

Binary Binary
Natural Signed decimal
Decimal Signed decimal
Hexadecimal Hexadecimal ○

 Display format changes are applied to all selected items.

●Changing register data
 [Change Value...]:

 Register values can be changed.
 Select the register to be altered and select [Change Value...].
 Edit the value in the dialog box displayed, and click [OK].

 [Value] column:
 Values can be edited directly via the [Value] column if [Registers] view is displayed in table format. If 

a value is input which exceeds the register size, only the last 24 bits will be valid, with bits 25 and over 
ignored.

●View memory
 [View Memory]:

 This allows a specific register value to be registered and displayed in [Memory] view.
 Select Context menu > [View Memory] for the register to be registered, and register and display the register 

value in [Memory] view in the form "$r0" (for register R0)".

●Registering watch expression
 [Create Watch Expression]:

 Allows specific register values to be registered and displayed in [Expressions] view.
 Select Context menu > [Create Watch Expression] for the register to be registered, and register and display 

the register value in [Expressions] view in the form "$r0" (for register R0)".
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●group registers
 Frequently referenced registers can be grouped and displayed together.
 All registers displayed by default are registered in the group called Main.
 [Add Register Group]:

 Select and name the registers to be grouped from the list.
 The registered group will be displayed in tree form.

 [Restore Default Register Groups]:
 Deletes all the groups registered and restores the Main group (listing all registers).

 [Edit Register Group]:
 Edits a group registered, enabling registers to be added and deleted. (The group name cannot be changed.)

 [Remove Register Group]:
 Deletes a group registered.

10.4.8.5  Restrictions
・ The display is not updated even if the register details are modified by commands.
・ Registers displayed initially in [Registers] view immediately after launching the debugger will vary depending 

on the view display area. Using [Select All] in this case will select only those registers currently displayed.
 If all registers are viewed in [Registers] view, [Select All] selects all of the registers.
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10.4.9  [Memory] View

[Memory] view is used to display and correct the memory details.

10.4.9.1  Window layout
The window is divided into two with the memory monitor pane (address list) on the left-hand side and the memory 
rendering pane (memory data) on the right-hand side. The right-hand pane is divided into address, data, and ASCII 
sections.

10.4.9.2  Menu/Toolbar

●Toolbar
Table 10.4.9.2.1  Toolbar

Button function

New Memory View Opens a new [Memory] view.
Pin Memory Monitor Pins the selection state for the memory monitor (right-hand) pane when a 

new memory address has been registered using [Add Memory Monitor].
When "ON", the currently selected address is retained even when 
registered.
When "OFF", the address changes to the registered address.

Toggle Memory Monitors 
Pane

Displays or hides the memory monitor (left-hand) pane.

Toggle Split Pane Toggles the two-divided display for the memory rendering (right-hand) 
pane.

Link Memory Rendering 
Panes

Not supported.

Switch Memory Monitor Toggles multiple memory monitors (display addresses).

●View menu

 

Table 10.4.9.2.2  View menu
Menu function

Layout Changes the view display
Horizontal Orientation
Vertical Orientation

Displays the memory monitor and memory rendering panes 
horizontally.
Displays the memory monitor and memory rendering panes 
vertically.

Preferences... Opens a dialog box for the overall [Memory] view settings.
Table Renderings Preferences... Not supported.
Traditional Rendering Preferences... Sets the memory rendering (right-hand pane).
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●Context menu
・Memory monitor (left-hand pane) context menu

 

Table 10.4.9.2.3  Context menu (Memory monitor)
Menu function

Add Memory Monitor... Registers a new memory register in the memory monitor.
Remove Memory Monitor Deletes the selected memory address from the memory monitor.
Reset Resets the memory display as far as the selected memory 

address.

・Memory rendering (right-hand pane) Context menu

 

Table 10.4.9.2.4  Context menu (Memory rendering)
Menu function

Add Watchpoint Not supported.
Add Rendering Adds the display format for displaying memory.
Remove Rendering Deletes the memory display currently selected.
Panes Displays or hides the address/data/ASCII sections.

Address Address section
Binary Data section
Text ASCII section

Endian Toggles the display between little endian and big endian.
Big Big endian
Little (default) Little endian

Text Switches the ASCII section encoding.
ISO-8859-1 (default)
US-ASCII
UTF-8.

Displays in one of the encoding types listed on the left.

Cell Size Switches the display byte size for each column of the data section.
1
2
4 (default)
8byte

Displays in one of the encoding types listed on the left.
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Menu function

Radix Switches the display format for each column of the data section.
Hex (default) Hexadecimal

Decimal Signed Signed decimal
Decimal Unsigned Unsigned decimal
Octal Octal
Binary Binary

Columns Switches the number of columns in the data section.
(Data is arranged so that Cell Size x Columns bytes are displayed for 
each line.)

Auto Size to Fill Resizes to fit column view resizing.
1 to 128 Specifies the number of columns. (1/2/4/8/16/32/64/128)
Custom... Specifies the number of columns by direct input.

Copy To Clipboard Copies the section selected.
Copy Address Copies the boundary address at the cursor position.
Reset To Base Address Restores the data section display to the address position at the time it 

was registered in the memory monitor.

10.4.9.3  Display Details

●Memory display

Memory monitor 
pane (address list)

Memory rendering pane (memory data)
Split into address, data, and ASCII sections.

 [Memory] view displays the dump results for the memory area.
 [Memory] view is divided into two panes as shown below.

Table 10.4.9.3.1  Pane display details

Pane Description
Memory monitor pane (left-
hand pane)

Registers the base address forming the start position for memory display.
Multiple addresses can be registered.

Memory rendering pane 
(right-hand pane)

Displays the addresses corresponding to the addresses selected in the 
memory monitor pane split into the address, data, and ASCII sections.
The memory rendering pane display format can be changed via the 
Context menu settings.
The data section endian depends on the display format settings.
(Specifications within parameter files are not used.)
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10.4.9.4  Operation

●Opening/closing view
 Open the [Memory] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

●Display address setting
 [Add Memory Monitor]:

 By default there is no memory address displayed when [Memory] view is opened. Clicking the  icon in 
[Memory] view opens the [Monitor Memory] dialog box. Enter the address for the start of display in the text 
box and click the [OK] button to add the address to the list in the memory monitor pane (left-hand pane). The 
memory area for that address is also displayed in the memory rendering pane (right-hand pane). The address 
can be specified in hexadecimal (prefixed with 0x), decimal, global symbol, or other desired expression.

 When numerical values are specified, the last 32 bits are used, and bits from bit 33 on are ignored. Entering 
0x1122334455667788 will specify the value 0x55667788.

 If a symbol is specified, the symbol value will be used as the address. "&" should be added in front of the 
symbol if the symbol specifies the address at which it is placed.

 The memory rendering (right-hand pane) display must be refreshed by clicking [Add Rendering] if the 
debugger is subsequently launched.

[Add Rendering]:
 Registering an address using [Add Memory Monitor] displays the memory area in the memory rendering 

pane (right-hand pane), which can be opened as shown below if it has been closed.
1. Select the [New Rendering...] tab.
2.  Select [Traditional] from the list.
3.  Click the [Add Rendering] button.

 [Remove Rendering]:
 The address added using [Add Rendering] will be displayed in the memory monitor pane (left-hand pane).
 The corresponding memory display can be deleted by selecting the address and clicking [Remove 

Rendering].
 Clicking [Remove All] deletes all memory currently displayed.

●Registering addresses from other views
 Addresses can be registered in [Memory] view from other views.
 Addresses can be registered using any of the following methods.
・ [Variables] view Context menu > [View Memory]
・ [Expressions] view Context menu > [View Memory]
・ [Registers] view Context menu > [View Memory]

●Scrolling
 Memory areas not visible can be displayed using the scroll bar or Page Up/Page Down keys on the Memory 

Rendering pane (right-hand pane).
 Clicking the [Reset To Base Address] returns to the address position at the time the data section was registered 

in the memory monitor.
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 Note: Performance may be affected if the display is scrolled continuously.

●Changing memory data
 Memory data can be changed using the procedure shown below.

1. Move the cursor over the data to be changed to change the value in the data or ASCII section.
2. Enter the new value. The input is entered in overwrite mode. The input format varies depending on the 

current display format (such as hexadecimal, decimal, or character code).
3. The background changes to light green for newly entered values.

4. To confirm the value, press [Enter].
 The background changes to red for confirmed values.

5. To cancel the value entered, move the cursor away from the input position and press [Esc].

 The following keys cannot be used when entering values.
・ [Backspace]
・ [Delete]
・ [Insert]

 If an incorrect value is entered, move the cursor back to the input position and reenter the correct value. The 
cursor keys can also be used for moving the cursor.

 Note: Values changed will not be highlighted for sections not displayed in [Memory] view.

●Changing display format
 Various display formats can be set via the Context menu for the memory data displayed in the memory 

rendering pane (right-hand pane).

Table 10.4.9.4.1  List of display formats
Display format function

Panes Displays or hides the address/data/ASCII sections.
Address Address section
Binary Data section
Text ASCII section

Endian Toggles the display between little endian and big endian.
Big Big endian
Little (default) Little endian

Text Switches the ASCII section encoding.
ISO-8859-1 (default)
US-ASCII
UTF-8

Displays in one of the encoding types listed on the left.

Cell Size Switches the display byte size for each column of the data section.
1
2
4 (default)
8 bytes

Displays in one of the encoding types listed on the left.

Radix Switches the display format for the data section.
Hex (default) Hexadecimal
Decimal Signed Signed decimal
Decimal Unsigned Unsigned decimal
Octal Octal
Binary Binary

Columns Switches the number of columns in the data section.
(Data is arranged so that Cell Size x Columns bytes is displayed for 
each line.)
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Display format function

Auto Size to Fill Resizes to fit column view resizing.
1 to128 Specifies the number of columns. (1/2/4/8/16/32/64/128)
Custom... Specifies the number of columns by direct input.

●Changing settings
 Settings related to [Memory] view can be opened via the View menu.

・Settings
 [Reset Memory Monitor]

 

Table 10.4.9.4.2  [Reset Memory Monitor] dialog box
Setting Details

Reset Memory Monitor If multiple memory rendering panes (right-hand pane) are opened when 
[Reset] has been used for the memory monitor pane (left-hand pane)

Reset visible renderings Resets only the display currently visible in the memory rendering pane 
(right-hand pane). This should normally be selected.

Reset all renderings Resets the entire display in the memory rendering pane (right-hand 
pane).
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 [Padded String]

 

Table 10.4.9.4.3  [Padded String] dialog box
Setting Details

Padded String This text string is used to display memory data that cannot be displayed.

 [Select Codepages]
  Not supported.
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・Traditional Rendering Preferences
 [Traditional Memory Readering]

 

Table 10.4.9.4.4  [Traditional Memory Rendering] dialog box
Setting Details

Use Global Text Color Uses the system setting (black) for the text color.
Text Color Specifies the color used for text. 

(When [Use Global Text Color] is "OFF")
Brighten Alternate Cells Changes the contrast for text in alternate columns. (Left: light, right: 

dark)
Use Global Background Color Uses the same background color setting as for other views.
Background Color Specifies the background color. 

(When [Use Global Background Color] is "OFF")
Changed Color Specifies the color for locations that have been changed.
Edit Color Specifies the color for locations edited.
Use Global Selection Color Uses the same selection highlight color setting as for other views.
Selection Color Specifies the selection highlight color. 

(When [Use Global Selection Color] is "OFF")
Edit Buffer Specifies the editing method.

Save on Enter, Cancel on 
Focus Lost

Saves changes when [Enter] is pressed or the cursor is moved away 
from the input position. This should normally be used.

Save on Enter or Focus 
Lost

Saves changes when [Enter] is pressed or the cursor is moved away 
from the input position.

History Trail Levels Not supported.

10.4.9.5  Restrictions
・ Display details in [Memory] view will not be updated even if memory address details are corrected using 

commands. [Memory] view should be scrolled to update the display.
・ [Table Renderings Preferences...] is not supported, as it does not use the [Memory] view included with Eclipse.
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10.4.10  [Console] View

[Console] view is used to display command execution and execution results.
It also displays the simulated I/O output. See Section 10.4.11, "[Simulated I/O] View".
For details of the command reference for commands that can be input via this window, see Section 10.7, 
"Command Reference".

10.4.10.1  Window layout

10.4.10.2  Menu/Toolbar

●Toolbar
Table 10.4.10.2.1  Toolbar

Button function

Terminate Terminates the process corresponding to the console.
Remove Launch Deletes the debug icon in [Debug] view corresponding to the console.
Remove All Terminated 
Launches

Deletes all terminated debug icons in [Debug] view.

Clear Console Clears the console display.
Scroll Lock Toggles the scroll lock.
Show Console When 
Standard Out Changes

Focuses the console when there is standard output.

Show Console When 
Standard Error Changes

Focuses the console when there is standard error output.

Save console content Saves the output details.
Pin Console Pins the console currently displayed.
Display Selected Console Switches between the currently displayed console and the previously 

displayed console. It is also possible to switch the display to a console 
selected in the list attached.

Open Console The console selected from the ▼ button list will be opened as a separate 

view.

●View menu
 There is no view menu.
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●Context menu

 

Table 10.4.10.2.2  Context menu
Menu function

Cut/Copy/Paste/Select All Edits the console output text.
Find/Replace... Searches within the console.
Clear Clears the console display.
Remove All Terminated Deletes all terminated debug icons in [Debug] view.
Scroll Lock Toggles the scroll lock.
Preferences... Opens the console setting dialog box.

10.4.10.3  Display Details

●Prompt
 The following prompt is displayed when command input is possible.
 (gdb)

|
 Entering and executing a command displays the corresponding results (only for commands with result 

output functions). For details of the execution results for the commands displayed, refer to the corresponding 
command descriptions. Commands should be entered in the next line after the (gdb) prompt.

 Note that the (gdb) prompt may be output in succession, but commands should be entered in the next line after 
the final (gdb) prompt.

 Standard input, standard output, and standard error output are displayed in different colors respectively. These 
color settings can be changed in [Preferences...].

10.4.10.4  Operation

●Opening/closing view
 Open the [Console] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

Note:  Closing [Console] view prevents commands from being input.
  If [Console] view has been closed, reopen using [Window] > [Show View] > [Console], clicking 

the debugger process (gdb.exe icon) in [Debug] view, and then clicking the [Pin Console] 
button to pin the console.

  If the gdb console does not appear immediately after the debugger has been launched, 
temporarily disable pinning using [Pin Console] in [Console] view, click the debugger process 
(gdb.exe) icon in [Debug] view, and then click the [Pin Console] button before pinning the 
console.
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●Command input
 [Console] view enables debug commands to be input and executed.
 The prompt "(gdb)" appears on the last line in [Console] view, enabling commands to be input via the 

keyboard.
 Selecting the debugger process (gdb.exe icon) in [Debug] view activates [Console] view and enables GDB 

commands to be input.

Note: ・ Commands cannot be input unless the debugger process (gdb.exe icon) is selected in 
[Debug] view.

 ・ The view display is updated after the following commands have been input. (It is not 
updated for commands other than these.)

 ・ Press the Enter key if a character is inserted before the "(gdb)" console prompt or ">" 
command prompt.

 Example 1: "(gdb)" prompt Example 2: ">" prompt

  

(Deleting the character with "Backspace" will prevent console input. If this happens, click 
the Exit button  at the top right in Console view to exit the debugger.)

Table 10.4.10.4.1  List of commands for updating views
Category Command

Breakpoint commands break

tbreak

hbreak

thbreak

info breakpoints

Step execution commands step

stepi

next

nexti

finish

continue

until

CPU reset commands c17 rst

●Editing operations
 [Cut/Copy/Paste/Select All]:

 Cuts, copies, pastes, and selects all text strings in [Console] view.
 [Find/Replace...]:

 Searches for text strings in [Console] view.

  Note: Does not replace.
 [Clear Console]:

 Clears the current console output using either the [Clear Console] button or Context menu > [Clear].
 [Save console content]:

 The [Save console content] button can be used to save the current console output to a file.

●Display related operations
 [Pin Console]:

 [Console] view allows more than one console to be displayed within a single view, but selecting this button 
pins the currently displayed console to ensure that it is constantly displayed.

 This prevents the console for command input from being hidden when there is output to other consoles such 
as simulated I/O.
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 [Display Selected Console]:
 [Console] view allows more than one console to be displayed within a single view, and this selects the 

particular console to be displayed.
[Scroll Lock]:
 Enables scrolling to be locked.
[Show Console When Standard Out Changes]:
[Show Console When Standard Error Changes]:
 Clicking these buttons changes the focus to [Console] view when standard output or standard error output is 

written, respectively.

●Terminating process
 The same procedures as for [Debug] view can be used in [Console] view.

 [Terminate]:
 Terminates the debugger (GDB). The [Debug] view display also terminates.

 [Remove Launch]:
 [Remove All Terminated Launches]:

 Deletes terminated debugger displays in [Debug] view.
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●Changing settings
 Console settings can be changed via the [Preferences...] menu.

 ・[Console]

Table 10.4.10.4.2  [Console] setting dialog box
Setting Details

Fixed width console Fixes the console width. This should be left set to "OFF".
Maximum character width Specifies the width.

Limit console output Limits the output buffer.
Console buffer size 
(characters)

Specifies the buffer size by number of characters.

Displayed tab width Specifies the tab width.
Show when program writes to 
standard out

Focuses the console when there is output.

Show when program writes to 
standard error

Focuses the console when there is error output.

Standard Out text color Sets the output text color.
Standard Error text color Sets the error output text color.
Standard In text color Sets the input text color.
Background color Background color
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10.4.10.5  Restrictions
・The maximum number of output characters is equivalent to the [Console buffer size] setting + 8,000.
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10.4.11  [Simulated I/O] View

The simulated I/O function output is displayed in [Console] view.
When the target program (elf icon) is selected in [Debug] mode, [Console] view becomes the active view, 
displaying the simulated I/O output window.
The simulated I/O function is input via the keyboard in [Console] view.
If the keyboard is used for input, no filename should be specified in the c17 stdin command arguments.
To use file input, specify the filename in the c17 stdin command arguments.

10.4.11.1  Window layout

10.4.11.2  Menu/Toolbar
These are the same as the menu and toolbar for [Console] view.
See Section 10.4.10.2, "Menu/Toolbar".

10.4.11.3  Display Details
Details are displayed for the simulated I/O function output and keyboard input to stdout.

Note: ・ Closing [Console] view prevents the simulated I/O output from being displayed. If [Console] 
view has been closed, reopen using [Window] > [Show View] > [Console], and clicking the 
target program icon in [Debug] view.

・ "\n" (line break) must always be added to output functions such as printf when using 
simulated I/O. Lines without line breaks added cannot be output in [Console] view.

10.4.11.4  Operation
The following operations can be used in [Console] view.

●Editing operations
 [Cut/Copy/Paste/Select All]:

 Cuts, copies, pastes, and selects all text strings in [Console] view.
 [Find/Replace...]:

 Searches for text strings in [Console] view.

 Note: Does not replace.
 [Clear Console]:

 Clears the current console output using either the [Clear Console] button or Context menu > [Clear].
 [Save console content]：

 The [Save console content] button can be used to save the current console output to a file.



S5U1C17001C MANUAl Seiko Epson Corporation 10-77
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

10
Debugger

●Display related operations
 [Pin Console]:

 [Console] view allows more than one console to be displayed within a single view, but selecting this button 
pins the currently displayed console to ensure that it is constantly displayed.

 This prevents the console for command input from being hidden when there is output to other consoles such 
as simulated I/O.

[Display Selected Console]:
 [Console] view allows more than one console to be displayed within a single view, and this selects the 

particular console to be displayed.
 [Scroll Lock]:

 Enables scrolling to be locked.
 [Show Console When Standard Out Changes]:
 [Show Console When Standard Error Changes]:

 Clicking these buttons changes the focus to [Console] view when standard output or standard error output is 
written, respectively.

Note that changes to [Console] settings are also applied to simulated I/O.
See "Changing settings" in Section 10.4.10.4, "Operation".
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10.4.12  [Trace] View

[Trace] view is used to display trace data.

10.4.12.1  Window layout

10.4.12.2  Menu/Toolbar

●Toolbar
Table 10.4.12.2.1  Toolbar

Button function

Clear Trace Clears the trace display.
Save Trace content Saves the trace output details.

●View menu
 There is no view menu.

●Context menu

Table 10.4.12.2.2  Context menu
Menu function

Copy/Select All Edits output text strings.
Clear Trace Clears the trace display.

10.4.12.3  Display Details
The trace data is displayed forming the execution results for commands.
For details of how to start and set traces, see Section 10.6.6, "Trace Functions".
If trace data is received from the debugger by the IDE while debugging is in progress with trace turned on, [Trace] 
view opens automatically to display the data.

Note: ・ Trace data that can be displayed only once is subjected to a size limit of 1,000,000 characters 
by [Console buffer size] in "Changing settings" in Section 10.4.10.4, "Operation". Adjoining old 
data which has been executed will not be displayed.

 ・ The debug monitor mode does not have a trace function.

●PC trace
 Enabling the Trace function displays the trace for all subsequent program executions.
 (Except when file output is selected)

 The following information is displayed:
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・ Trace number
・ Clock count
・ PC value and command code
・ Bus information (address, R/W and access size, data)
・ Register value (R0 to R7, SP)
・ PSR value (IE, IL, CVZN)
・ Disassembly details and source
・ Calculation display specification for clock count (clock count displayed separately for each command if 0)
Sets which of the above information is displayed when c17 tm command is set.

10.4.12.4  Operation

●Opening/closing view
 Open the [Trace] view using [Window] > [Show View]. See Section 10.4.1.3, "Opening/Closing View". The 

view can be closed by clicking the X button.

●Trace data editing operations
 [Clear Trace]:

 The current output details can be cleared using the [Clear Trace] button or [Clear Trace] in the Context menu.
 [Save Trace content]:

 The [Save Trace content] button can be used to save the current trace output to a file.
 [Copy/Select All]:

 Edits (copies/selects all) the trace output.
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10.5  Method of Executing Commands
This section describes the method of executing these commands. For command parameters and other details, see 
the explanation of each command described later in this manual.

10.5.1  Entering Commands from the Keyboard

Commands are entered using [Console] view. If [Console] view lies behind other views, click [Console] view to 
activate it. If [Console] view is not displayed, select [Console] from the [Window] > [Show View] menu.

general command input format

(gdb) 
command [parameter [parameter ... parameter]]

 A space is required between the command and a parameter, and between parameters.

 If you have entered an incorrect command by mistake, use the arrow (←, →), [Backspace], or [Delete] keys to 
correct it.

 When you have finished entering a command, press the [Enter] key to execute the command.
 Example: (gdb) 
   continue  (entry of command only)

   (gdb) 
   target icd usb (entry of command and parameters)
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10.5.2  Parameter Input format

Numeric input
 Parameters used to specify an address or data in a command must be entered in decimal (by default). To enter a 

parameter in hexadecimal, add 0x (or 0X) to the beginning of the value. Only characters 0 to 9, 'a' to 'f' and 'A' 
to 'F' are recognized as hexadecimal.

 To specify an immediate address in a command that causes the program to break, add * to the beginning of the 
value, as shown below. 

 Example: (gdb) 
   break *0xc00040

 You need not add this asterisk for address parameters not preceded by * in the explanation of each command 
format. 

Specifying a source line number
 For commands that cause the program to break, you can specify a breakpoint by source line number. However, 

this is limited to only when debugging an elf format object file that includes information on source line 
numbers. 

 To specify a line number, use the format shown below.

Filename:LineNo.

Filename: Source file name
  Filename: can be omitted when specifying a line number existing in the current file (one that 

includes code for the current PC).
LineNo.: Line number
  Line numbers can only be specified in decimal.

 Example: main.c:100

Address specification by a symbol
 You can use a symbol to specify an address. However, this is limited to only when debugging an elf format 

object file that includes symbol information. 

Entering a file name
 For file names in other than the current directory, always be sure to specify a path.
 Only characters 'a' to 'z,' 'A' to 'Z,' 0 to 9, /, and _ can be used. 
 Drive names must be specified in /cygdrive/<drive name>/ format, with / instead of \ used for delimiting 

the path.
 Example: (gdb) 
   file /cygdrive/c/EPSON/gnu17/sample/txt/sample.elf
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10.5.3  Using Menus and Toolbar To Execute Commands 

Some commands are registered in the [Debug] view, [Source] editor menus, and toolbars. Specified commands can 
be executed simply by selecting from a menu or clicking the corresponding toolbar button. Each view also includes 
a corresponding function for executing a command. Table 10.5.3.1 below lists the registered commands.

Table 10.5.3.1  Commands specifiable from menus, toolbar, and views
Command View Menu/Other Button

continue [Debug] [Run] > [Resume]
[Resume] in Context menu

until [Source]
[Disassembly]

[Run] > [Run to Line]
[Run to Line] in Context menu – 

step [Debug] [Run] > [Step Into]
[Step Into] in Context menu

stepi [Debug] [Run] > [Step Into] in instruction stepping mode
[Step Into] in Context menu in instruction stepping mode 

When 
selected

next [Debug] [Run] > [Step Over]
[Step Over] in Context menu

nexti [Debug] [Run] > [Step Over] in instruction stepping mode
[Step Over] in Context menu in instruction stepping mode

When 
selected

finish [Debug] [Run] > [Step Return]
[Step Return] in Context menu

user command* [Debug] [Run] > [User Command]
[User Command] in Context menu

c17 rst * [Debug] [Run] > [Reset]
[Reset] in Context menu

c17 profile [Debug] [Profile] in Context menu

c17 coverage [Debug] [Coverage] in Context menu

break [Source]
[Disassembly]

[Run] > [Toggle Breakpoint]
[Run] > [Toggle Line Breakpoint]
[Run] > [Toggle Method Breakpoint]
Double-click Line ruler
[Toggle Breakpoint] in Line ruler Context menu

– 

tbreak [Source]
[Disassembly]

[Toggle Temporary Software PC Breakpoint] in Line ruler 
Context menu – 

hbreak [Source]
[Disassembly]

[Toggle Hardware Breakpoint] in Line ruler Context menu
– 

thbreak [Source]
[Disassembly]

[Toggle Temporary Hardware Breakpoint] in Line ruler 
Context menu – 
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Command View Menu/Other Button

disable [Source] [Disable Breakpoint] in Context menu – 

[Breakpoints] [Disable] in Context menu – 

enable [Source] [Enable Breakpoint] in Context menu – 

[Breakpoints] [Enable] in Context menu – 

delete [Source] Double-click Line ruler – 

[Breakpoints] [Remove] or [Remove All] in Context menu – 

x /b, x /h, x 
/w 

[Memory] Enter address via keyboard
– 

set {char}, 
set {short}, 
set {int} 

[Memory] Enter data via keyboard
– 

info reg [Registers] Open register group name (e.g., main) – 

set $Register [Registers] [Change Value] in Context menu – 

info locals [Variables] [Window] > [Show View] > [Variables] – 

print [Source] Move cursor to variable
[Add Watchpoint Expression] in Context menu

– 

[Expressions] [Add Watchpoint Expression] in Context menu

[Variables] [Add Global Variables] in Context menu

quit [Debug] [Run] > [Terminate]
[Terminate] in Context menu

   * These menus, commands, and buttons are associated with corresponding command files, and execute the 
command files using the source command. The contents of the command files may be freely edited by the user. 

 Furthermore, the file name and directory cannot be changed. If the command file does not exist in the directory 
in which the file was installed, an error occurs when it is executed by the menu command or the button.

 
[Run]-[User Command]

 Executes the command file \gnu17\userdefine.gdb. 
  Contents of userdefine.gdb at shipment
   #Edit user command
   #c17 rst  (No command executed) 

 
[Run]-[Reset]

 
 Executes the command file \gnu17\reset.gdb that can be edited by the user. 
  Contents of reset.gdb at shipment
   c17 rst  (Resets the CPU) 

Note: Compared to actual command input, this method is subject to some limitations (e.g., parameters 
cannot be specified).

The commands executed from menus or the toolbar are not displayed in the prompt part of the [Console] view.  
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10.5.4  Using a Command file To Execute Commands 

You can use a command file to execute a series of debugging commands written in the file. 

Creating a command file
 Create a command file as a text file using a general-purpose editor, etc.

Example of a command file
 Only one command can be written per line.
 Example: 

 c17 rpf c17.par Sets memory map information. 
 file sample.elf Loads debug information.
 target sim Connects the target.
 load Loads a program.
 c17 rst Resets the CPU.
 c17 stdout 1 WRITE_FLASH WRITE_BUF stdout.txt Sets stdout.
 c17 stdin 1 READ_FLASH READ_BUF stdin.txt Sets stdin.
 break _exit Sets a software PC breakpoint.
 cont Executes the program.
 c17 stdout 2 Clears stdout.
 c17 stdin 2 Clears stdin.

loading/executing a command file
 There are two methods of loading and executing a command file: 

1. Execution by a startup option
 By specifying the -x option (or --command option) in the debugger startup command, you can execute 

one command file at debugger startup.
 Example: c:\EPSON\gnu17\gdb -x startup.cmd

2. Execution by a command
 A command named "source" is available to execute a command file. The source command loads a 

specified file and executes the commands in it in the order written.
 Example: (gdb) 
  source startup.cmd

 The commands written in a command file are displayed in the [Console] view. 

Command execution intervals
 When you enter the --c17_cmw option, a wait time specified in seconds is inserted between each command. 

The wait time can be specified from 1 to 256 seconds. If any other value is specified, a 1-second wait time is 
assumed. When the debugger is started without specifying the --c17_cmw option, no wait time is inserted 
between each command. 
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10.5.5  log files

The commands executed and execution results can be saved as a log file in text format. Log files enable you to 
confirm the debugging procedure and contents at a later time.

Example command
 (gdb) 
 c17 log test.log Starts logging.

   :  Log mode
 (gdb) 
 c17 log   Finishes logging.

 After logging is started by the c17 log command, the debugger saves a log until the next time you execute 
this command.

Saved contents of a log 
 All commands executed and execution results are saved. This includes commands that have been executed from 

menus or toolbar buttons and are not displayed in the [Console] view.
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10.6  Debugging functions
This section outlines the debugging functions of gdb, separately for each function. For details about each debugging 
command, see Section 10.7, "Command Reference".

10.6.1  Connect Modes

Note that gdb supports two connect modes, of which the mode used is set by the target command. 

ICD Mini mode
 In this mode, the ICD Mini (S5U1C17001H) or ICD board is used to perform debugging. The program is 

executed on the target board. 

USB cable
(included with the ICD package)

4-pin to 4-pin
target system
connecting cable
(included with the ICD package)

USB

Target board

ICD

Figure 10.6.1.1  Example of debugging system using an ICD 

 Specification method
 Command: (gdb) 
   target icd usb

 Specification in IDE:
 Select "ICD Mini" from the [Debugger:] combo box in the [Create a simple startup command] 

dialog box to generate a startup command file.

 To start in ICD Mini mode, make sure an ICD and target board are connected correctly, and that the power for 
these units is turned on. For details on how to use the ICD, refer to the manual for the ICD used.

 Note that the trace mode is not available in ICD Mini mode.

Simulator (SIM) mode
 In simulator mode, target program execution is simulated in internal memory of a personal computer, with no 

other tools required. However, the ICD-dependent functions cannot be used in this mode.

 Specification method
 Command: (gdb) 
   target sim

 Specification in IDE:
 Select "Simulator" from the [Debugger:] combo box in the [Create a simple startup command] 

dialog box to generate a startup command file.

 The trace mode is available in simulator mode. The flash writer function cannot be used.
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10.6.2  loading a file

Types of files
 The debugger gdb can load an elf format object file to debug. 

file loading procedure 
 Use the following two commands to load a file:
 file command: Loads debugging information.
 load command: Loads object code into the target.

 Aside from the above, the debugger is provided with the c17 rpf command, which can be used to load a 
parameter file to set memory map information of the target. 

 The file command must be executed before the target or load command. The c17 rpf command must 
be executed before the target command.

 The following shows the basic procedure to execute a series of operations from loading a file to debugging.
 (gdb) 
 c17 rpf sample.par (Sets map information.)

 (gdb) 
 file sample.elf (Loads debugging information.)

 (gdb) 
 target icd usb (Connects the target.)

 (gdb) 
 load (Loads the program.)

 (gdb) 
 c17 rst (Resets the CPU.)

 To debug a program written in target ROM, there is no need to execute the load command. In this case, the 
file command can also be used to load debugging information for source-level debugging.

Notes
 The load command only loads several areas (containing the code and data) of an object file. All other areas 

are left intact in the original state before the load command was executed. 
 The debugger gdb loads source files according to debugging information to display the sources. Therefore, 

both contents and storage locations (directories) of the source files must be in the same state as at elf object file 
creation. 
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10.6.3  Manipulating Memory, Variables, and Registers

The debugger gdb can perform operations in memory and registers. 16-bit and 32-bit data are accessed and 
displayed in little endian format. In simulator mode, however, a specific external memory area can be displayed in 
big endian format (as set in a parameter file).

Manipulating memory areas
 Following operations can be performed in memory areas. You can use such symbols as variable names to 

specify addresses. Any operation described below can be processed in units of bytes, 16 bits, or 32 bits.

  Memory dump (x /b, x /h, x /w commands)
 Dumps memory contents for a specified amount of data from a specified address for display on the screen.
 Example: Memory dump for 16-bit × 16 from _START_text

(gdb) 
x /16h _START_text 
0xc00000 <_START_text>: 0x0004 0x00c0 0xc020 0x6c0f 0xa0f1 0xc000 0xc000 0x6c0f
0xc00010 <boot+12>:     0xc000 0xc000 0x1c04 0xdff8 0xdfff 0x1ef5 0x0200 0x6c04

 Memory data can be displayed in the [Memory] view. For display in the [Memory] view and how to operate in 
it, see Section 10.4.9, "[Memory] View".

  Entering data (set {char}, set {short}, set {long} commands)
 Writes specified data to a specified address.
 Data can also be entered or changed in the [Memory] view.
 Example: Setting int i to 0x5555

(gdb) 
set {short}&i=0x5555

  Rewriting a specified area (c17 fb, c17 fh, c17 fw commands)
 Rewrites all of a specified area with specified data.
 Example: Writing 0x00000001 (32 bits) × 4 to addresses 0x0 through 0xf

(gdb) 
c17 fw 0x0 0xf 0x1
Start address = 0x0, End address = 0xc, Fill data = 0x1 .....done 

  Copying a specified area (c17 mvb, c17 mvh, c17 mvw commands)
 Copies the content of a specified address to another area.
 Example: Copying 8 bytes from addresses 0x0 through 0x7 to an 8-byte area beginning with address 0x8

(gdb) 
c17 mvb 0x0 0x7 0x8
Start address = 0x0, End address = 0x7, Destination address = 0x8 .....done 

  Saving memory contents (c17 df command)
 Outputs the contents in a specified range of memory to a file in binary, text, or Motorola S3 format.
 Example: Saving the contents of addresses 0x80000 to 0x80103 as a Motorola S3 format file named dump.mot

(gdb) 
c17 df 0x80000 0x80103 3 dump.mot
Start address = 0x80000, End address = 0x8011f, File type = Motorola-S3
Processing 00080000-0008011F address.
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 Specification of target memory read mode (c17 readmd command)  ICD Mini mode only
 In an ordinary memory read by the x command or c17 df command, data is always read out in units of bytes, 

regardless of accessed data size. If this read method becomes inconvenient, use the c17 readmd command to 
alter the read method so that memory data will be read out from the correct boundary address in specified units. 
Note that doing so will increase memory dump time.
Example: The read method is modified so that memory data will be read out from the correct boundary address 

in specified units.
(gdb) 
c17 readmd 1

 Variable list
 A list of variables can be displayed. 

  Displaying global variables (info var, print commands)
 You can display a list of global variables, static variables, or section symbols by using the info var 

command. You also can display the contents of variables by using the x or print command.
 Example: Displaying a list of global symbols 

(gdb) 
info var
All defined variables:

File main.c:
int i;

Non-debugging symbols:
0x00000000  __START_bss
0x00000004  __END_bss
0x00000004  __END_data
0x00000004  __START_data

 Moreover, when the [Expressions] view has global variables 
registered in it, you can monitor the values of those variables. For 
display in the [Expressions] view and how to operate in it, see 
Section 10.4.7, "[Expressions] View".

  Displaying local variables (info locals command)
 You can display a list of local variables and values defined in a function that includes the current PC address by 

using the info locals command.
 Example: Displaying local variables defined in current function 

(gdb) 
info locals
i = 0
j = 2

 Moreover, by leaving the [Variables] view open, you can monitor 
the values of all local variables defined in the current function. For 
display in the [Variables] view and how to operate in it, see Section 
10.4.6, "[Variables] View".
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Register operation
 The following operations can be performed in registers.

  Displaying registers (info reg command)
 You can display the contents of all CPU registers or the content of a specified register in the [Console] view.
 Example: Displaying the values of all registers

(gdb) 
info reg
r0             0xd20 3360
r1             0xaaaaaa 11184810
r2             0xaaaaaa 11184810
r3             0xaaaaaa 11184810
r4             0x690 1680
r5             0xaaaaaa 11184810
r6             0x0 0
r7             0xaaaaaa 11184810
sp             0x7f8 2040
pc             0x4090 16528
psr            0x0 0

 The [Registers] view also displays register values. For display in the [Registers] view and how to operate in it, 
see Section 10.4.8, "[Registers] View".

  Altering register values (set $ command)
 You can set the contents of CPU registers to any desired values.
 Example: Setting the r1 register to 0x10000

(gdb) 
set $r1=0x10000

 The register values can also be rewritten in the [Registers] view. (See Section 10.4.8, "[Registers] View".)
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10.6.4  Executing the Program

The debugger can execute the target program continuously or one step at a time (single-stepping). 

Continuous execution

  Continuous execution commands (continue, until commands)
 The continuous execution commands execute the loaded program continuously from the current PC address.

 continue command: When executing the program continuously, you can disable the current breakpoint a 
specified number of times. 

 Example 1: Executing the program continuously from current PC
(gdb) 
cont
Continuing.

Example 2: Executing the program continuously from current PC after specifying that current breakpoint be 
skipped 4 times

(gdb) 
continue 5

 until command: You can specify a temporary PC breakpoint that is effective for only one break and cause the 
program to stop running at that position.
Example: Executing the program continuously from current PC to 10th line in main.c and causing the 

program to break immediately before executing 10th line in main.c
(gdb) 
until main.c:10
main () at main.c:10

 The commands above can also be executed in the [Debug] view. 
To execute the continue command: • Choose [Resume] from the [Run] menu.
 • Click the [Resume] button.

   [Resume] button

 * You cannot specify the number of times that a break should be 
disabled.

To execute the until command: • Select [Run to Line] in Context menu.
 * To display a context menu, right-click at the beginning of the source 

line where you wish to set a temporary PC breakpoint.

 For details on how to operate in the [Source] editor, see Section 10.4.3, "[Source] Editor."

  Stopping continuous execution
 The program being executed does not stop until made to break by one of the following causes:

• Break conditions set by a break setup command are met (including a temporary break specified by the un-
til command).

• Forcible break (generated by clicking the [Suspend] button)
• Other causes of break generated

 [Suspend] button

* If the program does not stop, it can be forcibly made to break by using this button.

 When the program stops, the cause of break and halted position are displayed in the [Console] view. Moreover, 
the contents displayed in the [Source] editor and [Registers] view are updated.



10-92 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

Single-stepping a program

  Types of single-step commands
 There are three types of single-step commands:

Single-stepping all codes (step and stepi commands)
 The program is executed one step or a specified number of steps from the current PC address. When a 

function or subroutine call is encountered, lines or instructions in the called function or subroutine are 
single-stepped.

 step command: The program is single-stepped one source line at a time.
 Example: Single-stepping the program by one source line indicated by the current PC

(gdb) 
step

 stepi command: The program is single-stepped one assembler instruction at a time.
 Example: Single-stepping the program by ten instructions from the address indicated by the current PC

(gdb) 
stepi 10
main () at main.c:13

Single-stepping all codes except functions/subroutines (next and nexti commands)
 The program is executed one step or a specified number of steps from the current PC address. When a 

function or subroutine call is encountered, all lines or instructions in the called function or subroutine are 
executed successively as one step. Otherwise, these commands operate the same way as the step and st-
epi commands.

 next command: The program is single-stepped one source line at a time. 
Example: Single-stepping the program by one source line indicated by the current PC, with any and all 

lines in a called function executed successively as one step
(gdb) 
next

 nexti command: The program is single-stepped one assembler instruction at a time.
Example: Single-stepping the program by ten instructions from the address indicated by the current PC, 

with any and all lines in a called subroutine executed successively as one step
(gdb) 
nexti 10
main () at main.c:13

Terminating a function/subroutine (finish command)
 When the program has been halted within a function/subroutine, this command single-steps the program 

until returning to the caller.
 Example: Terminating the current function

(gdb) 
finish
Run till exit from #0  0x00c00040 in sub (k=1) at main.c:22
main () at main.c:14
Value returned is $1 = 480

 When executing the commands above from the command prompt, you can specify the number of steps to 
execute, for up to 0x7fffffff. 

 When the program stops, the source at the halted position is displayed in the [Console] view. The contents 
displayed in the [Source] editor and [Registers] view are also updated.

 The commands above can also be executed using the menus or toolbar buttons in the [Debug] view. However, 
you cannot specify the number of steps to execute (since only one step is always executed).
To execute the step command: • Select [Step Into] in the [Run] menu.
 • Select [Step Into] in the Context menu.
 • Click the [Step Into] button.

  [Step Into] button
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To execute the stepi command: • Select [Step Into] in the [Run] menu with the [Instruction Stepping Mode] 
button selected.

 • Select [Step Into] in the Context menu with the [Instruction Stepping 
Mode] button selected.

 • Click the [Step Into] button with the [Instruction Stepping Mode] button 
selected.

  [Step Into] button with   selected

To execute the next command: • Select [Step Over] in the [Run] menu.
 • Select [Step Over] in the Context menu.
 • Click the [Step Over] button.

   [Step Over] button

To execute the nexti command: • Select [Step Over] in the [Run] menu with the [Instruction Stepping 
Mode] button selected.

 • Select [Step Over] in the Context menu with the [Instruction Stepping 
Mode] button selected.

 • Click the [Step Over] button with the [Instruction Stepping Mode] button 
selected.

   [Step Over] button with   selected

To execute the finish command: • Select [Step Return] in the [Run] menu.
 • Select [Step Return] in the Context menu.
 • Click the [Step Return] button.

   [Step Return] button

  Breaking program execution during single-stepping
 When the program is run after specifying the number of steps to execute, the program will be made to break 

before completion by one of the following causes:
• Forcible break (generated by clicking the [Suspend] button)
• Other causes of break than those set by the user

During single-stepping, the program does not stop at PC breakpoints.

 [Suspend] button

* If the program does not stop, it can be forcibly made to break by using this button.

 When the program stops, the cause of break and halted position are displayed in the [Console] view. 

Calling a user function (callmd and call commands)
 The call command can be used to call a user function. 
 The callmd command is used to set the destination (screen or file) to which execution results of the call 

command are to be output.

HAlT and SlEEP states and interrupts
 The halt and slp instructions are always executed to place the CPU in standby mode, regardless of whether 

the program is executed continuously or single-stepped. The CPU exits standby mode when an external 
interrupt is generated. Clicking the [Suspend] button also releases the CPU from standby mode. 
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Measuring the execution cycles/execution time
 In ICD Mini or simulator mode, you can measure the program execution cycles or time.

  Execution counter
 In ICD Mini, the counter measures only execution time. In simulator mode, it counts only the number of cycles 

executed. 
 The measurement results can be displayed in the [Console] view by using the c17 clock command.
 If the counter exceeds the maximum measurable value, a message ("clock timer overflow") is displayed. 

  Integrating mode and reset mode
 With the debugger's default settings, the execution cycle counter is set to integrating mode. In this mode, the 

values measured by the counter each time are integrated until the counter is reset. 

 Reset mode can be set using the c17 clockmd command. In cases where the counter is set to reset mode, the 
counter is reset when the program is started by entering an execution command and continues counting until the 
program terminates (or made to break). 

  Resetting the execution counter
 The execution counter is reset in the following cases:

• When the mode of the execution counter is changed (from integrating mode to reset mode, or vice versa) by 
the c17 clockmd command 

• When the program is started while the counter is set to reset mode 
• When the CPU is reset 
• When the c17 timebrk, step, stepi, next, nexti or finish command is executed in ICD Mini 

mode

Resetting the CPU 
 The CPU is reset by the c17 rst command. This command can also be executed using the menu or toolbar 

button in the [Debug] view.
To execute the c17 rst command: • Choose [Reset] from the [Run] menu.
(\gnu17\reset.gdb) • Click the [Reset] button.

  [Reset] button

Note: This menu command/button executes the predetermined command file. The command file at 
shipment contains the above reset command only (it may be edited by the user).

 When the CPU is reset, its internal registers and other components are initialized as shown below.

(1) Internal registers of the CPU 
 r0–r7: 0x000000
 pc:  Boot address (reset vector in the trap table)
 sp: 0xfffffc
 psr: 0x00 (IL = 000, IE = 0, CVZN = 0000)

(2) The execution counter is cleared to 0.

(3) The [Source] editor and [Registers] view reappear.
 Because the PC is set to the boot address, the [Source] editor redisplays the program beginning with that 

address. The [Registers] view reappears with the initialized values. 

 Memory contents are not changed.
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10.6.5  Break functions

The target program being executed is made to break by one of the following causes:
•  Break conditions set by a break setup command are met. 
•  A forcible break is applied (by clicking the [Suspend] button).
•  An illegal attempt is made to access memory, etc.

Command-actuated breaks
 The debugger gdb supports the following two types of breaks for which break conditions can be set by a 

command:
 1. Software PC break
 2. Hardware PC break

 In all cases, the program being executed is made to break when break conditions are met.

  Software PC breaks (break and tbreak commands)
 This type of break occurs when the executed PC address matches the address set by a command. The program 

is actually made to break before executing the instruction at that address. Breakpoints can be set at up to 200 
address locations.

 There are two types of software PC breaks: normal and temporary. Both are the same in terms of functionality. 
The only difference is that a normal software PC breakpoint remains effective until being cleared by a command, 
regardless of how many times the program is made to break (a hit). Conversely, a temporary software PC 
breakpoint is cleared after one break hit.

 break command: This command sets a normal software PC breakpoint.
 Example: To set a software PC breakpoint at address 0xc0001c

(gdb) 
break *0xc0001c
Breakpoint 1 at 0xc0001c: file main.c, line 7.

 tbreak command: This command sets a temporary software PC breakpoint.
 Example: To set a temporary software PC breakpoint at address 0xc0001e

(gdb) 
tbreak *0xc0001e
Breakpoint 2 at 0xc0001e: file main.c, line 10.

 When a software PC break occurs, the debugger waits for command input after displaying the following message:
(gdb) 
continue
Continuing.

Breakpoint 1, main () at main.c:7

 Breakpoints can be set by specifying a source line number or function/label name, as well as by directly 
specifying addresses. Specifying a source line number sets a breakpoint at the address of the first assembler 
instruction to be executed among those for which the specified line is expanded. Specifying a line that is not 
expanded to such assembler instructions, such as a variable declaration that does not involve initialization,  a 
breakpoint will be set at the line that contains the first instruction to be executed next. 

 Example: To set a software PC breakpoint at line 7 in main.c
(gdb) 
break main.c:7
Breakpoint 1 at 0xc0001c: file main.c, line 7.

 Specifying a function name sets a breakpoint at the source line that contains the first instruction to be executed 
in the function. No breakpoints are set at lines consisting only of variable declarations. 

 Example: To set a software PC breakpoint in function main
(gdb) 
break main
Breakpoint 1 at 0xc0001c: file main.c, line 7.

 Although the ld instruction to save registers is added at the beginning of a function when compiling source 
files, the address of this instruction does not constitute a breakpoint because it does not correspond to any 
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source line. However, it can be set as a breakpoint by specifying that address.
 Software PC breakpoints can also be set from the [Source] editor. 
 For details, see Section 10.4.5, "[Breakpoints] View".

Notes: • Software PC breaks are implemented by an embedded brk instruction. Therefore, they cannot 
be used for the target board ROM in which instructions cannot be embedded. In such case, 
use hardware PC breaks instead.

 • When you set a software PC break at the address of an ext-based extended instruction or 
delayed branch instruction, note that you cannot set a breakpoint at other than the start address. 

  ext xxxx ... Can be set. jr*.d xxxx ... Can be set.
  ext xxxx ... Cannot be set.  Delayed instruction ... Cannot be set.
  Extended instruction ... Cannot be set. 

 • The debugger refers to the memory map information set by loading a parameter file using 
the c17 rpf command as it checks each address to determine whether a software PC 
breakpoint can be set. Unless the c17 rpf command has been executed, the debugger does 
not perform error processing that pertains to the target system.

  Hardware PC breaks (hbreak and thbreak commands)
 The on-chip debugger of the S1C17 Core is used to set the type of break. Breaks can also be simulated in 

simulator mode, as well as in other modes. When the executed PC address matches the address set by a 
command, the program is made to break before executing the instruction at that address. The maximum number 
of addresses that can be set as hardware PC breakpoints depends on the model. For more information, refer to 
the technical manual for the model in question.

 Like software PC breaks, there are two types of hardware PC breaks: normal and temporary. 

 hbreak command: This command sets a normal hardware PC breakpoint.
 Example: To set a hardware PC breakpoint at line 7 in main.c

(gdb) 
hbreak main.c:7
Hardware assisted breakpoint 1 at 0xc0001c: file main.c, line 7.

 thbreak command: This command sets a temporary hardware PC breakpoint.
 Example: To set a temporary hardware PC breakpoint at address 0xc0001e

(gdb) 
thbreak *0xc0001e
Hardware assisted breakpoint 2 at 0xc0001e: file main.c, line 10.

 When a hardware PC break occurs, the debugger waits for command input after displaying the following 
message:
(gdb) 
continue
Continuing.

Breakpoint 1, main () at main.c:7

 Breakpoints can be set by specifying an address, source line number, or function/label name the same way as 
for software PC breakpoints. 

 Hardware PC breakpoints can also be set from the [Source] editor. 
 For details, see Section 10.4.5, "[Breakpoints] View".
Note: When you set a hardware PC break at the address of an ext-based extended instruction or 

delayed branch instruction, note that you cannot set a breakpoint at other than the start address. 
  ext xxxx ... Can be set. jr*.d xxxx ... Can be set.
  ext xxxx ... Cannot be set.  Delayed instruction ... Cannot be set.
  Extended instruction ... Cannot be set. 

  Breakpoint control (software PC break, hardware PC break)
 When software PC breakpoints or hardware PC breakpoints are set, they are sequentially assigned break 

numbers beginning with 1 (regardless of the types of breaks set) that are displayed in a message in the [Console] 
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view when you execute a break setup command. (See the examples above.) These numbers are required when 
you disable/enable or delete breakpoints individually at a later time. Even when you deleted breakpoints, the 
breakpoint numbers are not moved up (to reuse deleted numbers) until after you quit the debugger. 

 To manipulate the breakpoints you set, use the following commands:

 disable command: This command disables a breakpoint. (Breakpoints are effective when set and remain 
effective unless disabled.)

 Example: To disable breakpoint 1
(gdb) 
disable 1

 enable command: This command enables a breakpoint. 
 Example: To enable breakpoint 1

(gdb) 
enable 1

 delete or clear command: These commands delete a breakpoint.
 Example 1: To delete breakpoints 1 and 2

(gdb) 
delete 1 2

 Example 2: To delete a breakpoint at line 10 in main.c
(gdb) 
clear main.c:10

 ignore command: This command specifies the number of times that a break is disabled.
 Example: To specify that break 2 be disabled twice.

(gdb) 
ignore 2 2

 info breakpoints command: This command displays a list of breakpoints.
 Example: To display a list of breakpoints

(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c00026 in main at main.c:11
 breakpoint already hit 1 time
2   hw breakpoint  del  n   0x00c00038 in sub at main.c:20

 For details, see the explanation of each command described later in this manual.

 It is also possible to display a list of PC breakpoints in the [Breakpoints] view, where you can operate on 
breakpoints to disable/enable or delete. For details, see Section 10.4.5, "[Breakpoints] View".

forcible break by the [Suspend] button

 [Suspend] button 

 If the program has entered an endless loop or standby mode (HALT, SLEEP) and cannot exit that state, you can 
use the [Suspend] button in the [Debug] view to forcibly terminate the program. 

Map breaks and breaks by invalid instruction execution (simulator mode)
 The program is also made to break when accessing an invalid area.

Notes: • The following breaks are only effective in simulator mode.

 • A memory map-related break occurs according to the memory map information set by a 
parameter file loaded by the c17 rpf command. An unexpected break may occur unless the 
loaded parameter file is correct.

  Writes to the ROM area
 The program is made to break after writing to the ROM area set by a parameter file. When this break occurs, 

the following message is output:
Break by writing ROM area.
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  Access to an undefined area
 The program is made to break when accessing an undefined area other than those mapped by a parameter file. 

Break by accessing no map.

  Stack overflow
 The program is made to break after writing to a stack exceeding the stack area set by a parameter file, thus 

causing it to overflow.
Break by stack overflow.

  Execution of an invalid instruction
 The program is made to break when executing an invalid instruction (not generated by the assembler).

Illegal instruction.

  Execution of an invalid address instruction
 The program is made to break when executing an instruction at an invalid address. 

Illegal address exception.

  Execution of an invalid delayed instruction
 The program is made to break when executing an invalid delayed instruction. 

Illegal delayed instruction.
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10.6.6  Trace functions

The debugger in simulator mode has a function to trace program execution. 

note: The trace function cannot be used in ICD Mini mode.

In simulator mode, you can use the c17 tm command to turn the trace function on or off, as well as specify the 
method of displaying data in a window or writing data to a file. When the trace function is turned on, trace results 
are displayed in a window or saved to a file for each instruction executed. 
Example 1: To set the trace mode for displaying all information and to specify the trace.log file in which to 

save the information
(gdb) 
c17 tm on 0xff trace.log

Example 2: To turn trace mode off
(gdb) 
c17 tm off

 The trace information displayed is listed below.

<Format of each trace information line>
 num  clk  pc  code  bus_addr/type/data  r0  r1  r2  r3  r4  r5  r6  r7  sp  ie/il/cvzn  src_mix

num: Number of executed instructions (in decimal)
 Number of instructions executed since the CPU was reset
clk: Number of execution clocks (in decimal)
 Number of execution clocks since the CPU was reset
pc: Address of executed instructions (in hexadecimal)
code: Instruction codes (in hexadecimal)
bus_addr: Accessed memory addresses (in hexadecimal)
type: Type of bus operation
 r8: Byte data read; r16: 16-bit data read; r32: 32-bit data read
 w8: Byte data write; w16: 16-bit data write; w32: 32-bit data write
data: Read/written data (in hexadecimal)
r0–r7: r0–r7 register values (in hexadecimal)
sp: sp register value (in hexadecimal)
ie: IE bit value in psr
il: IL bit value in psr
cvzn: C, V, Z and N bit values in psr
src_mix: Disassembled contents and source codes of executed instructions

 The trace information is displayed in the [Trace] view when you choose to display in a view by using the c17 
tm command.

note: The number of clock cycles executed (clk) displayed in a view is calculated using the wait cycle 
information set in a parameter file. The displayed information may not be correct if the parameter 
file was erroneously set.
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10.6.7  Simulated I/O

The simulated I/O function of gdb allows you to evaluate the external input/output of the serial interface, etc. by 
means of standard input/output (stdin, stdout) or file input/output.

Input by stdin (c17 stdin command)
 Set the following conditions in the c17 stdin command:
 •  Break address
 •  Input buffer address (with buffer size fixed to 65 bytes)
 •  Input file (when omitted, input from [Console] view)

 After setting these conditions, run the program continuously.

When an input file is specified
 When the set break address is reached, gdb reads data from the specified file and places it in the buffer. 

Then it resumes executing the program from the address where it left off. 
 Example 1: To set a data input function

(gdb) 
c17 stdin 1 READ_FLASH READ_BUF input.txt

 Example 2: To turn the data input function off 
(gdb) 
c17 stdin 2

When no input files are specified
 When the set break address is reached, gdb opens the [Console] view and waits for data to be entered from 

the keyboard. When you enter data and press the [Enter] key, gdb writes the data entered to the buffer and 
resumes executing the program from the address where it left off. 

 Example: To set a data input function using the [Console] view 
(gdb) 
c17 stdin 1 READ_FLASH READ_BUF

Output by stdout (c17 stdout command)
 Set the following conditions in the c17 stdout command:
 •  Break address
 •  Output buffer address (with buffer size fixed to 65 bytes)
 •  Output file (when omitted, output to [Console] view)

 After setting these conditions, run the program continuously.

When an output file is specified
 When the set break address is reached, gdb outputs the contents of the buffer to the specified file. Then it 

resumes executing the program from the address where it left off. 
 Example 1: To set a data output function

(gdb) 
c17 stdout 1 WRITE_FLASH WRITE_BUF output.txt

 Example 2: To turn the data output function off 
(gdb) 
c17 stdout 2

When no output files are specified
 When the set break address is reached, gdb opens the [Console] view and displays the buffer contents in 

that window. Then it resumes executing the program from the address where it left off. 
 Example: To set a data output function using the [Console] view 

(gdb) 
c17 stdout 1 WRITE_FLASH WRITE_BUF
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Requirements for the program 
 Before the simulated I/O function can be used, the following must be defined in the program:

  Definition of input/output buffers
 Before using the program, define global buffers that gdb will use for data input/output in the format shown 

below.
 Definition of an input buffer: unsigned char READ_BUF[65]

 Definition of an output buffer: unsigned char WRITE_BUF[65]

 For the buffer name, use any name conforming to symbol name conventions. Fix the buffer size to 65 bytes. 
Use this symbol name to specify the buffer address when executing the c17 stdin and c17 stdout 
commands.

 When data is entered, the size of the actually entered data (1 to 64 bytes) is placed in READ_BUF[0]. If EOF 
is entered, value 0 is placed in READ_BUF[0]. The input data is stored in READ_BUF[1] and those that 
follow. To output data, write the size of data to be output (1–64) to WRITE_BUF[0], then output the data to 
WRITE_BUF[1] and those that follow. To output EOF, write value 0 to WRITE_BUF[0]. A data row of up to 

64 bytes in size can be input/output between gdb and the program.

  Definition of data-updating global labels
 Before using the program, define global labels like those shown below at the position where gdb inputs data to 

the input buffer and at the position where gdb outputs data from the output buffer.
 Input position: .global  READ_FLASH

  READ_FLASH:

 Output position: .global  WRITE_FLASH
  WRITE_FLASH:

 Any name can be used for the labels. Use this symbol name to specify the break address when executing the 
c17 stdin and c17 stdout commands.

 In the C source, define these labels in the lower-level write and read functions among the standard input/
output library functions (see Section 7.3.4). 

 For examples of actual programs, refer to the sample programs and debugger command file installed in the 
\gnu17\sample\S1C17common\simulator\simulatedIO directory.

 When the program breaks at READ_FLASH, gdb reads data from a file and loads the data into the defined input 
buffer. Then it resumes executing the program. When the program breaks at WRITE_FLASH, gdb outputs data 
from the output buffer to a file, then resumes executing the program. 

Precautions
• The break addresses specified in the c17 stdin and c17 stdout commands cannot duplicate those of 

software PC breaks.

• Because the debugger uses software PC breaks internally, addresses in the target board ROM cannot be 
specified.

• Only ASCII characters can be used for input/output. Binary data (especially 0x0 and 0x1a) may cause the 
CPU to operate erratically.

• The parts of the program where c17 stdin or c17 stdout perform input/output must be executed 
successively by the continue command (do not execute in single stepping). Also make sure that no breaks 
will occur in areas near those parts. 
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10.6.8  flash Memory Operation

The debugger gdb has a function to manipulate flash memory mounted in the target board, as well as the flash write 
function to use the ICD. 

Manipulating flash memory on the target board
 The debugger gdb has a utility and commands that allow you to write data to or erase data from flash memory 

built into the S1C17 chip or mounted on the target board. This utility and these commands can be used in the 
debugging environments of ICD Mini mode.

 Follow the procedure described below to write data to flash memory. For more details, refer to readme_j.
txt / readme_e.txt for flash support utility fls17.

1. Loading flash routines
 Use the load command to load flash routines (erase and write routines) into internal RAM, etc. 
 Example:

(gdb) 
file fls17701.elf   (Load debugging information.)
(gdb) 
target icd usb   (Connect the target.)
C17 ICD17 debugging
Connecting with target (ID_OK) ..... done 
ICD Initializing (ID_INITIALIZE) ... done 
Read ICD Version (ID_VER_READ) ..... done 
  ICD hardware version ............. 1.0 
  ICD software version ............. 1.0 
Debug base address (ID_DATA_READ) .. 0x000FC0
Boot address (ID_DATA_READ) ........ 0x008080
Hardware break MAX ................. 4
Target file is pointer24.
(gdb) 
load     (Load flash routines.)

 Use the routines loaded here to erase data from or write data to flash memory.

2. Setting flash memory (c17 fls command)
 Set the start and end addresses of flash memory, along with the entry addresses of erase and write routines 

loaded in step 1 in gdb. 
Example: When the flash memory area is 0x8000 to 0x17fff and the entry addresses of the erase and write 

routines are FLASH_ERASE and FLASH_LOAD 
(gdb) 
c17 fls 0x8000 0x17fff FLASH_ERASE FLASH_LOAD

3. Erasing flash memory (c17 fle command)
 Erase the entire area or blocks of flash memory.
 The contents of flash memory will change to 0xff after erasure.

Example: To erase all flash memory whose start address is 0x8000
(gdb) 
c17 fle 0x8000 0 0

 Always run the c17 fle command after the c17 fls command. If you do not want to erase flash 
memory, specify the block range ("0 0" in the example above) as "-1 0", precluding the need for erasing 
flash memory.
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4. Writing to flash memory
 Use the load command to write a program to flash memory. 
 Example: 

(gdb) 
load sample.elf

 Perform steps 1 and 2 before writing a program to flash memory.
 The written contents can be confirmed using the x command.

 The data to be entered in flash memory set by the c17 fls command in step 2 is passed to the flash write 
routine, by which the data is written to flash memory. This is an exception and all other operations are 
processed as writing to RAM. If flash memory has not been erased (not 0xff), an error is returned.

flash writer function of the ICD Mini (S5U1C17001H)
 The ICD Mini (S5U1C17001H) incorporates a flash writer function, and gdb has commands to control this 

function.
 For how to use the ICD Mini (S5U1C17001H) as a flash writer, refer to the "S5U1C17001H Manual (S1C17 

Family In-Circuit Debugger)".

 The flash writer control commands can only be used with the ICD Mini (S5U1C17001H) in ICD Mini mode, as 
described below.

  
Note: The ICD board does not support the flash writer function.

Erasing programs/data (c17 fwe command)
 The c17 fwe command erases the data erase/write program or write data and address information loaded in 

the S5U1C17001H. 
 Example 1: To erase write data

(gdb) 
c17 fwe 0

 Example 2: To erase the data erase/write program 
(gdb) 
c17 fwe 1

  loading a program (c17 fwlp command)
 The c17 fwlp command loads the data erase/write program from the host in the ICD Mini (S5U1C17001H) 

and sets entry information about the erase/write routines. 
Example: When the data erase/write program file is writer.sa and the start addresses of erase and write 

routines are 0x90 and 0xb4, respectively
(gdb) 
c17 fwlp writer.sa 0x90 0xb4

  loading data (c17 fwld, c17 fwdc commands)
 The c17 fwld command loads the data to be written to flash memory from the host in the ICD Mini 

(S5U1C17001H). The c17 fwdc command loads the data saved in target board memory into the ICD Mini 
(S5U1C17001H). Also set the range of flash memory to be erased.
Example 1:  To load sample.sa after erasing all blocks of flash memory whose start address is 0x8000
(gdb) 
c17 fwld sample.sa 0 0 0x8000

Example 2:  To load 1-MB data from the address FLASH_START on target memory after erasing all blocks of 
flash memory whose start address is 0x8000

(gdb) 
c17 fwdc FLASH_START 0x100000 0 0 0x8000
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  Displaying flash writer information (c17 fwd command)
 The c17 fwd command displays information about the data loaded in the ICD Mini (S5U1C17001H) and 

information about the erase/write program.  
(gdb) 
c17 fwd
CPU data address            : xxxxxxxx
Data size                   : xxxxxxxx
Erase start block           : xxxxxxxx
Erase end block             : xxxxxxxx
Erase parameter             : xxxxxxxx
Comment : xxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

CPU program address         : xxxxxxxx
Program size                : xxxxxxxx
Erase routine entry address : xxxxxxxx
Write routine entry address : xxxxxxxx
Comment : xxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
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10.6.9  Support for Big Endian

The tools (C compiler to the linker) and libraries only support little endian. Note that the C compiler cannot create 
elf files that can be loaded in big endian areas. Regarding data references, however, the debugger supports big 
endian.

Method of specifying big endian (in simulator mode)
 To set information about big endian areas in the debugger while in simulator mode, specify it in the map 

information of a parameter file. For areas you wish to set to big endian, write B in the 5th parameter. Without 
this statement, areas are assumed to be little endian. However, the S1C17 chip for which you are developing 
software must be a type that supports big endian. Also note that internal ROM, RAM, and I/O cannot be set to 
big endian. 

 For details about parameter files, see Section 10.9, "Parameter Files".

Operation of debugger commands

  Memory manipulating commands (x, set, c17 fg/fh/fw, c17 mvb/mvh/mvw)
 These commands perform operations and display information suitable for endian format because memory is 

accessed for read and write in units of bytes, 16 bits, or 32 bits according to the type of data in each command. 

  load command
 Swaps data suitable for endian format and writes data in units of 16 bits. For this reason, programs created by 

the C compiler cannot be loaded correctly in big endian areas.
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10.7  Command Reference

10.7.1  list of Commands
Table 10.7.1.1  List of commands

Classification Command Operation
Supported modes

Page
ICD Mini SIM

Memory manipulation c17 fb Fill area (in bytes) 10-108
c17 fh Fill area (in 16 bits) 10-108
c17 fw Fill area (in 32 bits) 10-108
x /b Memory dump (in bytes) 10-110
x /h Memory dump (in 16 bits) 10-110
x /w Memory dump (in 32 bits) 10-110
set {char} Data input (in bytes) 10-112
set {short} Data input (in 16 bits) 10-112
set {long} Data input (in 32 bits) 10-112
c17 mvb Copy area (in bytes) 10-113
c17 mvh Copy area (in 16 bits) 10-113
c17 mvw Copy area (in 32 bits) 10-113
c17 df Save memory contents 10-115
c17 readmd Memory read mode – 10-117

Register manipulation info reg  Display register 10-118
set $  Modify register 10-119

Program execution continue  Execute continuously 10-120
until  Execute continuously with temporary break 10-121
step Single-step (every line) 10-123
stepi Single-step (every mnemonic) 10-123
next Single-step with skip (every line) 10-125
nexti Single-step with skip (every mnemonic) 10-125
finish  Quit function 10-127
c17 callmd Set user function call mode 10-128
c17 call Call user function 10-129

CPU reset c17 rst Reset (execute reset.gdb) 10-131
c17 rstt Reset target – 10-132

Interrupt c17 int Interrupt – 10-133
c17 intclear Clear interrupt – 10-134
c17 int_load Load interrupt event file – 10-135

Break break Set software PC break 10-136
tbreak Set temporary software PC break 10-136
hbreak Set hardware PC break 10-139
thbreak Set temporary hardware PC break 10-139
delete  Clear break by break number 10-142
clear  Clear break by break position 10-143
enable Enable breakpoint 10-144
disable Disable breakpoint 10-144
ignore Disable breakpoint with ignore counts 10-146
info breakpoints Display breakpoint list 10-147
c17 timebrk Set lapse of time break – 10-148
commands Set command to execute at break 10-149

Symbol information info locals Display local symbol 10-150
info var Display global symbol 10-150
print  Alter symbol value 10-151

File loading file  Load debugging information 10-152
load Load program 10-153
c17 loadmd  Set program load mode – 10-154

Map information c17 rpf  Set map information 10-155
c17 map  Display map information – 10-156

Flash memory 
manipulation

c17 fls  Set flash memory – 10-157
c17 fle  Erase flash memory – 10-158
c17 flv Set flash memory write/delete voltage l *1 – 10-159
c17 flvs Cancel flash memory write/delete voltage setting l *1 – 10-160

Trace c17 tm Set trace mode – 10-161
Simulated I/O c17 stdin  Data input simulation 10-164

c17 stdout Data output simulation 10-165
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Classification Command Operation
Supported modes

Page
ICD Mini SIM

Flash writer c17 fwe  Erase program/data l *2 – 10-166
c17 fwlp  Load program l *2 – 10-167
c17 fwld  Load data l *2 – 10-168
c17 fwdc  Copy target memory l *2 – 10-169
c17 fwd  Display flash writer information l *2 – 10-170

Profiler/coverage c17 profilemd Profile/coverage mode setting – 10-171
c17 profile Display of profile window – 10-172
c17 coverage Display of coverage window – 10-173

Other set output-radix Change variable display format 10-174
c17 log  Logging 10-175
source  Execute command file 10-176
c17 clockmd Set execution counter mode 10-177
c17 clock Display execution counter 10-177
target  Connect target 10-179
detach Disconnect target 10-180
pwd Display current directory 10-181
cd Change current directory 10-181
c17 firmupdate Update ICD firmware – 10-182
c17 ttbr Set TTBR – 10-183
c17 help  Help 10-184
c17 chgclkmd Select clock source for break mode – 10-186
quit Quit debugger 10-187

Supported modes:  = Can be used, – = Cannot be used, l = Conditional
*1: ICDmini Ver.2.0 (S5U1C17001H2100) command. Cannot be used with ICDmini (S5U1C17001H) or ICD boards. (An error will be 

displayed.)
*2: These commands can be used with the ICD Mini (S5U1C17001H). They cannot be executed normally with the ICD board (an 

error message will not be displayed).

10.7.2  Detailed Description of Commands

This chapter describes in detail each debugger command using the format shown below. 

Command name (operation of command) [Supported modes]
A detailed description of each command begins with the command name in this format. 
[Supported modes] shows such modes as ICD Mini and SIM in which the command can be used. You cannot use 
the command in modes other than those written here. 
Basically, each command is described separately. However, two or more commands (belonging to the same 
operation group) that differ only slightly or which can be better understood when explained together are described 
collectively. 

Operation

Explains the operation of the command.

Format

Shows the format in which the command is entered in the [Console] view and the contents of parameters. 
Parameters enclosed in brackets [ ] can be omitted. Otherwise, no parameters can be omitted. The italicized 
characters denote parameters specified with numeric values or symbols. 

Usage example

Shows an example of how to enter the command and the results of command execution, etc.

Notes

Describes limitations on use of the command or precautions to be taken when using the command. 

Some commands have additional items other than those described above when needed for explanatory purposes.



10-108 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

10.7.3  Memory Manipulation Commands

c17  fb (fill area, in bytes)

c17  fh (fill area, in 16 bits)

c17  fw (fill area, in 32 bits) [ICD Mini / SIM]

Operation

c17 fb Rewrites specified memory area with specified byte data. 
c17 fh Rewrites specified memory area with specified 16-bit data.  
c17 fw  Rewrites specified memory area with specified 32-bit data. 

Format

c17 fb StartAddr EndAddr Data
c17 fh StartAddr EndAddr Data
c17 fw StartAddr EndAddr Data

StartAddr: Start address of area to be filled (decimal, hexadecimal, or symbol)
EndAddr: End address of the area to be filled (decimal, hexadecimal, or symbol)
Data: The data to write (decimal or hexadecimal)
Conditions: 0 ≤ StartAddr ≤ EndAddr ≤ 0xffffff, 0 ≤ Data ≤ 0xff (c17 fb), 0 ≤ Data ≤ 0xffff (c17 fh), 
 0 ≤ Data ≤ 0xffffffff (c17 fw)

Usage example

n Example 1
(gdb) 
c17 fb 0x0 0xf 0x1
Start address = 0x0, End address = 0xf, Fill data = 0x1 .....done 
(gdb) 
x /16b 0x0  (memory dump command)
0x0: 0x01 0x01 0x01 0x01 0x01 0x01 0x01 0x01
0x8: 0x01 0x01 0x01 0x01 0x01 0x01 0x01 0x01

The entire memory area from address 0x0 to address 0xf is rewritten with byte data 0x01. 

n Example 2
(gdb) 
c17 fh 0x0 0xf 0x1
Start address = 0x0, End address = 0xe, Fill data = 0x1 .....done 
(gdb) 
x /8h 0x0  (memory dump command)
0x0: 0x0001 0x0001 0x0001 0x0001 0x0001 0x0001 0x0001 0x0001

The entire memory area from address 0x0 to address 0xf is rewritten with 16-bit data 0x0001. (This applies to 
when using little endian.)

n Example 3
(gdb) 
c17 fw 0x0 0xf 0x1
Start address = 0x0, End address = 0xc, Fill data = 0x1 .....done 
(gdb) 
x /4w 0x0  (memory dump command)
0x0: 0x00000001 0x00000001 0x00000001 0x00000001

The entire memory area from address 0x0 to address 0xf is rewritten with 32-bit data 0x00000001. (This 
applies to when using little endian.)
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Notes

• Writing in units of 16 bits or 32 bits is performed in little endian format. However, when debugging a 
program in simulator mode, you can set a specified area to big endian format in a parameter file.

• Even if the entire or a portion of the memory section specified for write is an unused area, no errors are 
assumed. Data is rewritten, except in unused areas.

• The data write memory section is aligned to boundary addresses according to the size of data. 
 (gdb) 
 c17 fw 0x3 0x9 0x0

 For example, when a write memory section is specified as shown above, and because start address 0x3 and 
end address 0x9 are not located on 32-bit data boundaries, both are aligned to boundary addresses by setting 
the 2 low-order bits to 00 (LSB = 0 for 16 bits). The following shows the actually executed command, where 
32-bit data addresses 0x0 to 0x8 (byte data addresses 0x0 to 0xb) are rewritten with data 0x00000000.

 (gdb) 
 c17 fw 0x0 0x8 0x0

• If the specified address exceeds the 24-bit range, an error is assumed.

• Data parameters are only effective for the 8 low-order bits for c17 fb, 16 low-order bits for c17 fh, and 
32 low-order bits for c17 fw, with excessive bits being ignored. For example, when data 0x100 is specified 
in c17 fb, it is processed as 0x00.

• If the end address is smaller than the start address, an error is assumed.

• Even when memory contents are modified by this command, the contents displayed in the [Memory] view 
and [Source] editor are not updated. Therefore, perform the appropriate operation to update display in each 
view. Similarly, even when the program area is rewritten, the source displayed in a view remains unchanged.

10
Debugger
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x  (memory dump) [ICD Mini / SIM]

Operation

Dumps memory contents (in hexadecimal) to a view. The data size, display start address, and display data 
counts can be specified.

Format

x [/[Length]Size] [Address]

Length: Number of data items to display (in decimal)
 1 when omitted.
Size: One of the following symbols that specify data size (in which units of data are displayed)
 b In units of bytes
 h In units of 16 bits
 w In units of 32 bits (default) 
Address: Address from which to start displaying data (decimal, hexadecimal, or symbol)
 When omitted, the last address displayed when previously executing the x command is assumed. 

The default address assumed at gdb startup is 0x0.
Conditions: 0 ≤ Length ≤ 0xffffffff, 0 ≤ Address ≤ 0xffffff

Display

Memory contents are displayed as described below.
Address[<Symbol>]:     Data     [Data ...]

Address: The start address of each line of data is displayed in hexadecimal.
Symbol: When the address displayed at the beginning of a line has a symbol or label defined for it, the name of 

that symbol or label is displayed. When an intermediate address of a function or variable is specified, 
the specified symbol and a decimal offset (<Symbol + n>) are also displayed. 

Data: Up to 16 bytes of data starting from Address are displayed on one line. 

Usage example

n Example 1
(gdb) 
x
0x0:  0x00000000

When all parameters are omitted after startup, the command is executed as "x /1w 0x0".

n Example 2
(gdb) 
x /b 0
0x0 <i>:   0xe3
(gdb) 
x /b 1
0x1 <i+1>: 0xa1

When Size is specified but Length omitted, one unit of data equal to the specified data size is displayed. The 
letter i is a symbol defined at address 0x0. If any address other than the address at the beginning of a variable, 
etc. is specified, <symbol+offset> is displayed as the symbol. 

n Example 3
(gdb) 
x /16h _START_text
0xc000
00 <_START_text>: 0x0004 0x00c0 0xc020 0x6c0f 0xa0f1 0xc000 0xc000 0x6c0f
0xc00010 <boot+12>:     0xc000 0xc000 0x1c04 0xdff8 0xdfff 0x1ef5 0x0200 0x6c04

When Length is specified, the specified amount of data is displayed. When a code area is displayed, 
<label+offset> is displayed as the symbol, even for addresses with no symbols defined as in ASSEMBLY 
display of the [Disassembly] view.
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n Example 4
(gdb) 
x /4w 0
0x0 <i>: 0x00001ae3 0x00000000 0x00000000 0x00000000
(gdb) 
x
0x10:    0x00000000
(gdb) 
x
0x14:    0x00000000

When the x command is executed once, you can dump and display a single unit of data (having the same size 
as that of the previous address) from the address following the previous address by simply entering x.         

n Example 5
(gdb) 
x /w &i
0x0 <i>: 0x00000010
(gdb) 
x /w i
0x10:    0x00000000

When specifying an address with a data symbol that references the assigned address, add & when you enter the 
command. When only specifying a symbol, note that its data value is used as the address. In such case, & need 
not be added because labels in program code indicate assigned addresses.

Notes

• Memory contents are displayed in little endian format. However, when debugging a program in simulator 
mode, you can set a specified area to big endian format in a parameter file.

• Even when an unused area of memory is specified, no errors are assumed. However, the displayed data is not 
valid.

• Even if the specified address is not a boundary address conforming to the data size, the x command starts 
displaying memory contents from that address.

• If the specified address exceeds the 24-bit range, an error is assumed.

• Executing this command does not affect the [Memory] view.
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set  { }  (data input) [ICD Mini / SIM]

Operation

Writes specified data to a specified address.

Format

set {Size}Address=Data

Size: One of the following symbols that specify data size
 char In units of bytes
 short In units of 16 bits (default)
 int In units of 16 bits
 long In units of 32 bits
Address: Address to which to write data (decimal, hexadecimal, or symbol)
Data: The data to write (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ Address ≤ 0xffffff, 0 ≤ Data ≤ 0xff (set {char}), 0 ≤ Data ≤ 0xffff (set {short/int}), 
 0 ≤ Data ≤ 0xffffffff (set {long})

Usage example

n Example 1
(gdb) 
set {char}0x1000=0x55
(gdb) 
x /b 0x1000
0x1000:  0x55

Byte data 0x55 is written to address 0x1000.

n Example 2
(gdb) 
set {short}0x1000=0x5555
(gdb) 
x /h 0x1000
0x1000:  0x5555

16-bit data 0x5555 is written to address 0x1000.

n Example 3
(gdb) 
set {long}&i=0x55555555
(gdb) 
x /w &i
0x0 <i>: 0x55555555

32-bit data 0x55555555 is written to long variable i.

Notes

• Writing in units of 16 bits or 32 bits is performed in little endian format. However, when debugging a 
program in simulator mode, you can set a specified area to big endian format in a parameter file.

• Even when an unused area of memory is specified, no errors are assumed. 

• If the specified address exceeds the 24-bit range, an error is assumed.

• Data parameters are only effective for the 8 low-order bits for set {char}, 16 low-order bits for set 
{short} and set {int}, and 32 low-order bits for set {long}, with excessive bits being ignored. 

For example, when data 0x100 is specified in set {char}, it is processed as 0x00.

• Even when memory contents are modified by this command, the contents displayed in the [Memory] view 
and [Source] editor are not updated. Therefore, perform the appropriate operation to update display in each 
view. Similarly, even when the program area is rewritten, the source displayed in a view remains unchanged.
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c17  mvb (copy area, in bytes)

c17  mvh (copy area, in 16 bits)

c17  mvw (copy area, in 32 bits) [ICD Mini / SIM]

Operation

c17 mvb Copies the content of a specified memory area to another area in units of bytes.
c17 mvh  Copies the content of a specified memory area to another area in units of 16 bits.
c17 mvw  Copies the content of a specified memory area to another area in units of 31 bits.

Format 

c17 mvb SourceStart SourceEnd Destination
c17 mvh SourceStart SourceEnd Destination
c17 mvw SourceStart SourceEnd Destination

SourceStart: Start address of area from which to copy (decimal, hexadecimal, or symbol)
SourceEnd: End address of area from which to copy (decimal, hexadecimal, or symbol)
Destination: Start address of area to which to copy (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ SourceStart ≤ SourceEnd ≤ 0xffffff, 0 ≤ Destination ≤ 0xffffff

Usage example

n Example 1
(gdb) 
x /16b 0
0x0:  0x00  0x01  0x02  0x03  0x04  0x05  0x06  0x07
0x8:  0x08  0x09  0x0a  0x0b  0x0c  0x0d  0x0e  0x0f
(gdb) 
c17 mvb 0x0 0x7 0x8
Start address = 0x0, End address = 0x7, Destination address = 0x8 .....done 
(gdb) 
x /16b 0
0x0:  0x00  0x01  0x02  0x03  0x04  0x05  0x06  0x07
0x8:  0x00  0x01  0x02  0x03  0x04  0x05  0x06  0x07

The content of a memory area specified by addresses 0x0 to 0x7 is copied to an area beginning with address 
0x8.

n Example 2
(gdb) 
x /4w 0
0x0 <i>: 0x00000000 0x11111111 0x22222222 0x33333333
(gdb) 
c17 mvw i i i+4
Start address = 0x0, End address = 0x0, Destination address = 0x4 .....done 
(gdb) 
x /4w 0
0x0 <i>: 0x00000000 0x00000000 0x22222222 0x33333333

The content of long variable i is copied to an area located four bytes after that int variable. 

Notes

• When the source and destination have different endian formats, the data formats are converted when copied 
from the source to the destination. 

• If the specified address exceeds the 24-bit range, an error is assumed.

• In c17 mvh and c17 mvw, addresses are adjusted to boundary addresses conforming to the data size. This 
is accomplished by processing the LSB address bit as 0 for c17 mvh and the 2 low-order address bits as 00 
for c17 mvw.

• If the end address at the source is smaller than its start address, an error is assumed.

• If a specified memory section at the source contains an unused area, the data in that area is handled as 0xf0 
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when copied.

• If a memory section at the destination contains an unused area, data is only copied to the effective area 
(excluding the unused area).

• When the start address at the destination is smaller than that of the source, data is copied sequentially 
beginning with the start address. Conversely, when the start address at the destination is larger than that of 
the source, data is copied sequentially beginning with the end address. Therefore, data is always copied even 
when the specified destination address exists within the source area.

• If the end address at the destination exceeds 0xffffff, data is only copied only up to 0xffffff.

• Even when memory contents are modified by this command, the contents displayed in the [Memory] view  
and [Source] editor are not updated. Therefore, perform the appropriate operation to update display in each 
view. Similarly, even when the program area is rewritten, the source displayed in a view remains unchanged.
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c17  df  (save memory contents) [ICD Mini / SIM]

Operation

Outputs the specified range of memory contents to a file in binary, text, or Motorola S3 format.

Format

c17 df StartAddr EndAddr Type Filename [Append]

StartAddr: Start address of area to save (decimal, hexadecimal, or symbol)
EndAddr: End address of area to save (decimal, hexadecimal, or symbol)
Type: One of the following values that specify the type of file
 1 Binary file
 2 Text file
 3 Motorola S3 file
Filename: File name
Append: a Append mode enabled
  If Type = 1, dump data is appended to the end of a binary file when it is output.
  If Type = 2, dump data is appended to the end of a text file when it is output.
  If Type = 3, no footer records are appended to the end of a Motorola file.
 f Append mode enabled
  If Type = 1, dump data is appended to the end of a binary file when it is output.
  If Type = 2, dump data is appended to the end of a text file when it is output.
  If Type = 3, a footer record is appended to the end of a Motorola file.
 If this specification is omitted, a new file is created.
Conditions: 0 ≤ StartAddr ≤ EndAddr ≤ 0xffffff

Usage example

n Example 1
(gdb) 
c17 df 0x0 0xf 2 dump.txt
Start address = 0x0, End address = 0xf, File type = Text
Processing 00000000-0000000F address.

Contents at addresses 0x0–0xf are written to file "dump.txt" in text format.
(Contents of dump.txt)
  addr   +0 +1 +2 +3 +4 +5 +6 +7 +8 +9 +A +B +C +D +E +F
00000000 00 01 02 03 04 05 06 07 00 01 02 03 04 0D 0E 0F 

n Example 2
(gdb) 
c17 df 0x80000 0x80103 3 dump.mot
Start address = 0x80000, End address = 0x8011f, File type = Motorola-S3
Processing 00080000-0008011F address.

Contents at addresses 0x80000–0x80103 are written to file "dump.mot" in Motorola S3 format. In Motorola 
S3 format, data is output 32 bytes per line. If the last line is less than 32 bytes, the end address is corrected so 
that the last line will be filled. In this example, specified end address 0x80103 is corrected to 0x8011f when 
writing data to a file. 
(Contents of dump.mot)
S3250008000094D4BA020FCA086120800961881C6F0AA4D4BA020FCA086120800961881C6F0AA8
S3250008002008D3730A00000000000000000000000008D3730A09CA026139A505610CD309613F
       :
S32500080100A4D5BA0278D5BA02A6D440004C000000C4D6BA0238E1260A8886730A2CD3280A32
S70500000000FA

n Example 3
(gdb) 
c17 df 0x10 0x1f 2 dump.txt a

The contents of addresses 0x10–0x1f are appended in text form to the end of the file "dump.txt" when it is 
output.
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n Example 4
(gdb) 
c17 df 0x1000 0x1fff 3 dump.mot a ; Footer is not output. (First)
(gdb) 
c17 df 0x3000 0x3fff 3 dump.mot a ; Footer is not output.
(gdb) 
c17 df 0x5000 0x5fff 3 dump.mot a ; Footer is not output.
(gdb) 
c17 df 0x7000 0x7fff 3 dump.mot f ; Footer is output. (Last)

The contents of addresses 0x1000–0x7fff (every 0x1000 addresses) are written out in Motorola S3 format to the 
file "dump.mot".
If no Append parameters exist or the parameter 'f' is specified, a footer record is output to a Motorola S3 format 
file.

Notes

• If the specified address exceeds the 24-bit range, an error is assumed.

• If the end address is smaller than the start address, an error is assumed.
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c17  readmd  (memory read mode) [ICD Mini]

Operation

Selects the method for reading data from the target memory from the following two modes:

1. Normal mode
 Memory data is always read in bytes.

2. Boundary exact mode
 Data is read using the appropriate instruction in the mini-monitor's external routine from the correct 

boundary address aligned with access size. The ld.b instruction is used to access memory in 8-bit units. 
The ld instruction is used to access memory in 16 bit or 32-bit units.

Use boundary exact mode if reading data in units of bytes every time becomes inconvenient.

Format

c17 readmd Mode

Mode: Selects memory read mode
 0 Normal mode (default)
 1 Boundary exact mode

Usage example

(gdb) 
c17 readmd 1

Selects boundary exact mode.

Notes

• This command cannot be used in simulator mode.

• Selecting boundary exact mode will slow memory reading.

• Memory read mode settings affect the reading of data from memory by the commands listed below.
 c17 df, x
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10.7.4  Register Manipulation Commands

info  reg  (display register) [ICD Mini / SIM]

Operation

Displays the contents of the CPU registers.

Format

info reg [RegisterName]

RegisterName: Name of register to display (specified in lowercase letters) 
 r0–r7, sp, pc, psr
 If the above is omitted, the contents of all registers are displayed.

Display

Register contents are displayed as described below.
Register     Hexadecimal     Decimal

Register: This is a register name.
Hexadecimal: Shows the register value in hexadecimal.
Decimal: Shows the register value in decimal.

Usage example

n Example 1
(gdb) 
info reg r1
r1             0xaaaaaa   1184810
(gdb) 
info reg pc
pc             0x4090 16528

When a register name is specified, only the content of that register is displayed.

n Example 2
(gdb) 
info reg
r0             0xd20   3360
r1             0xaaaaaa   1184810
r2             0xaaaaaa   1184810
r3             0xaaaaaa   1184810
r4             0x690   1680
r5             0xaaaaaa   1184810
r6             0x0    0
r7             0xaaaaaa   1184810
sp             0x7f8   2040
pc             0xc00030   12582960
psr            0x7f8   2040

Notes

Be sure to specify register names in lowercase letters. Using uppercase letters for register names or specifying 
nonexistent register names results in an error.



S5U1C17001C MANUAl Seiko Epson Corporation 10-119
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

set  $  (modify register) [ICD Mini / SIM]

Operation

Changes the values of the CPU registers.

Format

set $RegisterName=Value

RegisterName: Name of register to change (specified in lowercase letters)
 r0–r7, sp, pc, psr

Value: 24-bit data to set in the register (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ Value ≤ 0xffffff

Usage example

(gdb) 
set $r1=0x10000
(gdb) 
info reg r1
r1             0x10000 65536
(gdb) 
set $pc=main

In addition to numerals, symbols can also be used to set values.

Notes

• If the specified value exceeds the 24-bit range, the 24 low-order bits only will be effective.

• The contents of the set values are not checked internally. No errors are assumed even when values other than 
16-bit or 32-bit boundary addresses are specified for PC or SP, respectively. However, when the registers are 
actually modified, values are forcibly adjusted to boundary addresses by truncating the lower bits.

• The contents displayed in the [Registers] view are not updated by executing this command.
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10.7.5  Program Execution Commands

continue  (execute continuously) [ICD Mini / SIM]

Operation

Executes the target program from the current PC address. 
The program is run continuously until it is made to break by one of the following causes:
• Already set break conditions are met.
• The [Suspend] button is clicked.

When reexecuting a target program halted because break conditions have been met, you can specify to disable 
the current breakpoint the specified number of times.

Format

continue [IgnoreCount]
cont [IgnoreCount]  (abbreviated form)

IgnoreCount: Specifies the number of breaks (decimal or hexadecimal)
 The program is run continuously until break conditions are met the specified number of times.

Usage example

n Example 1
(gdb) 
continue
Continuing.

Breakpoint 1, main () at main.c:13

When continue is executed with IgnoreCount omitted, the target program starts running from the current PC 
address and stops the first time break conditions are met.  

n Example 2
(gdb) 
cont 5

Breakpoint 1, main () at main.c:13

Because value 5 is specified for IgnoreCount, break conditions that have been met four times (= 5 - 1) since the 
program started running are ignored, and the program breaks when break conditions are met the fifth time. In 
this example, the target program is restarted after being halted at the PC breakpoint (break 1) set at line 13 in 
main.c, and the program stops upon the fifth hit at that PC breakpoint. 

The same effect is obtained by executing the following command:
(gdb) 
ignore 1 4
(gdb) 
continue

Notes

• To run the program from the beginning, execute c17 rst (reset) before the continue command.

• The continue command with IgnoreCount specified can be executed on condition that the target program 
has been executed at least once and is currently halted because break conditions are met. In this case, a break 
caused by the [Suspend] button is not assumed since break conditions are met. If IgnoreCount is specified 
while the target program has never been made to break once, the specification is ignored.

• If the target program has been halted by one cause of a break, and the continue command is executed with 
IgnoreCount specified after clearing that break setting, an error is assumed. The same applies when other 
break conditions have been set.

• If break conditions other than the one that stopped the target program must be ignored a specified number 
of times, specify break conditions and the number of times that a break hit is to be ignored in the ignore 
command. Then execute the continue command without any parameters.
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until  (execute continuously with temporary break)  [ICD Mini / SIM]

Operation

Executes the target program from the current PC address.
A temporary break can be specified at one location, causing the program to stop before executing that 
breakpoint. A hardware PC break is used for this temporary break, which is cleared when the program breaks 
once. When a temporary break is specified, assembly sources other than the C source are executed continuously.

If the program does not pass the breakpoint set (a miss), the program runs continuously until made to break by 
one of the following causes:
•  Other set break conditions are met.
•  The [Suspend] button is clicked.
•  Control is returned to a higher level from the current level (within the function).
•  There is no assembly source or source information (in which case, only the current instruction is executed).

Format

until Breakpoint

Breakpoint: Temporary breakpoint
 Can be specified by one of the following:
 •  Function name
 •  Source file name:line number, or line number only
 •  *Address (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ address ≤ 0xffffff

Usage example

n Example 1
(gdb) 
until main
main () at main.c:10

The target program is run with a temporary break specified by a function name. The program breaks before 
executing the first C instruction in main() (that is expanded to mnemonic). The PC on which the program has 
stopped displays the start address of that instruction (i.e., address of first mnemonic expanded). 

n Example 2
(gdb) 
until main.c:10
main () at main.c:10

The target program is run with a temporary break specified by line number. Although the breakpoint here is 
specified in "source file name:line number" format when the breakpoint is to be set in the C source containing 
the current PC address, it can be specified by simply using a line number like "until 10". For assembly 
sources, a source file name is always required. When this command is executed, the program breaks before 
executing the C instruction on line 10 in main.c. The PC on which the program has stopped displays the 
start address of that instruction (i.e., address of first mnemonic expanded). If no instructions exist on line 10 
with actual code (i.e., not expanded to mnemonic), the program breaks at the beginning of the first instruction 
encountered with actual code thereafter.

n Example 3
(gdb) 
until *0xc0001e
main () at main.c:10

The target program is run with a temporary break specified by address. The program breaks before executing 
the instruction stored at that address location. A symbol can also be used, as shown below.
(gdb) 
until *main
main () at main.c:7

Note that adding an asterisk (*) causes even the function name to be regarded as an address. 
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Notes

• To run the program from the beginning, execute c17 rst (reset) before the until command.

• If the location set as a temporary breakpoint is a C source line that does not expand to mnemonic, the 
program does not break at that line. The program breaks at the address of the first mnemonic executed 
thereafter.

• No temporary breakpoints can be set on the following lines, because an error is assumed.
 -  Extended instruction lines (except for the ext instruction at the beginning)
 -  Delayed instruction lines (next line after a delayed branch instruction)

• If temporary breakpoints are specified using a nonexistent function name or line number, an error is assumed.

• If temporary breakpoints are specified by an address value that exceeds the 24-bit range, an error is assumed.

• When specifying temporary breakpoints by address value and the address is specified with an odd value, the 
specified address is adjusted to the 16-bit boundary by assuming LSB = 0. 
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step (single-step, every line)

stepi (single-step, every mnemonic) [ICD Mini / SIM]

Operation

Single-steps the target program from the current PC address. Lines and instructions in the called functions or 
subroutines also are single-stepped.
step: Single-steps the program by executing one source line at a time. In C sources, one line of C instruction 

(all multiple expanded mnemonics) are executed as one step. In assembly sources, instructions are executed the 
same way as for stepi.
stepi: Single-steps the program by executing one assembler instruction (in mnemonic units) at a time. 

In addition to one line or instruction, a number of steps to execute can also be specified. However, even before 
all specified steps are completed, the program may be halted by one of the following causes:
•  Already set break conditions are met.
•  The [Suspend] button is clicked.

Format

step [Count]
stepi [Count]

Count: Number of steps to execute (decimal or hexadecimal)
 One step is assumed if omitted.
Conditions: 1 ≤ Count ≤ 0x7fffffff

Usage example

n Example 1
(gdb) 
step

The source line displayed on the current PC is executed.

n Example 2
(gdb) 
stepi

The instruction (in mnemonic units) is executed at the address displayed on the current PC.

n Example 3
(gdb) 
step 10
sub (k=5) at main.c:20

Ten lines are executed from the source line displayed on the current PC.

n Example 4
(gdb) 
stepi 10
main () at main.c:13

Ten instructions (in mnemonic units) are executed from the address displayed on the current PC.

Notes

• The program cannot be single-stepped from an address that does not have source information (i.e., debugging 
information included in the object). The program can be run continuously, however, by using the continue 
command.

• To run the program from the beginning, execute c17 rst (reset) before step or stepi.

• Even with stepi , ext-based extended instructions are executed collectively (i.e., entire extended 
instruction set consisting of two or three instructions) as one step.

• Interrupts are accepted even while single-stepping the program.
 Similarly, the halt and slp instructions are executed while single-stepping the program, causing the CPU 
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to enter standby status. The CPU exits standby status when an external interrupt is generated. Clicking the 
[Suspend] button also releases the CPU from standby mode. 
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next (single-step with skip, every line)

nexti (single-step with skip, every mnemonic) [ICD Mini / SIM]

Operation

Single-steps the target program from the current PC address. The basic operations here are the same as with 
step and stepi, except that when a function or subroutine call is encountered, all lines or instructions in the 

called function or subroutine are executed successively as one step until returning to a higher level.
next: Single-steps the program by executing one source line at a time. In C sources, one line of C instruction 

(all multiple expanded mnemonics) are executed as one step. In assembly sources, instructions are executed the 
same way as for nexti.
nexti: Single-steps the program by executing one assembler instruction (in mnemonic units) at a time. 

In addition to one line or instruction, a number of steps to execute can also be specified. However, even before 
all specified steps are completed, the program may be halted by one of the following causes:
•  Already set break conditions are met.
•  The [Suspend] button is clicked.

Format

next [Count]
nexti [Count]

Count: Number of steps to execute (decimal or hexadecimal)
 One step is assumed if omitted.
Conditions: 1 ≤ Count ≤ 0x7fffffff

Usage example

n Example 1
(gdb) 
next

The source line displayed on the current PC is executed. When the source is a function or subroutine call, the 
function or subroutine called is also executed until returning to a higher level.

n Example 2
(gdb) 
nexti

The instruction (in mnemonic units) is executed at the address displayed on the current PC. When the 
instruction is a subroutine call, the subroutine called is also executed until returning to a higher level. 

n Example 3
(gdb) 
next 10
sub (k=5) at main.c:20

Ten lines are executed from the source line displayed on the current PC.

n Example 4
(gdb) 
nexti 10
main () at main.c:13

Ten instructions (in mnemonic units) are executed from the address displayed on the current PC.

10
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Notes

• The program cannot be single-stepped from an address that does not have source information (i.e., debugging 
information included in the object). The program can be run continuously, however, by using the continue 
command.

• To run the program from the beginning, execute c17 rst (reset) before next or nexti.

• Even with nexti , ext-based extended instructions are executed collectively (i.e., entire extended 
instruction set consisting of two or three instructions) as one step.

• Interrupts are accepted even while single-stepping the program.
 Similarly, the halt and slp instructions are executed while single-stepping the program, causing the CPU 

to enter standby mode. The CPU exits standby mode when an external interrupt is generated. Clicking the 
[Suspend] button also releases the CPU from standby mode. 
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finish  (finish function) [ICD Mini / SIM]

Operation

Executes the target program from the current PC address and causes it stop upon returning from the current 
function to a higher level. The instruction at the return position is not executed. 
Even before a return, however, the program may be halted by one of the following causes:
•  Already set break conditions are met.
•  The [Suspend] button is clicked.

Format

finish

Usage example

(gdb) 
finish

The target program is executed from the current PC address and halted after a return.

Notes

When the finish command is executed at the highest level (e.g., boot routine), the program does not stop. If 
no breaks are set, use the [Suspend] button to halt the program.
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c17  callmd  (set user function call mode) [ICD Mini / SIM]

Operation

Sets the destination at which to output execution results after executing the c17 call (user function call) 
command.

Format

c17 callmd Mode [Filename]

Mode: One of the following numeric values that specify result output destination:
 1 Display in the [Console] view (default).
 2 Write to a file.
 3 Display in the [Console] view and write to a file.
Filename: Output file name (not effective when Mode = 1)

Usage example

(gdb) 
c17 callmd 2 call.txt

The execution results of the c17 call command to be executed are written to file call.txt.

Notes

When mode 2 (= file) is selected as the output destination, a file is created in the current directory during c17 
call command execution, with the results written to the file (which is then closed) when the c17 call 

command is completed. If an existing file name is specified, the file is overwritten with the new execution 
results.
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c17  call  (call user function) [ICD Mini / SIM]

Operation

Calls a user function.
However, an assembler entry program is required.

Format

c17 call Function [Arg1 [Arg2 [Arg3]]]

Function: The function to be called (function name or decimal/ hexadecimal start address)
Arg1–3: Argument (decimal, hexadecimal, or symbol)
Conditions: Up to three arguments can be specified.

Usage example

(gdb) 
c17 callmd 1
(gdb) 
c17 call print_data 1 2 3
arg1=1, arg2=2, arg3=3 (Execution result)

The function print_data() is called after specifying three arguments.

User function and entry routine

When c17 call is invoked, gdb executes a specified user function and receives a return value from %r0. 
If the return value is -1 (0xffffff), gdb terminates the session without performing anything. When the value 
received is other than that, gdb interprets it as the start address of a packet passed from the function and 
displays internal data of the packet in the [Console] view or directly writes it to a file in its original form. The 
c17 callmd command specifies the output destination. The default output destination is the [Console] view. 

The following shows the configuration of the packet returned by a user function.

data size (4 bytes)   data ...

A packet must always start from a 4-byte boundary. A user function must set the start address of this packet in 
%r0. If packets cannot be returned, the user function should set -1 in %r0. 

The following shows an example of a user function to be called.
The user function must always end with "jpa %r1". 

Example entry program (assembler)
#define SP_INI  0x0800 ; sp is in end of 1KB internal RAM
 jpa %r1 ; back to mini monitor

; ****28 - ****3f DSIO command area, 24byte
;
;  ****28 WBUF data1  DSIO output command
;  ****2c WBUF data2
;
;  ****32 RBUF ID  DSIO input command
;  ****33 RBUF size
;  ****34 RBUF addr
;  ****38 RBUF data1
;  ****3c RBUF data2

;
; input  
;        %r0 : debug ram start address = ****28
;        %r1 : return address( mini Monitor )
; output 
;   ****28 WBUF data1 : gdb output message start address
;
;              <message format>
;               size    : message size (4 byte)
;               message : String data
;
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#define SP_INI  0x1000

    .global ext_test
ext_test:
 ld.a %r7, %sp  ; 
 Xld.a %r2, SP_INI  ; set SP
 ld.a %sp, %r2
 ld.a -[%sp], %r7  ; save SP
 ld.a -[%sp], %r1  ; save return address
 ld.a -[%sp], %r0  ; save debug ram start address
 ld.a %r6, %r0  ; %r0 : debug ram start address = ****28
 add.a %r6, 0x0c
 ld   %r0, [%r6]+      ; Set Arg1
 ld   %r1, [%r6]+
 ld   %r2, [%r6]+      ; Set Arg2
 ld   %r3, [%r6]+
 ld   %r5, [%r6]+     ; Set Arg3
 ld   %r4, [%r6]+
 sub.a %sp, 4
 ld   [%sp+0x0], %r5
 ld   [%sp+0x2], %r4
 Xcall iprint_data  ; enter C program
    ; return = %r0: message buffer address
 add.a %sp, 4
 ld.a %r6, %r0  ;
 ld.a %r0, [%sp]+  ; restore debug ram start address
 ld.a [%r0], %r6  ; set %r0 ( message address ) to WBUF data1
 ld.a %r1, [%sp]+  ; restore return address
 ld.a %r7, [%sp]+  ; restore SP
 ld.a %sp, %r7
 jpa %r1  ; back to mini monitor

User function
#include "stdio.h"

void *iprint_data( long arg1, long arg2, long arg3 );

struct {
  long size;
  char buf[0x100];
} tmpbuf;

void *iprint_data( long arg1, long arg2, long arg3 )
{
 tmpbuf.size = sprintf(tmpbuf.buf,"arg1=%d,arg2=%d,arg3=%d",arg1,arg2,arg3);
 return (void*)&tmpbuf;
}

Notes

If any function without an entry program is called, gdb may run uncontrollably.
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10.7.6  CPU Reset Commands

c17  rst  (reset) [ICD Mini / SIM]

Operation

Resets the CPU.
As a result, the CPU is reset to its initial state as shown below.

(1) Internal registers of the CPU
 r0–r7: 0x000000
 pc:  Boot address (reset vector in the trap table)
 sp: 0xfffffc
 psr: 0x00 (IL = 000, IE = 0, CVZN = 0000)

(2) The execution counter is cleared to 0.

(3) The [Source] editor and [Registers] view reappear.
 Because the PC is set to the boot address, the [Source] editor redisplays the program beginning with that 

address. The [Registers] view reappears with the same settings as (1). 

Format

c17 rst

Usage example

(gdb) 
c17 rst

The CPU is reset.

Notes

• The contents of memory and debugging status of break and trace are not reset.

• When using gdb in ICD Mini mode, the bus status and I/O status are retained. 
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c17  rstt  (reset target) [ICD Mini]

Operation

Outputs the reset signal to the reset input pin on the target board.

Format

c17 rstt

Usage example

(gdb) 
c17 rstt

The target is reset.

Notes

• The c17 rstt command can only be used in ICD Mini mode.

• To execute this command, a reset input pin is required on the target board. 
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10.7.7  Interrupt Commands

c17  int  (interrupt) [SIM]

Operation

Simulates the generation of an interrupt.
When an interrupt number is specified by this command, the specified interrupt is generated at next program 
startup.

Format

c17 int [No Level]

No: Interrupt number (decimal, hexadecimal, or symbol)
Level: Interrupt priority level (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ No ≤ 0x1f, 0 ≤ Level ≤ 7

Usage example

n Example 1
(gdb) 
c17 int

If no parameters are specified, an NMI is generated. 

n Example 2
(gdb) 
c17 int 3 6

Any maskable interrupt number and its priority level can be set.

Notes

• The c17 int command can only be used in simulator mode.

• Make sure the interrupt number is specified from 0 to 31. If this range is exceeded, an error is assumed.

• Make sure the interrupt priority level is specified from 0 to 7. If this range is exceeded, an error is assumed.

• TTBR is effective even in simulator mode.
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c17  intclear  (clear interrupt) [SIM]

Operation

Simulates canceling interrupts.
The interrupt specified by the interrupt number is cleared.

Format

c17 intclear [No]

No: Interrupt number (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ No ≤ 0x1f

Usage example

(gdb) 
c17 int 3 6
(gdb) 
continue
(gdb) 
c17 intclear 3

Cancels the interrupt of interrupt number 3.

Notes

• The c17 intclear command can only be used in simulator mode.

• Make sure the interrupt number is specified from 0 to 31. If this range is exceeded, an error is assumed.
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c17  int_load  (load interrupt event file) [SIM]

Operation

Loads an interrupt event file.
When an event condition written in the event file that has been loaded is met during program execution, the 
designated interrupt occurs.

Event file format
Address_NMI_INT_Vector_Level_RES  // Comment
Address_NMI_INT_Vector_Level_RES
Address_NMI_INT_Vector_Level_RES
Address_NMI_INT_Vector_Level_RES
   :
Address_NMI_INT_Vector_Level_RES

 Address: Address to generate an event (000000–fffffe) 
  An interrupt occurs when the PC reaches this address.
 NMI: 1 = NMI request 
  0 = No NMI request 
 INT: 1 = Interrupt request specified with the Vector and Level below
  0 = No interrupt request
 Vector: Interrupt vector number (00–1f, valid when INT = 1)
 Level: Interrupt level (0–7, valid when INT = 1)
 RES: 1 = Reset request 
  0 = No reset request 

The order of interrupt priority is RES > NMI > Vector.
A comment (alphanumeric characters) with "//" prefixed can be written on the right of each event line.

Format

c17 int_load Filename

Filename: Interrupt event file name

Usage example

(gdb) 
c17 int_load event.txt

Loads the interrupt event file event.txt.

Example of event file 
009002_0_1_10_3_0 An interrupt of which the interrupt vector number = 0x10 and interrupt level 

= 3 occurs when PC = 0x9002.
009f02_0_0_00_0_1  A reset exception occurs when PC = 0x9f02.
004030_1_1_1c_7_0 An NMI occurs when PC = 0x4030. After that an interrupt of which 

the interrupt vector number = 0x1c and interrupt level = 7 occurs when 
interrupts are enabled.

004030_0_1_1c_7_1 A reset exception occurs when PC = 0x4030. Although an interrupt vector 

number (= 0x1c) and an interrupt level (= 7) has been written, no interrupt 
will occur even when interrupts are enabled because the INT parameter is set 
to 0.

Notes

• The c17 int_load command can only be used in simulator mode.

• If the c17 rst command is executed when an interrupt event file has been loaded, the event sequence is 
reset so that the events will be generated from the first line again.

• Up to 256 events (event lines) can be written in an interrupt event file.

• Up to 300 characters can be written in an event line.

10
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10.7.8  Break Setup Commands

break (set software PC break)

tbreak (set temporary software PC break) [ICD Mini / SIM]

Operation

Sets a software PC breakpoint. This breakpoint can be set at up to 200 locations. If the PC matches the address 
set during program execution, the program breaks before executing the instruction at that address. A breakpoint 
can be set using a function name, line number, or address.
The break and tbreak commands are functionally the same. The following describes the difference:
break: The breakpoints set by break are not cleared by a break that occurs when the set point is reached 

during program execution.
tbreak: The breakpoints set by tbreak are cleared by one occurrence of a break at the set point.

Format

break [Breakpoint]
tbreak [Breakpoint]

Breakpoint: Breakpoint
 A breakpoint can be specified with one of the following:
 •  Function name
 •  Source file name:line number or line number only
 •  *Address (decimal, hexadecimal, or symbol)
 When omitted, a breakpoint is set at the address displayed on the current PC.
Conditions: 0 ≤ address ≤ 0xfffffe

Usage example

n Example 1
(gdb) 
break main
Breakpoint 1 at 0xc0001e: file main.c, line 10.
(gdb) 
continue
Continuing.

Breakpoint 1, main () at main.c:10

A software PC breakpoint is set at the position specified using a function name. 
When the target program is run, it breaks before executing the first C instruction (expanded to mnemonic) in 
main(). The PC on which the program has stopped displays the start address of that instruction (i.e., address 

of first mnemonic expanded). 

n Example 2
(gdb) 
tbreak main.c:10
Breakpoint 1 at 0xc0001e: file main.c, line 10.

A temporary software PC breakpoint is set at the position specified with a line number. Although the breakpoint 
here is specified in "source file name:line number" format when the breakpoint is to be set in the C source 
containing the current PC address, it can be specified by simply using a line number like "tbreak 10". For 
assembly sources, a source file name is always required. 
If no instructions exist on the specified line with actual code (i.e., not expanded to mnemonic), a breakpoint is 
set at the beginning of the first instruction encountered with actual code thereafter. 
When the target program is run, it breaks before executing the C instruction on line 10 in main.c. The PC 
on which the program has stopped displays the start address of that instruction (i.e., address of first mnemonic 
expanded). If no instructions exist on line 10 with actual code, the program breaks at the beginning of the first 
instruction encountered with actual code thereafter. Because the breakpoint is set by tbreak, it is cleared after 
a break.
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n Example 3
(gdb) 
break *0xc0001e
Note: breakpoint 1 also set at pc 0xc0001e.
Breakpoint 2 at 0xc0001e: file main.c, line 10.

A software PC breakpoint is set at the position specified using an address.
When the target program is run, it breaks before executing the instruction at that address. A symbol can also be 
used, as shown below.
(gdb) 
tbreak *main
Breakpoint 3 at 0xc0001c: file main.c, line 7.

Note that adding an asterisk (*) causes even a function name to be regarded as an address. 

Breakpoint management

The breakpoints that you set are sequentially assigned break numbers beginning with 1, regardless of the types 
of breaks set, and are displayed as a message in the [Console] view when you execute a break setup command. 
(See the examples above.) These numbers are required to disable/enable or delete breakpoints individually at 
a later time. Even when you delete breakpoints, the breakpoint numbers are not moved up (to reuse deleted 
numbers) until after you quit the debugger. 
To manipulate the breakpoints you set, use the following commands:
disable: Disables a breakpoint.
enable: Enables a breakpoint. 
delete or clear: Deletes a breakpoint.
ignore: Specifies the number of times a break is disabled.
info breakpoints: Displays a list of breakpoints.

For details, see the description of each command.

Notes

• Software PC breakpoints can be set at up to 200 locations. If this limit is exceeded, an error is assumed. Note 
that this break count includes the software PC breakpoints used by the debugger in other functions. 

• C source lines that are not expanded to mnemonic cannot be specified as a location at which to set a software 
PC breakpoint. Specifying such a C line sets a software PC breakpoint at the address of the first instruction to 
be executed next. 

• When a function name or the beginning C source line in a function is specified as the position where to set 
a software PC breakpoint, the program execution will break at the start address of the first C source (i.e., 
instruction to be expanded to mnemonic) in the function. Although a ld instruction to save register contents 
is inserted at the beginning of the function during compilation, this instruction is executed before the program 
breaks. To make the program break before executing this instruction, specify a software PC breakpoint using 
the address value of that instruction. 

• No software PC breakpoints can be set at the following lines.
 -  Extended instruction lines (except for the ext instruction at the beginning)
 -  Delayed instruction lines (next line after a delayed branch instruction)

• If software PC breakpoints are specified using a nonexistent function name or line number, an error is 
assumed.

• When specifying a software PC breakpoint by an address value, the specified address will be adjusted to 
the 16-bit boundary by assuming LSB = 0 if it is an odd value. Furthermore, an error occurs if the specified 
address exceeds the 24-bit range. 

• Software PC breaks are implemented by an embedded brk instruction and therefore cannot be used for 
target board ROM in which instructions cannot be embedded. In such case, use hardware PC breaks instead.

• Processing resulting from the embedment of BRK command in source
 When a BRK command embedded in a user application source, instead of a break command, PC+=2 is 

automatically performed following a software break ((1)+2 results in (2) in the following example). The 
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C17 can be set with only one hardware break. By embedding a BRK command in a source, a break can be 
implemented at multiple locations when ROM such as flash memory is used for execution.

 Example:
sample.c
void main()
{
 ・   ; < Continues here.
 ・
 ・
 a = b + 1  ;
 iRet = sub( a ) ; < (3)
 asm( "brk" ) ; < (1) Embedment of brk command
 if ( iRet == 1 ) { ; < (2) Stops here. (BRK command address + 2)
 b -= 2  ;
}
 ・
 ・
 ・

 In the above example, if a software break is set at (1), the process stops at (1). This is because the debugger 
cannot determine whether the BRK command embedded in memory is by a break command or one 
embedded in the source. Note that the breakpoint setting must be cleared before the next execution.

 When a hardware break is set at (1), the process stops at (2). After (3) is processed by "next," the process 
stops at (2).
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hbreak (set hardware PC break)

thbreak (set temporary hardware PC break) [ICD Mini / SIM]

Operation

Sets a hardware PC breakpoint. The maximum number of hardware PC breakpoints that can be set is 1 to 4 for 
the ICD mode, depending on the model, and only 1 for the SIM mode.
When the PC matches the address set during program execution, the program breaks before executing the 
instruction at that address. A breakpoint can be set using a function name, line number, or address.
The hbreak and thbreak commands are functionally the same. The following describes the difference:
hbreak: The breakpoints set by hbreak are not cleared by a break that occurs when the set point is reached 

during program execution.
thbreak: The breakpoints set by thbreak are cleared by one occurrence of a break at the set point.

When the connection from the debugger is established, the number of the hardware PC breakpoints is 
determined by whether 1 write and 1 read are permitted for each IBEx bit. You cannot write 1 for an 
unimplemented break number (1: write, 0: read).

0xffffa0

 D0 DM

 D1 SE

 D2 IBE0

 D3 IBE1

 D4 DR

 D5 IBE2  <-Add
 D6 IBE3  <-Add
 D7 IBE4  <-Add

0xffffb0 IBAR0

0xffffb4 IBAR1

0xffffb8 IBAR2  <-Add
0xffffbc IBAR3  <-Add
0xffffd0 IBAR4  <-Add

Format

hbreak [Breakpoint]
thbreak [Breakpoint]

Breakpoint: Breakpoint
 A breakpoint can be specified with one of the following:
 •  Function name
 •  Source file name:line number or line number only
 •  *Address (decimal, hexadecimal, or symbol)
 When omitted, a breakpoint is set at the address displayed on the current PC.
Conditions: 0 ≤ address ≤ 0xfffffe

Usage example

n Example 1
(gdb) 
hbreak main
Hardware assisted breakpoint 1 at 0xc0001e: file main.c, line 10.
(gdb) 
continue
Continuing.

Breakpoint 1, main () at main.c:10

A hardware PC breakpoint is set at the position specified using a function name. 
When the target program is run, it breaks before executing the first C instruction (expanded to mnemonic) in 
main(). The PC on which the program has stopped displays the start address of that instruction (i.e., address 
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of first mnemonic expanded). 

n Example 2
(gdb) 
thbreak main.c:10
Hardware assisted breakpoint 1 at 0xc0001e: file main.c, line 10.

A temporary hardware PC breakpoint is set at the position specified with a line number. Although the 
breakpoint here is specified in "source file name:line number" format when the breakpoint is to be set in the 
C source containing the current PC address, it can be specified by simply using a line number like "thbreak 
10". For assembly sources, a source file name is always required. 

If no instructions exist on the specified line with actual code (i.e., not expanded to mnemonic), a breakpoint is 
set at the beginning of the first instruction encountered with actual code thereafter. 
When the target program is run, it breaks before executing the C instruction line 10 in main.c. The PC on 
which the program has stopped displays the start address of that instruction (i.e., address of first mnemonic 
expanded). If no instructions exist on line 10 with actual code, the program breaks at the beginning of the first 
instruction encountered with actual code thereafter. Because the breakpoint is set by thbreak, it is cleared 
after a break.

n Example 3
(gdb) 
hbreak *0xc0001e
Note: breakpoint 1 also set at pc 0xc0001e.
Hardware assisted breakpoint 2 at 0xc0001e: file main.c, line 10.

A hardware PC breakpoint is set at the position specified using an address.
When the target program is run, it breaks before executing the instruction at that address. A symbol can also be 
used, as shown below.
(gdb) 
thbreak *main
Hardware assisted breakpoint 3 at 0xc0001c: file main.c, line 7.

Note that adding an asterisk (*) causes even a function name to be regarded as an address. 

Breakpoint management

The breakpoints you set are sequentially assigned break numbers beginning with 1, regardless of which 
types of breaks you set, and are displayed as a message in the [Console] view when you execute a break 
setup command. (See the examples above.) These numbers are required when you disable/enable or delete 
breakpoints individually at a later time. Even when you delete breakpoints, the breakpoint numbers are not 
moved up (to reuse deleted numbers) until after you quit the debugger. 
To manipulate the breakpoints you set, use the following commands:
disable: Disables a breakpoint.
enable: Enables a breakpoint. 
delete or clear: Deletes a breakpoint.
ignore: Specifies the number of times a break is disabled.
info breakpoints: Displays a list of breakpoints.

For details, see the description of each command.

Notes

• The maximum number of enabled hardware PC breakpoints that can be set is 1 to 4 for ICD mode, 
depending on the model, and only 1 for the SIM mode. You can set more hardware PC breakpoints by setting 
the breakpoints in the disabled state. Keep in mind that this break count includes a temporary hardware PC 
breakpoint.

• C source lines that are not expanded to mnemonic cannot be specified as a location where to set a hardware 
PC breakpoint. Specifying such a C line sets a hardware PC breakpoint at the address of the first instruction 
to be executed next. 

• If a function name or the beginning C source line in a function is specified as the position at which to set 
a hardware PC breakpoint, the program execution will break at the start address of the first C source (i.e., 
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instruction to be expanded to mnemonic) in the function. Although a ld instruction to save registers is 
inserted at the beginning of the function during compilation, this instruction is executed before the program 
breaks. To make the program break before executing this instruction, specify a breakpoint with the address 
value of that instruction. 

• No hardware PC breakpoints can be set at the following lines, because an error is assumed and the target 
program can no longer be executed. (This problem may be resolved, however, by clearing the breakpoint.)

 -  Extended instruction lines (except for the ext instruction at the beginning)
 -  Delayed instruction lines (next line after a delayed branch instruction)

• If hardware PC breakpoints are specified using a nonexistent function name or line number, an error is 
assumed.

• When specifying hardware PC breakpoints by address value and the address is specified with an odd value, 
the specified address is adjusted to the 16-bit boundary by assuming LSB = 0. 
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delete  (clear break by break number) [ICD Mini / SIM]

Operation

Deletes all breakpoints currently set or one or more breakpoints individually by specifying a break number.

Format

delete [BreakNo]

BreakNo: Break number (decimal)
 When this entry is omitted, all breakpoints are deleted.

Usage example

(gdb) 
info breakpoints (displays a breakpoint list.)
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c00038 in sub at main.c:20
2   breakpoint     keep y   0x00c00030 in main at main.c:14
3   breakpoint     keep y   0x00c0003c in sub at main.c:22

Let's assume that breakpoints have been set as shown above.

n Example 1
(gdb) 
delete 1 2
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
3   breakpoint     keep y   0x00c0003c in sub at main.c:22

When you specify a break number, only that break can be cleared. You can specify multiple break numbers at a 
time.

n Example 2
(gdb) 
delete
(gdb) 
info breakpoints
No breakpoints or watchpoints.

When a break number is omitted, all breakpoints are cleared. To avoid inadvertent deletion, a dialog box is 
displayed for your confirmation. When "Delete all breakpoints?" appears, respond by clicking the [Yes] or [No] 
button. Choosing [Yes] clears all breaks; choosing [No] cancels deletion.

Notes

• Break numbers are sequentially assigned to each breakpoint you set, beginning with 1. If you do not know 
the break number of a breakpoint you wish to delete, use the info breakpoints command to confirm as 
in the example above.

• The delete command clears all break settings. To disable a breakpoint temporarily, use the disable or 
ignore command.

• Note that specifying a break number not set displays the "No breakpoint number N." message, with no 
breakpoints being deleted.
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clear  (clear break by break position) [ICD Mini / SIM]

Operation

Deletes PC breakpoints (including temporary breakpoints) currently set individually by specifying a set position 
(function name, line number, or address).  

Format

clear breakpoint

Breakpoint: Breakpoint 
 Can be specified by one of the following:
 •  Function name
 •  Source file name:line number or line number only
 •  *Address (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ address ≤ 0xfffffe

Usage example

(gdb) 
info breakpoints (displays a breakpoint list.)
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c0001e in main at main.c:10
2   breakpoint     keep y   0x00c00038 in sub at main.c:20
3   breakpoint     keep y   0x00c0003c in sub at main.c:22
4   breakpoint     keep y   0x00c00042 in sub at main.c:22

Let's assume that breakpoints have been set as shown above. Although break numbers 3 and 4 are at different 
addresses, the breakpoints are set on one line in terms of the C source. (This applies when breakpoints are set at 
addresses displayed in ASSEMBLY mode.) 

n Example 1
(gdb) 
clear main.c:22
Deleted breakpoints 4 3 
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c0001e in main at main.c:10
2   breakpoint     keep y   0x00c00038 in sub at main.c:20

When you specify a line number, all breakpoints set on the source line are cleared.

n Example 2
(gdb) 
clear main
Deleted breakpoint 1 
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
2   breakpoint     keep y   0x00c00038 in sub at main.c:20

When you specify a function name, the breakpoint set in the first C instruction within the function (expanded to 
mnemonic) is cleared. Use this method to delete breakpoints that have been set by "break function name", etc.

Notes

• The clear command completely clears break settings. To disable a breakpoint temporarily, use the dis-
able or ignore command.

• If you specify a function name, line number, or address for which no breakpoints are set, an error is assumed.
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enable (enable breakpoint)

disable (disable breakpoint) [ICD Mini / SIM]

Operation

enable: Enables a currently disabled breakpoint to make it effective again.
disable: Disables a currently effective breakpoint to make it ineffective. 

Breakpoints are effective when set by a break command and remain effective. The disable command disables 
these breakpoints without deleting them. Once disabled, the breakpoints are ineffective and the program does 
not break until said breakpoints are reenabled by the enable command.

Format

enable [BreakNo]
disable [BreakNo]

BreakNo: Break number (decimal)
 When this entry is omitted, all breakpoints are disabled or enabled.

Usage example

(gdb) 
info breakpoints (displays a breakpoint list.)
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c0001c in main at main.c:7
2   breakpoint     keep y   0x00c0001e in main at main.c:10
3   breakpoint     keep y   0x00c00028 in main at main.c:13
4   breakpoint     keep y   0x00c00038 in sub at main.c:20

Let's assume that breakpoints have been set as shown above. The effective breakpoints are marked by 'y' in the 
Enb column.

n Example 1
(gdb) 
disable 1 3
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep n   0x00c0001c in main at main.c:7
2   breakpoint     keep y   0x00c0001e in main at main.c:10
3   breakpoint     keep n   0x00c00028 in main at main.c:13
4   breakpoint     keep y   0x00c00038 in sub at main.c:20

When executing the disable command with a break number attached, note that only the specified break is disabled. 
You can specify multiple break numbers at a time. Ineffective breakpoints are marked by 'n' in the Enb column.

n Example 2
(gdb) 
enable
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c0001c in main at main.c:7
2   breakpoint     keep y   0x00c0001e in main at main.c:10
3   breakpoint     keep y   0x00c00028 in main at main.c:13
4   breakpoint     keep y   0x00c00038 in sub at main.c:20

When a break number is omitted, all breakpoints are enabled (or disabled) simultaneously.
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Notes

• Break numbers are sequentially assigned to each breakpoint when set, beginning with 1. If you do not know 
the break number of a breakpoint you wish to disable or enable, use the info breakpoints command to 
confirm as in the example above.

• The number of breakpoints that can be set is limited. Use the delete command to delete unnecessary 
breakpoints.

• Note that specifying a break number not set displays the "No breakpoint number N." message, with no 
breakpoints being disabled or enabled.
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ignore  (disable breakpoint with ignore counts) [ICD Mini / SIM]

Operation

Disables a specific break the number of times specified by a break hit count.

Format

ignore BreakNo Count

BreakNo: Break number (decimal)
Count: Number of break hits to be disabled (decimal or hexadecimal)

Usage example

(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c0003c in sub at main.c:22
2   breakpoint     keep y   0x00c00030 in main at main.c:14
(gdb) 
ignore 2 2

Break number 2 is disabled twice.

(gdb) 
continue
Continuing.

Breakpoint 1, sub (k=1) at main.c:22
(gdb) 
continue
Continuing.

Breakpoint 1, sub (k=1) at main.c:22
(gdb) 
continue
Continuing.

Breakpoint 2, main () at main.c:14

Although the target program passes through the breakpoint twice as it is run twice (by continue) above, no 
break occurs. A break occurs when running the program a third time because the breakpoint is reenabled. 

Notes

• Break numbers are sequentially assigned to each breakpoint when set, beginning with 1. If you do not know 
the break number of a breakpoint you wish to disable, use the info breakpoints command to confirm 
as in the example above.

• Count is used to count the number of times a specific break is hit, and not the number of times the target 
program is run. The count is not decremented unless the program passes through a specified breakpoint.

• The ignore command cannot be used to collectively disable multiple breakpoints.

• Note that specifying a break number not set displays the "No breakpoint number N." message, with program 
execution being aborted. 
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info  breakpoints  (display breakpoint list) [ICD Mini / SIM]

Operation

Displays a list of breakpoints currently set. 

Format

info breakpoints

Display

The breakpoint list is displayed as shown below.
(gdb) 
info breakpoints
Num Type           Disp Enb Address    What
1   breakpoint     keep y   0x00c00026 in main at main.c:11
 breakpoint already hit 1 time
2   hw breakpoint  del  n   0x00c00038 in sub at main.c:20

Num: Indicates a break number.
Type: Indicates the type of breakpoint.
 breakpoint Software PC breakpoint
 hw breakpoint Hardware PC breakpoint
Disp: Indicates breakpoint status after a break hit.
 keep The breakpoint will not be deleted.
 del The breakpoint will be deleted. This means that the breakpoint is a temporary break.
Enb: Indicates whether the breakpoint is effective or ineffective.
 y Effective
 n Ineffective
Address: Indicates the address at which a breakpoint is set (in hexadecimal). 
What: Indicates the location where a breakpoint is set. This information is displayed in "in function name 

at source file name:line number" format. 

Moreover, the number of times a breakpoint has thus been hit is displayed in "breakpoint already hit N times" 
format.

When breakpoints are not set at any location, the list is displayed as shown below.
(gdb) 
info breakpoints
No breakpoints or watchpoints.
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c17  timebrk (set lapse of time break) [ICD Mini]

Operation

Sets a time interval until the program execution is made to break forcibly after it starts. This command also 
disables this break function. 

Format

c17 timebrk Timer

Timer: Time until program execution is made to break from start in millisecond units (decimal or hexadecimal) 
 Can be set within the range from 1 to 300000 (milliseconds).
 The break function is disabled if 0 is specified. (Default setting at starting up of the debugger)

Usage example

n Example 1
(gdb) 
c17 timebrk 1000
      timer break on. [1000 ms]
(gdb) 
cont
Continuing.

A forcible break will occur after 1 second from starting the program execution.

n Example 2
(gdb) 
c17 timebrk 0
      timer break off.

The lapse of time break is disabled.

Notes

• This command cannot be used in simulator mode.

• When a break time has been set once, the lapse of time break is effective until it is disabled with "c17 
timebrk 0". A break will occur after the set time has elapsed every time the program is started.

• If another break condition is met or the [Suspend] button is clicked before the set time has elapsed, the 
program being executed is made to break at that point immediately.
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commands  (setting a command to execute after break) [ICD Mini/Sim]

Function

This command sets or cancels a command (multiple lines) to execute when execution halts at a specified 
breakpoint.

Format

commands [break number]

After the command is entered, the prompt will change to a ">." Enter the command line to be set for a break.
The command line entered may consist of multiple lines. Enter "end" to end input.
Use the info breakpoint command to view the set command line.
Omitting the break number results in specification of the number of the most recently set breakpoint.

Command line cancellation:
When the prompt changes to ">," enter "end" on the first line.

Usage example

(gdb)
break boot.s:16
(gdb)
commands 1
>x /4b 0x100
>break main
>continue
>x /4b sub
>end
(gdb)continue
Continuing.

Breakpoint 1, boot () at boot.s:16
0x100: 0xaa 0xaa 0xaa 0xaa
Breakpoint 2 at 0x632: file main.c, line 18.

Breakpoint 2, main () at main.c:18
Current language: auto; currentry c
0x658 <sub>:   0x00   0x40   0x25  0x18

(gdb)

Notes

• An error will be generated if a nonexistent numeric value is specified as a break number.
• If the break number is omitted, the number of the most recently set breakpoint will be specified.
• Proper operation is guaranteed for command lines of up to 50 lines. Even if a command line exceeds 50 lines, 

no error will be generated. Lines exceeding 50 lines are used as is.
• The program will halt immediately if an error occurs while a command is executing.
• The command line is not executed when a break occurs using a temporary breakpoint (tbreak, thbreak).
• The commands command cannot be nested. If a commands command occurs in the command line, the 

command line specified by the commands command cannot be entered during a break.
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10.7.9  Symbol Information Display Commands

info  locals (display local symbol)

info  var (display global symbol) [ICD Mini / SIM]

Operation

Displays a list of symbols.
info locals: Displays a list of local variables defined in the current function.
info var: Displays a list of global and static variables.

Format

info locals

info var

Usage example

n Example 1
(gdb) 
info locals
i = 0
j = 2

All local symbols defined in the function that includes the current PC address are displayed along with symbol 
content.

n Example 2
(gdb) 
info var
All defined variables:

File main.c:
int i;

Non-debugging symbols:
0x00000000  __START_bss
0x00000004  __END_bss
0x00000004  __END_data
0x00000004  __START_data

All defined global and static variables are displayed in list form separately for each source file. Displayed under 
the heading "Non-debugging symbols:" are such global symbols as section symbols defined in other than the 
source file. 

Notes

If the current position indicated by the PC address is outside the function (stack frame) (e.g., in boot routine of 
an assembly source), local symbols are not displayed.
(gdb) 
info locals
No frame selected.
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print  (alter symbol value) [ICD Mini / SIM]

Operation

Alters the value of a symbol.

Format

print Symbol[=Value]

Symbol: Variable name
Value: Value used to alter (decimal, hexadecimal, or symbol)
 When this entry is omitted, the current symbol value is displayed.
Conditions: 0 ≤ Value ≤ valid range of type

Usage example

n Example 1
(gdb) 
info local
j = 0
(gdb) 
print j
$1 = 0

When you specify only a variable name, the value of that variable is displayed. The $N is a number used to 
reference this value at a later time. The contents displayed here can be referenced using print $1.

n Example 2
(gdb) 
print j=5
$2 = 5
(gdb) 
info local
j = 5

Note that specifying a value changes the variable value to that specified.

Notes

• If you specify an undefined symbol, an error is assumed. 

• Even if the value you have specified exceeds the range of values for the type of variable you wish to alter, no 
errors are assumed. Only a finite number of low-order bits equivalent to the size of the variable are effective, 
with excessive bits being ignored. For example, specifying 0x10000 for variable int is processed as 0x0000. 
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10.7.10  file loading Commands

file  (load debugging information) [ICD Mini / SIM]

Operation

Loads only debugging information from elf format object files. 
Use the load command to load necessary object code. 

Format

file Filename

Filename: Name of object file in elf format to be debugged (with path also specifiable)

Usage example

(gdb) 
file sample.elf

Debugging information is loaded from sample.elf in the current directory. 

Notes

• The file command only loads debugging information; it does not load object code. Therefore, except when 
the program is written to target ROM, you cannot start debugging by simply executing the file command.

• The file command must be executed before the target and load commands. The following shows the 
basic sequence of command execution: 

 (gdb) 
 file sample.elf (this command)
 (gdb) 
 c17 rpf sample.par (sets map information.)
 (gdb) 
 target sim  (connects the target.)
 (gdb) 
 load   (loads the program.)
 (gdb) 
 c17 rst  (resets the CPU.)

• Unless executed for elf object files in executable format (generated by the linker), the file command 
results in an error and no files can be loaded. If the loaded file contains no debugging information, an error 
also results. 

• The "Source file is more recent than executable" warning dialog will appear if the creation time for the file 
specified is more recent than the source file when executing the file command. Click the "OK" button.

• The elf format object files contain information on source files (including the directory structure). For this 
reason, unless the source files exist in a specified directory in the object file as viewed from the current 
directory, the source files cannot be loaded. Basically, the series of operations from compiling to debugging 
should be performed in the same directory. 

• Once the file command is executed, operation cannot be aborted until the debugger finishes loading the 
file. 

• An error will occur if an unsupported elf file (with no C17 flag) is specified.
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load  (load program) [ICD Mini / SIM]

Operation

Loads the program and data from elf format object files into target memory.

Format

load [Filename]

Filename: Name of ROM data HEX file (Motorola format HEX file) to be debugged (with path also 
specifiable)

 When this entry is omitted, the file specified previously by the file command is loaded. This 
specification is usually omitted. 

Usage example

(gdb) 
file sample.elf
(gdb) 
target sim
(gdb) 
load

The program and data are loaded from sample.elf in the current directory (specified by the file 
command) into target memory (computer memory in this example because the debugger operates in simulator 
mode).

Notes

• The load command must be executed after the file and target commands. The following shows the 
basic sequence of command execution: 

 (gdb) 
 file sample.elf (loads debugging information.)
 (gdb) 
 c17 rpf sample.par (sets map information.)
 (gdb) 
 target sim  (connects the target.)
 (gdb) 
 load   (this command)
 (gdb) 
 c17 rst  (resets the CPU.)

• The load command loads only several areas of an object file containing the code and data. All other areas 
are left intact in the previous state before load command execution. 
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c17  loadmd  (set program load mode) [ICD Mini]

Operation

Set the mode to load program/data into the target memory from an elf format object file when the load 
command is executed.

Format

c17 loadmd Mode

Mode: Transfer mode
 0 High-speed byte transfer mode (default)
 1 Low-speed byte transfer mode

Usage example

(gdb) 
file sample.elf
(gdb) 
target icd usb
(gdb) 
c17 loadmd 0
(gdb) 
load

The program and data are loaded from sample.elf located in the current directory (specified by the file 
command) into the target memory using high-speed 8-bit instructions.

Notes

• This command cannot be used in simulator mode.
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10.7.11  Map Information Commands

c17  rpf  (set map information) [[ICD Mini/SIM]

Operation

Sets memory map information by loading a specified parameter file.

Format

c17 rpf Filename

Filename: Name of parameter file (with path also specifiable)

Usage example

(gdb) 
c17 rpf sample.par

Memory map information is loaded from sample.par in the current directory.

Notes

• The c17 rpf command can only be used in simulator mode.

• For details about parameter files, see Section 10.9, "Parameter Files".

• Make sure the c17 rpf command is executed only once prior to the target command. The following 
shows the basic sequence of command execution: 

 (gdb) 
 file sample.elf (loads debugging)
 (gdb) 
 c17 rpf sample.par (this command)
 (gdb) 
 target sim  (connects the target.)
 (gdb) 
 load   (loads the program.)
 (gdb) 
 c17 rst   (resets the CPU.)

 To reset memory map information, quit the debugger temporary, then restart it and execute the c17 rpf 
command.

• The debugger allocates a PC memory area according to the memory map information in the parameter file 
loaded. If a required area cannot be allocated (with error message "Cannot allocate memory." displayed), 
correct the area size in the parameter file by making it smaller.

• No software PC breaks and temporary software PC breaks can be set in areas assigned the "ROM" attribute 
in a parameter file (*.par).

• The following memory map information will be set if this command is not executed while in  ICD connection 
mode.

 TTBR 0x8000
 RAM 0x0–0xffffff, R/W wait cycle = 0, 16-bit access, little endian
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c17  map  (display map information) [SIM]

Operation

Displays memory map information set by a parameter file.

Format

c17 map

Usage example

(gdb) 
c17 map
CPU : C17
Memory map information Type  Wait(r/w) Size  Endian 
    00008000           TTBR
    00000000-00ffffff  RAM     0/0     16Bit Little
    00000000-00003eff  STACK

CPU: Indicates the type of CPU.
 C17: S1C17 Core
Memory map information:
 Indicates the range of memory addresses to which the device is allocated (start address–end address 

of the area) in hexadecimal.
Type: Indicates the type of memory or device.
Wait (r/w): Indicates the number of wait cycles inserted during read/write operation. 
Size: Indicates the data width of the device (in bits).
Endian: Indicates the endian format (little or big endian) of the area.

When memory map information has yet to be loaded by the c17 rpf command, a message appears like the 
one shown below.
(gdb) 
c17 map
CPU : C17
Memory map information Type  Wait(r/w) Size  Endian 
    00008000           TTBR
    00000000-00ffffff  RAM     0/0     16Bit Little

Notes

The c17 map command can only be used in simulator mode.
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10.7.12  flash Memory Manipulation Commands

c17  fls  (set flash memory) [ICD Mini]

Operation

Sets up flash memory of the target system as required to write data to it.

Format

c17 fls StartAddr EndAddr ErasePrg WritePrg [SendSize]

StartAddr: Start address of flash memory (decimal, hexadecimal, or symbol)
EndAddr: End address of flash memory (decimal, hexadecimal, or symbol)
ErasePrg: Start address of erase program (decimal, hexadecimal, or symbol)
WritePrg: Start address of write program (decimal, hexadecimal, or symbol)
SendSize: Work area size for transferring the flash load program (decimal, hexadecimal, or symbols)
Conditions: 0 ≤ StartAddr ≤ EndAddr ≤ 0xffffff, 0 ≤ ErasePrg ≤ 0xffffff, 0 ≤ WritePrg ≤ 0xffffff, 
 0 ≤ SendSize ≤ 1010

Usage example

(gdb) 
c17 fls 0x200000 0x2fffff FLASH_ERASE FLASH_LOAD
Flash start address = 0x200000, Flash end address = 0x2fffff
Flash erase routine address = 0x100, Flash write routine address = 0x200 .....done

The flash memory area in the target system (0x200000 to 0x2fffff), and addresses of the erase and write 
routines are set. 

Notes

• This command cannot be used in simulator mode.

• Before you can erase flash memory of the target system or write data to flash memory, you must have written 
the data write and erase programs to the specified address locations. 

• SendSize should be set to fit in the flash load program usable area (internal RAM) size for the model used. 
For details of the memory map, refer to the technical manual for the specific device.
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c17  fle  (erase flash memory) [ICD Mini]

Operation

Erases the contents of flash memory of the target system. 

Format

c17 fle ControlReg StartBlock EndBlock [Timer]

ControlReg: Start address set by c17 fls (decimal, hexadecimal, or symbol)
StartBlock: First block in erase range (decimal, hexadecimal, or symbol)
EndBlock: Last block in erase range (decimal, hexadecimal, or symbol)
 When StartBlock = EndBlock = 0, the entire area is erased.
Timer: Timeout value (decimal or hexadecimal)
 Specify a time in second. When omitted, a timeout occur in 150 seconds.

Usage example

(gdb) 
c17 fle 0x200000 0 0
Control Register = 0x200000, Start block = 0x0, End block = 0x0 .....Finish with 
0x00000000

The entire area of flash memory is erased.

Notes

• This command cannot be used in simulator mode.

• Before you can erase flash memory of the target system, you must have written the data write and erase 
programs to the target system memory and executed the c17 fls command. If you execute the c17 fle 
command with no erase programs set, an error is assumed.

• Before writing data to flash memory of the target system, always be sure to use this command to erase flash 
memory.

• Some models do not allow the setting of a desired flash erasure range. For such models, make a setting for 
the erasure of all blocks. To determine whether or not it is possible to set a desired flash erasure range, refer 
to readme_x.txt in the fls folder (\gnu17\mcu_model\MODEL NAME\fls) for the model in 
question.
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c17  flv  (flash memory write/delete voltage setting) [ICD Mini]

Operation

Command specifically for the ICDmini Ver.2.0 (S5U1C17001H2100)
Set the voltage for writing and deleting to the ICDmini with microprocessors with a flash programming power 
pin. This command is used before writing data to the flash microprocessor using the load command (load 
command) or when deleting sectors (c17 fls command).

Format

c17 flv Voltage

Voltage: Flash memory write/delete voltage (decimal, in 0.1 V units)
 The decimal point and "0" must be included. (e.g., "7.0")
Conditions: 6.0 ≤ Voltager ≤ 8.0

Usage example

(gdb) 
 c17 fls  0x8000  0x1ffff  FLASH_ERASE  FLASH_LOAD
Flash start address = 0x8000, Flash end address = 0x1ffff
Flash erase routine address = 0x100, Flash write routine address = 0x200 .....done
(gdb)
 c17 flv 7.5
Set flash voltage 7.5V
(gdb)
 c17 fle  8000  0  0
(gdb)

 c17 flvs   * Must always be executed after flash deletion.
Stop output flash voltage.
(gdb)
 c17 flv 7.0
Set flash voltage 7.0V
(gdb)
 load
(gdb)

 c17 flvs   * Must always be executed after flash writing.
Stop output flash voltage.

Deletes the entire flash memory area at 7.5 V, and cancels the setting with the c17 flvs command, then 
writes the program to flash memory at 7.0 V.
Finally cancels the setting with the c17 flvs command.

Notes

• A microprocessor with a flash programming power pin and ICDmini Ver.2.0 (S5U1C17001H2100) are 
required to use this command. (An error will occur if the ICDmini differs.)

• The setting will vary depending on the model. Refer to the specific information given for "Electrical 
Characteristics" in the corresponding technical manual.

• This command cannot be used in simulator mode.

• Cancel the write/delete voltage setting using the c17 flvs command after flash memory writing/deleting.
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c17  flvs  (cancel flash memory write/delete voltage setting)  [ICD Mini]

Operation

Command specifically for the ICDmini Ver.2.0 (S5U1C17001H2100).
Cancels the voltage set by the c17 flv command.
This command is used after writing data to the flash microprocessor using the load command (load command) 
or sector deletion (c17 fle command).

Format

c17 flvs

Usage example

(gdb)
 c17 fls  0x8000  0x1ffff  FLASH_ERASE  FLASH_LOAD
Flash start address = 0x8000, Flash end address = 0x1ffff
Flash erase routine address = 0x100, Flash write routine address = 0x200 .....done
(gdb)
 c17 flv 7.5
Set flash voltage 7.5V
(gdb)
 c17 fle  8000  0  0
(gdb)

 c17 flvs  * Must always be executed after flash deletion.
Stop output flash voltage.
(gdb)
 c17 flv 7.0
Set flash voltage 7.0V
(gdb)
 load
(gdb)

 c17 flvs  * Must always be executed after flash writing.
Stop output flash voltage.

Deletes the entire flash memory area at 7.5 V, and cancels the setting with the c17 flvs command, then 
writes the program to flash memory at 7.0 V.
Finally cancels the setting with the c17 flvs command.

Notes

• A microprocessor with a flash programming power pin and ICDmini Ver.2.0 (S5U1C17001H2100) are 
required to use this command. (An error will occur if the ICDmini differs.)

• This command cannot be used in simulator mode.
• Execute this command after flash memory writing and deletion.
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10.7.13  Trace Command

c17  tm  (set trace mode) [SIM]

Operation

Sets the conditions below.

Turning trace on/off
When you turn trace on, trace information is sampled along with program execution. 

Trace information items to be displayed
You can choose the items in the trace information to be displayed.

Output destination of trace information
You can choose a view or file as the destination at which sampled trace information is output. Choosing a view 
displays trace information in the [Trace] view. Choosing a file requires that you specify a file name.

Format

c17 tm on Mode [Filename]  (sets trace mode.)
c17 tm off    (clears trace mode.)

Mode: Trace mode (contents of trace information displayed)
 Specify within the range from 0x00 to 0xff. Set the bit corresponding to the item to be displayed to 1.
 Bit 0 Trace number
 Bit 1 Clock number
 Bit 2 PC value and instruction code
 Bit 3 Bus information (address, R/W and access size, data)
 Bit 4 Register values (R0–R7, SP)
 Bit 5 PSR value (IE, IL, CVZN)
 Bit 6 Disassembled contents and source code
 Bit 7 Cumulative number of clocks (number of clocks spent by each instruction when set to 0)
Filename: Name of file to which trace information is output 
 When a file name is specified, sampled trace information is output to the specified file, and not 

displayed in a view. When this entry is omitted, trace information is displayed in the [Trace] view, 
and not output to a file. 

Usage example

n Example 1
(gdb) 
c17 tm on 0xff trace.log

This example sets the trace mode for displaying all information and specifies the trace.log file in which 
to save the information. Running the program after setting these options outputs trace information to a file for 
each instruction executed. If a file name is omitted, the information is displayed in the [Trace] view.

n Example 2
(gdb) 
c17 tm off

Trace mode is turned off. From this time on, no trace information is sampled even when running the program. 
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Trace information

Running the target program after setting trace mode with this command displays trace information in the [Trace] 
view for each instruction executed, or outputs it to a file. 
The contents of trace information displayed in a view or output to a file are as follows:

Format of each trace information line
 num  clk  pc  code  bus_addr/type/data  r0  r1  r2  r3  r4  r5  r6  r7  sp  ie/il/cvzn  src_mix

num: Number of executed instructions (in decimal)
 Number of instructions executed since the CPU was reset
clk: Number of execution clocks (in decimal)
 Number of execution clocks since the CPU was reset
pc: Address of executed instructions (in hexadecimal)
code: Instruction codes (in hexadecimal)
bus_addr: Accessed memory addresses (in hexadecimal)
type: Type of bus operation
 r8: Byte data read; r16: 16-bit data read; r32: 32-bit data read
 w8: Byte data write; w16: 16-bit data write; w32: 32-bit data write
data: Read/written data (in hexadecimal)
r0–r7: r0–r7 register values (in hexadecimal)
sp: sp register value (in hexadecimal)
ie: IE bit value in psr
il: IL bit value in psr
cvzn: C, V, Z and N bit values in psr
src_mix: Disassembled contents and source codes of executed instructions

Display example
First half of information lines (trace number to register values)
num    clk     pc     code  bus addr/type/data     r0     r1     r2     r3     r4     r5     r6     r7

  652   1445  0040dc  9900  ------ --- --------  000094 000000 000000 00ffff 000000 000000 000000 000000

  653   1446  0040de  4000  ------ --- --------  000094 000000 000000 00ffff 000000 000000 000000 000000

  654   1447  0040e0  4000  ------ --- --------  000094 000000 000000 00ffff 000000 000000 000000 000000

  655   1449  0040e2  d900  000000 w16 00000000  000094 000000 000000 00ffff 000000 000000 000000 000000

  656   1450  0040e4  2a12  ------ --- --------  000094 000000 000000 00ffff 000000 000000 000000 000000

  657   1451  0040e6  2814  ------ --- --------  000000 000000 000000 00ffff 000000 000000 000000 000000

  658   1452  0040e8  4000  ------ --- --------  000000 000000 000000 00ffff 000000 000000 000000 000000

  659   1457  0040ea  1805  003ef4 w32 000040ec  000000 000000 000000 00ffff 000000 000000 000000 000000

  660   1458  0040f6  a001  ------ --- --------  000000 000000 000000 00ffff 000000 000000 000000 000000

  661   1459  0040f8  9000  ------ --- --------  000000 000000 000000 00ffff 000000 000000 000000 000000

  662   1462  0040fa  0e0e  ------ --- --------  000000 000000 000000 00ffff 000000 000000 000000 000000

  663   1466  004118  0120  003ef4 r32 000040ec  000000 000000 000000 00ffff 000000 000000 000000 000000

  664   1467  0040ec  8201  ------ --- --------  000000 000000 000000 00ffff 000001 000000 000000 000000

  665   1468  0040ee  9205  ------ --- --------  000000 000000 000000 00ffff 000001 000000 000000 000000

Second half of information lines (SP value to source code)
  sp ie/il/cvzn   src mix

003ef8 0 0 0010 ld         %r2,0x0              (main.c)       00012     i = 0;

003ef8 0 0 0010 ext        0x0                  

003ef8 0 0 0010 ext        0x0                  

003ef8 0 0 0010 ld         [0x0],%r2            

003ef8 0 0 0010 ld         %r4,%r2              (main.c)       00014     for( j = 0; j < 6; ++j )

003ef8 0 0 0010 ld         %r0,%r4              (main.c)       00016         sub(j);

003ef8 0 0 0010 ext        0x0                  

003ef4 0 0 0010 call       0x5                  

003ef4 0 0 0010 and        %r0,0x1              (main.c)       00022     if(k & 0x1)

003ef4 0 0 0010 cmp        %r0,0x0              

003ef4 0 0 0010 jreq       0xe                  

003ef8 0 0 0010 ret                             (main.c)       00027 }

003ef8 0 0 0000 add        %r4,0x1              (main.c)       00014     for( j = 0; j < 6; ++j )

003ef8 0 0 1001 cmp        %r4,0x5              
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Notes

• This command cannot be used in ICD Mini mode.

• The number of clock cycles displayed in a view is calculated using the wait cycles information set in a 
parameter file. The information displayed may not be correct if the parameter file was set erroneously. For 
details, see Section 10.9, "Parameter Files".

• To change trace mode (with contents of trace information displayed), temporarily turn off trace mode (by 
executing c17 tm off), then set a new trace mode.
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10.7.14  Simulated I/O Commands

c17  stdin  (data input simulation) [ICD Mini / SIM]

Operation

Sets conditions for data to be entered from a file or [Console] view and passed to the program.
The following conditions are set by the c17 stdin command:
•  Break address (position at which gdb takes in data)
•  Input buffer address (65-btye buffer)
•  Input source (file or [Console] view)

For operation on the program side, see Section 10.6.7, "Simulated I/O".

Format

c17 stdin 1 BreakAddr BufferAddr [Filename] (set)
c17 stdin 2      (clear)

BreakAddr: Break address (decimal, hexadecimal, or symbol)
BufferAddr: Input buffer address (decimal, hexadecimal, or symbol)
 The buffer size is fixed to 65 bytes.
Filename: Name of input file
 When this entry is omitted, data entry from the [Console] view is assumed.
Conditions: 0 ≤ BreakAddr ≤ 0xffffff, 0 ≤ BufferAddr ≤ 0xffffff

Input examples

n Example 1
(gdb) 
c17 stdin 1 READ_FLASH READ_BUF input.txt

Data entered from a file is set.
When you run the program continuously after making this setting, the debugger aborts processing at the 
position of the READ_FLASH label in the program. Here, the debugger takes one line of data from the input.
txt file and places it in the input buffer (READ_BUF), then resumes program execution. 

n Example 2
(gdb) 
c17 stdin 1 READ_FLASH READ_BUF

Data entered via the [Console] view is set.
When you run the program continuously after making this setting, the debugger aborts processing at the 
position of the READ_FLASH label in the program and opens the [Console] view. When you enter data in the 
window and press the [Enter] key, the debugger takes data from the window and places it in the input buffer 
(READ_BUF), then resumes program execution. 

n Example 3
(gdb) 
c17 stdin 2

The data input simulation function is cleared. If data entered from a file was set, the specified file is closed.

Notes

• The break addresses specified by the c17 stdin command cannot duplicate those of software PC 
breaks. Be sure to clear software PC breaks before executing the c17 stdin command. Break addresses 
overlapping those of hardware PC breakpoints are accepted.

• If the break address is specified with an odd value, the specified address is adjusted to the 16-bit boundary by 
assuming LSB = 0. 

• BreakAddr and BuffAddr should specify the RAM address.
 If BreakAddr is specified in ROM, the debugger will not function correctly, since the software PC break 

command is written to BreakAddr.
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c17  stdout  (data output simulation) [ICD Mini / SIM]

Operation

Sets conditions for data to be output from a specified output buffer to a file or the [Console] view. 
The following conditions are set by the c17 stdout command:
•  Break address (position at which gdb outputs data)
•  Output buffer address (65-btye buffer)
•  Output destination (file or [Console] view)

For operation on the program side, see Section 10.6.7, "Simulated I/O".

Format

c17 stdout 1 BreakAddr BufferAddr [Filename] (set)
c17 stdout 2      (clear)

BreakAddr: Break address (decimal, hexadecimal, or symbol)
BufferAddr: Output buffer address (decimal, hexadecimal, or symbol)
 The buffer size is fixed to 65 bytes.
Filename: Name of output file
 Outputs to a file and [Console] view.
 When this entry is omitted, data is output to the [Console] view.
Conditions: 0 ≤ BreakAddr ≤ 0xffffff, 0 ≤ BufferAddr ≤ 0xffffff

Input examples

n Example 1
(gdb) 
c17 stdout 1 WRITE_FLASH WRITE_BUF output.txt

Data output to a file is set.
When you run the program continuously after making this setting, the debugger aborts processing at the 
position of the label WRITE_FLASH in the program. Here, the debugger outputs data from a specified buffer 
(WRITE_BUF) to a specified file, then resumes program execution. 

n Example 2
(gdb) 
c17 stdout 1 WRITE_FLASH WRITE_BUF

Data output to the [Console] view is set.
When you run the program continuously after making this setting, the debugger aborts processing at the 
position of the label WRITE_FLASH in the program. Here, the debugger opens the [Console] view and displays 
it with the data contained in a specified buffer (WRITE_BUF), then resumes program execution. 

n Example 3
(gdb) 
c17 stdout 2

The data output simulation function is cleared. If data output to a file was set, the specified file is closed.

Notes

• The break addresses specified by the c17 stdout command cannot duplicate those of software PC 
breaks. Be sure to clear software PC breaks before executing the c17 stdout command. Break addresses 
overlapping those of hardware PC breakpoints are accepted.

• If the break address is specified with an odd value, the specified address is adjusted to the 16-bit boundary by 
assuming LSB = 0.

• BreakAddr and BuffAddr should specify the RAM address.
 If BreakAddr is specified in ROM, the debugger will not function correctly, since the software PC break 

command is written to BreakAddr.
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10.7.15  flash Writer Commands

c17  fwe  (erase program/data) [ICD Mini]

Operation

This is a dedicated command for the flash writer of the S5U1C17001H. 
It erases the data erase/write program or write data and address information loaded in the S5U1C17001H. 

Format

c17 fwe 0 (erases write data.)
c17 fwe 1 (erases data/erase write program.)

Usage example

n Example 1
(gdb) 
c17 fwe 0

The storage area for flash write data and the address information in the S5U1C17001H are erased.

n Example 2
(gdb) 
c17 fwe 1

The storage area for the flash erase/write program and the entry information in the S5U1C17001H are erased.

Notes

• This command cannot be used in simulator mode.

• This command can be used with the ICD Mini (S5U1C17001H). It cannot be executed normally with the 
ICD board (an error message will not be displayed).

• Some models do not allow the setting of a desired flash erasure range. For such models, make a setting for 
the erasure of all blocks. To determine whether or not it is possible to set a desired flash erasure range, refer 
to readme_x.txt in the fls folder (\gnu17\mcu_model\MODEL NAME\fls) for the model in 
question.
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c17  fwlp  (load program) [ICD Mini]

Operation

This is a dedicated command for the flash writer of the S5U1C17001H. 
It loads the data erase/write program from the host into the S5U1C17001H. 

Format

c17 fwlp Filename EraseEntryAddr WriteEntryAddr [Comment]

Filename: Name of data erase/write program file (Motorola S3 format file)
EraseEntryAddr: Erase routine entry address (RAM address on the CPU side, in decimal or hexadecimal)
WriteEntryAddr: Write routine entry address (RAM address on the CPU side, in decimal or hexadecimal)
Comment: Comments to identify data/address information (may be omitted)
 • If the comment contained the null character (space), it encloses with a double quotation.
 • If you are using a microprocessor with a flash programming power pin, you must include 

the write and delete voltages in the comments in the format given below. Note that the 
voltage will not be set for microprocessors without a flash programming power pin, even 
with the above comment.

  "-vEraseVoltage-WriteVoltage" (no spaces)
Conditions: 0 ≤ EraseEntryAddr ≤ 0xfffffe (A0 = 0 ), 0 ≤ WriteEntryAddr ≤ 0xfffffe (A0 = 0 ),
 0 ≤ comment size ≤ 128 bytes
 6.0 ≤ EraseVoltage ≤ 8.0V
 6.0 ≤ WriteVoltage ≤ 8.0V

Usage example

n Example 1
(gdb) 
c17 fwlp writer.sa 0x90 0xb4

The data erase/write program for the flash writer (prepared in file writer.sa ) is loaded in the 
S5U1C17001H, and start addresses of the erase and write routines are set to 0x90 and 0xb4, respectively.

n Example 2
(gdb) 
c17 fwlp writer.sa 0x90 0xb4 "-v7.0-7.0"

Set the delete voltage to 7.0 V and the write voltage to 7.0 V for a microprocessor with a flash programming 
power pin.

Notes

• This command cannot be used in simulator mode.

• This command can be used with the ICD Mini (S5U1C17001H). It cannot be executed normally with the 
ICD board (an error message will not be displayed).

• The data erase/write program is 8KB or less in size.

• For the value of EraseEntryAddr/WriteEntryAddr, refer to "readme_e.txt" located at mcu_model\MODEL 
NAME\fls.

• A microprocessor with a flash programming power pin and ICDmini Ver.2.0 (S5U1C17001H2100) are 
required to set the flash programming power supply using a comment. 

 The setting will vary depending on the model. Refer to the specific information given for "Electrical 
Characteristics" in the corresponding technical manual.
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c17  fwld  (load data) [ICD Mini]

Operation

This is a dedicated command for the flash writer of the S5U1C17001H. 
It loads the data to be written to flash memory from the host into the S5U1C17001H.  

Format

c17 fwld Filename EraseStartBlock EraseEndBlock EraseParam [Comment]

Filename: Name of data file (Motorola S3 format file)
EraseStartBlock: Block at which to start erasing (flash on the CPU side, in decimal or hexadecimal)
EraseEndBlock: Block at which to complete erasing (flash on the CPU side, in decimal or hexadecimal)
EraseParam: Erase parameter
 A parameter passed to the erase routine in an external routine call
Comment: Comments to identify data/address information (may be omitted)
 • If the comment contained the null character (space), it encloses with a double quotation.
Conditions: 0 ≤ EraseStartBlock ≤ 0xffffffff, 0 ≤ EraseEndBlock ≤ 0xffffffff
 If EraseStartBlock = EraseEndBlock = 0, all blocks in flash memory are assumed to be 

erased. 
 0 ≤ comment size ≤ 128 bytes

Usage example

(gdb) 
c17 fwld sample.sa 0 0 0x200000

The range of flash memory to be erased (all blocks in flash memory) is set, and the flash write data prepared in 
file sample.sa is loaded in the S5U1C17001H. 

Notes

• This command cannot be used in simulator mode.

• This command can be used with the ICD Mini (S5U1C17001H). It cannot be executed normally with the 
ICD board (an error message will not be displayed).

• The program data is 8MB or less in size.

• Some models do not allow the setting of a desired flash erasure range. For such models, make a setting for 
the erasure of all blocks. To determine whether or not it is possible to set a desired flash erasure range, refer 
to readme_x.txt in the fls folder (\gnu17\mcu_model\MODEL NAME\fls) for the model in 
question.
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c17  fwdc  (copy target memory) [ICD Mini]

Operation

This is a dedicated command for the flash writer of the S5U1C17001H. 
It loads the data stored in target board memory into the S5U1C17001H so that the data can be written to flash 
memory.

Format

c17 fwdc SourceAddr Size EraseStartBlock EraseEndBlock EraseParam [Comment]

SourceAddr: Target memory address from which to copy (flash on the CPU side, in decimal, hexadecimal, 
or symbol)

Size: Number of bytes to copy (decimal or hexadecimal)
EraseStartBlock: Block at which to start erasing (flash on the CPU side, in decimal or hexadecimal)
EraseEndBlock: Block at which to complete erasing (flash on the CPU side, in decimal or hexadecimal)
EraseParam: Erase parameter
 A parameter passed to the erase routine in an external routine call
Comment: Comments to identify data/address information (may be omitted)

 • If the comment contained the null character (space), it encloses with a double quotation.
Conditions: 0 ≤ SourceAddr ≤ 0xfffffe (A0 = 0), 0 ≤ Size ≤ 0xfffffe (D0 = 0),
 0 ≤ EraseStartBlock ≤ 0xffffffff, 0 ≤ EraseEndBlock ≤ 0xffffffff
 When EraseStartBlock = EraseEndBlock = 0, all blocks in flash memory are assumed to be 

erased. 
 0 ≤ comment size  ≤ 128 bytes

Usage example

(gdb) 
c17 fwdc FLASH_START 0x100000 0 0 0x200000

The range of flash memory to be erased (all blocks in flash memory) is set, and 1MB of area is copied from 
FLASH_START in target memory to the S5U1C17001H. 

Notes

• This command cannot be used in simulator mode.

• This command can be used with the ICD Mini (S5U1C17001H). It cannot be executed normally with the 
ICD board (an error message will not be displayed).

• The ICDmini flash memory can retain up to 4 MB of data.
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c17  fwd  (display flash writer information) [ICD Mini]

Operation

This is a dedicated command for the flash writer of the S5U1C17001H. 
It displays information on the data and erase/write program loaded in the S5U1C17001H. 

Format

c17 fwd

Display

(gdb) 
c17 fwd
CPU data address            : xxxxxxxx
Data size                   : xxxxxxxx
Erase start block           : xxxxxxxx
Erase end block             : xxxxxxxx
Erase parameter             : xxxxxxxx
Comment : xxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

CPU program address         : xxxxxxxx
Program size                : xxxxxxxx
Erase routine entry address : xxxxxxxx
Write routine entry address : xxxxxxxx
Comment : xxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Information about the address and size of flash write data, and range of flash memory to be erased are displayed 
in the first half, as set by the c17 fwld or c17 fwdc command.
Information about the start address and size of the flash erase/write program, and entry addresses of the erase/
write routines are displayed in the latter half, as set by the c17 fwlp command.

Notes

• This command cannot be used in simulator mode.

• This command can be used with the ICD Mini (S5U1C17001H). It cannot be executed normally with the 
ICD board (an error message will not be displayed).
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10.7.16  Profiler and Coverage Commands

c17  profilemd (profile/coverage mode setting) [SIM]

Operation

Sets whether profile or coverage data are acquired while a user program is running.
This command is executed to disable the mode and improve the run speed slightly when the run speed is 
reduced when the profile function is not used.

Format

c17 profilemd Mode
Mode: 0  Disables subsequent acquisition of profile/coverage data. Data prior to disabling will be saved.
 1  Enables subsequent acquisition of profile/coverage data. (Default)

 The status is displayed when omitted. When disabled, "Profiler mode is disabled." is displayed, and when 
enabled, "Profiler mode is enabled." is displayed.

 If there are two or more parameters, "C17 command error, number of parameters." will be displayed. Similarly, 
"C17 command error, invalid parameter." will be displayed if parameters other than 0 or 1 are included.

Usage example

(gdb)
c17 profilemd 0
Profiler mode is disabled.
(gdb)
c17 profilemd 1
Profiler mode is enabled.
(gdb)
c17 profilemd
Profiler mode is enabled.

Notes

The profile cannot be measured correctly if the mode settings are changed as shown below. Do not enable or 
disable the settings midway.
Mode: enabled
(gdb) 
C17 rst
(gdb) 
Cont

Break occurs
(gdb)
C17 profilemd 0
(gdb)
Cont 

No measurement data between these points.Break occurs
(gdb) 
C17 profilemd 1
(gdb) 
Cont

Break occurs
(gdb) 
C17 profile ← The profile will not be measured correctly here.
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c17  profile  (launching of profiler window) [SIM]

Operation

Opens a profiler window and displays profile results. For detailed information on the profiler window, refer to 
Section 10.8, "Profiler and Coverage Functions."

Format

c17 profile

Usage example

(gdb)
c17 rpf c17.par
(gdb)
file sample.elf
(gdb)
target sim
(gdb)
load
(gdb)
c17 rst
(gdb)
break _exit
(gdb)
cont ←	 Measurement starts.
Break ←	 Measurement ends.
(gdb)
c17 profile ←	 Profiler window opens.

Notes

• In SIM mode, this command opens a profiler window. If the execution cycle count is 0, measurement results 
are not displayed. Measurement results are displayed if the execution cycle count is larger than 0.

• This command generates an error in ICD mode.
• If a profiler window is already open, executing this command will not open another window. Nor will it 

update the information displayed.
• If the profile function is disabled by the c17 profilemd command, a profiler window will open but will 

not display measurement results, even if measurement data exists.
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c17  coverage  (launching of coverage window) [SIM]

Operation

Opens a coverage window and displays coverage results. For detailed information on the coverage window, 
refer to Section 10.8, "Profiler and Coverage Functions."

Format

c17 coverage

Usage example

(gdb)
c17 rpf c17.par
(gdb)
file sample.elf
(gdb)
target sim
(gdb)
load
(gdb)
c17 rst
(gdb)
break _exit
(gdb)
cont ←	 Measurement starts.
Break ←	 Measurement ends.
(gdb)
c17 coverage ←	 Coverage window opens.

Notes

• In SIM mode, this command opens a coverage window. If the execution cycle count is 0, measurement results 
are not displayed. Measurement results are displayed if the execution cycle count is larger than 0.

• This command generates an error in ICD mode.
• If a coverage window is already open, executing this command will not open another window. Nor will it 

update the information displayed.
• If the profile function is disabled by the c17 profilemd command, a coverage window will open but will 

not display measurement results, even if measurement data exists.
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10.7.17  Other Commands

set  output-radix  (change of variable display format) [ICD Mini/SIM]

Operation

Changes the format of variables displayed in [Source] editor, [Expressions] view, and [Variables] view and by 
the print command.
Selectable formats are hexadecimal, decimal, and octal.
Note that the display format will not change if the variable has a floating decimal point or pointer.
The format changed is not stored when the debugger ends, and variables are displayed in the default format 
(decimal) when the GDB is started next.

Format

set output-radix Type

Type: Display format
 16 = Hexadecimal
 10 = Decimal (default)
 8 = Octal

Usage example

(gdb)
print i
$1 = -21846
(gdb)
set output-radix 16
(gdb)
print i
$2 = 0xaaaa
(gdb)
set output-radix 8
(gdb)
print i
$3 = 0125252

Notes

• The debugger will not display correctly if binary is set (set output-radix 2).
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c17  log  (logging) [ICD Mini / SIM]

Operation

Saves the entered commands and command execution results displayed in the [Console] view to a file. The 
contents displayed in the [Console] view are written directly to a log file unchanged. Moreover, the contents of 
commands not displayed in the [Console] view, but executed from menus or by other means, are also output to 
a log file.

Format

c17 log Filename (starts logging.)
c17 log   (completes logging.)

Filename: Name of log file 

Usage example

n Example 1
(gdb) 
c17 log log.txt
log on

The commands to be entered hereafter and execution results are output to log.txt in text format. 
Log output remains on until the c17 log command is subsequently executed.

n Example 2
(gdb) 
c17 log
log off

The log file is closed and log output terminated.

Notes

• If an existing file name is specified, the c17 log command overwrites the file.

• To change the destination of log output to another file, terminate log output temporarily and specify a new 
file name before restarting log output. 

• The c17 log command contained in the command file specified by startup option -x is only effective 
with the [Console] view open. Be careful not to close the [Console] view before executing the c17 log 
command, because no log files will be created.
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source  (execute command file) [ICD Mini / SIM]

Operation

Loads a command file and successively executes the debug commands written to the file.

Format

source Filename

Filename: Name of command file

Usage example

<File name = src.cmd>
# load symbol information
file /cygdrive/c/EPSON/gnu17/sample/tst/sample.elf
#connect to the debugger with specified mode and port
target sim
# load to memory
load /cygdrive/c/EPSON/gnu17/sample/tst/sample.elf
# reset
c17 rst

From # to the end of the line is interpreted as a comment.

(gdb) 
source src.cmd
(gdb) 
(gdb) 
file /cygdrive/c/EPSON/gnu17/sample/tst/sample.elf
(gdb) 
(gdb) 
target sim
boot () at boot.s:9
Connected to the simulator.
Current language:  auto; currently asm
(gdb) 
(gdb) 
load /cygdrive/c/EPSON/gnu17/sample/tst/sample.elf
Loading section .text, size 0xbc lma 0xc00000
Start address 0xc00000
Transfer rate: 1504 bits in <1 sec.
(gdb) 
(gdb) 
c17 rst
CPU resetting ...................... done 

A specified command file is loaded and the commands contained in it are executed successively. The 
commands are displayed in the [Console] view as shown in the example above.

Notes

• If the command file contains a description error, the debugger stops executing the command file there. 
Because no error messages appear in this case, be very careful when creating a command file.

• Source commands can be nested so that source commands exist in the command file. There are no restrictions 
on the number of nests.

• Command files do not support control commands for if statements.
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c17  clockmd (set execution counter mode)

c17  clock (display execution counter) [ICD Mini / SIM]

Operation

c17 clockmd: Sets mode of the execution counter. 

The counter can be set to cumulating mode (where measured values are cumulated until the counter is reset) or 
reset mode (where the counter is reset each time the program is run). 

c17 clock: Displays the results counted during program execution.

In ICD Mini mode, the ICD execution counter value is displayed as hours, minutes, seconds, milliseconds and 
microseconds. 
In simulator mode, the counter value is displayed as the number of cycles.

For details about the execution counter, see "Measuring the execution cycles/execution time" in Section 10.6.4, 
"Executing the Program".

Format

c17 clockmd Mode  (sets execution counter mode.)
c17 clock   (displays execution counter.)

Mode: Counter mode
 1   Reset mode
 2   Cumulating mode (default)

Usage example

n Example 1 (simulator mode)
(gdb) 
c17 clockmd 2
(gdb) 
c17 rst
CPU resetting ...................... done 
(gdb) 
continue
Continuing.

Breakpoint 1, sub (k=0) at main.c:20
(gdb) 
c17 clock
           218 cycle
(gdb) 
continue
Continuing.

Breakpoint 1, sub (k=1) at main.c:20
(gdb) 
c17 clock
           330 cycle

After setting in cumulating mode, the execution counter is reset by the reset command, thereby starting the 
program. In cumulating mode, the execution counter is not reset even when program execution is resumed after 
a break.
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n Example 2 (ICD Mini mode)
(gdb) 
c17 clockmd 1
(gdb) 
c17 rst
CPU resetting .................... done 
(gdb) 
continue

Breakpoint 1, sub (k=0) at main.c:20
(gdb) 
c17 clock
           0 hour 0 min 1 sec 23 ms 1.33 us
(gdb) 
continue
Continuing.

Breakpoint 1, sub (k=1) at main.c:20
(gdb) 
c17 clock
           0 hour 1 min 53 sec 0 ms 0 us

In this example, after setting in reset mode, the execution counter is reset by the reset command, thereby 
starting the program. In reset mode, the execution counter is reset when program execution resumes after a 
break. Therefore, counts in this mode differ from those in cumulating mode.

Notes

• In ICD Mini mode, the continue/until command must be executed before this command becomes 
effective.

 In simulator mode, this command is always effective.

• To get accurate measured values, the breakpoint does not set to the measurement start position.
 If the breakpoint set to the measurement start position, the execution time of the measurement start position 

is not measured.

• The c17 clock command cannot display execution times while the lapse of time break (c17 timebrk) 
is enabled. Disable the lapse of time break (c17 timebrk 0) to measure execution times.

• The execution counter is reset in the following cases:

1. When the c17 clockmd command changes execution counter mode (from cumulating mode to reset 
mode or vice versa)

2. When the program is started with the counter set to reset mode 

3. When the CPU is reset

4. When the c17 timebrk, step, stepi, next, nexti or finish command is executed in ICD 
Mini mode

• Restrictions for ICD Mini mode
1. The maximum measurable time is 6,515 hours.
2. Measurement display is not possible after step execution commands (e.g., step or next) and step 

return (finish).
3. Measurement may not be possible for very short execution times (under 3 microseconds).
4. Measurement results include the following tolerances, since they include the accuracy of 

the oscillator included in the ICD Mini and processing for entering/exiting debug mode. 
Measurement results = Actual time taken (±50 ppm) + debug mode enter/exit processing (approx. 40 
cycles)

• Restrictions in simulator mode
 The number of cycles measured in simulator mode includes tolerances of approximately 10% compared to 

the actual number of hardware cycles.
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target  (connect target) [ICD Mini / SIM]

Operation

Establishes connection to the target and sets connect mode.
ICD Mini mode: Connected with the ICD Mini (S5U1C17001H) or ICD board via a USB interface. 
Simulator mode: Debugger is set to simulator mode.

Format

target Type

Type: One of the following symbols that specify the target
icd usb: Connected with the ICD via a USB interface (in ICD Mini mode).
icd usb2: Connected with the ICD via a USB interface (in ICD Mini mode).

 This is used when debugging the target in an environment where a single PC and 
two ICD units are connected via USB. The debugger must be started up with the 
--c17_double_starting specified and use "target icd usb2" to connect the 

debugger. This allows you to start two debuggers with a single PC.
sim: Simulator started (in simulator mode).

Usage example

n Example 1
(gdb) 
target sim
Connected to the simulator.

The debugger is set to simulator mode.

n Example 2
(gdb) 
target icd usb

The debugger is set to ICD Mini mode.

Notes

When you set a memory map by loading a parameter file, be sure to execute the c17 rpf command before the 
target command. Also be sure to execute the target command before the load command, and the file 

command before the target command. The following shows the basic sequence of command execution: 
(gdb) 
file sample.elf (loads debugging information.)
(gdb) 
c17 rpf sample.par (sets map information.)
(gdb) 
target icd usb (this command)
(gdb) 
load (loads the program.)
(gdb) 
c17 rst (resets the CPU.)
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detach  (disconnect target) [ICD Mini / SIM]

Operation

Closes the port used to communicate with the target and exits the current connect mode.

Format

detach

Usage example

(gdb) 
target icd usb
  :
       Debug
  :
(gdb) 
detach

ICD Mini mode is exited.

Notes

This command can be used to turn the ICD off to switch between simulator mode and other modes, or perform 
operations on the target board. You need not execute this command to terminate debugging.
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pwd (display current directory)

cd (change current directory) [ICD Mini / SIM]

Operation

pwd: Displays the current directory.
cd: Changes the current directory. 

Format

pwd  (displays the current directory.)
cd Directory (changes the current directory.)

Directory: Character string used to specify a directory

Usage example

(gdb) 
pwd
Working directory /cygdrive/c/EPSON/gnu17/sample/tst.
(gdb) 
cd /cygdrive/c/EPSON/gnu17/sample/ansilib
Working directory /cygdrive/c/EPSON/gnu17/sample/ansilib.

After the current directory is confirmed, it is changed to "c:\EPSON\gnu17\sample\ansilib". 

Notes

A drive name must be specified in "/cygdrive/drive name/" format. Do not specify a drive name in "c:" 
format. Moreover, use a slash (/) instead of (\) to delimit directories.
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c17  firmupdate  (update firmware) [ICD Mini]

Operation

Updates the firmware written in the flash memory on the ICD. This command is effective after an ICD is 
connected. Therefore, the target command must be executed before this command can be used.
After the firmware has been updated, close gdb and turn the ICD off and on again.

Format

c17 firmupdate Filename

Filename: Name of firmware file (Motorola S3 format file)

Usage example

(gdb) 
target icd usb
(gdb) 
c17 firmupdate icd17dmt.sa

Loads the firmware file icd17dmt.sa and updates the ICD firmware with the loaded contents.

Notes

The c17 firmupdate command is effective only in ICD Mini mode.
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c17  ttbr  (set TTBR) [SIM]

Operation

Sets an address to TTBR.
When the reset command (c17 rst) is executed, the value (reset vector) that has been stored in the address 
represented by TTBR is set to the PC. This command has the same function as the TTBR line written in the 
parameter file.

Format

c17 ttbr Address

Address: Address to be set to TTBR (decimal, hexadecimal, or symbol)
Conditions: 0 ≤ Address ≤ 0xffff00 (The eight low-order bits of Address must be 0x00.)

Usage example

(gdb) 
c17 ttbr 0x8000 

Sets address 0x8000 to TTBR. 

Notes

• The c17 ttbr command can be used only in simulator mode.

• This command must be executed before the target command.
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c17  help  (help) [ICD Mini / SIM]

Operation

Displays a command description.

Format

c17 help [Command]
c17 help [GroupNo.]

Command: Name of command 
GroupNo.: Command group number 

Usage example

n Example 1
(gdb) 
c17 help
group  0: memory ...........  c17 fb,c17 fh,c17 fw,x /b,x /h,x /w,set {char},set 

{short},set {int},c17 mvb,c17 mvh,c17 mvw,c17 df,c17 
readmd,c17 loadmd 

group  1: register ......... info reg,set $ 
group  2: execution ........  continue,until,step,stepi,next,nexti,finish,c17 

callmd,c17 call 
group  3: CPU reset ........ c17 rst, c17 rstt 
group  4: interrupt ........ c17 int,c17 intclear,c17 int_load 
group  5: break ............  break,tbreak,hbreak,thbreak,delete,clear,enable, 

disable,ignore,info breakpoints,c17 timebrk,c17 
hbreakmd 

group  6: symbol ........... info locals,info var,print 
group  7: file ............. file,load
group  8: map .............. c17 rpf,c17 map,c17 memwait,c17 ttbr
group  9: flash memory ..... c17 fls,c17 fle 
group 10: trace ............ c17 tm 
group 11: simulated I/O .... c17 stdin,c17 stdout 
group 12: flash writer ..... c17 fwe,c17 fwlp,c17 fwld,c17 fwdc,c17 fwd 
group 13: others ...........  c17 log,source,c17 clockmd,c17 clock,c17 firmupdate,ta

rget,detach,set output-radix,pwd,cd,c17 help,quit
 Please type "c17 help 1" to show group 1 or type "c17 help c17 fb" to get usage of 
command "c17 fb".

When you omit parameters, a list of command groups is displayed.

n Example 2
(gdb) 
c17 help 2
group 2: execution
 continue           Execute continuously
 until              Execute continuously with temporary break
 step               Single-step every line
 stepi              Single-step every mnemonic
 next               Single-step with skip every line
 nexti              Single-step with skip every mnemonic
 finish             Quit function
 c17 callmd         Set user function call mode
 c17 call           Call user function
 Please type "c17 help continue" to get usage of command "continue".

When you specify a command group number, a list of commands belonging to that group is displayed.



S5U1C17001C MANUAl Seiko Epson Corporation 10-185
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

10
Debugger

n Example 3
(gdb) 
c17 help step
step: Single-step,every line                                  [ICD/SIM]

usage: step [Count]
       Count: Number of steps to execute (decimal or hexadecimal)
              One step is assumed if omitted.
       Conditions: 1-0x7fffffff

example:
(gdb)
step
(gdb)
step 10

When you specify a command, a detailed description of that command is displayed.

n Example 4
(gdb) 
c17 help c17 rst
c17 rst: Reset                                                [ICD/SIM]

usage: c17 rst

example:
(gdb)
c17 rst
The CPU is reset.

To display a C17 command, specify the command name including "c17".

Notes

• Executing the help command (that comes standard with gnu) instead of the c17 help command displays 
help for the command classes and commands set in the gnu debuggers. This debugger does not support all 
of these command classes or commands. Note that device operation cannot be guaranteed for commands not 
described in this manual. 

• A mode list (e.g. [ICD/SIM]) appears in the usage display (see Examples 3 and 4) indicating the modes in 
which the command is effective. 
ICD: The command can be used in ICD Mini mode (when the ICD Mini (S5U1C17001H) or ICD board is 

used)
SIM: The command can be used in simulator mode (when debugging with the PC alone)

 If "[ICD]" is displayed, it indicates that the command cannot be executed in modes other than ICD Mini 
mode.
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c17  chgclkmd  (clock source selection in break mode) [ICD Mini]

Operation

Selects whether to switch the clock to high-speed when switching to break mode.

Format

c17 chgclkmd [Mode]
Mode: 0 Switches to high-speed clock source (default)
  1 Does not switch to high-speed clock source
  Current mode is displayed if omitted.
  When Mode = 0: "The clock is changed."
  When Mode = 1: "The clock is not changed."

Usage example

<When target CPU is S1C17702>
(gdb)

 target icd usb

(gdb)

 load sample.elf

(gdb)

 c17 rst

(gdb)

 break main

(gdb)

 continue

　　Set to OSC1 in target program
　　Break occurs for main   ・・・Switch to HSCLK with mode "0"
(gdb)

 finish     ・・・Switch to OSC1

　　finish end    ・・・Switch to HSCLK
(gdb)

 c17 chgclkmd 1

(gdb)

 break usb

(gdb)

 continue    ・・・Continue with HSCLK as in Mode = 1

　　Sub break with function  ・・・Do not switch clock as in Mode = 1
(gdb)

 x /w 0x100

(gdb) 

Notes

• Clock source switching is not possible with step/stepi commands or next/nexti commands other 
than function calls. In this case, the clock will not be switched.

• When Mode = 0, the clock may not be switched correctly in the following cases:
 1. Overwriting clock control and clock source registers during break
 2. Breaking while switching target program clock
 3. Step running the target program clock switching section
 In the cases described above, set Mode = 1.
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quit  (quit debugger) [ICD Mini / SIM]

Operation

Terminates the debugger.
Any ports or files used by the debugger that remain open are closed. 

Format

quit

q  (abbreviated form)

Usage example

(gdb) 
q
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10.8  Profiler and Coverage functions
The main purpose of the profiler and coverage functions is to detect sections of programs (such as functions) that 
cause bottlenecks and impair performance. The profiler and coverage functions are available only in simulator 
mode.

10.8.1  Overview of functions

The profiler and coverage functions can be categorized into the following two groups.

(1) Measurement using simulator in GDB
 Profile measurement  : Measures the number of cycles consumed by each function and the number of 

executions.
 Code coverage measurement : Records whether each command was executed.
 Measurement range  : From Reset + Go to Break (excluding breaks in simulated I/O)

(2) Display of measurement data
 The two tools, profiler result display executable file and coverage result display executable file, display 

measurement data.

[1] Profiler result display tool
 This Windows application offers functions for displaying and saving measurement data (described in (1)) 

and for comparing data and showing comparison results.
 To execute this tool, run the gdb "c17 profile" command, click the the [Profile] button in [Debug] 

view, or select [Profile] from the Context menu.

 Executable filename gnuProf.exe
 Input file  Profiler measurement data file (*.prf)
    Storage file for profiler measurement data file paths (c17_profile_path.gdb)
 Output file  Profiler measurement data file (*.prf)
    Display result text file (*.txt, *.csv)

[2] Coverage result display tool
 This Windows application offers functions for displaying, saving, and merging measurement data (described 

in (1)).
 To execute this tool, run the gdb "c17 coverage" command, click the [Coverage] button in [Debug] 

view, or select [Coverage] from the Context menu.

 Executable filename gnuCvrg.exe
 Input file  Profiler measurement data file (*.prf)
    Storage file for profiler measurement data file paths (c17_profile_path.gdb)
 Output file  Profiler measurement data file (*.prf)
    Display result text file (*.txt, *.csv)

* Although the above tools are Windows applications, they are not designed for stand-alone operation. Note that 
complete compatibility is not guaranteed under standalone operating conditions.

* A profiler measurement data file includes all profiler and coverage measurement information and is used by the 
above two windows.
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10.8.2  list of functions

The following table lists the main functions.
Table 10.8.2.1  List of functions

Major classification Intermediate classification Minor classification

Measurement data 
acquisition

Measuring process You can specify whether to obtain measurement data 
during user program execution.
(c17 profilemd)
Obtains measurement data during user program 
execution.

Profile command
(c17 profile)

Saves measurement data to a file.

Opens a profiler window.

Coverage command
(c17 coverage)

Saves measurement data to a file.

Opens a coverage window.

Measurement data 
display

Profiler window Displays the number of cycles, excluding those 
corresponding to functions and their child functions.
Displays the number of cycles, including those 
corresponding to functions and their child functions.
Compares two measurement results and displays 
the differences in cycle count and code size for each 
function.
Sorts and displays specified items.

Reads out a profiler measurement data file.

Saves the profiler measurement data file.

Saves display results to a file (text or csv format).

Coverage window Displays the code coverage for each function.

Displays the code coverage for each address.

Sorts and displays specified items.

Reads out a profiler measurement data file.

Saves the profiler measurement data file.

Saves display results to a file (test or csv format).

Merges the current data with the coverage result most 
recently saved and displays the merged results.
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10.8.3  Detailed Description of functions

10.8.3.1  Profiler window
Use the "c17 profile" command, [Profile] button in [Debug] view, or [Profile] in the Context menu to open a 
profiler window. The profiler window displays measurement data, if any. If no measurement data is found, the error 
message "No profiling data" is displayed. In this case, you can open a profile window (no data display) by clicking 
the [OK] button. The profiler window closes when GDB ends.

Comparison result state: When the list shows comparison results, this section 
indicates "COMPARISON RESULT." (Otherwise, this section is blank.)

Profiler window
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Displayed items
Name : Function name (256 characters max.)
  Static functions are indicated in the following format: function name@filename.
  The "***TOTAL***" in the last line indicates the total number.
Total cycle : Total number of function execution cycles (decimal value) (32-bit length max.)
Ratio (%) : Ratio of function execution cycles (Total cycle ÷ Sum of total cycles, unit: %, up to the 

second decimal place displayed)
Call : Number of function callouts (decimal value, 32-bit length max.)
Average cycle : Average execution cycles per function (Total cycle ÷ Call, decimal value, 32-bit length max.)
Size : Size of command executed within function (unit: bytes, decimal value, 24-bit length max.)

• Click an item name to sort. By default, items are sorted and displayed in the order of highest Ratio (%) to lowest 
Ratio (%). Clicking an item name toggles the ascending/descending order indication.

• If no measurement data is found when the profile window launches or if an error is generated, the window will 
not display any data.

• Functions that have not been executed are also displayed.
• After comparison results are displayed, loading another file using the [Load Profile] button or changing the [Include 

Cycle of child function] checkbox status will display the data prior to the comparison.

[Include Cycle of child function]:
Selecting this checkbox displays the number of cycles, including those corresponding to child functions.
Deselecting this checkbox displays the number of cycles, excluding those corresponding to child functions. (default)

[load Profile] button:
Opens the file dialog box and loads a profiler measurement data file.

[Save Profile] button:
Opens the file dialog box and saves profile information to a profiler measurement data file.
Even if the information after comparison is displayed, this will save the data originally loaded.

[Save Result] button:
Opens the file dialog box and stores the displayed data.
Data can be stored in text file format (default) or csv file format.

[Reload] button:
If the window currently displays comparison results, click this button to return the display to the one in place 
immediately after the window was launched or after data was loaded.

[Compare] button:
Compares the currently displayed profile information and saved profile information. Open the file dialog box and 
specify the profiler measurement data file to be compared. The comparison results are displayed based on "Include 
Cycle of child function" settings. The following comparative calculation processes are performed.

（1） If the comparison target includes the displayed function name, the comparison result will be displayed.
 Displayed result is as follows: displayed value － value of specified file.
(2) If the displayed function name is not in the comparison target, it is a newly added function. The function line 

will be added and "displayed value" displayed.
(3) If the function exists only in the comparison target (i.e., the function has been deleted), "0 － value of specified 

file" is displayed.
(4) In the TOTAL section, "TOTAL of displayed value － TOTAL of value of specified file" is displayed.

Meaning of displayed value
Positive value : Increase = Change for worse
Negative value : Decrease = Improvement
0  : No change
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This is because correcting the source can add or delete a function in certain cases.

Table 10.8.3.1.1  Example of comparison result

Displayed function
Function to be 

compared
Displayed function Value Case

A B’ A A //(2)
B C’ B B－B’ //(1)
C D’ C C－C’ //(1)
E E’ E E－E’ //(1)

D ０－D’ //(3)

< format of text file created by Save Result button >

(1) Example of output generated when "text" is selected
----------------------------------------------------------------------------

Profile result

Total cycle  Ratio(%)        Call  Average cycle        Size  Name

         17    10.43            1          17.00          40  boot

         51    31.29            1          51.00          44  main

         23    14.11            1          23.00          40  sub @ main.c

         27    16.56            1          27.00          38  sub2 @ main.c

         45    27.61            3          15.00          30  sub3 @ main.c

          0     0.00            0           0.00          30  sub4 @ main.c

        163   100.00            7                        222  *** TOTAL ***

----------------------------------------------------------------------------

(2) Example of output generated when "csv" is selected
----------------------------------------------------------------------------

Total cycle,Ratio(%),Call,Average cycle,Size,Name

         0,   1.54,         0,        0.00,         0, boot

         0,   4.63,         0,        0.00,         0, main

         0,   2.09,         0,        0.00,         0, sub @ main.c

        -6,  -1.78,         0,       -6.00,        -4, sub2 @ main.c

       -15,  -6.48,        -1,        0.00,         0, sub3 @ main.c

         0,   0.00,         0,        0.00,         0, sub4 @ main.c

       -21,       ,        -1,            ,         -4, *** TOTAL ***

----------------------------------------------------------------------------
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10.8.3.2  Coverage Window
Use the "c17 coverage" command, [Coverage] button in [Debug] view, or [Coverage] in the Context menu 
to open a coverage window. The coverage window displays measurement data, if any. If no measurement data is 
found, the error message "No profiling data," is displayed. In this case, you can open a coverage window (no data 
display) by clicking the [OK] button. The coverage window closes when the GDB ends.

Merging result state: When the list shows merging results, this section indicates "MERGING 

RESULT." (Otherwise, this section is blank.)

Function coverage display section Address coverage display section

Coverage window
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Displayed items
Function coverage display section
 Name : Function name (256 characters max.)
   The "***TOTAL***" in the last line indicates the total number.
 Fetched cycle : Size of code fetched inside function (unit: bytes, decimal value, 24-bit length max.)
 Size : Size of function (unit: bytes, decimal value, 24-bit length max.)

Ratio (%) : Ratio of "Fetched" in function (Fetched ÷ Size, unit: %, up to the second decimal place 
displayed)

 Start : Start address of function (hexadecimal value, 0 to FFFFFF)
 End : End address of function (hexadecimal value, 0 to FFFFFF)

・ Click an item name to sort. Clicking an item name toggles the ascending/descending order indication. By default, 
items are sorted and displayed in ascending order of the "Start" item.

・ Functions that have not been executed are also displayed.

Address coverage display area
 Address : Range of executed addresses (hexadecimal value, 0 to FFFFFF)
 Count : Number of executions (decimal value, 31-bit length max.)

[load Profile] button:
Opens the file dialog box and loads a profiler measurement data file.

[Save Profile] button:
Opens the file dialog box and saves profile information to a profiler measurement data file.
Even if the information after merging is displayed, this will save the data originally loaded.

[Save Result] button:
Opens the file dialog box and stores the displayed data.
Data can be stored in text file format (default) or csv file format.

[Reload] button:
If the window currently displays merging results, click this button to return the display to the one in place 
immediately after the window was launched or after data was loaded.

[Merge] button:
Merges the currently displayed coverage information with saved coverage information. Open the file dialog box 
and specify the profiler measurement data file to be merged. The following merging results are displayed.

(1) Function coverage display section
 Displays results sorted in alphabetical order of function start address (default).
 Function name : No change
 Fetched : The count is incremented if the fetched address is different.
 Size : No change
 Ratio : Recalculation
 Start, End : No change
 An error is generated if the total number of functions and all function names fail to match at the merge 

destination. Even if they match, an error is still generated if the Start and End addresses of all functions fail 
to match. (Note that data obtained after a change in the program cannot be merged.)

(2) Address coverage display section
 Updates the address range and count of merged results and displays in alphabetical order (fixed) of address.
 Address : Displays the range of addresses additionally fetched.
 Count : Updates the value if the address is the same and the merged value is larger.
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< format of text file created by Save Result button >

（1）When "text" is selected
----------------------------------------------------------------------------

Function Coverage result

Fetched           Size  Ratio(%)  Start   End     Name

        28          40    70.00   000604  00062C  boot

        44          44   100.00   00062C  000658  main

        40          40   100.00   000658  000680  sub @ main.c

        38          38   100.00   000680  0006A6  sub2 @ main.c

        30          30   100.00   0006A6  0006C4  sub3 @ main.c

       180         192    93.75                   *** TOTAL ***

Address Coverage result

Address             Count

000604-00061F           1

00062C-0006A5           1

0006A6-0006C3           3

----------------------------------------------------------------------------

（2） When "csv" is selected
----------------------------------------------------------------------------

Function Coverage result

Fetched,Size,Ratio(%),Start,End,Name

        28,        40, 70.00,0x000604,0x00062C,boot

        44,        44,100.00,0x00062C,0x000658,main

        40,        40,100.00,0x000658,0x000680,sub @ main.c

        38,        38,100.00,0x000680,0x0006A6,sub2 @ main.c

        30,        30,100.00,0x0006A6,0x0006C4,sub3 @ main.c

       180,       192, 93.75,,,*** TOTAL ***

Address Coverage result

Address,Count

0x000604-0x00061F,         1

0x00062C-0x0006A5,         1

0x0006A6-0x0006C3,         3

----------------------------------------------------------------------------
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10.8.3.3  Error Messages Displayed by Profile Window and Coverage Window
Errors are displayed in the message box (provided with an [OK] button).
Measurement results are not displayed after you click the [OK] button.
An error is displayed at the time a window is opened or a profiler measurement data file is loaded.

Table 10.8.3.3.1  Error messages

Message Description
No profiling data. The profiler measurement data file cannot be found.
This file is not profiler format. The size of the specified profiler measurement data file is 0.
This file is not C17 architecture. The specified file is not for C17. The ID is not "C17PROF."
not enough memory. Adequate memory area could not be secured in the PC.
Version mismatch. The version of the profiler measurement data file is not 

supported. The tool version differs from the version used to 
create the measurement data.

Program called too many functions. The program called more than 10,000 different functions.
Program called too deep functions. The program made more than 10,000 deep calls as viewed from 

the top function.
Cycle counter was overflowed. The cycle counter exceeded 32 bits.
Function address were overlapped An overlap in function address occurred.
unexpected error occured in GDB. Measurement was not conducted properly. Restrictions may 

have been violated (e.g., there is no assembler source type 
declaration; refer to Section 10.8.8.4, "Restrictions.")

Merging mismatch (Function name) The function names and the number of functions at the merge 
source and merge destination failed to match.

Merging mismatch (Start or End address) The starting addresses and ending addresses at the merge 
source and merge destination failed to match.
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10.8.3.4  Restrictions
The following shows the restrictions for measurements.

・ Valid profiles cannot be obtained if the function name labels in assembler sources do not also have stab 
information using ".type."

 Example) .type sub, @function
 This is also required when creating a library.
 * The above is not necessary for C sources because the C compiler automatically outputs ".type" statements.

・ Valid profiles cannot be obtained if the program counter (% PC) is forcibly changed using "set $pc = XXX" or 
similar means while the program is in break mode.

・ Valid profiles cannot be obtained if a measurement is interrupted̶for example, executing the "c17 pro-
filemd 0" command while the program is in break mode, executing the program again, and then executing the 

program once more after executing the "c17 profilemd 1" command in break mode.

・The measurement range can be from RESET (boot address) to the address at which a break occurs.
 It is not possible to perform measurements in a range from a specific address to the address at which a break 

occurs. However, measurement will continue until the subsequent break even if "Go" is executed again without 
changing "%PC" after a break.

・ A profile cannot be obtained from a program that transfers a program or function dynamically from the ROM 
area to the RAM area and executes it (e.g., programs in which ".text" sessions are linked as LMA ≠ VMA).

・ A profile cannot be obtained if a program has more than 10,000 functions and made more than 10,000 calls.

・ A profile cannot be obtained if a program made more than 10,000 deep calls as viewed from RESET (boot 
address).

・ Static functions without debug information (without assembler －gstabs option or compiler －gstabs option) 
cannot be displayed in the form of "function name + @ + filename"; the filename section will not be displayed.
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10.9  Parameter files
Parameter files are text files in which memory map information of the target system is written. The debugger reads 
this file to create memory map information, based on which it performs the following processing: 
•  Checks whether software PC break addresses are within a valid mapped area
•  Breaks at write operation to ROM area (only in simulator mode)
•  Breaks at accessing undefined areas (only in simulator mode) 
•  Breaks when stack overflows (only in simulator mode)
•  Refers TTBR at reset.
•  CPU model (ICD mode only)

When a parameter file is loaded, the appropriate size of storage (required for all areas of memory written to the file) 
is reserved in internal memory of your computer.

How to load a parameter file
 A parameter file is loaded in the debugger by executing the c17 rpf command. 

(gdb) 
c17 rpf Filename.par  (loads a parameter file to set a memory map.)

 The IDE may be used to create a special command file, like the one loaded when the debugger starts. For 
details about IDE, see Chapter 5, "GNU17 IDE".

 Be sure to execute the c17 rpf command before the target and load commands. The following shows 
the basic sequence of command execution: 
(gdb) 
file sample.elf (loads debugging information.)
(gdb) 
c17 rpf sample.par (sets map information.)
(gdb) 
target sim (connects the target.)
(gdb) 
load (loads the program.)
(gdb) 
c17 rst (resets the CPU.)

How to create a parameter file
 You can create parameter files by selecting [GNU17 Parameter Settings] from the [Properties] dialog box of the 

IDE. For details about IDE, see Chapter 5, "GNU17 IDE". Because parameter files are text files, you can use a 
general-purpose editor to create and correct parameter files.

Note: Do not use non-ASCII (Japanese, etc.) characters for file names (including extensions) and text in 
a file.

Contents of parameter file 
 The following shows an example of a parameter file.

#gnu17 gdb parameter file    (1)
CHIP S1C17701     (2)
ESSIM S1C17701     (3)

RAM 000000 001fff 00W    #IRAM  (4)
IO 040000 04ffff 00H    #IO
RAM 600000 6fffff 11H    #RAM
ROM c00000 cfffff 55B  B #ROM
STACK  000000 001fff        #STACK  (5)

(1) Comment
 From # to the end of the line is interpreted as a comment.
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(2) CHIP CPU name
 Specify when setting the clock source to high-speed for break mode in ICD mode.
 The clock will not be switched if this is omitted.

(3) Target model
 This parameter specifies the target model to simulate with the ES-Sim 17.

(4) Memory map information
 Each line is comprised as follows:

  Device  StartAddr  EndAddr  [Condition]  [BigEndian]  [#Comment]

Device: Specify the type of memory by using one of the following symbols:
 ROM Write-only memory area
 RAM Readable/writable memory area
 IO Peripheral circuit control memory area

StartAddr: Specify the start address of the area.
 The address must be specified in hexadecimal, but need not be preceded by 0x.

EndAddr: Specify the end address of the area.
 The address must be specified in hexadecimal, but need not be preceded by 0x.

Condition: Specify wait cycles and a device size as shown below.
 <Wait cycles for read><Wait cycles for write><Device size>
 Wait cycles: 0 to f 0 to 15 cycles
 Device size: B 8 bits
  H 16 bits
  W 32 bits

 For example, assume a 16-bit device with one wait cycle for read and two wait cycles for write. 
In this case, specify 12H. 

 This parameter is only effective in simulator mode, and may be omitted. When this entry is 
omitted, this parameter is processed as 77H.

BigEndian: For big endian devices, specify B.
 This parameter is only effective in simulator mode. However, internal ROM, RAM, and I/O 

cannot be set to big endian format. When this entry is omitted, this parameter is processed as 
little endian. In ICD Mini mode, this parameter is ignored. 

#Comment: A comment beginning with a # can be described in each line. However, required parameters 
must be described before writing a comment. 

Notes: • Items Device, StartAddr, and EndAddr in memory map information cannot be omitted. 

 • If duplicate memory areas are specified, only the first area specified is effective.
  RAM   600000 6fffff 11H   #RAM Effective 
  ROM   600000 6fffff 22H   #ROM Ignored
  IO    600000 7fffff 33H   #I/O 0x700000 through 0x7fffff effective as IO area

 • The area size in the memory map should be specified with 256MB or less per area. Setting a 
larger size causes the debugger to fail the memory allocation during starting up.
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(5) Stack area information
 Specify the area to be used as a stack in the format shown below.

 STACK  StartAddr  EndAddr

StartAddr: Specify the start address of the area.
 The address must be specified in hexadecimal, but need not be preceded by 0x.
EndAddr: Specify the end address of the area.
 The address must be specified in hexadecimal, but need not be preceded by 0x.

 This setting is effective in simulator mode, and causes a break to occur when the stack overflows.
 In no case will this setting affect SP operation by a program.

When not loading a parameter file
 Parameter files are not always needed for debugging. You can perform debugging with any parameter file 

loaded in the debugger. In this case, however, the following limitations apply:

In simulator mode
• If the target sim command is executed without executing the c17 rpf command, the simulation 

memory is reserved assuming that the RAM is mapped to the area from address 0x0 to address 0xffffff (16MB). 
In this case, the initial value of memory is 0x00. The TTBR address is set to 0x8000.

• The following map breaks do not work:
 1. Break by write operation to ROM area
 2. Access to an undefined area
 3. Stack overflow

• Counts of the execution counter and the number of clocks in trace information do not indicate the correct 
values.
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10.10  Status and Error Messages

10.10.1  Status Messages

When the target program breaks, one of the following messages is displayed, indicating the cause of the break 
immediately before entering the command input wait state.

Table 10.10.1.1  Status messages
Message Description

Breakpoint #, function at file:line Made to break at a set breakpoint
Break by accessing no map. Made to break by accessing unmapped area in simulator mode
Break by writing ROM area. Made to break by accessing read-only area in simulator mode
Break by stack overflow. Made to break by stack overflow in simulator mode
Illegal instruction. Made to break by executing invalid instruction in simulator mode
Illegal delayed instruction. Made to break by executing invalid delayed instruction in 

simulator mode
Break by key break. Forcibly made to break by [Suspend] button (in simulator mode)
Break by key break. Program received signal 
SIGINT, Interrupt.

Forcibly made to break by [Suspend] button (in ICD Mini mode)

10.10.2  Error Messages

Table 10.10.2.1  Error messages (in alphabetical order)
Message Description

· · · gdb : unrecognized option 'option' An illegal startup option is specified.
A setup of a serial port was not completed. An ICD mode not supported in gdb is specified.
Address is 24bit over. The specified address is out of the 24-bit range. The maximum 

S1C17 address size is 24 bits (0xffffff).
Address(0x#) is ext or delayed instruction. The specified address cannot be set due to an ext or delayed 

instruction.
C17 command error, command is not supported at 
present mode.

The input command cannot be executed in the current connect 
mode (ICD Mini or simulator mode).

C17 command error, command is not supported in 
ICDmini hardware Ver xx.

Not supported for ICDmini hardware version xx.

C17 command error, command is not supported in 
ICDmini firmware Ver xx.

Not supported for ICDmini firmware version xx.

C17 command error, command is too long. The input command exceeds 256 characters in length.
C17 command error, invalid command. The command is erroneous.
C17 command error, invalid parameter. The command is specified with an invalid parameter.
C17 command error, no map area. The address for the specified command argument falls beyond 

the address range specified by the parameter file.
C17 command error, number of parameter. The number of command parameters is incorrect.
C17 command error, start address > end address. The specified start address is greater than the end address.
Cannot access memory. The specified address cannot be accessed.
Cannot allocate memory. The necessary size of memory area as specified by a parameter 

could not be reserved.
Cannot clear hard pc break(0x#). The specified hardware PC break address is invalid; no 

breakpoints are set there.
Cannot clear soft pc break(0x#). The specified software PC break address is invalid; no 

breakpoints are set there.
Cannot display clock counter.
Now Timer break mode is on.
Please timer break mode off.

The execution counter value cannot be displayed when the 
lapse of time break is enabled. Disable the lapse of time break 
before execution times can be measured.

Cannot display clock counter.
Time measurement should use continue or until 
command.

The execution counter value cannot be displayed if the con-
tinue or until command has not been executed.

Cannot load to no map memory. (0x#-0x#) Cannot load a file to an area beyond the address range 
specified by the parameter file.

Cannot measure clock timer. The program execution time cannot be measured as it is too 
short.
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Message Description

Cannot open file(file). Cannot open the file.
Cannot open ICD17 usb driver. Failed to open the USB drive.
Cannot set hard pc break. Cannot set a hard break at the address specified.
Cannot set hard pc break any more. The number of hardware PC breakpoints set exceeds the limit 

(one location only).
Cannot set soft pc break. Cannot set a soft break at the address specified.
Cannot set soft pc break any more. The number of software PC breakpoints set exceeds the limit (up 

to 200).
Cannot set soft pc break at ROM area. Cannot write to read-only memory.
Cannot set at same breakpoint address. A break has already been set at the address specified.
Cannot set timer. 
Timer Conditions: 1<=Timer<=300000

Cannot set a lapse of time break as the specified time exceeds 
the valid range.

Cannot write file. Cannot write to the file.
Clock timer overflow. The counter overflows during clock measurement.
Communication error(bcc). A BCC error occurred in the message received from ICD.
Communication system error(#). Connection was severed while communicating with ICD.
Copy end address max(0x#) overflow. The end address of the source to be copied exceeds the upper 

limit (0xffffff).
Copy start address max(0x#) overflow. The start address of the source to be copied exceeds the upper 

limit (0xffffff).
Coverage Window is already opened. A coverage window is open.
CPU is running. Cannot accept a command while the CPU is running.
Erase entry address max(0x#) overflow. The flash erase routine address exceeds the upper limit (0xffffff).
Flash memory end address max(0x#) overflow. The flash memory end address exceeds the upper limit (0xffffff).
Flash memory start address max(0x#) overflow. The flash memory start address exceeds the upper limit (0xffffff).
ICD17 is busy(#). ICD is in a busy state.
Illegal instruction. An attempt was made to execute an undefined instruction in 

simulator mode.
Initialization error of ICD17. Failed to initialize the target.
Invalid ID error(0x#). The gdb has transmit an invalid ID number. (Internal error)
Invalid format event file (#). Format error for the event file specified by c17 int_load (interrupt 

event command)
Invalid parameter file(#: file). The parameter file contains an error.
Invalid parameter file, start address > end 
address(#: file).

The start and end addresses set in the parameter file are invalid 
because the former is greater than the latter.

It is not c17 architecture ELF file. The file specified with the file command is not an elf format 
file supported in S5U1C17001C.

Load end address max(0x#) overflow. The end address of the program to be written to flash memory 
exceeds the upper limit (0xffffff).

Load motorola file format error.(file) The specified Motorola file contains a format error.
Load size limit(0x#) overflow. The size of the specified file exceeds the upper limit.

• Flash write/erase program 8K bytes - 1 byte (0x1fff)
• Write data for flash memory 3M bytes - 1 byte (0x2fffff)
• Firmware 8M bytes - 1 byte (0x7fffff)

Load start address max(0x#) overflow. The start address of the program to be written to flash memory 
exceeds the upper limit (0xffffff).

Profiler Window is already opened. A profiler window is open.
Receiving message is inaccurate. A message exceeding the maximum size was received during 

communication with ICD.
Script file error: IF nest max(5) over. The number of nested if statements exceeds five in the script 

file (*.Spt).
Script file format error. (Line no.#) Format error for line number # in the script file (*.Spt).

Send Size entry address is out of limit (# - #). The data size sent per packet to the ICD falls beyond the valid 
range.

Specification is required in the device for connecting. The device name for ICD selection in the target command 
must be specified correctly.

Specified voltage cannot be output. The specified voltage could not be output.
Specified voltage is out of range (6.0V – 8.0V). The specified voltage falls outside the range.
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Message Description

Target down. A communication error has occurred between the ICD and the 
target.

There is no argument given to this command. Failed to disconnect the target.
Too much event(#). The number of events specified with the c17 int_load (event 

file read) command exceeds the upper limit (256).
Transmitting failure(#). NAK was received from ICD during communication with ICD.
USB communication error(host->ICD17). Failed in USB transmission to ICD.
USB communication error(ICD17->host). Failed in USB receiving from ICD.
Write entry address max(0x#) overflow. The address of the flash write routine exceeds the upper limit 

(0xffffff).

ICD denotes the ICD Mini (S5U1C17001H) or ICD board.
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10.11  Embedded System Simulator (ES-Sim17)
The embedded system simulator (ES-Sim17) provides a feature to simulate the S1C17 hardware in a PC. It runs 
with simulator mode in the debugger gdb allowing practical debugging for application systems using a PC only.
The features of the ES-Sim17 are as follows:
1. Indicates general-purpose port outputs status and simulates general-purpose port inputs.
2. Sets supply voltage level to evaluate the SVD operation.
3. Simulates LCD panel display by the LCD driver built into a target model.
 * The number of ports and whether with or without SVD will be determined by the model.

The [ES-Sim] window shown below is used for all operations and display.

  Control window select tab    Control window

LCD window

[ES-Sim] window (sample for S1C17701)

The ES-Sim17 can simulate operations with the OSC1 clock in real time. For operations with the OSC3 clock, 
refer to "simulator_readme.txt".

Note: The ES-Sim17 is a simulator that runs on a PC, therefore, it has some restrictions. Refer to 
Section 10.11.8, "Restrictions", and "simulator_readme.txt".
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10.11.1  Input/Output files

essim17.inifile.par

CPU configuration file

essim17_user.ini

User setting file

file.lcd
LCD panel
setting file

file.bmp

LCD capture bitmap file

Parameter file

LCD panel Tool

LCDUtil17

Embedded system simulator

ES-Sim17

Debugger

gdb

Figure 10.11.1.1  Input/output files 

Input files
 Parameter file

File format: Text file
File name: <filename>.par
Description: This file has recorded in it the contents needed to set the memory map information for the 

debugger. (See Section 10.9, "Parameter Files".
 The ES-Sim17 obtains the target model name to be simulated from the parameter file that has 

been read in the debugger.

 CPU configuration file
File format: Text file
File name: essim17.ini (fixed)
Description: This is the file created in the project folder if you selected a CPU model compatible with ES-

Sim17 when creating the project. This file contains the hardware configuration for the target 
model to be simulated in the ES-Sim17.

Note: Do not modify this file, as the ES-Sim17 may not run normally.

 User setting file
File format: Text file
File name: essim17_user.ini (fixed)
Description: This file contains the values that can be configured by the user.
 The following settings are possible.

・ OSC1 and OSC3 clock frequency Indicate in Hz.
・ LCD file path  Set to "blank" if there is no LCD file. This can also 

be set from the ES-Sim window.
 Example: ;;UserSetting The line beginning with ';' is regarded as a comment. 
  ;oscillator clock [Hz]

  [osc] CSC clock setting field
  osc1=32768 OSC1 clock frequency = 32.678 kHz
  osc3=4000000 OSC3 clock frequency = 4 MHz
  ;lcd file path

  [LCD FILE PATH] LCD file path setting field
  path=C:\EPSON\GNU17\tools\LcdUtil17\sample_lcd\SVT17701.lcd 

  LCD file path
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 lCD panel setting file
File format: Binary file
File name: <filename>.lcd
Description: This is an LCD panel setting file for ES-Sim17 created by LcdUtil17.
 ES-Sim17 can simulate dot-matrix and segment LCDs.

Output file
 lCD screen-capture bitmap file

File format: Bitmap file
File name: <filename>.bmp
Description: This is a bitmap file that contains an LCD screen image simulated and can be generated by the 

ES-Sim17.
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10.11.2  Starting and Terminating ES-Sim17

Starting up ES-Sim17
 The debugger launches the ES-Sim17 when the following two conditions are met:

1. The parameter file read in the debugger has the comment below. 
 ESSIM <model name>

 Example: ESSIM S1C17701

 When the parameter file is created by the IDE, this comment is written to it according to the target 
processor selected.

2. The target sim command (to set the debugger in simulator mode) is executed. 

 When the ES-Sim17 starts up, the [ES-Sim] window appears. 

Terminating ES-Sim17
 The ES-Sim17 terminates in the following two cases: 

1. When the detach command is executed in the debugger

2. When the debugger is terminated

Opening/closing the [ES-Sim] window
 The [ES-Sim] window can be closed by clicking the [Close] button. (This operation does not terminate the ES-

Sim17.)
 To reopen the window, execute \essim17\EssWnd.exe. Note, however, that the ES-Sim17 must be running at 

that point. If the ES-Sim17 has already terminated, execute the target sim command again.
 The [ES-Sim] window cannot be opened twice. If you attempt to open the window when it is already opened, 

the [ES-Sim] window moves to the foreground but a new window does not appear.
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10.11.3  Menus

[file] menu

[Load lcd file]
 Open an LCD file (.lcd) created in LCDUtil17.
 For information on LCDUtil17 and LCD files, see Section 11.11, "LCDUtil17 (LCD 

Panel Customizing Tool)."

[Help] menu

[About EssWnd]
 Shows ES-Sim Window version information.
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10.11.4  Simulating I/O Ports

The [ES-Sim] window allows control of the input status for the ports that have been set for general-purpose input. 
It also provides indicators to monitor the output status for the ports that have been set for general-purpose output.

Port data control window
 Click on a control window select tab to select the port group (P0x, P1x, P2x, P3x) you want to operate or 

display.

Port data button

   Simultaneous input ports select check box Simultaneous input button

Port data control window (P0x port)

 The ES-Sim17 obtains the information, such as selected I/O port functions and I/O directions, from the 
emulation memory in the PC to determine the port configuration to be displayed in the port data control 
window.

 The port data buttons and simultaneous input ports select check boxes for the ports configured as general-
purpose input becomes effective and are used to set input levels. When you change the input level in the 
window, the ES-Sim17 updates the input data register in the emulation memory through the debugger.

 The port data buttons and simultaneous input ports select check boxes for the ports configured as a general-
purpose output are grayed out to disable operations. However, the port data buttons indicate the current output 
status. When the output data register for the port configured as a general-purpose output is altered by the 
program, its status is reflected to the port data button.

 The port data buttons and simultaneous input ports select check boxes for the ports configured to an internal 
peripheral input/output are not displayed.

 The port data buttons and simultaneous input ports select check boxes for the ports that do not exist in the target 
model are not displayed.

Setting the port input status
 Select either High or Low port data button. This determines the current port input level.

  P00 input = High P01 input = Low



10-210 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

10  DEBUggER

Simultaneous multiple key inputs
 To simulate an operation press two or more keys simultaneously, first select the simultaneous input ports select 

check boxes for those ports. Then click the simultaneous input button. The port input levels are reversed from 
the status set with the port data buttons.

  (1) Select the ports used for simultaneous input.  (2) Click the button to reverse the input levels.

 This operation affects ports not contained in the tab page being currently displayed. The simultaneous input 
button located in any page reverses all the ports that have been selected with the simultaneous input ports select 
check boxes regardless of whether its tab page is displayed or not.

 Even if multiple ports are selected with the simultaneous input ports select check boxes, the port data button 
can be used to control each port individually.

Port output status
 When a port changes its output level by executing the program in the debugger, the output status is reflected to 

the display of the port data button immediately.
 The port data button for the ports configured as a general-purpose output cannot be operated using the mouse.

P0 port key entry reset
 If the target model supports the P0 port key entry reset function, the CPU can be reset by entering the 

active level signals to the ports specified with software. To evaluate this function, use the same way as the 
simultaneous multiple key inputs described above.

Port input interrupts
 Changing the input status by an operation in the port data control window can generate a port input interrupt.
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10.11.5  Simulating SVD

The [ES-Sim] window allows control of the supply voltage level for evaluating the SVD operation.

SVD control window
 Click on the SVD control window select tab to display the SVD control window.

    Current voltage level Voltage level setting buttons

Voltage indicator bar 

SVD control window

 The SVD control window is initialized with voltage level 15 (maximum level).

Setting voltage level
 The voltage level can be set within 16 steps* from 0 (low) to 15 (high) using the voltage level setting buttons.

* The number of voltage levels is equivalent to the number of valid SVD compare voltages supported in the 
target model. The number of available levels may be changed depending on the model.

 Clicking the button changes the current voltage level and voltage indicator bar. At the same time, the compare 
voltage set in the SVD control register in the emulation memory and the voltage level set in this window are 
compared and the result is written to the SVD detection result register.

SVD interrupt
 If the target model supports the SVD interrupt, setting a voltage level lower than the SVD compare voltage in 

this window can generate an interrupt.
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10.11.6  Simulating an lCD Panel

The ES-Sim17 simulates display on an LCD panel according to control of the LCD driver and display memory.

lCD window
  LCD image capture button

LCD image display area

LCD window

 This window simulates display on a dot-matrix type LCD panel.
 The ES-Sim17 reads the contents of the display memory in 32-Hz cycles to redraw this window.

 The drive duty setting and display control (display on/off, contrast adjustment, display area selection, etc.) in 
the program are reflected to this window.

Saving lCD screen
 The screen image being currently displayed in the LCD window can be saved to a bitmap file (.bmp).
 Click the [LCD capture] button when the screen you want to capture is displayed. When the file save dialog box 

appears, select the directory and enter the file name you want to save.
 The screen data is captured at the point the [LCD capture] button is clicked and the LCD window stops 

refreshing the display until the file save has completed.
 The whole panel image is saved even if the LCD window does not display a part of the screen.
 The ES-Sim17 generates a Windows standard bitmap file (.bmp).

Restrictions
• The dot size, contrast, and background color are different from those of the actual LCD panels.

• The LCD display refresh times differ from actual LCD panels.
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10.11.7  ES-Sim17 Error Massages
Table 10.11.7.1  Error messages (displayed in the gdb [Console] window)
Message Description

ES-Sim error 01 : Loading the dll file was failed. The dll file for ES-Sim17 does not exist in the default location or 
cannot be loaded normally.

ES-Sim error 02 : Opening the CPU construction file 
was failed.

The CPU configuration file does not exist in the specified 
location or cannot be loaded normally.

ES-Sim error 03 : Generating the CPU components 
was failed.

The ES-Sim17 has failed generation of the CPU module as the 
CPU module definition is incorrect or no required dll file exists.

ES-Sim error 04 : Connecting the CPU components 
was failed.

The ES-Sim17 has failed correction to the CPU module 
generation as the connect destination in the CPU module 
definition is incorrect.

ES-Sim error 05 : Opening the "user.ini" was failed. The user setting file does not exist in the specified location or 
cannot be opened normally.

ES-Sim error 06 : Setting of the "user.ini" is invalid. The setting value written in the user setting file is incorrect.

Table 10.11.7.2  Error messages (displayed in a dialog box)
Message Description

Failed to save "path\file". The ES-Sim17 has failed saving the captured image to the file.
Failed to open "path\file".
Please confirm the file is fitting with the CPU type, 
or the file is existing.

The Lcd file could not be opened.

10.11.8  Restrictions

• The ES-Sim17 supports the model shown below.
 S1C17701、S1C17702、S1C17704、S1C17602、S1C17001

• The ES-Slim17 supports monochrome dot-matrix LCD and monochrome segment LCD panels as external 
devices.

• The dot size, contrast, and panel color of the LCD window are different from those of the actual LCD panels.

• The ES-Sim17 performs simulation on an instruction cycle basis. Therefore, operation cycles lower than the 
instruction cycle cannot be simulated.

• The ES-Sim17 simulates the operation clock based on the instruction cycles. Therefore, the operation timings are 
not the same as those of the actual hardware.

• The functions listed below cannot be simulated.
 1. Timer clock and oscillation clock external outputs
 2. Data transfer using the UART, I2C and SPI
 3. Noise and chattering filters

• More than one ES-Sim17 cannot be run on a PC for simulation.

• Setting higher oscillation clock frequency causes degradation of simulation performance.

• The I/O control registers that are not supported by the ES-Sim17 function as general-purpose read/write registers. 
Also they are not initialized at a reset.

• Some peripheral circuits, such as the oscillator and SVD circuits, need time until their operations stabilize. In the 
simulation by the ES-Sim17, they can operate with stability immediately after they start.

* For the restrictions in the latest version of ES-Sim17 and model dependent restrictions, refer to "simulator_ 
readme.txt".
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11  Other Tools
 This chapter explains the other tools that are included in the S1C17 Family C Compiler Package. 

11.1  make.exe

11.1.1  functional Outline

The S1C17 Family C Compiler Package contains a make tool (hereafter referred to as the make.exe) that efficiently 
processes compilation to linkage.
Based on the dependence relationship between the sources written in a make file and the files output by each tool, 
the make.exe uses the necessary tools to update the files to the latest version. For example, if only one source file 
is corrected after the make process is completed once, the make executes compilation and/or assembly only for that 
file. For other modules, the make skips compilation and/or assembly processes for the source files and processes 
the object files from the linkage stage.
The make.exe in this package is based on gnu make (ver. 3.81), note, however, it only supports the dependency 
lists, suffix definitions, and macro definitions necessary to perform the above processing.

11.1.2  Input file 

make file
File format: Text file 
File name: <filename>.mak
Description: This file contains procedures for a make process. Normally use the make file created by the IDE.
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11.1.3  Starting Method

general command line format

 make [<option>] [<target name>]

 The brackets [ ] denote that the specification can be omitted.

 Example: make -f test.mak clean

Operation on IDE
 This is called when a build is executed.

Option
 The make.exe has the following available startup option.

 -f <filename>

Function: Specify make file
Explanation: The make.exe reads in a make file specified by <filename> (extension included), and processes 

its contents.
Default: Unless the -f option is specified, a file named "makefile" is input as the make file. 

Target name
 Specify the target name (a label that indicates a command location) for the command to be executed. If this 

specification is omitted, the first target that appears in the make file is executed. 

 A make file created by the IDE contains a target name (clean) used to delete the files generated during make 
processing.

 Example: make -f test.mak clean

 When clean is specified, the object and map files that have been created by executing test.mak will be 
deleted. This function is useful to rebuild the program from all the source files.

 To execute clean from the IDE, select [Clean] from the [Project] menu.

 The S5U1C17001C only supports ordinary makes without target names and makes with the target name 
"clean" and a designation of "all."
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11.1.4  make files 

The make file is a text file that contains a description of the dependence relationship of the files and the commands 
to be executed.
Given below are examples of the make file generated by the IDE.
Example:

# Make file generated by Gnu17 Plug-in for Eclipse
# This file should be placed directly under the project folder

# macro definitions for target file
TARGET= sample
GOAL= $(TARGET).psa

# macro definitions for tools
TOOL_DIR= C:/EPSON/GNU17
CC= $(TOOL_DIR)/xgcc
AS= $(TOOL_DIR)/xgcc
AS_CC= $(TOOL_DIR)/as
LD= $(TOOL_DIR)/ld
RM= $(TOOL_DIR)/rm
SED= $(TOOL_DIR)/sed
CP= $(TOOL_DIR)/cp
CC_KFILT= $(TOOL_DIR)/xgcc_filt
OBJDUMP= $(TOOL_DIR)/objdump
OBJCOPY= $(TOOL_DIR)/objcopy
MOTO2FF= $(TOOL_DIR)/moto2ff
SCONV= $(TOOL_DIR)/sconv32
VECCHECKER= $(TOOL_DIR)/vecChecker

# macro definitions for tool flags
CFLAGS= -B$(TOOL_DIR)/ -gstabs -S  -O1 -I$(TOOL_DIR)/include -fno-builtin -Wall 
-Werror-implicit-function-declaration
ASFLAGS= -B$(TOOL_DIR)/ -c -xassembler-with-cpp -Wa,--gstabs
ASFLAGS_CC=
LDFLAGS=  -Map sample.map -N -T sample_gnu17IDE.lds
EXTFLAGS= -Wa,-mc17_ext -Wa,$(TARGET).dump -Wa,$(TARGET).map
EXTFLAGS_CC= -mc17_ext $(TARGET).dump $(TARGET).map
OBJDUMPFLAGS= -t
OBJCOPYFLAGS= -I elf32-little -O srec --srec-forceS3
MOTOSTART= 8000
MOTOSIZE= 10000
SCONVFLAGS= S2
VECCHECKERFLAGS= -t symtable.out -r raw.out
VECCHECKER_ON= false

# macro for switching 2pass or 1pass build
PASS= 2pass

# macro definitions for tool flags
PROTECT_ON= true

# search paths for source files
vpath %.c
vpath %.s

# macro definitions for object files
OBJS= boot.o \
      lib.o \
      main.o \
      sys.o \

# macro definitions for library files
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OBJLDS= $(TOOL_DIR)/lib/24bit/libstdio.a \
        $(TOOL_DIR)/lib/24bit/libc.a \
        $(TOOL_DIR)/lib/24bit/libgcc.a \
        $(TOOL_DIR)/lib/24bit/libc.a \

# macro definitions for assembly files generated from c source files
CEXTTEMPS= lib.ext0 \
      main.ext0 \
      sys.ext0 \

# macro definitions for dependency files
DEPS= $(OBJS:%.o=%.d)
SED_PTN= 's/[[:space:]]\([a-zA-Z]\)\:/ \/cygdrive\/\1/g'
SED_PTN2= 's/^\($(subst .,\.,$(@F))\)\:/$(subst /,\/,$(@))\:/g'

# macro definitions for creating dependency files
DEPCMD_CC= @$(CC) -M -MG $(CFLAGS) $< | $(SED) -e $(SED_PTN) | $(SED) -e $(SED_PTN2) 
>$(@:%.o=%.d)
DEPCMD_AS= @$(AS) -M -MG $(ASFLAGS) $< | $(SED) -e $(SED_PTN) | $(SED) -e $(SED_
PTN2) >$(@:%.o=%.d)

# targets and dependencies 
.PHONY : all clean

all : $(GOAL)

$(TARGET).psa : $(TARGET).elf
# clean psa files
 $(RM) -f $(TARGET).sa $(TARGET).saf $(TARGET).psa
# create psa file from elf
 $(OBJCOPY) $(OBJCOPYFLAGS) $< $(TARGET).sa
 $(MOTO2FF) $(MOTOSTART) $(MOTOSIZE) $(TARGET).sa
 $(SCONV) $(SCONVFLAGS) $(TARGET).saf $(TARGET).psa
#create protected psa file
 ifeq ($(PROTECT_ON), true)
 $(TOOL_DIR)/gdb.exe --nw --command=protect.cmd
 $(SCONV) $(SCONVFLAGS) temp $(TARGET)_ptd.psa
 $(RM) -f temp
endif
 @cmd /c "echo ---------------- Finished building target : $@ ----------------"

$(TARGET).elf : $(OBJS) sample_gnu17IDE.mak sample_gnu17IDE.lds
ifeq ($(PASS), 1pass)
# 1pass linking
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS)
else
# 1pass linking
 -$(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS) 2>lderr
 @if [ -s lderr ]; then \
  cmd /c "type lderr" \
  && $(RM) -f $(TARGET).elf \
  && exit 1; \
 else $(RM) -f lderr ; \
 fi
 $(OBJDUMP) $(OBJDUMPFLAGS) $@ > $(TARGET).dump
 $(RM) -f $(TARGET).elf
# save 1pass object files
 @if [ -e obj1pass ]; then \
  cmd /c "rd /s /q obj1pass" ; \
 fi
 cmd /c "md obj1pass"
 for NAME in $(subst /,\\,$(OBJS)) ; do \
  cmd /c "copy /y $$NAME obj1pass\\$$NAME" >nul ; done \
 && $(RM) -f $(OBJS)
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# 2pass for assembly files
 $(AS) $(ASFLAGS) $(EXTFLAGS) -o boot.o boot.s
# 2pass for c files
 for NAME in $(basename $(CEXTTEMPS))  ; do \
  $(AS_CC) $(ASFLAGS_CC) $(EXTFLAGS_CC) -o $$NAME.o $$NAME.ext0 ; done
 $(RM) -f $(TARGET).map
# 2pass linking
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS)
# restore 1pass object files
 $(RM) -f $(OBJS) \
 && \
 for NAME in $(subst /,\\,$(OBJS)) ; do \
  cmd /c "copy /y obj1pass\\$$NAME $$NAME" >nul ; done \
 && cmd /c "rd /s /q obj1pass"
endif

# check copro function in vector
ifeq ($(VECCHECKER_ON), true)
 $(RM) -f symtable.out raw.out
 $(OBJDUMP) -t $@ > symtable.out
 $(OBJDUMP) -s $@ > raw.out
 $(VECCHECKER) -t symtable.out -r raw.out
endif

 @cmd /c "echo ---------------- Finished building target : $@ ----------------"

## boot.s
boot.o : boot.s
 $(AS) $(ASFLAGS) -o $@ $<
 $(DEPCMD_AS)

## lib.c
lib.o : lib.c lib.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

## main.c
main.o : main.c main.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

## sys.c
sys.o : sys.c sys.ext0
 $(CC) $(CFLAGS) -o $(@:%.o=%.ext0) $<
 $(AS_CC) $(ASFLAGS_CC) -o $@ $(@:%.o=%.ext0)
 $(DEPCMD_CC)

# dependecies for assembled c source files
lib.ext0 : lib.c
main.ext0 : main.c
sys.ext0 : sys.c

# include dependency files
-include $(DEPS)

# clean files
clean :
 $(RM) -f $(OBJS) $(TARGET).elf $(TARGET).map $(DEPS) $(CEXTTEMPS) $(TARGET).dump 
lderr $(TARGET).sa $(TARGET).saf $(TARGET).psa $(TARGET)_ptd.psa
 @if [ -e obj1pass ]; then \
  cmd /c "rd /s /q obj1pass" ; \
 fi
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Path descriptions in a make file
 The make file supports descriptions in the cygwin format (or UNIX format). Therefore, the following 

precautions should be taken especially when a path is described.

 1) Drive name and delimiter in path
 "\" used in Windows must be replaced with "/". Additionally, write the drive name in the format "/cygdrive/

<drive name>/".
 Example:

  c:/EPSON/gnu17/sample/tst/boot.o : c:/EPSON/gnu17/sample/tst/boot.s

   as –o boot.o c:/EPSON/gnu17/sample/tst/boot.s

      ↓
  /cygdrive/c/EPSON/gnu17/sample/tst/boot.o : /cygdrive/c/EPSON/gnu17/sample/tst/boot.s

   as –o boot.o c:/EPSON/gnu17/sample/tst/boot.s

 If a drive name is written in the form "<drive name>:", an error will result when make is executed. 
However, when entering a command line for Windows such as an assembler, you can use the "<drive 
name>:" format to write the path to be specified as a command line parameter.

 2) Space
 Make sure any spaces within a directory or file name is preceded by a "\".
 Example: Tool Folder → Tool\ Folder

 3) Case sensitive 
 Directory and file names are case sensitive. Be sure to check upper/lower case for path descriptions.

 Also the make.exe allows descriptions of relative paths from the current directory in which the make.exe is 
invoked.

 Example: .libraries/lib1.a

Comments 
 A statement from # to the end of the line is regarded as a comment. 
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11.1.5  Macro Definition and Reference 

You can define a character string as a macro in a make file and can refer to defined character strings using the 
macro names. The following shows the formats in which a macro can be defined and referenced.

Definition: <macro name> = <character string> 
Reference: $(<macro name>) 

Example: 
 TARGET= sample
  :
 TOOL_DIR = /cygdrive/c/EPSON/gnu17
  :
 LD= $(TOOL_DIR)/ld
 LIB_DIR= $(TOOL_DIR)/lib
  :
 LDFLAGS= -T $(TARGET).lds -Map $(TARGET).map -N
  :
 OBJS= boot.o \
       main.o \
  :
 OBJLDS= 
  :
 LIBS= $(LIB_DIR)/libc.a $(LIB_DIR)/libgcc.a 
  :
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS) $(LIBS)

 The last line that refers macros in the example above is a command line to invoke the linker. If the macros have 
been defined as the example, this line will be executed after the macro names are replaced as below.

/cygdrive/c/EPSON/gnu17/ld -T sample.lds -Map sample.map -N -o sample.elf boot.o main.o 
/cygdrive/c/EPSON/gnu17/lib/libc.a /cygdrive/c/EPSON/gnu17/lib/libgcc.a

Predefined macros
 $@ used in the example above is a predefined macro. The following three predefined macros are available. 

Note, however, that they can be used only in the command lines in dependency lists.
 $@ This will be replaced with the target file name (including the extension) currently being processed.
  Example:
  sample.elf : . . .
      ld -o $@ . . . (= ld -o sample.elf . . .)

 $* This will be replaced with the target file name (not including the extension) currently being processed.
  Example:
  sample.elf : . . .
      ld $*.o . . . (= ld sample.o . . .)

$< This will be replaced with the first dependency file (including the extension) of the target currently being 

processed.
  Example:
  main.o : main.c ...
   xgcc -o $@ $< (= xgcc -o main.o main.c)

Precaution
 When the same macro name is defined twice or more, the newest defined macro is effective.
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11.1.6  Dependency list

This section explains the dependency list when no suffix definition is used.

Dependency list format
 The make is executed according to a dependency list that is written in the following formats: 

 Format 1: <target file name>:<dependent file name 1> [^ <dependent file name2>...] 
   [ TAB  <command 1> 
    TAB  <command 2> 
               :    ]

 Format 2: <target name>:
   [ TAB  <command 1> 
    TAB  <command 2> 
               :    ]

 • ^ denotes a space. 
 • [ ] indicates that entries in brackets can be omitted. 
 • The command lines must begin with a TAB (space is not allowed).

 format 1
 In Format 1, the dependent files necessary to obtain a target file are specified, and in cases when no target 

file has been created or there is a dependent file newer than the target file, the command that follows is 
executed.

 Normally, a startup command of a tool is described as the command. The output file of the tool is specified 
as the target file and the input files are specified as the dependent files.

 Example: main.o : $(SRC1_DIR)/main.c
   $(CC) $(CFLAGS) $(SRC1_DIR)/main.c

 In this example, the target file main.o depends on main.c. If the target file main.o does not exist or 
main.c is newer than main.o (when the source is modified after it has been compiled), the command 

"$(CC) $(CFLAGS) $(SRC1_DIR)/main.c" (compilation by xgcc) is executed.

 format 2
 If no dependent file is written, <target name> is used only as a label. By specifying a <target name> with 

the make.exe startup command, it is possible to execute the written command.
 Example: Commands executed by make -f test.mak clean 
  clean:
   $(RM) -f $(OBJS) $(TARGET).elf $(TARGET).map $(DEPS) 

 If no <target name> is specified in the startup command, the first dependency list written in the file is used 
to execute the make process.

 An executable command (with .exe) and its parameters can be written as a command. If no command has 
been written, nothing is executed. However, if a suffix definition with the extensions of the target file and 
the first dependent file is described, the command in the suffix definition is executed.
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Processing dependency lists by make.exe
 For example, when target.elf is created from two source files, boot.s and main.c, the dependent 

relationship of the files including the temporary files (.o) is shown as Figure 11.1.6.1. Therefore, three 
dependency lists for target.elf, boot.o and main.o as the target files are required.

target.elf

boot.o main.o

boot.s main.c

Assembly Compilation

Linkage

Figure 11.1.6.1  Relationship of files (example)

Sample of a make file:
 target.elf : boot.o main.o        

(A)
      $(LD) $(LDFLAGS) -o target.elf boot.o main.o $(LIBS)

 boot.o : boot.s          
(B)

      $(AS) $(ASFLAGS) -o boot.o boot.s

 main.o : main.c          
(C)

      $(CC) $(CFLAGS) main.c

 (A) Dependency list for generating target.elf
 (B) Dependency list for generating boot.o
 (C) Dependency list for generating main.o

 * See the above sample make file generated by the IDE for the macro contents referred with $(XXX).

 The first make process for this make file is executed as follows:

1. The make.exe checks Dependency list A (target.elf: ...) that appears first in the make file.

2. The dependent files boot.o and main.o are target files in other dependency lists, so the make.exe 
evaluates these dependency lists first.

 If boot.o or main.o does not exist and the dependency list for generating it is not written in the make 
file, an error occurs.

3. The make.exe evaluates Dependency list B (boot.o: ...). Then the command (for assembling boot.s) 
is executed to generate boot.o since boot.o does not exist at this time. 

 If boot.s does not exist at this time, an error occurs since there is no dependency list for generating 
boot.s. In this case, create boot.s and locate it into the specified directory (the current directory in this 

make file) or delete the descriptions related to boot.s and boot.o.

4. Dependency list C (main.o: ...) is evaluated and main.o is generated similar to Step 3 above.

5. The make process returns to Dependency list A and the command (linkage) is executed since target.
elf has not been generated yet. The target.elf is then generated.
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 If main.c is modified after the make process above has already completed, the next make is processed as follows:

1. The make.exe checks Dependency list A (target.elf: ...) that appears first in the make file.

2. The dependent files boot.o and main.o are target files in other dependency lists, so the make.exe 
evaluates these dependency lists first.

3. The make.exe evaluates Dependency list B (boot.o: ...). At this time, boot.o exists and it is newer 
than boot.s, so the following command (for assembling boot.s) is not executed.

4. The make.exe evaluates Dependency list C (main.o: ...). In this case, the dependent file main.c is 
newer than main.o, so the following command (for compiling main.c) is executed. This updates main.o.

5. The make process returns to Dependency list A and the command (linkage) is executed since the dependent 
file main.o is newer than target.elf. The target.elf is updated.

 If no dependent file is updated from the previous make process, the commands in Dependency lists A to C are 
not executed.

Precautions on writing dependency list
• In a dependency list, do not use the same file twice or more if possible. Otherwise, executing the command 

may set the time stamp of the file as a later time depending on the OS environment and the make sequence 
may not be processed normally.

 Bad example: 
 vector2.o : vector.c
  /cygdrive/c/EPSON/gnu17/sed.exe -f ../comm/place.sed vector.c > vector2.c
  /cygdrive/c/EPSON/gnu17/xgcc -B/cygdrive/c/EPSON/gnu17/ -c vector2.c -o vector2.o

 This example executes sed.exe to convert vector.c into vector2.c and then compiles vector2.c to 
generate vector2.o. It is better to separate into two dependency lists like below.

 Good example:
 vector2.o : vector2.c
  /cygdrive/c/EPSON/gnu17/xgcc -B/cygdrive/c/EPSON/gnu17/ -c vector2.c -o vector2.o

 vector2.c : vector.c
  /cygdrive/c/EPSON/gnu17/sed.exe -f ../comm/place.sed vector.c > vector2.c

 If modification is difficult, execute the make.exe again after the Make clean is executed.

• The relationship of dependency lists should be within 3 or 4 lists. Do not make a long link path of 
dependency lists.

• A maximum of about 4,000 dependency lists can be described in a make file. If descriptions exceed the limit, 
the make process may not be completed normally.

• Up to 255 alphanumeric characters can be used for a file name. 2-byte code characters are not allowed. 
Furthermore, when describing a file in full-path format, the file may not be accessed if the path exceeds 255 
characters.
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11.1.7  Suffix Definitions

Dependency lists in which the target file type is ".o" and the dependent file type is ".c" normally contain a 
command line to invoke the compiler. In other words, basically the same command line can be used common to 
all dependency lists that process the same file type if only the file names can be replaced. The suffix definition is 
a description of a list of file types (extensions) and commands to be executed and allows the make file to omit the 
description of commands in each dependency list. This function helps simplify dependency lists when many source 
files must be managed.

When a suffix definition has been made in the make file, the make.exe executes the commands described in the 
suffix definition for the dependency list that have the same file type configuration as the suffix definition and does 
not have a command description. If a dependency list has a command described, it is executed, not the command 
in the suffix definition.  Therefore, the specific dependency list can execute a different command from others by 
describing the command in the normal form. This is useful when executing a different function only for the specific 
source, or when using a source located in a different directory from the other sources.

The following shows the dependency lists without a suffix definition and with a suffix definition.

Dependency lists without a suffix definition
# dependency list start 

### src definition start
SRC1_DIR= .
### src definition end

$(TARGET).elf : $(OBJS) $(TARGET).mak $(TARGET).lds
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS) $(LIBS)

## boot.s
boot.o : $(SRC1_DIR)/boot.s
 $(AS) $(ASFLAGS) -o boot.o $(SRC1_DIR)/boot.s

## main.c
main.o : $(SRC1_DIR)/main.c
 $(CC) $(CFLAGS) $(SRC1_DIR)/main.c

# dependency list end 

Dependency lists with a suffix definition
# suffix & rule definitions
.SUFFIXES : .c .s .o .elf        Suffix definition

.c.o :
 $(CC) $(CFLAGS) -o $(SRC_DIR)/$*.o $(SRC_DIR)/$*.c  

Suffix rules.s.o :
 $(AS) $(ASFLAGS) -o $(SRC_DIR)/$*.o $(SRC_DIR)/$*.s

# dependency list start 

### src definition start
### src definition end 

$(TARGET).elf : $(OBJS) $(TARGET).mak $(TARGET).lds
 $(LD) $(LDFLAGS) -o $@ $(OBJS) $(OBJLDS) $(LIBS)

## boot.s          Dependency lists
boot.o : $(SRC_DIR)/boot.s 

## main.c 
main.o : $(SRC_DIR)/main.c

## sub.c 
sub.o : $(SRC_DIR)/sub.c

# dependency list end
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format of a suffix definition 

 Specifying extensions

 Format: .SUFFIXES : .xxx  .yyy  .zzz  ......

 Example: .SUFFIXES : .c .s .o .elf

 Specify all the extensions related to the dependency lists to which the suffix rules are applied.

 Definition of suffix rules
 The following shows the format of a suffix rule:

 Format: .<extension of dependent file 1>.<extension of target file>: 
    TAB  <command 1> 
   [ TAB  <command 2> 
               :   ]

 Example: .c.o :  
    $(CC) $(CFLAGS) -o $(SRC_DIR)/$*.o $(SRC_DIR)/$*.c

• $* is a macro that will be replaced with the target file name (not including the extension) described in the 
dependency list.

•  The command lines must begin with a TAB (space is not allowed).

 The suffix rule in the example above corresponds to the dependency lists in the format below in which the 
target file type is ".o" and the type of the first dependent file is ".c".

 <file1>.o: <file1>.c [<other files>]

 The command in this suffix rule will be executed in the dependency list for which the command line is omitted.
 Example: Dependency list 

  ## main.c 
  main.o : $(SRC_DIR)/main.c

  ## sub.c 
  sub.o : $(SRC_DIR)/sub.c

 The suffix rule (.c.o) in the example above is applied to these two dependency lists as follows:
  ## main.c 
  main.o : $(SRC_DIR)/main.c
   $(CC) $(CFLAGS) -o $(SRC_DIR)/main.o $(SRC_DIR)/main.c
  ## sub.c 
  sub.o : $(SRC_DIR)/sub.c
   $(CC) $(CFLAGS) -o $(SRC_DIR)/sub.o $(SRC_DIR)/sub.c

 The time stamp of the dependent file is checked even when the suffix rule is applied and the command is not 
executed if the target file is newer than the dependent file.

Precautions on use of suffix definition
 When using a suffix definition, the target file name and the first dependent file name must be the same except 

for their extensions (also the file name is case sensitive).
 Bad example: main.o : main1.c

 In this case, the suffix rule is not applied. The make ignores such dependency lists and executes nothing for 
them.
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11.1.8  clean

The make file created by IDE contains a description of a command to delete intermediate and object files other 
than the sources. This command can be executed by specifying the target name clean when the make is invoked (in 
IDE, select [Clean] from the [Project] menu.). 
The following shows the command included in a make file: 
Example:

TARGET= sample
  :
TOOL_DIR = c:/EPSON/gnu17
  :
RM= $(TOOL_DIR)/rm
  :
OBJS= boot.o \
      main.o \
  :
DEPS = $(OBJS:%.o=%.d)
clean:
 $(RM) -f $(OBJS) $(TARGET).elf $(TARGET).map $(DEPS)

"clean" uses the file remove utility (rm.exe) to delete the ".o" files, ".elf" file and ".map" file generated by a 
make process using this make file.

11.1.9  Invocation by sh.exe

If the command line in a makefile contains a shell metacharacter such as a semicolon (;), a switching symbol (<, >, 
>>, |), a replacement symbol (*, ?, [], $, =), a quote mark, an escape character, or a comment ("", ‘, `, \, #, etc., :), 
the make will launch the Bourne shell and process the command.
If there is no need for syntax analysis of the command line by a shell, the make executes the command directly. In 
this case, the Bourne shell used is sh.exe at the location where make.exe is found.
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11.1.10  Messages

The following shows the messages generated by the make.exe:

Table 11.1.10.1  Normal message
Message Description

make: Nothing to be done for 'TARGET '. No process has been executed for creating the TARGET. 
This error will occur if no command is defined for creating 
a target file.

make: 'FILENAME' is up to date. FILENAME has already been updated. The make process 
is terminated without executing a command.

Table 11.1.10.2  Error messages
Error message Description

make: *** No rule to make target 'FILENAME1', needed by 
'FILENAME2'.  Stop.

FILENAME1 required for generating FILENAME2 cannot 
be found, or a dependency list for generating FILENAME1 
has not been defined. The make process is terminated.

make: TOOL: Command not found TOOL specified in the dependency list for generating FILE-
NAME cannot be found. The make process is terminated.make: *** [FILENAME] Error 127

make: *** [FILENAME] Error 1 An error has occurred in the tool invoked. The make 
process is terminated.

XXX.mak:LINE: *** missing separator. Stop. There is an illegal separator symbol at the line LINE in the 
XXX.mak file. The make process is terminated. This error 
will occur if the command line in a dependency list or 
suffix rule begins with a character other than TAB, such as 
a space.

XXX.mak:LINE: *** commands commence before first 
target. Stop.

A command was found before the first target definition in 
the line LINE in the xxx.mak file. The make process was 
aborted. This error will occur if TAB is specified before the 
first target.(like "all")."

Table 11.1.10.3  Warning messages
Warning message Description

make: *** Warning: File 'FILENAME' has modification time 
in the future 
 (yyyy-mm-dd hh:mm:ss > yyyy-mm-dd hh:mm:ss)

The time stamp of FILENAME has been set at a later time.
An erroneous clock setting has been made. The make 
process may not be completed normally.

make: warning:  Clock skew detected.  
Your build may be incomplete.

11.1.11  Precautions

• In the make.exe in this package, functions other than those described in this manual cannot be guaranteed to 
work normally.

• The make allows description of a maximum 30,000 characters for arguments of the executable files that can 
be invoked from a make file. Therefore, an error may occur during linkage if too many files that have long file 
names are added in the make file.
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11.2  ccap.exe

11.2.1  function

This tool produces a file from the messages output to the console (standard output or standard error) by other tools 
or commands. 

11.2.2  Output file 

Message file 
File format: Text file 
File name: <filename>.err
Description: This text file contains the tool messages saved through ccap.

11.2.3  Method for Using ccap

Startup format

 ccap [<option>] <output file name> "<execution command>"

  [ ] indicates the possibility to omit. 

 <output file name>: Specify a file name to which the messages to be output. 
 <execution command>: Input the startup command of the tool to be executed. 

Options
 The following four types of startup options are provided for ccap:

 -a

Function: Add to an existing file
Explanation: If this option is specified, the output contents are added at the end of the specified file if it exists. 

If the file does not exist, ccap creates a new file.
Default: Unless this option is specified, the contents are overwritten to the specified file (if the file exists) 

or (if the file does not exist) ccap creates a new file.

 -o

Function: Output only a file 
Explanation: The messages of the executed command are output to a file only, and not output to the console.
Default: Unless this option is specified, the messages are output to both console and file.

 -c

Function: Disable outputting execution command line
Explanation: If this option is specified, the execution command line is neither output to the console nor a file.
Default: Unless this option is specified, the execution command line is output along with messages. 

 -e

Function: Error count
Explanation: If this option is specified, ccap outputs the number of the error messages output by the executed 

command. The messages counted are those which begin with the following character strings:
 Error Count of the error messages
 Warning Count of the warning messages
Default: Error messages are not counted.

 When entering an option, you need to place one or more spaces before and after the option. 
 Example: c:\EPSON\gnu17\ccap -a -o -e Compile.err "xgcc -c -gstabs test.c"
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Usage output
 If no file name or execution command was specified or an option was not specified correctly, ccap ends after 

delivering the following message concerning the usage: 

ccap
Console Capture Ver x.xx
Copyright (C) SEIKO EPSON CORP. 199x
Usage:
    ccap [options] <output-file> "command line"
Options:
    -a : append mode
    -o : disable console output
    -c : disable command echo
    -e : display error count
Example:
    ccap -a -o -c console.cap "gcc sample.c"

11.2.4  Error Messages

The following shows the error messages generated by ccap:

Table 11.2.4.1  Error messages
Error message Description

Error: Cannot execute The specified "execution command" cannot be executed.
Error: Cannot open output file The output file cannot be opened.
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11.3  objdump.exe

11.3.1  function

The objdump displays the internal data of binary files in elf format. Disassembled code, raw data, section 
configuration, section map addresses, data size and relocatable information symbol tables can be displayed.

11.3.2  Input files 

Executable object file
File format: Binary file in elf format
File name: <filename>.elf
Description: An executable object file after the linkage process by the linker has been completed. The contents 

will be displayed using the absolute addresses.

Object file
File format: Binary file in elf format
File name: <filename>.o
Description: An object file after assembled. The contents will be displayed using the relative addresses from 

the beginning of the file or section. 

11.3.3  Method for Using objdump

Startup format

 objdump <option> <input file name>

 <input file name>: Specify a object file name to be dumped. 

Options
 The following startup options can be specified:

 -d

Function: Display disassembled contents
Explanation: Displays all the executable sections after disassembling the object code. No source is displayed 

together.

 -h

Function: Display section information 
Explanation: Displays the section configuration, section size and address. 

 -g

Function: Display information converted from debugging information
Explanation: Displays the relations between sources and addresses based on the debugging information. The 

data types of the global symbols are also displayed.

 -t

Function: Display global symbol information 
Explanation: Displays a list of the global symbols including the local labels.

 -s

Function: Display in hexadecimal dump format
Explanation: Displays all the section information in hexadecimal dump format. Data corresponding to 

unresolved symbols cannot be displayed correctly.

 -D

Function: Display disassembled contents for all sections
Explanation: Displays all the sections after disassembling the object code.
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 -G

Function: Display raw data of debugging information 
Explanation: Displays the raw data of the debugging information in stab format.

 -S

Function: Mixed display 
Explanation: Displays all the executable sections after disassembling the object code. The source code is also 

displayed with the corresponding disassembled code if possible.

 When entering an option, you need to place one or more spaces before and after the option. 
 Example: c:\EPSON\gnu17\objdump -S test.elf

11.3.4  Dump format 

The following shows the display examples by specifying each option:

-d (Disassembled display) 

 Displays the disassembled information from the beginning of the executable section.

C:\EPSON\gnu17\>objdump -d main.o
main.o:     file format elf32-c17

Disassembly of section .text:

00000000 <main>:
   0: 3e5c  ld.a    -[%sp],%r4       ld.a       -[%sp],%r4

00000002 <.LBB2>:
   2: 9900  ld      %r2,0x0          ld         %r2,0x0 <main>
   4: 4000  ext     0x0
   6: 4000  ext     0x0
   8: d900  ld      [0x0],%r2       xld         [0x0],%r2 <main>
   . . . . .

-h (Display section information) 

 Displays the section configuration in the file, section size and mapped address (VMA and LMA). .stab, 
.stabstr and .comment are the sections that contains debugging information.

 The load command does not send these debug information sections to the target.

C:\EPSON\gnu17\>objdump -h sample.elf
        
sample.elf:     file format elf32-c17

Sections:
Idx Name          Size      VMA       LMA       File off  Algn
  0 .bss          000000b8  00000000  00000000  000000b4  2**2
                  ALLOC
  1 .data         00000000  000000b8  00004080  00000134  2**0
                  CONTENTS, ALLOC, LOAD, DATA
  2 .rodata       00000080  00004000  00004000  000000b4  2**2
                  CONTENTS, ALLOC, LOAD, DATA
  3 .text         0000023e  00004080  00004080  00000134  2**1
                  CONTENTS, ALLOC, LOAD, CODE
  4 .stab         00000bb8  000042c0  000042c0  00000374  2**2
                  CONTENTS, READONLY, DEBUGGING
  5 .stabstr      000008b3  00004e78  00004e78  00000f2c  2**0
                  CONTENTS, READONLY, DEBUGGING

*** Debugging sections will not be loaded to the target ***
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-g (Display converted debugging information) 

 Displays the relations between the sources and the execution addresses in the following display format:
 /* file <filename> line <source line number> addr 0x<address> */

 The data types of the global symbols are also displayed.

C:\EPSON\gnu17\>objdump -g sample.elf
        
sample.elf:     file format elf32-c17

boot.s:
/* file boot.s line 47 addr 0x4080 */
/* file boot.s line 48 addr 0x4082 */
/* file boot.s line 49 addr 0x4084 */
/* file boot.s line 50 addr 0x4086 */
/* file boot.s line 53 addr 0x4088 */
   . . . . .
main.c:
typedef int16 int;
typedef int8 char;
typedef int32 long int;
typedef uint16 unsigned int;
typedef uint32 long unsigned int;
   . . . . .
typedef complex float0 complex float;
typedef complex float0 complex double;
typedef complex float0 complex long double;
typedef void *__builtin_va_list;
typedef enum { False, True } _Bool;
int main ()
{ /* 0x40a0 */
  /* file main.c line 10 addr 0x40a0 */
  { /* 0x40a2 */
    register int j /* 0x4 */;
    /* file main.c line 12 addr 0x40a2 */
    /* file main.c line 14 addr 0x40aa */
    /* file main.c line 16 addr 0x40ac */
    /* file main.c line 14 addr 0x40b2 */
  } /* 0x40b8 */
  /* file main.c line 18 addr 0x40b8 */
} /* 0x40bc */
   . . . . .

-t (Display global symbol information) 

 Displays the list of the global symbols including the internal symbols in the following display format:
 SYMBOL TABLE:
 <execution address> <local/global> <symbol type> <section> <data size> <symbol name>
        C:\EPSON\gnu17\>objdump -t sample.elf

        
sample.elf:     file format elf32-c17

SYMBOL TABLE:
00000000 l    d  .bss 00000000 
000000b8 l    d  .data 00000000 
00004000 l    d  .rodata 00000000 
00004080 l    d  .text 00000000 
000042c0 l    d  .stab 00000000 
00004e78 l    d  .stabstr 00000000  
   . . . . .
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-s (Hexadecimal dump display)

 Displays the raw data of each section in the following display format:
 Contents of section <section name>
 <address> <raw data> <raw data> <raw data> <raw data> < ASCII  characters>

   . . . . .

 <address> <raw data> <raw data> <raw data> <raw data> < ASCII  characters> 
 Contents of section <section name>
 <address> <raw data> <raw data> <raw data> <raw data> < ASCII  characters>

   . . . . .

C:\EPSON\gnu17\>objdump -s sample.elf
        
sample.elf:     file format elf32-c17

Contents of section .data:
Contents of section .rodata:
 4000 90400000 88400000 80400000 80400000  .@...@...@...@..
 4010 80400000 80400000 80400000 80400000  .@...@...@...@..
 4020 80400000 80400000 80400000 80400000  .@...@...@...@..
   . . . . .
Contents of section .text:
 4080 00000000 0000fc13 00000000 00002801  ..............(.
 4090 7e4000bc 0040b918 00400218 00402010  ~@...@...@...@ .
 40a0 5c3e0099 00400040 00d9122a 14280040  \>...@.@...*.(.@
   . . . . .

-D (Disassembled display for all sections)

 This option expands the display area by the -d option into all sections. The display format is the same as the 
-d option.

-G (Display raw data of debugging information)

 Displays the raw data of the debugging information. Normally, this information is not used. Refer to the gnu 
documents or source codes for the display contents.

C:\EPSON\gnu17\>objdump -G sample.elf
        
sample.elf:     file format elf32-c17

Contents of .stab section:

Symnum n_type n_othr n_desc n_value  n_strx String

-1     HdrSym 0      249    000008b3 1     
0      SO     0      0      00004080 1      boot.s
1      SLINE  0      47     00004080 0      
2      SLINE  0      48     00004082 0      
3      SLINE  0      49     00004084 0      
4      SLINE  0      50     00004086 0      
   . . . . .

-S (Mixed source and disassembled code display)

 Displays the disassembled information of all the executable sections and the corresponding source codes 
together.

C:\EPSON\gnu17\>objdump -S sample.elf
        
sample.elf:     file format elf32-c17

Disassembly of section .text:

00004080 <__START_text>:
.text
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.align 1

EXCEPTION:
    nop
    4080: 0000  nop                      nop
   . . . . .
00004090 <BOOT>:

BOOT:
    xld.a  %sp, 0x3f00
    4090: 407e  ext     0x7e
    4092: bc00  ld.a    %sp,0x0         sld.a       %sp,0x3f00
    xcall  _init_lib
    4094: 4000  ext     0x0
    4096: 18b9  call    0xb9            xcall       0xb9     (0x00420A) <_init_lib>
   . . . . .
000040a0 <main>:

void sub( int k );

main()
{
    40a0: 3e5c  ld.a    -[%sp],%r4       ld.a       -[%sp],%r4

000040a2 <.LBB2>:
 int j;
 i = 0;
    40a2: 9900  ld      %r2,0x0          ld         %r2,0x0 <__START_bss>
    40a4: 4000  ext     0x0
    40a6: 4000  ext     0x0
    40a8: d900  ld      [0x0],%r2       xld         [0x0],%r2 <__START_bss>
   . . . . .
}
    40b8: 3e38  ld.a    %r4,[%sp]+       ld.a       %r4,[%sp]+
    40ba: 0120  ret                      ret
   . . . . .

11.3.5  Error Message

The following shows the error message generated by objdump:

Table 11.3.5.1  Error message
Error message Description

/cygdrive/X/path to objdump/objdump: filename: 
   File format not recognized

An unrecognized file (filename) is specified. Specify an elf 
format file.

11.3.6  Precautions

• The disassembled display may be aborted halfway if the amount of information is too large.

• When a .o file before linking is dumped, the relative addresses from the beginning of each section are displayed, 
not the absolute addresses. In this case the beginning of each section is address 0x0.
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11.4  objcopy.exe

11.4.1  function

The objcopy is the gnu standard object file format conversion utility, and it copies and converts data format of 
object files.
In application development for the S1C17 Family, this tool is used to convert an elf format object file into Motorola 
S3 format HEX files so that data can be written to the ROMs.
Although objcopy supports many functions (options) and file formats, this section treats only the elf to HEX file 
conversion function. Refer to the documents for the gnu utilities for details of objcopy.

11.4.2  Input/Output files

Input file

  Object file
File format: Binary file in elf format
File name: <filename>.elf
Description: An executable object file after the linkage process by the linker has been completed. 

Output file

  HEX file
File format: Motorola S3 format file
File name: <filename>.sa
Description: A HEX data file for writing to the ROM. When the system uses two or more ROMs, create a data 

file for each ROM by extracting the section data to write to the ROM from the elf object file.
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11.4.3  Method for Using objcopy

Startup format

 objcopy <option> <input file name> [<output file name>]

  [ ] indicates the possibility to omit. 

 <input file name>: Specify an elf format object file name to be converted.
 <output file name>: Specify the Motorola S3 format HEX file name after conversion. 

Note: When <output file name> is omitted, objcopy creates a temporary file used to output the 
converted data, and renames it with the input file name after the process has been completed. 
Therefore, the input file is destroyed.

Options
 The following options are mainly used in application development for the S1C17 Family:

-I elf32-little

Function: Specifies the input file format.
Explanation: Specifies elf as the input file format.

 -O srec

Function: Output in Motorola format
Explanation: Specifies the Motorola format as the output file format. This option must be specified together 

with ‘-I elf32-little’.

 -O binary

Function: Output in binary format
Explanation: Specifies binary format as the output file format. This option must be specified together with  

‘-I elf32-little’.
 --srec-forceS3

Function: Specify Motorola S3 format
Explanation: Specifies the Motorola S3 format as the output file format. This option must be specified with the 

-O srec option.

 Example: ... -O srec --srec-forceS3 ...

 -R SectionName
Function: Remove section
Explanation: Specifies that the section named SectionName should not be included in the output file. This 

option can be specified multiple times in a command line. This option must be specified together 
with ‘-I elf32-little’.

 -v (or --verbose)
Function: Verbose output mode
Explanation: Displays the converted object file names.

 -V (or --version)
Function: Display version number
Explanation: Displays the version number of objcopy, and then terminates the process.

 --help

Function: Usage display
Explanation: Displays the usage of objcopy, and then terminates the process.
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11.4.4  Creating HEX files

Open the command prompt window and execute objcopy at the command line as shown below.
C:\EPSON\gnu17\>objcopy -I elf32-little -O srec -R SectionName --srec-forceS3  

InputFile OutputFile

Running the above command converts sections other than those specified with the -R option into S3 records and 
generates an output file.
Example: Extract all section data from input.elf and write the data to output.sa.
 C:\EPSON\gnu17\>objcopy -I elf32-little -O srec --srec-forceS3 input.elf 

output.sa
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11.5  ar.exe

11.5.1  function

The ar is the gnu standard utility for maintenance of archived files. This utility is used to create and update library 
files that can be used with the linker ld. Refer to the documents for the gnu utilities for details of ar.

11.5.2  Input/Output files

Object file
File format: Binary file in elf format
File name: <filename>.o
Description: A relocatable object file. The ar can add files in this format into an archive or extract an object 

from an archive to generate a file in this format.

Archive file (library file)
File format: Archive file in binary format
File name: <filename>.a
Description: A library file that can be input to the linker ld.
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11.5.3  Method for Using ar

Startup format

 ar <key> [<modifier>] [<add position>] <archive> [<objects>]

  [ ] indicates the possibility to omit. 

<key>, <modifier>: Specify a process.
<add position>: Specify the location in the archive for inserting <objects> using the object name in the 

archive.
<archive>: Specify an archive file to be edited.
<objects>: Specify object file names to be added, extracted, moved or removed. Multiple file names 

can be specified by separating between the file names with a space.

Keys
d Removes <objects> from the archive.

m Moves <objects> to the end of the archive. By specifying with modifier 'a' or 'b', the location in the archive 

where <objects> are moved can be specified.

q Adds <objects> at the end of the archive. This function does not update the symbol table in the archive.

r Replaces <objects> in the archive with the object files with the same name. If the archive does not contain 
<objects>, the <objects> files are added at the end of the archive. (By specifying with modifier 'a' or 'b', 
the location in the archive where <objects> are added can be specified.)

t Displays the list of objects in the archive or the list of the specified <objects>.

x Extracts <objects> from the archive and creates the object files. When <objects> are omitted, all the 

objects in the archive are extracted to create the files.

Modifiers
a Use this modifier with key 'r' or 'm' to place <objects> behind the <add position>. Specify an object name 

located at the <add position> in the archive file. 

b This modifier has the same function as 'a' but <objects> are placed in front of the <add position>.

s Forcibly updates the symbol table in the archive.

u Use this modifier with key 'r' to replace only the updated objects in the <objects> that are newer than those 

included in the archive.

v Specifies verbose mode to display the executed processes.

Do not enter a space between the keys and modifiers.
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Usage examples

(1) Creating a new archive
 ar rs mylib.a func1.o func3.o

 (mylib.a: func1.o + func3.o)

 When the specified archive (mylib.a) does not exist, a new archive is created and the specified object files 
(func1.o and func3.o) are added into it in the specified order.

(2) Adding objects
 ar rs mylib.a func4.o func5.o

 (mylib.a: func1.o + func3.o + func4.o + func5.o)

 func4.o and func5.o are added at the end of mylib.a.

(3) Adding an object to the specified location
 ar ras func1.o mylib.a func2.o

 (mylib.a: func1.o + func2.o + func3.o + func4.o + func5.o)

 func2.o is added behind the func1.o in mylib.a.

(4) Replacing objects
 ar rus mylib.a func1.o func2.o func3.o func4.o func5.o

 (mylib.a: func1.o + func2.o + func3.o + func4.o + func5.o)

     If there are files from among func1.o, func2.o, func3.o, func4.o and func5.o that have been 
updated after they have been added into mylib.a, the objects in mylib.a are replaced with the newer files. 
The objects that have not been updated are not replaced.

(5) Extracting an object
 ar x mylib.a func5.o

 (mylib.a: func1.o + func2.o + func3.o + func4.o + func5.o)

 func5.o is extracted from mylib.a and an object file is created. The archive is not modified.

(6) Removing an object
 ar ds mylib.a func5.o

 (mylib.a: func1.o + func2.o + func3.o + func4.o)

 func5.0 is removed from mylib.a.
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11.6  moto2ff.exe

11.6.1  function

The moto2ff loads a Motorola S3 format file with a given start address and block size and fills the unused area of 
the file with 0xff to generate an output file. 
In applications development for the S1C17 Family, the moto2ff is used to retrieve ROM area data from the 
Motorola S3 format file generated by objcopy.
The ROM area data generated by moto2ff should be processed with sconv32 and winmdc17 to generate the mask 
data to be submitted to Seiko Epson. For the mask data generation procedure, refer to Section 3.3.7, "Creating 
ROM Data."

Note: To generate mask data, select [Build Mask file (.psa)] in [Build goal switch] of the [Properties] 
dialog box and generate the mask data according to the procedures described in Section 3.3.7, 
"Creating ROM Data." Generating the mask file incorrectly or with the wrong settings may 
generate malfunctioning mask data. Always proceed carefully when generating mask data.

11.6.2  Input/Output files

Input file

  HEX file
File format: Motorola S3 format file
File name: <filename>.sa
Description: A Motorola S3 format HEX file converted from an elf format executable file by the objcopy.

Output file

  ROM area data file
File format: Motorola S3 format file
File name: <filename>.saf
Description: A data file of the specified ROM area in which the unused area is filled with 0xff.

11.6.3  Startup format
moto2ff <data start address> <data block size> <input file name>

<data start address>: Specify the data output start address in the input file using a hexadecimal number.
<data block size>: Specify the output data block size in bytes using a hexadecimal number.
<input file name>: Specify the file name of the Motorola S3 format file to be filled with 0xff.
 The file name must be within 128 characters including a path and an extension. Path can be 

specified for the input file, note, however, that the output file will be located in the current 
directory.

• Usage will be displayed when no parameters are specified.

• If the output file already exists, it will be overwritten.

• When an error occurs, an error message is displayed and the output file is not generated.

• If the input Motorola S3 file contains data that exceeds the range specified by a start address and a block size, the 
following message appears and the output file is not generated.

 Error: FILENAME contains data outside of specified range (STARTADDR:SIZE)

• If Motorola S3 data records are in the same address, the first data is overwritten by the last. 

• Make sure that the data start address and data block size are correct values for the model by referring its technical 
manual. If an incorrect value is input, an error will occur in the winmdc17 process to generate final mask data.
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• When moto2ff has completed successfully, the following message is shown in the standard output.
 moto2ff : Convert Completed

• [-f]: Forced output option. Even when the input Motorola S3 format file has data in the range beyond that 
specified by the start address and the block size, the specified range is cut out, and the output file is generated 
with the unused area filled by 0xff. If out-of-range data is present, a warning is output.

11.6.4  Error/Warning Messages

The following shows the error and warning messages generated by the moto2ff:

Table 11.6.4.1  Error messages
Error message Description

Input filename is over 128 letters. The input file name has exceeded 128 characters.
Cannot open input file "FILENAME". The input file FILENAME cannot be opened.
Cannot open output file "FILENAME". The output file FILENAME cannot be opened.
Motorola S3 checksum error. A checksum error occurred while reading Motorola S3 

format file.
Cannot allocate memory. Cannot allocate memory.
FILENAME contains data outside of specified range 
("STARTADDR":"SIZE")

The input file FILENAME contains data that exceeds the 
specified range (SIZE bytes from STARTADDR). The output 
file is not generated.

Table 11.6.4.2  Warning messages
Warning message Description

Invalid file format in "FILENAME" line "NUMBER". The input file FILENAME contains an invalid format data at 
line NUMBER.

FILENAME contains data outside of specified range 
("STARTADDR":"SIZE")

Although FILENAME contains data outside the specified 
range (from "STARTADDR" to "SIZE"), an output file is 
generated due to the forced output option, -f.

11.6.5  Creating ROM Area Data 

After a Motorola S3 format HEX file has been generated by the objcopy, convert it into ROM area data using the 
moto2ff. 
Open the command prompt window and execute moto2ff as shown below.
Example: C:\EPSON\gnu17\>moto2ff 8000 10000 input.sa

The command above outputs the data of 0x10000 bytes starting from address 0x8000 contained in input.sa to 
input.saf. The unused addresses within the range from addresses 0x8000 to 0x17fff are filled with 0xff. 

The ROM area data file for the internal ROM are generated by the above procedure.

After that convert the ROM area data file generated here into the Motorola S2 format ROM data file using sconv32. 
Then perform the final verification of program operation on the actual target board using that file.

Finally, pack the verified ROM data file and the mask option data file generated by winfog17 into a mask data file 
using winmdc17 and present it to Seiko Epson.



11-30 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

11  OTHER TOOlS

11.7  sconv32.exe

11.7.1  function
The sconv32 is a tool to convert a Motorola S format into another S format. In an application development for the 
S1C17 Family, the sconv32 is used to convert the Motorola S3 format ROM area data file generated by moto2ff 
into the Motorola S2 format.
The converted ROM data file should be processed with winmdc17 to generate the mask data to be submitted to 
Seiko Epson after performing the final verification of program operation on the actual target board using the ROM 
data file. For the mask data generation procedure, refer to Section 3.3.7, "Creating ROM Data".

11.7.2  Input/Output files

Input file
  ROM area data file

File format: Motorola S3 format file
File name: <filename>.saf
Description: A Motorola S3 format HEX file generated by moto2ff.

Output file
  ROM data file

File format: Motorola S2 format file
File name: <filename>.psa
Description: The Motorola S2 format file converted form the input file.

11.7.3  Startup format
sconv32 S2 <input file name>  <output file name>

S2: This is a switch to convert the input file into the Motorola S2 format.
<input file name>: Specify a ROM area data file generated by moto2ff.
<output file name>: Specify the output file name that will be converted into the Motorola S2 format.
 The file extension must be ".psa".

• Usage will be displayed when no parameters are specified.

• If the output file already exists, it will be overwritten.

• When an error occurs, an error message is output to the standard error device and the output file is not generated.

• The [ESC] key can be used to forcibly terminate the process while converting.

• When sconv32 has completed successfully, the following message is displayed.
 Sconv32 : Convert Completed End message   *1

 *1: Output to the standard output

11.7.4  Error Messages

The following shows the error messages generated by the sconv32:
Table 11.7.4.1  Error messages

Error message Description

INVALID SWITCH. An invalid switch is specified.
COMPLEMENT SWITCH ERROR. The specified complement of the checksum for the output file is incorrect.
S FORMAT TYPE ERROR. The specified S format for the output file is incorrect.
NO INPUT FILE NAME. An input file is not specified.
NO OUTPUT FILE NAME. An output file is not specified.
INPUT SAME FILE. The same file name is specified for input and output.
CANNOT OPEN SOURCE FILE (filename). The specified input file cannot be found or cannot be opened.
CANNOT OPEN DESTINATION FILE (filename). The output file cannot be opened.
SOURCE RECORD TYPE NOT SUPPORT. The input file has an unsupported record type.
ADDRESS LENGTH RANGE OVER. The address range of the input file exceeds the address range for the 

S format to be converted.
OTHER ERROR. Another error has occurred.
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11.8  Outline of the Development Tools
The S1C17 C Compiler Package contains the tools to create mask option and mask data files, as well as files that 
contain descriptions of setup information for each type of microcomputer. The tools below are Windows GUI 
applications that run under Windows XP or Windows Vista versions.

1. function option generator <winfog17.exe>
 The winfog17 creates the function option document file that is necessary to generate IC mask patterns after 

selecting the mask options of the S1C17xxx. You can create function option data by selecting the appropriate 
item using the check boxes. Refer to Section 11.9 for details.

2. Mask data checker <winmdc17.exe>
 The winmdc17 checks the data in development-completed built-in ROM file and option document file to create 

the mask data file that will be presented to Seiko Epson. Refer to Section 11.10 for details.

3. Device information definition file <S1C17xxx.ini>
 This file is used to set information, such as the configuration of options, on each type of microcomputer for the  

tools described above. This file must be available before each tool can be executed.

Note: There is no difference between each tool between the different types of microcomputers. 
Therefore, the explanations in this manual are for all types of microcomputers using "S1C17xxx" 
as the representative name. The contents of the sample screens shown in this manual vary 
according to the type of microcomputer. 

For the mask data generation procedure including creation of a internal ROM data filer, refer to Section 3.3.7, 
"Creating ROM Data".
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11.9  winfog17.exe

11.9.1  outline of winfog17

The S1C17 Family allows several hardware specifications such as I/O port functions to be selected as mask options 
depending on the model. This helps you to configure the hardware of your product by changing the S1C17 chip's 
mask patterns according to its specifications. 
The Function Option Generator winfog17 is the software tool for creating the files necessary to generate mask 
patterns. Its graphical user interface (GUI) ensures easy selection mask options. From the files created by winfog17, 
Seiko Epson produces the mask patterns for the S1C17 chip.

11.9.2  input/output files

Figure 11.9.2.1 shows the input/output files of winfog17.

Selection of 
mask options

winfog

Function option
document file

Device information
definition file

Mask data creation
by mask data checker

S1C17xxx.ini

file.fdc

Figure 11.9.2.1  Input/output files of winfog17

input file

  Device information definition file
File format: Text format file
File name: S1C17xxx.ini

Description: This file contains option lists for various types of microcomputers and other information. Always 
be sure to use the files presented by Seiko Epson. This file is effective for only the type of 
microcomputer indicated by the file name. Do not modify the contents of the file or use the file in 
other types of microcomputers.

output file

  function option document file
File format: Text format file
File name: <filename>.fdc
Description: This is a text format file in which the contents of selected mask options are stored. You can read 

this file into winfog17 and correct the already selected option settings. This file is packed along 
with completed other program/data files into a single file by the mask data checker winmdc17, 
which we would like to have presented to Seiko Epson as the mask data file. From this file, Seiko 
Epson will create the mask patterns for the IC. 
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11.9.3  Starting Up

Startup from Explorer
Double-click on the winfog17.exe icon or select winfog17 from the start menu.
If the device information definition file (S1C17xxx.ini) was loaded into your computer during 
previous execution, winfog17 automatically reads the same file as it starts. 
Alternatively, drag the device information definition file icon into the winfog17.exe icon to start 
winfog17, which will then read the device information definition file.

Startup from IDE
To start WinFog17, select [Start WinFog17] from the IDE [GNU17 Actions] menu or click the [Start WinFog17] 
toolbar button.

When winfog17 starts, it displays the [FOG] window. The following diagrams show a [FOG] window when the 
device information definition file has been loaded and when it has not.

 

[FOG] Window (initial screen)

If the model lacks mask options, the [INI file does not include FOG information] dialog box will appear when you 
click the [Start Winfog17] button. 

 

In this case, there is no need to create a function options file. Close the dialog box and exit Winfog17.



11-34 Seiko Epson Corporation S5U1C17001C MANUAl
  (C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

11  OTHER TOOlS

[FOG] Window (after reading the device information definition file)
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11.9.4  Window
       Option list area   Function option document area

 Message area  

The area can be resized by dragging the frame boundary.

* The microcomputer model name on the title bar is the file name (not including the path and extension) of the device 
information definition file that has been read.

* The option list and the function option document vary with each type of microcomputer.

Figure 11.9.4.1  Window configuration

The [FOG] window is divided into three areas as shown above.

Option list area
 Lists mask options set in the device information definition file (S1C17xxx.ini). Use the check boxes in this area 

to select each option. A selected option has its check box marked by ✓. 

function option document area
 Displays the contents of selected options in the function option document format. The contents displayed in this 

area are output to the function option document file. When you change any selected item in the option list area, 
the display in this area is immediately updated.

Message area
 When you create a file by selecting [Generate] from the [Tool] menu or clicking the [Generate] button, this area 

displays a message showing the result of the selected operation.

←   →

↑
↓
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11.9.5  Menus and Toolbar Buttons

This section explains each menu item and toolbar button.

[file] menu
Open
Opens a function option document file. Use this menu command when correcting an existing 
file. The [Open] button has the same function. 

 [Open] button

End
Terminates winfog17.

[Tool] menu
generate
Creates a file according to the selected contents of the option list. The [Generate] button has 
the same function.

 [Generate] button

Setup
Sets the date of creation, output file name and a comment included in the function option 
document file. The [Setup] button has the same function.

 [Setup] button

Device INI Select
Loads the device information definition file (S1C17xxx.ini). The [Device INI Select] button 
has the same function. This file must be loaded first before performing any operation with 
winfog17.

 [Device INI Select] button

[Help] menu
Version
Displays the version of winfog17. The [Help] button has the same function.

 [Help] button

The dialog box shown below appears. Click [OK] to close this dialog box.
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11.9.6  Operation Procedure

The following shows the basic operation procedure.

(1) loading the device information definition file 
 First, select a device information definition file (S1C17xxx.ini) and load it.
 Select [Device INI Select] from the [Tool] menu or click the [Device INI Select] button.
 

 [Device INI Select] button

 The dialog box shown below appears. Enter a file name including the path in the text box or select a file by 
clicking the [Ref] button. 

Click [OK], and the file is loaded. If 
the specified file exists and there is no 
problem with its contents, the option 
list and the function option document, 
which have both been set by default, are 
displayed in each area. 
To stop loading the file, click [Cancel].

 Once a device information definition file is selected, the same file is automatically loaded the next time you 
start winfog17.

Note: When you load a device information definition file after setting up options, all settings are reset to 
the default state.

(2) Setup
 Select [Setup] from the [Tool] menu or click the [Setup] button to bring up the [Setup] dialog box. From this 

dialog box, select items and enter data.
 

 [Setup] button

Date
Displays the current date. Change it as 
necessary.

Function Option Document file
Specify the function option document file 
name you want to create. The file name 
displayed by default can be modified. You 
can use the [Ref] button to look at other 
folders.

Function Option HEX
Do you make hex file?
Select whether to create a function option 
HEX file. 
The S1C17 Family does not use a function 
option HEX file, so select "No".

EPROM Type
This option is not available for S1C17 
Family microcomputers.
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 User's Name
 Enter your company name. You can enter up to 40 characters. You can use English letters, numbers, symbols, 

and spaces. The content entered here is recorded in the USER'S NAME field of the function option document 
file.

 Comment
 Enter a comment. Up to 50 characters can be entered in one line. You can enter up to 10 lines. You can use 

English letters, numbers, symbols, and spaces. Use the [Enter] key to create a new line. All comments should 
include the following information:

 • Place of business, your department or section
 • Address, telephone number, and facsimile number
 • Other: Technical information, etc.

 The content entered here is recorded in the COMMENT field of the function option document file.
 When you have finished entering the above necessary items, click [OK]. The setup contents are saved, and the 

dialog box is closed. The setup contents take effect immediately. If you click [Cancel], current settings will not 
be changed and the dialog box is closed.

Notes: • File name specification is subject to the following limitations:
1. The number of characters that can be used to specify a file name including the path is 2,048. 
2. The file name itself (not including the extension) can be up to 15 characters, and the 

extension up to three characters.
3. The file name cannot begin with a hyphen (-), nor can the following symbols be used as 

part of directory names (folder names), file names, and extensions:
 / : , ; * ? " < > |

 • The symbols shown below cannot be used in the User's Name and Comment:
  $ \ | `

(3) Selecting options
 Select necessary options by clicking the corresponding check boxes in the option list. When you change any 

selection item in the option list area, the display in the function option document area is updated. Note that 
when you have loaded the device information definition file, the option list is placed in its default selection 
state.

 For details about option specifications, refer to the Technical Manual available for each type of microcomputer.

(4) Creating files
 After selecting options, select [Generate] from the [Tool] menu or click the [Generate] button to create the files.
 

 [Generate] button

 The function option document file you specified from the [Setup] dialog box is created. When winfog17 has 
finished creating the files normally, it displays the message "Making file(s) is completed" in the message area. 
If an error occurs, an error message is displayed.
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(5) Correcting an existing document file
 You can read an existing function option document file into winfog17 and correct it as necessary.
 To read a file, select [Open] from the [File] menu or click the [Open] button.
 

 [Open] button

 The dialog box shown below appears, so enter a file name including the path in the text box or select a file by 
clicking the [Ref] button.

 Click [OK], and the file is loaded. If the specified file exists and there is no problem with its contents, the 
option list and the function option document areas are updated according to the contents of the file. To stop 
loading the file, click [Cancel].

 Perform steps (2) to (4) to update the file. 
 If you select [Generate] without changing the file name, the message shown below is displayed asking you 

whether or not to overwrite the file. Click [Yes] to overwrite or [No] or [Cancel] to stop overwriting. Use the 
[Setup] dialog box to change the file name.

Note: The function option document file can be read only when the device information definition file has 
been loaded.

(6) Quitting
 To terminate winfog17, select [End] from the [File] menu.
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11.9.7  Error/Warning Messages

The error and warning messages of winfog17 are listed below. The "Dialog" in the Display column means that 
messages are displayed in the dialog box, and "Message" means that messages are displayed in the [FOG] window 
message area.

Table 11.9.7.1  List of error messages
Message Description Display

File name error Number of characters in the file name or extension exceeds 
the limit.

Dialog

Illegal character Prohibited characters have been entered. Dialog
Please input file name File name has not been entered. Dialog
Can't open File: xxxx File (xxxx) cannot be opened.

Error message (this output is produced, for example, when a 
file is deleted during debugging).

Dialog

INI file is not found Specified device information definition file (.ini) does not exist. Dialog
INI file does not include FOG information Specified device information definition file (.ini) does not 

contain function option information.
Dialog

Function Option document file is not found Specified function option document file does not exist. Dialog
Function Option document file does not 
match INI file

Contents of the specified function option document file do not 
match device information definition file (.ini).

Dialog

A lot of parameter Too many command line parameters are specified. Dialog
Making file(s) is completed
[xxxx is no data exist]

Finished creating the file, but the created file (xxxx) does not 
contain any data.

Message

Can't open File: xxxx
Making file(s) is not completed

File (xxxx) cannot be opened when executing Generate. Message

Can't write File: xxxx
Making file(s) is not completed

File (xxxx) cannot be written when executing Generate. Message

Table 11.9.7.2  Warning message
Message Description Display

Are you file update?
xxxx is already exist

Overwrite confirmation message
(Specified file already exists.)

Dialog



S5U1C17001C MANUAl Seiko Epson Corporation 11-41
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

11  OTHER TOOlS

11
Tools

11.9.8  Sample Output file

Note: Option and other configurations vary with each type of microcomputer.

Example of a function option document file
* S1C17xxx_xxKB FUNCTION OPTION DOCUMENT Vx.xx ← Version
*
* FILE NAME    zzzzzzzz.FDC    ← File name (specified by [Setup])
* USER'S NAME  SEIKO EPSON CORPORATION   ← User name (specified by [Setup])
* INPUT DATE   yyyy/mm/dd     ← Date of creation (specified by [Setup])
* COMMENT      SAMPLE DATA     ← Comment (specified by [Setup])
*
* *** OPTION NO.1 ***     ← Option number
* --- OSC1 SYSTEM CLOCK ---    ← Option name
* Crystal(32.768KHz) ---- Selected   ← Selected specification
 OPT0101 01       ← Mask data
*
* *** OPTION NO.2 ***
* --- OSC3 SYSTEM CLOCK ---
* CR 200KHz ---- Selected
 OPT0201 01
*
* *** OPTION NO.3 ***
* --- INPUT PORT PULL UP RESISTOR ---
* K00 With Resistor ---- Selected
* K01 With Resistor ---- Selected
* K02 With Resistor ---- Selected
* K03 With Resistor ---- Selected
* K04 With Resistor ---- Selected
* K05 With Resistor ---- Selected
* K06 With Resistor ---- Selected
* K07 With Resistor ---- Selected
 OPT0301 01
 OPT0302 01
 OPT0303 01
 OPT0304 01
 OPT0305 01
 OPT0306 01
 OPT0307 01
 OPT0308 01
*
* *** OPTION NO.4 ***
* --- OUTPUT PORT OUTPUT SPECIFICATION ---
* R00 Complementary ---- Selected
* R01 Complementary ---- Selected
* R02 Complementary ---- Selected
* R03 Complementary ---- Selected
 OPT0401 01
 OPT0402 01
 OPT0403 01
 OPT0404 01
*
   :
*
* *** OPTION NO.8 ***
* --- SOUND GENERATOR POLARITY ---
* NEGATIVE ---- Selected
 OPT0801 01
*EOF       ← End mark
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11.10  winmdc17.exe

11.10.1  Outline of winmdc17

The Mask Data Checker winmdc17 is the software tool for checking the format of each generated file and creating 
the files necessary to generate mask patterns. The winmdc17 checks the built-in ROM data file generated by 
objcopy, moto2ff and sconv32, and the function option document file generated by winfog17. 
The winmdc17 also has a function for restoring the created mask data file into the original file format.

11.10.2  Input/Output files

Figure 11.10.2.1 shows the input/output files of winmdc17.

Create mask data 
(packed)

To Seiko Epson

Device information 

S1C17xxx.ini

Built-in ROM data Function option 

winmdc

Restore data 
(unpacked)

winmdc

C17xxx··yyy.pa

Figure 11.10.2.1  Input/output files of winmdc17

Device information definition file
File format: Text format file
File name: S1C17xxx.ini

Description: This file contains option lists for various types of microcomputers and other information. Always 
be sure to use the files presented by Seiko Epson. This file is effective for only the type of 
microcomputer indicated by the file name. Do not modify the contents of the file or use the file in 
other types of microcomputers.

Built-in ROM data HEX file
File format: Motorola S2 format file
File name: <filename>.psa
Description: This is the built-in ROM data file in Motorola S2 format. This file is created by objcopy, moto2ff 

and sconv32. The unused areas in the built-in ROM are filled with 0xff.

function option document file
File format: Text format file
File name: <filename>.fdc
Description: This is a text format file in which the contents of selected function options are stored. This file is 

created by function option generator winfog17.

Pack file
File format: Text format file
File name: <filename>.pa
Description: This is a text format file which contains the above data files combined into one. We would like 

to have this file presented to Seiko Epson as the mask data file. Seiko Epson will create the mask 
patterns for the IC from this mask data file.
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Unpacked file
File format: Motorola-S2-format file
File name: <filename>.usa
Description: This is a Motorola-S2-format internal ROM data file for a data file section separated from a 

packed file. The content is the same as the internal ROM data file used for packing.

Unpacked function option document file
File format: Text-format file
File name: <filename>.ufd
Description: This is a text-format file for a function option document file section separated from a packed file. 

The content is the same as the function option document file used for packing.
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11.10.3  Starting Up

Startup from Explorer
Double-click on the winmdc17.exe icon or select winmdc17 from the start menu.
If the device information definition file (S1C17xxx.ini) was loaded into your computer during a 
previous execution, winmdc17 automatically reads the same file as it starts. 
Alternatively, drag the device information definition file icon into the winmdc17.exe icon to start 
winmdc17, which will then read the device information definition file.

Startup from IDE
 To start winmdc17, select [Pack with winmdc17] from the IDE [GNU17 Actions] menu or click the [Pack with 

winmdc17] toolbar button.

When winmdc17 starts, it displays the [MDC] window.

[MDC] Window (initial screen)

* The microcomputer model name on the title bar is the file name (not including the path and extension) of the device 
information definition file that has been read.

* The [Pack] and [Unpack] buttons on the tool bar are enabled when the device information definition file is read.
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11.10.4  Menus and Toolbar Buttons

This section explains each menu item and toolbar button.

[file] menu
End
Terminates winmdc17.

[Tool] menu
Pack
Packs the ROM data file and option document file to create a mask data file for presentation 
to Seiko Epson. The [Pack] button has the same function. 

 [Pack] button

Unpack
Restores files in the original format from a packed file. The [Unpack] button has the same 
function.

 [Unpack] button

Device INI Select
Loads the device information definition file (S1C17xxx.ini). The [Device INI Select] button 
has the same function. This file must be loaded first before performing any operation with 
winmdc17.

 [Device INI Select] button

[Help] menu
Version
Displays the version of winmdc17. The [Help] button has the same function.

 [Help] button

The dialog box shown below appears. Click [OK] to close this dialog box.
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11.10.5  Operation Procedure

The following shows the basic operation procedure.

(1) loading the device information definition file
 First, select a device information definition file (S1C17xxx.ini) and load it.
 Select [Device INI Select] from the [Tool] menu or click the [Device INI Select] button.
 

 [Device INI Select] button

 The dialog box shown below appears. Enter a file name including the path in the text box or select a file by 
clicking the [Ref] button. 

 Click [OK], and the file is loaded. If the specified file exists and there is no problem with its contents, the set-
up items in winmdc17 are initialized with the loaded device information. 

 To stop loading the file, click [Cancel].
 Once a device information definition file is selected, the same file is automatically loaded the next time you 

start winmdc17.

(2) Packing
1. Select [Pack] from the [Tool] menu or click the [Pack] button on the tool bar to bring up the [Pack] dialog 

box.

  [Pack] button
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2. Select the files to be entered.
 [Pack Input Files] lists the files of the type specified in the device information definition file by their default 

file names. If the data files to be entered are represented by different names in this list, replace the file 
names following the procedure below.

 a. Select a file name to be changed by clicking on it from the list box.   
 b. Click the [Ref] button and select the data file to be entered.
 Do this for all files listed. 
 When replacing files, take care not to mistake one file type (extension) for another. If the type of input file 

is erroneous, an error will result during file packing.

3. Setting output file names.
 In the [Pack Output File] text box, specify a pack file name in which you want the mask data to be output. 

The file name displayed by default can be modified. You can use the [Ref] button to look at other folders.
 Make sure the extension of the output file name is ".pa". 

Note: File name specification is subject to the following limitations:
1. The number of characters that can be used to specify a file name including the path is 2,048. 
2. The file name itself (not including the extension) can be up to 15 characters, and the extension 

up to three characters.
3. The file name cannot begin with a hyphen (-), nor can the following symbols be used as part of 

directory names (folder names), file names, and extensions:
 / : , ; * ? " < > |

4. Click the [Pack] button to execute packing.
 When winmdc17 has completed packing, it dsiplays a message "Packing completed!" in the [Pack 

message] text box. If an error has occurred, an error message is displayed.

5. Click the [Cancel] button to close the dialog box.
 Alternatively, you can click the [Cancel] button to quit winmdc17 before it executes packing.
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(3) Unpacking
1. Select [Unpack] from the [Tool] menu or click the [Unpack] button on the tool bar to bring up the [Unpack] 

dialog box.
 

 [Unpack] button

 

2. Select the file you want to unpack.
 In the [Packed Input File] text box, specify the pack file name you want to enter. Use the names displayed 

by default to specify this file name after changing one, or select another file using the [Ref] button.

3. Select the output file name.
 [Unpack Output Files] lists the files of the type specified in the device information definition file by their 

default file names. Modify the file name displayed by the following procedure. 
a. Click in the list box to select the file name to be modified.
b. Click the [Ref] button to select another folder, and then enter a file name. Modify all the listed file names. 

The extensions cannot be changed.

4. Click the [Unpack] button to execute unpacking.
 When winmdc17 has completed unpacking, it displays a message "Unpacking completed!" in the [Unpack 

message] text box. If an error has occurred, an error message is displayed.

5. Click the [Cancel] button to close the dialog box.
 Alternatively, you can click the [Cancel] button to quit winmdc17 before it executes unpacking.

(4) Quitting
 To terminate winmdc17, select [End] from the [File] menu.
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11.10.6  Error Messages

The error messages of winmdc17 are listed below. The "Dialog" in the Display column means that messages are 
displayed in the dialog box, and "Message" means that messages are displayed in the message area of the [Pack] or 
[Unpack] dialog box.

Table 11.10.6.1  List of I/O error messages
Message Description Display

File name error Number of characters in the file name or extension exceeds 
the limit.

Dialog

Illegal character Prohibited characters have been entered. Dialog
Please input file name File name has not been entered. Dialog
INI file is not found Specified device information definition file (.ini) does not 

exist.
Dialog

INI file does not include MDC information Specified device information definition file (.ini) does not 
contain MDC information.

Dialog

Can't open file : xxxx File (xxxx) cannot be opened. Dialog
Can't write file: xxxx File (xxxx) cannot be written. Dialog

Table 11.10.6.2  List of ROM data error messages
Message Description Display

Hex data error: Not S record. Data does not begin with "S." Message
Hex data error: Data is not sequential. Data is not listed in ascending order. Message
Hex data error: Illegal data. Invalid character is included. Message
Hex data error: Too many data in one line. Too many data entries exist in one line. Message
Hex data error: Check sum error. Checksum does not match. Message
Hex data error: ROM capacity over. Data is large. (Greater than ROM size) Message
Hex data error: Not enough the ROM data. Data is small. (Smaller than ROM size) Message
Hex data error: Illegal start mark. Start mark is incorrect. Message
Hex data error: Illegal end mark. End mark is incorrect. Message
Hex data error: Illegal comment. Model name shown at the beginning of data is incorrect. Message

Table 11.10.6.3  List of function option data error messages
Message Description Display

Option data error : Illegal model name. Model name is incorrect. Message
Option data error : Illegal version. Version is incorrect. Message
Option data error : Illegal option number. Option No. is incorrect. Message
Option data error : Illegal select number. Selected option number is incorrect. Message
Option data error : Mask data is not enough. Mask data is insufficient. Message
Option data error : Illegal start mark. Start mark is incorrect. Message
Option data error : Illegal end mark. End mark is incorrect. Message
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11.10.7  Sample Output file

Note: The configuration and contents of data vary with each type of microcomputer.

Example of a pack file (mask data file)
*
* S1C17xxx_xxKB MASK DATA VER x.xx  ← Version
*
\ROM1       ← Built-in ROM HEX data start mark
S1C17xxxyyy PROGRAM ROM    ← Model name
S224008000................................
 :       :       :       :       :  "xxxxxxxx.psa"
S804000000FB
\END       ← Built-in ROM HEX data end mark
\OPTION1       ← Function option start mark
* S1C17xxx FUNCTION OPTION DOCUMENT V x.xx ← Model name/version
*  
* FILE NAME    zzzzzzzz.FDC
* USER'S NAME  SEIKO EPSON CORPORATION
* INPUT DATE   yyyy/mm/dd
* COMMENT      SAMPLE DATA
*        "xxxxxxxx.fdc"
* *** OPTION NO.1 *** 
* --- OSC1 SYSTEM CLOCK --- 
* Crystal(32.768KHz) ---- Selected
 OPT0101 01
 :       :       :       :       :
 OPTnn01 01
*EOF
\END       ← Function option end mark
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11.11  lcdUtil17 (lCD Panel Customizing Tool)

11.11.1  Overview

The LCD panel customizing tool (LcdUtil17) produces an LCD file that describes the LCD panel layout and 
COM/SEG port allocation. This file is used by the ES-Sim17 (v.1.2 or newer) built-in simulator to simulate a 
monochrome LCD panel screen. LcdUtil17 produces a layout of the segment LCD from a bitmap file (.bmp), 
allowing the ES-Sim17 to simulate the screen that would appear on an actual product. This tool also lets users 
produce dot-matrix LCD layouts.

11.11.2  Input/Output files

Figure 11.11.2.1 shows the LcdUtil17 input and output files.

file.lcd 

LcdUtil17 

ES-Sim17 

LCD file 

file.bmp Icon bitmap file essim17.ini 
Device information 

definition file 

Figure 11.11.2.1 LcdUtil17 input/output files

Model information definition file (essim17.ini)
This file contains recorded information on the simulator model. Be sure to use the setting file provided by Seiko 
Epson. Modifying the contents of this file may prevent the LcdUtil17 and ES-Sim17 operating properly.

Bitmap file (file_name.bmp)
This bitmap file contains an LCD panel image (in monochrome). LcdUtil17 reads this bitmap file, then loads each 
part as an icon, allowing editing of the layout in the LcdUtil17 window.

lcd file
This file contains an LCD panel layout and COM/SEG allocation information and is loaded into the simulator for 
LCD screen simulation.
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11.11.3  Starting and Closing lcdUtil17

To start LcdUtil17, select [Start LcdUtility] from the [GNU17 Actions] menu of the IDE or click the  button 
on the IDE toolbar. 
To end the LcdUtil17 program, select [Exit] from the [File] menu.

11.11.4  Window

Panel editing window
Opening a bitmap file (.bmp) or LCD file (.lcd) will display the file in this window.
This window is used to design an LCD panel layout and assign COM/SEG.
Two or more windows can be opened at the same time, and icons and dot matrices can be dragged and dropped 
between two windows.
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11.11.5  Menus and Toolbar

11.11.5.1  Menus

[file] menu
[New] ([Ctrl]+[N])
Opens a new panel editing window.
[Open...] ([Ctrl]+[O])
Opens an LCD file (.lcd).
[Open Bitmap file…]
Opens a bitmap file (.bmp).
[Close]
Closes the active panel editing window.
[Save] ([Ctrl]+[S])
Saves the contents of the active panel editing window to the 
LCD file (.lcd) (by overwriting).
[Save As…]
Saves the contents of the active panel editing window to an LCD 
file (.lcd) under a new name.
[Print...] ([Ctrl]+[P])
Prints the bitmap data in the active panel editing window.
[Print Preview]
Displays the print image of the active panel editing window.
[Print Setup…]
Opens the dialog box used for selecting the paper size or printer 
to use.
File list
Displays up to eight previously opened files and enables access 
to those files.
[Exit]
Ends LcdUtil17.
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[Edit] menu
[Cut] ([Ctrl]+[X])
Cuts the part selected in the panel editing window and 
copies it to the clipboard.
[Copy] ([Ctrl]+[C])
Copies the part selected in the panel editing window to the 
clipboard.
[Paste] ([Ctrl]+[V])
Pastes the part copied in the clipboard to the upper left 
corner of the panel editing window.
[Insert dot matrix] ([Ctrl]+[M])
Inserts a dot matrix in the panel editing window. Use the 
dialog box to change dimensional settings, if necessary.
[Icon list] ([Ctrl]+[I])
Displays a list of icons appearing in the active panel editing 
window. This list can also be used to allocate COM/SEG.
[Resize lCD]
Sets the size of the LCD panel. The default size of the new 
panel editing window is 640 x 480.
[group Icon]
Sets multiple icons as a group.
[Release group]
Cancels the grouping and returns the grouped icons to 
separate icons.

[View] menu
[Toolbar]
Displays or hides the toolbar.
[Status Bar]
Displays or hides the status bar.

[Window] menu
[Cascade]
Rearranges all open panel editing windows in cascading 
format.
[Title]
Rearranges all open panel editing windows in tiled format.
[Arrange Icons]
Minimizes all open panel editing windows to icons at the 
bottom of the window.
Window list
Displays a list of names of all currently open panel editing 
windows.
Select a panel editing window in the list to activate the 
selected panel editing window.
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[Help] menu
[About lcdUtil…]
Displays LcdUtil17 version information.

11.11.5.2  Toolbar Buttons

 [New] button

 Opens a new panel editing window.

 [Open] button

 Opens an LCD file (.lcd).

 [Bitmap] button

 Opens a bitmap file (.bmp).

 [Save] button

 Saves the contents of the active panel editing window to the LCD file (.lcd) (by overwriting).

 [Dot Matrix] button

 Inserts a dot matrix in the panel editing window.

 [Icon list] button: [Edit] － [Icon List]

 Displays a list of icons appearing in the active panel editing window.

 [Cut] button

 Cuts the part selected in the panel editing window and copies it to the clipboard.

 [Copy] button

 Copies the part selected in the panel editing window to the clipboard.

 [Paste] button

 Pastes the part copied in the clipboard to the upper left corner of the panel editing window.

 [Undo] button

 Cancels up to three of the most recent operations.
 Commands that can be undone include Move, Cut, and Paste for icon/dot matrix, Change of SEG/COM, 

Group Icon, Release Group

 [Redo] button

 Reperforms the command most recently undone with Undo.

 [Print] button

 Prints the bitmap image in the active panel editing window.

 [About] button

 Displays LcdUtil17 version information.
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11.11.6  Producing an lCD file

The panel editing window allows icons and dot matrices to be laid out in the same way as they would appear on an 
actual LCD panel. It also permits COM/SEG allocation. Described below are the procedures for producing an LCD 
file.

11.11.6.1  Producing a Dot Matrix lCD Panel
1) Select [New] from the [File] menu.
 A blank panel editing window will open.

2) Select [Resize LCD] from the [Edit] menu.
 The [Resize LCD image] dialog box will open.

 Enter the LCD panel size, then click the [OK] button.
 The default LCD size of a new panel editing window is 640 x 480 dots.
 Calculate the dot matrix size and set the LCD panel size.
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3) Select [Insert dot matrix] from the [Edit] menu.
 If no LCD driver is set, the [LCD Driver] dialog box appears.
 From the list, select the model for development, then click the [OK] button.

* The [LCD Driver] dialog box appears only when no LCD driver has been set. 
When an already produced LCD file is read or when the LcdUtil17 start button of the IDE is clicked while 
a project is selected by the IDE, an LCD driver is already set and this dialog box does not appear.

Note: Once set, an LCD driver cannot be changed. Be extremely careful when setting the LCD driver.

4) The [Dot matrix] dialog box appears.
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Figure 11.11.6.1.1  Dot matrix setting

Make the following settings in the [Dot matrix] dialog box.

Position
 Specify the coordinates of the upper left corner of the dot matrix. (X and Y in the diagram)

Number of dots
 Specify the number of dots along the horizontal and vertical axes of the dot matrix. (C and R in the 

diagram)

Dot size
 Specify the size of each dot in the dot matrix by entering the number of dots. (W and H in the diagram)

Pitch size
 Specify the interval between dots in the dot matrix by entering the number of dots. (h and v in the diagram)

Driver
 Indicates the name of the currently set LCD driver. This cannot be changed.
 The maximum COM/SEG value is set by the LCD driver.

COM/SEg
 Select the COM/SEG port allocating direction. Port numbers will be allocated in sequence based on the 

COM/SEG values specified in the [Start] text box.

 Click the [Preview] button after making the settings above. A dot matrix will be displayed in the panel 
editing window for confirmation. Click the [OK] button to produce a dot matrix based on the settings 
entered.
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Dot matrices allocated with a COM/SEG port are indicated in red.
Double-click a dot matrix to display the [Dot matrix] dialog to change settings.

Note: A dot matrix that is copied and pasted retains position and size information but discards port 
allocation information. Dot matrices without allocation information are indicated in black.
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11.11.6.2  Producing a Segment lCD Panel
1) Prepare a bitmap file of an icon for segment LCD.
 Although bitmap files can be created with an ordinary paint application, note the following when creating 

files:

Number of colors and file format
Set the background to white and create an icon in black. Save data in monochrome bitmap format (.bmp).
* You can read a color bitmap file, but binarization may not complete successfully, in certain cases.

Size
Keep the size of the bitmap file less than 1280 x 1024.

Number of files
 You can use several icons produced in several separate bitmap files to create a segment LCD panel in the 

LcdUtil17 window. However, since LcdUtil17 offers only simplified editing functions, we recommend 
producing one bitmap file.

2) Read a bitmap file.
Start LcdUtil17, and select [Open Bitmap File] from the [File] menu.
Select the bitmap file you created.
A panel editing window will open and display the read bitmap.

3) Edit the icon layout.
 

Icon condition
Icons can be in one of the following three states.
 Black: COM/SEG information not set
 Red: COM/SEG information set
 Blue: In selected state

Editing icons
You can perform the following operations on a selected icon.

Change of position
Drag with the mouse to move an icon. You can also move an icon from one panel editing window to another 
by dragging and dropping.

Cut, Copy
Select the command from the [Edit] menu or click the toolbar button.
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Paste
Select the command from the [Edit] menu or click the toolbar button.
The icon will be pasted at the upper left corner of the LCD panel.

Delete
Press the [delete] key to delete the icon.

Group
 [You can select multiple icons by holding down the [Ctrl] key while clicking. Set the multiple selected 

icons as a group by selecting [Group Icon] from the [Edit] menu. Once grouped, the icons can be treated as 
a single icon.

 To cancel the grouping, select [Release Group] from the [Edit] menu.

Note: Grouped icons reflect the COM/SEG information corresponding to the icon selected last. 
If the icons are then ungrouped, the individual icons will have the COM/SEG information 
corresponding to the grouped icons.

Note: LcdUtil17 offers only simplified functions. We recommend completing layout during bitmap 
production.

4) Allocate a port to the icon.
 Double-click the icon.
 The [LCD Driver] dialog box opens.

4-1) If no LCD driver has been set, the [LCD Driver] dialog box will appear.
  From the list, select the model for development, then click the [OK] button.

* The [LCD Driver] dialog box appears only when no LCD driver has been set. When an already produced 
LCD file is read or when the LcdUtil17 start button of the IDE is clicked while a project is selected by 
the IDE, an LCD driver is already set and this dialog box does not appear.

Note: Once set, an LCD driver cannot be changed. Be extremely careful when setting the LCD 
driver.
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4-2) The [COM/SEG] dialog box appears.

COM, SEG
Select from the pull-down list. COM/SEG allocation is applied immediately after the change is made.

[Reset] button
Click this button to clear COM/SEG settings and set COM/SET in the "not set" state.

Driver
Indicates the name of the currently set LCD driver. This cannot be changed.
The maximum COM/SEG value is set by the LCD driver.

Uninitialized data
You can initiate settings if you click an icon for which no COM/SEG has been set.

No operation The COM/SEG information will not be changed.
Copy COM and SEG The displayed COM/SEG information will be set to the icon.
Increment COM The COM will be incremented (+1) and set to the displayed COM/SEG 

information.
Increment SEG The SEG will be incremented (+1) and set to the displayed COM/SEG 

information.

Note: The port allocation information is discarded if you copy and paste an icon or move an icon from 
another panel editing window. Dot matrices without allocation information appear in black.
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5) Display the icon list.
 Select [Icon List] from the [Edit] menu.
 A list appears and shows the icons in the currently active panel editing window.

Click an icon in the list to display the corresponding icon in the panel editing window in blue.
In this window, you can also change COM/SEG information for icons.

11.11.7  Shortcut Key list

The following shows a list of shortcut keys available with LcdUtil17.

Table 11.11.7.1  List of shortcut keys

Function Shortcut key

Copy
Ctrl + C
Ctrl + Insert

Cut
Ctrl + X
Delete

Paste
Ctrl + V
Shift + Insert

Icon List Ctrl + I

Dot Matrix Ctrl + M

New Ctrl + N

Open Ctrl + O

Save Ctrl + S

Print Ctrl + P

Undo
Ctrl + Z
Alt + BS

Redo Ctrl + Y
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11.11.8  Warning Messages and Error Messages

The following is a list of warning messages displayed by LcdUtil17.

Table 11.11.8.1  List of warning messages

No. When creating or opening a file

1 A blank document could not be created.

Cause: A new window could not be opened because more than 100 windows are currently open. 
A new window could not be opened due to insufficient memory.

Corrective action: Close windows to reduce the number of open windows to 99 or less. Close other 
applications to increase available memory.

2 Unexpected file format

Cause: The file was not in the correct lcd or bmp format. The file was an lcd file with an 
unsupported driver.

Corrective action: Select a file supported by LcdUtil17.

When entering an input

3 Enter an integer value between ???? and ????.

Cause: A value outside the allowed range was entered.

Corrective action: Enter a correct value.

4 Enter an integer.

Cause: A nonnumeric character was entered in the edit box for integer input.

Corrective action: Enter a correct value.

Dot matrix setting window (when Preview button is pressed)

5 Invalid ???? （???? = position、number of dots、dot size、pitch size、start COM/SEG）
Cause: An invalid value is entered in ????.

Corrective action: Enter a correct value.

6 Invalid ??? start number or Invalid number of dots （??? = COM、SEG）
Cause: The number of COM/SEG allowed by the driver has been exceeded, based on settings for 

Start ???, dot count, and COM/SEG allocation direction.

Corrective action: Set the Start ???, dot count, and COM/SEG allocation direction in accordance with the 
number of COM/SEG allowed by the driver.

No. When using [Save as]

7 Some icons/matrixes are out of LCD panel. Remove them? [OK][Cancel]

Cause: An attempt was made to save data while an icon or dot matrix extended from the LCD 
panel.

Corrective action: Move the icon or dot matrix so that it does not extend from the LCD panel or click the [OK] 
button to remove the icon or dot matrix extending from the LCD panel before saving.

When creating an icon or reading a file

8 The number of the icon is exceeding 4096 pieces.

Cause: The total number of icons exceeded the maximum value of 4096.

Corrective action: Reduce the total number of icons to less than 4096.

9 The number of the icon is exceeding 4096 pieces. Loaded the icons to 4096 pieces.

Cause: The total number of icons exceeded the maximum value of 4096.

Corrective action: Reduce the total number of icons to less than 4096.

When creating a matrix or reading a file

10 The number of the matrix is exceeding 10 pieces.

Cause: The total number of dot matrices exceeded the maximum value of 10.

Corrective action: Reduce the total number of dot matrices to less than 10.
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No. When saving data or closing a window without saving changes

11 This file was not saved.

Cause: The icon or dot matrix extending from the LCD panel was not removed.

Corrective action: Data cannot be saved if an icon or dot matrix extends from the LCD panel.

The following shows a list of error messages displayed by LcdUtil17.

Table 11.11.8.2  List of error messages

No. During startup

1 Cannot open bitmap file. The size of the panel is too large.

Cause: The vertical or horizontal size of the bitmap file is too large.

Corrective action: Use a bitmap file with a horizontal size of no more than 1280 and a vertical size of no 
more than 1024.
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11.12  Stand-Alone flash Writer

11.12.1  Overview

The stand-alone flash writer writes data or addresses to the ICDmini flash memory via the debugger in advance. 
The ICDmini FLASH WRITER mode makes it easy to write to the target without the debugger. 
Debugger commands are used to write data and addresses to the ICDmini flash memory. To select FLASH 
WRITER mode, set the DIP switch on the side of the ICDmini main body.
The ICDmini stand-alone flash writer implements three types of processing: ERASE, WRITE, and VERIFY. Select 
the desired processing by setting the DIP switch on the side of the ICDmini main body.
After completing these settings, press RESET/START button in the upper part of ICDmini to begin the selected 
processing of the flash writer. The LED on ICDmini indicates the execution status of the selected processing. 
To write the same data once again, simply press RESET/START button in the upper part of ICDmini to execute the 
flash writer. You do not need to repeat the initial settings.

11.12.2  Procedures for Stand-Alone flash Writer

To execute a stand-alone flash writer, you will need the following two files.
・ The ROM file to be written to target flash memory
・ The program file for erasing and writing target flash memory

First, generate the ROM file (in Motorola S3 format) to be written to target flash memory. Generate the file using 
objcopy.exe and moto2ff.exe (included in the S1C17 Family C compiler package).

(1) Convert the generated elf file into Motorola S3 format.
 Example: To convert sample.elf into sample.sa in Motorola S3 format:
  ＞objcopy -I elf32-little -O srec -R .gbss --srec-forceS3 sample.elf sample.sa

• Refer to Section 11.4, "objcopy.exe" for detailed information on parameters.

(2) Fill the unused area of the generated sa file with 0xff data.
 Example: To fill the unused area of the generated sample.sa with 0xff:
  (When the data start address is 8000h and target block size is 1000h)
  > moto2ff 8000 1000 sample.sa

• The extension of the output file is saf. This does not need to be changed.

Next, prepare the program file for erasing and writing the target flash memory. This file is placed under "GNU17\
mcu_model\17xxx\fls." ("xxx" in "17xxx" indicates the model name.) Note that the folder differs from model to 
model.

(3) Prepare the erasing and writing program file appropriate for the target model and the ICDmini firmware 
version.

 Example: When the target model is c17701 and the ICDmini firmware version is Ver1.1:
 Use GNU17\mcu_model\17701\fls\fwr17701v11.saf.

• Use fls17701.elf in the same folder when you write the flash memory using the debugger.
• Use fwr17701v10.saf in the same folder when the ICDmini firmware version is Ver. 1.0. Since the speed of 

the flash writer is improved in Ver. 1.1, we recommend updating the firmware if you are currently using Ver. 
1.0.

When the required files above are ready, download the two files to ICDmini flash memory.



S5U1C17001C MANUAl Seiko Epson Corporation 11-67
(C COMPIlER PACKAgE fOR S1C17 fAMIly) (Ver. 2.0.0)

11  OTHER TOOlS

11
Tools

(4) Connect ICDmini to the PC and the target and set to ICD mode.
 After connecting ICDmini to the PC and the target, turn off DIP switches 2 and 3 on the side of ICDmini.

(5) Start the debugger and connect the debugger and the target.
 Follow the procedures described in the S5U1C17001H User Manual (Refer to Section 5.2) to start ICDmini. 

Start the gdb debugger from the command prompt (or GNU17 IDE).

(6) Connect the target and the debugger.

  (gdb) 
  target icd usb

• If the connection fails, repeat steps (5) and (6).

(7) Download the program for erasing and writing the target flash memory to ICDmini using the c17 fwlp 
command.

 Example 1: When the target model is c17701 and the ICDmini firmware version is Ver. 1.1:

  (gdb) 
  c17 fwlp fwr17701v11.saf 0x48 0x80

• Specify the file name selected in step (3) for the first parameter (erasing and writing program file name). 
• Refer to readme in NU17\mcu_model\17xxx\fls for more information on the second and third parameters 

(erasing and writing routine addresses). Note that the setting value differs depending on the model and 
firmware version.

 Example 2: For Target device c17554, ICDmini Ver.2.0(S5U1C17001H2100)
  (gdb)
   c17 fwlp fwr17554v11.saf 0x0c 0x40 "-v7.0-7.0"

• Set the delete voltage and write voltage for the 4th parameter (comment) for a microprocessor with flash 
programming power pin. The setting will vary depending on the model. Refer to the specific information 
given for "Electrical Characteristics" in the corresponding technical manual.

(8) Download the ROM data to be written to the target flash memory to ICDmini using the c17 fwld (or c17 fwdc) 
command.

 Example: When the target model is c17701 and to erase all blocks and write sample.saf:
  (gdb) 
  c17 fwld sample.saf 0 0 0x8000

• Set the range to be erased with the second and third parameters (start and end blocks for erasing) and the 
fourth parameter (flash memory start address) at the same time.

(9) Quit the debugger.
  (gdb) 
  quit

• The debugger will not be used in the subsequent steps.

(10)Set ICDmini to FLASH WRITER mode and set the processing to be performed.
 Turn on DIP switches 2 and 3 on the side of ICDmini and restart ICDmini.

• Turning on either DIP switch 2 or 3 enables FLASH WRITER mode.

(11)Press RESET/START button in the upper part of ICDmini to start the flash writer.
 If the LED for FLASH WRITER mode does not turn on before the flash writer starts or a flashing error occurs 

immediately after entering this mode, restart ICDmini as for ICD mode.
• Refer to Section 6.2 of the S5U1C17001H User Manual for LED specifications and for other information 

when using the stand-alone flash writer.

When the LED corresponding to the selected ICDmini processing turns green, the processing is completed.
To write the same data to a different target, repeat the steps from step (10).

・ Refer to Section 10.7, "Command Reference" for detailed information on debugger commands.
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11.13  Old Debugger Version

This version of the S1C17 Family C/C++ compiler package can be used with debugger versions up to 1.5.0. For 
details of launching and operation methods, refer to the 1.5.0 version manual. The 1.5.0 version manual can be 
downloaded via the Seiko Epson user website.



S1C17 Family C Compiler Package

Quick Reference

概要

インストール

開発手順

ソース

IDE

Cコンパイラ

ライブラリ

アセンブラ

リンカ

デバッガ

ツール

 Reference



 Reference

CMOS 16-bit Single Chip Microcomputer

S1C17 family C Compiler Package

Quick Reference
for Development

Memory Map and Trap Table (S1C17 Core) S1C17 Core

Memory Map Trap Table

Registers (S1C17 Core) S1C17 Core

general-purpose Registers (8) Special Registers (3) PSR

Reserved Core I/O area
1K bytes

Internal memory/
Internal peripherals/

User area

TTBR: Trap table start address
(Can be read from address 0xffff80.)

R7
R6
R5
R4
R3
R2
R1
R0

23 0
PC

PSR

SP

Program counter

Processor status register

Stack pointer

23

7

0

23 0

0

IL[2:0]
7 6 5

IE
4

C
3

V
2

Z
1

N
0

IL[2:0]:
IE:
Z:
N:
C:
V:

Interrupt level
Interrupt enable
Zero flag
Negative flag
Carry flag
Overflow flag

(0–7: Enabled interrupt level)
(1: Enabled, 0: Disabled)
(1: Zero, 0: Non zero)
(1: Negative, 0: Positive)
(1: Carry/borrow, 0: No carry)
(1: Overflow, 0: Not overflown)

0xff ffff

0xff fc00
0xff fbff

0x00 0000

Reset
Address misaligned interrupt

NMI
Maskable external interrupt 3

:
Maskable external interrupt 31

Vector address
TTBR + 0x00
TTBR + 0x04
TTBR + 0x08
TTBR + 0x0c
          :
TTBR + 0x7c

No.
0 (0x00)
1 (0x01)
2 (0x02)
3 (0x03)

:
31 (0x1f)

0 0 0 0 0 0 0 0Initial value
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Software Development flowchart Development Tools

1. Creating a project
Use the IDE to create a new project or importing an 
existing project.

2. Editing source files
Edit resources such as the sources using the IDE editor or 
a general-purpose editor.

3. Building (Compile, Assemble, Link)
3-1) Edit the build options and linker script in the IDE 
project property dialog box. (Also the makefile and linker 
script file created by the user can be used.)
3-2) Execute the make.exe using the IDE. 
The make.exe executes the C Compiler xgcc, Assembler 
as and Linker ld sequentially to generate an executable 
object file (.elf).

4. Debugging
4-1) Edit the parameter and the command file to be 
executed at gdb startup at the project properties in the IDE.
4-2) Start up the debugger gdb from the IDE.
4-3) Debugging the program using the debug commands.

5. Mask data creation
When the program development has been completed, 
create the mask data file.
5-1) Create the ROM data file using objcopy, moto2ff and 
sconv32.
5-2) Create the option data file using winfog17.
5-3) Pack the ROM data file and option data file into a 
mask data file using winmdc17.
5-4) Submit the created data file to Seiko Epson.
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gNU17 IDE (1) Development Tools

Overview
The gNU17 IDE provides an integrated development environment that 
allows the user to easily develop software with the S1C17 Family C Compiler 
Package (S5U1C17001C).

Start-up Command
eclipse

Views
Displays various information by contents. To open a closed view, select it from 
[Show View] on the [Window] menu.

Editor
Edits text files such as C sources and assembler sources.

 Status bar

Create new resources Select perspective

Create new directory/file
Launch

debugger

Search Navigate

Save/Print
Build Select 

working set
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Menu Bar Menu Bar
[file] menu [Edit] menu

New (Alt+Shift+N)  Creates a new project, a new file and a 
new directory.
Open file...  Choose a file to be opened with the editor.
Close (Ctrl+W)  Closes the current active file.
Close All (Ctrl+Shift+W)  Closes all files open in the editor.
Save (Ctrl+S)  Saves changes made in the current file.
Save As...  Saves the current active file under another name.
Save All (Ctrl+Shift+S)  Saves all open files.
Revert  Discards any changes made in the current active file, 
reverting to the previously saved version.
Move...  Moves the file or directory selected in the [C/C++ 
Projects]/[Navigator] view to a different location.
Rename... (f2)  Places the file or directory selected in the 
[C/C++ Projects]/[Navigator] view in editing mode (allowing 
renaming of the file or directory).
Refresh (f5)  Updates the displayed content of the [C/C++ 
Projects]/[Navigator] view.
Convert line Delimiters To  Selects a line delimiting 
character.
Print... (Ctrl+P)  Prints the current active file.
Switch Workspace...  Selects another workspace.
Restart  Restarts the IDE.
Import...  Adds an existing project or source file to the current 
workspace or project.
Export...  Writes the file in the current project out to another 
directory.
Properties (Alt+Enter)  Displays or edits properties of the 
project, file, or directory currently selected in the [C/C++ 
Projects]/[Navigator] view.
Exit  Closes the IDE.

Undo Typing (Ctrl+Z) Undoes the most recent operation 
performed.
Redo Typing (Ctrl+y)  Repeats the last operation canceled 
by [Undo Typing].
Cut (Ctrl+X)  Cuts the selected string/file/directory.
Copy (Ctrl+C)  Copies a selected string/file/directory.
Paste (Ctrl+V)  Pastes the copied content from the clipboard. 
Delete (Delete)  Deletes the selected string/file/directory.
Select All (Ctrl+A)  Selects all of the contents in currently 
active document in the editor.

find/Replace... (Ctrl+f)  Finds and replaces a string in 
the editor.
find word  Searches for the next occurrence matching the 
search string.
find Next (Ctrl+K)  Jumps to the next instance of a 
search string.
find Previous (Ctrl+Shift+K)  Jumps back to the previous 
instance of a search string.
Incremental find Next (Ctrl+J)  Performs incremental 
search backward from the current position in the editor.
Incremental find Previous  Performs incremental search 
forward from the current position in the editor.
Add Bookmark...  Registers a line in an active document 
in the editor at the current cursor position as a bookmark.
Add Task...  Registers the line at the current cursor position 
in an active document in the editor as a task (memorandum).
Smart Insert Mode (Ctrl + Shift + Insert)  Changes the 
editor Smart Insert Mode.
Show Tooltip Description (f2)  Press the [F2] key while 
a tooltip is displayed to focus on the tooltip.
Word Completion (Alt + /)  Inserts a word beginning with the 
character being entered in the editor at the current position.
Quick fix (Ctrl + 1)  Displays proposals for error/warning 
corrections.
Content Assist (Ctrl + Space)  Helps enter a C source 
keyword or template.
Parameter Hints (Ctrl + Shift + Space)  Displays a tip for 
function arguments.
Shift Right Moves  the beginning of a line to the right.
Shift left (Shift + Tab)  Moves the beginning of a line to 
the left.
format (Ctrl + Shift + f)  Formats a text according to 
formatter settings.
Set Encoding...  Selects the text-encoding format.

Rename... (Alt + Shift + R)  Changes the name of a 
selected function or variable.
Extract Constant (Alt + C)  Cuts out a constant from a 
source file for use in a variable.
Extract function (Alt + Shift + M)  Cuts out a part of a 
code from a source file for use in a function.

gNU17 IDE (2) Development Tools

[Edit] menu

[Refactor] menu



 Reference

Menu Bar Menu Bar
[Navigate] menu

[Search] menu

[Project] menu

[Run] menu

[Window] menu

go Into  Changes display of the [C/C++ Projects]/[Navigator] view 
to display the content of just the currently selected directory.
go To  Navigates the display history of the [C/C++ Projects]/ 
[Navigator] view.
Open Declaration (f3)  Opens the declaration or definition of a 
selected object.
Open Type Hierarchy (f4)  Opens the type hierarchy of a selected 
variable.
Open Call Hierarchy (Ctrl + Alt + H)  Opens the call hierarchy of a 
selected function.
Open Include Browser (Ctrl + Alt + I)  Opens the include hierarchy 
of a selected source file.
Toggle Source/Header (Ctrl + Tab)  Switches to the corresponding 
source file and header file with the editor.
Show In (Alt+Shift+W)  Selects a view to highlight the resource 
that includes the selected function name, variable name, or type.
Next Annotation (Ctrl+.)  Selects the next item the list displayed in 
the [Problems] or the [Search] view.
Previous Annotation (Ctrl+,)  Selects the previous item the list 
displayed in the [Problems] or the [Search] view.
last Edit location (Ctrl+Q)  Jumps to the last edited position in 
the editor.
go to line... (Ctrl+l)  Jumps to the position in the active document 
indicated by the specified line number.
Back (Alt+left)  Returns to any position in the document just 
referenced or edited.
forward (Alt+Right)  Reverts the display traced back by [Back] 
above to the next recent state.

Search... (Ctrl+H)  Displays a [Search] dialog box that lets the user 
search for a file or C.
file...   Searches for a file containing the specified string.
C/C++...  Searches for C source containing the specified string.
Text  Searches a string from the specified range.

Open Project  Opens the closed project currently selected in the 
[C/C++ Projects]/[Navigator] view.
Close Project  Closes the project currently selected in the [C/C++ 
Projects]/[Navigator] view.

Build All (Ctrl+B)  Executes a build process on all projects open 
in the [C/C++ Projects]/[Navigator] view.
Build Project  Executes a build process on the project currently 
selected in the [C/C++ Projects]/[Navigator] view.
Build Working Set  Executes a build process on the resources 
included in a specified working set.
Clean...  Executes a clean or a rebuild.
Properties  Displays a [Properties] dialog box that lets the user 
display or edit properties of the project selected in the [C/C++ 
Projects] or [Navigator] view.

Start Winfog17  Launches winfog17.exe, creating a function 
option document file for Start WinFog17 mask ROM.
Pack with WinMdc17  Launches Pack with MinMdc17 
winmdc17.exe and generates a pack file (<project name>.pa).
Unpack with WinMdc17  Launches Unpack with MinMdc17 
winmdc17.exe and unpacks a packed file (<project name>.pa).
Start lcdUtility  Launches the Start LcdUtility LCD utility 
(lcdUtil17.exe).

Debug last launched  Starts debugging using the configuration 
previously launched.
Debug History  Displays a shortcut in the submenu to the debug 
configuration last launched.
Debug Configurations...  Opens the debugger gdb launch 
configuration dialog box.

New Window  Opens a new window.
New Editor  Opens the currently edited file with the new editor tab.
Open Perspective  Opens the perspective.
Show View  Opens a view.
Customize Perspective...  Changes settings for the current 
perspective.
Save Perspective As...  Saves settings for the current 
perspective under another name.
Reset Perspective  Restores the perspective to the default state.
Close Perspective  Closes the currently active perspective.
Close All Perspectives  Closes all loaded perspectives.
Navigation  Navigates the editor or view.
Preferences...  Customizes the IDE environment.

gNU17 IDE (3) Development Tools

[gNU17 Actions] menu

[Project] menu



 Reference

Menu Bar
[Help] menu

Help Contents  Displays Help files.
Search  Displays a search view for help topics.
Dynamic Help  Displays the help topic related to the 
view currently activated.
Key Assist... (Ctrl+Shift+l)  Displays the list of 
currently available menu commands.
Software Updates  Installs an updater, updates, plug-
ins, etc. for software management.
About Eclipse for gNU17 Vx.x  Shows IDE version 
information and detailed information on plug-ins, etc.

gNU17 IDE (4) Development Tools
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Editor Area
The area of the editor where you edit source code. The IDE opens the C editor or the assembler editor according to the file type to be edited.

gNU17 IDE (5) Development Tools

Marker bar
The marker bar shows the line in error and the markers
indicating a bookmark, a line in which a task is set, etc.
Markers are displayed on the left edge of the 
corresponding line.

Error marker

Overview ruler
The overview ruler shows the position in error 
and the position at which a bookmark or task is 
set by a square symbol. Click a marker to go to 
that position.

Editing area
Edit sources in this area. 
While a C source being edited, the content assist function 
shown below can be used by pressing the [Ctrl] + [Space] keys.

Bookmark marker

Task marker
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[C/C++ Projects] View
Lists the projects present in the workspace along with the C and assembler sources, include files, 
and generated execution format object files included in these projects. (Select the type of file to be 
displayed using [Filters...] from the view menu.) The function names and global variable names, 
etc. in the C source can also be displayed. Before editing a project or source or performing other 
operations, be sure to select the desired project or source here.

gNU17 IDE (6) Development Tools

[Navigator] View
Lists the directories and files present in the workspace. (The type of file to be displayed can be 
selected using [Filters...] from the view menu.) Before editing a project or source or performing 
other operations, select the desired project or source here.

Project

Source files

Navigate
display history

Collapse hierarchy list
Link with editor

Menu
Navigate

display history

Collapse hierarchy list
Link with editor

Menu

Project directory

Directories/files 
in the project

Include directory

Function/variable,
etc., in the C source
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[Outline] View
Shows the functions and global variables that are written in the C source being displayed in the 
editor. Clicking on one of these items allows you to jump to the position in the editor at which the 
function or variable is written. While an assembler source is being displayed, no information is 
shown in this view.

GNU17 IDE (7) Development Tools

[Make Target] View
When using a makefile you created, specify a target to execute.

Sort in alphabetical order
Display/hide fields, static members, 
members other than public

Icons
Project

Binary container

Executable format file

Include container

Include folder

Header file

Source folder

C source file

Assembler source file

Text file, etc.

Object file

Include

Variable

Function

Structure (struct)

Member variable

Union (union)

Enumeration type (enum)

Enumerator

Function definition (prototype declaration)

Macro-definition

Type definition (typedef)

Navigate Execute a make process 
at a selected target

Hide the folders in which 
no makefile exists.

Project directory

Targets in the project

Menu
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[Console] View
Displays the executed command line or the messages output by the GNU17 tools.

gNU17 IDE (8) Development Tools

[Problems] View
Shows the errors that occurred during a build operation. For errors in the source file, you can jump 
to the corresponding spot in the editor that is in error by clicking on an error message here.

Clear the contents displayed
Automatic scroll lock

Enable other view while the 
[Console] view is displaying messages.
Switching [Console]
Opens a new [Console].

Menu

Error message

Error

Warning

Locations in error (file/directory/line number)
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[Properties] View
Displays information on the resource or member currently selected in the [C/C++ Projects], the 
[Navigator], or the [Outline] view.

GNU17 IDE (9) Development Tools

[Search] View
Shows the result of a search that was performed using the [Search] dialog box. This view in the 
initial IDE configuration is not displayed. It appears when a search is executed.

Repeat previous search
Open/collapse hierarchy list

Delete search results (selected/all)
Navigate search results

Cancel search being executed
Search history
Enable other view while the 
[Search] view is displaying results
Menu

Item Set values/contents
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[Bookmarks] View
Shows the bookmarks registered in the editor, letting you jump to a bookmark or delete a 
bookmark.

gNU17 IDE (10) Development Tools

[Tasks] View
Shows the tasks (To-Do) registered in the editor, letting you jump to or delete a task.

Menu

Completion mark (check) display

Priority
High

(blank)Normal
Low

Menu

Description for tasks Task set locations (file/directory/line number)

Bookmark name/description Bookmark set locations (file/directory/line number)
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C Compiler xgcc Development Tools

Outline
This tool is made based on GNU C Compiler and is compatible with 
ANSI C. This tool invokes cpp.exe and cc1.exe sequentially to 
compile C source files to the assembly source files for the S1C17 
Family. It has a powerful optimizing ability that can generate 
minimized assembly codes. The xgcc.exe can also invoke the 
as.exe assembler to generate object files.

flowchart

Start-up Command
xgcc <options> <filename>

<filename>  C source file name

Example: xgcc -c -gstabs test.c

Major Command-line Options
-S Output assembly code (.s)
-c Output relocatable object file (.o)
-E Execute C preprocessor only
-B<path> Specify compiler search path
-I<path> Specify include file directory
-fno-builtin Disable built-in functions
-D<macro>[=<string>] Define macro name
-O0,-O,-O3 Optimization
-gstabs Add debugging information with relative path to source files
-mpointer16 Generate code for 16-bit (64KB) data space
-mshort-offset Generate code for 20-bit (1MB) space
-Wall Enables warning options
-Werror-implicit-function-declaration Undeclared function error output
-mno-sjis-filt Disables filter function for Shift JIS code
-xassembler-with-cpp Invoke C preprocessor
-Wa,<option> Specify assembler option

C compiler
xgcc -S

file.s
Assembly

source files

as assembler

C compiler
xgcc -c

file.c

file.o

C source files

file.c

C source files

Object files

ld linker
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Assembler as (1) Development Tools

Outline
This tool assembles assembly source files output by the C compiler and converts 
the mnemonics of the source files into object codes (machine language) of the 
S1C17. The as.exe allows the user to invoke the assembler through xgcc.exe, this 
makes it possible to include preprocessor directives into assembly source files. The 
results are output in an object file that can be linked or added to a library.

flowchart
Major Command-line Options

-o<filename> Specify output file name
-a[<suboption>] Output assembly list file

Example: -adhl (high-level assembly listing without debugging 

directives)

--gstabs Add debugging information with relative path to source files
-mpointer16 Specify 16-bit pointer mode
-mc17_ext <dumpfile> <mapfile> Optimize extended instructions

Major Preprocessor Pseudo-instructions
#include Insertion of file
#define Definition/macro definition of character string and numeric 

value
#if – #else – #endif Conditional assembly

(Can be used when the -c -xassembler-with-cpp option of xgcc is specified.)

Major Assembler Pseudo-instructions
.text Declare .text section
.section .data Declare .data section
.section .rodata Declare .rodata section
.section .bss Declare .bss section
.long <data> Define 4-byte data
.short <data> Define 2-byte data
.byte <data> Define 1-byte data
.ascii <string> Define ASCII character strings
.space <length> Define blank area (0x0)
.zero <length> Define blank area (0x0)
.align <value> Alignment to specify boundary address
.global <symbol> Global declaration of symbol
.set <symbol>,<address> Define symbol with absolute address

Start-up Command
as <options> <filename>

<filename>  Assembly source file name

Example: as -o test.o -adhl test.s

Assembler
as

file.s

file.o

Specify the -c and 
-xassembler-with-cpp 
options

-mc17_ext 
C compiler

xgcc

Preprocessor
cpp

Assembler
as

file.s

file.o

Assembly sources 
including preprocessor instructions

Object files

ld linker

Object files

ld linker

Link map and
dump files

Assembly 
sources

file.d
file.map
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Assembler as (2) Development Tools

Error/Warning Messages

Error messages
Unrecognized opcode: 'XXXXX' The operation code XXXXX is undefined.
junk at end of line: 'XXXXX A format error of the operand. 
XXXXXX: invalid register name The specified register cannot be used.
operand out of range The value specified in the operand is out of the
(XXXXXX: XXX not between AAA and BBB) effective range.
There are too many characters of one The number of characters (except for a new line
line in assembler source file. character) in an assembler source line has exceeded

2,047 characters.
Cannot allocate memory. Memory allocation by malloc() has failed.
Cannot specify plurality source files. More than one source file name is specified in the

command line.
Cannot find the dump file. A dump file name is not specified even though the

-mc17_ext option is specified. Or the specified
dump file does not exist.

Cannot find the map file. A map file name is not specified even though the
-mc17_ext option is specified. Or the specified map
file does not exist.

The format of the dump file is invalid. The contents in the dump file specified with the
-mc17_ext option are invalid.

The format of the map file is invalid. The contents of the map file specified with the
-mc17_ext option are invalid.

Cannot close the map file. The map file specified with the -mc17_ext option
cannot be closed after it has been read.

There are too many characters of one The number of characters (except for a new line
line in dump file. character) in a line of the dump file specified with the

-mc17_ext option has exceeded 2,047 characters.
There are too many characters of one The number of characters (except for a new line
line in map file. character) in a line of the map file specified with the

-mc17_ext option has exceeded 2,047 characters.
Error: Value of XXXX too large for field of The address of the label located XXXX bytes from 
AAA bytes at BBB the beginning of the .text session is too large. This 

label is referenced by the AAA-byte symbol table 
located BBB bytes from the beginning of the .rodata 
session.

Error : Failed to hash symbols. -mc17_ext was specified, but symbol name 
registration failed.

Warning messages
Unrecognized .section attribute: The section attribute is not a, w or x.
want a, w, x
Bignum truncated to AAA bytes The constant declared (e.g. .long, .int) exceeds  

the maximum size. It has been corrected to AAA-byte 
size.

Value XXXX truncated to AAA The constant declared exceeds the maximum value 
AAA. It has been corrected to AAA. 
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linker ld (1) Development Tools

Outline
Defines the memory locations of object codes created by the C compiler and 
assembler, and creates executable object codes. This tool puts together multiple 
objects and library files into one file.

flowchart

Start-up Command
ld <options> <filename>

<filename>  Object and library files to be linked

Example: ld -o sample.elf boot.o sample.o ..\lib\24bit\libc.a 
..\lib\24bit\libgcc.a ..\lib\24bit\libc.a

Major Command-line Options
-o <filename> Specify output file name
-T <filename> Read linker script file
-M Link map stdout output
-Map <filename> Link map file output
-N Disable data segment alignment check

Error Messages
The offset value of a symbol is over 16bit. The address of the symbol exceeds the 16-bit 

address space.
The offset value of a symbol is over 24bit. The address of the symbol exceeds the 24-bit 

address space.
Input object file use both 16bit and 24bit The object files to be linked contain both files created 
address mode. in 24-bit pointer mode and 16-bit pointer mode.
section XXX is not within 16bit address. The address of the XXX section exceeds the 16-bit 

address space.
section XXX is not within 24bit address. The address of the XXX section exceeds the 24-bit 

address space.

file.ldsLinker script file

Link map file

gdb debugger

as assembler

linker
ld

file.o

file.elf

file.a

file.map

User
Library

Library files

Object files

Executable
object file

ANSI library
Emulation library

Simulated I/O library

libstdio.a

 libc.a
libgcc.a(libgccM.a/libgccMD.a)
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linker ld (2) Development Tools

Default linker script file generated by the IDE

/* Linker Script file generated by Gnu17 Plug-in for Eclipse */
OUTPUT_FORMAT("elf32-c17", "elf32-c17", "elf32-c17")
OUTPUT_ARCH(c17)
SEARCH_DIR(.);

SECTIONS
{
 /* stack pointer symbols */
  __START_stack = 0x000FC0;

 /* location counter */
 . = 0x0;

 /* section information */
 .bss 0x000000 : 
   {
    __START_bss = . ;
    boot.o(.bss)
    main.o(.bss) files(.bss)
    libc.a(.bss)
   }
   __END_bss = . ;

 .data __END_bss : AT( __END_rodata )
   {
    __START_data = . ;
    files(.data)
   }
   __END_data = . ;

 .vector 0x008000 : 
   {
    __START_vector = . ;
    boot.o(.rodata)
   }
   __END_vector = . ;

 .text __END_vector : 
   {
    __START_text = . ;
    files(.text)
   }
   __END_text = . ;

 .rodata __END_text : 
   {
    __START_rodata = . ;
    main.o(.rodata)
    libc.a(.rodata)
   }
   __END_rodata = . ;

 /* load address symbols */
 __START_data_lma = LOADADDR( .data );
 __END_data_lma = __START_data_lma + SIZEOF( .data );
}

unused

.data (2)

.data (3)

.bss (2)

.bss (3)
.data (1)

.data (1).text (1)
.rodata (1)

boot.o

(When boot.o, main.o, libc.a are linked.)
.bss (1)

.data (2)

.rodata (2)
.text (2)

main.o

.bss (2)

.data (3)

.rodata (3)
.text (3)

libc.a (library)

.bss (3)

.bss (1)

(RAM)

Copy 
before 
using.

.data section
(VMA)

.bss section
(VMA)

0x000000

__END_data

__START_data

__END_bss

__START_bss

unused

.text (2)

.text (3)

.text (1)

.rodata (2)

.rodata (3)

(ROM)

.data (2)

.data (3)

.data (1)

.data section
(LMA)

.rodata section
(LMA = VMA)

.text section
(LMA = VMA)
.vector section
(LMA = VMA)0x008000

__START_data_lma

__END_rodata

__START_rodata

__END_text

__START_text

__END_vector

__START_vector

.rodata (1)
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Debugger gdb (1) Development Tools

Outline
The gdb serves to perform source-level debugging by controlling an ICD. It also 
comes with a simulating function that allows you to perform debugging on a 
personal computer. gdb.exe supports Windows GUI. Commands that are used 
frequently, such as break and step, are registered on the tool bar, minimizing the 
necessary keyboard operations. Moreover, various data can be displayed in multi 
windows, with resultant increased efficiency in the debugging tasks. 

Flowchart

Start-up Command
gdb <options>

Example: gdb -x sample.cmd --cd=/cygdrive/c/EPSON/gnu17/sample

Command-line Options
--command=<filename> Specifies a command file
-x <filename> Specifies a command file
--c17_cmw=<seconds> Specifies the command execution intervals for command files
--cd=<path> Changes current directory
--directory=<path> Changes source file directory
--c17_double_starting Enables double starting

Debugger

gdb

Embedded system simulator

ES-Sim17

file.cmd

Command
file

file.log

Command 
log file

file.log

Trace
log file

file.log

Stdout file

from Linker

ICD

file.par

Parameter file

file.xxx

Motorola
HEX fileStdin file

Profile/coverage
data file

c17_profile_path.gdb

Profile/coverage
data path file

c17_profile_path.gdb

Storage location file for
profile/coverage data files

c17_profile.prf

Profile/coverage data file

User definition button

command file

userdefine.gdb

Reset definition

command file

reset.gdb

file.elf

elf object file

file.c
file.s

Source file(s)

file.xxx

c17_profile.prf
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Debugger gdb (2) Development Tools

Debug perspective

[Expressions] view
Used for registering watch
expressions (global symbols and
registers) and monitoring their
values.

[Variables] view
Used for monitoring local
variable values.

[Breakpoints] view
Used for displaying and
managing breakpoints.

[Resister] view
Used for displaying and
correcting CPU register
values.

[Disassembly] view
Displays program disassembly

for the stack frame selected in

[Debug] view.

[Debug] view
Main window with debugging menus
and toolbars used for debugging.
This window is used for stepping
execution and program
termination/restarting.

[Console] view
Used for displaying command
execution and execution results. It
also displays the Simulated I/O
output.

[Source] editor
The editor used for source editing
on the IDE can be used for the
current source line displayed when
debugging. The [Source] editor is
also used for setting breakpoints.

[Trace] view
Displays trace data.

[Memory] view
Used for displaying and
correcting the memory
contents.
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Debugger gdb (3) Development Tools 

[Debug] view

[Source] editor

[Disassembly] view

[Breakpoints] view

[Variables] view

[Copy Stack]:  Copies the stack configuration below the icon 
selected as a text string.
[Find...]:  Searches for icons.
[Drop To Frame]:  Not supported.
[Restart]: Not supported.
[Reset]:  Runs a reset.
[Step Into]:  Step into.
[Step Over]:  Step over.
[Step Return]:  Step return.
[Instruction Stepping Mode]:  [Step Into]/[Step Over] are step-run 
for individual mnemonic commands when depressed.
[Use Step Filters]:  Not supported.
[Resume Without Signal]:  Not supported.
[Resume]: Resumes the program.
[Suspend]:  Suspends the program.
[Terminate]:  Stops the debugger (GDB) and ends debugging.
[Terminate and Relaunch]:  Relaunches after terminating the 
program.
[Disconnect]:  Not supported.
[Remove All Terminated]:  Removes all of the terminated icons.
[Relaunch]:  Relaunches the debugger after termination.
[Edit GDB17 Debugger for **** ...]:  Opens the launch configuration 
dialog box for editing.
[Edit Source Lookup...]:  Not supported. 
[Lookup Source]:  Not supported.
[Terminate and Remove]:  Terminates the debugger selected in 
[Debug] view and removes the icon.
[Terminate/Disconnect All]:  Terminates all of the debuggers 
currently launched.
[Properties]:  Not supported.
[User Command]:  Runs a user-defined command.
[Profile]:  Launches the Profiler window.
[Coverage]:  Launches the Coverage window.

[Run to Line]:  Runs as far as the line specified by the cursor.
[Resume at Line]:  Not supported.
[Add Watch Expression...]:  Opens the dialog box for registering 
watch expressions.
[Run As]:  Not supported.

[Run to Line]:  Runs as far as the line specified by the cursor.
[Resume at Line]:  Not supported.

[Go to File]:  Opens the selected breakpoint in the editor.
[Enable]:  Enables the breakpoint.
[Disable]:  Disables the breakpoint.
[Remove]:  Removes the selected breakpoints from the display.
[Remove All]:  Removes all breakpoints from the display.
[Select All]:  Selects the entire breakpoint list.
[Copy/Paste]:  Copies or pastes the breakpoints.
[Export Breakpoints...]:  Saves the breakpoints.
[Import Breakpoints...]:  Restores the breakpoints.
[Add Watchpoint]:  Not supported.
[Properties]:  Opens the dialog box displaying the breakpoint 
properties.

[Select All]:  Selects the entire view display.
[Copy Variables]:  Copies the details selected.
[Enable]: Allows the variables to be updated.
[Disable]:  Prevents the variables from being updated.
[Display As Array...]:  Not supported.
[Cast To Type...]:  Not supported.
[Restore Original Type]:  Not supported.
[View Memory]:  Displays the variable value address in [Memory] 
view.
[Find...]: Searches for a variable.
[Change Value...]:  Opens a dialog box for changing variable values.
[Add Watchpoint...]:  Not supported.
[Add Global Variables…]:  Selects and adds global variables from 
the list.
[Remove Global Variables]:  Deletes the selected global variables 
from the display.
[Remove All Global Variables]:  Deletes all global variables from the 
display.
[Create Watch Expression]:  Registers variables in [Expressions] 
view.
[Format]:  Alters the display format.

Context menu Context menu
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Debugger gdb (4) Development Tools

Context menu Context menu

[Select All]:  Selects the entire view display.
[Copy Expressions]:  Copies the selected details.
[Remove]:  Deletes the selected expressions from the display.
[Remove All]:  Deletes all the expressions from the display.
[find...]:  Searches for an expression.
[Change Value...]:   Opens the dialog box for changing the expression 
value.
[Add Watch Expression...]:  Adds a watch expression.
[Edit Watch Expression...]:  Edits the watch expression.
[Reevaluate Watch Expression]:  Reevaluates (recalculates) the watch 
expression.
[Create Watch Expression]:  Registers the selected value as a watch 
expression in [Expressions] view.
[Enable]:  Allows the watch expression to be updated.
[Disable]:  Prevents the watch expression from being updated.
[format]:  Changes the display format.
[Display As Array...]:  Not supported.
[Cast To Type...]:  Not supported.
[Restore Original Type]:  Not supported.
[View Memory]:  Displays the expression value address in [Memory] 
view.

[Select All]:  Selects the entire view display.
[Copy Registers]:  Copies the details selected.
[Enable]:  Allows registers to be updated.
[Disable]:  Prevents registers from being updated.
[Display As Array...]: Not supported.
[Cast To Type...]:  Not supported.
[Restore Original Type]:  Not supported.
[View Memory]:  Displays register value addresses in [Memory] view.
[find...]:  Searches for registers.
[Change Value...]:  Opens the dialog box for changing register values.
[Add Register group]:  Creates a register group to display only specific 
registers.
[Restore Default Register groups]:  Restores the default register 
group display.
[Edit Register group]:  Edits the register group.
[Remove Register group]:  Deletes the register group.
[Create Watch Expression]:  Registers a register in [Expressions] view.
[format]:  Changes the display format.

[Add Watchpoint]:  Not supported.
[Add Rendering]:  Adds the display format for displaying memory.
[Remove Rendering]:  Deletes the memory display currently selected.
[Panes]:  Displays or hides the address/data/ASCII sections.
[Endian]:  Toggles the display between little endian and big endian.
[Text]:  Switches the ASCII section encoding.
[Cell Size]:  Switches the display byte size for each column of the data 
section.
[Radix]:  Switches the display format for each column of the data 
section.
[Columns]:  Switches the number of columns in the data section.
[Copy To Clipboard]:  Copies the section selected.
[Copy Address]:  Copies the boundary address at the cursor position.
[Reset To Base Address]:  Restores the data section display to the 
address position at the time it was registered in the memory monitor.

[Cut]:  Cuts the content selected.
[Copy]:  Copies the content selected.
[Paste]:  Pastes the content selected.
[Select All]:  Selects the entire view display.
[find/Replace...]:  Searches within the console.
[Clear]:  Clears the console display.
[Remove All Terminated]:  Deletes all terminated debug icons in 
[Debug] view.
[Scroll lock]:  Toggles the scroll lock.
[Preferences...]:  Opens the console setting dialog box.

[Copy]:  Copies the content selected.
[Select All]:  Selects the entire view display.
[Clear Trace]:  Clears the trace display.

[Register]  view

[Expressions]  view [Memory]  view

[Console]/[Simulated I/O]  view

[Trace]  view
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Debug Commands

Debugger gdb (5) Development Tools

Break
break [addr] Set software PC breakpoint ICD Mini/SIM
tbreak [addr] Set temporary software PC breakpoint ICD Mini/SIM 
hbreak [addr] Set hardware PC breakpoint ICD Mini/SIM
thbreak [addr] Set temporary hardware PC breakpoint ICD Mini/SIM
delete [breakNo.] Clear breakpoint by break number ICD Mini/SIM
clear addr Clear breakpoint by location ICD Mini/SIM
enable [breakNo.] Enable breakpoint ICD Mini/SIM
disable [breakNo.] Disable breakpoint ICD Mini/SIM
ignore breakNo. count Disable breakpoint with ignore count ICD Mini/SIM
info breakpoints Display breakpoint list ICD Mini/SIM
c17 timebrk timer Set lapse of time break ICD Mini
commands Set a command to execute after break ICD Mini/Sim

Symbol information
info locals Display local symbol information ICD Mini/SIM
info var Display global symbol information ICD Mini/SIM
print symbol[=value] Change symbol values ICD Mini/SIM

file
file file Load debug information ICD Mini/SIM
load [file] Load program ICD Mini/SIM
c17 loadmd mode Set program load mode ICD Mini

Map information
c17 rpf file Set map information ICD Mini/SIM
c17 map Display map information SIM

flash memory
c17 fls addr1 addr2 erase write Set up flash memory ICD Mini
c17 fle control block1 block2 [timer] Erase flash memory ICD Mini
c17 flv Voltage Set flash memory write/delete voltage ICD Mini
c17 flvs Cancel flash memory write/delete voltage setting ICD Mini

Trace
c17 tm on/off mode [file] Set trace mode SIM

Simulated I/O
c17 stdin 1/2 break buffer [file] Sets the simulated input condition. ICD Mini/SIM
c17 stdout 1/2 break buffer [file] Sets the simulated output condition. ICD Mini/SIM

Memory operation
c17 fb addr1 addr2 data Fill memory area (8 bits) ICD Mini/SIM
c17 fh addr1 addr2 data Fill memory area (16 bits) ICD Mini/SIM
c17 fw addr1 addr2 data Fill memory area (32 bits) ICD Mini/SIM
x /[length]b [addr] Dump memory data (8 bits) ICD Mini/SIM
x /[length]h [addr] Dump memory data (16 bits) ICD Mini/SIM
x /[length]w [addr] Dump memory data (32 bits) ICD Mini/SIM
set {char} addr=data Set memory data (8 bits) ICD Mini/SIM
set {short} addr=data Set memory data (16 bits) ICD Mini/SIM
set {long} addr=data Set memory data (32 bits) ICD Mini/SIM
c17 mvb addr1 addr2 addr3 Copy memory area (8 bits) ICD Mini/SIM
c17 mvh addr1 addr2 addr3 Copy memory area (16 bits) ICD Mini/SIM
c17 mvw addr1 addr2 addr3 Copy memory area (32 bits) ICD Mini/SIM
c17 df addr1 addr2 type file [append] Save memory data to file ICD Mini/SIM
c17 readmd mode Memory read mode ICD Mini

Register operation
info reg [register] Display register data ICD Mini/SIM
set $register=data Set register data ICD Mini/SIM

Program execution
continue [Ignore] Execute program successively ICD Mini/SIM
until addr Execute program successively with temporary break ICD Mini/SIM
step [count] Execute source lines ICD Mini/SIM
stepi [count] Execute instruction steps ICD Mini/SIM
next [count] Execute source lines with function skip ICD Mini/SIM
nexti [count] Execute instruction steps with subroutine skip ICD Mini/SIM
finish Exit from function/subroutine ICD Mini/SIM
c17 callmd mode [file] Set user-function call mode ICD Mini/SIM
c17 call func [arg1... [arg3]]] Call user function ICD Mini/SIM

CPU reset
c17 rst Reset CPU (execute reset.gdb) ICD Mini/SIM
c17 rstt Reset target ICD Mini

Interrupt
c17 int [intNo. level] Generate interrupt SIM
c17 intclear [intNo.] Clear interrupt SIM
c17 int_load [file] Load interrupt event file SIM
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Debugger gdb (6) Development Tools

Debug Commands

Profiler/coverage
c17 profilemd Profile/coverage mode setting SIM
c17 profile Display of profile window SIM
c17 coverage Display of coverage window SIM

Others
set output-rad x Change variable display format ICD Mini/SIM
c17 log [file] Logging ICD Mini/SIM
source file Execute command file ICD Mini/SIM
c17 clockmd mode Set execution counter mode ICD Mini/SIM
c17 clock Display execution counter ICD Mini/SIM
target type Connect target ICD Mini/SIM
detach Disconnect target ICD Mini/SIM
pwd Display current directory ICD Mini/SIM
cd directory Change current directory ICD Mini/SIM
c17 firmupdate file Update ICD firmware ICD Mini
c17 ttbr addr Set TTBR SIM
c17 chgclkmd 0/1 Clock source selection in break mode ICD Mini
c17 help [command/groupNo.] Help ICD Mini/SIM
quit Terminate debugger ICD Mini/SIM

Status and Error Messages

Status messages
Breakpoint #, function at file:line Made to break at the set breakpoint.
Break by accessing no map.  Made to break by the accessing of an unmapped 
 area in simulator mode.
Break by writing ROM area.  Made to break by the accessing of a read-only area 
 in simulator mode.
Break by stack overflow.  Made to break by a stack overflow that occurred in 
 simulator mode.
Illegal instruction.  Made to break by the execution of an illegal 
 instruction in simulator mode.
Illegal delayed instruction.  Made to break by the execution of an illegal delayed 
 instruction in simulator mode.
Break by key break. Forcibly made to break using the [Suspend] button. 
  (Simulator mode)
Break by key break. Program received   Forcibly made to break using the [Suspend] button. 
signal SIGINT, Interrupt. (ICD Mini mode)

Error messages
· · · gdb : unrecognized option 'option' An illegal startup option is specified.
A setup of a serial port was not completed. An ICD mode not supported in gdb is specified.
Address is 24bit over. The specified address is out of the 24-bit range. The 
 maximum S1C17 address size is 24 bits (0xffffff).
Address(0x#) is ext or delayed instruction. The specified address cannot be set, as it is for the 
 ext or delayed instruction.
C17 command error, command is not  The input command cannot be executed in the 
supported at present mode.  current connect mode (ICD Mini or simulator mode).
C17 command error, command is not  Not supported for ICDmini hardware version xx.
supported in ICDmini hardware Ver xx.
C17 command error, command is not  Not supported for ICDmini firmware version xx.
supported in ICDmini firmware Ver xx.
C17 command error, command is too long. The input command is too long, as it exceeds 256 
 characters.
C17 command error, invalid command. The command is invalid; it contains an error.
C17 command error, invalid parameter. The command is specified with an invalid parameter.
C17 command error, no map area. The address for the specified command argument  
 falls beyond the address range specified by the  
 parameter file.
C17 command error, number of parameter. The number of parameters in the command is 
 incorrect.
C17 command error,  The number used as the start address specified in the
start address > end address. command is greater than that used as the end address.
Cannot access memory at address # Address # cannot be accessed.
Cannot allocate memory. A memory area of the size specified by a parameter 
 cannot be allocated.
Cannot clear hard pc break(0x#).  The specified hardware PC break address is 
 nonexistent.
Cannot clear soft pc break(0x#).  The specified software PC break address is nonexistent.
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Debugger gdb (7) Development Tools

Error messages
Cannot display clock counter. The execution counter value cannot be displayed when
Now Timer break mode is on. the lapse of time break is enabled. Disable the lapse 
Please timer break mode off.  of time break before execution times can be measured.
Cannot display clock counter. The execution counter value cannot be displayed if 
Time measurement should use continue  the continue or until command has not been 
or until command.  executed.
Cannot load to no map memory. (0x#-0x#) Cannot load a file to an area beyond the address range  
 specified by the parameter file.
Cannot measure clock timer. The program execution time cannot be measured as 
 it is too short.
Cannot open file(file).  The system cannot open the file.
Cannot open ICD17 usb driver.  The system failed to open the USB driver.
Cannot set hard pc break. Cannot set a hard break at the address specified.
Cannot set hard pc break any more.  The number of hardware PC breakpoints set exceeds 
 the limit (1).
Cannot set soft pc break. Cannot set a soft break at the address specified.
Cannot set soft pc break any more.  The number of software PC breakpoints set exceeds 
 the limit (200).
Cannot set soft pc break at ROM area. Cannot write to read-only memory.
Cannot set at same breakpoint address. A break has already been set at the address specified.
Cannot set timer.  Cannot set a lapse of time break as the specified
Timer Conditions: 1<=Timer<=300000 time exceeds the valid range.
Cannot write file.  The system cannot write to the file.
Clock timer overflow.  The clock measurement timer has overflowed.
Communication error(bcc).  A BCC error was found in the messages received 
 from the ICD.
Communication system error(#).  The connection was unexpectedly terminated during 
 communication with the ICD.
Copy end address max(0x#) overflow. The end address of the source to be copied exceeds 
 the upper limit (0xffffff).
Copy start address max(0x#) overflow. The start address of the source to be copied exceeds 
 the upper limit (0xffffff).
Coverage Window is already opened. A coverage window is open.
CPU is running. Cannot accept a command while the CPU is running.
Erase entry address max(0x#) overflow. The flash erase routine address exceeds the upper 
 limit (0xffffff).
Flash memory end address max(0x#)  The flash memory end address exceeds the upper 
overflow. limit (0xffffff).
Flash memory start address max(0x#)  The flash memory start address exceeds the upper 
overflow. limit (0xffffff).
ICD17 is busy(#).  The ICD side is busy.
Initialization error of ICD17.  The system failed to initialize the target.
Invalid ID error(0x#).  The gdb has transmit an invalid ID number. 
 (Internal error)
Invalid format event file (#). Format error for the event file specified by c17   
 int_load (interrupt event command)

Invalid parameter file(#: file).  The parameter file contains an error.
Invalid parameter file,  The address range set in the parameter file is invalid, 
start address > end address(#: file).  as the number used as the start address is greater 
 than that used as the end address.
It is not c17 architecture ELF file. The file specified with the file command is not an 
 elf format file supported in S5U1C17001C.
Load end address max(0x#) overflow. The end address of the program to be written to flash 
 memory exceeds the upper limit (0xffffff).
Load motorola file format error.(file)  The specified Motorola file contains a format error.
Load size limit(0x#) overflow. The size of the specified file exceeds the upper limit.
 • Flash write/erase program 
      8K bytes - 1 byte (0x1fff)
 • Write data for flash memory 
      3M bytes - 1 byte (0x2fffff)
 • Firmware 
      8M bytes - 1 byte (0x7fffff)
Load start address max(0x#) overflow. The start address of the program to be written to 
 flash memory exceeds the upper limit (0xffffff).
Profiler Window is already opened. A profiler window is open.
Receiving message is inaccurate.  A message exceeding the maximum size was 
 received during communication with the ICD.
Script file error: IF nest max(5) over. The number of nested if statements exceeds five in  
 the script file (*.Spt).
Script file format error. (Line no.#) Format error for line number # in the script file (*.Spt).
Send Size entry address is out of limit  The data size sent per packet to the ICD falls   
(# - #). beyond the valid range.
Specification is required in the device for There is an insufficient number of device names from 
connecting. which to select the ICD in the target command.
Specified voltage cannot be output. The voltage specified falls outside the range.
Specified voltage is out of range The voltage specified falls outside the range.
(6.0V – 8.0V).
Target down.  A communication error has occurred between the 
 ICD and the target.
There is no argument given to this  The system failed to disconnect the target.
command. 
Too much event(#).  The number of events specified with the c17 int_ 
 load (event file read) command exceeds the upper 
 limit (256).
Transmitting failure(#).  NAK was received from the ICD during 
 communication with the ICD.
USB communication error(host->ICD17).  The system failed in USB transmission to the ICD.
USB communication error(ICD17->host).  The system failed in USB receiving from ICD.
Write entry address max(0x#) overflow.  The address of the flash write routine exceeds the 
 upper limit (0xffffff).

Error messages

Status and Error Messages
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libraryEmulation library libgcc.a (libgccM.a / libgccMD.a) (1)

floating-point Calculation functions

Double-type operation
__adddf3 Addition x ← a + b
__subdf3 Subtraction x ← a - b
__muldf3 Multiplication x ← a * b
__divdf3 Division x ← a / b
__negdf2 Sign change x ← -a

float-type operation
__addsf3 Addition x ← a + b
__subsf3 Subtraction x ← a - b
__mulsf3 Multiplication x ← a * b
__divsf3 Division x ← a / b
__negsf2 Sign change x ← -a

Type conversion
__fixunsdfsi double → unsigned long x ← a
__fixdfsi double → long x ← a
__floatsidf long → double x ← a
__fixunssfsi float → unsigned long x ← a
__fixsfsi float → long x ← a
__floatsisf long → float x ← a
__truncdfsf2 double → float x ← a
__extendsfdf2 float → double x ← a

Comparison
__**df2 double type Changes %psr and x by a - b

**=eq, ne, gt, ge, lt, le 
__**sf2 float type Changes %psr and x by a - %13

**=eq, ne, gt, ge, lt, le 

floating-point Data format

Double-type data format

S
63

Exponent part
62 52

Fixed-point part
51 0

Double-type effective range
+0: 0.0e+0 0x00000000 00000000
-0: -0.0e+0 0x80000000 00000000
Maximum normalized number: 1.79769e+308 0x7fefffff ffffffff
Minimum normalized number: 2.22507e-308 0x00100000 00000000
Maximum unnormalized number: 2.22507e-308 0x000fffff ffffffff
Minimum unnormalized number: 4.94065e-324 0x00000000 00000001
Infinity: 0x7ff00000 00000000
-Infinity: 0xfff00000 00000000

float-type data format

S
31

Exponent part
30 23

Fixed-point part
22 0

float-type effective range
+0: 0.0e+0f 0x00000000
-0: -0.0e+0f 0x80000000
Maximum normalized number: 3.40282e+38f 0x7f7fffff
Minimum normalized number: 1.17549e-38f 0x00800000
Maximum unnormalized number: 1.17549e-38f 0x007fffff
Minimum unnormalized number: 1.40129e-45f 0x00000001
Infinity: 0x7f800000
-Infinity: 0xff800000
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libraryEmulation library libgcc.a (libgccM.a / libgccMD.a) (2)

Integral Calculation functions

Integral calculation
__divsi3 Signed 32-bit integral division x ← a / b
__modsi3 Signed 32-bit remainder calculation x ← a % b
__udivsi3 Unsigned 32-bit integral division x ← a / b
__umodsi3 Unsigned 32-bit remainder calculation x ← a % b
__mulsi3 32-bit multiplication x ←a * b
__divhi3 Signed 16-bit integral division x ← a / b
__modhi3 Signed 16-bit remainder calculation x ←a % b
__udivhi3 Unsigned 16-bit integral division x ← a / b
__umodhi3 Unsigned 16-bit remainder calculation x ← a % b
__mulhi3 16-bit multiplication x ← a * b

Integral shift
__ashlsi3 32-bit arithmetical shift to left x ← a << b bits
__ashrsi3 32-bit arithmetical shift to right x ← a >> b bits
__lshrsi3 32-bit logical shift to right x ← a >> b bits
__ashlhi3 16-bit arithmetical shift to left x ← a << b bits
__ashrhi3 16-bit arithmetical shift to right x ← a >> b bits
__lshrhi3 16-bit logical shift to right x ← a >> b bits

Integral comparison 
__cmpsi2 comparison (long) x ← 2 | 1 | 0 
__ucmpsi2 Comparison (unsigned long) x ← 2 | 1 | 0 

long long Type Calculation functions

long long type calculation
__muldi3 Signed 64-bit multiplication x ← a * b
__divdi3 Signed 64-bit division x ← a / b
__udivdi3 Unsigned 64-bit division x ← a / b
__moddi3 Signed 64-bit remainder calculation x ← a % b
__umoddi3 Unsigned 64-bit remainder calculation x ← a % b
__negdi2 Sign inversion x ← -a

long long type shift
__lshrdi3 64-bit logical shift to right x ← a >> b bits
__ashldi3 64-bit arithmetical shift to left x ← a << b bits
__ashrdi3 64-bit arithmetical shift to right x ← a >> b bits

Type conversion
__fixunsdfdi double → unsigned long long x ← a
__fixdfdi double → long long x ← a  
__floatdidf long long → double x ← a
__fixunssfdi float → unsigned long long x ← a
__fixsfdi float → long long x ← a
__floatdisf long long → float x ← a

long long type comparison
__cmpdi2 Comparison (long long) x ← 2 | 1 | 0
__ucmpdi2 Comparison (unsigned long long) x ← 2 | 1 | 0
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ANSI library libc.a (1) library

Input/Output functions (header file: stdio.h)
fread( ) size_t fread(void *ptr, size_t size, size_t count, FILE *stream); *1, *2
fwrite( ) size_t fwrite(const void *ptr, size_t size, size_t count, FILE *stream); *1, *2
fgetc( ) int fgetc(FILE *stream); *2
getc( ) int getc(FILE *stream); *1, *2
getchar( ) int getchar(void); *1, *2
ungetc( ) int ungetc(int c, FILE *stream); *1
fgets( ) char *fgets(char *s, int n, FILE *stream); *1, *2
gets( ) char *gets(char *s); *1, *2
fputc( ) int fputc(int c, FILE *stream); *2
putc( ) int putc(int c, FILE *stream); *1, *2
putchar( ) int putchar(int c); *1, *2
fputs( ) int fputs(char *s, FILE *stream); *1, *2
puts( ) int puts(char *s); *1, *2
perror( ) void perror(const char *s); *1, *2
fscanf( ) int fscanf(FILE *stream, const char *format, ...); *1, *2
scanf( ) int scanf(const char *format, ...); *1, *2
sscanf( ) int sscanf(const char *s, const char *format, ...); *1, *2
fprintf( ) int fprintf(FILE *stream, const char *format, ...); *1, *2
printf( ) int printf(const char *format, ...); *1, *2
sprintf( ) int sprintf(char *s, const char *format, ...); *1, *2
vfprintf( ) int vfprintf(FILE *stream, const char *format, va_list arg); *1, *2
vprintf( ) int vprintf(const char *format, va_list arg); *1, *2
vsprintf( ) int vsprintf(char *s, const char *format, va_list arg);

Utility functions (header file: stdlib.h)
malloc( ) void *malloc(size_t size); *1
calloc( ) void *calloc(size_t elt_count, size_t elt_size); *1
free( ) void free(void *ptr); *1
realloc( ) void *realloc(void *ptr, size_t size); *1
exit( ) void exit(int status);
abort( ) void abort(void);
bsearch( ) void *bsearch(const void *key, const void *base, size_t count,size_t size, int 

(*compare)(const void *, const void *));
qsort( ) void qsort(void *base, size_t count, size_t size,int (*compare)

const void *, const void *));
abs( ) int abs(int x);
labs( ) long labs(long x);
div( ) div_t div(int n, int d); *1
ldiv( ) ldiv_t ldiv(long n, long d); *1
rand( ) int rand(void);
srand( ) void srand(unsigned int seed);
atol( ) long atol(const char *str);
atoi( ) int atoi(const char *str); *1
atof( ) double atof(const char *str); *1
strtod( ) double strtod(const char *str, char **ptr); *1
strtol( ) long strtol(const char *str, char **ptr, int base); *1
strtoul( ) unsigned long strtoul(const char *str, char **ptr, int base); *1

Date and Time functions (header file: time.h)
gmtime( ) struct tm *gmtime(time_t *t);
mktime( ) time_t mktime(struct tm *tmptr);
time( ) time_t time(time_t *tptr); *1

Non-local Branch functions (header file: setjmp.h)
setjmp( ) int setjmp(jmp_buf *ptr);
longjmp( ) void longjmp(jmp_buf *ptr, int status);

*1 These functions need to declare and initialize the global variables.
*2 These functions need to define the low-level functions and I/O buffers.
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ANSI library libc.a (2) library

Mathematical functions (header file: math.h, errno.h, float.h, limits.h)
fabs( ) double fabs(double x); *1
ceil( ) double ceil(double x); *1
floor( ) double floor(double x); *1
fmod( ) double fmod(double x, double y); *1
exp( ) double exp(double x); *1
log( ) double log(double x); *1
log10( ) double log10(double x); *1
frexp( ) double frexp(double x, int *nptr); *1
ldexp( ) double ldexp(double x, int n); *1
modf( ) double modf(double x, double *nptr); *1
pow( ) double pow(double x, double y); *1
sqrt( ) double sqrt(double x); *1
sin( ) double sin(double x); *1
cos( ) double cos(double x); *1
tan( ) double tan(double x); *1
asin( ) double asin(double x); *1
acos( ) double acos(double x); *1
atan( ) double atan(double x);
atan2( ) double atan2(double y, double x); *1
sinh( ) double sinh(double x); *1
cosh( ) double cosh(double x); *1
tanh( ) double tanh(double x);

Character Type Determination/Conversion functions (header file: ctype.h)
isalnum( ) int isalnum(int c);
isalpha( ) int isalpha(int c);
iscntrl( ) int iscntrl(int c);
isdigit( ) int isdigit(int c);
isgraph( ) int isgraph(int c);
islower( ) int islower(int c);
isprint( ) int isprint(int c);
ispunct( ) int ispunct(int c);
isspace( ) int isspace(int c);
isupper( ) int isupper(int c);
isxdigit( ) int isxdigit(int c);
tolower( ) int tolower(int c);
toupper( ) int toupper(int c);

Variable Argument Macros (header file: stdarg.h)
va_start( ) void va_start(va_list ap, type lastarg);
va_arg( ) type va_arg(va_list ap, type);
va_end( ) void va_end(va_list ap);

*1 These functions need to declare and initialize the global variables.

Character functions (header file: string.h)
memchr( ) void *memchr(const void *s, int c, size_t n);
memcmp( ) int memcmp(const void *s1, const void *s2, size_t n);
memcpy( ) void *memcpy(void *s1, const void *s2, size_t n);
memmove( ) void *memmove(void *s1, const void *s2, size_t n);
memset( ) void *memset(void *s, int c, size_t n);
strcat( ) char *strcat(char *s1, const char *s2);
strchr( ) char *strchr(const char *s, int c);
strcmp( ) int strcmp(const char *s1, const char *s2);
strcpy( ) char *strcpy(char *s1, const char *s2);
strcspn( ) size_t strcspn(const char *s1, const char *s2);
strerror( ) char *strerror(int code);
strlen( ) size_t strlen(const char *s);
strncat( ) char *strncat(char *s1, const char *s2, size_t n);
strncmp( ) int strncmp(const char *s1, const char *s2, size_t n);
strncpy( ) char *strncpy(char *s1, const char *s2, size_t n);
strpbrk( ) char *strpbrk(const char *s1, const char *s2);
strrchr( ) char *strrchr(const char *str, int c);
strspn( ) size_t strspn(const char *s1, const char *s2);
strstr( ) char *strstr(const char *s1, const char *s2);
strtok( ) char *strtok(char *s1, const char *s2);

*1 Declaring and Initializing global Variables
FILE _iob[FOPEN_MAX+1]; _iob[N]._flg=_UGETN; _iob[N]._buf=0; _iob[N]._fd=N;

(N=0: stdin, N=1:  stdout, N=2: stderr)
FILE *stdin; stdin=&_iob[0];
FILE *stdout; stdout=&_iob[1];
FILE *stderr; stderr=&_iob[2];
int errno; errno=0;
unsigned int seed; seed=1;
time_t gm_sec; gm_sec=-1;

*2 Definition of lower-level functions
read( ) int read(int fd, char *buf, int nbytes);

unsigned char READ_BUF[65];  (Variable name is arbitrary)
unsigned char READ_EOF;

write( ) int write(int fd, char *buf, int nbytes);
unsigned char WRITE_BUF[65];  (Variable name is arbitrary)
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Instruction list (1) Assembly Programming

Symbols in the Instruction list

Registers/Register Data
%rd, rd: A general-purpose register (R0—R7) used as the destination register or its contents
%rs, rs: A general-purpose register (R0—R7) used as the source register or its contents
%rb, rb: A general-purpose register (R0—R7) that has stored a base address to be accessed in the 

register indirect addressing mode or its contents
%sp, sp: Stack pointer (SP) or its contents
%pc, pc: Program counter (PC) or its contents 

Memory/Addresses/Memory Data
[%rb], [%sp]: Specification for register indirect addressing
[%rb]+, [%sp]+: Specification for register indirect addressing with post-increment
[%rb]-, [%sp]-: Specification for register indirect addressing with post-decrement
-[%rb], -[%sp]: Specification for register indirect addressing with pre-decrement
[%sp+immX]: Specification for register indirect addressing with a displacement
[imm7]: Specification for a memory address with an immediate data
B[XXX]: An address specified with XXX, or the byte data stored in the address
W[XXX]: A 16-bit address specified with XXX, or the word data stored in the address
A[XXX]: A 32-bit address specified with XXX, or the 24-bit or 32-bit data stored in the address

Immediate
immX: A X-bit unsigned immediate data
signX: A X-bit signed immediate data

Symbol/label
Symbol: A symbol that points an address.
Label: A branch destination label.

Notes
¥ The instruction list contains the basic instructions in the S1C17 instruction set and the extended instructions (s... and x..., except for xor).

¥ "Italic basic instructions" indicate that the upper compatible extended instructions are provided.

Bit field
(X): Bit X of data.
(X:Y): A bit field from bit X to bit Y.
{X, Y···}: Indicates a bit (data) configuration.

functions
←: Indicates that the right item is loaded or set to the left item.
+: Addition
-: Subtraction
&: AND
|: OR
^: XOR
!: NOT

flags
IL: Interrupt level
IE: Interrupt enable flag
C: Carry flag
V: Overflow flag
Z: Zero flag
N: Negative flag
—: Not changed
↔: Set (1), reset (0) or not changed
1: Set (1)
0: Reset (0)

D
: Indicates that the instruction can be used as a delayed instruction.

—: Indicates that the instruction cannot be used as a delayed instruction.
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Opcode
ld.b

sld.b

xld.b

ld.ub

sld.ub

xld.ub

Operand
%rd, %rs
%rd, [%rb]
%rd, [%rb]+
%rd, [%rb]-
%rd, -[%rb]
%rd, [%sp+imm7]
%rd, [imm7]
[%rb], %rs
[%rb]+, %rs
[%rb]-, %rs
-[%rb], %rs
[%sp+imm7], %rs
[imm7], %rs
%rd, [%sp+imm20]
%rd, [imm20]
[%sp+imm20], %rs
[imm20], %rs
%rd, [%sp+imm24]
%rd, [imm24]
[%sp+imm24], %rs
[imm24], %rs
%rd, %rs
%rd, [%rb]
%rd, [%rb]+
%rd, [%rb]-
%rd, -[%rb]
%rd, [%sp+imm7]
%rd, [imm7]
%rd, [%sp+imm20]
%rd, [imm20]
%rd, [%sp+imm24]
%rd, [imm24]

function

rd(7:0)←rs(7:0), rd(15:8)←rs(7), rd(23:16)←0
rd(7:0)←B[rb], rd(15:8)←B[rb](7), rd(23:16)←0
rd(7:0)←B[rb], rd(15:8)←B[rb](7), rd(23:16)←0, rb(23:0)←rb(23:0)+1
rd(7:0)←B[rb], rd(15:8)←B[rb](7), rd(23:16)←0, rb(23:0)←rb(23:0)-1
rb(23:0)←rb(23:0)-1, rd(7:0)←B[rb], rd(15:8)←B[rb](7), rd(23:16)←0
rd(7:0)←B[sp+imm7], rd(15:8)←B[sp+imm7](7), rd(23:16)←0
rd(7:0)←B[imm7], rd(15:8)←B[imm7](7), rd(23:16)←0
B[rb]←rs(7:0)
B[rb]←rs(7:0), rb(23:0)←rb(23:0)+1
B[rb]←rs(7:0), rb(23:0)←rb(23:0)-1
rb(23:0)←rb(23:0)-1, B[rb]←rs(7:0)
B[sp+imm7]←rs(7:0)
B[imm7]←rs(7:0)
%rd←B[%sp+imm20](with sign extension)
%rd←B[imm20](with sign extension)
B[%sp+imm20]←%rs(7:0)
B[imm20]←%rs(7:0)
%rd←B[%sp+imm24](with sign extension)
%rd←B[imm24](with sign extension)
B[%sp+imm24]←%rs(7:0)
B[imm24]←%rs(7:0)
rd(7:0)←rs(7:0), rd(15:8)←0, rd(23:16)←0
rd(7:0)←B[rb], rd(15:8)←0, rd(23:16)←0
rd(7:0)←B[rb], rd(15:8)←0, rd(23:16)←0, rb(23:0)←rb(23:0)+1
rd(7:0)←B[rb], rd(15:8)←0, rd(23:16)←0, rb(23:0)←rb(23:0)-1
rb(23:0)←rb(23:0)-1, rd(7:0)←B[rb], rd(15:8)←0, rd(23:16)←0
rd(7:0)←B[sp+imm7], rd(15:8)←0, rd(23:16)←0
rd(7:0)←B[imm7], rd(15:8)←0, rd(23:16)←0
%rd←B[%sp+imm20](with zero extension)
%rd←B[imm20](with zero extension)
%rd←B[%sp+imm24](with zero extension)
%rd←B[imm24](with zero extension)
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Mnemonic
Classification

Signed 8-bit data 
transfer

Unsigned 8-bit 
data transfer

flags

Instruction list (2) Assembly Programming

Remarks



 Reference

Opcode
ld

sld

xld

ld.a

Operand
%rd, %rs
%rd, sign7
%rd, [%rb]
%rd, [%rb]+
%rd, [%rb]-
%rd, -[%rb]
%rd, [%sp+imm7]
%rd, [imm7]
[%rb], %rs
[%rb]+, %rs
[%rb]-, %rs
-[%rb], %rs
[%sp+imm7], %rs
[imm7], %rs
%rd, imm16
%rd, symbol±imm16
%rd, [%sp+imm20]
%rd, [imm20]
[%sp+imm20], %rs
[imm20], %rs
%rd, imm16
%rd, symbol±imm16
%rd, [%sp+imm24]
%rd, [imm24]
[%sp+imm24], %rs
[imm24], %rs
%rd, %rs
%rd, imm7
%rd, [%rb]
%rd, [%rb]+
%rd, [%rb]-
%rd, -[%rb]
%rd, [%sp+imm7]
%rd, [imm7]

function

rd(15:0)←rs(15:0), rd(23:16)←0
rd(6:0)←sign7(6:0), rd(15:7)←sign7(6), rd(23:16)←0
rd(15:0)←W[rb], rd(23:16)←0
rd(15:0)←W[rb], rd(23:16)←0, rb(23:0)←rb(23:0)+2
rd(15:0)←W[rb], rd(23:16)←0, rb(23:0)←rb(23:0)-2
rb(23:0)←rb(23:0)-2, rd(15:0)←W[rb], rd(23:16)←0
rd(15:0)←W[sp+imm7], rd(23:16)←0
rd(15:0)←W[imm7], rd(23:16)←0
W[rb]←rs(15:0)
W[rb]←rs(15:0), rb(23:0)←rb(23:0)+2
W[rb]←rs(15:0), rb(23:0)←rb(23:0)-2
rb(23:0)←rb(23:0)-2, W[rb]←rs(15:0)
W[sp+imm7]←rs(15:0)
W[imm7]←rs(15:0)
%rd←imm16
%rd←symbol±imm16(15:0)
%rd←W[%sp+imm20]
%rd←W[imm20]
W[%sp+imm20]←%rs(15:0)
W[imm20]←%rs(15:0)
%rd←imm16
%rd←symbol±imm16(15:0)
%rd←W[%sp+imm24]
%rd←W[imm24]
W[%sp+imm24]←%rs(15:0)
W[imm24]←%rs(15:0)
rd(23:0)←rs(23:0)
rd(6:0)←imm7(6:0), rd(23:7)←0
rd(23:0)←A[rb](23:0), ignored←A[rb](31:24)
rd(23:0)←A[rb](23:0), ignored←A[rb](31:24), rb(23:0)←rb(23:0)+4
rd(23:0)←A[rb](23:0), ignored←A[rb](31:24), rb(23:0)←rb(23:0)-4
rb(23:0)←rb(23:0)-4, rd(23:0)←A[rb](23:0), ignored←A[rb](31:24)
rd(23:0)←A[sp+imm7](23:0), ignored←A[sp+imm7](31:24)
rd(23:0)←A[imm7](23:0), ignored←A[imm7](31:24)
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Mnemonic
Classification

16-bit data 
transfer

32-bit data 
transfer

flags

Instruction list (3) Assembly Programming

Remarks



 Reference

Opcode
ld.a

sld.a

xld.a

Operand
[%rb], %rs
[%rb]+, %rs
[%rb]-, %rs
-[%rb], %rs
[%sp+imm7], %rs
[imm7], %rs
%rd, %sp
%rd, %pc
%rd, [%sp]
%rd, [%sp]+
%rd, [%sp]-
%rd, -[%sp]
[%sp], %rs
[%sp]+, %rs
[%sp]-, %rs
-[%sp], %rs
%sp, %rs
%sp, imm7
%rd, imm20
%sp, imm20
%rd, symbol±imm20
%sp, symbol±imm20
%rd, [%sp+imm20]
%rd, [imm20]
[%sp+imm20], %rs
[imm20], %rs
%rd, imm24
%sp, imm24
%rd, symbol±imm24
%sp, symbol±imm24
%rd, [%sp+imm24]
%rd, [imm24]
[%sp+imm24], %rs
[imm24], %rs

function

A[rb](23:0)←rs(23:0), A[rb](31:24)←0
A[rb](23:0)←rs(23:0), A[rb](31:24)←0, rb(23:0)←rb(23:0)+4
A[rb](23:0)←rs(23:0), A[rb](31:24)←0, rb(23:0)←rb(23:0)-4
rb(23:0)←rb(23:0)-4, A[rb](23:0)←rs(23:0), A[rb](31:24)←0
A[sp+imm7](23:0)←rs(23:0), A[sp+imm7](31:24)←0
A[imm7](23:0)←rs(23:0), A[imm7](31:24)←0
rd(23:2)←sp(23:2), rd(1:0)←0
rd(23:0)←pc(23:0)+2
rd(23:0)←A[sp](23:0), ignored←A[sp](31:24)
rd(23:0)←A[sp](23:0), ignored←A[sp](31:24), sp(23:0)←sp(23:0)+4
rd(23:0)←A[sp](23:0), ignored←A[sp](31:24), sp(23:0)←sp(23:0)-4
sp(23:0)←sp(23:0)-4, rd(23:0)←A[sp](23:0), ignored←A[sp](31:24)
A[sp](23:0)←rs(23:0), A[sp](31:24)←0
A[sp](23:0)←rs(23:0), A[sp](31:24)←0, sp(23:0)←sp(23:0)+4
A[sp](23:0)←rs(23:0), A[sp](31:24)←0, sp(23:0)←sp(23:0)-4
sp(23:0)←sp(23:0)-4, A[sp](23:0)←rs(23:0), A[sp](31:24)←0
sp(23:2)←rs(23:2)
sp(6:2)←imm7(6:2), sp(23:7)←0
%rd←imm20
%sp←imm20
%rd←symbol±imm20(19:0)
%sp←symbol±imm20(19:0)
%rd←A[%sp+imm20](23:0), ignored←A[%sp+imm20](31:24)
%rd←A[imm20](23:0), ignored←A[imm20](31:24)
A[%sp+imm20](23:0)←%rs(23:0), A[%sp+imm20](31:24)←0
A[imm20](23:0)←%rs(23:0), A[imm20](31:24)←0
%rd←imm24
%sp←imm24
%rd←symbol±imm24(23:0)
%sp←symbol±imm24(23:0)
%rd←A[%sp+imm24](23:0), ignored←A[%sp+imm24](31:24)
%rd←A[imm24](23:0), ignored←A[imm24](31:24)
A[%sp+imm24](23:0)←%rs(23:0), A[imm24](31:24)←0
A[imm24](23:0)←%rs(23:0), A[%sp+imm24](31:24)←0
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Mnemonic
Classification

32-bit data 
transfer

flags

Instruction list (4) Assembly Programming

Remarks



 Reference

Opcode
add
add/c
add/nc
add
sadd
xadd
add.a
add.a/c
add.a/nc
add.a

sadd.a

xadd.a

adc
adc/c
adc/nc
adc
sadc
xadc
sub
sub/c
sub/nc
sub
ssub
xsub
sub.a
sub.a/c
sub.a/nc
sub.a

Operand
%rd, %rs
%rd, %rs
%rd, %rs
%rd, imm7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%sp, %rs
%rd, imm7
%sp, imm7
%rd, imm20
%sp, imm20
%rd, imm24
%sp, imm24
%rd, %rs
%rd, %rs
%rd, %rs
%rd, imm7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, imm7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%sp, %rs
%rd, imm7
%sp, imm7

function

rd(15:0)←rd(15:0)+rs(15:0), rd(23:16)←0
rd(15:0)←rd(15:0)+rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)+rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)+imm7(with zero extension), rd(23:16)←0
rd(15:0)←rd(15:0)+imm16, rd(23:16)←0
rd(15:0)←rd(15:0)+imm16, rd(23:16)←0
rd(23:0)←rd(23:0)+rs(23:0) 
rd(23:0)←rd(23:0)+rs(23:0) if C = 1 (nop if C = 0)
rd(23:0)←rd(23:0)+rs(23:0) if C = 0 (nop if C = 1)
sp(23:0)←sp(23:0)+rs(23:0)
rd(23:0)←rd(23:0)+imm7(with zero extension)
sp(23:0)←sp(23:0)+imm7(with zero extension)
rd(23:0)←rd(23:0)+imm20(with zero extension)
sp(23:0)←sp(23:0)+imm20(with zero extension)
rd(23:0)←rd(23:0)+imm24
sp(23:0)←sp(23:0)+imm24
rd(15:0)←rd(15:0)+rs(15:0)+C, rd(23:16)←0
rd(15:0)←rd(15:0)+rs(15:0)+C, rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)+rs(15:0)+C, rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)+imm7(with zero extension)+C, rd(23:16)←0
rd(15:0)←rd(15:0)+imm16+C, rd(23:16)←0
rd(15:0)←rd(15:0)+imm16+C, rd(23:16)←0
rd(15:0)←rd(15:0)-rs(15:0), rd(23:16)←0
rd(15:0)←rd(15:0)-rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)-rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)-imm7(with zero extension), rd(23:16)←0
rd(15:0)←rd(15:0)-imm16, rd(23:16)←0
rd(15:0)←rd(15:0)-imm16, rd(23:16)←0
rd(23:0)←rd(23:0)-rs(23:0) 
rd(23:0)←rd(23:0)-rs(23:0) if C = 1 (nop if C = 0)
rd(23:0)←rd(23:0)-rs(23:0) if C = 0 (nop if C = 1)
sp(23:0)←sp(23:0)-rs(23:0)
rd(23:0)←rd(23:0)-imm7(with zero extension)
sp(23:0)←sp(23:0)-imm7(with zero extension)
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Mnemonic
Classification

Arithmetic 
operation

flags

Instruction list (5) Assembly Programming

Remarks



 Reference

Opcode
ssub.a

xsub.a

sbc
sbc/c
sbc/nc
sbc
ssbc
xsbc
cmp
cmp/c
cmp/nc
cmp
scmp
xcmp
cmp.a
cmp.a/c
cmp.a/nc
cmp.a
scmp.a
xcmp.a
cmc
cmc/c
cmc/nc
cmc
scmc
xcmc
and
and/c
and/nc
and
sand
xand

Operand
%rd, imm20
%sp, imm20
%rd, imm24
%sp, imm24
%rd, %rs
%rd, %rs
%rd, %rs
%rd, imm7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, imm7
%rd, imm20
%rd, imm24
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16

function

rd(23:0)←rd(23:0)-imm20(with zero extension)
sp(23:0)←sp(23:0)-imm20(with zero extension)
rd(23:0)←rd(23:0)-imm24
sp(23:0)←sp(23:0)-imm24
rd(15:0)←rd(15:0)-rs(15:0)-C, rd(23:16)←0
rd(15:0)←rd(15:0)-rs(15:0)-C, rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)-rs(15:0)-C, rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)-imm7(with zero extension)-C, rd(23:16)←0
rd(15:0)←rd(15:0)-imm16-C, rd(23:16)←0
rd(15:0)←rd(15:0)-imm16-C, rd(23:16)←0
rd(15:0)-rs(15:0)
rd(15:0)-rs(15:0) if C = 1 (nop if C = 0)
rd(15:0)-rs(15:0) if C = 0 (nop if C = 1)
rd(15:0)-sign7(with sign extension)
rd(15:0)-imm16
rd(15:0)-imm16
d(23:0)-rs(23:0)
rd(23:0)-rs(23:0) if C = 1 (nop if C = 0)
rd(23:0)-rs(23:0) if C = 0 (nop if C = 1)
rd(23:0)-imm7(with zero extension)
rd(23:0)-imm20(with zero extension)
rd(23:0)-imm24
rd(15:0)-rs(15:0)-C
rd(15:0)-rs(15:0)-C if C = 1 (nop if C = 0)
rd(15:0)-rs(15:0)-C if C = 0 (nop if C = 1)
rd(15:0)-sign7(with sign extension)-C
rd(15:0)-imm16-C
rd(15:0)-imm16-C
rd(15:0)←rd(15:0)&rs(15:0), rd(23:16)←0
rd(15:0)←rd(15:0)&rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)&rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)&sign7(with sign extension), rd(23:16)←0
rd(15:0)←rd(15:0)&imm16, rd(23:16)←0
rd(15:0)←rd(15:0)&imm16, rd(23:16)←0

D

–
–
–
–

–
–

–
–

–
–

–
–

–
–

Il
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

IE
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Z
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

N
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

C
–
–
–
–
↔
–
–
↔
↔
↔
↔
–
–
↔
↔
↔
↔
–
–
↔
↔
↔
↔
–
–
↔
↔
↔
–
–
–
–
–
–

V
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
0
0
0
0
0
0

Mnemonic
Classification

Arithmetic 
operation

logic
operation

flags

Instruction list (6) Assembly Programming

Remarks



 Reference

Opcode
or
or/c
or/nc
or
soor
xoor
xor
xor/c
xor/nc
xor
sxor
xxor
not
not/c
not/nc
not
snot
xnot
jpr / jpr.d

sjpr / sjpr.d

xjpr / xjpr.d

jpa / jpa.d

sjpa / sjpa.d

xjpa / xjpa.d

jrgt / jrgt.d
sjrgt / sjrgt.d

xjrgt / xjrgt.d

Operand
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16
%rd, %rs
%rd, %rs
%rd, %rs
%rd, sign7
%rd, imm16
%rd, imm16
%rb
sign10
label±imm20
sign20
label±imm24
sign24
%rb
imm7
label±imm20
imm20
label±imm24
imm24
sign7
label±imm20
sign20
label±imm24
sign24

function

d(15:0)←rd(15:0) | rs(15:0), rd(23:16)←0
rd(15:0)←rd(15:0) | rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0) | rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0) | sign7(with sign extension), rd(23:16)←0
rd(15:0)←rd(15:0) | imm16, rd(23:16)←0
rd(15:0)←rd(15:0) | imm16, rd(23:16)←0
rd(15:0)←rd(15:0)^rs(15:0), rd(23:16)←0
rd(15:0)←rd(15:0)^rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←rd(15:0)^rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←rd(15:0)^sign7(with sign extension), rd(23:16)←0
rd(15:0)←rd(15:0)^imm16, rd(23:16)←0
rd(15:0)←rd(15:0)^imm16, rd(23:16)←0
rd(15:0)←!rs(15:0), rd(23:16)←0
rd(15:0)←!rs(15:0), rd(23:16)←0 if C = 1 (nop if C = 0)
rd(15:0)←!rs(15:0), rd(23:16)←0 if C = 0 (nop if C = 1)
rd(15:0)←!sign7(with sign extension), rd(23:16)←0
rd(15:0)←!imm16, rd(23:16)←0
rd(15:0)←!imm16, rd(23:16)←0
pc←pc+2+rb
pc←pc+2+sign11; sign11={sign10,0}
pc←label±imm20
pc←pc+2+sign20
pc←label±imm24
pc←pc+2+sign24
pc←rb
pc←imm7
pc←label±imm20
pc←imm20
pc←label±imm24
pc←imm24
pc←pc+2+sign8 if !Z&!(N^V) is true; sign8={sign7,0}
pc←label±imm20 if !Z&!(N^V) is true
pc←pc+2+sign20 if !Z&!(N^V) is true
pc←label±imm24 if !Z&!(N^V) is true
pc←pc+2+sign24 if !Z&!(N^V) is true

D

–
–

–
–

–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Il
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

IE
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Z
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

N
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

C
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

V
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Mnemonic
Classification

logic
operation

Branch

flags

Instruction list (7) Assembly Programming

Remarks



 Reference

Opcode
jrge / jrge.d
sjrge / sjrge.d

xjrge / xjrge.d

jrlt / jrlt.d
sjrlt / sjrlt.d

xjrlt / xjrlt.d

jrle / jrle.d
sjrle / sjrle.d

xjrle / xjrle.d

jrugt / jrugt.d
sjrugt / sjrugt.d

xjrugt / xjrugt.d

jruge / jruge.d
sjruge / 
sjruge.d
xjruge / 
xjruge.d
jrult / jrult.d
sjrult / sjrult.d

xjrult / xjrult.d

jrule / jrule.d
sjrule / sjrule.d

xjrule / xjrule.d

Operand
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24

function

pc←pc+2+sign8 if !(N^V) is true; sign8={sign7,0}
pc←label±imm20 if !(N^V) is true
pc←pc+2+sign20 if !(N^V) is true
pc←label±imm24 if !(N^V) is true
pc←pc+2+sign24 if !(N^V) is true
pc←pc+2+sign8 if N^V is true; sign8={sign7,0}
pc←label±imm20 if N^V is true
pc←pc+2+sign20 if N^V is true
pc←label±imm24 if N^V is true
pc←pc+2+sign24 if N^V is true
pc←pc+2+sign8 if Z | (N^V) is true; sign8={sign7,0}
pc←label±imm20 if Z | (N^V) is true
pc←pc+2+sign20 if Z | (N^V) is true
pc←label±imm24 if Z | (N^V) is true
pc←pc+2+sign24 if Z | (N^V) is true
pc←pc+2+sign8 if !Z&!C is true; sign8={sign7,0}
pc←label±imm20 if !Z&!C is true
pc←pc+2+sign20 if !Z&!C is true
pc←label±imm24 if !Z&!C is true
pc←pc+2+sign24 if !Z&!C is true
pc←pc+2+sign8 if !C is true; sign8={sign7,0}
pc←label±imm20 if !C is true
pc←pc+2+sign20 if !C is true
pc←label±imm24 if !C is true
pc←pc+2+sign24 if !C is true
pc←pc+2+sign8 if C is true; sign8={sign7,0}
pc←label±imm20 if C is true
pc←pc+2+sign20 if C is true
pc←label±imm24 if C is true
pc←pc+2+sign24 if C is true
pc←pc+2+sign8 if Z | C is true; sign8={sign7,0}
pc←label±imm20 if Z | C is true
pc←pc+2+sign20 if Z | C is true
pc←label±imm24 if Z | C is true
pc←pc+2+sign24 if Z | C is true

D

–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Il
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

IE
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Z
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

N
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

C
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

V
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Mnemonic
Classification

Branch

flags

Instruction list (8) Assembly Programming

Remarks



 Reference

Opcode
jreq / jreq.d
sjreq / sjreq.d

xjreq / xjreq.d

jrne / jrne.d
sjrne / sjrne.d

xjrne / xjrne.d

call / call.d

scall / scall.d

xcall / xcall.d

calla / calla.d

scalla / scalla.d

xcalla / xcalla.d

ret / ret.d
int
intl
reti / reti.d
brk
retd
sr

sa

sl

swap

Operand
sign7
label±imm20
sign20
label±imm24
sign24
sign7
label±imm20
sign20
label±imm24
sign24
%rb
sign10
label±imm20
sign20
label±imm24
sign24
%rb
imm7
label±imm20
imm20
label±imm24
imm24

imm5
imm5, imm3

%rd, %rs
%rd, imm7
%rd, %rs
%rd, imm7
%rd, %rs
%rd, imm7
%rd, %rs

function

pc←pc+2+sign8 if Z is true; sign8={sign7,0}
pc←label±imm20 if Z is true
pc←pc+2+sign20 if Z is true
pc←label±imm24 if Z is true
pc←pc+2+sign24 if Z is true
pc←pc+2+sign8 if !Z is true; sign8={sign7,0}
pc←label±imm20 if !Z is true
pc←pc+2+sign20 if !Z is true
pc←label±imm24 if !Z is true
pc←pc+2+sign24 if !Z is true
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←pc+2+rb
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←pc+2+sign11; sign11={sign10,0}
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←label±imm20
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←pc+2+sign20
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←label±imm24
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←pc+2+sign24
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←rb
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←imm7
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←label±imm20
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←imm20
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←label±imm24
sp←sp-4, A[sp]←pc+2(d=0)/4(d=1), pc←imm24
pc←A[sp](23:0), sp←sp+4
sp←sp-4, A[sp]←{psr, pc+2}, pc←vector(TTBR+imm5×4)
sp←sp-4, A[sp]←{psr, pc+2}, pc←vector(TTBR+imm5×4), psr(IL)←imm3
{psr, pc}←A[sp], sp←sp+4
A[DBRAM]←{psr, pc+2}, A[DBRAM+4]←r0, pc←0xfffc00
r0←A[DBRAM+4](23:0), {psr, pc}←A[DBRAM]
Logical shift to right; rd(15:0)←rd(15:0)>>rs(15:0), rd(23:16)←0, zero enters to MSB (*1)
Logical shift to right; rd(15:0)←rd(15:0)>>imm7, rd(23:16)←0, zero enters to MSB (*1)
Arithmetical shift to right; rd(15:0)←rd(15:0)>>rs(15:0), rd(23:16)←0, sign copied to MSB (*1)
Arithmetical shift to right; rd(15:0)←rd(15:0)>>imm7, rd(23:16)←0, sign copied to MSB (*1)
Logical shift to left; rd(15:0)←rd(15:0)<<rs(15:0), rd(23:16)←0, zero enters to LSB (*1)
Logical shift to left; rd(15:0)←rd(15:0)<<imm7, rd(23:16)←0, zero enters to LSB (*1)
rd(15:8)←rs(7:0), rd(7:0)←rs(15:8), rd(23:16)←0

D

–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Il
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
↔
–
↔
–
–
–
–
–
–
–

IE
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
0
0
↔
0
↔
–
–
–
–
–
–
–

Z
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
–
↔
↔
↔
↔
↔
↔
↔
–

N
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
–
↔
↔
↔
↔
↔
↔
↔
–

C
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
–
↔
↔
↔
↔
↔
↔
↔
–

V
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
–
↔
–
–
–
–
–
–
–

Mnemonic
Classification

Branch

Shift and swap

flags

Instruction list (9) Assembly Programming

Remarks
*1) Number of bits to be shifted: Zero to three bits when rs/imm7 = 0–3, four bits when rs/imm7 = 4–7, eight bits when rs/imm7 ≥ 8



 Reference

Opcode
cv.ab
cv.as
cv.al
cv.la
cv.ls
ext
nop
halt
slp
ei
di
ld.cw

sld.cw

xld.cw

ld.ca

sld.ca

xld.ca

ld.cf

sld.cf

xld.cf

Operand
%rd, %rs
%rd, %rs
%rd, %rs
%rd, %rs
%rd, %rs
imm13

%rd, %rs
%rd, imm7
%rd, imm20
%rd, symbol±imm20
%rd, imm24
%rd, symbol±imm24
%rd, %rs
%rd, imm7
%rd, imm20
%rd, symbol±imm20
%rd, imm24
%rd, symbol±imm24
%rd, %rs
%rd, imm7
%rd, imm20
%rd, symbol±imm20
%rd, imm24
%rd, symbol±imm24

function

rd(23:8)←rs(7), rd(7:0)←rs(7:0)
rd(23:16)←rs(15), rd(15:0)←rs(15:0)
rd(23:16)←rs(7:0), rd(15:0)←rd(15:0)
rd(23:8)←0, rd(7:0)←rs(23:16)
rd(23:16)←0, rd(15:0)←rs(15)
Extends the immediate or operand of the following instruction.
No operation
HALT mode
SLEEP mode
psr(IE)←1
psr(IE)←0
co_dout0←rd, co_dout1←rs
co_dout0←rd, co_dout1←imm7
co_dout0←rd, co_dout1←imm20
co_dout0←rd, co_dout1←symbol±imm20
co_dout0←rd, co_dout1←imm24
co_dout0←rd, co_dout1←symbol±imm24
co_dout0←rd, co_dout1←rs, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm7, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm20, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←symbol±imm20, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm24, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←symbol±imm24, rd←co_din, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←rs, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm7, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm20, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←symbol±imm20, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←imm24, psr(C, V, Z, N)←co_cvzn
co_dout0←rd, co_dout1←symbol±imm24, psr(C, V, Z, N)←co_cvzn

D

–

–
–

–
–
–
–

–
–
–
–

–
–
–
–

Il
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

IE
–
–
–
–
–
–
–
–
–
1
0
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–

Z
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

N
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

C
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

V
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
–
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔
↔

Mnemonic
Classification

Conversion

Imm extension
System control

Coprocessor

flags

Instruction list (10) Assembly Programming

Remarks



 Reference

Opcode
sld.b
sld.ub
sld
sld.a

sld.b
sld
sld.a

sld

sld.a

Operand
%rd, [%sp+imm20]

Example) sld.b  %rd, [%sp+imm20]

%rd, [imm20]

Example) sld  %rd, [imm20]

[%sp+imm20], %rs

Example) sld.b  [%sp+imm20], %rs

[imm20], %rs

Example) sld  [imm20], %rs

%rd, imm16

Example) sld  %rd, imm16

%rd, symbol±imm16

Example) sld  %rd, symbol+imm16

%rd, imm20

Example) sld.a  %rd, imm20

%sp, imm20

Example) sld.a  %sp, imm20

Extended instruction Expansion format
Condition 1
imm20≤0x7f

ld.b %rd, [%sp+imm20(6:0)]

imm20≤0x7f
ld %rd, [imm20(6:0)]

imm20≤0x7f
ld.b [%sp+imm20(6:0)], %rs

imm20≤0x7f
ld [imm20(6:0)], %rs

imm16≤0x7f
ld %rd, imm16(6:0)

Unconditional
ext (symbol+imm16)(15:7)
ld %rd, (symbol+imm16)(6:0)

imm20≤0x7f
ld.a %rd, imm20(6:0)

imm20≤0x7f
ld.a %sp, imm20(6:0)

Condition 2
0x7f<imm20

ext imm20(19:7)
ld.b %rd, [%sp+imm20(6:0)]

0x7f<imm20
ext imm20(19:7)
ld %rd, [imm20(6:0)]

0x7f<imm20
ext imm20(19:7)
ld.b [%sp+imm20(6:0)], %rs

0x7f<imm20
ext imm20(19:7)
ld [imm20(6:0)], %rs

0x7f<imm16
ext imm16(15:7)
ld %rd, imm16(6:0)

–

0x7f<imm20
ext imm20(19:7)
ld.a %rd, imm20(6:0)

0x7f<imm20
ext imm20(19:7)
ld.a %sp, imm20(6:0)

Condition 3
–

–

–

–

–

–

–

–

Expansion format of  Extended Instructions (1) Assembly Programming

Remarks



 Reference

Opcode
sld.a

xld.b
xld.ub
xld
xld.a

xld.b
xld
xld.a

xld

Operand
%rd, symbol±imm20

Example) sld.a  %rd, symbol+imm20

%sp, symbol±imm20

Example) sld.a  %sp, symbol-imm20

%rd, [%sp+imm24]

Example) xld.b  %rd, [%sp+imm24]

%rd, [imm24]

Example) xld  %rd, [imm24]

[%sp+imm24], %rs 

Example) xld.b  [%sp+imm24], %rs

[imm24], %rs 

Example) xld  [imm24], %rs

%rd, imm16

Example) xld  %rd, imm16

%rd, symbol±imm16

Example) xld  %rd, symbol+imm16

Extended instruction Expansion format
Condition 1

Unconditional
ext (symbol+imm20)(19:7)
ld.a %rd, (symbol+imm20)(6:0)

Unconditional
ext (symbol-imm20)(19:7)
ld.a %sp, (symbol-imm20)(6:0)

imm24≤0x7f
ld.b %rd, [%sp+imm24(6:0)]

imm24≤0x7f
ld %rd, [imm24(6:0)]

imm24≤0x7f
ld.b [%sp+imm24(6:0)], %rs

imm24≤0x7f
ld [imm24(6:0)], %rs

imm16≤0x7f
ld %rd, imm16(6:0)

Unconditional
ext (symbol+imm16)(15:7)
ld %rd, (symbol+imm16)(6:0)

Condition 2
–

–

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld.b %rd, [%sp+imm24(6:0)]

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld %rd, [imm24(6:0)]

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld.b [%sp+imm24(6:0)], %rs

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld [imm24(6:0)], %rs

0x7f<imm16
ext imm16(15:7)
ld %rd, imm16(6:0)

–

Condition 3
–

–

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld.b %rd, [%sp+imm24(6:0)]

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld %rd, [imm24(6:0)]

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld.b [%sp+imm24(6:0)], %rs

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld [imm24(6:0)], %rs

–

–

Expansion format of  Extended Instructions (2) Assembly Programming

Remarks



 Reference

Opcode
xld.a

sadd
sadc
ssub
ssbc
sadd.a
ssub.a

xadd
xadc
xsub
xsbc

Operand
%rd, imm24

Example) xld.a  %rd, imm24

%sp, imm24

Example) xld.a  %sp, imm24

%rd, symbol±imm24

Example) xld.a  %rd, symbol+imm24

%sp, symbol±imm24

Example) xld.a  %sp, symbol-imm24

%rd, imm16

Example) sadd  %rd, imm16

%rd, imm20

Example) ssub.a  %rd, imm20

%sp, imm20

Example) sadd.a  %sp, imm20

%rd, imm16

Example) xadc  %rd, imm16

Extended instruction Expansion format
Condition 1
imm24≤0x7f

ld.a %rd, imm24(6:0)

imm24≤0x7f
ld.a %sp, imm24(6:0)

Unconditional
ext (symbol+imm24)(23:20)
ext (symbol+imm24)(19:7)
ld.a %rd, (symbol+imm24)(6:0)

Unconditional
ext (symbol-imm24)(23:20)
ext (symbol-imm24)(19:7)
ld.a %sp, (symbol-imm24)(6:0)

imm16≤0x7f
add %rd, imm16(6:0)

imm20≤0x7f
sub.a %rd, imm20(6:0)

imm20≤0x7f
add.a %sp, imm20(6:0)

imm16≤0x7f
adc %rd, imm16(6:0)

Condition 2
0x7f<imm24≤0xfffff

ext imm24(19:7)
ld.a %rd, imm24(6:0)

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld.a %sp, imm24(6:0)

–

–

0x7f<imm16
ext imm16(15:7)
add %rd, imm16(6:0)

0x7f<imm20
ext imm20(19:7)
sub.a %rd, imm20(6:0)

0x7f<imm20
ext imm20(19:7)
add.a %sp, imm20(6:0)

0x7f<imm16
ext imm16(15:7)
adc %rd, imm16(6:0)

Condition 3
0xfffff<imm24

ext imm24(23:20)
ext imm24(19:7)
ld.a %rd, imm24(6:0)

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld.a %sp, imm24(6:0)

–

–

–

–

–

–

Expansion format of  Extended Instructions (3) Assembly Programming

Remarks



 Reference

Opcode
xadd.a
xsub.a

scmp
scmc

scmp.a

xcmp
xcmc

xcmp.a

sand
soor
sxor
snot
xand
xoor
xxor
xnot

Operand
%rd, imm24

Example) xsub.a  %rd, imm24

%sp, imm24

Example) xadd.a  %sp, imm24

%rd, imm16

Example) scmp  %rd, imm16

%rd, imm20

Example) scmp.a  %rd, imm20

%rd, imm16

Example) xcmc  %rd, imm16

%rd, imm24

Example) xcmp.a  %rd, imm24

%rd, imm16

Example) sand  %rd, imm16

%rd, imm16

Example) xoor  %rd, imm16

Extended instruction Expansion format
Condition 1
imm24≤0x7f

sub.a %rd, imm24(6:0)

imm24≤0x7f
add.a %sp, imm24(6:0)

imm16≤0x7f
cmp %rd, imm16(6:0)

imm20≤0x7f
cmp.a %rd, imm20(6:0)

imm16≤0x7f
cmc %rd, imm16(6:0)

imm24≤0x7f
cmp.a %rd, imm24(6:0)

imm16≤0x7f
and %rd, imm16(6:0)

imm16≤0x7f
or %rd, imm16(6:0)

Condition 2
0x7f<imm24≤0xfffff

ext imm24(19:7)
sub.a %rd, imm24(6:0)

0x7f<imm24≤0xfffff
ext imm24(19:7)
add.a %sp, imm24(6:0)

0x7f<imm16
ext imm16(15:7)
cmp %rd, imm16(6:0)

0x7f<imm20
ext imm20(19:7)
cmp.a %rd, imm20(6:0)

0x7f<imm16
ext imm16(15:7)
cmc %rd, imm16(6:0)

0x7f<imm24≤0xfffff
ext imm24(19:7)
cmp.a %rd, imm24(6:0)

0x7f<imm16
ext imm16(15:7)
and %rd, imm16(6:0)

0x7f<imm16
ext imm16(15:7)
or %rd, imm16(6:0)

Condition 3
0xfffff<imm24

ext imm24(23:20)
ext imm24(19:7)
sub.a %rd, imm24(6:0)

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
add.a %sp, imm24(6:0)

–

–

–

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
cmp.a %rd, imm24(6:0)

–

–

Expansion format of  Extended Instructions (4) Assembly Programming

Remarks



 Reference

Opcode
scall
scall.d
sjpr
sjpr.d

sjr*1
sjr*1.d

scalla
scalla.d
sjpa
sjpa.d

xcall
xcall.d
xjpr
xjpr.d

Operand
label±imm20

Example) scall  label+imm20

sign20

Example) sjpr  sign20

label±imm20

Example) sjreq  label+imm20

sign20

Example) sjrne  sign20

label±imm20

Example) scalla  label+imm20

imm20

Example) sjpa  imm20

label±imm24

Example) xcall  label+imm24

sign24

Example) xjpr  sign24

Extended instruction Expansion format
Condition 1

Unconditional
ext (label+imm20)(19:12)
call (label+imm20)(11:1)

-1024≤sign20≤1023
jpr sign20(11:1)

Unconditional
ext (labe+imm20)(19:8)
jreq (label+imm20)(7:1)

-128≤sign20≤127
jrne sign20(7:1)

Unconditional
ext (label+imm20)(19:7)
calla (label+imm20)(6:0)

imm20≤0x7f
jpa imm20(6:0)

Unconditional
ext (label+imm24)(23:12)
call (label+imm24)(11:1)

-1024≤sign24≤1023
jpr sign24(11:1)

Condition 2
–

sign20<-1024 or 1023<sign20
ext sign20(19:12)
jpr sign20(11:1)

–

sign20<-128 or 127<sign20
ext sign20(19:8)
jrne sign20(7:1)

–

0x7f<imm20
ext imm20(19:7)
jpa  imm20(6:0)

–

sign24<-1024 or 1023<sign24
ext sign24(23:12)
jpr sign24(11:1)

Condition 3
–

–

–

–

–

–

–

–

Expansion format of  Extended Instructions (5) Assembly Programming

Remarks
*1) sjreq, sjreq.d, sjrne, sjrne.d, sjrgt, sjrgt.d, sjrge, sjrge.d, sjrlt, sjrlt.d, sjrle, sjrle.d, sjrugt, sjrugt.d, sjruge, sjruge.d, sjrult, sjrult.d, sjrule, sjrule.d



 Reference

Opcode
xjr*1
xjr*1.d

xcalla
xcalla.d
xjpa
xjpa.d

sld.cw
sld.ca
sld.cf

xld.cw
xld.ca
xld.cf

Operand
label±imm24

Example) xjreq  label+imm24

sign24

Example) xjrne  sign24

label±imm24

Example) xcalla  label+imm24

imm24

Example) xjpa  imm24

%rd, imm20

Example) sld.cw  %rd, imm20

%rd, symbol±imm20

Example) sld.ca  %rd, symbol+imm20

%rd, imm24

Example) xld.cw  %rd, imm24

%rd, symbol±imm24

Example) xld.ca  %rd, symbol+imm24

Extended instruction Expansion format
Condition 1

Unconditional
ext (label+imm24)(23:21)
ext (label+imm24)(20:8)
jreq (label+imm24)(7:1)

-128≤sign24≤127
jrne sign24(7:1)

Unconditional
ext (label+imm24)(23:20)
ext (label+imm24)(19:7)
calla (label+imm24)(6:0)

imm24≤0x7f
jpa imm24(6:0)

imm20≤0x7f
ld.cw %rd, imm20(6:0)

Unconditional
ext (symbol+imm20)(19:7)
ld.ca %rd, (symbol+imm20)(6:0)

imm24≤0x7f
ld.cw %rd, imm24(6:0)

Unconditional
ext (symbol+imm24)(23:20)
ext (symbol+imm24)(19:7)
ld.ca %rd, (symbol+imm24)(6:0)

Condition 2
–

-1048576≤sign24<-128 or 127<sign24≤1048575
ext sign24(20:8)
jrne sign24(7:1)

–

0x7f<imm24≤0xfffff
ext imm24(19:7)
jpa imm24(6:0)

0x7f<imm20
ext imm20(19:7)
ld.cw %rd, imm20(6:0)

–

0x7f<imm24≤0xfffff
ext imm24(19:7)
ld.cw %rd, imm24(6:0)

–

Condition 3
–

sign24<-1048576 or 1048575<sign24
ext sign24(23:21)
ext sign24(20:8)
jrne sign24(7:1)

–

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
jpa imm24(6:0)

–

–

0xfffff<imm24
ext imm24(23:20)
ext imm24(19:7)
ld.cw %rd, imm24(6:0)

–

Expansion format of  Extended Instructions (6) Assembly Programming

Remarks
*1) xjreq, xjreq.d, xjrne, xjrne.d, xjrgt, xjrgt.d, xjrge, xjrge.d, xjrlt, xjrlt.d, xjrle, xjrle.d, xjrugt, xjrugt.d, xjruge, xjruge.d, xjrult, xjrult.d, xjrule, xjrule.d
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